Pro Tools
ALL IN ONE DESK REFERENCE
FOR
DUMMIES®

by Jeff Strong
About the Author

Jeff Strong is the author of Home Recording for Musicians For Dummies and is President of the REI Institute, a MusicMedicine research organization and therapy provider. Jeff graduated from the Percussion Institute of Technology at the Musician’s Institute in Los Angeles in 1983, and has either worked in or owned a recording studio since 1985. Every week, he records dozens of custom-client CDs using Pro Tools. He has also released eight commercially available CDs, four of which can be found at www.reiinstitute.com. This is his fourth book.
Author's Acknowledgments

This book wouldn’t have happened without the inspiration and vision of Senior Acquisitions Editor Steve Hayes. This is my second book with Steve; this one was just as much fun to do as the first. A hearty thanks to my agent Carol Susan Roth for making sure I get what’s coming to me.

Books, by nature, are a team effort and this book is the result of an extremely talented and dedicated team of professionals: Project Editor Paul Levesque (my partner in crime for the second time), who reminded me what a great editor can do for a writer; Senior Copy Editor Barry Childs-Helton, whose guitar mania found its way onto the page; Technical Editor James Murray, who kept me on the straight and narrow; and Copy Editor Virginia Sanders, whose dry sense of humor put a smile on my face more than once during this process.

I’m also indebted to Philip O’Keefe who contributed the text for the PC configuration and Digidesign hardware sections of this book.

I am especially grateful for the love and support of my wife Beth and my daughter Tovah, who never cease to amaze me in their capacity to endure non-stop recording talk.
Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

**Acquisitions, Editorial, and Media Development**

- **Project Editor:** Paul Levesque
- **Acquisitions Editor:** Steve Hayes
- **Copy Editor:** Barry Childs-Helton
- **Technical Editor:** James Murray
- **Editorial Manager:** Kevin Kirschner
- **Permissions Editor:** Carmen Krikorian
- **Media Development Manager:** Laura VanWinkle
- **Media Development Supervisor:** Richard Graves
- **Editorial Assistant:** Amanda Foxworth
- **Cartoons:** Rich Tennant (www.the5thwave.com)

**Production**

- **Project Coordinator:** Kristie Rees
- **Layout and Graphics:** Amanda Carter, Andrea Dahl, Denny Hager, Stephanie D. Jumper, Kristin McMullan, Heather Ryan, Jacque Schneider, Julie Trippetti, Melanie Wolven
- **Proofreaders:** Melissa D. Buddendeck, Luisa Perez, Carl William Pierce, Dwight Ramsey
- **Indexer:** Joan Griffitts

---

**Publishing and Editorial for Technology Dummies**

- Richard Swadley, Vice President and Executive Group Publisher
- Andy Cummings, Vice President and Publisher
- Mary C. Corder, Editorial Director

**Publishing for Consumer Dummies**

- Diane Graves Steele, Vice President and Publisher
- Joyce Pepple, Acquisitions Director

**Composition Services**

- Gerry Fahey, Vice President of Production Services
- Debbie Stailey, Director of Composition Services
Contents at a Glance

Introduction ................................................................. 1

Book I: Home Recording Basics ................................. 7
Chapter 1: Discovering What You Need .......................... 9
Chapter 2: Getting Connected: Setting Up Your Studio .......... 31
Chapter 3: Meeting the Mixing Board ............................ 51
Chapter 4: MIDI and Electronic Instruments .................. 69
Chapter 5: Understanding Microphones ....................... 85

Book II: Getting Started Using Pro Tools .................... 107
Chapter 1: Configuring Your Computer .......................... 109
Chapter 2: Setting Up Your Hardware ............................ 127
Chapter 3: Examining Software Basics ........................... 145
Chapter 4: Understanding the Pro Tools Windows ............ 163
Chapter 5: Importing and Exporting Files ....................... 197

Book III: Recording Audio ........................................ 217
Chapter 1: Taking Care of Tracks ................................. 219
Chapter 2: Miking: Getting a Great Source Sound .......... 237
Chapter 3: Preparing to Record ................................. 267
Chapter 4: Recording Audio ................................. 289

Book IV: Editing Audio ............................................... 315
Chapter 1: Audio Editing Basics ................................. 317
Chapter 2: Selecting Material to Edit ............................. 339
Chapter 3: Getting into Editing ................................. 365
Chapter 4: Adding to Your Editing Palette ..................... 393

Book V: Managing MIDI .............................................. 417
Chapter 1: Preparing to Record MIDI ............................ 419
Chapter 2: Recording MIDI ........................................ 435
Chapter 3: Editing MIDI Data ....................................... 451
Chapter 4: Performing MIDI Operations ......................... 479
Book VI: Mixing in Pro Tools ................................................. 493
Chapter 1: Mixing Basics ................................................................. 495
Chapter 2: Setting Up Your Mix ...................................................... 509
Chapter 3: Using Equalization .......................................................... 535
Chapter 4: Digging into Dynamics Processors ............................... 547
Chapter 5: Singling out Signal Processors ................................... 563
Chapter 6: Automating Your Mix .................................................... 573
Chapter 7: Making Your Mix ............................................................ 591

Book VII: Mastering with Pro Tools ............................................ 597
Chapter 1: Mastering Basics ............................................................ 599
Chapter 2: Mastering Your Music ................................................... 605

Book VIII: Getting Your Music out to the Masses .............. 619
Chapter 1: Putting Your Music on CD .......................................... 621
Chapter 2: Getting Your Music on the Internet ............................. 633

Index .......................................................................................... 651
# Table of Contents

## Introduction ................................................................. 1

- About This Book ........................................................................................................ 1
- Not-So-Foolish Assumptions ................................................................................... 2
- How This Book Is Organized ................................................................................. 2
  - Book I: Home Recording Basics ........................................................................ 3
  - Book II: Getting Started Using Pro Tools ............................................................ 3
  - Book III: Recording Audio .................................................................................... 3
  - Book IV: Editing Audio ......................................................................................... 3
  - Book V: Managing MIDI ......................................................................................... 4
  - Book VI: Mixing in Pro Tools ................................................................................ 4
  - Book VII: Mastering with Pro Tools ....................................................................... 4
  - Book VIII: Getting Your Music out to the Masses ................................................ 5
- Icons Used in This Book ......................................................................................... 5
- Where to Go from Here ......................................................................................... 5

## Book I: Home Recording Basics ..................................... 7

### Chapter 1: Discovering What You Need ......................... 9

- Eyeing the Big Picture .............................................................................................. 9
- Focusing on the Details ........................................................................................... 9
  - Interpreting input devices ..................................................................................... 10
  - Deciphering direct boxes ....................................................................................... 12
  - Perusing the preamp ............................................................................................. 12
- Meeting the Mixer .................................................................................................... 14
  - Managing the MIDI controller ............................................................................. 14
- Recognizing the Recorder ....................................................................................... 16
  - Digital recorders .................................................................................................. 16
  - The computer ....................................................................................................... 18
- Signing On to Signal Processors ........................................................................... 21
  - Equalizers (EQ) .................................................................................................... 21
  - Dynamic processors ............................................................................................... 23
  - Effects processors ................................................................................................ 24
  - Monitors ................................................................................................................ 26
- Mastering Media ....................................................................................................... 28
  - CD .......................................................................................................................... 29
  - Computer files ....................................................................................................... 29

### Chapter 2: Getting Connected: Setting Up Your Studio .... 31

- Making Connections ............................................................................................... 31
- Analog ....................................................................................................................... 32
- Stereo/TRS ............................................................................................................... 33
- Digital ........................................................................................................................ 36
Working Efficiently ........................................................................................38
Taming heat and dust ..................................................................................40
Monitoring your monitors ........................................................................41
Optimizing Your Room .............................................................................41
Sound isolation .......................................................................................42
Sound control ..........................................................................................44

Chapter 3: Meeting the Mixing Board ........................................................51
Meeting the Many Mixer Types ................................................................51
Analog mixer ............................................................................................52
Digital mixer ............................................................................................52
The computer control surface ...............................................................53
Understanding Mixer Basics ....................................................................55
Channel strip ............................................................................................55
Input jack ..................................................................................................55
Insert jack ...............................................................................................56
Trim knob ...............................................................................................57
Equalization ............................................................................................58
Auxiliary (Aux) Send knobs ..................................................................58
Pre/Post switch .......................................................................................60
Pan knob ..................................................................................................60
Mute switch ............................................................................................60
Solo switch .............................................................................................61
Assign switches ......................................................................................61
Faders .......................................................................................................61
Routing/Busing ........................................................................................61
Master fader ............................................................................................62
Sub (submix) faders ................................................................................62
Solo/Mute switches ................................................................................62
Control Room level knob .......................................................................64
Phones knob ............................................................................................64
Auxiliary (Aux) Send knobs ..................................................................64
Auxiliary (Aux) Return knobs ...............................................................64
Aux Assign .............................................................................................64
Master Level meters ...............................................................................65
Output Jacks .............................................................................................65
Master Out jacks ....................................................................................66
Phones jack ..............................................................................................66
Monitors ..................................................................................................66
Direct Out jacks .....................................................................................66
Aux Return jacks ...................................................................................67
Patch Bay ..................................................................................................67

Chapter 4: MIDI and Electronic Instruments ..............................................69
Meeting MIDI ............................................................................................70
Perusing MIDI ports ................................................................................70
Understanding MIDI channels ..............................................................72
Appreciating MIDI messages .................................................................73
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing modes</td>
<td>74</td>
</tr>
<tr>
<td>General MIDI</td>
<td>75</td>
</tr>
<tr>
<td>Getting Started with MIDI</td>
<td>76</td>
</tr>
<tr>
<td>Gearing up</td>
<td>76</td>
</tr>
<tr>
<td><strong>Chapter 5: Understanding Microphones</strong></td>
<td><strong>85</strong></td>
</tr>
<tr>
<td>Meeting the Many Microphone Types</td>
<td>85</td>
</tr>
<tr>
<td>Construction types</td>
<td>86</td>
</tr>
<tr>
<td>Polarity patterns</td>
<td>89</td>
</tr>
<tr>
<td>Buying the Right Microphone for You</td>
<td>94</td>
</tr>
<tr>
<td>How many, what kind</td>
<td>95</td>
</tr>
<tr>
<td>Detailing applications</td>
<td>96</td>
</tr>
<tr>
<td>Partnering with preamps</td>
<td>98</td>
</tr>
<tr>
<td>Considering compressors</td>
<td>100</td>
</tr>
<tr>
<td>Preamp, compressor, and equalizer combos</td>
<td>100</td>
</tr>
<tr>
<td>Analyzing some microphone accessories</td>
<td>101</td>
</tr>
<tr>
<td>Caring for Your Microphones</td>
<td>103</td>
</tr>
<tr>
<td>Daily care</td>
<td>104</td>
</tr>
<tr>
<td>Storing</td>
<td>104</td>
</tr>
<tr>
<td><strong>Book II: Getting Started Using Pro Tools</strong></td>
<td><strong>107</strong></td>
</tr>
<tr>
<td><strong>Chapter 1: Configuring Your Computer</strong></td>
<td><strong>109</strong></td>
</tr>
<tr>
<td>Using Pro Tools on a Mac</td>
<td>109</td>
</tr>
<tr>
<td>Understanding system requirements</td>
<td>109</td>
</tr>
<tr>
<td>Setting system settings</td>
<td>113</td>
</tr>
<tr>
<td>Installing the program</td>
<td>114</td>
</tr>
<tr>
<td>Using Pro Tools on a PC</td>
<td>115</td>
</tr>
<tr>
<td>Understanding system requirements</td>
<td>115</td>
</tr>
<tr>
<td>Preparing to install Pro Tools software</td>
<td>118</td>
</tr>
<tr>
<td>Connecting your hardware</td>
<td>122</td>
</tr>
<tr>
<td>Installing the program</td>
<td>122</td>
</tr>
<tr>
<td>Keeping Bugs at Bay: Good Habits To Get Into</td>
<td>123</td>
</tr>
<tr>
<td>Back up your data often (and more than once)</td>
<td>123</td>
</tr>
<tr>
<td>Back up your system drive</td>
<td>124</td>
</tr>
<tr>
<td><strong>Chapter 2: Setting Up Your Hardware</strong></td>
<td><strong>127</strong></td>
</tr>
<tr>
<td>Mbox</td>
<td>128</td>
</tr>
<tr>
<td>Following the ins and outs of the Mbox</td>
<td>129</td>
</tr>
<tr>
<td>Hooking up the Mbox</td>
<td>130</td>
</tr>
<tr>
<td>Digi 001</td>
<td>132</td>
</tr>
<tr>
<td>Discovering the ins and outs of the Digi 001</td>
<td>133</td>
</tr>
<tr>
<td>Hooking up the Digi 001</td>
<td>133</td>
</tr>
<tr>
<td>Digi 002 Rack</td>
<td>135</td>
</tr>
<tr>
<td>Discovering the ins and outs of the Digi 002 Rack</td>
<td>136</td>
</tr>
<tr>
<td>Hooking up the 002 Rack</td>
<td>136</td>
</tr>
</tbody>
</table>
Digi 002 .................................................................138
Déjà vu-ing the ins and outs of the Digi 002 .........................139
Examining control surface features .....................................139
Hooking up the 002 ......................................................143

Chapter 3: Examining Software Basics .................................145
Keeping Software Straight ..............................................145
Looking at LE and TDM versions ......................................145
Distinguishing between software versions ..........................146
Differences between Macs and PCs .................................146
Getting Set Up ...............................................................147
Setting hardware settings ..............................................147
Playing with the Playback Engine settings ...........................149
The ins and outs of inputs and outputs ..............................150
Dealing with Sessions ....................................................152
Creating a new session ..................................................152
Opening sessions ..........................................................154
Saving Sessions ............................................................154
Creating a session template ............................................157
Getting to know Audio and MIDI Files ...............................159
Understanding audio files ..............................................159
Meeting MIDI files ........................................................159
Finding your files ..........................................................160

Chapter 4: Understanding the Pro Tools Windows ..............163
Tackling the Transport Window .......................................163
Adjusting the Transport window ......................................164
Basic controls .............................................................164
Counters ......................................................................167
Expanded ......................................................................167
MIDI controls .............................................................169
Examining the Edit Window .............................................171
Taking a look at track controls .......................................171
Examining edit modes ....................................................175
Zeroing in on Zoom controls ..........................................176
Elucidating edit tools .....................................................176
Looking at Counter displays .........................................178
Evaluating the Event Edit area ........................................179
The Black Bar hodgepodge .............................................180
Looking at lists ............................................................182
Rulers rule! .................................................................185
Managing the Mix Window .............................................187
Checking out channel strips ..........................................187
Expanding the view of the channel strips .........................192
Looking at lists: The Mix Window variant .........................194
## Table of Contents

### Chapter 5: Importing and Exporting Files
- Importing into a Session ................................................................. 197
  - Importing audio files ................................................................. 197
  - Importing MIDI files ............................................................... 202
  - Importing tracks .................................................................... 204
- Exporting from a Session ............................................................... 208
  - Exporting audio .................................................................. 208
  - Exporting MIDI .................................................................. 212
- Managing Files ............................................................................ 213
  - Compacting files ................................................................. 213
  - Deleting unwanted files ...................................................... 215
  - Backing up data ................................................................. 215

### Book III: Recording Audio
- Chapter 1: Taking Care of Tracks .............................................. 219
  - Understanding Tracks in Pro Tools ......................................... 219
    - Track types ................................................................. 219
    - Track formats ............................................................ 220
  - Setting Up Tracks ................................................................. 220
    - Creating new tracks ...................................................... 220
    - Duplicating tracks ....................................................... 221
    - Naming tracks ............................................................ 221
    - Assigning inputs and outputs ...................................... 222
  - Altering Your View of Tracks .................................................. 223
    - Showing and hiding tracks ............................................. 223
    - Assigning track color .................................................... 225
    - Changing track size ....................................................... 226
    - Moving tracks around .................................................. 227
    - Deleting tracks ............................................................. 228
  - Grouping Tracks .................................................................. 228
    - Keeping track of grouped track parameters .................. 228
    - Creating groups ........................................................... 229
    - Enabling groups ........................................................... 230
    - Editing groups .............................................................. 230
    - Linking edit and mix groups .......................................... 232
  - Soloing and Muting ................................................................. 233
  - Managing Track Voices ........................................................... 233
    - Assigning voices .......................................................... 234
    - Setting voice priority ..................................................... 234
    - Freeing up a voice from a track ......................................... 235
Chapter 2: Miking: Getting a Great Source Sound .............................................. 237
   Tracing Typical Microphone Techniques .................................................... 237
     Spot ..................................................................................................... 238
     Distant ................................................................................................. 239
     Ambient .............................................................................................. 239
     Stereo .................................................................................................. 240
     Mic combinations .............................................................................. 244
   Taming Transients ....................................................................................... 245
     Setting your levels properly ............................................................. 245
     Placing mics properly ....................................................................... 246
     Compressing carefully ...................................................................... 246
   Setting Up Your Mics: Some Suggestions ................................................. 248
     Vocals .................................................................................................. 249
     Backup vocals .................................................................................... 251
     Electric guitar .................................................................................... 252
     Electric bass ....................................................................................... 255
     Acoustic guitars and such ................................................................ 256
     Drum set ............................................................................................. 257
     Hand drums ........................................................................................ 264
     Percussion .......................................................................................... 265

Chapter 3: Preparing to Record ................................................................. 267
   Recognizing Record Modes ........................................................................ 267
     Non-destructive Record mode ......................................................... 268
     Destructive Record mode ................................................................. 268
     Loop Record mode ............................................................................ 268
     QuickPunch Record mode ................................................................ 269
   Dealing with Disk Allocation ........................................................................ 270
     Allocating hard-drive space ............................................................. 270
     Using multiple audio drives ............................................................. 271
   Enabling Recording ..................................................................................... 272
     Record-enabling ................................................................................. 272
     Using Latch Record Enable mode ................................................... 273
     Running Record Safe mode ................................................................ 274
   Setting Levels ............................................................................................... 275
   Setting a Record Range ........................................................................... 276
   Monitoring Your Tracks ........................................................................... 277
     Setting up monitoring ....................................................................... 277
     Choosing a monitor mode .................................................................. 277
     Linking and unlinking Record and Playback faders ...................... 278
     Adjusting the monitoring latency .................................................... 279
     Using low latency monitoring .......................................................... 280
   Creating a Click Track ................................................................................. 281
     Setting the tempo ............................................................................. 281
     Choosing the meter .......................................................................... 282
     Configuring your device .................................................................. 283
     Enabling a click track ....................................................................... 284
     Hearing your click .......................................................................... 284
     Setting up tempo and meter events .................................................. 286
# Table of Contents

## Chapter 4: Recording Audio ..........................................................289

- Recording Tracks ............................................................................289
  - Recording a single track .........................................................289
  - Managing multiple tracks at once .........................................292
  - Using pre- and post-rolls .........................................................292
- Playing Back Your Tracks ...............................................................295
  - Playing recorded tracks .........................................................295
  - Setting scrolling options ........................................................296
  - Listening to playback loops ....................................................297
  - Using the Scrub feature ..........................................................298
- Doing Additional Takes ..................................................................299
  - Starting over from scratch ......................................................299
  - Punching in and out ...............................................................300
  - Loop recording ........................................................................303
  - Using QuickPunch ...................................................................304
  - Overdubbing: Recording additional tracks ............................304
  - Recording to playlists .............................................................306
- Getting Rid of Unwanted Takes .....................................................311
  - Canceling your performance ..................................................311
  - Undoing your take ....................................................................312
  - Clearing the file from the Audio Regions list ...........................312

## Book IV: Editing Audio .................................................................315

## Chapter 1: Audio Editing Basics ....................................................317

- Understanding Pro Tools Editing ..................................................317
  - Nondestructive editing ...........................................................318
  - Editing during playback .........................................................318
- Getting to Know Region types .......................................................318
- Viewing Regions ............................................................................320
  - Selecting the track view ..........................................................320
  - Adjusting the track height .......................................................321
  - Assigning region-name and time-location displays .................322
  - Zooming in and out ...............................................................324
- Understanding Edit Modes ............................................................327
  - Setting the Grid resolution .......................................................329
  - Displaying the grid lines ........................................................330
- Working (Okay, Playing) with Playlists .........................................331
  - Creating a new playlist ............................................................332
  - Duplicating a playlist .............................................................332
  - Deleting a playlist ...................................................................332
  - Renaming playlists .................................................................333
  - Choosing playlists ...................................................................333
- Using the Audio Regions list ..........................................................333
  - Selecting regions .....................................................................334
Using the Audio Regions list pop-up menu ........................................334
Displaying region information .............................................................336
Managing undos ..................................................................................336
Setting levels of Undo ........................................................................336
Performing Undos .............................................................................337
Knowing when you can no longer Undo .........................................338

Chapter 2: Selecting Material to Edit ....................................................339
Selecting Track Material ........................................................................339
Selecting part of a region ....................................................................340
Selecting across multiple tracks .........................................................342
Selecting an entire region ...................................................................342
Selecting two regions and any space between them ..........................342
Selecting an entire track ....................................................................343
Selecting all regions in all tracks ..........................................................343
Selecting on the fly ............................................................................343
Selecting using the Selection Indicator fields .....................................344
Making a selection using the Tab to Transients function ......................345
Making Changes to Your Selection .......................................................345
Changing a selection’s length ..............................................................346
Nudging selections .............................................................................346
Extending selection lengths ................................................................348
Moving and extending selections between tracks ...............................349
Managing Memory Locations ..............................................................350
Dealing with the dialog box .................................................................350
Creating memory locations .................................................................352
Getting to know the Memory Locations window .................................356
Recalling memory locations ...............................................................358
Editing memory locations ..................................................................359
Playing Selected Material .................................................................362
Playing your selection ........................................................................362
Using pre- and post-rolls ....................................................................362
Auditioning Start and End points .........................................................363
Looping your selection’s playback .......................................................363

Chapter 3: Getting into Editing ............................................................365
Editing Regions ....................................................................................365
Creating regions ..................................................................................366
Healing regions ....................................................................................368
Placing regions in tracks .....................................................................370
Using region Synch points ..................................................................372
Aligning regions ..................................................................................374
Trimming regions ................................................................................376
Moving regions ....................................................................................380
Locking regions ....................................................................................384
Quantizing regions ..............................................................................385
Muting/Unmuting regions .................................................................386
Splitting stereo tracks .........................................................................386
Setting the Wait for Note option ......................................................436
Monitoring MIDI inputs .....................................................................437
Recording MIDI tracks ......................................................................437
Playing Back Your Tracks ................................................................438
Playing recorded tracks ....................................................................438
Setting scrolling options ...................................................................438
Changing sounds ...............................................................................439
Getting Rid of Unwanted Takes .................................................................440
Canceling your performance ...........................................................440
Undoing your take .............................................................................440
Clearing the file from the MIDI Regions list ...................................441
Overdubbing MIDI Performances ..............................................................442
Using MIDI Merge/Replace ...............................................................442
Punching in and out ..........................................................................443
Punching MIDI on-the-fly ..................................................................446
Loop recording ..................................................................................447
Recording System-Exclusive Data ...........................................................449

Chapter 3: Editing MIDI Data .................................................................451
Working with MIDI Tracks ..................................................................451
Taking a look at track views .............................................................451
Selecting track material ....................................................................454
Recognizing regions ..........................................................................455
Setting MIDI patches on tracks ........................................................456
Dealing with Note Chasing ..................................................................456
Editing MIDI in the Edit Window ...............................................................457
Perusing the Pencil tools ..................................................................457
Custom note duration .......................................................................460
Adding MIDI events ..........................................................................460
Deleting MIDI data ...........................................................................462
Changing MIDI events .......................................................................463
Editing program data ..........................................................................466
Changing continuous controller data .............................................467
Using the Smart Tool .........................................................................469
Exploring MIDI Events ........................................................................470
Exploring the MIDI Event List window ............................................470
Editing in the MIDI Event list ............................................................474

Chapter 4: Performing MIDI Operations ..................................................479
Getting Used to the MIDI Operations Menu ..............................................479
Performing MIDI Operations .................................................................480
Quantize ..............................................................................................482
Groove Quantize ...............................................................................483
Restore Performance ..........................................................................485
Flatten Performance ...........................................................................486
Change Velocity ................................................................................487
Change Duration ................................................................................488
Transpose ...........................................................................................489
Table of Contents

Select Notes .................................................................................................................. 490
Split Notes ...................................................................................................................... 491
Input Quantize ................................................................................................................. 492

Book VI: Mixing in Pro Tools ......................................................................................... 493

Chapter 1: Mixing Basics ............................................................................................ 495

- Understanding Mixing ............................................................................................. 495
- Managing Levels as You Work ................................................................................. 496
- Getting Started Mixing Your Song ............................................................................ 497
- Mixing In Pro Tools ..................................................................................................... 498
  - Using the 002 control surface ................................................................................. 498
  - Using a MIDI controller ......................................................................................... 498
  - Using a digital mixer .............................................................................................. 499
  - Using an analog mixer .......................................................................................... 499
- Using the Stereo Field ............................................................................................... 500
  - Left or right ........................................................................................................... 500
  - Front or back ........................................................................................................ 502
- Adjusting Levels: Enhancing the Emotion of the Song ...................................... 503
  - Dynamics ............................................................................................................... 504
  - The arrangement ..................................................................................................... 505
- Tuning Your Ears ........................................................................................................ 506
  - Listening critically ................................................................................................. 506
  - Choosing reference CDs ....................................................................................... 507
  - Dealing with ear fatigue ....................................................................................... 508
  - Making several versions ....................................................................................... 508

Chapter 2: Setting Up Your Mix ..................................................................................... 509

- Revisiting the Mix Window ......................................................................................... 509
- Getting to Know Signal Flow ..................................................................................... 511
- Rounding Out Your Routing ...................................................................................... 512
  - Using a master fader .............................................................................................. 513
  - Adding auxiliary inputs ......................................................................................... 514
  - Inserting inserts ..................................................................................................... 515
  - Setting up sends .................................................................................................... 516
- Accessing Output Windows ....................................................................................... 520
  - Tackling Track Output windows ........................................................................... 520
  - Setting up Send Output windows ......................................................................... 523
- Playing with Plug-ins ............................................................................................... 524
  - Real Time Audio Suite (RTAS) ............................................................................. 524
  - AudioSuite ............................................................................................................. 527
  - Using AudioSuite Plug-ins .................................................................................... 530
- Processing with External Effects ............................................................................. 530
  - Creating a hardware insert .................................................................................... 531
  - Connecting your external device ......................................................................... 531
  - Routing your track ............................................................................................... 533
Chapter 3: Using Equalization .................................................. 535

Exploring Equalization .......................................................................................... 535
Parametric ................................................................................................................. 535
Low shelf/high shelf ............................................................................................... 536
Low-pass/high-pass ................................................................................................. 536
Dialing in EQ ........................................................................................................... 536
Inserting an EQ plug-in in a track ........................................................................ 537
Perusing Pro Tools EQ options .............................................................................. 538

Equalizing Your Tracks ......................................................................................... 540
General guidelines .................................................................................................. 541
Vocals ......................................................................................................................... 542
Guitar ......................................................................................................................... 543
Bass ............................................................................................................................. 543
Drums ......................................................................................................................... 544
Percussion .................................................................................................................. 545
Piano .......................................................................................................................... 546

Chapter 4: Digging into Dynamics Processors ............................................... 547

Connecting Dynamics Processors ....................................................................... 547
Introducing Compressors ....................................................................................... 548
Getting to know compressor parameters ............................................................. 548
Getting started using compression ....................................................................... 550
Using compression .................................................................................................. 551
Looking into Limiters .............................................................................................. 554
Understanding limiter settings .............................................................................. 554
Setting limits with the limiter ................................................................................. 555
Introducing Gates ................................................................................................... 556
Getting to know gate parameters ........................................................................... 556
Getting started using gates ..................................................................................... 557
Examining the Expander ....................................................................................... 557
Playing with expander parameters ....................................................................... 558
Getting started using an expander ......................................................................... 559
Keying into External Keys ...................................................................................... 559
Setting up a side-chain .......................................................................................... 560
Using a side-chain .................................................................................................. 560

Chapter 5: Singling out Signal Processors ...................................................... 563

Routing Your Effects ............................................................................................ 564
Inserting effects ........................................................................................................ 564
Sending signals to effects ....................................................................................... 565
Rolling out the Reverb ............................................................................................ 566
Seeing reverb settings ............................................................................................ 566
Getting started using reverb .................................................................................. 568
Detailing Delay ........................................................................................................ 569
Digging into delay settings .................................................................................... 569
Getting started using delay .................................................................................... 570
Creating Chorus Effects ......................................................................................... 571
# Table of Contents

## Chapter 6: Automating Your Mix

- Understanding Automation ................................................................. 573
  - Audio tracks ....................................................................................... 574
  - MIDI tracks ......................................................................................... 574
- Accessing Automation Modes .............................................................. 574
- Setting Automation Preferences ......................................................... 576
- Enabling Automation ............................................................................. 578
  - Suspending or enabling automation across all tracks ......................... 578
  - Suspending automation for an individual track .................................. 579
- Writing Automation ............................................................................... 580
  - Writing automation on a track ......................................................... 580
  - Writing plug-in automation .............................................................. 581
  - Writing send automation .................................................................. 582
- Viewing Automation ............................................................................... 583
- Drawing Automation ............................................................................. 583
- Thinning Automation ............................................................................ 585
  - Automatically thinning data ............................................................. 585
  - Using the Thin command .................................................................. 585
- Editing Automation Data ........................................................................ 586
  - Using editing commands .................................................................. 586
  - Editing with (surprise) edit tools ...................................................... 588

## Chapter 7: Making Your Mix

- Submixing by Recording to Tracks ....................................................... 591
- Mixing In-the-Box ................................................................................... 593
  - Examining bounce options ............................................................... 593
  - Performing the bounce ..................................................................... 595
- Using an External Master Deck ............................................................ 596

## Book VII: Mastering with Pro Tools

- Chapter 1: Mastering Basics ................................................................. 599
  - Demystifying Mastering ..................................................................... 599
    - Processing ....................................................................................... 600
    - Sequencing ....................................................................................... 601
    - Leveling .......................................................................................... 601
  - Getting Ready to Master ...................................................................... 601
  - Paying a Pro or Doing It Yourself ...................................................... 602
  - Hiring a Professional Mastering Engineer .......................................... 603
- Chapter 2: Mastering Your Music ......................................................... 605
  - Considering General Guidelines ......................................................... 605
  - Setting up a Mastering Session .......................................................... 606
  - Optimizing Dynamics ........................................................................ 608
  - Perfecting Tonal Balance .................................................................... 610
  - Balancing Levels ............................................................................... 612
Introduction

Chances are that after you became interested in recording some music, you started hearing about a great software program called Pro Tools. You may have read an article in which an artist said that he or she records with Pro Tools, or you heard that such-and-such major recording studio uses Pro Tools, or a friend told you that you need Pro Tools to record professional-quality music. Well, lots of great recording programs are available, but without a doubt the most popular — and one of the most powerful — is Pro Tools.

Pro Tools is an audio and Musical Instrument Digital Interface (MIDI) recording program. Aside from recording audio and MIDI tracks, Pro Tools offers some of the most powerful editing functions available, allowing you to tweak your recordings to a high level of detail, clarity, and accuracy. You also get excellent mixing abilities that help you mix your tracks together, EQ (equalize) them, and apply effects. This all-in-one program lets you control your music from start to finish.

About This Book

*Pro Tools All-in-One Desk Reference For Dummies* not only introduces you to Pro Tools audio- and MIDI-recording software, it also presents basic multitrack recording techniques. You find out about the many Pro Tools features and functions and ways to use this program to create the best possible recordings of your music.

This book also acquaints you with the basic audio-engineering skills needed to make high-quality recordings. These skills can save you countless hours of experimenting and give you more time to actually record your music (what a concept).

In this book . . .

✦ You explore the Pro Tools windows and menus.
✦ You get a handle on all the useful functions within Pro Tools.
✦ You discover the ins and outs of using the various pieces of equipment in your studio.
Not-So-Foolish Assumptions

✦ You explore tried-and-true engineering techniques, such as microphone choice and placement.
✦ You find out about the concepts of multitracking, mixing, and mastering.
✦ You get a chance to turn your music into complete songs and discover how to assemble and release an album.

Pro Tools All-in-One Desk Reference For Dummies puts you on the fast track toward creating great-sounding CDs by cutting to the chase and showing you skills you can use right away. I don’t bother you with tons of technical jargon or useless facts.

Not-So-Foolish Assumptions

I have to admit that when I wrote this book, I made a couple of assumptions about you, the reader (and we all know what happens when we ASSume anything). But what the heck, I did it anyway. First, I assume that you’re interested in recording your music (or someone else’s) with Pro Tools LE software.

I also assume that you’re relatively new at the recording game and not yet a seasoned professional. Of course, if you are an audio engineer — maybe one making the leap from analog to digital — this book offers a great brush-up on many audio-engineering fundamentals and how they apply to the basic functions of Pro Tools.) Oh, and I assume that you play a musical instrument or sing — or are at least familiar with how instruments function and how sound is produced.

Other than these things, I don’t assume that you play a certain type of music or that you ever intend to try to “make it in the music business” (or even that you want to treat it as a business at all).

I almost forgot one other foolish assumption regarding your computer: The Start/Windows key (often called just the Windows key in Windows books) is the key on a Microsoft keyboard (just outward from each Alt key on the bottom key row) that is labeled only with a Windows logo. This key can activate various Pro Tools features, but non-Microsoft keyboards don’t have it. If you have a PC without a Microsoft-style keyboard and it doesn’t have that pesky Start/Windows key, don’t worry: I show you other possible ways to activate the same features.

How This Book Is Organized

Pro Tools All-in-One Desk Reference For Dummies is organized so you can find the information you want quickly and easily. Each book contains chapters that cover a specific part of the recording process, and I briefly describe each book in the following sections.
How This Book Is Organized

**Book I: Home Recording Basics**

Book I introduces you to the basics of home recording. Chapter 1 introduces you to the individual components of a home studio, and explains what everything is for. Chapter 2 shows you how to make the connections — both analog and digital — that you need when you're trying to get sound from one place to another. Chapter 3 acquaints you with the mixing board, introducing you to its many functions. Chapter 4 demystifies MIDI and gives you practical advice on how to use this powerful communication tool to enhance your music. Chapter 5 puts you inside the world of microphones. You get a chance to understand what kind of mics are available, how they work, and which ones work best for different situations.

**Book II: Getting Started Using Pro Tools**

Book II leads you into the Pro Tools world, examining the software and the Digidesign hardware that you need in order to run it. Chapter 1 helps you configure your computer to run Pro Tools — and walks you through the process of installing the software on both Macs and PCs. Chapter 2 introduces you to the available Digidesign hardware options — and shows you where and how to plug it in. Chapter 3 helps you make your hardware and software work together and introduces you to the concept of sessions — the standard building block of the Pro Tools song-file system. In Chapter 4, you examine the three windows in Pro Tools — Transport, Edit, and Mix — where you do most of your work. Book II finishes off with Chapter 5, which gets you up to speed on file formats and compatibility in Pro Tools. You discover ways to import and export various file types.

**Book III: Recording Audio**

Book III gets into the meat of actually recording music. Chapter 1 explains tracks in Pro Tools and discusses setting them up properly. Chapter 2 explores the fundamentals of getting a good source sound from microphones. You discover which mics work best for certain instruments and how to place those microphones for the best sound. Chapter 3 helps you get ready to record your first track. You discover how to set levels, enable recording, and monitor your input signals so that you can hear yourself. This book ends with Chapter 4, in which you begin the process of recording single or multiple tracks in Pro Tools. Chapter 4 also shows you how to listen critically (but practically) to those tracks when you play them back.

**Book IV: Editing Audio**

Book IV is all about editing the audio tracks that you record. Chapter 1 explains the basics of editing audio in Pro Tools, from knowing which of the four edit modes to use on your music to using the Audio Region list and playlists to find the material to edit. Chapter 2 gets you comfortable with
selecting the material you want to edit. You find out how to change a selection and hear it before you edit it — as well as how to use memory locators to move quickly from one part of your session to another. Chapter 3 gets to the heart of editing in Pro Tools. You get used to working with regions (the standard on-screen representations of the music you recorded in Pro Tools), using the editing commands, and using looped material to turn your raw tracks into usable pieces. This book ends with Chapter 4, in which you step up your editing prowess by exploring the Smart tool and other advanced editing features.

**Book V: Managing MIDI**

Although Musical Instrument Digital Interface (MIDI) is in its infancy in Pro Tools, you can still do a lot with this powerful communication protocol. Chapter 1 helps you set up your MIDI devices. Chapter 2 gets you started capturing MIDI data by showing you how to create MIDI tracks, and record your performance. Chapter 3 presents the many Pro Tools editing functions that you can use to improve on your performance. Chapter 4 explores MIDI operations — specialized commands that you can use to transform your MIDI data in numerous ways.

**Book VI: Mixing in Pro Tools**

Book VI helps you take all your individual tracks and blend them together to create a finished song. Chapter 1 introduces you to the process of multitrack mixing and helps you prepare yourself to mix. Chapter 2 walks you through the process of setting up your Pro Tools session for mixing. Chapter 3 details equalization (EQ) and how you can use it to make all your instruments fit together well. Chapter 4 examines four types of dynamics processors — compressors, limiters, gates, and expanders. These processors are essential to getting your instruments to “sit in the mix,” (sound good together) and this chapter helps you use them properly. Chapter 5 guides you into the world of effect processors like reverb and delay. These effects are useful for adding life to your productions and this chapter shows you some ways to use them effectively. Chapter 6 covers one of the most useful things about recording with Pro Tools: You can automate the elements of your mix — levels, panning, effects, and so on. Chapter 7 finishes off Book VI by showing you how to mix to a stereo file.

**Book VII: Mastering with Pro Tools**

Book VII focuses on the often-misunderstood process of mastering music. Chapter 1 details what mastering is and helps you determine whether you want to give it a try or let a professional do it for you. Chapter 2 provides a step-by-step plan to help you in the event that you want to try your hand at the mastering game.
Book VIII: Getting Your Music out to the Masses

Book VIII helps you break out of your cocoon so that you can share your finished music with others. Chapter 1 covers how to choose CD-Rs and burn your music to them. You also explore the best ways to make copies of your CDs. If you’re looking to cultivate an audience in cyberspace, Chapter 2 helps you make your music available on the Internet. You get a chance to format your music for Internet distribution and discover some ways to promote your band.

Icons Used in This Book

Like all For Dummies authors, I use a few icons to help you along your way.

MEMBER

Certain techniques are very important and deserve remembering. This icon gives you a gentle nudge to keep you on track.

TECHNICAL STUFF

Throughout the book, this icon shows up in instances where I include technical background on certain subjects. When you see this icon, brace yourself for some dense information.

Tip

This icon highlights expert advice and ideas that can help you produce better recordings.

WARNING!

This icon warns you ahead of time about instances when you could damage your equipment, your ears, or your song.

Where to Go from Here

This book is set up so that you can read it cover to cover (and progressively build on your knowledge) or jump around and read only those parts that interest you at the time. For instance, if you’re getting ready to record a mix of your song and need some ideas on how to use equalization (EQ), go to
Book VI, Chapter 3. If you’re new to recording with Pro Tools and want to know how to set up a session, check out Book II, Chapter 3. And if you’re completely new to the whole concept of home recording, start with Book I, Chapter 1.

I recommend starting with Book I, Chapter 1 to get yourself up to speed on my way of thinking. Book I, Chapter 1 can also help you understand some of what I discuss in later chapters. Wherever you start and wherever you want to go, you’re in for an adventure...
"I laid down a general shuffling sound over dubbed with periodic coughing, some muted talking files, and an awesome ringing cell phone loop."
Contents at a Glance

Chapter 1: Discovering What You Need
Chapter 2: Getting Connected: Setting Up Your Studio
Chapter 3: Meeting the Mixing Board
Chapter 4: MIDI and Electronic Instruments
Chapter 5: Understanding Microphones
Chapter 1: Discovering What You Need

In This Chapter
- Understanding the components of a home studio
- Discovering how each component contributes to the final sound

Whether you use a PC- or Mac-based system for your Pro Tools studio, your home recording system of choice employs much of the same basic technology. In fact, your simple Pro Tools studio consists of the same basic components as a typical million-dollar professional studio complex.

In this chapter, you discover the purpose of each individual component of a home recording studio — and you also discover how each of these components relates to the quality of sound you ultimately get from your studio. This knowledge will help you to spend the right amount of money on the right stuff. (See Book 2, Chapter 1 for more on purchasing gear.)

Eyeing the Big Picture

In spite of what you may surmise from this chapter — with its long list of equipment — you only need a few things in order to do multitrack recording with Pro Tools. This simple list comprises instruments and microphones (called input devices), a computer, a Digidesign audio interface, Pro Tools software, and monitors (speakers, to you home-stereo enthusiasts). No matter how complicated your system becomes and how many pieces of gear you end up accumulating, your studio will still consist of these basic parts.

This chapter breaks down recording systems into the components they have to have — but you may not need to purchase every component separately to get a great-sounding system. Many of these components come bundled together. For example, your Digidesign hardware will include at least two preamps or you may find speakers that come with a power amp inside them.

Focusing on the Details

As you begin to build your home studio, you’ll notice a long list of components — okay, let’s go ahead and call them “extras” — lurking within
the Top Four of computer, interface, software, and monitors. In this section, I focus on these details so you can understand just what roles they play in your system.

As you get more and more involved in recording, you’ll find you can add almost any of these components to your existing system to expand and enhance what you can do.

**Interpreting input devices**

All your expensive recording gear is useless if you have nothing to plug into it. This is where the input device comes into play. An *input device* is, simply, any instrument, microphone, or sound module that produces or delivers a sound to the recorder.

**Instruments**

Your electric guitar, bass, synthesizer, and drum machines are typical of the instruments that plug into the interface and represent most of the input devices that you use in your studio. The synthesizer and drum machine can plug directly into the Line In inputs of your interface, whereas your electric guitar and bass need a direct box (or its equivalent) to plug into first. (In the case of your Digidesign interface, you need to use one of the inputs with a preamp.)

A *direct box* is an intermediary device that allows you to plug your guitar directly into the mixer without going through your amp first. (For more on direct boxes, see the upcoming section, “Deciphering direct boxes.”) Check out Figure 1-1 for an example of an instrument-input device.

**Figure 1-1:**

An instrument-input device, which you can plug right into the mixer.

**Microphone**

A microphone (abbreviated *mic*) enables you to record the sound of a voice or an acoustic instrument — sound sources that, last time we checked, couldn’t be plugged directly into the interface. A microphone converts
sound waves into electrical energy that can be understood by the interface. I detail the several types of microphones in Book 1, Chapter 5. Check out Figure 1-2 for a look at a microphone.

**Sound modules**

*Sound modules* are special kinds of synthesizers and/or drum machines. What makes a sound module different from a regular synthesizer or drum machine is that these contain no triggers or keys that you can play. Instead, sound modules are controlled externally by another synthesizer’s keyboard or by a *Musical Instrument Digital Interface (MIDI) controller* (a specialized box designed to control MIDI instruments). Sound modules have MIDI ports (MIDI jacks) to enable you to connect them to other equipment.

---

**Figure 1-2:**
A microphone. Use this when your instrument can’t plug into the mixer directly.
Often sound modules are *rack-mountable*, meaning they have screw holes and mounting ears so you can put them into an audio component rack. Some controllers, however, are not rack-mountable; Figure 1-3, for example, shows a drum module that rests on a stand or tabletop.

![Diagram](image)

**Figure 1-3:** The sound module can be plugged right into the mixer but has to be played by another source.

---

### Deciphering direct boxes

A direct box (or DI box, short for *Direct Induction*) is used to connect your guitar or bass directly into the mixer without having to run it through your amp first. A direct box’s purpose is twofold: to change the guitar’s impedance level so the mixer can create the best sound possible, and to change the nature of the connection from unbalanced (quarter-inch) to balanced (XLR) so you can use a long cord without creating noise. (For more on cord types and balanced-versus-unbalanced signals, go to Book 1, Chapter 2.)

For most home recordists, the main purpose of a direct box is to act as an impedance transformer. You’re unlikely to need a long run of cords from your guitar to your mixer. Without a direct box changing your impedance levels, your guitar signal may sound thin or may have excess noise.

---

### Perusing the preamp

Microphones produce a lower signal level than do line-level devices (synthesizers, for example); thus they need to have their signal level increased. For this purpose, you need a *preamp*, a device that boosts a microphone’s output. Preamps can be internal or external, meaning they could reside within your mixer or be a separate unit that you have to plug in between your microphone and mixer.
The preamp is one of the most crucial elements of a recording system. It can affect your instrument’s sound significantly. Most professional recording studios have a variety of preamps to choose from, and engineers use a particular preamp based upon the type of sound they’re trying to capture.

The three basic types of preamps available are solid state, tube, and hybrid (you can find out more about preamps in Book 1, Chapter 5).

**Solid-state**

*Solid-state preamps* use transistors to boost the level of the microphone or instrument. Top-quality (expensive) solid state preamps are generally designed to produce a sound that’s clear and accurate (GML and Crane Song brands, for instance). Solid-state preamps can also be designed to add a pleasing distortion to the music (Neve and Neve-clone preamps, for example). Many recording professionals prefer the clear and accurate sound of a solid-state preamp for acoustic or classical music or any situation when capturing a very natural sound is important. The preamps in your Digidesign interface are solid state, though not as high a quality as many of the more-expensive external preamps.

**Tube**

Since the beginning of the digital recording revolution, professionals have been complaining about the harshness of digital recording. As a result, many digital-recording pros prefer classic *tube preamps* because they can add warmth to the recording. This warmth is actually distortion, albeit a pleasing one. All-tube preamps are generally very expensive, but they are highly sought after among digital recording aficionados because of their sound. Tube preamps work well with music when you want to add color to the sound (that is, not produce an accurate representation of the original source sound). No wonder they show up a lot in rock and blues — and they’re great for recording drums. You can also find tube preamps that are clean and open such as those made by Manley Labs.

**Hybrid**

A *hybrid preamp* contains both solid-state and tube components. Most of the inexpensive “tube” preamps that you find in the marketplace are actually hybrids. (These are also called *starved-plate* designs because the tubes don’t run the same level of voltage as expensive tube designs.) These types of preamps are usually designed to add the classic tube warmth to your instrument’s sound. How much the sound is colored by the tubes; how pleasing that colored sound is to the listener’s ears is dependent on the quality of the preamp. Most hybrid preamps allow you to dial in the amount of *character* (pleasing distortion) that you want.
Your Digidesign interface will come with either two (Mbox and Digi 001) or four (Digi 002 and 002 Rack) preamps. If you want to plug in more mics than the number of preamps you have or if you want to be able to produce different sounds from your preamps, you need to buy one or more external preamps, such as the one shown in Figure 1-4.

**Figure 1-4:** An external preamp.

### Meeting the Mixer

The mixer is the heart of any recording system. Take a look at Figure 1-5. Although the mixer may seem daunting with all its knobs, buttons, sliders, and jacks, it’s really one of the most interesting and versatile pieces of equipment that you’ll have in your studio. With the mixer, you can control the level of the incoming signal, adjust the tonal quality of an instrument, blend the signals of two or more instruments together, and a host of other things. And don’t worry; after you read through this book, you’ll get the hang of all those knobs in no time.

For the Pro Tools home recordist (that’s you), the mixer is incorporated into your computer software. (Of course, you can always use an external hardware mixer if you want.) The mixer in Pro Tools does the job well enough that you don’t need an external mixer, although some people prefer having physical faders and knobs to mess with. If you’re a knob-turner and like to physically touch the instrument you’re playing (or, for that matter, the gadget you’re tweaking), then a hardware mixer is your best choice. On the other hand, if you prefer clicking a mouse or typing on a keyboard (the kind with letters on the keys), then choose a software version.

An elegant and inexpensive solution for you knob-twiddlers is a dedicated control surface such as the Mackie Control (shown in Figure 1-6). With this unit, you get your knobs and faders while still using the internal mixer in Pro Tools. This can be an advantage because it eliminates the need for lots of analog-to-digital (ADC) and digital-to-analog (DAC) conversions (not to mention the actual converters, which can cost a lot of money).

### Managing the MIDI controller

If you’re like most home recordists, you’ll end up using some sort of MIDI controller in your studio. (See Book 1, Chapter 4 for more about MIDI.) The purpose of this piece of equipment is to allow the various MIDI instruments to communicate and synchronize with one another.
MIDI (Music Instrument Digital Interface) is a protocol that musical instrument manufacturers (in a rare moment of cooperation) developed to allow one digital instrument to communicate with another. MIDI uses binary digital data, in the form of 1s and 0s, to tell an instrument to play or release a note, to change sounds, and a host of other messages. (Discover more about MIDI in Book 1, Chapter 4.)

MIDI controllers come in many shapes and sizes. The most common are computer software, keyboard, or standalone controllers. These controllers can reside within the computer (Pro Tools, for example, has MIDI capabilities), a keyboard (synthesizer), or a separate box. They enable you to either play, in real time, another instrument or to trigger another instrument with the sequencer, which is a MIDI program that allows you to play an instrument without actually playing (like old-time player pianos). They just need to have MIDI capability and be connected through their MIDI ports (using MIDI cables).
Recognizing the Recorder

The recorder is where your music actually gets, well, recorded. In Pro Tools, your recorder consists of your computer and the software. Sound becomes data and is stored as digital information, as 1s and 0s. Digital recording introduces very little noise into the final sound and can be copied without any loss in that sound quality. (Depending on the bit depth and sample rate you record at, of course. See next section.)

Digital recorders

A digital recorder is included as part of your Pro Tools setup. Digital recorders use two terms to describe the overall quality of the sound that they produce — sampling rate and bit depth.

Sampling rate

The sampling rate refers to the frequency at which the recorder samples the incoming sound source. When a recorder samples a sound, it actually takes a small snapshot of the audio signal. Typical sample rates for digital recorders are 44.1 kHz (the sample rate for audio CDs), 48 kHz, 88.2 kHz, and 96 kHz (the sampling rate for DVD audio). The higher the number, the more samples are taken each second, and the closer the recorded sound is to the original.
What do these numbers mean? Well, the more times per second that a digital recorder samples the sound of the incoming signal, the more of the original sound it includes (which means, among other things, a bigger sound file that takes up more space on your computer). These numbers are described in kHz (kilohertz) — that is, as taking place thousands of times per second. For example, when you record at 48 kHz, the sound is sampled 48,000 times every second. This sounds like an awful lot, but accurate sound requires lots of samples.

**Bit depth**

When you start looking at digital recorders, you’ll hear jargon such as *16-bit* (the bit depth of audio CDs), *20-bit*, *24-bit*, and so forth. This is the **bit depth**, which is described in terms of bits (a bit, short for *Binary digit*, is the basic unit of information in the binary numbering system used by computers). The numbers 16, 20, and 24 relate to the amount of digital information that can be contained in each of those sample rates that I describe in the previous section, “Sampling rate.” The higher the number, the more accurately the sound is represented; most professional audio gear now records at a 24-bit resolution. With that higher number, however, the sound is going to take up more of your digital storage space. This usually isn’t a big deal, though, considering the low cost of huge hard drives.

**A/D and D/A converters**

A third variable that affects how good a digital recorder will sound is the type of *analog-to-digital* (A/D) and *digital-to-analog* (D/A) converters that the recorder uses. The A/D and D/A converters are what actually transform an analog sound source into digital information and back again. They do this by taking small snapshots of the incoming signal (at whatever sampling rate the converter uses) and applying a number to that sample (based upon the bit depth).

For example, suppose that you have a 24-bit converter with a 48-kHz sampling rate. When it senses an auditory signal — a vocal perhaps — the A/D converter takes a snapshot (measurement) of that signal 48,000 times per second (48 kHz). Each of these snapshots is given a value between –8,395,008 and +8,395,008 (24-bit resolution has 16,790,016 possible levels), which will put the vocal sound somewhere on a chart corresponding to a waveform shape. The recorder in turn reads these numbers, and the D/A converter translates these numbers back into an analog waveform again (whew!).

Converting an analog signal into digital data and back again is a highly technical process. You could spend days or even weeks reading about the intricacies of audio conversion. (Check out *Principles of Digital Audio* by Ken C. Pohlmann, published by McGraw-Hill Professional, or *The Art of Digital Audio* by John Watkinson, published by Focal Press, if you’re into this techie stuff.)
The most important thing to remember when considering A/D and D/A converters is how well you like the sound. If the converter sounds good to you, it’s a good converter.

You can buy separate A/D and D/A converters that can sound better than the one included in your Digidesign hardware. Depending on your ears, your engineering skills, and the style of your music, the improvement in sound of external converters can range from barely noticeable to mind-blowing. Before you spend any money on external converters, though, I highly recommend working on your skills as a songwriter, musician, and engineer.

The computer
No matter which platform of computer you choose (Mac or PC), the stuff you find inside your computer plays a major role in determining how smoothly (or how less-than-smoothly) your Pro Tools system runs. (Book 2, Chapter 1 details the best computer setups for Pro Tools.)

To set up a Pro Tools computer, you need several things:

✦ A computer (preferably with a speedy processor)
✦ Bunches (BIG bunches) of memory
✦ Dual hard drives
✦ An audio interface (This is the Digidesign hardware that you use with Pro Tools software)
✦ The software (Pro Tools, of course)

The following list clues you in on the various pieces of hardware that you find in your computer:

✦ The CPU: The CPU (processor) is the heart of your computer studio. The speed of your CPU will ultimately dictate just how well any program runs on it. As a general rule, for audio get the fastest processor that you can afford. For most audio software, you need at least a Pentium III for the PC or a G3 for Mac. If you can afford it, get a dedicated computer — one specifically for recording audio — because running other types of applications (home finance, word processors, video games) can cause problems with your audio applications and reduce the stability of your system.

✦ Memory: Computer-based audio programs and all their associated plugins are RAM (Random-Access Memory) hogs. My advice: Get a lot of RAM. Okay, that’s not very specific, but how much you really need depends on your recording style. If you do a lot of audio tracks and want reverb or some effect on each track, you need more RAM (and a faster processor).
Pro Tools recommends a minimum of 384MB of RAM, but you should really get a lot more. And I mean a lot more. At least a gigabyte, but you can never have too much. Also, don’t skimp on the quality of the RAM you use. Cheap RAM is worse than no RAM at all, so I recommend that you buy name-brand RAM.

Regardless of the platform you choose (PC or Mac), keep in mind that you can never have too fast a processor or too much memory.

✦ The hard drives: To record audio, be sure you get the right type of hard drives. Notice how I said hard drives (plural). Yep, you should get more than one if you want to record more than a few tracks of audio. You want one hard drive to hold all the software and the operating system — and another drive just for the audio data. Having two greatly increases the likelihood that your system remains stable and doesn’t crash on you, especially if you try to run 16 or more tracks.

As for the size of the hard drive — again, bigger is better, at least in the audio drive where you store your music. For the core system drive, you can get by with a 10GB (gigabyte) drive; for the audio, 20GB is still pretty conservative because audio data can take up a ton of space. For example, a 5-minute song with 16 tracks recorded at a 24-bit resolution and 44.1-kHz bandwidth would take up about 600MB of hard-drive space (that’s about 7.5MB per track minute).

Choose your hard drives wisely. For the software hard drive, you can get away with a stock drive (usually the one that comes with your computer). But for the audio, you need a drive that can handle the demands of transferring audio data at high speed. The main things you want to look for are spindle speed, seek time, and buffer size.

**Spindle speed:** Also called rotational speed, this is the rate at which the hard drive spins. For the most part, a 7,200-rpm drive will work well for recording and playing back audio.

**Seek time:** This is the amount of time the drive takes to find the data stored on it. You want an average seek time under 10 milliseconds.

**Buffer size:** Often called cache buffers, these memory units store data as it’s being transferred. You want a buffer size of at least 512K.

The track count that your system can handle is directly related to the speed of your hard drive — the faster the drive, the more tracks you can record and play back at once. (Of course, the type of drive you get determines how large a role your processor plays.) My current choice for a drive is a Maxtor 7200-rpm ATA IDE drive with an 8.5-ms seek time and 2MB cache buffer. A 100GB drive currently costs around $100.

**Getting the sound in and out**

After you have a computer with enough speed and muscle (see the earlier section “The computer”), then you need the appropriate hardware to get the
Recognizing the Recorder

sound in and out of it. Traditionally (if there can be traditions in such a new technology), you needed a sound card — also called a PCI card because it fits in the PCI (Peripheral Component Interface) slot in your computer. You also needed an audio interface, which allowed you to get the sound from your mixer or preamp to the sound card. This is not the case anymore.

Currently, audio can be brought in and out of a computer in several ways:

✦ **Through a PCI card connected to your computer’s PCI slot:** The Digi 001 is a PCI-based interface. The 001 has a sound card that installs in your computer and a separate box that houses the converters, inputs, and outputs.

If you have a Mac G5 computer, you can’t use the Digi 001. The PCI slots in this computer aren’t compatible with the PCI card of the 001.

✦ **Through an interface connected to the USB port:** The Mbox is Digidesign’s USB offering. This interface works great; the only problem is that you’re limited to two inputs and two outputs because of the relatively slow data transfer speed of USB ports. If you don’t see yourself needing to record more than two tracks at once, this may be a good option for you.

✦ **Through your FireWire port:** Both the Digi 002 and the Digi 002 Rack connect to your computer through a FireWire port. FireWire is preferable to USB because the transfer speed is fast enough to keep latency (the delay from the audio going in and coming back out of your computer) down to a minimum. FireWire ports are inexpensive and available on laptop computers as well as desktop systems, which makes FireWire interfaces more versatile than PCI-based systems.

Each of the Digidesign interfaces is described in detail in Book 2, Chapter 2.

**Software**

Since you’re using a Digidesign interface, you’ll also be using Pro Tools LE software. Down the road, however, you may want to add some other software to your system. This can include programs like Acid for creating loops or Logic for more MIDI-intensive work.

On the Internet, you can find an online discussion board for each of the major audio-recording software programs. Before you buy, go to the sites of the systems that interest you and see what people are saying about the programs. Ask questions, explore the issues that the people are having with the programs, and look for comments that reflect how well the programs interact with Pro Tools and your Digidesign hardware. Doing so can save you lots of time dealing with bugs in your system, and allow you to record a lot more music. You can find these sites by using the product name as the keyword in your favorite search engine or by checking out these Internet forums:
Part of the recording process involves making adjustments to a sound either before or after it’s been recorded. This is the job of the signal processor. Signal processors come in three varieties — equalizers, dynamic processors, and effects processors. They can either be incorporated into the system or be separate, standalone units. For most Pro Tools users, the signal processors of choice are integrated into the software as plug-ins, although you can also use external processors by sending the audio out of your computer and back in again.

**Equalizers (EQ)**

Equalizers enable you to adjust the frequencies of a sound in a variety of ways. In effect, you tell the frequencies to

- **Go away:** You can get rid of unwanted noise or an annoying ringing by reducing select frequencies.
- **Come hither:** Add life or presence to an instrument by bringing the best characteristics of that instrument forward.
- **Scoot over:** You can make room within the frequency spectrum for each of the instruments in your mix by selectively boosting or cutting certain frequencies.

You can find out more about EQ (and discover some great EQ tips and tricks) in Book 6, Chapter 3. The three main types of EQ are graphic, shelf, and parametric. Here’s the rundown:

**Graphic EQ**

Use graphic equalizers to choose a specific frequency to increase or decrease by a certain amount, generally up to 6 or 12 decibels (dB). Doing so enables you to eliminate an offending frequency from the signal or make other adjustments to the tonal quality of the source signal. The graphic EQ will have a certain number of frequency bands that you can adjust. You’re limited to only those frequency bands that your EQ has available. Figure 1-7 shows a typical graphic EQ.
**Shelf EQ**

A shelf equalizer affects a range of frequencies above or below the target frequency. Shelf EQs are generally used to roll off the top or bottom end of the frequency spectrum. For example, you can set a shelf EQ to roll off the frequencies below 250 hertz (Hz) in order to reduce the amount of rumble (low-frequency noise) in a recording. You can see how this looks in Figure 1-8. Notice how the shelf EQ gradually reduces the amount of energy (sound) below the set point and then levels off: hence, the shelf in its name.

**Parametric EQ**

The parametric equalizer enables you to choose the specific frequency that you want to affect, as well as the range of frequencies to put around that frequency. With a parametric EQ, you dial in the frequency that you want to change, and then you set the range (referred to as the Q) — that is, the number of octaves that the EQ will affect. Check out Figure 1-9: The two diagrams show how the Q relates to the range of frequencies affected. (The higher the Q setting, the narrower the band of frequencies affected.)

You’ll find that the parametric EQ is one of your most useful tools when mixing all your individual tracks into a stereo pair. I describe this tool in detail in Book 6, Chapter 3.
Dynamic processors

*Dynamic processors* are devices that regulate the amount of sound or energy that gets passed through them. This amount is defined as the *dynamic range* — the range between the softest sound and the loudest sound. Dynamic processors come in three varieties: *compressors/limiters*, *gates*, and *expanders*. I explain each variety in the following sections.

Dynamic processors are used in a variety of ways. Use them to

- Control the signal going into the mixer and recorder
- Tame the levels and correct the effects of an erratic musical performance when mixing
- Optimize the levels of the finished stereo tracks when mastering

Dynamic processors are some of the most useful tools that you have in your home studio. See Book 6, Chapter 4 for more on dynamic processors.

**Compressors/limiters**

The compressor’s job is to compress the dynamic range of the sound being affected. The purpose of the compressor is to eliminate *transients* (unusually loud notes) that can create *clipping* (digital distortion). The compressor
limits not only how loud a note can be, but it also reduces the difference between the loudest and softest note (compressing the dynamic range).

Compressors are used extensively on vocals; the device keeps transients at bay by gently reducing the highest level that goes through it. Compressors are also used in mastering, to raise the overall volume of a song without creating distortion. The device does this by reducing the overall dynamic range; as a result, a compressor effectively raises the volume of the softer notes without allowing the louder notes to be too loud and distorting.

A limiter works much like the compressor, except it severely limits the highest level of a sound source. The limiter is basically a compressor on steroids; it gives you beefed-up control over volume. Any signal above a certain level, called the threshold, gets chopped off rather than compressed (as with the compressor). A limiter is a good choice in extreme situations, such as when you want a really in-your-face snare drum sound. In this instance, the limiter essentially eliminates any dynamic variation from the drummer’s snare drum hits and makes them all as loud as possible.

Gates
A gate is basically the opposite of the limiter. Rather than limiting how loud a note can get, the gate limits how soft a note can get. The gate filters out any sound below a certain setting (the threshold) while allowing any note above that threshold to be heard.

Gates are often used on drums to keep unwanted sounds from the cymbals from bleeding through to the tom-tom or snare drum mics, or on guitars by refusing to allow the noise generated by guitar effects to be heard when the instrument isn’t playing.

Expander
The expander is basically the opposite of a compressor — instead of attenuating (reducing the volume of) the loudest notes in a performance, an expander attenuates the softest notes. For example, if you have a singer whose breath you can hear in the mic and you want to get rid of that particular blemish, just set the expander to go on at a level just above the annoying breath sounds and it will drop out the offending noise subtly.

Effects processors
Effects are historically used to mimic real-world situations. As a home recordist, you will likely discover a great affinity toward your effects processors because they enable you to create sonic environments without having to rent some great recording room. For example, imagine dragging your drums and all your recording equipment into a large cathedral, setting them up, and spending several hours getting the mics placed just right. Sounds like a lot of
work, right? (I’m tired just thinking about it.) Well, how about recording your drums in your modest home studio and simply choosing the “cathedral hall reverb” patch instead? Now that’s much easier.

I can practically guarantee that you will use effects processors all the time in your studio. Scope out Book 6, Chapter 5 for how to use them effectively.

In the world of effects processors, you have many choices, and many more show up every year. The most common effects processors are (in no particular order) reverb, delay, chorus, flanger, and pitch correction. Read on for the lowdown on each type.

**Reverb**

Reverb is undoubtedly the most commonly used effects processor. With reverb, you can make any instrument sound as if it were recorded in almost any environment. Reverb, a natural part of every sound, is the result of the sound bouncing around inside a room. The larger the room, the more pronounced the reverb. The purpose of a reverb in audio production is to make an instrument sound more natural (especially since most instruments are recorded in small, nonreverberant rooms) or to add a special effect. Reverb can make almost any recorded instrument sound better — if used correctly.

**Delay**

Think of delays as the recording studio’s version of an echo. The delay can be set to happen immediately after the original sound or be delayed much longer. Delay can sound natural or be used as a spacey special effect. You can have a single echo or multiple delays (very common with the snare drum in reggae music, for instance). Delays are commonly used on vocals and guitar, although you can hear them on just about any instrument, depending on the style of music.

**Chorus**

A chorus effect can make one instrument sound like several. Chorus effects add very-slightly-off-tune versions of the unaffected sound, which results in a fuller sound. You find chorus effects used on vocals, guitars, and lots of other melodic instruments.

**Flanger**

A flanger (pronounced flanj-er) effect is similar to chorus effect in sound except that the flanger gets its sound from delaying part of the affected sound in relation to the original, rather than altering its pitch. Flangers are sometimes used on background vocals and solo instruments to add an interesting texture. This is a unique sound that you recognize almost immediately upon hearing it.
The flanger effect comes from the early days in recording. You create the flanger effect the old-fashioned way by recording a duplicate track of the one that you want to flange, using a two-track recorder. You then play the two identical parts back at the same time and gently press against the edge of the two-track tape (the one with the duplicate part) while it’s running. This delays certain parts of the sound slightly and drastically changes the character of the instrument.

Nowadays, you can just choose the flanger patch (sound) on your effects processor to get this sound. Isn’t technology great?

**Pitch correction**

*Pitch correction*, like its name suggests, is used to correct an out-of-tune note. You can use this effect to help a singer or an instrument player sound better by fixing those notes that are slightly out of tune. Pitch correction (also called *auto-tune*) has gotten a bad rap lately (mainly from its overuse and potential for abuse with a singer who can’t sing in key). When used sparingly and appropriately, pitch correction can make an otherwise decent vocal performance really shine. Auto-tune can also be used to create some interesting effects, such as that robotic-vocal sound you hear on so many of the pop songs on the radio nowadays. An easily distinguished example would be the lead vocal on Cher’s “Believe.”

**Monitors**

To record and mix music, you need to be able to hear it (hey, obvious things need love too). Monitors make this happen. You can use headphones or speakers as monitors; most home studios use both. Monitors are an essential part of a recording studio because you need to get what you’re recording and mixing into your ears before you make sure that it sounds good.

Without good speakers, you won’t know what your mixes are going to sound like on other speakers. (Find out more about mixing in Book 6.)

**Headphones**

Chances are that your first home studio will be in a spare bedroom or a corner of your garage or basement. All your recording, monitoring, and mixing will be done in this room. If that’s the case, you’ll find that a set of headphones is indispensable. When you use headphones, you can turn off your speakers and still hear what’s being (or has been) recorded. When you go to record a guitar using a microphone in front of the guitar amp, you want to hear only the guitar — not the guitar amp *and* the guitar amp coming back through your monitors. Headphones will allow you to do this. (See Figure 1-10.)
Speakers

For most home recordists, the first set of monitors consist of the home stereo system, but sooner or later you're gonna want a real set of monitors. Studio monitors come in many varieties, but the home recordist’s best bet is a set of near-field monitors. Near-field monitors are designed to be positioned close to you (which is often the case anyway because most home recordists have very little room in which to work).

Near-field monitors either come with or without an amplifier. The amplified monitors are called active monitors, and the nonamplified monitors are referred to as passive monitors. Which type of monitor you choose depends on your budget and whether you like the idea of the amp coming with the speakers or prefer to purchase the amp separately. Figure 1-11 has a picture of an active near-field monitor. The amplifier is located inside the speaker cabinet.

If you end up getting passive monitors, then you need to buy an amplifier to send power to the speakers. The amplifier connects to the outputs of the mixer and boosts the signal to the speakers. A good power amp should be matched in power to work well with whatever speakers you have.
Mastering Media

After you mix your music, you need to put your final music on something. The two most common media for Pro Tools users are CD and raw computer files. Which medium you choose depends upon what your goals are. For instance, if you intend to send your finished mix out to a mastering house, then you’re better off saving it as raw audio data in a computer file. On the other hand, if you master your music yourself and just want to have it duplicated (or you want to give copies for your friends to play), then you would want to use a CD.
Discovering What You Need

**CD**
With the cost of CD-R (write) and CD-RW (rewrite) drives plummeting, CD mastering is the only choice for most home recordists. With CDs, you can back up large amounts of data at a very low cost, and burn audio CDs that can play in any CD player. You can even send out your mastered CD to be duplicated and packaged for retail sale. (Book 8, Chapter 1 details the process for burning CDs and how to have mass quantities created.)

**Computer files**
Sometimes you won’t want to master your music directly to CD. You may decide to have a professional mastering house do it, or maybe you want to put your music on the Internet. In those situations, store your recordings as computer files. The following sections describe the most commonly used file formats for storing recorded music.

**WAV and AIFF**
WAV and AIFF (Audio Interchange File Format) files are the formats for audio files found with most professional audio software. The advantage to saving your music to WAV or AIFF is that when you hand over a CD containing your WAV and/or AIFF files to a mastering house, the recorded sound is actually in a higher-quality format than that of the finished CD (provided your recorder records in 20 or 24 bit, which most do). You can also take your music files to any other studio that supports these file formats and work with them there.

**MIDI**
A MIDI file is not an audio file; rather, it’s a data file that contains MIDI information that can be transferred from one computer to another. An advantage to MIDI files is that they take up less room than an audio file. The disadvantage is that they only contain the MIDI information and no sound. In order to play a MIDI file, you have to have a sound module. And the sound you get from the file depends entirely on what sound source you use.

**MP3**
MP3 is a file format that has become quite popular on the Internet. Its advantage over audio CDs and other computer files is that it takes up less room. Its disadvantage is that the data is compressed and the sound quality is not near that of commercial CDs (contrary to what MP3 proponents claim). You can find out more about MP3s and audio quality in Book 8, Chapter 2.
In This Chapter

✓ Getting to know the various types of connectors
✓ Plugging in your equipment
✓ Creating an efficient workstation
✓ Making your room sound great (or at least decent)

Okay, so you're ready to turn that spare bedroom or basement into a recording studio. After you unpack all your shiny new gear and get it plugged in properly, you need to get your room to work for you. This involves creating an efficient place to work, but above all, it means getting your room to *sound good*. This can be tricky; after all, pro studios spend tons of time and money getting the room to sound *great*. You're going to have to do much the same. You may not have to spend a ton of money (as if any of us could), but you will need to spend some time.

After you decide on a space for your home recording system, the next steps involve setting up the system and getting your space to work for you. In this chapter, I help you make sense of all those connectors that you end up using — and help you get them all plugged in properly. I also show you how to find the best way to work in your environment, with a goodly measure of tips and tricks thrown in to make your room sound as good as possible.

**Making Connections**

No matter what type of home recording equipment you have, one thing’s for sure — you’re gonna have to plug in some cords somewhere. Exactly where depends on the particular system you own, so read through this section to make sense of all those different cords and connectors, whether analog or digital.

You probably have a lot of experience with analog connectors and cords, such as the ones on your stereo system. But you may never have come in contact with digital connectors, unless you’ve plugged in a DVD player to your TV or had a chance to go into a recording studio that uses digital gear. If you’ve already had this foretaste, pay particular attention to the “Digital” section of this chapter.
Analog
No doubt you've had a chance to see and use a variety of analog connectors. If you play a guitar or keyboard (synthesizer), for example, you're familiar with a quarter-inch analog plug. Some microphones use an XLR analog plug. Keeping it all straight can be a little confusing: Why do you have to use one plug for one thing and another for something else? And what's a TRS plug, anyway?

Read on to decipher the secrets of the most-common analog connectors: quarter-inch (mono/TS and stereo/TRS), XLR, and RCA.

The quarter-inch analog plug
The quarter-inch plug is the most common audio connector and one of the most versatile as well (you see it on cables strung all over the studio to connect instruments, amps, speakers, headphones, and mixers). Quarter-inch plugs come in two varieties: mono/TS or stereo/TRS.

Mono/TS
The humble plug at the end of the cord you use for your guitar or synthesizer is an example of a mono quarter-inch plug; mono (monaural) means it has only one channel with which to send the signal. This type of plug is also referred to as a TS plug (short for Tip/Sleeve): The tip is the very tip of the plug and the sleeve is the rest of the cylindrical metal part. A plastic divider separates the two sections, each of which is connected to a different part of the cable. Check out Figure 2-1 to see this familiar plug.

Figure 2-1:
A typical quarter-inch plug used for guitars and other electric instruments.

TS plugs are used for a variety of purposes — to go from your guitar to your guitar amp, from your synthesizer to your mixer, from your mixer to your power amplifier (amp), and from your power amp to your speakers. You'd expect that one cord could work for all of these applications. After all, a TS plug is a TS plug is a TS plug, right? Well, not really. The same plug can be wired differently, and it can carry different levels of power. For example, an
Making Connections

instrument cord (the one you use for your synthesizer or guitar) contains one wire and a shield — the wire is connected to the tip and the shield is connected to the sleeve — whereas a speaker cord contains two wires and no shield — one wire is connected to the tip and the other to the sleeve.

The speaker cord also carries a lot more current (power) than the instrument cable; that’s the reason it doesn’t have a shield. The high signal level covers up any noise present in the cord. Because there isn’t nearly as much current present in an instrument, you don’t want to use a speaker cord for your instrument; you need the instrument cable’s shield to keep the noise down. If you do use a speaker cord for your instrument, you may end up with some noise — a hiss, buzz, or even a radio broadcast coming out of your amp (or wherever you’ve plugged in your instrument).

When you buy cords with TS plugs, first be sure to look at (or ask) what purpose the cord is designed for. Then, when you get it home, be sure to make a note of what type of cord it is so that you use it correctly. You can mark your cord a number of ways: You can put colored tape on it (red for speaker or blue for instrument, for example), put a tag or label on it, or (gasp) dot it with nail polish.

You generally don’t need to worry about which end of the cord you plug into your instrument — the signal will travel equally well in either direction. However, currently (so to speak), you can buy cords that are designed to send the current in one direction. (The cord has an arrow on it designating which direction the signal should flow.) I call these designer cords, and two of the most common brands are Monster and Planet Waves. The theory behind these cords is that they do a better job of preserving the sound qualities of the instrument for which they’re designed. These cords are specifically designed for almost every instrument and application known to humankind.

Instrument cords are often called unbalanced lines because of the way they’re wired. An unbalanced cord has one wire surrounded by a braided shield; the wire is connected to the tip of the TS plug and the shield is connected to the sleeve. The signal is sent through the wire and the shield is used for the ground. (It keeps the noise down.) There are balanced lines as well, which I explain in the upcoming section on stereo/TRS plugs.

**Stereo/TRS**

A stereo/TRS (short for Tip/Ring/Sleeve) quarter-inch plug looks like a stereo headphone plug (take a look at Figure 2-2). The tip is at the very end of the plug, the ring is the small middle section located between the two plastic dividers, and the sleeve is the rest of the cylindrical metal part of the plug. A TRS plug can be used a couple of ways: as a balanced cord or with a Y cord. Read on to find out what these italicized terms mean.
A balanced cord is used on professional audio gear to connect the various pieces of equipment together (the mixer to the recorder, for example). The advantage with a balanced cord is that you can have longer cord runs without creating noise.

Why is it that balanced cords are so conveniently noise-free? The balanced cord has two wires and a shield inside, and is wired with the same signal running through both wires. One is 180 degrees out of phase with the other (their wave forms are exactly opposite one another) — the crest of one wave occurs at exactly the same time as the trough of the other, so they cancel each other out. When they get to the mixer (or wherever they’re plugged into), one of the signals is instantly flipped and added to the other. Any noise that was built up in the signal is cancelled out. (Yep, it’s wave cancellation from high-school physics. Who knew it also rocks?)

A Y cord consists of a TRS plug on one end and two TS plugs on the other, forming — you guessed it — a nice representation of the letter Y. The purpose of this cord is to allow you to insert an effects processor — a compressor or equalizer, for example — into the line-in insert jack of a mixer. Check out Book 1, Chapter 3 for all the details. The TRS plug both sends and receives a signal. The Y cord is wired so the tip sends the signal and the ring receives it (see Figure 2-3). The sleeve is connected to the shield of each cable.

**XLR**

The XLR connector is used for microphones and some line connections between professional gear. This cable has a female and a male end. (See Figure 2-4.) The cord is wired much like a TRS connector and is balanced to keep the noise down. The XLR microphone cable is also called a low-Z cable because it carries a low-impedance signal.

**RCA**

RCA plugs — named for good old RCA, also called phono plugs — are common on home stereo (and some semi-pro) audio gear. (See Figure 2-5.)
They function much like a TS plug and aren’t very common in professional audio equipment. Some mixers include them, however, so you can connect a tape deck. They are also used for digital S/PDIF signals. (See the next section for more on these babies.)

**Figure 2-3:** Use a Y cord to send and receive a signal.

**Figure 2-4:** An XLR connector: One end is male (left) and the other is female (right).
Since you’re using Pro Tools and your computer, you’re going to get comfortable with digital connectors. Digital audio equipment is a recent invention — no one standard has emerged. Because of this lack of standardization, a variety of digital connectors are on the market, only a few (or one) of which may be equipment that you own or intend to purchase. Regardless, knowing about the most-common connectors and their purposes will help you decide what equipment is right for you.

**MIDI**

MIDI, short for Musical Instrument Digital Interface, is a handy communication protocol that allows musical information to pass from one device to another. To allow for the free passage of such information, MIDI jacks are located on a whole host of electronic instruments — synthesizers, drum machines, sound modules, and even some guitars have MIDI jacks. And, in order to connect all these instruments, you need some MIDI cables. The MIDI cable contains five pins (male) that plug into the female MIDI jack (port) on the instrument or device. (See Figure 2-6.)

The Digi 001, 002, and 002 Rack each have MIDI ports, while the Mbox does not. If you want to use MIDI and you have an Mbox, you need to buy a separate MIDI interface. Regardless of which Digidesign interface you have, you will need to buy the cable for those ports separately.

**AES/EBU**

AES/EBU (Audio Engineering Society/European Broadcasting Union) cables are much like S/PDIF (see following). The AES/EBU standards require that these cables transmit two channels of data at a time. They differ from S/PDIF...
connectors in that they consist of XLR plugs and use balanced cables. (See Figure 2-7.) AES/EBU was developed to be used with professional audio components, hence the use of balanced connections — the kinds used in professional-level equipment. Your Pro Tools interface doesn’t have any AES/EBU connectors — S/PDIF and ADAT Optical are used instead. (See the following sections.)

Figure 2-6: MIDI connections have two male ends. The device contains the female jack.

S/PDIF

S/PDIF (short for Sony/Philips Digital Interface Format) connectors consist of an unbalanced coaxial cable (one wire and a shield) and RCA plugs. (See Figure 2-7.) They can also be made from fiber-optic cable and a Toslink connector. The S/PDIF format can transmit two channels of digital data at once. S/PDIF protocols are very similar to AES/EBU standards except S/PDIF was originally designed for the consumer market — which explains why unbalanced cords are used. Even so, you can find S/PDIF connectors on a lot of pro recording gear along with (or instead of) AES/EBU.

If you want to use cords longer than about 3 or 4 feet when you’re using a S/PDIF connection — or about 15 feet for AES/EBU connections — your best bet is to use video or digital audio cables. Regular audio cables degrade the sound at longer distances because they can’t transmit the type of signal that digital equipment produces without affecting the quality of the sound. If you use audio cables for longer distances, the sound loses some definition, becoming what some people describe as “grainy.”
**ADAT Optical**

The ADAT (Alesis Digital Audio Tape) Optical (lightpipe) format can send eight tracks of digital audio at once. Developed by Alesis, ADAT Optical has become a standard among digital audio products. It consists of a fiber-optic cable using a special connector developed by Alesis. In your Digidesign interface you can use the ADAT optical for either eight channels of ADAT information or for Optical S/DIF connections — but you can only use one or the other at one time. You choose your preference from the Hardware Setup screen under the Setups menu.

**TDIF**

TDIF (Teac Digital Interface Format) is Teac’s return volley to ADAT Lightpipe. TDIF uses a standard computer cable with a 25-pin connector. Like the ADAT Lightpipe, TDIF cables can transmit eight channels of digital data at a time. TDIF isn’t nearly as common as ADAT Lightpipe because Alesis made its Light-pipe technology available to other companies to use for free (and encouraged them to adopt it as a “standard”) and also because the Alesis ADAT recorders were so common. You won’t find any TDIF connections in your Digidesign hardware — ADAT is used instead.

**Working Efficiently**

I hope you’ll spend a great number of hours in your studio creating some great music (possibly to the dismay of the rest of your family). One important thing to keep in mind is that you need to be comfortable. First, get a good chair and set up your workstation to be as easy to get around as possible. Figure 2-8 shows a classic L setup. Notice how everything that you need
is within arm’s reach. If you have enough room, you might want to consider a U-shaped setup instead. You can see that in Figure 2-9.

If you use a lot of outboard gear — such as preamps or effects processors — and you think that you need to plug and unplug a lot, invest in a good patch bay so that you don’t have to strain to get at your cords tucked away behind your mixer. A patch bay is a device that consists almost entirely of inputs and outputs, allowing you to route your gear in (and out) in an almost-infinite variety of ways. If you’re going to do much plugging and unplugging, you’ll quickly find out that a patch bay is truly indispensable. It saves your back and it saves your cords (repeated plugging and unplugging wears them out quickly and produces buzzes that can be hard to locate).
Taming heat and dust

The number-one enemy of electronic equipment is heat. Dust is a close second. Try to set up your studio in a room that you can keep cool and fairly dust-free. Air conditioning is a must for most studios. Be careful with a window air conditioner, though; it can make a lot of noise, requiring you to shut it off when you record. Depending on where you live, this could heat your room up really fast. To deal with dust, try to cover up your equipment when you’re not using it, especially your microphones. A plastic bag placed over the top of a mic on a stand works well.

You could also just put your mics away when you’re not using them. However, if you use a particular mic a lot, you’re best off leaving it on a stand rather than handling it — some types of mics are pretty fragile. (You can find more on caring for your mics in Book 1, Chapter 5.)

Figure 2-9:
The U-shaped set-up works great if you have the room for it.
Monitoring your monitors

If you have a set of near-field monitors — the kind that are designed to be placed close to you — they should be set up so they’re equidistant from each other and from you, at a height that puts them level with your ears. Figure 2-10 illustrates the best placement for your monitors. Placing your monitors this way ensures that you hear the best possible sound from them and can accurately hear the stereo field. (For more on the stereo field, see Book 6, Chapter 1.)

![Figure 2-10: Your monitors sound best when placed at equal distances from both each other and you.]

Optimizing Your Room

Chances are that your studio occupies a corner in your living room, a spare bedroom, or a section of your basement or garage. All these spaces are less-than-ideal recording environments. Even if you intend to record mostly by plugging your instrument or sound module directly into the mixer, how your room sounds will have a big effect on how good your music may turn out to be.

Let’s face it — as a home recordist, you’re unlikely to have easy access to the resources that create a top-notch sound room. Commercial studios spend serious cash — up to seven figures — to make their rooms sound, well, professional. You don’t need to spend near that amount of money (you mean you don’t want to sell off the private jet . . .?) to get great sounding recordings. All it takes is a little understanding of the way sound travels, some ingenuity, and a little bit of work.
Sound isolation

One of the concerns that you (and your neighbors) are probably going to have when you start recording in your home is the amount of sound that gets in and out of your room. Sound waves are nasty little buggers. They get through almost any surface, and there’s not a lot you can do to stop it from happening.

You’ve probably noticed this phenomenon when somebody with a massive subwoofer in his car drives by blasting some obnoxious music. (Ever notice how someone else’s music is obnoxious whereas your music never is, no matter how loud you play it? Amazing . . . ) Your windows rattle, your walls shake, and your favorite mug flies off the shelf and breaks into a thousand pieces. Well, this is one of the problems with sound: It’s physical energy.

The best (and classic) way to isolate your studio room from everything around it is to build a room within a room. I won’t go into detail here, but you can go to my Web site (www.jeffstrong.com) to find some resources to get you started.

For the purpose of most home recordists who don’t have the money or space to build a room within a room, the best thing you can do is to try to understand what noises are getting in and getting out and deal with those. For example, if you live in a house or apartment with neighbors close by, don’t record live drums at night. You could also consider using a drum machine or electronic drumset (plugged directly into the recorder) instead.

Another idea is to try to choose a room in your house or apartment that is farthest away from outside noise (an interior room, for instance). Basements also work well because they’re underground and most of the sound gets absorbed by the ground. Install a little fiberglass batting insulation in the ceiling — typical house insulation that you can find at your local home center — can isolate you pretty well from your neighbors’ ears. Detached garages are generally farther away from other buildings, so sound has a chance to dissipate before it reaches your neighbors (or before your neighbors’ noise reaches your garage).

Also keep these things in mind when trying to isolate your studio:

✦ Dead air and mass are your friends. The whole concept of a room within a room is to create mass and still air space so the invading or escaping sound gets trapped there. When you work on isolating your room, try to design in some space that can trap air (creating dead air) — such as a suspended ceiling or big upholstered furniture — or use double layers of drywall on your walls (mass).

✦ Don’t expect acoustical foam or carpet to reduce the noise. Using these can help reduce the amount of sound that bounces around inside the room, but it won’t do much to keep sound in (or out of) the room.
Isolate the instrument instead of the room. Isolating the sound of your guitar amp can be much less expensive than trying to soundproof your whole room. Most commercial studios have one or more isolation booths for recording vocals and other acoustic instruments. You can use that concept to create your own mini-isolation booths.

One idea for a truly mini-isolation booth is to make an insulated box for your guitar (or bass) amp. If you just have to crank your amp to get the sound you want, you can place it inside an insulated box to reduce the amount of noise that escapes to the outside world. Check out Figure 2-11 to see what I mean.

You can also create an isolated space in a closet by insulating it and closing the door when you record, or you can put your guitar amp (or drums) in another room and run a long cord from there to your recorder. If you do this, remember that for long cord runs you need to use balanced cords; otherwise you may get a bunch of noise and your signal may be too low-level to record very well.

![Diagram of an amp-isolator box](image-url)
**Sound control**

After you create a room that’s as isolated from the outside world as possible, you need to deal with the way sound acts **within** your room.

Sound travels through the air in the form of waves. These waves bounce around the room and cause **reflections** (reverberations or echoes). One problem with most home studios is that they’re small — and sound travels very fast (1,130 feet per second, to be exact). When you sit at your monitors and listen, inevitably you hear the reflected sound as well as the original sound that comes out of your speakers. With big rooms, you can hear the original sound and reflections as separate sounds, meaning that the reflections themselves become less of a problem. For a good home studio, you have to tame these reflections so they don’t interfere with your ability to clearly hear what’s coming from the speakers.

How all these reflections bounce around your room can get pretty complicated. Read up on acoustics (the way sound behaves) to discover more about different **room modes**: axial (one dimension), tangential (two dimensions), and oblique (three dimensions). Each relates to the way sound waves interact as they bounce around a room. Knowing your room’s modes can help you come up with an acoustical treatment strategy, but there are very complicated formulas for figuring out your room’s modes, especially those dastardly tangential and oblique modes.

You can find out more on room modes, as well as discover some room mode calculators, on the Internet by using your favorite search engine and searching for **room modes**. Go to the Web site matches and you’ll see quite a few places to start looking. I recommend that you research these modes; this topic alone could fill an entire book.

So, at the risk of offending the professional acoustical engineers in the world, I’m going to share some tricks that I’ve been using in my studios. My main goal has been to create a room with a sound I like and that gives me some measure of control over the reflections within the room. Because I both record and mix in one room (as do most home recordists), it’s helpful to be able to make minor adjustments to the sound to accommodate what it is I’m trying to accomplish.

There are two aspects of recording where sound control plays a major role — tracking and mixing — and each requires different approaches for you to get the best possible sound out of your recordings. I cover both these aspects in this section.

**Sound control during tracking**

*Tracking* is what you’re doing when you’re actually recording. Two things that can make a room a bad environment for tracking are: (a) not enough
sound reflection; and (b) too much sound reflection. The goal when tracking is to have a room that’s not so dead (in terms of sound reflection) that it sucks the life out of your instrument and not so alive that it colors the sound too much. The determining factor in how much reflection you want in your room is going to be based upon the instrument that you record and the way it sounds in the room.

If your room is too dead (not enough sound reflection), you’ll want to add some reflective surfaces to liven things up (the room, that is). On the other hand, if your room is too live (too much sound reflection), you need to add some absorptive materials to tame down those reflections.

You could go out and buy a bunch of foam panels to catch the reflections, or maybe put in a wood floor or attach some paneling to the walls to add some life, but you’d be stuck with the room sounding only one way. It may end up sounding good for recording drums or acoustic guitar, but then it would probably be too live for getting a great vocal sound — which requires a deader space. One solution that I’ve found to work well is to get (or make) some portable panels that can either absorb or reflect the sound.

Figure 2-12 shows an absorber/reflector that I’ve used and have found to work quite well. (Go to my Web site, www.jeffstrong.com, for plans to build your own.) One side has an absorptive material (dense fiberglass insulation) and the other a reflective surface (wood). They are put together in an attractive frame and designed to stack easily when you want them out of the way. Even with very little woodworking experience, you can crank out a set of them in a weekend for very little money (about $30 per panel). I guarantee that if you make them (or hire someone to make them for you), you’ll find dozens of uses for them around your studio.

**Sound control during mixing**

Your first step in getting control of the sound of your (probably less-than-perfect) room during mixing is to get a good pair of near-field monitors. Near-field monitors are designed to be listened to up close (hence the “near” in their name) and will lessen the effects that the rest of the room has on your ability to hear them accurately and get a good mix.

The next step to mixing in an imperfect room is to mix at low volumes. I know; that takes the fun out of it, right? Well, as fun as it may be to mix at high volumes, it rarely translates into a great mix. Great mixing engineers often listen to their mixers at very low levels. Yes, they occasionally use high levels, but only after the mixing is pretty much done — and then only for very short periods of time. After all, if you damage your ears, you blow your career as a sound engineer. (Hey, that rhymes! Or is there an echo in here?) I don’t want to sound like your mother, but try to resist the temptation to crank it up. Your ears last longer and your mixes sound better.
Even with these two things (near-field monitors and low mixing levels), you still need to do something to your room to make it work better for you. The secret to a good mixing room is to tame the reflections of the sound coming out of your speakers.

Dealing with high and midrange frequencies is pretty easy — just put up some foam panels or the absorptive side of the panels shown in Figure 2-12. (See? I told you that you’d have a use for those panels.) Start by hanging two (or putting them on a stand or table) so they’re level with your speakers on the wall behind you. Also put one on each sidewall right where the speakers are pointed. (See Figure 2-13.) This positioning gets rid of the higher frequencies and eliminates much of the echo.

You may also need to put something on your ceiling right above your head, especially if you have a low (8 feet or less) or textured ceiling. (You know, one with that popcorny stuff sprayed on.) You may not want to mount one of the absorption panels over your head because they’re fairly heavy. Wrapping up a couple of 2-x-4-foot panels made of dense fiberglass (the same ones used in the absorber/reflectors) in fabric would work just about perfectly. In fact, you can make some overhead diffusers like the ones shown in Figure 2-14 very easily. (The plans for these are also on my Web site at www.jeffstrong.com.)
You can also place a set of these overhead panels in the corners of your room behind the speakers. Just hang them at the same height of your speakers so that they cut off the corner of the room. If there isn’t enough room to fit the panels at an angle in the corner, you can eliminate the backing from the fiberglass and bend the fabric-covered panel to fit right in the corner. Either approach will absorb sound that may otherwise bounce around behind the speakers.
Another thing that you need to consider when you’re mixing is standing waves. Standing waves are created when bass tones begin reflecting around your room and bounce into each other. Standing waves have a weird effect on mix quality. They can either overemphasize the bass from your speakers (resulting in mixes that are short on bass) or cancel out some — or all — of the bass coming out of your speakers (resulting in mixes with too much bass). One of the problems with standing waves is that they can really mess up your mixes and you may not even be aware that they are there.

To find out whether you have a problem with standing waves in your studio, sit in front of your monitors and put on one of your favorite CDs. Now listen carefully. Okay, now lean forward and backward a little bit. Does the amount of bass that you hear change as you move? Next, get up and walk around the room. Listen for places within the room where the bass seems to be louder or softer. You may find places where the bass drops out almost completely. If either inspection gives you a variable experience of the bass, then you are the proud owner of standing waves. Don’t worry, though. You can tame that standing-wave monster with a pair of bass traps.
Bass traps absorb the energy in the lower frequencies so they don't bounce all over your room and throw off your mixes. You can buy bass traps made of foam from some music stores or (yep, you guessed it) you can make your own out of wood and insulation. Check out Figure 2-15 for a look at some homemade bass traps. (The plans to make these are — you guessed it — located on my Web site: www.jeffstrong.com.)

The most common placement for bass traps is in the corners behind you when you're sitting at your mixer (as in Figure 2-16). You may also find that putting a set in the other corners of the room helps even more.

After you place the bass traps, do the listening test again. If you notice some areas where the bass seems to get louder or softer, try moving the bass traps around a little. With some trial and error, you'll most likely find a place where they seem to work best.
Try not to get stressed out about the sound of your room. As important as your room's sound may be, it has a lot less impact on the quality of your recordings than good, solid engineering practices. I know, I keep saying this, but it's important to remember. So do what you can and then work with what you've got.
Chapter 3: Meeting the Mixing Board

In This Chapter

- Understanding the mixer
- Deciphering channel strips
- Exploring routing and busing

If you’ve ever been to a recording studio and watched a great recording engineer create a mix, you’ve probably been entranced by the way that he or she interacted with the mixing board: a dance around the mixer, a twist of a knob here, a push of a slider there. All this to the beat of the music. It’s like watching a genius painter paint, or a great orchestra conductor conduct, or a brilliant surgeon surge . . . er, operate. I’ll even bet that one of the reasons you got interested in home recording is so you could have a chance to play with those knobs yourself. Go ahead and admit it — you’ll feel better.

Well, you get your chance in this chapter. Not only do you discover what each of those knobs does, you get a feel for all the functions that the mixer fulfills in the studio. You discover what makes up a channel strip and how it’s used. You get a chance to see how routing works (and even discover what routing is). And you see how digital mixers use fader banks to provide numerous functions while taking up very little space.

Meeting the Many Mixer Types

Pro Tools has an integrated mixer as part of its software, and with it you can effectively do anything that you could possibly want (and more) with your music. You can adjust EQ, levels, panning, and routing (to name just a few) by either using keystrokes on your computer keyboard or administering a click of your mouse.

Even with all the power that the Pro Tools mixer has, some people (myself included) like to have some knobs to twiddle and some faders to slide while they work. If you’re one of these people, this section will help you decide which of the three hardware options would work best for you.
Analog mixer

The analog mixer, as shown in Figure 3-1, enables you to route the signals within the analog domain. Analog mixers tend to have many knobs, lights, and faders — a set for each channel. If you want to change from mixing inputs (your instruments) to mixing sounds recorded on the recorder, you need to plug and unplug cords or you need to get a mixer with twice as many channels as your recorder.

Many people prefer analog mixers because they believe they sound better than the mixer in Pro Tools software (this is not necessarily the case, at least to my ears) or they want to create elaborate mixes for a band to hear in their headphones as they record.

The main disadvantage to using an analog mixer with Pro Tools (or any other computer-based recording system) is that you need just as many analog inputs and outputs for your Digidesign hardware as you want channels to mix in your mixer. For example, if you want to mix a 16-track song, you need the equivalent of two Digi 002 Racks. The other possible disadvantage is that each analog-to-digital-to-analog conversion degrades the sound of your music.

Digital mixer

The digital mixer, as shown in Figure 3-2, is a great option for Pro Tools users because it can perform the same functions as a conventional analog mixer in a lot less space, and you don’t have to worry about having as many analog connections. Also, the whole issue of sound degradation from going back and forth to digital is moot because all your music stays in the digital domain.

If you want to use a digital mixer with Pro Tools, make sure that it is compatible with the software — an easy task if you go to www.digidesign.com/compato — and that you have enough channels of digital connection in your hardware. (Book 2, Chapter 2 details each of Digidesign’s hardware capabilities.)

Like in Pro Tools software, routing — the process of sending your signals to various places within the mixer — becomes almost easy using one of these. You can switch between input and track channels without having to change a single cord.

One of the great things about digital mixers is that any EQ or effects plug-ins that you use are powered by the processor in the mixer, not the processor in your computer. This can allow you to have many more effects on your mixes (not always a good thing) before your system bogs down.
The downside to this arrangement is that you’re stuck with the EQ and effects that are part of your mixer — and if they aren’t that great to begin with, you may not want to use them.

**The computer control surface**

A computer control surface is a piece of hardware that interfaces with your computer to control the controls within the Pro Tools software. As far as I’m concerned, a computer control surface, like the one included with the Digi 002, is the way to go with Pro Tools — as long as you have a powerful-enough computer to handle the mix, because all your EQ and effects processing is still done in the computer, unlike what you’d get with a digital or analog mixer. There are quite a few control surfaces that integrate smoothly with Pro Tools, including the cool-looking Mackie Control shown in Figure 3-3.
Before you buy a control surface, check out the compatibility page on Digidesign’s Web site at www.digidesign.com/compato.html to make sure the one you want works with Pro Tools.

Figure 3-2: The digital mixer performs the same functions but takes up less space than an analog mixer.

REMEmBER

Figure 3-3: A computer control surface acts like a digital mixer for a computer-based system.
These controllers send MIDI messages — messages coded using the Musical Instrument Digital Interface communications protocol — to the computer telling it which parameters to change. These controllers can easily be programmed to work like a separate digital mixer.

**Understanding Mixer Basics**

In spite of the many types of mixers out there (see the “Meeting the Many Mixer Types” section, earlier in this chapter), you’ll discover that they all generally follow the same basic principles — and have a number of elements in common. You’ll also discover that, regardless of the type of mixer you use, two mixing aspects — the channel strip and busing (also known as routing) — are universal. The rest of this chapter concentrates pretty heavily on these two aspects.

Think of a mixing board as a sort of air-traffic controller for the audio world. Just as the guys (and gals) in the towers near an airport communicate with all the planes in the air, making sure that collisions are avoided and that traffic moves quickly and efficiently, the mixer routes all the incoming and outgoing signals from the instruments, effects, and recording devices so they get to their desired destination without any problems.

**Channel strip**

The mixer is composed of numerous channels into which you process the signal of an instrument or microphone before it’s sent to the recorder. This is called the channel strip. (See Figure 3-6.) Even though the mixer may look confusing with all its knobs, lights, and sliders, you only need to understand the basic makeup of one channel to understand them all. The channel strip’s job is to take the signal from an instrument or microphone and send it where you want it.

The channel strip also enables you to make adjustments to the level of the signal in a variety of ways: overall level, a certain frequency’s level (different for each mixer), left or right stereo level, and effect levels.

The channel strip serves two functions: to control the level of an input device (the input channel) and to control the level of a recorded track (the track channel). Both functions of the channel strip operate the same way. In fact, you can use the same channel for either an input or track signal. The only difference is which device (an instrument or the output from your recorder) is plugged in.

**Input jack**

The input jack, generally located on the back of the mixer (although it can also be on the upper part of the top of the mixer), is where you plug in your
instrument (or microphone or the output from your recorder). Many professional mixers have both a quarter-inch and an XLR jack for each channel. (See Figure 3-4.) For the lowdown on jacks, read through Book 1, Chapter 2.

The quarter-inch jack is used for line-level sources such as a synthesizer, drum machine, or the cord from the line out of your guitar amp. The XLR jack is for the male end of the microphone cord. Most semi-pro and pro mixers also have phantom power available to the XLR jack. The *phantom power* feature sends a low level of current from the mixer to the microphone to get the microphone to produce a signal. Phantom power is necessary for professional condenser mics.

If you choose not to mic your guitar amp and instead want to plug your guitar directly into your mixer, you need to do one of three things:

✦ Plug your guitar into your amp and run a cord from the Line Output of the amp to the mixer’s channel input.

✦ Plug your guitar into a *direct box* (a device that changes the impedance level of your guitar or bass) and plug the direct box into the channel input of your mixer.

✦ Plug your guitar directly into the “Hi-Z” input of your mixer if it has one. (You’ll find this feature on many newer mixers.)

Most pro mixers allow you to use either a balanced or unbalanced cord. (For the scoop on balanced and unbalanced cords, see Book 1, Chapter 2.) Read through the owner’s manual for your mixer to find whether balanced connections are part of your mixer’s specs. Balanced connections are only important if you have really long cords (over 25 feet, for instance) because they cut down on the noise that can result from long cord runs using unbalanced cords.

**Insert jack**

Aside from the quarter-inch and XLR input jacks, another jack — an *Insert jack* — is often found on the back of the mixer for each channel. Its purpose is to enable you to send the signal from the channel out to a processor such as a compressor or an equalizer and to receive the signal back after it has been processed. Unlike the Effect Send (described in the upcoming section, “Auxiliary (Aux) Send knobs”), this jack won’t let you mix in as much effect signal as you want — all of the signal is affected. Figure 3-4 shows a typical set of input jacks.

To use the Insert jack, you need a Y cable, as shown in Figure 3-5. You connect the plug at the base of the Y to the mixer Insert jack; the plugs on the two arms of the Y go into the input and output jacks of the processor.
The job of the *Trim knob* (labeled as *Gain* on your Digidesign interface) is to adjust the level of the input signal as it enters the mixer. (You usually find the Trim knob at the top of the front panel of the channel strip, as shown in Figure 3-4.)
Figure 3-6.) The amount that you adjust the Trim knob depends on the instrument that you have plugged into the channel strip. If the Trim knob is set too high, you get distortion; if it's set too low, you get too weak a signal to record, so be sure to listen as you make your adjustments.

Most Trim knobs have a switch or markings for Line or Mic(rophone) signals. See these markings in Figure 3-6. Turn the knob all the way left for line sources — or slowly keep turning it right for microphone sources — until you get a nice clean sound coming into the mixer. See Book 3, Chapter 2 for more on setting input levels.

If you choose to use an external preamp, check the owner’s manual of your mixer to see whether you can bypass the internal preamp. Most professional mixers enable you to do this. Sometimes just having the Trim knob all the way down (to the Line marking) disengages the preamp from the circuit — and this is the case with the Digidesign preamps. You can also plug into the line inputs if you want to keep your Digidesign preamps free for other mics or instruments.

**Equalization**

Semi-pro and pro mixers give you the opportunity to adjust the equalization (EQ) of your signal — that is, to boost or reduce specific ranges of sound frequency. Less-expensive mixers have fewer equalizer settings (as few as two — one for high frequencies and one for low frequencies). Pro mixers have three or four; digital mixers and software mixers may have more.

**Auxiliary (Aux) Send knobs**

You may find occasions when you want to add some effect, such as reverb or delay, to the signal coming into your mixer. With effects such as reverb, you don’t want to use the Insert jack — as you would with a compressor — because you want to be able to control how much of the effect you actually hear. (Compressors affect the entire signal, not some portion of it.)

This is where the Auxiliary (Aux) Send feature comes in. That’s what the little knobs in the middle of the channel strip in Figure 3-6 are for. Adjust these knobs to send as much (or as little) of the signal as you want to go to the appropriate auxiliary component (Aux, get it?). Doing so specifies how much (or how little) of the effects processing shows up in your final sound. Turning the knob to the left produces less effect; turning it to the right gives you more effect.
Figure 3-6: Use the mixer channel strip to make many adjustments to your source signal.
Not only can you set the Effect Send level at each channel (and you can send more than one channel’s signal to each effect), you can also adjust the level of the affected signal that’s brought back into the mixer and mixed with all the dry signals at the master bus (see the “Routing/Busing” section later in this chapter). This is the **Aux Return**, which you can find out more about in the “Auxiliary (Aux) Return knobs” section, later in this chapter.

**Pre/Post switch**

The **Pre/Post switch** enables you to send the signal to the Aux bus (through the Aux Send knobs) either before (pre) it gets through the EQ and channel fader or after (post) it goes there. Use the Pre/Post switch to send an un-equalized signal to the effect, and then to adjust the EQ of the dry (unaffected) signal without affecting what the effect sounds like. You can also use the Pre/Post switch to control the level of both the signal and the effect with the channel fader.

Having this option gives you more flexibility to control what the affected sound will sound like. For example, you can send the dry signal of a kick drum to a reverb (with the switch in the Pre position) and then boost the bass on the dry signal. Doing this gives you some reverb on the higher frequencies without adding it to the lower ones, which would create some mud in the final mix. The downside to this is that you can’t use a fader to control the level of the signal being sent to the effect. (You bypassed the fader in the “Pre” position.) In this case, if you raise and lower the channel fader, the amount of effect that you hear in relation to the dry signal will change as well. For example, when you lower the fader, you hear more effect because there’s less dry signal mixed in; when you raise the fader, you hear less effect because the dry signal is louder and the effect level is the same.

**Pan knob**

Use the **Pan knob** to adjust where in the stereo field (how far left or right) your signal is heard. This knob is generally located toward the bottom of the channel strip and is an important part of mixing. Where you put something in the stereo field has an effect on how well it’s heard among all the other instruments playing through the mixer. (Book 6, Chapter 1 has more details on panning and mixing.)

**Mute switch**

The **Mute switch**, located toward the bottom of the channel strip, enables you to silence the channel (mute it). This switch is commonly used during mixdown to help you work with the sound of a particular part in the mix. This switch allows you to quickly silence the parts you don’t want to hear when you’re mixing so you can concentrate on the sound of the instruments that you want to hear. For example, when you work in EQing and balancing the
levels of the drum set, you can use the mute switch for all the other channels so you hear only the drum-set tracks.

**Solo switch**
The *Solo switch*, when engaged, allows one channel to “sing solo” while muting all the rest. This switch (normally located near the Mute switch) is also commonly used during mixdown when you want to hear only one instrument. This saves you the hassle of having to press the Mute switch on all the rest of the channels. For example, when you work on EQing and are affecting the lead vocal, you can press the Solo switch to mute all the other instruments while you make your adjustments. Then when you want to hear what your adjusted vocal sounds like with the rest of the instruments, all you have to do is disengage the Solo switch (press it again).

**Assign switches**
The *Assign switches* can be located just above the fader, at the top of the mixer or right next to the fader. Use these switches to choose where to send the outgoing signal. You can send it to the *Master bus* or to any of the *submix buses*. (For more on *buses* — the electronic pathways along which signals are sent — see the next section.) If your mixer doesn’t have a separate Solo switch, one of the Assign switches can give you the option of soloing that channel.

**Faders**
The *fader*, usually a slider control located at the bottom of each channel strip, determines the overall level of the signal coming out of the channel strip before it makes its way to the recorder, the Master bus, or the submix bus. (Check out the next section, “Routing/Busing,” for more details.)

**Routing/Busing**
After you have an instrument plugged into the mixer channel strip, you want to send that signal somewhere. This is referred to as *routing* or *busing*. (The place where the signal ends up is, conveniently enough, referred to as a *bus*. Most mixers offer numerous busing possibilities, including busing to the

- **Master bus**: where you can send your mixed music to a two-track recorder.
- **Submix bus**: where you can mix several tracks together before they go to the Master bus.
- **Control room bus**: where you can listen to the tracks through your monitors.
- **Auxiliary bus**: where you can add an effect to your signal.
In the next few sections, I introduce you to some of the most-used busing options and describe some ways to make this process easier.

The busing controls are generally located on the right side of the mixing console, as shown in Figure 3-7. Here you have faders for the Master and submix (Sub) buses, dials for the Aux bus, and Solo and Mute buttons for the Master and submix (Sub) buses. This area is often called the master control section of the mixer.

**Master fader**

The Master fader, located in the lower-right corner of Figure 3-7, controls the Master bus, where your mixed music goes out to the 2-track recorder or back into Pro Tools. When you have something plugged into a channel input, it’s automatically sent to the Master bus. Where you have your Pan knob set for each channel (how far to the left or right) dictates how much signal is sent to the left or right channels of the Master bus. Some mixers are designed with only one master fader to control both left and right channels; on other mixers, you have one fader for each left and right channel.

**Sub (submix) faders**

Depending on the mixer you own, you may or may not have a group of submix (Sub) faders located to the left of the Master fader, as shown in Figure 3-7. The submix faders control the submix buses, which is where you can mix several of your tracks and group them together independently of the rest of the tracks. You use the Assign switches for each channel to choose which (if any) submix buses you want the signal sent to.

The submix can be sent out of the mixer as a unit. For example, you may want to record all the drums on one or two tracks instead of recording them individually. The submix is also routed to the Master bus as a unit. If you assign instruments to a submix, they get diverted from the Master bus and go to the submix fader first. Then everything assigned to that submix fader gets sent to the Master bus to be controlled by the Master fader. Most mixers also allow you to send the submix out without having to go through the Master bus first — there are often submix outputs located on the back of the mixer.

**Solo/Mute switches**

Above each submix fader on your mixer, you’ll most likely have Mute and Solo switches, as shown in Figure 3-7. Use these switches to, well, solo or mute (that is, isolate or silence) the submix group. For example, you may want to hear only the submix of the drums or maybe background vocals. This switch allows you to quickly check your submix.
Figure 3-7: The master control section of a mixer controls the routing of the signals coming from the channel’s strips.
Routing/Busing

**Control Room level knob**
The **Control Room level knob**, usually located above the Master fader, as shown in Figure 3-7, controls the level of the signal going through the Control Room bus — the signal that’s sent to your studio monitors. The Control Room level knob is fed by the Master bus and has the same mix that goes through the master output to your recorder. This allows you to have a different volume than the master level so you can monitor at a different volume than the level being sent out through the Master bus.

The Control Room level knob is especially useful when you’re recording and sending a high level to the recorder but also want to listen to what’s being recorded — at a more comfortable, lower volume — through the monitor speakers.

**Phones knob**
Like the Control Room level knob, the **Phones knob** (located above the Control Room level knob in Figure 3-7) enables you to adjust the level going to the headphones independently of the master level. The Phones knob is fed by the Master bus and will have the same mix as the Master fader.

**Auxiliary (Aux) Send knobs**
The **Aux Send knobs**, also located in the master controls section of the mixer, allow you to send the entire mix from the Master bus to an effects processor, such as a reverb or delay. In Figure 3-7, you can see the Aux Send knobs above the submix fader on the left.

**Auxiliary (Aux) Return knobs**
The **Aux Return knobs** control the overall level for each of the signals routed through an effects processor and sent back to the Master bus. You use these knobs to mix in the amount of wet (affected) signal that you want. The wet signal mixes with the dry (unaffected) signals from each of the channels.

**Aux Assign**
Some mixers can route a signal sent through an effects processor to any of the submix buses, where they can be controlled by the corresponding submix fader. This **Aux Assign** capability enables you to have (for instance) the reverb you want on the drums routed to the submix fader that controls the overall drum level. You choose your bus by pressing in the corresponding Assign button.
**Master Level meters**

At the top of many mixers are the *Master Level meters*, which keep tabs on recording levels and warn you when you may be producing a signal that’s too strong or too weak. Too strong a signal could lead to distortion; too weak a signal produces a sound that lacks fidelity (sounds thin). Master Level meters can come in the form of VU meters (the ones with needles that go back and forth) or as LED lights (where green is good and red is bad).

**Output Jacks**

Most mixers have a bunch of *output jacks* (where — you guessed it — the signal comes out) located at the left on the back of the mixer, as shown in Figure 3-8. You often find output jacks for the Master bus, headphones, monitors, and Direct Outs for each channel, as well as jacks for the Aux Returns.

---

**Figure 3-8:** Mixers usually have their output jacks in the back.
**Master Out jack**

The *Master Out jack* goes to the power amp for your speakers or to a mastering recorder (2-track). This jack is controlled by the Master fader and sends the signal that’s routed through the Master bus.

**Phones jack**

The *Phones jack* is for your headphones and is fed by the Phones knob on the master console, which carries the same signal as the Master bus — only you get to control the volume separately.

**Monitors jack**

The *Monitors jack* is where you plug in your monitor speakers. Control this jack with the Monitor (or Control Room) knob on the mixer. It carries the signal from the Master bus to the speakers.

**Direct Out jacks**

You get *Direct Out jacks* on more full-featured mixers. These jacks are controlled by their corresponding channel fader (Channel 1 goes to Direct Out 1; Channel 2 to Direct Out 2; and so on). The signal goes directly out from each channel without going through the Master bus.

Most semi-pro and pro mixers won’t actually have a Direct Out for each mixer channel. That’s no big deal; Direct Out jacks are designed so you can send a signal directly out (hence the name) from the channel to a recorder. If you don’t have direct outs on your mixer, you can just use the Insert jack to send your signal directly out of the mixer and into the recorder. The exact procedure for this connection depends on your mixer; check your owner’s manual.

Direct Out jacks are really helpful when you’re recording using overdubs, a process where you layer a track by recording one instrument at a time. For example, you could record the drums on Channels 1 through 4, the bass guitar on Channel 5, and the guitar part on Channel 6. You then send the signal via the Direct Outs from Channels 1 through 6 to the recorder’s Tracks 1–6 and send those signals back to the mixer on channels 9 through 14. You could then use Channel 7 to record the lead guitar part to Track 7 of the recorder while listening back to Tracks 1 through 6 on channel strips 9 through 14. This saves you from having to crawl behind your mixer and change cords when you want to hear the recorded track back.
As you can see, the mixer setup can get complicated. Don’t worry. After you get to know your mixer and get a chance to try some different routing configurations, this stuff will become second nature to you.

**Aux Return jacks**

The *Aux Return jacks* are where you plug in the cord from the line-out jack of your effects processor. This jack is fed to the Aux Return knob.

**Patch Bay**

After you set up your mixer and plug it into the input devices, effects processors, and recorder, you’re set to go. But what if you want to record a track and then listen back to it right away to see whether you like what you hear? Well, for most home recordists, this can be a problem because you’ll most likely have only enough channel strips in your mixer for either recording or listening back. If this is the case, you’re going to have to crawl behind the mixer and unplug your input device and then plug in the outputs from your recorder. Then, when you’re done listening back, you have to switch the cables back in order to record again. All this crawling and connecting can be time-consuming (and eventually hard on your cables).

The solution is to get a patch bay. A *patch bay* is a device that consists almost entirely of input and output jacks. You plug your gear into it so you can change the cord configuration without crawling around behind your big pile of technology. Check out Figure 3-9 for a look at a patch bay.

A patch bay is an essential tool for analog studios — and it’s useful for the more-complicated digital ones as well. Patch bays function by giving two series of jacks — one in the back where you plug in all your gear, and one in the front that you can use to *patch* — connect together with cables — any
one piece of gear into any other. For example, imagine that you want to plug
in the output from your synthesizer into Channels 1 and 2 and you want to
record your friend’s guitar in Channel 3. At the same time, you want to moni-
tor the bass guitar on Channel 4 and the drums on Channels 5 through 8.
This is pretty straightforward, but what if you want to hear what you
recorded on Channels 1 through 3? With a patch bay, all you have to do is
change the cords going into mixer Channels 1 through 3 at the patch bay.
You still have to change cords when you use a patch bay, but at least every-
thing is upfront and accessible; without a patch bay, you’re stuck having to
crawl behind your mixer and recorder to change the cords.
Chapter 4: MIDI and Electronic Instruments

In This Chapter

- Understanding Musical Instrument Digital Interface (MIDI)
- Getting to know synthesizers, drum machines, and other electronic instruments
- Synchronizing MIDI devices
- Exploring sequencing

My first job in a recording studio was in 1985. I can still remember the first time I walked into that studio. The owner was sitting, arms crossed, in a chair in front of the mixing console (it was called a console in those days because the mixer was an actual piece of furniture that took up nearly the whole room). He looked at me and hit a key on the Macintosh computer sitting next to him. Then all of a sudden, a synthesizer started playing, then another, and yet another. This is cool, I thought. But then I heard my nemesis — the drum machine.

Drum machines made me lose my recording gigs as a drummer and drove me to expand my career to that of a recording engineer as well. However, I eventually came to love that drum machine and the many others to follow (sigh). In fact, over the years, I became so captivated by the whole MIDI/drum machine thing that I assembled a whole series of electronic drum sets using drum machines and samplers — all controlled through MIDI.

In this chapter, you find out how MIDI enables synthesizers and computers to communicate with one another — a revolutionary thing for the musician. You get your hands dirty in the world of sequencing — the process of recording MIDI performance information so you can play your performance automatically. You also peruse a variety of MIDI-capable instruments and explore the ins and outs of controlling your MIDI gear.

Like audio recording, MIDI can be a deep subject. You can go nuts trying to understand every little nuance of MIDI. (I know some guys who are not quite the same after plunging headfirst into this stuff.) The reality is that to use MIDI effectively, you don’t need to know every little thing about it. In this chapter, I focus on what you need to know to get started.
MIDI is a protocol (a set of agreed-upon standards) for musical instruments to communicate with one another through a cabled connection and a common digital language. This arrangement allows each one to understand the other, regardless of manufacturer or instrument. All that’s required is an instrument equipped with MIDI ports (jacks).

MIDI data is different from an audio recording because it contains no sound as such; rather, it’s limited to performance information. This includes information about various performance characteristics, which (for keyboards, at least) includes the following:

- **Note-on and note-off**: What note is played and when.
- **Velocity**: How hard someone presses a key.
- **After-touch**: Whether the key pressure changes after the initial press.
- **Vibrato and pitch bend**: Whether the pitch changes while a key is pressed.

This information allows the MIDI musician to potentially create a performance that is as rich in texture as those of the world’s finest players.

Digital messages sent from one device to another across a cable (called the MIDI cable, of course) create MIDI data. The cable connects to MIDI ports on each device, and the messages are sent in the form of binary digits. Each instrument can understand and respond to these messages.

### Perusing MIDI ports

There are three types of MIDI ports: In, Out, and Thru. The In port receives incoming messages, and the Out port sends those messages. You use the Thru port when you create a daisy chain, which means you connect more than two devices together. The Thru port sends the messages that one device receives directly to the In port of another instrument. Figure 4-1 shows a daisy chain setup.

MIDI signals travel in only one direction. Data flows from the Out port of one device to an In port of another device — but not the other way around. Likewise, data going through the Thru port originates from the first device in the chain — not the device whose Thru port is being used. The particular way that data flows is what gives you flexibility in how you can connect different devices together. Here are some examples:
Example 1: In Figure 4-1, three synthesizers are connected in a daisy-chain lineup. A cable connects device A’s Out port to device B’s In port. Another cable connects device B’s Thru port to device C’s In port. In this scenario, device A controls devices B and C. Devices B and C can’t control any other device, because neither device B nor device C has a connection from its Out port.

Example 2: Suppose you connect device B to device C by using device B’s Out port instead of its Thru port. In this case, device A sends messages to device B but not to device C. Device B controls device C. Device C has no control over either A or B because neither one is connected to device C’s Out port.

Example 3: Now take a look at Figure 4-2. In this figure, two devices have MIDI cables running from the Out port of each to the In port of the other — which allows communication to go both ways. (The MIDI interface in this figure is necessary for making MIDI connections in a computer.) For example, a master synthesizer and a computer sequencer are frequently connected this way so you can send performance information from the synthesizer to the sequencer (when you’re recording your part) and from the sequencer back to the synthesizer (when you want to play the part back again).

Figure 4-1: MIDI devices can be chained together through the In, Out, and Thru ports on each instrument.
A connection to a MIDI device’s In port or through a device’s Thru port doesn’t allow the device to control another device. A MIDI device can control another device only if the cable is connected from its Out port to the other device’s In port.

**Understanding MIDI channels**

Okay, so you’ve got a daisychain of MIDI instruments all hooked together, and you want to control them from your master keyboard or sequencer program. Now you want the drum machine to play the drum part and a sound module to play the string part. This is where MIDI channels come in handy.

The *MIDI channels* allow you to designate which messages go to a particular machine. You can program each machine to receive messages on one or more of the 16 MIDI channels. For instance, you can set your drum machine to receive messages on Channel 10 (the default channel for drum sounds) and set the sound module with the string sounds to receive data on Channel 1. (You set the MIDI channels on your digital instrument by going into the System Parameters menu. Check your owner’s manual for specific procedures.) After you assign your channels, your master keyboard sends the performance information for both MIDI signals — the drum machine and the sound module playing the string sounds — across one MIDI cable. Each receiving device responds only to the messages directed to the MIDI channel that it’s assigned to receive.

In this scenario, the sound module with the string sounds receives all the data from the master keyboard, responds to the messages on Channel 1, and simultaneously sends the data from the master keyboard onto the drum machine (via the sound module’s Thru port). The drum machine receives the same
messages from the master keyboard as the sound module, but only responds to those sent for Channel 10.

Having 16 MIDI channels allows you to have up to 16 separate instruments playing different parts at the same time. You may use 16 different devices or 16 different parts from the same device if you have a multitimbral sound generator (see the synthesizer section later in this chapter for more on such sound generators).

You’d think that each MIDI channel would be sent along its own wire in the MIDI cable. That’s actually not the case. Inside the MIDI cable are three wires — two for data transmission, and one to serve as a shield. MIDI messages are sent across the two wires using a channel code, which tells the receiving device to what channel it should send the data following the code. Such a MIDI channel message, also called a channel voice message, precedes each performance command.

**Appreciating MIDI messages**

In order for MIDI instruments to communicate with one another, they need to have a vocabulary in common. This is where MIDI messages come in. MIDI messages contain an array of commands, including performance data, control changes, system-common messages, and system-exclusive messages (about which more in a minute).

Not all MIDI devices recognize all MIDI commands. For example, a sound module generally can’t send performance-data messages (such as after-touch) because a sound module doesn’t have triggering mechanisms that produce those commands.

Check your instrument’s manual for a MIDI Implementation Chart. All MIDI instruments come with this chart. In it, you can find a list of all the MIDI commands that the device can send or receive. The chart also includes information on polyphony, which refers to how many notes the instrument can play at once, and multitimbrality, or how many different sounds the instrument can produce at the same time.

**Performance data**

Included in performance data are note-on and note-off messages, as well as specifications for velocity, after-touch, vibrato, and pitch bend.

MIDI performance-data messages each have 128 different values. For example, each note that you play on the keyboard has a number associated with it (middle C is 60, for instance). Likewise, velocity is recorded and sent as a number between 0 and 127, 0 being the softest volume (no sound) and 127 the loudest that you can play.
**Control-change messages**

*Control-change messages* are a type of performance-data message. These messages contain data about expression, including modulation, volume, and pan.

**System-common messages**

*System-common messages* contain data about which channel the performance data is sent to and what sound in the sound library to play. System-common messages also include information about timing data, master volume, and effects settings.

**System-exclusive messages**

*System-exclusive messages* contain information that is exclusive to the system or device. These messages can include data transfers of new sound patches, among other things.

To use MIDI effectively, you don’t need to know all (or even many) of the MIDI messages that a device can recognize. If you hook up your gear and play, your MIDI devices generate and respond to the messages for you.

**Managing modes**

Your synthesizer, drum machine, or other MIDI module has four operating modes, appropriately called Mode 1, Mode 2, Mode 3, and Mode 4. These modes dictate how your instrument responds to the MIDI messages it receives.

**Mode 1: Omni On/Poly**

In Omni On/Poly mode, your instrument responds to all the MIDI messages coming across the wires (well, except for the MIDI channel data). This means that your synthesizer (or whatever) tries to play the parts of all the instruments hooked up to your MIDI controller. In this mode, your device also plays polyphonically (more than one note at a time).

Some older MIDI devices default to Omni On/Poly mode (Mode 1) when you turn them on. In such a case, you have to reset your instrument if it’s one of several in your MIDI setup. If you don’t, the instrument responds to *any* MIDI message sent from the controller, not just the ones directed toward it.

**Mode 2: Omni On/Mono**

Omni On/Mono allows your device to receive messages from all MIDI channels but only lets it play one note at time (monophonically). This mode is rarely, if ever, used.
Mode 3: Omni Off/Poly
In the Omni Off/Poly mode, your device can play polyphonically but responds only to MIDI signals on the channels that it’s set to. This is the mode you use most often when you’re sequencing — recording or playing back MIDI data. (Book 5, Chapter 2 covers this process in Pro Tools in greater detail.)

Mode 4: Omni Off/Mono
In the Omni Off/Mono mode, your instrument responds only to the messages sent on the MIDI channel it’s set to and ignores the rest. Rather than play polyphonically, as in Mode 3, your instrument plays only one note at a time. This can be advantageous if you’re playing a MIDI controller from an instrument that can play only one note at a time, such as a guitar or saxophone.

General MIDI
If you end up composing music for other people to play on their MIDI instruments — or if you want to use music from another composer — General MIDI is invaluable to you. General MIDI (GM) is a protocol that enables a MIDI instrument to provide a series of sounds and messages consistent with other MIDI instruments. With General MIDI, you can take a Standard MIDI File (SMF) of a song created on one sequencer program, transfer the file to another program, and use that other program to play the exact performance — sounds, timing, program changes, everything.

GM instruments contain numerous sound patches that the MIDI community has standardized. Not all these sounds are exactly the same as far as sound quality goes, but their sound type and location (acoustic grand piano on patch #1, for instance) is the same on all GM-compatible machines.

Not all MIDI-capable instruments follow the GM standards. If this feature is important to you, be sure you find out if the instrument that interests you is GM-compatible before you buy.

GM standards dictate not only the particular sounds that a synthesizer has, but also which drum sounds are located on which keys, how many notes of polyphony the instrument has, and how many different channels the instrument can receive and send instructions on. The two levels of GM compatibility are Level 1 and Level 2.

GM Level-1 compatibility
Level 1 protocols were developed in 1991 and consist of a minimum of 128 instrument patches, 24 notes of polyphony, receiving and sending capability for all 16 MIDI channels, 16-part multitimbrality, and a host of controller and performance messages.
Roland and Yamaha both decided a while ago to raise the bar on the GM level-1 standards by developing their own protocols. Called GS and XG respectively, the machines conforming to either of these standards are synthesizers on steroids. For example, the Yamaha XG protocol calls for a minimum of 480 sounds, including at least 9 drum sets and 51 types of effects (reverb, chorus, and variations), among a host of control-change messages. Roland’s GS standard, on the other hand, requires at least 226 different instrument patches and 20 different control-change messages, among other things.

If you use a GS or XG synthesizer to compose your music, you may be disappointed if you play that composition back on a synthesizer that doesn’t have the GS or XG enhancements; the sound won’t be quite the same. You’ll get the same instrument type (grand piano, for instance) but the sound of the instrument will be different. Also, if you used any of the additional MIDI messages contained in the GS and XG protocols (control change, for example), they won’t be understood by the non-GS or XG device.

**GM Level-2 compatibility**

Level 2 was implemented in 1999 and includes more sounds, polyphony, and features. A GM2-compatible device has 32 notes of polyphony, 16-channel support, up to 16 simultaneous instrument sound patches, and a host of additional sounds (384, to be exact) including 2 channels of simultaneous percussion sounds. Also added to the GM2 standard are reverb and chorus effects.

**Getting Started with MIDI**

Enough with the technical aspects of MIDI — you want to know how to start using this great technology, right? Well, in this section, I introduce you to some essential MIDI gear, help you synchronize your machines, and show you the basics of sequencing. You also discover how to save and transfer your MIDI files.

**Gearing up**

Okay, so this MIDI thing sounds kind of interesting to you, and you want to know just what you’re going to need to buy to do some MIDling yourself. Well, I’m sorry to inform you that you can’t do any of this cool MIDI stuff with your vintage Stratocaster guitar or your acoustic drum set (unless you do some fancy rigging to your gear — see the sidebar, “MIDI control this . . .”). What you do need is
• **A sound generator**: This device is what enables you to hear the music and may be a synthesizer, drum machine, sound module, or sampler.

• **A MIDI controller**: This is the device that actually controls the MIDI instruments in your studio. You’ll most likely use the MIDI functions in Pro Tools for this purpose. This may also be your keyboard, electronic drum pads, or other MIDI instruments (such as the Roland GK2a).

• **A sequencer**: This device records and plays the MIDI performances that are programmed into it. The sequencer allows you to program your part into the synthesizer and have it play back automatically (much like the old-time player piano). Again, you’ll most likely use Pro Tools software for this, but you could use a sequencer in your keyboard if you prefer.

• **A MIDI interface**: The MIDI interface is used to enable your computer to send and receive MIDI data. If you have a Digi 001, Digi 002, or Digi 002 Rack you already have MIDI ports in your hardware (sorry, Mbox users, you have to buy a separate MIDI interface).

I know this sounds like a lot of stuff, but most of this gear performs more than one function in the MIDI studio. For example, nearly all synthesizers come with drum sounds, and some synthesizers even include a sequencer. In this case, this one synthesizer can do the job of sound generator, drum machine, MIDI controller, and sequencer all in one.

In the following sections, I discuss the different types of sound generators. Although you may find one piece of equipment that does everything you want, in this section, I separate all the features different equipment may have to help you understand the function of each feature and decide for yourself how to configure your studio.

**Sound generators**

The sound generator is the core of the MIDI studio. This is what produces the sounds that you hear. Without it, you may as well skip the rest of the stuff because, of course, you won’t hear any of your work.

Sound generators can come in many different shapes and sizes: There’s the fully functional keyboard synthesizer, the independent drum machine, the standalone sound module, samplers, software synthesizers (soft-synths), and the computer sound card. Each of these devices has its strengths and weaknesses. (Read on for the details.)

**Synthesizer**

A synthesizer, like the one shown in Figure 4-3, consists of not only sounds, but also a keyboard on which you can play these sounds. Synthesizers come in a variety of sizes and configurations. For example, some keyboards come with 61 keys (5 octaves) while others provide as many 88 keys — the size of an acoustic piano keyboard.
If you’re in the market for a synthesizer, you need to consider several things:

✦ **Polyphony:** Polyphony is the number of notes that sound at one time. Most decent synthesizers nowadays have at least 16 notes of polyphony, although models that can produce 32 notes at once are not uncommon. Each manufacturer treats polyphony differently, and the GM standards allow some variations on the effective use of this parameter. For instance, a synth patch may use more than one digital sound to create the actual sound you hear. The synth patch that you love so much may, in fact, consist of four different sounds layered on top of one another. In such a case, you just reduced your polyphony by three-fourths, just by using that one patch. If your synthesizer has 16-note polyphony, it’s now down to 4-note polyphony because each of those 4 notes has four “sounds” associated with it. If you use this patch, you can play only 4 notes (a simple chord) at a time, not the 16 that you thought you had to work with.

Your best bet is to buy a synthesizer (or sound module) with the highest polyphony you can get, especially if you want to layer one sound on top of another or do multitimbral parts with your synth.

✦ **Multitimbrality:** Most decent keyboards allow you to play more than one sound patch at a time. This is called multitimbrality, which basically allows you to have your keyboard divided up into several groups of sounds. For example, a multitimbral synth can divide a song’s chords, melody, bass part, and drum-set sounds into different groups of sounds — and then play all those groups at once.

If you do any sequencing (recording or playing back MIDI data), a multitimbral synth is a must-have. Otherwise, you would need a separate synthesizer for each type of sound that you want to play. Fortunately, with the GM standards, compatible synthesizers made in the last ten years have the ability to play 16 sounds at once.

✦ **Keyboard feel:** Some keyboards have weighted keys and feel like real pianos, while other keyboards have a somewhat spongy action. If you’re
a trained piano player, a spongy keyboard might feel uncomfortable to you. On the other hand, if you have no training in piano and don’t need weighted keys, you don’t have to pay the extra money for that feature.

✦ **Sound quality:** This is a subjective thing. Choose the synthesizer that has the sounds you think you’ll use. I know this seems kind of obvious, but buy the synthesizer whose sounds you like even if this means waiting and saving up some more money before you can buy. If you buy a synth that was a good deal but don’t love the sounds, you’ve wasted your money because you’ll just end up buying the more expensive one later anyway.

✦ **Built-in sequencer:** Many keyboards contain a built-in sequencer, which will allow you to program and play back your performance. Units like these are usually called *keyboard workstations* or *MIDI workstations* because they contain everything you need to create a song. If you’re considering one of these complete workstations, take a good, hard look at the sequencer and the user interface — make sure that you like the way those work for you. Each manufacturer treats the process of sequencing a little differently; you can probably find one that fits your style of working.

**Drum machine**
A drum machine contains not only the sounds of the drum set and other more exotic drums, but also a sequencer to allow you to program rhythms. Figure 4-4 shows you a typical drum machine.

Most drum machines contain hundreds of drum sounds, numerous preset rhythm patches, and the ability to program dozens of songs. All standalone drum machines have pads on which you can play the part. The more advanced drum machines can give your rhythms a more human feel. Effects, such as reverb and delay, are also fairly common on the more advanced drum machines.

**Sound module**
A *sound module* is basically a stripped-down version of a synthesizer or drum machine. Sound modules don’t contain triggering devices (such as the keys for the keyboard, hex pickups for the guitar, or pads for the drum machine). What they do contain are a variety of sounds (often hundreds) that a master controller or sequencer can trigger. The advantage to sound modules is they take up little space and cost considerably less than their fully endowed counterparts (the synths and drum machines, that is).

If you already have a master keyboard, then you may find that adding sound modules is a cost- and space-effective way to add more sounds to your system.
**Samplers**

A sampler is a sound module that contains short audio samples of real instruments. Most samplers come with sound libraries containing hundreds of different types of sounds, from acoustic pianos to snare drums to sound effects. These sounds are often much more realistic than those that come in some synthesizers.

The real purpose of a sampler is to allow you to record your own sounds. For example, in the '80s, it was cool to make a drum set out of unusual percussive sounds. A snare drum could be the sound of a flushing toilet (don’t laugh, I actually did this) or breaking glass. Tom-toms could be grunts set to certain pitches. You’d be amazed at the strange stuff that people have turned into music — all with the help of a sampler.

Another common use of a sampler is recording short sections of already recorded songs. This can be a melodic or rhythmic phrase, a vocal cue, or a single drum or synth sound. Sampling other songs is common in electronic music, rap, and hip-hop (be careful of copyright issues before doing this, however). If you’re into electronic music or hip-hop, you may find a sampler a necessary addition to your studio.
Soft-synths

If you’ve chosen a computer-based system to run your home studio on, your DAW (Digital Audio Workstation) software enables you to produce great sounds by using soft-synth plug-ins. Soft-synths are basically software equivalents of standalone synthesizers, sound modules, or samplers. As you can see in Figure 4-5 a soft-synth’s GUI — its Graphical User Interface, the smiley face that the software shows the world — is often designed to look just like a piece of regular hardware, complete with “buttons” and “knobs.”

Of course, soft-synths have their advantages and disadvantages:

✦ Advantages: Soft-synths cost less than standalone units because no hardware is involved.

✦ Disadvantages: Unlike regular synthesizers, soft-synths use up processor power. This can slow down your computer system and prevent you from recording as many audio tracks or applying as many effect patches as you’d like. Another downside (depending on whom you talk to) is that soft-synth programs may not sound quite as good as an external synthesizer.

Countless soft-synth plug-ins are available for Pro Tools. Check out Digidesign’s compatibility page for programs that will work with the software (www.digidesign.com/compato).

Sound card

Most sound cards that you can put in your computer (or that come with a computer) have General MIDI sounds in them. Depending on the quality of your sound card, it may sound decent or border on unbearable.
Getting Started with MIDI

To find out if the GM sounds in your computer’s sound card are any good, go ahead and play a MIDI file on your computer. First, do a search on the Internet for MIDI files (just type MIDI into your favorite search engine). Some sites require you to pay to download a song — especially for popular or familiar tunes — but you can find many sites that allow you to choose a song to listen to without downloading or paying a fee. Click a song and it’ll start playing automatically. You’ll immediately know whether you like the sound of your sound card.

If you bought a new sound card for your computer to record audio with, you’ll generally find that the sounds are pretty good. And (happily) with your audio program, you also have access to soft-synth patches.

**MIDI controller**

A MIDI controller is essentially what its name describes — it’s a device that can control another MIDI device. MIDI controllers come in many different formats. In fact, a MIDI controller can be anything from a synthesizer to a drum machine, a computer to a xylophone.

When MIDI first came out, your controller choice was limited to a keyboard, but now you can choose between keyboards, wind controllers (for saxophones or other wind instruments), guitars, or drums. So even if you don’t play piano, you can find a controller that resembles an instrument you know
how to play. Look around, and you may find one (or more) MIDI controllers that allow you to create music your way.

**Sequencer**
Although you can get standalone sequencers and sequencers integrated into a synthesizer, you probably want to just use the sequencer in Pro Tools for this. The reasons for this are many, but the overriding factor is that you can have your MIDI and audio tracks in one place, and Pro Tools offers you more-powerful editing capabilities than a sequencer that’s contained in a box and that uses a tiny LCD screen.

**MIDI interface**
The MIDI interface allows you to send and receive MIDI information from a computer. All Digidesign interfaces — with the exception of the Mbox — have a MIDI port, but if you end up doing a lot of MIDI sequencing and use more than one sound module or external controller, or if you have the Mbox, you need a separate MIDI interface, such as the one shown in Figure 4-6.

MIDI interfaces come in a staggering variety of configurations, so there are several things to consider when you buy a MIDI interface. The following questions will help you to determine your needs:
✦ **What type of computer do you own?** MIDI interfaces are configured to connect to either a serial, parallel, or USB port. You determine which one to use by the type of port(s) you have in your computer. For example, new Macs only have a USB port, although you can add a serial port if you remove the internal modem. A PC has either a parallel port or a USB port (sometimes both). PCs also have a joystick port, which accepts a special MIDI joystick cable (no MIDI interface is needed).

✦ **How many instruments do you intend to connect?** MIDI interfaces come with a variety of input and output configurations. There are models with two “ins” and two “outs,” four “ins” and four “outs,” and even eight “ins” and eight “outs.” There are also “thru” boxes that have one or more inputs and several outputs. If you have only one or two instruments, you can get by with a smaller interface (in this case a 2x2 interface — two “ins” and two “outs” — would work great). If you have many instruments that you want to connect, you need a larger box.
Chapter 5: Understanding Microphones

In This Chapter

- Looking at the various types of microphones
- Positioning microphones for the best sound
- Exploring a variety of preamps
- Taking care of your microphones

A microphone’s job is generally to try to capture, as closely as possible, the sound of an instrument. But you can also use a microphone to infuse a specific sound characteristic into a performance. Likewise, a preamp — which boosts the signal of a microphone as it travels to the recorder — can be used to accurately represent a sound or to add texture and dimension to it. The fact is that microphones and preamps are the center of the sound engineer’s palette. Just as a painter has his paints and brushes, you have your microphones and preamps. And just as a painter can create a stunning variety of visual textures with his tools, you too can make your creative statement with the judicious use of these two pieces of equipment.

In this chapter, you explore the two most versatile tools of your auditory craft. You look at the various types of microphones and preamps, and you gain an understanding of each one’s role in capturing a performance. You also discover what types of mics and preamps work for particular situations. To top it off, this chapter guides you through purchasing and caring for your precious new friends (the mics and preamps, that is). You can find out how to use your mics in Book 3, Chapter 2, where I discuss specific mic-placement options.

Meeting the Many Microphone Types

When you start looking at microphones, you’ll find basically three different types of construction methods (dynamic, condenser, ribbon) and three basic polarity patterns (omnidirectional, figure-8, and cardioid). This section explores these various constructions and patterns and helps you make sense of them.
Construction types

Whether a microphone is a $10 cheapie that has a cord permanently attached to it or a $15,000 pro model with gold-plated fittings, all microphones convert sound waves to electrical impulses that the preamp or mixer can read and the recorder can store. Each of the three construction types captures this auditory signal in a different way, and as such, each adds certain characteristics to the sound. Here’s how the different mics affect sound:

✦ **Ribbon**: Adds silkiness to the recorded sound because it rolls off the higher frequencies slightly.

✦ **Dynamic**: Tends to accent the middle of the frequency spectrum.

✦ **Condenser**: Tends to have a well-rounded frequency response.

I detail these aspects in the following sections. In most cases, the type of construction dictates the general cost category in which the mics fit.

Condenser microphones

The condenser microphone is, without a doubt, the most popular style of microphone used in recording studios (home or commercial). Condenser mics are sensitive and accurate, but they can also be expensive. Recently, however, condenser mics have come down in cost, and you can buy a decent one for around $200. Very good ones start at about $500.

The condenser microphone has an extremely thin metal (or metal-coated plastic or Mylar) diaphragm (the part that senses the signal). The diaphragm is suspended in front of a metal plate (called a backplate). Polarizing voltage is applied to both the diaphragm and the backplate, creating a static charge in the space between them. When the diaphragm picks up a sound, it vibrates into the field between it and the backplate. This produces a small signal that can then be amplified. Figure 5-1 shows how a condenser mic is constructed.

Condenser mics need a small amount of voltage (between 9 and 48 volts) to function. If you use a condenser mic, make sure that it has its own internal battery — or that you have a preamp or mixer equipped with phantom power. (Not sure what phantom power means? You’re in luck. The next section will enlighten you.)

Phantom power?

*Phantom power* is the small amount of voltage applied to run a condenser microphone properly. In most cases, the phantom power comes from your mixer or preamp and is sent to the microphone through one of the wires in the XLR cable. (I cover XLR cables in Chapter 3.) Some condenser mics have an internal battery or separate power supply that provides this power.
A switch, which is usually located on the preamp or mixer, enables you to turn the phantom power off and on. Even though dynamic microphones don’t use phantom power, this small amount of voltage doesn’t damage them.

**Tube or solid state?**
Condenser mics can be made with transistors (these are *solid-state* mics) or vacuum tubes (*tube* mics). As with all gear that offers a choice between tube and solid state, base your decision on the sound characteristics that you prefer. For the most part, tube condenser mics have a softer high end (though not necessarily *less* high end) and a warmer overall tone. Solid-state mics, on the other hand, are often more *transparent* — they capture the sound with less coloration, sometimes with a bit greater clarity.

**Large- or small-diaphragm?**
Condenser mics come in two broad categories: small-diaphragm and large-diaphragm (see Figure 5-2). Large-diaphragm condenser mics are more popular than their small-diaphragm counterparts; they offer a more pronounced bottom end (low frequencies). Large-diaphragm mics also make less *self noise*, which is electronic noise created by the microphone.

Before you go out and buy only large-diaphragm mics, consider this: Small-diaphragm condenser mics often have an even frequency response and can more accurately capture instruments with a pronounced high-frequency component (violins, for instance).
Dynamic microphones

Chances are you’ve had a chance to use a dynamic mic. Two hugely popular Shure models characterize this type of mic — the SM57 and the SM58, which has a silvery ball of gridded wire at one end and an XLR connector at the other. Dynamic microphones have several qualities that make them unique. First, they can handle a lot of volume (technically known as SPL, meaning Sound Pressure Level), which makes them perfect for extremely loud signals, such as drums, amplifiers, and some rock vocals. Dynamic mics are not as transparent as condenser mics (they don’t represent high frequencies as accurately), so they often impart a “dirty” or “gritty” sound to the signal.

The dynamic microphone uses a magnetic field to convert the sound impulse from the diaphragm into electrical energy (as in Figure 5-3). The diaphragm, often made of plastic or Mylar, is located in front of a coil of wire called a voice coil. The voice coil is suspended between two magnets. When the diaphragm moves (the result of a sound), the voice coil moves as well. The interaction between the voice coil’s movement and the magnets creates the electrical signal.

The sound of a dynamic mic can be described as somewhat boxy, meaning that these mics don’t represent the highest or lowest frequencies of your
Meeting the Many Microphone Types

hearing spectrum accurately (not necessarily a bad thing). They are also durable. Rough treatment probably won’t damage them much (aside from the diaphragm, which a tough metal screen protects). Dynamic mics are the type used most often for live shows. They tend to be inexpensive to buy and easy to maintain; you can get a good dynamic mic for around $100.

Ribbon microphones

A ribbon microphone produces its sound in much the same way as a dynamic mic. The diaphragm is suspended between two magnets. The ribbon mic uses a thin ribbon of aluminum (see Figure 5-4) instead of the plastic or Mylar you’d find in a dynamic mic. Although ribbon mics were very popular from around the 1930s to the 1960s, they’ve mostly taken a backseat to condenser mics in today’s studios. This is mainly because they are fragile, expensive, and aren’t as transparent as condenser mics. In fact, a gust of wind or a strong breath into the diaphragm is all it takes to break a ribbon mic.

Ribbon mics are experiencing a renaissance because a lot of recording engineers are searching for an old, vintage sound. Ribbon mics have a unique sound that is often described as silky or smooth. This essentially means that the high frequencies tend to roll off (gradually reduce) slightly, and the lower frequencies smear together a bit.

Ribbon mics are fairly expensive. You’d be hard pressed to find a new one for much less than $1,000.

Polarity patterns

Microphones pick up sounds in different ways, which are known as polarity patterns. Here’s how the various patterns work:
✦ Omnidirectional mics can capture sounds all around them.
✦ Cardioid (or directional) mics pick up sounds just in front of them.
✦ Figure-8 (or bidirectional) mics pick up sounds from both the front and back.

**Omnidirectional**

The omnidirectional mic is able to pick up sounds coming from anywhere around it. Omnidirectional mics are useful for situations where you want to capture not only the source sound, but also the sound of the room it’s coming from. You can find omnidirectional mics used in stereo pairs, suspended over drum sets to capture the whole sound of the kit, or used overhead to pick up groups of acoustic instruments (such as orchestras).

---

**Figure 5-4:**
Ribbon mics use a ribbon suspended between two magnets to create their signals.
Omnidirectional mics are not generally used for close miking — placing the mic less than a foot from the sound source — because they tend to catch too much background noise. You can see the pick-up pattern of an omnidirectional mic in Figure 5-5. The round pattern shows that the mic picks up sound from all directions.

**Cardioid**
Cardioid microphones pick up the sound in front of them and reject any sounds that come from behind. Cardioid mics are the most common for live bands because you can control the sound that they pick up. If you have a cardioid mic on the tom-tom of a drum set, for example, the mic picks up only the sound of that drum and not the sound from the other instruments around it.
Meeting the Many Microphone Types

The three types of cardioid microphones are cardioid, super-cardioid, and hyper-cardioid. The differences among the types of cardioid patterns of each mic aren’t that great. Check out the graphs in Figure 5-6 to see how the polarity patterns of cardioid microphones differ.

Generally, you don’t need to think about the minor polarity-pattern differences among the types of cardioid mics when you buy or use a microphone. You won’t notice the practical differences in the way these three types of mics work.

**Figure 5-6:** The three types of cardioid mics have similar polarity patterns.

---

**Figure-8**

Figure-8 mics (also called *bidirectional*) pick up sound from both the front and back, but not all the way around. If you take a look at the graph in Figure 5-7, you can see that sound is not effectively picked up from areas on either side of the microphone.

Figure-8 mics are often used to record two instruments simultaneously. For example, you can place the microphone between two horn players with the side of the mic perpendicular to the players. This allows you to capture both instruments while eliminating any sound in front of the musicians.

Most figure-8 condenser mics have the same frequency response for both the front and back sides, but some ribbon mics produce very different responses that depend on whether the sound is coming from the front or the back. For instance, a Royer r121 ribbon mic picks up more high frequencies from behind the mic than from in front. You can use this to your advantage when recording an instrument. If the sound is too rich in low frequencies, just turn the mic around a little — or a lot, depending on how much of the high frequencies you want to add. (More on this in Book 3, Chapter 2.)
Meeting the Many Microphone Types

Multiple-pattern mics

Some condenser microphones can change their pick-up patterns. You can choose from cardioid, omni, or figure-8 (as in Figure 5-8). These mics (generally they’re large-diaphragms) can do this trick because they usually contain two sets of diaphragms and backplates, positioned back-to-back. You may want to have at least one multiple-pattern mic around to give you more variety in microphone positions.

The omni pattern in a multiple-pattern microphone works (and sounds) differently from a true omnidirectional mic. For critical applications (recording an orchestra, for instance), you may not find that a multiple-pattern mic is a fair substitute for an exclusively omnidirectional mic.
Buying the Right Microphone for You

Buying microphones is, without a doubt, one of the most critical decisions that you’ll make when setting up your home studio. Using the right microphone for the job can mean the difference between an okay track and a truly spectacular one.

As recently as just a few years ago, your choice in microphones was between inexpensive dynamic mics (what most home recordists could afford) and expensive condenser or ribbon mics (what the pro studios had). But, as luck would have it, you’ve entered a time in home recording where your options are much more diverse. In fact, a whole line of project-studio mics has recently emerged. This is a new market that manufacturers have found to be hugely profitable, so the choices are expanding almost daily. In some cases, a $500 project-studio mic can rival a $2,000-plus pro mic — at least for the home recordist’s purposes.

So the question that you’re inevitably going to ask is, “What microphones should I get for my home studio?” Good question. And the answer is, “Well, it depends on what you need.” So before I go into detail about what mics might
be best for you, try to spend a minute assessing your needs. These questions may help you figure out what your needs are:

✦ **What type of music will you record?** If you play rock or pop music, you probably want to start with dynamic mics because they’re inexpensive and their limitations in high or low frequencies don’t matter as much as they would if (for example) you wanted to record your string quartet. In this case, a pair of condenser mics would do the trick.

✦ **What instruments will you record?** Loud amps, drums, and screaming singers beg to be recorded with dynamic mics, whereas light percussion, vocals, and stand-up basses shine through with large-diaphragm condenser mics.

✦ **How many mics will you use at once?** If you need to record your whole band at once, budget constraints may dictate your choice between dynamic and condenser mics or a condenser or ribbon mic for vocals. If you need only a couple of mics to record the occasional vocal or instrument, then you can invest more in each mic.

### How many, what kind

You will likely build your microphone collection over time rather than buying all your mics at once. This is the best way to buy mics, because it gives you time to develop an understanding of what you can do with the microphone that you have before you plunk down your money for another. You’re better off having a few mics that best fit your situation than a whole bunch of mics that just sorta work for you.

If you’re like most people, your budget dictates how many mics you can buy and what kind they might be. In this section, I try to help you get the best mics for your recording needs and guide you through the process of slowly accumulating microphones.

Before you go out and buy a ton of mics, know this: Many digital systems have an effect called a **mic simulator** — a program that allows you to use a relatively inexpensive mic and get the sound of a much more-expensive one. If your system has a mic-simulator program (you can find out by searching through your system’s effects patches), then I recommend getting a basic dynamic mic first. You may find that you like the way the mic simulator sounds and discover that you don’t need as many mics as you thought.

### Getting started

A basic mic setup consists of a couple of dynamic mics for drums, guitar amps, or other loud instruments and a decent condenser mic for vocals or other acoustic instruments. You can buy a good, sturdy all-around dynamic mic for under $100; a lower-end (but nice-sounding) condenser mic costs around $200.
For most home recordists, a large-diaphragm condenser mic is the first condenser mic. These are good all-around mics that can work well for a lot of applications.

**Movin’ on**

After you have your basic mics, you can start to add a few more. If you intend to record your band, you need to at least mic the drum set (four mics will get you around the set). In this case, you can add a couple more dynamic mics and start thinking about getting one or two that are designed for particular applications. For instance, you can find mics on the market that are made to work best on the kick drum of a drum set.

At this point, you can also get a second condenser mic — maybe a small-diaphragm condenser mic this time or a large-diaphragm tube condenser. You may want to choose one that sounds different from the one you already have, or, if you love the one you have, you can get a second one just like it so you have a stereo pair.

**Going all out**

As your mic collection grows, you’ll probably start looking for a vocal mic that works best for your voice. In this case, you may look at large-diaphragm tube condenser mics or even a ribbon mic.

After this, your next step might be to buy a stereo pair of omnidirectional mics for drum overheads (mics placed over the drum set) or other multi-instrument applications.

**Detailing applications**

Certain mics work better than others for particular situations. In this section, I try to present some typical applications to give you an idea of what types of mics are traditionally used for various purposes. (You can find more ideas about mic usage in Book 3, Chapter 2, where I discuss specific miking techniques.)

When you consider a mic, think about the frequency spectrum of the instrument(s) you’re recording. If you use a dynamic mic for a symphonic orchestra performance, for example, you’ll be disappointed by the results because it lacks an accurate high-frequency response. On the other hand, using a small-diaphragm condenser mic on the tom-toms of a drum set makes them sound thin and is a waste of money because you can get by with a much less expensive dynamic mic for this purpose.
Microphone choice is fairly subjective. The following list contains some basic suggestions, based on what’s typically used in the recording industry. You may choose a different type of mic, especially if you try to create a certain effect. For instance, using a ribbon mic on a metallic shaker rather than a small-diaphragm condenser mic softens the highest frequencies of the instrument and gives it a mellower sound.

✦ **Vocals:** Most people prefer the sound of a large-diaphragm condenser mic for vocals. If you have the budget, you may also want to audition some ribbon mics for your voice. A dynamic mic is best when you’re going for a dirty or raw sound (excellent for some harder rock, blues, or punk music) or if your singer insists on screaming into the mic. A small-diaphragm condenser mic is rarely the first choice for most singers, but not out of the question for some female vocalists if you don’t mind a bright, present sound (pronounced high frequency).

✦ **Electric guitar amp:** A dynamic mic or a small-diaphragm condenser works well on an electric guitar amp. Some people use large-diaphragm condenser mics on guitar amps and like the added low frequencies that can result.

✦ **Electric bass amp:** Your first choice when miking an amplified electric bass is either a large-diaphragm condenser mic or a dynamic mic. Either one can capture the frequency spectrum that the bass guitar encompasses. Small-diaphragm condenser mics aren’t a good choice because of their inherent high frequency focus.

✦ **Acoustic guitar and other stringed instruments:** A large or small-diaphragm condenser mic or a ribbon mic works well in most instances. A dynamic mic has too limited a frequency response to create a natural sound (but may create an effect that you like). Choose the large or small-diaphragm based upon the overall frequency spectrum of the instrument. For example, if you want to capture the depth of a guitar’s tone, choose a large-diaphragm mic, but for an instrument with a higher register, such as a violin or mandolin, a small-diaphragm mic works great.

✦ **Drum set:** The tom-toms, snare drum, and kick (bass) drum all sound good with dynamic mics because they don’t put out any high frequencies. You can also use large-diaphragm condenser mics, but be careful where you place them — if your drummer hits them, they’re toast.

✦ **Cymbals:** For the cymbals of a drum set, a pair of small-diaphragm condenser mics works well, although some people prefer to use large-diaphragm mics instead. Many old-timers are using ribbon mics on cymbals when they record digitally to give the mics a softer sound. A dynamic mic would lack the high-frequency response needed to make the cymbals shine through in a mix.

✦ **Miscellaneous percussion:** Now, here’s a broad category. By miscellaneous, I mean shakers, triangles, maracas, and other higher-pitched
Buying the Right Microphone for You

Percussion toys. For these instruments, you'll find that either small or large-diaphragm condenser mics work well. If it’s a very quiet instrument, a large-diaphragm mic is preferable because of the higher self noise of the small-diaphragm mic.

If you intend to record loud instruments — drums, amplified guitars, or basses — look for a mic with a high SPL (Sound-Pressure Level) — a rating of how much volume (listed as decibels) the microphone can handle before distorting. A high SPL is above 130 decibels.

Some professional condenser mics have a pad switch that allows you to reduce the sensitivity of the mic, thereby increasing how well it can handle high sound-pressure levels.

**Partnering with preamps**

One of the most important relationships in your home studio is the one between your microphones and the **preamp** — the nice bit of hardware that boosts the mic’s signal so it can be recorded. The greatest microphone in the world is wasted if it’s run through a cheap preamp. By the same token, a cheap mic plugged into a great preamp sounds only as good as the bad mic.

Your Digidesign hardware comes with at least two preamps (Book 2, Chapter 2 details each piece of hardware). This may be enough for you, but you may want a separate preamp if you want a different (better) sound, or if you need more inputs than your hardware provides.

For the most part, the preamps in the Digidesign hardware are more than adequate until your engineering skills are way up there. I recommend using them and spending your money on some decent mics first. (Unless, of course, you need more preamps than those that come with your hardware.)

You can find three types of preamps in the marketplace — solid-state, vacuum-tube, and hybrid — and each has its own characteristics. In this section, you get a chance to explore some preamp styles and discover how each relates to the sounds produced by the types of microphones I discussed earlier in the chapter. This can help you to start considering the relationship between the microphone and preamp in your studio.

**Solid-state**

*Solid-state preamps* use transistors to boost the level of the microphone. Solid-state preamps can be designed to produce as clear and detailed (that is, “transparent”) a sound as possible or can be designed to create a pleasing level of distortion (warmth) for your music. Solid-state preamps cost anywhere from a couple hundred to several thousand dollars.
A good clean, clear, solid-state preamp (such as those from the Earthworks or GML brands) is a great choice if you want as natural a sound as possible on your recording of an instrument or if you are using a microphone that has a sound quality that you want to hear as clearly as possible. For example, I particularly like the way a solid-state preamp works in conjunction with a tube condenser or ribbon mic. The warmth and smoothness of these types of microphones shines through clearly with a clean solid-state preamp.

On the other hand, a more aggressive (warm or pleasingly distorted) solid-state preamp, such as those modeled after the classic Neve designs, can add just a touch of “grit” to certain instruments. These types of preamps are great with dynamic, ribbon, or condenser mics, especially when recording drums, guitar, and some vocals.

**Tube**

*Tube preamps* use vacuum tubes to process and amplify the microphone’s signal. This generally adds some coloration to the sound of your mic (how much and what kind of coloration depends on the particular preamp). As you’ve undoubtedly discovered after reading any other chapter in this book, digital recording aficionados love the sound of tube gear, especially tube preamps. The advantage with a tube preamp is that it can add a nice warm sound to your mics. The disadvantage is that you often can’t get rid of this colored sound. Professional recording engineers often have several tube preamps in their studios to give them different coloration options.

The preamps included in your mixer are solid-state. If you find that you want the colored sound of a tube preamp, you have to buy an external one.

Tube preamps are great for imparting a subtle low-frequency addition to the sound of the microphone signal. Tube preamps also seem to soften the higher frequencies slightly. If you’re like most people, you’ll find the addition of a tube preamp to be welcome, especially if you intend to record rock, blues, or acoustic jazz music. The downside is that all-tube preamps are expensive, with the least expensive costing about $1,000 (the Peavey VMP-2) and most running several thousand dollars (for brands such as Manley Labs).

I prefer to use tube preamps with drums and any “woody” instrument (acoustic guitar, for instance). In this case, I often find myself reaching for a large-diaphragm condenser mic, and in extreme cases, I might even use a large-diaphragm tube condenser mic with the tube preamp (for an extra dose of “tubiness”).

**Hybrid**

A *hybrid preamp* contains both solid-state and tube components to boost the mic’s signal. Most of the inexpensive (under $1,000) “tube” preamps that you find in the marketplace are actually hybrids. An advantage to this design
approach is that the preamp can often be adjusted to give you varying degrees of that warm tube sound. The disadvantage is that these relatively inexpensive “tube” preamps won’t have as clear a sound as a great solid-state preamp, and they won’t have quite the same pleasing character as an expensive all-tube preamp.

For most home recordists, this type of preamp offers a lot of flexibility and can allow you to get either a fairly clear, open sound of a solid-state preamp or a warm, colored sound characteristic of a classic tube preamp. If you can afford only one external preamp, you might find a great solution in one of these hybrid versions.

The countless hybrid preamps on the market vary widely. (In fact, most of the hybrid preamps are actually marketed as tube preamps.) Your best bet in choosing a hybrid (or any preamp, for that matter) is to do some research. Talk to people, read reviews, visit Internet forums, and then audition the two or three that stand out to you. Choose the one that you think sounds best for your needs.

**Considering compressors**

A compressor enables you to alter the dynamic range of an instrument. Along with the microphone and preamp, the compressor is often added to the signal chain before it goes to the mixer. The advantage of using the compressor in the signal chain before it hits the mixer is that you can control the transients of an instrument so it doesn’t overload your converters and create digital distortion.

The compressor plug-ins in Pro Tools are of no use to you if you want to control the transients of an instrument because they are located after the converters. If you don’t want to use (or can’t afford) an external compressor, keep your input level down a bit when you record (Book 3, Chapter 3 covers setting levels in detail).

If you record a lot of vocals or real drums, a decent external compressor may be a good idea. You can find some great-sounding compressors for as little as $200. (Check out my Web site at [www.jeffstrong.com](http://www.jeffstrong.com) for some great “bang-for-the-buck” compressor finds.)

**Preamp, compressor, and equalizer combos**

As long as you’re looking at preamps and compressors, take a look at some channel-strip devices — combos that integrate preamp, compressor, and equalizer. For some people (maybe you), a channel-strip device is the way to go. Using just one unit cuts down on the number of cords, and it’s designed to make the three parts function well together. Quite a few great-sounding channel-strip devices are available for under $500.
Analyzing some microphone accessories
Along with your new mics, you’re going to need a few accessories. These include mic cords, stands, and pop filters.

Microphone cords
Microphone cords can cost anywhere from about $10 up to several hundred dollars. You’re probably asking yourself, “Is there really a difference between a $10 or $20 mic cable and one that sells for hundreds of dollars?”

My answer is, “Supposedly, but chances are, you’ll never hear it.” Let me qualify this answer a little. Unless you have very good microphones, pre-amps, A/D and D/A converters, mixer, recorder, and monitors, you’re wasting your money on expensive microphone cords. I know only one sound engineer (not me, though — I’ve spent too many years behind the drums) who claims that he can actually hear the difference between an average mic cord and one of the expensive ones. And he says that the difference is very subtle. (It would have to be — otherwise I’d hear the difference too.)

Don’t waste your money on an expensive mic cord (or any cord) until you’ve got such kickin’ equipment that the cord is the weakest link in your signal chain. By then, spending a couple hundred dollars on a cord will seem like pennies because you’ll already have invested tens of thousands of dollars in top-quality gear.

Stands
A sturdy stand is essential if you intend to mic anything in your studio. Studio mics can get a bit cumbersome, and decent mic stands are relatively inexpensive — so try to resist the temptation to buy a flimsy stand. A good mic stand has a sturdy base and can securely hold your mics.

Good mic stands cost about $30 and have either a round, cast-iron base (great for getting into tight spaces) or a tripod base (superior stability). Either one works well. Check out Figure 5-9 to see these two types of stands.

Pop filters
A pop filter is a nylon screen that is used to eliminate the “pops” (technically called plosives) that singers make when they sing. Plosives are the result of sudden bursts of air projected into the mic (from singing words starting with Ps and Ts, for example). If you record vocals, a pop filter is a must-have.

Pop filters are relatively inexpensive, but if you want to make your own, you can with a pair of tights or pantyhose and a coat hanger. Bend the coat hanger into a circle and stretch the nylons or pantyhose over it. You can attach the coat hanger to the mic stand by using duct tape. Adjust it so the pop filter is
about 4 to 6 inches away from the microphone. Have the singer sing through it. Check out Figure 5-10 for a look at a homemade pop filter.
Caring for Your Microphones

After investing hundreds, if not thousands, of dollars in microphones, you probably want to know how to take care of them properly. Caring for or storing your microphones isn’t rocket science. Just follow the general guidelines and ideas that follow, and you’ll keep your mics in tip-top shape.
A good microphone lasts a lifetime. Take care of your mics, and they'll offer you years of service.

Daily care

Probably the most important thing to keep in mind when using your mics is to resist the temptation to blow into them. I know you’ve probably seen the doof on stage blow into a mic and yell, “Test — is this thing on?” to see if it’s working. And some folks figure that’s how the pros must check their mics — well, it isn’t. Blowing into a mic is one of the worst ways to test it — and for some sensitive models (like those expensive ribbon mics), it’s a sure way to literally blow the diaphragm. If you want to check to see whether a mic is working, then just speak into it in a normal voice.

There is no need to blow or yell into any mic, unless, of course, you’re singer’s style is to yell into the mic and you’re trying to set the input level. In this case, offer him or her your trusty dynamic mic and keep that expensive ribbon mic hidden.

Another thing to keep in mind when handling your mics is that they can be fragile. Condenser and ribbon mics don’t survive rough handling well. In fact, if you drop a condenser or ribbon mic, you may break it. (This is a good reason to have a sturdy stand.) Dynamic mics, on the other hand, are more durable, which is why they are often used for live applications and on drums (where it’s not uncommon for an overzealous drummer to whack them by accident — as a drummer, I know about this firsthand).

Try to keep your mics away from dust and high humidity. Dust is probably the number-one enemy of a microphone; it can settle on the diaphragm and lessen the sensitivity of the mic — even alter its frequency response. Always cover your mics or put them away when you're not using them.

Storing

Most professionals have mic lockers where they can safely keep the mics that aren’t in use. Mic lockers can look a number of ways. You can make a special locked box fitted with foam padding that has a cutout for each mic, or you can keep your mics in their pouches or cases (if they came with them) in a closet or cabinet.

Regardless of the type of storage cabinet you have, try to handle your mics as little as possible. In fact, if you have a mic that you use a lot, you’re often better off leaving it on a secure stand between sessions instead of dragging it in and out of its case or storage cabinet.
If you do leave your mic out on its stand when it’s not in use, cover it with a plastic bag and close the open end around the mic. (See Figure 5-11.) This keeps off the dust.

Humidity can also be a problem for microphones. If you live in a humid environment, store your mics with a bag of silica gel next to them. (Silica gel is the stuff that comes in the packaging of a lot electronic gear. It absorbs moisture.) You can find silica gel listed as desiccant packets (Desi Pak) by the manufacturer. You can order silica gel in quantities as little as ten from Hydroscopic Products, P.O. Box 437, 25 School Street, Ashley Falls, MA 01222 (www.dehumidify.com/desipak.html).

You can also do an Internet search using the term, Desi Pak.
Well, shoot – I know the audio track’s moving a mite too fast, but dang if I can find a ‘mosey’ function anywhere in the toolbox.”
Contents at a Glance

Chapter 1: Configuring Your Computer
Chapter 2: Setting Up Your Hardware
Chapter 3: Examining Software Basics
Chapter 4: Understanding the Pro Tools Windows
Chapter 5: Importing and Exporting Files
Chapter 1: Configuring Your Computer

In This Chapter

- Choosing hardware
- Setting up a Mac
- Configuring a PC

Pro Tools works well on both Macs and PCs, so no matter which type of computer you prefer, you can make good music without much hassle. However, there are a few things you need to do to your computer — and certain hardware requirements you need to observe — to run Pro Tools successfully.

This chapter gets you up to speed on these areas. You also walk through the process of setting up and configuring your system and installing the software. As an added attraction I've included some advice on how to keep the bugs at bay. (You know, those nasty computer hiccups that can keep you from capturing your best guitar solo or, worse yet, losing it after the fact.)

Using Pro Tools on a Mac

Getting up and going on a Mac is easy. Once you have a computer that has the right specs (which I cover in this section) it will take you less than 15 minutes to be ready to plug in your hardware (I cover this in Book 2, Chapter 2) and start recording (covered in Book 3). This section takes you through, step by step, the process of turning your Mac into a lean, mean, audio recording machine.

Understanding system requirements

One of the great things about Macintosh computers is that they’re isn’t a lot of variables. Almost any Mac will be able to record audio using Pro Tools. (Well, as long as it meets the basic system requirements. See the following Remember icon.) There are a few things, however, that you need to know to record well. These are covered in this section.
The best way to ensure that the computer you own or are considering buying will work with Pro Tools and the Digidesign hardware that you want is to go to the compatibility page on Digidesign’s Web site at

www.digidesign.com/compato/

Choose the hardware and operating system you use (or intend to use) to see what will work with it.

Since the people at Digidesign can’t test all possible hardware options, you might also want to check out the Digidesign User’s Conference (DUC) for any topics covering hardware issues. That Web page is: duc.digidesign.com/. There is a section down the page dedicated to Pro Tools for Macs.

**Knowing which Mac to buy**

For the most part, any PowerBook, G4 with the AGP graphics card, and most G5s. (The newest ones often take a few weeks for Digidesign to add to its list of compatible computers.) In addition, iMacs, iBooks and eMacs may work but you will need to check out the compatibility documents for the hardware and operating system you intend to use on the Digidesign Web site. (Again, the Web address for that is www.digidesign.com/compato/.)

The Digidesign interface you have dictates what type of computer you can use. For example, if you have a Digi 001, you need a computer with an open PCI slot. This eliminates everything except the G4. The G5 is off the list too, because it uses a PCI configuration that is incompatible with the Digi 001. The Digi 002 and 002 Rack both require a FireWire port on the computer. This covers just about all the newer Macs. The Mbox uses a USB connection so make sure that your computer of choice has at least one USB port (they all should).

**Opting on an operating system**

Even though many people still get by using OS 9, OS X is the operating system you really need to use to get the most out of the newest Pro Tools software. All new Macs are being shipped with OS X and some Digidesign hardware, such as the 002 Rack, only works on OS X. As well, Pro Tools version 6 won’t work on OS 9.

If you have an older computer that runs OS 9 and can’t upgrade to X, you’re stuck using version 5 of the Pro Tools software and choosing between the 002, M-Box, and 001. These options work fine, but I’ve got to tell you that OS X is a much better operating system than OS 9. Also, Pro Tools version 6.1 is far superior to version 5. Bottom line: I think the pain (and cost) of upgrading is worth it. I strongly suggest that you upgrade as soon as you can — even if this means buying a new computer.
Recognizing your RAM needs
Pro Tools requires at least 384MB of RAM (Random Access Memory), but I say go for broke here. Get as much RAM as your system can hold. And don’t buy the cheap stuff — get high-quality RAM. The only thing to remember is that for Pro Tools versions prior to 6.1, the maximum RAM that you can have in your system is 1.5GB. 6.1 and above will handle 2GB. If you have more RAM than Pro Tools can handle, you get an error message at startup and Pro Tools won’t boot.

Getting a handle on hard drives
Pro Tools (and any other audio-recording software for that matter) likes to have more than one hard drive. In fact, I’ll go as far as to say that Pro Tools needs more than one hard drive to run properly. My advice? Get two drives: One drive for all your system files and software, and the other for all your audio and MIDI files. Here’s a look at how to organize them:

✦ Drive one: The system drive. For your system drive you can use the stock drive that came with your computer — but if you have a choice, I recommend getting one with a spindle speed (also known as rotational speed, the speed at which the hard drive spins) of 7,200 rpm. You’ll be much happier and Pro Tools will be much happier too. And get a big one — hard drive, that is.

There is no need to partition your drive even if you have other programs such as finance or word-processing software on your computer. In fact, doing so may slow down your system.

✦ Drive two: The audio drive. It used to be that you needed a good high-speed SCSI drive to record and playback audio reliably, but this isn’t the case anymore. You can use both IDE and FireWire drives for storing audio; just make sure that you have a drive with the following (or better) specs:

• Spindle speed: Also called rotational speed, this is the rate at which the hard drive spins. For the most part, a 7,200-rpm drive will work well for recording and playing back audio.

• Seek time: This is the amount of time that it takes the drive to find the data that’s stored on it. You want an average seek time under 10 milliseconds (ms). Get as low as you can. (I prefer a seek time of 8 to 9 ms.)

• Buffer size: Often called a cache buffer, buffers are memory units that store data as it’s being transferred. You want a buffer size of at least 512K, but get one as big as you can. I recommend a drive with an 8 MB buffer.
• **Chipset:** If you use a FireWire drive make sure that it comes with at least the Oxford 911 bridge chipset. This is necessary to get the most bandwidth out of the drive and results in more tracks in your session.

A drive with these specs in a good size (100GB or so) will run you about $100, so there’s no reason not to spring for the second drive.

If you use either the 002 or the 002 Rack as your interface, you’re better off using an ATA/IDE drive as your audio drive, since a FireWire drive will compete with the 002’s FireWire connection for bandwidth. If you want to use a PowerBook or other Mac that doesn’t have room for a second internal ATA/IDE drive, you may need to get either a PCI (for desktops) or Cardbus (for laptops) FireWire adapter. Using an adapter will let you record and playback more tracks and essentially make your sessions run smoother.

**Dealing with other software on your system**

There was a day not too long ago when installing any other software on the computer that you intended to record audio into was asking for trouble. This isn’t a problem so much anymore (see the Warning icon below though) but you still need to be careful not to stress your system by putting too much junk on your computer (games come to mind).

As an experiment, I had Pro Tools running while I had both my e-mail and Internet browser program open and downloading files, as well as Photoshop and MS Word running (talk about multitasking!) — and Pro Tools still ran fine. I wouldn’t try to record or mix seriously with all this stuff going, but I was able to work without my system crashing.

With that said, if you’re really serious about having a bulletproof system, try to keep any extra software (such as games, finance, publishing, graphics, and so on) off your audio computer. At the very least keep all other applications closed while you work in Pro Tools.

Whatever you do, *don’t* install AOL on this computer. I don’t want to bash AOL, but its software is not too successful at making friends with audio programs. Imagine it as the schoolyard bully. You don’t pick a fight with a bully; you just walk away, or better yet, avoid it altogether. So put that free AOL disc down and slowly back away! You’ll thank me later.

If you already have AOL installed in this computer, then either take your chances or (and this is what I’d do) back up all your software and files, reformat the drive and reinstall everything from scratch. Uninstalling AOL doesn’t work; it still leaves some things on the computer that are impossible to find and could still cause trouble.
Setting system settings

Before you install Pro Tools software check to make sure that you have the latest version of OS X. (Also check Digidesign’s compatibility Web page to make sure this version is supported.) Then follow these steps to prepare your system for the software installation:

1. Log on to your computer using an administration account.
   Your OS X documentation will spell out this procedure for you.

2. Choose Apple $\rightarrow$ System Preferences from the main menu, as shown in Figure 1-1.

3. Under the Hardware Options, click the Energy Saver icon.
   A new window opens.

4. Under the Sleep tab, slide the slider for Put The Computer To Sleep When It Is Inactive For: option over to Never, as in Figure 1-2.
   This keeps your computer from shutting down if you record a long song because you don’t touch any keys while recording.

5. Leave the Put the Hard Disk To Sleep When Possible option unchecked.
   This keeps your computer from going to sleep during long sessions.

6. Go back to the main Systems Preferences page by pressing the Show All button in the upper-left corner of the window.

7. Choose Software Update from the System options at the bottom of the page.
8. When the new window opens, deselect the Automatically Check for Updates When You Have a Network Connection option, as shown in Figure 1-3.

This keeps your system from dedicating resources to look for and download software updates.

9. Close the window by clicking the red button in the upper-left corner of the window.

Installing the program

After you’ve completed the system-setup requirements in the previous section, you can install Pro Tools software by following these steps:
1. Insert the Pro Tools software CD in your computer’s CD drive.

2. In the new window that appears, double-click the Install Pro Tools icon.
   The OS X Administration window appears, asking you to enter your password.

3. Enter your OS X Administration password and click OK.
   The Pro Tools installer opens.

4. Select the Startup hard drive as the destination drive.
   The installation path is set.

5. Click Install.
   Pro Tools is installed on your computer (this may take a few minutes so sit back and contemplate the fun you’re going to have once it’s finished installing itself).

6. Restart your computer.
   Wait to open the program until after you’ve attached your hardware. The complete details for this procedure are located in Book 2, Chapter 2.

**Using Pro Tools on a PC**

Getting set up with a PC is a little more complicated than it is with a Mac, simply because there are a lot more hardware variables to deal with. But as long as you keep the basic system requirements in mind, you can set yourself up a very powerful system, often for less money than you’d shell out for a comparable Mac-based system. In this section, I cover some basic things to keep in mind when you’re either purchasing or configuring a PC system for use with Pro Tools.

**Understanding system requirements**

Although the system requirements for PCs are similar to the basic ones for Macs, you do have to deal with a ton more variables. Of these variables, central processing units (CPUs), motherboards, and graphics cards are probably the most confusing to people starting out. These components — as well as the more basic stuff such as hard drives and RAM — are covered in this section so you can get up and running on a PC in no time.

Again, the best source for the latest hardware compatibility information can be found online at the Digidesign Web site at

(www.digidesign.com/compato/)
or on the Digidesign User’s Conference (DUC) Web page at

duc.digidesign.com/

The DUC Web page has a section down the page dedicated to Pro Tools for PCs. At the top of that forum, you’ll find a very useful thread called “The Best System For Pro Tools Under $1,000.00,” which contains a wealth of information about user-tested system configurations that are known to work well.

**Central Processing Unit (CPU)**

The CPU is a small chip that is responsible for processing all the data in your computer. It’s essentially the computer’s brain. There are two major CPU manufacturers in the PC world — Intel and AMD. Digidesign supports both, and each can work fine as the core of your Pro Tools host computer. For Intel systems, I recommend going with a Pentium 4, and for AMD systems, the Athlon XP.

Avoid the lower-cost (and lower-performance) Intel Celeron and AMD Duron processors.

Also, at this time, Pro Tools for Windows isn’t optimized for the new 64-bit CPUs that are just starting to hit the market. Until that changes (and eventually it will), stick with the Athlon XP or Pentium 4. Regardless of which you decide on, I suggest getting the fastest processor you can afford.

Since Pro Tools is a host-based system, it relies on the processing power of your computer’s CPU instead of hardware-processing cards (as the more elaborate Pro Tools HD systems do). The number of plug-ins and amount of mix automation you can use in a session is directly related to how powerful (read: fast) your system is — so don’t skimp on CPU speed.

**Motherboard**

The motherboard is the main circuit board in your computer and holds the CPU, memory, and other peripheral cards. The motherboard you choose will depend on whether you are running the Intel or AMD CPU (see previous section). Each CPU type has its own motherboard requirements, and there are many choices available for each, with new motherboards being released all the time. I have had good results over the years with Asus brand motherboards, although other brands can also work well.

When you select a motherboard for use with Pro Tools, your main concern is that it (a) supports the CPU you plan on using and (b) has a compatible chipset, as specified by Digidesign on the compatibility Web site at

www.digidesign.com/compato/
Be sure to check out the compatibility site before you buy a motherboard.

**Graphics card**

Pro Tools doesn’t make the same demands on your graphics card that modern game software does. A simple 2X or 4X AGP graphics card will work just fine. Make sure, however, that the graphics card you use is compatible with your motherboard. In most cases, this isn’t an issue, but check it out anyway as a hedge against Murphy’s Law.

For example, my latest motherboard (an Asus A7N8X Deluxe) wasn’t compatible with my old Matrox G550 graphics card, but it works fine with my new ATI Radeon 9000 card.

One final consideration for graphics cards: You may want to consider a dual-head AGP graphics card. These work just like any other graphics card, but support the use of dual monitors. Since Pro Tools uses two main display screens, having two monitors and a dual-display-capable graphics card allows you to see both screens without having to “toggle” between them. Okay, it’s certainly not a requirement, but many people find that it’s a nice convenience.

**RAM**

As far as RAM (Random Access Memory) goes, I suggest a minimum of 512 MB, and more if possible. The only important thing to remember when buying RAM for your PC is that you get the proper type of RAM for your motherboard.

Like I said in the Mac section, don’t buy cheap RAM. It can cause problems with your system. High-quality RAM is not much more expensive than the cheap stuff, so spend the extra few bucks and you’ll be thanking me when your system doesn’t freeze on you.

**Hard drives**

Hard drives for a PC system are essentially the same as those for Macs. Check out the hard-drive section for Macs earlier in this chapter for the lowdown on buying hard drives for your system.

**Opting on the operating system**

For PC users, Windows XP is the way to go. It is by far the most stable operating system Microsoft has released to date. While it’s true that older versions of Pro Tools (5.0 – 5.3.1) would work on Windows 98 Second Edition or Windows ME, all versions from 5.3.2 onward require Windows XP. The Digi 001 will work any version (5.0 and newer), but if you use any of Digidesign’s...
Using Pro Tools on a PC

newer hardware (002, Mbox, or 002 Rack), you have no choice but to upgrade to Windows XP. Additionally, the 002 Rack needs Pro Tools 6.1 software, and you can’t run 6.1 without Windows XP.

Both the Home and Professional versions of Windows XP will work. Which one should you buy? They are basically the same. For use with Pro Tools, the main difference is that Windows XP can run dual-CPU systems. (The central processing unit is the main computer “brain,” so essentially it’s a mutant Computer with Two Brains.) The Professional version lets you run dual CPUs; the Home version doesn’t. As of this time, there is no real performance advantage to running a dual CPU system on a Windows PC. That may change in the future as Pro Tools evolves.

Unless you already own a dual-CPU-equipped computer — or plan to purchase (or build) one in the not-too-distant future, save yourself a few bucks and go with the Windows XP Home edition.

Preparing to install Pro Tools software

Before you can actually install your Pro Tools software, you need to get your system configured for it. This section describes the procedures and helps you make sure that your system will run trouble-free (at least as much as can be expected).

Windows settings

While it’s true for the most part that you can run Pro Tools just fine on a standard Windows XP configuration, a few system adjustments will free up system resources, allowing more of your computer system’s power to be freed up for use by Pro Tools. This is important since Pro Tools is a native DAW (Digital Audio Workstation) — one that relies solely on the host computer’s processing power with no additional DSP (Digital Signal Processing) cards for support. And some of these adjustments — such as enabling DMA for all your IDE hard drives — are crucial for running Pro Tools successfully. The sections that follow lay out the basic system settings that I recommend.

Windows XP Classic mode

There are many ways to accomplish the same basic housekeeping and setup tasks in Windows XP. Since I don’t know how your system is set up right now, I lead you through the process from the start. The first thing you want to do is set your system to Windows Classic mode. Here’s how:

1. **Click Start and choose Settings ➪ Control Panel from the Start menu that appears.**

   The contents of the Control Panel folder appears on-screen.
2. Double-click the Display icon.
3. Select the Themes tab, and under Themes, select Windows Classic.
4. Click the Apply button.
5. Select the Desktop tab, and under Background, select None.
6. Click OK.

This procedure disables the active desktop in Windows, which frees up some valuable system resources.

**Choosing Control Panel settings**

Windows XP is remarkably stable, but for those rare times when it (or a program running under Windows) crashes, it generates an error report and asks whether you want to send the report to Microsoft. This feature, called Error Reporting, takes system resources to run — and since you’d rather have those resources working hard to keep Pro Tools running smoothly, you need to disable Error Reporting. Here’s the drill:

1. Click Start and choose Settings ➪ Control Panel from the Start menu that appears.
2. Double-click the System icon.
3. Select the Advanced tab.
4. Click the Error Reporting button.
5. Click Disable Error Reporting.
6. Click OK.
7. Leave the Control Panel open. You have more settings to adjust.

Standby power should be set to Always On for your Pro Tools system. To do this, follow these steps:

1. Open the Control Panel if you closed it already. (Click Start and choose Settings ➪ Control Panel.)
2. Double-click the Power Options icon.
3. Under Power Schemes, select the Always On option.
4. Click OK.
5. Leave the Control Panel open. You have more settings to adjust.
You also want to make sure that your screen doesn’t go to sleep and crash your session. These steps show you how to do this:

1. Open the Control Panel if you closed it already. (Click Start and choose Settings ➤ Control Panel.)
2. Double-click the Display icon and then select the Screen Saver tab.
3. Select None in the Screen Saver selection menu.
4. Click Apply.
5. Select the Appearance tab.
6. Click Effects.
   Make sure that none of the options listed in the window are selected with a check mark. If any of them are, simply click those pesky check marks so they disappear.
7. Click OK.
8. Leave the Control Panel open; there’s still one more thing you have to do.

Your System Sounds need to be disabled to prevent potential problems with Pro Tools. To do this, follow these steps:

1. Open the Control Panel if you closed it already. (Click Start and choose Settings ➤ Control Panel.)
2. Double-click the Sounds And Audio Devices icon in the Control Panel.
3. Select the Sounds tab.
4. Under Sound Scheme select No Sounds.
5. Click OK.
6. Close the Control Panel.

Congratulations! You’ve just configured your system settings.

**Enabling DMA**

All IDE hard drives on your system MUST have DMA enabled before Pro Tools can effectively write and read data to and from your hard drives. To enable DMA, do the following:

1. Right-click the My Computer icon on the Windows desktop.
2. From the context menu that appears, select Properties to access the Properties window and then select the Hardware tab.
3. On the Hardware tab of the Properties window, click the Device Manager button.

4. In the Device Manager window, double click IDE ATA/ATAPI controllers.
   The Device Manager tree expands to show the controllers associated with your system.

5. From the listing, double click the Primary IDE controller and select the Advanced Settings tab.
   If it doesn’t already say DMA If Available under the Transfer Mode option, change it so it does. If you have several disk drives on your system, you have to do the same for Device 0 and Device 1.

6. Click OK and repeat the same steps for the Secondary IDE controller.
   It's in the Device Manager, directly below the Primary controller.

**Disabling AutoPlay**

AutoPlay is a feature of Windows XP that automatically runs certain programs or plays music on a CD when you insert it into your computer’s CD drive. This is a handy feature in everyday life, but can cause problems with the Pro Tools software. For the sake of Pro Tools, disable AutoPlay for all CD drives on your system. Here’s the drill:

1. Double click the My Computer icon on the Windows desktop.
   The My Computer window duly appears.

2. In the My Computer window, right-click the icon for your CD drive.

3. From the context menu that appears, select Properties to access the Properties window and then select the AutoPlay tab.

4. Select Music Files in the Select Content Type menu.

5. At the bottom of the dialog box, click the Prompt Me Each Time To Choose an Action option.

6. Repeat steps 4 and 5 with the Pictures, Video Files, Mixed Content, Music CD, and Blank CD options for the Select Content Type Menu.

7. Click OK.

8. Repeat steps 1 through 8 for each CD or DVD drive on your computer.

**Disabling virus protection**

Virus protection is an important thing to have on any computer that connects to the Internet, but virus protection can also adversely affect Pro Tools
performance. Ideally, your Pro Tools host computer would be dedicated to just running Pro Tools. However, many of you will be using an “all-purpose” computer that you will use for many tasks, such as surfing the Web for business, pleasure, and/or for helping with your children’s homework. In that case, you should turn off your virus protection whenever you are running Pro Tools. Check with the documentation that came with your virus-protection software for the best way to do this. (And don’t forget to re-enable virus protection before you log on to the Internet again.)

I hate to repeat myself but I will: If you’re really serious about having a bullet-proof system, try to keep any extra software (such as games, finance, publishing, graphics, and so on) off your audio computer. At the very least, keep all other applications closed while you work in Pro Tools.

Once you’ve made all of these system adjustments listed above, you need to reboot your computer.

Connecting your hardware

Once you have your system fine-tuned (as in the previous section), you can now connect your hardware. Shut down your computer and refer to Book 2, Chapter 2 for the specifics on connecting your Digidesign hardware. Each piece of hardware has its own installation procedure; I’ve covered each one, step by step, in that chapter. Once you have the hardware connected, turn on your computer. Then, after the Windows desktop appears, turn on the power to your Digidesign hardware (if you’re using a product that doesn’t have a power switch, you can ignore this step).

On Windows PCs, it’s important to wait to install the program until after you’ve attached your hardware, and, if needed, powered it on. The complete details for this procedure are located in Book 2, Chapter 2.

Installing the program

After you’ve complete the Windows system-setup adjustments listed in the previous section, you can install Pro Tools software by following these steps:

1. **Connect your Digidesign interface to your computer.**
   If you have a 002 or 002 Rack this means connecting the FireWire cable, the Mbox requires the USB connection, and the 001 requires plugging in the PCI card into an open PCI slot and making the connection between the PCI card and the breakout box (the rest of the 001 system).

2. **Start Windows.**
   The Windows desktop appears.

3. **Turn on your Digidesign interface if it has a power switch.**
4. Insert the Pro Tools software CD in your computer’s CD drive.
5. Double-click the My Computer icon on the Windows desktop.
   The My Computer window appears.
6. In the My Computer window, double-click the icon for your CD drive.
   The contents of the CD are displayed in a new window.
7. Double-click the Pro Tools Installer folder.
9. Once the Installer appears, click Next to continue.
10. Specify the default paths for installation — they’re fine and it’s less hassle — and click Next.
11. Wait for the installation to complete.
12. Restart your computer.

Digidesign has included additional drivers that aren’t needed for use with Pro Tools, but are included in case you’re using third-party programs and want your Digidesign hardware to interface with them. Frankly, I don’t recommend installing these drivers unless you absolutely have to. Remember, it’s best to keep a lean, mean DAW (Digital Audio Workstation) machine, and that means staying away from any unnecessary drivers and programs. If you have to install these drivers for use with a third-party audio program (such as Sonar or Cubase), refer to their manuals and the Digidesign documentation that came with your hardware for instructions.

**Keeping Bugs at Bay: Good Habits To Get Into**

One thing is certain with computers: Hiccups will happen. Just when you think everything is performing perfectly, something crashes your system. Since these things are inevitable, I recommend that you work on developing some good habits to keep these minor problems from becoming disasters. In this section, I list a bunch of things that can help give you as stress-free an experience recording on your computer as possible.

**Back up your data often (and more than once)**

There’s an old saying about computer data — *If it doesn’t exist in at LEAST two places, then it DOESN’T EXIST!* Your hard drive can be considered one such “location.” A lot of people also copy their data to a second hard drive (either the system drive or a FireWire drive) — and removable media back-ups are also commonly used. This would include CD-R or DVD +/-R discs.
Keeping Bugs at Bay: Good Habits To Get Into

Regardless of the method you choose, the important thing to remember is to back up your data. Hard drives have become remarkably reliable, but as with anything else, failures can and do happen. If your hard drive should fail (or if you accidentally delete something that you shouldn’t have), you’ll be very happy you made copies of all your Pro Tools sessions to another storage device — and (if you didn’t make copies) very sad to see your hard work disappear forever right before your eyes.

On the PC, I prefer to back the data up to a FireWire drive and to either CD-Rs or DVD-Rs. DVD burners are becoming a more attractive option, since they can hold over six times as much data as a CD-R disc, and the prices on DVD burners and the blank disks they use are dropping all the time. I recently added a 4X DVD-/+RW drive to my system and it cost around $200, with blank discs running a bit over a dollar each. Since large Pro Tools sessions can easily exceed the storage capacity of a CD-R, the extra storage capacity of DVD discs allows you to store the session on a single disc instead of spanning it across multiple discs — which makes backing up your data that much easier.

The software you need for backing up your data to CD was probably included with your CD/DVD burner (or came preinstalled on your system). Any good burning software, such as Nero or CD Creator, will work just fine for making CD-R backups of your work. The important thing to remember is that if it’s important to you, make a backup copy of it. I recommend you get into the habit of backing up your session data at the end of every Pro Tools session. Trust me, you’ll thank me for this later.

**Back up your system drive**

Installing your operating system, software applications, plug-ins, and so forth can take a considerable amount of time. So I prefer to back up this information as well as my audio and session data. On the PC, Norton Ghost 2002 is a great way to do this. This program allows you to create a “ghost” image of your hard drive and save it to either another hard drive (or to removable media, such as CD-Rs). In the event of a hard drive crash or other problem, you can restore your drive (or a new drive) to exactly the way you had it before the crash occurred. The best part is that this takes a lot less time than reinstalling everything from scratch does. I normally install Windows XP, then all my software, and then back it up with Ghost. After that, I leave the C (operating system) drive alone, and use my second drive exclusively for Pro Tools sessions and audio data, leaving the system drive for only the programs. Any time I add any new programs or plug-ins — or make any other significant changes to my system drive — I create a new Ghost backup before I install the new stuff. That way, if disaster does strike, my system can bounce back and be up and running with very little delay.
A few minutes spent backing up your system drive and your Pro Tools sessions now can save you hours of work reloading all of your programs later and can also save you from losing that session you spent so many hours perfecting. So get into the habit of backing up your data regularly.
Chapter 2: Setting Up Your Hardware

In This Chapter

- Setting up the Mbox
- Checking out the Digi 001
- Advancing to the Digi 002 Rack
- Going the extra mile with the Digi 002

In order to use Pro Tools software, you need to have one of Digidesign’s hardware interfaces — the boxes that get the sound in and out of your computer. Digidesign choices here include the Mbox, Digi 001, Digi 002, and Digi 002 Rack. All these interfaces work with either Macintosh-or Windows-based computers, and they all run using the same Pro Tools software. Differences include the number of inputs and outputs each interface provides, the sample rates each one supports, and the different ways they connect to your computer.

In this chapter, you get the lowdown on the Mbox, Digi 001, Digi 002, and Digi 002 Rack. To help you choose the best interface for your needs, we tell you how many inputs and outputs you get, note the sample rates, and discuss connection requirements for each of these units. Also, in the case of the Digi 002, we get you up to speed on the numerous functions of the control surface — the faders and knobs that let you mix with your hands. In this chapter, we also show you how to connect each interface so you can get your system up and running.

Throughout this chapter, we describe a lot of connector types. Some of these may be familiar to you, while others may seem a bit like rocket science. (What is an S/PDIF, anyway, and will it blow up if I plug it in?) If you start getting a little dizzy from all these new terms, check out Book 1, Chapter 3, where we explain all types of analog and digital connectors in detail.

Despite the differences between the various Digidesign interfaces, there are many things they share. These include:

- **Preamps:** All the interfaces contain at least two preamps. Preamps boost the signal from microphones so that you can record them directly into Pro Tools. I discuss preamps in detail in Book 1, Chapter 1.
Phantom Power: Phantom power is a small current (48 volts) that is sent from your interface to your microphone (through the mic cable) and is necessary for your condenser microphone to work. Phantom power is only available on your preamp channels and can be switched on and off.

Line-Level Inputs: Line-level inputs are analog connections that let you plug your guitar, keyboard, or other instruments into your interface without any gear between your instrument and the device. Getting your preamp inputs in the interface to accept line-level signals is easy; just push a button on the interface.

S/PDIF: The S/PDIF connector lets you plug in an external converter into your interface, allowing you to bypass the analog-to-digital or digital-to-analog conversion process. Some people prefer to do this if they have separate converters that they prefer the sound of over the ones contained in the interface. All the Digidesign interfaces contain S/PDIF inputs and outputs.

ADAT Lightpipe: The ADAT lightpipe connectors let you have up to eight channels of digital information coming and going through your device. Like S/PDIF, this lets you bypass the conversion process in your interface. ADAT lightpipe is useful if you have an external digital mixer and you want to mix with that. All the Digidesign interfaces except for the Mbox have ADAT lightpipe inputs and outputs.

Mbox

The Mbox (pronounced “EMbox”) is Digidesign’s least expensive Pro Tools hardware interface. (That’s it in Figure 2-1.) Perfect for people with limited input and output needs (and maybe limited cash flow), such as solo artists and singer/songwriters who only need to record one or two tracks at a time (instead of, say, the Flatbush Philharmonic), and those who need something small and portable.

The Mbox interfaces with the host computer and gets its power via a USB interface — rather than from a separate power source — making it an ideal solution for laptop users who want to edit music on the go. While it lacks the high sample rate capabilities and MIDI input and outputs of the Digi 002/002 Rack, it’s still a very capable product and is a perfect solution for those who are looking for ultimate portability or have to squeak by on a tight budget.
Following the ins and outs of the Mbox

The Mbox is actually the simplest of the Digidesign lineup. It includes a pair of combination line/instrument input/microphone preamps (by Focusrite). Phantom power is included. Better still, you can either fire up the built-in microphone preamps to work with condenser microphones that need phantom power, or switch ‘em off to work with dynamic or ribbon mics. (For more about phantom power and condenser mics, see Book 1, Chapter 5.)

Mbox works its magic via S/PDIF digital input and output jacks. These are much the same as the stereo coaxial (coax or RCA) connectors that allow you to record audio into your computer. Typically such a connection sends the output from your CD player or keyboard over a balanced (TRS) or unbalanced (TS) quarter-inch cable to the line inputs (depending on what kind of output jacks you have on your CD player or keyboard). If you want to use microphones that require cables with three-pin XLR connectors, no problem: Mbox offers XLR jacks in back.
The line and XLR inputs share the same jack — called a Neutrik combo jack. These jacks, located on the back of the Mbox, can accept standard XLR (microphone) cables, or balanced TRS or unbalanced TS quarter-inch cables via the hole in the center of the jack. Pretty slick! You can hook up a bass or guitar the same way as a line input without having to use a separate direct box. (Book 1, Chapter 1 has more about direct boxes.)

No matter which input type you use — a microphone, say, or some kind of instrument — make sure that the front panel Source switch is set for the input type you’re using. Three LED lights next to the selector switch tell you at a glance which type of input the Mbox is set up for; press the switch repeatedly to scroll through the three possible types — Mic, Line, or Instrument.

You’ll want to be able to hear what you’re doing, so you’ll probably want to connect a pair of headphones to either stereo headphone jack (1/8-inch on the front panel or 1/4-inch on the rear). If you want to go the speaker route, you can connect powered monitor speakers to the quarter-inch line output jacks on the back of the Mbox.

If you have a DAT player, CD player with a digital output, or other equipment with digital S/PDIF coax connectors that you’d like to connect to the S/PDIF inputs of your Mbox, use 75-Ohm coax digital audio cables. These cables look a lot like the regular RCA cables you’d use to connect a cassette deck to your home stereo, but don’t let looks deceive you. It’s important you use the proper cables; make sure that the cables you end up using are really 75-Ohm coax digital audio cables. (Book 1, Chapter 2 has more on cables and connectors.)

**Hooking up the Mbox**

Hooking up the Mbox is pretty simple. Just connect a few cords and you’re ready to go. This section covers these connections.

**Connecting to the computer**

Did I say simple? Check this out:

1. **Shut down your computer.**
2. **Attach the included USB cable to your Mbox USB jack.**
3. **Plug in the other end of the cable to the USB connector on your computer.**

   Don’t use a USB hub; connect directly into your computer. This keeps your signal from being interrupted by having too much data trying to get through one USB line.

4. **Turn your computer back on and install your software.**
Connecting your gear

In case you haven’t noticed, The Mbox has no power plug or switch. This is because it’s powered by your computer through the USB cable. When your Mbox is plugged into the computer and your computer is turned on, the Mbox is ready to go. You can double-check this by seeing if the USB light is on (the one located on the right side of the front panel above the Mix knob).

The Mbox has two analog inputs that can handle any of your gear. This connector takes XLR (microphone), TRS (balanced cords — the ones with three wires in them that cancel out any built up noise), and TS (your run-of-the-mill instrument cables). These inputs are controlled by the top two knobs on the front of the Mbox, labeled Source 1 and Source 2. These knobs let you adjust the level of the signal. Next to each of these knobs is a button that lets you select the type of device that you’re running through the inputs. You have three options:

✦ **Mic**: This option is for your microphones. If you have a mic connected to the Mbox with a standard XLR mic cable, this is the option to choose.

✦ **Line**: This option is for line-level sources. This includes synthesizers, tape decks, and other line-level sources.

✦ **Inst**: This option is for instrument connections. This is the one you choose when you want to plug your guitar or bass directly into the Mbox — without a direct box in between. (Book 1, Chapter 1 has more on direct boxes.)

The front panel also has a Mix knob. This knob lets you monitor your inputs while you record and also lets you hear the playback of any previously recorded tracks. Adjusting this knob lets you mix the balance between your input and the already-recorded stuff in your headphones. This makes it easy to overdub without hearing a delay from the time it takes your instrument’s signal to enter and exit the computer. Because the Mbox uses a USB connection and USB transfer rates are pretty slow (for audio, anyway), the delay is significant. Using the Mix function in the Mbox allows you to have “zero latency monitoring.” In other words, there’s no delay in your headphones when you overdub tracks.

Of course, using zero latency monitoring causes other problems. That is, your overdubbed tracks are exactly 147 samples behind (the amount of time it takes the signal to enter the computer) your previously recorded tracks. If you use the Mix knob when you overdub and you played in time with the tracks already recorded in Pro Tools, you need to move them earlier in the session (song) to line them up. This isn’t a big deal and I give you step-by-step instructions on how to do this in Book 3, Chapter 4.

You can connect your headphones to either the 1/8-inch jack on the front or the 1/4-inch jack on the back, or both if you have two people wanting to
listen through phones. The overall volume of your headphones is controlled by the bottom knob on the Mbox labeled (appropriately enough) Headphones.

On the back of the Mbox there are two Line outputs where you connect your speakers and two channel inserts. These channel inserts let you connect a compressor between the analog input (including the preamps) and the A/D converter. To do this you need a “Y” cord. (I describe inserting using a “Y” cord in Book 1, Chapter 3.)

The Mbox has two digital S/PDIF jacks in the back where you plug in your digital gear, such as external converters or a CD player equipped with S/PDIF outputs. If you have S/PDIF connections made in the Mbox, the S/PDIF light — located up and to the left of the Mix knob — lights up.

**Digi 001**

The Digi 001, as shown in Figure 2-2, is the product that brought Pro Tools capabilities to the masses. It is similar to the newer Digi 002 Rack unit (listed later in this chapter) in terms of its basic input and output capabilities, except that it uses a PCI card for interfacing to your computer, rather than a FireWire connection. The PCI card attaches via a special cable (included with the Digi 001 package) to a breakout box — the box that contains all the digital and analog inputs and outputs, preamps, and the converters. This makes it somewhat more difficult to install; you have to open your computer case to insert the PCI card, and then attach the cable to the card and the breakout box.

The 001 is not capable of the same high sample-rate operation you’ll find in the newer Digi 002 and Digi 002 Rack, which are capable of 88.2/96 KHz. Speed isn’t much of a issue in this case, though, since many of today’s top albums are still being recorded at 24 bit/44.1 KHz. But as time marches on, new technology gets better results. So while the 001 is still a capable product, it’s slowly being phased out in favor of the newer 002 line.

The 001 can’t be used with the new Mac G5s because the PCI slot in the newer computers is a different configuration. Use your 001 with either a PC or a Mac G4.
Discovering the ins and outs of the Digi 001

The Digi 001 has all the inputs and outputs you need for recording a whole band at once:

✦ **8 analog inputs:** Two of these inputs also have microphone preamps and switchable phantom power, enabling you to plug a microphone directly into the 001.

✦ **8 analog outputs:** You can use these to send tracks out of your computer in a variety of ways — helpful if you have an analog mixer you want to use.

✦ **8 channels of ADAT lightpipe digital inputs and outputs:** The lightpipe connection sends digital info through a glass (or plastic) wire. This connector is useful for sending digital signals into and out from other components (a digital mixer, for example) and can send up to eight channels at a time.

✦ **2 channels of S/PDIF digital I/O:** These inputs and outputs are commonly used for CD players and external converters.

✦ **1 MIDI in and MIDI out jack:** You’d use these for connecting a MIDI keyboard or sound module (MIDI sound source) so you can record and playback your MIDI performances.

✦ **1 stereo quarter-inch headphone-output jack:** Plug in a pair of headphones so you can hear what’s coming and going from the unit. The jack comes with a dedicated volume control mounted on the front panel.

Hooking up the Digi 001

Hooking up the Digi 001 is easy. All you have to do is make the proper connections on your computer, install the software, and plug in your gear. This section covers these details.

Connecting to your computer

For some people, opening up a computer to connect the PCI card is nerve-wracking. Follow these instructions and you can cut the problem down to size:

1. **Shut down your computer and unplug it from the wall outlet.**
   
   You’re going to be messing around inside the computer case and you don’t want any power connected to it.

2. **Open the case.**
   
   This usually requires removing a couple of screws on the rear of the case to allow removal of the side panel on the left.
3. **Touch the metal frame of your computer.**

   Doing so discharges any static electricity that may have built up.

4. **Remove the Digi 001 PCI card from its static-free bag.**

   Grip it from the edges (like holding a CD of your favorite music) and be careful not to drop it.

5. **Locate an open PCI slot (consult your computer’s manual if you don’t know where this is) and gently push the Digi 001’s card into the slot — it will only go in one way.**

   Be careful not to bend the card or use excessive force, but make certain you have it fully seated into the PCI slot. If you’re unsure where the PCI slots are or how the PCI card fits, consult both your computer’s manual and the Getting Started guide that comes with the Digi 001.

   Take your time and don’t rush this step. I’ve seen more than one Digi 001 system that had intermittent problems because of an improperly installed card.

6. **Screw the screws for the PCI card in to fully seat the card.**

7. **Close your computer case.**

Next you need to connect the PCI card to the main Digi 001 unit, using the included cable. This cable attaches to the long connector on the back of the PCI card (which you can now find at the back of your computer) and the other end connects to the connector labeled “Computer” on the back of the Digi 001. Make sure you have the cables firmly connected. Now just boot up your computer and install your Pro Tools software!

### Connecting your gear

You’ve probably noticed that the Digi 001 unit has no power plug or switch, although there is a Power On LED indicator on the front panel. The 001 gets its power from your computer over the multipin cable. If your computer is on, then so is the 001.

Mic- and line-level I/O connections for the Digi 001 are handled in much the same way as for the Mbox, but the Digi 001 has a few tricks hidden up its sleeve. As with the Mbox, inputs 1 and 2 (mounted on the front panel of the breakout box) are on Neutrik combo XLR/quarter-inch connectors. The rear panel has six more line inputs on quarter-inch TRS jacks. Inputs 3 and 4 can be used normally (as inputs for Pro Tools) or can be routed directly out the MON Out L/R jacks (*MON* being short for *monitor*) by pressing the Monitor Mode switch on the front panel of the Digi 001.

The output section has eight line-level output jacks, as well as an “extra” set of outputs labeled MON Out L and MON Out R. These normally have the same signal coming out of them as you would get from Outputs 1 and 2, but
with a couple of twists. We already discussed how pressing the front panel Monitor Mode switch directly routes the signal from inputs 3 and 4 directly to these outputs. In addition, however, you can control the volume level of the signal coming out of the MON Out L/R jacks with the Gain knob. This knob, mounted on the front panel, is right between the Monitor Mode switch and the Power LED indicator, just to the left of the Headphone Volume knob.

Digital I/O is also available on the Digi 001 with the S/PDIF coax and ADAT lightpipe connectors. The S/PDIF connectors are located on the back of the breakout box, while the lightpipe connectors are located on the PCI card. (Book 1, Chapter 3 explains these digital connectors in detail.)

The two MIDI ports on the back of the Digi 001 can be connected with standard 5-pin MIDI cables. You should connect the MIDI Out of your MIDI keyboard to the MIDI In jack on the 001, and the MIDI Out jack back into the MIDI In jack on your keyboard or other MIDI device.

The Digi 001 also includes a jack for an optional punch in/out foot pedal. These were very popular back in the days of the four-track cassette mini-studios; a musician could use a footswitch to “punch” in or out of Record mode, leaving both hands free to play an instrument. You can use a footswitch with the Digi 001 to do the same thing, but most people use other methods these days. You get a look at some possible ways to toggle Record mode on and off when we start discussing using the Pro Tools software later in this book, but for those who are more comfortable with the “old school” method, the jack is there.

After connecting all the inputs and outputs on the Digi 001 to their proper components, you may wonder about the “mystery” connector on the back of the Digi 001 labeled “Serial.” It’s not mentioned in the Digidesign Getting Started guide that comes with the Digi 001.

What is it? What does it do? Why is it there? Well, there’s been a ton of speculation about that little connector over the past couple of years. I’ll let you in on a little secret: It doesn’t do anything. It isn’t even connected inside the unit. (Don’t open yours up to look though — you will void your warranty.) Why is it there? No one really knows for sure.

**Digi 002 Rack**

The Digi 002 Rack, shown in Figure 2-3, is similar to the older Digi 001 in terms of its basic input and output capabilities, except it uses a FireWire cable to connect to your computer instead of a PCI card. This makes installing it considerably easier, since (assuming your computer already has a suitable FireWire interface installed), it doesn’t require opening your computer case to install anything.
In addition, the Digi 002 Rack is capable of high sample-rate operation at up to 24 bit/96 KHz. The difference in sample rates offers a subtle improvement in sound quality, along with the more-noticeable sonic improvements that result from the upgrades Digidesign made to the analog-to-digital and digital-to-analog converters and the microphone preamps.

While Digi 001 systems are available on the used market at very attractive prices, I would suggest getting a 002 or 002 Rack instead if your budget can handle it. It’s definitely a better-sounding interface and the new features are well worth the added cost.

**Discovering the ins and outs of the Digi 002 Rack**

The Digi 002 Rack and Digi 002 feature nearly the same inputs and outputs as the Digi 001, with a couple of differences. Like the Digi 001, they have eight analog inputs, but four of those inputs feature microphone preamps, instead of just the two found on the Digi 001. The Digi 002 Rack and the Digi 002 retain eight channels of ADAT lightpipe, two channels of S/PDIF digital I/O, and a single MIDI In jack, but they also give you two MIDI Out jacks instead of just one. This can be handy if you have more than one MIDI keyboard or sound module you want to connect to Pro Tools, but not so many that you have to add another MIDI interface to your system. The Headphone jack and its volume control are also included, as well as the main Monitor Out volume control. The Digi 002 Rack and the Digi 002 also include a pair of separate, switchable Aux (auxiliary) inputs and Alt Main Analog outputs; you can use these to connect a CD player or other line-level source to your system.

**Hooking up the 002 Rack**

Hooking up the Digi 002 Rack is as easy as plugging in a few cords — some between your computer and the 002 and others between your instruments and the 002. This section covers these connections.
Connecting to the computer

Compared to connecting the Digi 001, hooking up the Digi 002 R to your computer is child’s play:

1. Shut down your computer.
2. Attach the included IEEE 1394 (FireWire) cable to one of the 1394 connectors on the back of the 002 Rack.
3. Plug in the other end of the cable to the FireWire connector on your computer.
4. Connect the power cable to the Digi 002 Rack and plug it into the wall power socket.
5. Turn your computer back on and install your software.

As with the Mbox, you should avoid using any “hubs” and instead connect the Digi 002 Rack directly to a FireWire port on your computer.

I suggest that you boot your computer first, and then power up the 002 Rack after the boot finishes up. You’re not going to break anything if you power up the 002 Rack first and boot later, but things tend to function better if you follow the procedure given here.

Connecting your gear

Although connecting audio and MIDI gear is much the same process for the Digi 002 as for the Digi 001, there are a few differences. First, there’s no PCI card for the 002 Rack; the ADAT lightpipe connectors are on the back of the rack unit, where they’re labeled Optical.

Why Optical instead of ADAT? Well, these use light instead of magnetic impulses. In addition to functioning as ADAT lightpipe connectors, these can also be set for use as optical S/PDIF connectors.

The ADAT lightpipe interface only functions at the 44.1/48 KHz sample rates, while the optical S/PDIF can be used at any sample rate, including the higher rates of 88.2/96 KHz. Either the coax (RCA) S/PDIF connectors or the optical connectors can be used, and even have cables connected to them at the same time, but only one or the other can be active at once. If you are working with a 44.1/48 KHz sample rate session, it is possible to use the analog inputs, 8 channels of ADAT lightpipe and the coax S/PDIF all at the same time, giving you a maximum of 18 possible inputs and outputs — eight analog and two of either optical or coax S/PDIF digital.

Like the Digi 001, the 002 Rack has a pair of monitor outputs, perfect for connecting to your powered monitor speakers. You can adjust the playback volume with the Monitor Level control on the front of the Digi 002 Rack. The
002 Rack also includes a Mute switch, which cuts off all sound from these outputs, and a Mono switch that combines stereo output into a monaural signal (handy for checking the mono compatibility of your mixes).

Two more pairs of jacks are also new to the Digi 002 Rack:

✦ **Alt Source Input:** These jacks can be routed to inputs 7 and 8 of the Digi 002 (instead of whatever is plugged into the normal line 7 and 8 inputs) or sent directly to the Monitor Outputs. This is useful if you want to listen to a tape deck or CD player without firing up Pro Tools software or your computer.

✦ **Alt Main Output:** These jacks duplicate the signal coming out of the Main Outputs 1 and 2. These jacks are handy if you have two sets of monitors and you want to hook them both up to your system.

The Digi 002 Rack also includes a jack for an optional footswitch for hands-free punching in and out of recording. It’s lacking the “mystery serial connector” from the 001, but that’s no great loss since that connector didn’t do anything anyway!

**Digi 002**

The Digi 002 (shown in Figure 2-4) is a groundbreaking product for two reasons:

✦ It’s the first Pro Tools hardware interface that can use the new high sample rates of 88.2/96 KHz.

✦ It has a full-featured control surface built in — an external device that moves the software controls in Pro Tools. This allows you to perform many tasks using dedicated hardware controls instead of having to use the computer mouse to adjust software controls. Many people find dedicated hardware switching a far more familiar and intuitive way of working. While it’s true you can adjust things like channel faders (used to control volume levels for individual tracks) just fine with a mouse, it’s often easier to grab a physical fader and move that instead. Also, unlike an on-screen control panel, a hardware control surface gives you enough things to grab that you can actually adjust several different things at once — perfect when you want to fade out one instrument while simultaneously fading in a second part. As with the 002 Rack, the microphone preamps and converters are significantly improved over those found on the Digi 001, resulting in even better sound quality. And since the 002 Rack uses a FireWire interface to connect to your computer (it’s the first Pro Tools hardware interface to use this method), installation is considerably easier.
Déjà vu-ing the ins and outs of the Digi 002

The ins and outs of the Digi 002 are identical to those of the Digi 002 Rack unit described in the previous section. If you thought something looked familiar here, you’re right.

Examining control surface features

The control surface is the only real difference between the Digi 002 and Digi 002 Rack, but it’s a big difference. As with the Rack version, you have controls for four mic preamps, as well as the headphone and monitoring controls. While the control surface doesn’t completely eliminate the need for a keyboard and mouse, many functions that would require them when using a Digi 002 Rack can be controlled directly from the control surface of the Digi 002, which has six main sections (described next).
**Fader section**

The Fader section takes up most of the Digi 002’s top panel. It includes

- **8 motorized, touch-sensitive, 100mm faders**: These faders control volume levels of individual tracks, among a host of other functions. These faders also move to follow the changes of the faders on-screen. This feature is helpful when performing complex mixes with automation. (Book 6, Chapter 6 has more on automating mixes.)

- **Mute, Solo, and SEL (select) buttons**: These buttons control the Mute, Solo, and Selection functions in the software.

- **Rotary Encoders**: Encoders are used for panning the sound from one channel to another, and for other functions such as adjusting reverb settings or other plug-in parameters.

- **Encoder Meter LED Rings**: These rings are used for showing the position of your encoder knobs, track levels, and so forth.

- **Channel Scribble Strips**: This is where abbreviated names of the corresponding Pro Tools tracks and other information such as fader values and plug-in parameters are displayed. Like many other areas of the Digi 002, these scribble-strip alphanumeric displays are multifunctional. They display a variety of different data besides just track names, depending on how other switches on the 002 are set.

**Console/Channel View section**

The Console/Channel View section is the collection of buttons just to the left of (and directly above) the Scribble Strips. These buttons, when used along with the Scribble Strips, SEL buttons, Rotary Encoders, and Encoder Meters (and even the eight main faders), offer a variety of capabilities from viewing and adjusting the Aux Send levels to changing the parameters for panning, channel inserts, and plug-ins.

*Views* is the Digidesign term for what’s displayed on the Digi 002 control surface and the 002 offers two views: Console and Channel.

- **Console View**: What you see on-screen is a virtual console; you can adjust panning, sends, and inserts for all channels on the control surface.

- **Channel View**: All of the Rotary Encoder controls and Scribble Strips are used to display and manipulate controls of various types — plug-in parameters, inserts, or sends — for a single track. If, for example, you want to see all the values for a particular plug-in (or all the send levels for a particular track) at once, Channel View is the way to get a look at it.

The switches directly above the Scribble Strips are used to select which type of data is displayed; you can navigate through various plug-in pages, bypass a plug-in, or exit Channel View and return to Console View.
Global Fader controls
Located just to the right of the channel faders, the Global Fader controls affect how all of the faders will operate as well as their assignments. The following list spells out what each Global Fader control does:

✦ **Record Enable:** The Record Enable switch does just what its name suggests — it enables the recording capability for tracks when you press. Pressing the Channel Select switch immediately after that is how you specify the track(s) you want to, uh, record-enable.

✦ **Fader Flip:** The Fader Flip switch functions in a variety of different ways, depending on which View mode you’ve chosen at the moment. Normally, when you press this button, it flips the main Channel Faders and the Rotary Encoders. Then you can use the Channel Faders to control panning and other functions normally handled by the Rotary Encoder controls. Hey, sometimes that’s just more intuitive.

The Send Flip mode, which operates when you’re in Console View, allows you to adjust send levels with the Channel Faders instead of the Rotary Encoders, and the Plug-in Flip mode, which functions when you are in Channel View and have a plug-in open, allows you to use the Channel Faders to control the parameters of software plug-ins such as compressors and equalizers.

✦ **Master Fader:** The Master Fader switch gives you the ability to move all master faders in your Pro Tools session to the far right hand side of the control surface.

Transport and Navigation controls
Located just to the right of the faders is the Transport and Navigation section, offering dedicated controls for transport functions — record, play, stop, and so on. These duplicate the on-screen transport controls found in the Pro Tools software.

A large, circular collection of four switches holds the Navigation and Zoom keys. Used along with the three keys immediately above them (labeled Bank, Nudge, and Zoom), these are used to zoom in and out of waveform displays, select banks of faders in groups of eight, or nudge the faders to the left or right, one track at a time. This allows you to control all the on-screen faders with just the eight hardware faders on the 002. Magic? Maybe not, but it’s close enough for rock’n’roll.

There are also buttons for selecting Loop Playback and Loop Record, to enable or disable Quick Punch, and to switch between the Edit, Mix, and Plug-in windows in the Pro Tools software.

The Function/Utility switches on the far right of the 002 are primarily used for when you use the Digi 002 as a standalone mixer without a computer.
You’d use these switches to handle such tasks as entering Utility mode, naming channels, and taking fader and control “snapshots” (as well as saving and recalling them) so you have a clear record of exactly what you did in a particular session. The F4 and F5 keys are surprisingly useful for running the Pro Tools software — read on to find out how.

F4 temporarily disables that spooky movement of the motorized hardware faders, without affecting the actual automation within the Pro Tools software. This feature can be handy when you’re recording yourself with a microphone in the same room as the 002 and you don’t want your microphone to pick up the sound of the faders moving around. When you’re done, just press F4 a second time and fader operation returns to normal.

The F5 switch can call up plug-ins you’ve inserted on various tracks and allows you to quickly change to various data-display modes for the Scribble Strips.

**Status Indicators and Display Controls**

Directly above the Transport and Navigation controls is the Status Indicators and Display Controls area of the Digi 002.

Here you’ll find a multi-LED displays that indicate the following:

✦ Sample rate for the current session.
✦ Successful communication with your computer via the FireWire interface.
✦ Whether or not MIDI data is being received at the MIDI In port or being transmitted out of either MIDI Out port.

Two additional Scribble Strips are also located here (called the Display Scribble Strips). These displays have two modes — these can be toggled by pressing the Display Mode switch:

✦ **Status mode**: This displays the current status of the Channel Scribble Strips, letting you know exactly what sort of data they are displaying, such as pan, sends, EQ, and so on.
✦ **Counter Mode**: This displays the current value of the main location indicator in the Pro Tools software, letting you know exactly what position you’re currently at within your song. This can be displayed as either bars and beats, minutes and seconds or in samples, depending on which of the three is selected as the main time scale in the Pro Tools software.

The Encoder/Meter Mode switch allows you to change the type of data displayed by the Encoder Meter LED rings that surround each Rotary Encoder control. As you toggle this switch, the meters display either levels or panning positions. This capability is available for mono or stereo channels and
sends (the signal going to effects); the three Encoder / Meter Mode LED indicators show you the current status.

Switches for Enter, Undo, and entering Standalone Mode are also located in this section.

**Keyboard Modifier switches**
As you start using Pro Tools, you’re likely to suspect right away that many tasks are performed by pressing a combination of two or more keys on your keyboard simultaneously. These *keyboard shortcuts* can save a lot of time compared to fishing around in the program menu for the action you want to perform. The Keyboard Modifier switches duplicate the most-often-used computer keys used for these commands (such as Shift, Option, and Control).

**Hooking up the 002**
Connecting the Digi 002 is done in the exact same way as the Digi 002 Rack as described in the previous section. Hook up the 1394 FireWire cable to the back of the Digi 002 and the other end to your computer’s 1394 FireWire port, plug in the power cable, and you’re all set to install your Pro Tools software.

It’s always best to follow this standard procedure: Turn on your computer first, and then power up the 002 after your computer finishes booting. You’re not going to break anything if you turn the 002 on first, but the software tends to function with improved stability this way.
Chapter 3: Examining Software Basics

In This Chapter

- Getting to know Pro Tools conventions
- Configuring system settings
- Understanding sessions
- Managing files

Pro Tools software is one of the more-simple and easy-to-get-started-on audio programs out there, but like any software there are some basic conventions that you need to know in order to work as efficiently as possible. This chapter covers the basics so you can better understand your software and get your system configured properly. This chapter also shows you how to open, set up, and navigate sessions as well as how to manage file formats and file types.

Keeping Software Straight

Pro Tools comes in several versions: TDM and LE, for example, Mac and PC, versions 6 and earlier. Although there are only minor differences between them, knowing such differences will help you better understand your own system. Read on to find out the details.

Looking at LE and TDM versions

Digidesign, the maker of Pro Tools software, offers two basic types of systems: LE and TDM. Although this book focuses on Pro Tools LE, you may end up encountering the TDM version if you take your files to a commercial studio that uses a TDM system. In this section, I offer an overview of both types of systems.

Pro Tools LE

Pro Tools LE is a host-based system — the Digidesign hardware (the 002, for example) acts as an interface between the analog-and-digital world and the software. Pro Tools software relies on the processing power of your computer’s CPU to work — all the recording, playback, mixing, editing, and
other processing you do is dependent on the power of your computer. So, the more powerful your computer, the more you’ll be able to do with your Pro Tools LE system. Pro Tools LE has a limited number of tracks that you have active (playing or recording at once). For versions 5.3.2 and newer the limit is 32 and for versions 5.3.1 and lower the limit is 24 tracks.

**Pro Tools TDM**

Pro Tools TDM systems are *processor-based* — such systems provide special computer chips that go into the computer to handle all the processing needs of the software. This takes the load off the computer and guarantees certain levels of performance. Pro Tools TDM has been the professional standard because Digidesign hardware (with its own built-in processors) can offer a stable, reliable, and predictable level of performance, and putting the same processors in your computer can give you the same performance. Your track limits are much higher with the TDM system compared to the LE version — up to 128 audio tracks — and these track counts are guaranteed by the Digidesign DSP (*Digital Signal Processing*) chips. The downside is that TDM systems are much more expensive than the LE version.

As a way of offsetting the higher cost, Digidesign has offered a few things to TDM users that LE users don’t have. These include more and better plug-ins and a few extra editing and mixing options. The good news is that any recordings you do in your LE system can be opened in a TDM system (at a commercial studio, for instance) to mix or otherwise process your tracks. This is handy if you want to record at home and then take it to a pro to mix.

**Distinguishing between software versions**

There’s one thing you can count on in the computer world: New software versions are always being developed and improved upon. There’s not a lot you need to know about the different software versions, except that prior to version 5.3, Pro Tools LE was limited to 24 tracks. Newer versions, up to the current 6.1, can go up to 32 tracks.

Chances are you use version 6. If, for some reason, you decide to open a session and work on it in a version before 5.3 — and you have 32 tracks of material in your session — you lose any tracks above 24 if you try to save the session in that earlier version.

**Differences between Macs and PCs**

Aside from the obvious hardware and operating-system differences between Apple- and Windows-based computers, Mac and PC versions of the Pro Tools software are nearly identical. The only significant difference you’ll find between the two is in the keyboard shortcuts you use to perform certain tasks. Throughout the book I give both versions of the shortcuts.
Getting Set Up

Before you can do any work in Pro Tools, you have to set up both your hardware and your Playback Engine settings. This section walks you through how to do this.

Setting hardware settings

One of the first things you need to do before you start using Pro Tools in earnest is to configure your hardware settings within the software program. This is done using the Hardware Setup window, shown in Figure 3-1. (To get there, choose Setups ➪ Hardware Setup from the main menu.) Within this window you can check out your peripherals as well as set the clock source, bit rate, and digital input. I give you a rundown of these options in the following sections.

Figure 3-1: The Hardware Setup menu is where you configure your hardware device.

Peripherals

Located in the upper-left portion of the window, the Peripherals pane shows the hardware you have hooked up to your computer. In the case of Figure 3-1, it’s the Digi 002. If you have a Digi 001 or Mbox, you’ll see either one of those listed in this pane.

Clock Source

This drop-down menu allows you to choose your source for the digital master clock. This makes sure that if you have more than one device (a separate A/D converter connected to your Digidesign interface, for example), all devices are synchronized. If you just use the Digidesign interface, simply choose Internal in this menu, but if you have other digital devices, such as a digital mixer or external converter, choose your clock source based on the device that has the best clock. In this case, you can choose from the following options:
✦ **Internal:** Uses the digital clock inside the Digidesign interface.

✦ **ADAT:** Synchronizes from a signal sent into the ADAT input of your interface.

✦ **S/PDIF:** Synchronizes to a signal sent via the coaxial S/PDIF input.

✦ **Optical (S/PDIF):** Synchronizes to a S/PDIF signal coming in the ADAT optical input. You can only choose this last one if you have the lower option checked in the Digital Input check box. (See the following section.)

For more on ADAT, S/PDIF and Optical connections, check out Book 1, Chapter 2.

Before you can use one of the digital connections as a clock source, you have to connect the device to your Digidesign hardware — and then you adjust the setting in the Hardware Setup menu. Otherwise the device won’t show up in the window.

If you have more than one digital device connected (such as a digital mixer connected to your Digidesign interface), do some experimenting by recording with different clock sources; compare the chosen sources to see which one gives you the best sound. (Digital clocks vary in quality.) Also, if you have more than three digital devices connected to your system, consider using a specialized master clock and distribute this clock source to all your devices. This will likely give you a better sound because it makes sure that all your devices are following the same clock timing.

**Digital Input**

This check box lets you choose how the digital inputs on your Digidesign hardware function. For example, with the Digi 002 you can use the Optical jacks (located on the back of the device — see Book 2, Chapter 2 for more) to send and receive either ADAT or S/PDIF signals. Your two options in this section of the window are

✦ **RCA:** Selecting this option means your RCA jacks send and receive S/PDIF signals while the Optical jacks send and receive ADAT signals.

✦ **Optical:** Selecting this option means your RCA jacks are disabled (you can no longer send and receive ADAT signals) and the S/PDIF signals are sent through the optical jacks instead.

**Sample Rate**

The Sample Rate drop-down menu allows you to choose the sample rate in which to work. Depending on your hardware, you can choose 44.1kHz, 48kHz, 88.2kHz, or 96kHz. Check out the Book 2, Chapter 2 to see which sample rates are supported by your Digidesign device and, while you’re at it, check out Book 1, Chapter 1 for the nitty-gritty of sample rates.
The Sample Rate drop-down menu is only editable when you don’t have a session open. If you have a session open, this box will show the sample rate chosen when this session was created but won’t allow you to make any changes. To choose a different sample rate, close the session you have open and then choose Setups ➪ Hardware Setup from the main menu, make your choice, and then click OK. Then open a new session. This new session will be in the sample rate you just chose.

**Playing with the Playback Engine settings**

The Playback Engine window is where you can tweak various options — hardware-buffer size, CPU-usage limit, and playback-buffer size, for example — so your system runs at top efficiency. Getting there — where “there” looks a lot like Figure 3-2 — involves choosing Setups ➪ Playback Engine from the main menu. As for what all these options actually mean, the following sections take care of that.

**H/W Buffer size**

H/W here stands for “Hardware,” and the hardware-buffer size controls the amount of memory used to handle the processing of audio (as well as plug-ins like reverb). The lower this setting, the lower the latency (time it takes to get sound into and back out of your system) that you hear when you record.

I suggest that you keep this setting as low as possible while recording (especially when you do overdubs). How low you can go depends on how many tracks you record at once — and whether you want to use plug-ins like reverb while recording. Using lots of tracks and lots of plug-ins requires lots of memory, which may force you (rats!) to bump up the hardware-buffer size. Higher buffer sizes mean higher latencies, which can make overdubbing tracks more difficult, so I reserve high buffer sizes until after I’m done recording all my tracks.
When you’re ready to mix, go ahead and raise the buffer size. This will put less stress on your system and allow you to have more plug-ins going at a time before you run into performance problems.

**CPU Usage Limit**
This menu allows you to set the amount of the computer’s processing power (as a percentage) that is used to run the program. The default is 65%, but you can go much higher if you only have Pro Tools open when you work. The more programs you have open when working in Pro Tools, the lower the setting you want to have. Set it as high as you can without affecting the response of your screen redraws. A good setting to start with is around 75% to 85%.

**DAE Playback Buffer**
The DAE (Digidesign Audio Engine) playback buffer deals with the amount of memory the audio engine uses to manage the hard drive’s buffers. Again you want as low a setting as you can get without sacrificing system performance. If the setting is too high, you experience a delay between when you hit the Play command and when Pro Tools starts playing the recording. Too low a setting, on the other hand, can create problems such as audio dropout — the sound cuts off — when you record or play back tracks. Start with the default setting and make adjustments as needed.

**The ins and outs of inputs and outputs**
Pro Tools allows you to assign your Input, Output, Insert, and Bus routings as you want. You do this within the I/O Setup window, shown in Figure 3-3. (Choose Setups ‹ I/O Setup to get there.)

**Input**
The Input tab of the I/O Setup window menu lets you choose and change the name of the inputs coming from your Digidesign hardware. Simply clicking the Default button brings up the inputs of the hardware you have connected. If you want to change the name of any of the inputs, double-click the current name, type in your new one and press Return. Whatever name you choose shows up in the Input section of the channel strip in the Mix and Edit windows.

Customizing the names of your inputs and outputs makes setting up sessions and remembering where everything is routed much easier. For example, if you use the S/PDIF inputs as your main microphone inputs (you’d have an external preamp and a A/D converter between your mic and the interface) you can name them mic 1 and mic 2 instead of S/PDIF.
Instead of choosing the default setup, you can start from scratch and set up your own Input routings by selecting the New Path or New Subpath options. You can also delete paths if you choose. Additionally, you can import or export routing settings by choosing the Import or Export buttons. This can save you time if you have custom settings that you want to use in all your sessions.

**Output**

Clicking the Default button in the Output tab of the I/O Setup window displays the outputs of the hardware connected to your system. As was the case with the Input tab of the I/O Setup window, you can change names for the outputs if you want. The Output tab, however, has three additional options, as shown in Figure 3-4: Meter, Audition, and Default Output. These options do the following:

- **Meter**: This is the output assigned to the master meter in the Mix window. This pop-up menu lets you assign any of your hardware or bus outputs as main outputs so you can know what the levels are.
- **Audition**: This is the output where audio regions — the representations of the audio files in your tracks — play. (Book 4, Chapter 1 has more on audio regions.)
- **Default Output**: Choosing your main output here automatically places this output in every track that you open in your session. Making your main output your default output makes things quicker and easier because you don’t have to choose an Output setting in the Mix or Edit window whenever you create a new track.
Dealing with Sessions

Insert
The Insert tab of the I/O Setup window allows you to set the routing for any of your insert effects, such as compressors and limiters. (See Book 6, Chapter 4 for more on insert effects.)

Bus
The Bus tab of the I/O Setup window has the 16 available buses for your send/return effects, such as reverb. (Check out Book 6, Chapter 5 for more on send/return effects.)

TIP
Choose Default for all the settings in the various tabs of the I/O Setup window and you’ll be up and running quickly.

Dealing with Sessions

Before you can do any recording, editing, or mixing in Pro Tools you have to set up a session in which to work. A session in Pro Tools is simply a song file that contains all the audio and MIDI tracks, plug-ins, and mixer settings for all your tracks. Session files don’t actually contain the audio data; they just have the audio files attached to them.

Creating a new session
To create a new session, choose File → New Session from the main menu or press Command+N on a Mac or Control+N on a PC. A dialog box appears, as shown in Figure 3-5, where you can choose the following:
Dealing with Sessions

✦ **Session Name**: This is where you type the name of this new song.

✦ **File location**: You can choose where you want to save the file on your hard drive. I recommend that you use the handy New Folder button to create a new folder for storing the session file and that you name the folder the same as your session file. This makes it easy to find on your hard drive — especially if you haven’t worked on the session for a while.

✦ **Audio File Type**: This pull-down menu lets you choose between BWF (*Broadcast WAV* File), AIFF, or SD2 files. Choose the one that works best for you. (I always use BWF files because they’re compatible with other software I use. Your needs may be different.) If you aren’t transferring your files from one program to another, I suggest using the default BWF option.

✦ **Sample Rate**: Here you choose the sample rate of your session. Your options will depend on the Digidesign hardware you have. For example, if you have the Digi-001 or M-Box, your choices will be between 44.1kHz and 48kHz, whereas if you have a Digi-002 or 002r, you can choose between 44.1kHz, 48kHz, 88.2kHz, and 96kHz.

The higher the sample rate, the more work your computer’s processor has to do. Often you have to balance your desire for the highest-resolution music possible against the capabilities of your system.
The sample rate you choose depends on your goals, intended final format (CD, for example), and the speed of your computer’s processor. For example, if your session is going to have a ton of tracks and end up on a CD, your best bet is to choose 44.1kHz because that’s where you’ll end up when you record to CD. Keep in mind, too, that a whole slew of tracks means your computer will need as much processing power as possible to handle mixing and processing tasks. In this case, recording at 96kHz would likely put too much strain on your computer and deprive you of the power to do what you want during mixing.

On the other hand, if you suspect you won’t use very many tracks and want the highest resolution possible — or if you have a very powerful computer and won’t go crazy creating multiple tracks — 88.2kHz or 96kHz may meet your goals better.

I recommend getting to know your system before you record a lot of music with it. Experiment with different sample rates and track counts to see what your computer can handle. With this information, you can get a good sense of how hard you can push your system before you reach the limits of its performance.

✦ **Bit Depth:** In this box, you can choose between 16- and 24-bit rates. Choose 24 bit.

✦ **I/O Settings:** In this dialog box, you can choose between the most recently used setting or a stereo-mix setting.

✦ **Forced Compatibility:** Checking this box ensures that if you transfer your session from a Mac computer to a PC, you can still open the session and work in it. Leave this box checked.

### Opening sessions

To open a session, choose File ➪ Open Session from the main menu or press Command+O on a Mac or Control+O on a PC. No matter which command you choose, you get the Open Session dialog box shown in Figure 3-6. Choose the file you want to open and then click Open.

It’s worth repeating: If you have a session with more than 24 tracks and you want to keep those additional tracks, don’t open it in a Pro Tools version before 5.3 (or if you do, don’t save it in there) because any additional tracks will be lost when you hit Save.

### Saving sessions

You have three options for saving sessions in Pro Tools: Save Session, Save Session As, and Save Session Copy In. These options are detailed in the next sections.
Dealing with Sessions

Examining Software Basics

Saving a Session

This is the same Save command that you find in any computer program. As usual, it’s located under the File drop-down menu. (You can also initiate a save by pressing Command+S (on a Mac) or Control+S (on a PC).

I highly recommend that you get used to hitting Command+S often to keep from losing any data while you work. You can also turn on the Auto Save function and have Pro tools save your session automatically. Choose Setups ➪ Preferences to access the Preferences dialog box, click the Operations tab, and then click in the Enable Session File Auto Backup box.

Using Save Session As

The Save Session As command is located under the File menu; use it to save your session with a new name and/or location. Figure 3-7 shows the Save As dialog box.

Use this command if you want to save a variation of a session that you’ve been working on. I do this a lot when I’m mixing because this way I can have a bunch of different mixes to choose from later on. The good thing about this command is that it only saves the session data and not the audio or MIDI files so it won’t take up much room on your hard drive.
Choosing Save Session Copy In

If you want to transfer your files from one program to another (Pro Tools to Logic, for example) the Save Session Copy In command can be useful. Choosing File ➪ Save Session Copy In opens the dialog box you see in Figure 3-8. Here you can change the file name, location, and file type, among other options. Each of these are detailed in the following bullet list:

✦ **Session format**: This pop-up menu lets you choose the Pro Tools version you want to save in. Your options will include the current version as well as PT5, PT4 24bit, PT4 16bit, and PT 3.2. (Keep in mind that you may lose some data if you save this session in an earlier version.)

✦ **Session Parameters**: The session parameters include audio file type, sample rate, and bit depth. You can choose from the same options that you had when you first opened the session. Within this box you can also choose to force Mac/PC compatibility. If you want to share this session between a Mac and PC, you need to have this box checked. Personally, I leave this box checked all the time, just in case I want to transfer my sessions back and forth.

✦ **Items to Copy**: The Items to Copy box includes options for audio files, plug-in settings, and movie or video files that may be part of the session. If you plan on taking this session to another computer, use this option when you choose what you want to copy.
Dealing with Sessions

Relying on Revert to Save

Revert to Save (located under the File menu) is a handy feature if you’ve done a bunch of work since you last saved your session and want to undo it without having to use the Undo command (located under Edit menu) to backtrack through the steps and undo each one.

Personally, if I’m in the position of wanting to undo a bunch of stuff and haven’t used the Save command since starting those changes, I choose to Save As the session. This way I have those changes just in case that, after thinking about it for a while, I do decide to keep them. If I go that route, the changes will be sitting in a separate session file, safe and (ahem) sound.

Creating a session template

To make your life easier, you can create a session template with all the options you want already in place — track settings, window views, mixer settings, and so on — so all you have to do when you open a new session is open the template and save it with your new session name.

To prepare a template, start by opening a new session and then creating your session as you want. After you’ve got all the options set, save the session file with a name that you’ll remember (like killer session template 1) so you can find it easily.

To transform the session file you saved into a session template, do the steps listed in one of the following steps lists — one for the Mac and one for the PC.
Using a Mac

Heads up, you Mac users out there:

1. **Single-click the file to highlight it.**
2. **Press Command+i or choose File $\text{\textbullet\textbullet}$ Get Info from the main menu.**
   
   The General Information window opens, as shown in Figure 3-9.
3. **Check the Stationery Pad box and close the window.**
   
   Your template is now saved in the location that you chose when you opened the session in the first place.

To later open your template, choose that template name after you choose File $\text{\textbullet\textbullet}$ Open Session from the main menu.

Using a PC

PC users, here’s the drill:

1. **Right-click the file icon to highlight it and choose Properties from the menu.**
   
   The Properties window appears.
2. **Check the Read Only box under Attributes on the bottom of the page.**
3. **Press OK to close the Properties window.**
   
   Your session file is now turned into a template for later use. It remains located in its original folder.

To later open your template, choose that template name after you choose File $\text{\textbullet\textbullet}$ Open Session from the main menu.
A variety of session templates comes with your Pro Tools Hardware. To use them, choose the Pro Tools LE Session Templates folder from the Software CD-ROM and drag it onto your hard drive. Open the template session and rename it as your new session. You can use this folder for all of your templates so that finding them again is easy — when you want to use one simply choose File→Open session from the main menu, select the template folder from the Open Session dialog box, and scroll to the template you want to use.

**Getting to Know Audio and MIDI Files**

Every time you hit the Record button with a track engaged (as in Book III, Chapter 1, where you can find more on tracks) you create an audio or MIDI file. This section walks you through what these files are and how to deal with them.

**Understanding audio files**

An *audio file* is the data created from recording onto an audio track. Audio files in Pro Tools are called *regions*. You can import, export, and edit these regions in a staggering variety of ways. (Book 4 shows you many of the ways to edit audio.) Whenever you create a new audio file, this region is added to the Audio Regions List, where you can manage it (as in Figure 3-10). The Audio Regions List is located on the right side of the Edit window. If the list isn’t visible, click the double arrows at the bottom-right of the Edit window. This expands the Edit window to include the Audio and MIDI Regions List view.

![Figure 3-10: Audio files created by recording into an audio track show up in the Audio Regions List.](image)

**Meeting MIDI files**

*MIDI files* are created whenever (you guessed it) you record MIDI data into a MIDI track. MIDI tracks don’t contain actual sounds; instead, they consist of
the MIDI performance and system instructions used to control a MIDI instrument. To have the MIDI data become sound, you have to record the output of your MIDI sound module (what it does in response to the MIDI file's instructions) onto an audio track. Then these sounds are contained in an audio file.

MIDI files show up in the MIDI Regions List (shown in Figure 3-11), where you can manage them. The MIDI Regions List is located in the lower-right section of the Edit window, below the Audio Regions List. If the List isn’t visible, click the double arrows at the bottom-right of the Edit window. This opens the Audio and MIDI Regions list sections of the window.

Finding your files

Whenever you open a session in Pro Tools, the program has to go out and find all the audio and MIDI files associated with that session before the session will actually open. If, for some reason, Pro Tools can’t find the files — if you’ve moved them, for instance — then a Missing Files dialog box opens. There you can choose to skip the file, let Pro Tools search for it automatically, or search for it manually. (See Figure 3-12 for a look at the Missing Files dialog box.) I always choose the Automatic Search option — it finds the missing file nearly every time. The only time that hasn’t worked for me is when I’ve moved a file to another hard drive. (Then I choose the manual selection method.)
After your session opens, all the audio and MIDI files (regions) for that session are displayed in the Audio Regions List or MIDI Regions List in the Edit window. Not only can you manage the files from these lists, but you can also import files that were originally recorded in another session — or even using another recording program (such as Logic or Nuendo).
Chapter 4: Understanding the Pro Tools Windows

In This Chapter

- Looking at the Transport window
- Examining the Mix window
- Discovering the Edit window

Recognizing that recording is a complex process, Pro Tools gives you three distinct windows in which to work: Transport, Mix, and Edit. Each window performs a certain set of functions and gives you control of a specific set of details. These are outlined in the sections to follow. These windows are the heart and soul of Pro Tools and the more comfortable you are navigating them the easier life will be as you create your masterpieces.

Tackling the Transport Window

At its most basic level, the Transport window — see Figure 4-1 — acts like the transport mechanism of a tape deck that moves the tape past the record and playback heads: It controls the digital processes that correspond to recording, playing, stopping, rewinding, and so on. On a deeper level, however, it also offers a host of other functions. This section details all the Transport window’s functions.

Figure 4-1:
The Transport window acts like the controls on a tape deck.
**Adjusting the Transport window**

There are those of us who salivate at the thought of information overkill and those of us who live by the maxim “Less is more.” Pro Tools is smart enough to accommodate both schools of thought. In case you don’t want all the information (and the accompanying clutter) present in the Transport window as shown in Figure 4-1, you can show or hide parts of it as you choose. You can find the commands for paring down the size of the Transport window under the Display drop-down menu at the top of the main Pro Tools window. Just choose Display → Transport Window Shows and then choose from the options listed — Counters, MIDI Controls, and Expanded — as shown in Figure 4-2.

**Basic controls**

The upper-left portion of the Transport window is home to your basic, traditional transport controls. If you honed your recording skills on a tape deck, you’ll be right at home. Taking a look at Figure 4-3, you’ll find (going from left to right) the following:
✦ **Online:** Engaging this button allows you to control record and playback with an external device. Before you can use this feature, you need to connect your device and specify its synchronization settings in Pro Tools. (Check out the Synchronization section of the Pro Tools Reference guide that came with your software for details on how to do this.)

✦ **Return to Zero:** Clicking here takes you back to the beginning of the session. You can also press Return on a Mac or Enter on a PC if you prefer to use your keyboard instead of the mouse.

✦ **Rewind:** This button “rewinds” the session in one of two ways, providing a fine-tuned control that’s really hard to get with the mechanics of a tape deck:

  - Press the button down and hold it. The session rewinds until you release it. One cool thing about this way of rewinding is that when you release the Rewind button, a marker is placed in the song — and all you have to do to rewind back to that point is hit the Stop button. The session goes right back to that point. (This is great if you want check the same spot several times — for example, to make sure that new guitar part comes in right on cue.)

  - Click the button. Each click rewinds the session a prescribed amount, depending on the time-scale setting displayed in your Main Counter (more about that in the next section). For example, if you have your Main Counter set up to display bars and beats, then clicking the Rewind button moves the session back one bar of music. If you have min:seconds or samples showing in the display, then the session moves back in one-second increments.

✦ **Stop:** Stop simply stops the session. (You can get the same thing done much faster, though, by pressing the Spacebar on your keyboard — no fumbling with the mouse required.)

✦ **Play:** The Play button starts the session. Simply hitting the Play button (or pressing the Spacebar) starts playback; pressing the Record button first and then the Play button starts recording (as long as you have a track enabled to record — and Book 3, Chapter 3 covers this in detail).

✦ **Fast Forward:** To move quickly through the session, just use the Fast Forward button. You can use Fast Forward one of two ways:

  - Press and hold the button. The session fast-forwards until you release the button. Depending on whether you were playing the session when you press and hold the button or the session was stopped, releasing the Fast Forward button can either return you to play mode or stop the session at that point.
• Click the button. Each click forwards the session a prescribed amount based upon the time scale setting displayed in your Main Counter (see next section). For example, if you have your Main Counter setup to display bars and beats, clicking the Rewind button moves the session back one bar of music. If you have min:seconds or samples set in the display, the session moves back by one-second increments.

✦ Go to End: This button takes you to the end of the session. If you don’t want to use your mouse, you can also press Option+Return on a Mac or Control+Enter on a PC.

✦ Record: The Record button readies your session to record any enabled tracks (Book 3, Chapter 3 talks about this more). You need to have at least one track enabled for this function to work. You’ll be alerted if you don’t. If you want to skip using the mouse, you can ready recording by pressing Command+Spacebar on a Mac or Control+Spacebar on a PC. To actually record you need to press the Play button after pressing Record.

In addition to readying recording, you can toggle through the different Record modes by pressing the Control key while you click with your mouse (on a Mac) or right-click (on a PC). These Record modes are covered in detail in Book 3, Chapter 4, but here is an overview:

• Nondestructive: This Record mode is indicated (rather subtly) by not showing an icon in the Record button; it doesn’t delete any previous takes (a take is a recorded performance) on that track.

• Destructive: This mode — indicated by a small D in the center of the Record button — records over the track, destroying any previous takes as it does so. Don’t use this mode unless you absolutely don’t want the previous take, because it’s gone forever.

• Loop: This mode — indicated by a loop graphic inside the Record button — allows you to repeatedly record over a selected section of your track (called, curiously enough, a loop). It’s a handy function if you have a section that may need more than one try to get right — when you’re done recording a take, it returns you to the start of the looped section and begins recording over again. Each loop through the section is saved and added to your track’s playlist where you can choose the best one later.

• Quick-punch: This mode is indicated by a “P” in the center of the Record button. Quick-punch allows you to automatically punch in and out of a section of a song. If, for example, your bass player just laid down a killer part except for two lousy notes, you can rerecord just those notes on the fly by punching in (start recording) just before the notes and punching out (stop recording) right after them.
Counters
The Counters section of the Transport window tells you where you are in the session. This section contains only the main counter for your session.

If the Counters section isn’t visible, choose Display ➤ Transport Window Shows from the main menu and then choose Counter — to see the Main Counter — and/or Expanded — to see the rest of the counters listed in this section. (Figure 4-4 shows how the Transport window looks with both these options checked.)

Expanded
The Expanded section of the Transport window shows a secondary counter for your session as well as additional goodies to help you get around your session. These include pre- and post-roll setting, a transport master selector for synchronizing Pro Tools with other devices, and start, end, and length times for selections. These are all shown in Figure 4-4.

The Expanded section of the Transport window contains the following display extras:

✦ Secondary Counter: Below the Main Counter is a secondary counter for your session. You can select the format displayed by opening the
pull-down menu to the right of the counter. Again, your choices are bars:beats, min:seconds, and samples. This lets you have two different counters displayed at one time, which is handy if you want to see where you are in your session in two different formats, such as minutes/seconds and bars/beats.

✦ **Pre-roll:** The pre-roll allows you to choose an amount of time that the session plays before a) the timeline of your session begins, or b) wherever you have the Start cursor. This is useful if you use a click track (the equivalent of an electronic metronome) or want to do some punch recording; whoever’s playing can use it to get used to the tempo before you start to record. (See the “MIDI controls” section, later in this chapter, for more on using a click track. See Book 3, Chapter 4 for more on punch recording.)

You choose the amount of your pre-roll by clicking in the value in the Pre-roll counter and then either typing a new value or (with the mouse button held down) scrolling up or down. Engage the Pre-roll function by clicking the Pre-roll box next to the counter.

✦ **Post-roll:** The post-roll is pretty much like the pre-roll except (surprise, surprise) in this case you tack on a specified amount of time after the session ends (or wherever the timeline End point is set).

You choose the length of your post-roll by clicking in the value in the Post-roll counter and either typing a new value or, with your mouse held down, scrolling up or down. Engage the Post-roll function by pressing the Post-roll box next to the counter.

✦ **Transport Master:** The drop-down menu of the Transport Master box lets you choose a specific device for the main Transport functions (play, record, stop, and so on) to control. In this menu, you can choose from several options, including MMC (MIDI Machine Control), MIDI, and Machine. (The last-named refers to Digidesign’s MachineControl software, which you have to buy from Digidesign. This is used for post-production and film work.) If you want to get into synchronizing Pro Tools with other devices, check out the Digidesign reference manual for details on how to do this. If you have no other control devices synchronized to Pro Tools, then this box says Transport = Pro Tools.

✦ **Start:** Use the Start counter to set the beginning of a range within which you can play or record. You choose this starting point by clicking in the Counter window and then either typing in the value or clicking and holding with your mouse (scrolling up or down to get the value you want).
✦ **End:** The End counter shows you where the play or record range ends. You can choose this endpoint by clicking in the counter window and then either typing in the value or clicking and holding with your mouse (scrolling up or down to get the value you want).

✦ **Length:** The Length counter shows the length of the play range created with the Start and End counters. As with the other counters, you can type in a value by clicking in the counter window first or you can click and hold your mouse button while you scroll up or down.

Typing in a value other than what is shown after you set the Start and End counter changes the placement of the End counter.

**MIDI controls**

The MIDI controls section is located on the right side of the Transport window. (If it’s not showing in your Transport window, choose Display ➪ Transport Window Shows ➪ MIDI Controls.) The MIDI Controls section, shown on the right side of Figure 4-5, includes the following:

**Wait for Note:** Clicking this button lets Pro Tools know it should wait to start recording until it receives a musical note from a MIDI device. This allows you to ensure that your first note is precisely at the beginning of the recorded section.

**Click:** This button turns on and off the metronome signal sent through the MIDI out of your MIDI interface.

Double-clicking this button opens the Click/Countoff Options dialog box (see Figure 4-6) where you can choose various Click parameters, including when the click sounds, what note it transmits, and what MIDI port (output) it uses.
✦ **Count-off:** This button turns on and off a specified count-off of the length chosen at the bottom of the Click/Countoff dialog box (Figure 4-6). (Double-clicking the Countoff button opens this box.) You can set the count-off to sound only during recording or during both recording and playback. You type in the length of this count-off in the Click/Countoff box. This number shows up in the count-off button once the dialog box is closed.

✦ **MIDI Merge:** Using this selector, you can either merge your recorded MIDI data with existing MIDI data on the record-enabled track or erase the existing data and replace it with the new stuff. Engaging the button lets you merge data.

✦ **Conductor:** Clicking this button turns on the tempo map defined in the Tempo line of the Edit window (see “Examining the Edit Window,” later in this chapter, for more on the Tempo line). You create this map by double-clicking the Meter button (described next). Alternatively, you can disable this button and choose a tempo by manually entering it (more about choosing the tempo in a minute).

✦ **Meter:** This button shows you the time signature for the present section of the session. Double-click this icon and a dialog box opens, allowing you to specify time signature (meter), tempo, and start point for these values. With this dialog box you can set up a tempo map, a scheme describing tempo changes for your entire song, no matter how complex. (Book 3, Chapter 2 details how to create a tempo map.)
Note: When the Conductor button is not engaged, the Note icon tells you what value note the metronome is sounding. Click this icon and a drop-down menu opens, letting you choose the value from whole notes to sixteenth notes.

Tempo: With the Conductor button engaged, this box simply shows you what tempo the current section of the session is in; with the Conductor button disabled, you can manually enter any tempo you like. You can do this in one of three ways:

- **Typing it in.** By clicking in the box where the tempo is displayed you can type in a number, in beats per minute. Press Return and the metronome and counters play at this tempo.

- **Tapping it in.** By tapping the Tap button you can get Pro Tools to play the tempo without you having to know exactly how many beats per minute you want. (This is a great feature for people who aren’t comfortable with metronome numbers.)

- **Sliding it in.** By adjusting the horizontal slider located under the Conductor, Meter, and Tempo buttons, you can choose your tempo. Slide to the right and you get a faster tempo; slide left for a slower one.

**Examining the Edit Window**

The Edit window, shown in Figure 4-7, is where you’ll do most of your work. Here, everything is set up in a timeline so you can see what’s happening in the session as it plays. This window contains a variety of tracking information, including inputs and outputs, sends, inserts, and automations data. The Edit window also has the tools you need to do any editing of audio and MIDI data you may want, such as creating, arranging, and editing specific regions of an audio track.

The list is almost endless. Don’t fret though; everything you need to know to use this window effectively is in this section.

**Taking a look at track controls**

Each track, whether audio or MIDI, is shown in the Edit window. These run horizontally underneath the Timeline section of the window. Figure 4-8 gives you a close-up view of the track section of the Edit window.
Examining the Edit Window

Figure 4-7: The Edit window shows a timeline of all your session data.

Figure 4-8: The track section of the Edit window shows information on each track in the session.
Basic controls
On the far left of the track section of the Edit window you have some basic controls. These include the following:

✦ Track Name button: By double-clicking this button (which shows the name of the track) you can open a window that lets you change the track's name and also add some comments. (All comments show up in the Comments section of the expanded Edit window or in the Mix window.)

✦ Playlist selector: Click and hold this button to open a drop-down menu that allows you to choose from edit playlists (see Book 4, Chapter 1 for more on edit playlists).

✦ Record Enable button: Press this button if you want to enable the track for recording.

✦ Solo button: Depressing this button solos a track — turns off the rest of the tracks — in a mix.

✦ Mute button: Depressing this button turns off this track.

✦ Track View selector: Click and hold this button to open a menu that lets you choose different views in the Timeline section of the track in the session. Your options include Blocks, Waveform, Volume, Mute, and Pan.

✦ Track Height selector: This arrow opens a drop-down menu from which you choose the height of the track data display. You choices include Mini, Small, Medium, Large, Jumbo, and Extreme.

✦ Automation Mode selector: Click and hold this button to open a menu that lets you choose from various automation modes, including volume, mute, pan, and send level. Each of these display modes shows the waveform in the background and the setting for the automation data in the foreground. (Book 6, Chapter 6 has more on automation modes and how to use them.)

✦ Voice selector: This button turns the track on and off. Click and hold this button to choose between auto (the track is heard if it has data in it) and off (the track doesn’t sound, even if it has an audio or MIDI file attached to it). Since Pro Tools LE only allows you to have 32 active voices (24 on versions 5.3.1 and older) you can use this selector to keep a track from occupying one of those voices.

Optional windows in the track section
You can enhance your Edit window view by adding information from the Mix window for each track. Just choose Display ➪ Edit Window Shows ➪ All from the main menu and you’ll end up with something that looks like Figure 4-9.
This is a handy feature if you only have one monitor and you want to be able to see the comments, inserts, sends, and I/O settings (or any combination) for each track without having to open the Mix window. (Not sure what inserts, sends, and I/O settings actually are? Don’t worry. I detail those in the “Managing the Mix Window” section, later in this chapter.)

One of the really cool things in this section of the expanded window is that you can actually open a channel strip for an individual track by clicking the small fader icon located at the lower right of the I/O settings window. Click the icon again and the channel strip disappears. Figure 4-10 shows the channel strip after being called up from the Edit window. (This feature is so handy that I rarely use the Mix window anymore.)
Examining edit modes

Editing in Pro Tools is done on regions. Regions are representations of the audio or MIDI files stored on your hard drive. What makes editing this way so powerful is that when you change a region you aren’t actually changing the audio file itself (there are some exclusions to this, which are covered in Book 4, Chapters 3 and 4, and Book 5, Chapter 3) you are only changing the way that Pro Tools plays it back.

When you want to move regions around in Pro Tools, you have four edit modes in which to work: Shuffle, Spot, Slip, and Grid (shown in Figure 4-11). These are located in the upper-left corner of the Edit Window. The following bullet list describes each of these modes:

- **Shuffle:** Using this mode, you can shuffle a region around and place it automatically at the end of the nearest region. For example, if you want to move the second bar of a four-bar phrase to the last bar, all you have to do is create a separate region for each bar, grab it by clicking it with the Grabber tool, and move it over to the end. (Book 4, Chapter 2 explains, in detail, how to do this.) The third bar moves over to replace the second; the original second bar snaps right to the end of the fourth bar. This mode is handy for shuffling regions around while making sure that there is no overlap or dead space between them.

- **Spot:** You can use this mode to designate the exact timeline placement of a region you want to move. When you click a region with Spot mode active, a dialog box pops up, asking you to enter the start point. Do so, click OK, and the selected region is placed right where you want it.

- **Slip:** Use this mode to move regions anywhere you want with your mouse by selecting them any of the ways described in Book 4, Chapter 2. You can have regions overlap or leave space between them, for instance.
✦ Grid: This mode enables you to move regions to a time grid — user-defined divisions of your session. You can set the time grid’s scale by choosing Tools ➪ Grid Value in the main Edit window.

For more detailed information on these edit modes, check out Book 4, Chapter 1.

### Zeroing in on Zoom controls

The Zoom controls (Figure 4-12) are located next to the Edit Mode selectors. Use these buttons to fit a good working view of your audio and MIDI regions into your screen by specifying horizontal and vertical zoom (as the following list makes clear):

- **Horizontal Zoom:** These outer two Zoom buttons control the horizontal zoom of the timeline, and of all audio and MIDI tracks and regions. Clicking the left button narrows the view; clicking the right button lengthens it.

- **Vertical Zoom:** These two center Zoom buttons control vertical zoom for audio and MIDI — the button for audio is at center-left and the one for MIDI is at center-right. Clicking the arrow at the top of either button increases the height of the display; clicking the arrow at the bottom decreases the height.

- **Zoom Presets:** At the bottom of the Zoom Controls section are five — easily programmable — presets. On a Mac, you simply Command+Click any one of the five buttons to assign your present setting to that button. On a PC, Control+Click does the trick. The zoom settings are saved and you can recall them by clicking on the assigned preset number.

### Elucidating edit tools

Pro Tools has some powerful editing features, easily accessible from the Edit toolbar found next to the zoom controls at the top of the Edit window.
Figure 4-13 shows you what the toolbar icons for these tools look like and the following list tells you what the tools can do for you:

- **Zoomer**: The Zoomer tool does much the same thing as the Horizontal Zoom tool, with a handy editing advantage: It zooms right in to the point that you click with your mouse or the area you click-drag across.

- **Standard Trimmer**: This tool lets you change the size of a region by clicking the beginning or end of the region and then sliding it to where you want it.

- **Selector**: Use the Selector tool to highlight a spot within a region so you can cut, paste, or do whatever you want with it. All you have to do is click and drag the mouse over the section you want to select.

- **Grabber**: In general terms, the Grabber tool lets you grab a region to move around your session. It has two options (which you can view if you click and hold the mouse button with the pointer over the tool): the Time and Separation tools (whichever tool you used last is the default tool until you select the other).

  - **Time**: The Time Grabber tool lets you select an entire region and then move it anywhere within — and between — tracks. You simply click the region with your mouse, hold down the button, and then drag the region to where you want it.

  - **Separation**: The Separation Grabber tool lets you move a portion of a region within or between tracks. To select a portion to move, use the Selector tool shown earlier in this list.

- **Scrubber**: The Scrubber tool lets you listen to a region without having to play the entire track. To use this tool, click the region and drag it forward to hear the audio play forward. Drag the mouse back along the
Examining the Edit Window

region and you can ear the audio play backward. This tool is handy when you want to locate a specific note in the audio region.

✦ **Pencil:** The Pencil tool can be used to redraw audio waveforms (great for drawing over clipped notes for example), to do MIDI editing, such as inserting or deleting notes, or to draw automation settings, among other things. (Book 4, Chapter 3 explains waveform editing in detail.) Clicking and holding this button opens a pop-up menu that offers five Pencil types (shown in Figure 4-14) as well as the Customize Note Duration option to use. (For more on custom note durations, see Book 4, Chapter 3.)

![Figure 4-14: The Pencil tool has five pencil shape options.](image)

✦ **Smart Tool:** This tool combines the functions of the Standard Trimmer, Selector, and Grabber tools. It changes the way the cursor works according to where you are within a region, automatically becoming the appropriate tool for that section. This keeps you from having to constantly switch tools as you work. (Ah, progress.)

**Looking at Counter displays**

The Edit window has two distinct Counter displays, and for each display you have a choice among three different formats — *bars and beats, minutes and seconds,* and *samples* — for showing where you actually are in the session. You choose your format from a drop-down menu that you access by clicking the small arrow located to the right of the display, as shown in Figure 4-15. This is a handy feature for being able to see where you are in your session. For example, I find that having my main counter to bars and beats and the secondary counter set to minutes and seconds helps me keep track of where I am in the session and how that relates to the actual length of the tune. This is especially important if I have a tune that has to conform to a certain time limit, since I prefer to work in beats and bars.
Evaluating the Event Edit area

Next to the Counter displays are the Event Edit displays. (See Figure 4-16.) These displays show the start point, end point, and length of a selected region in the same format as the main Counter display (see previous section for more on Counter displays). If you choose a specific MIDI note to examine, another window opens that shows you the pitch, note velocity, and release velocity of that note.

You can use the display to choose particular regions by clicking in the window and typing in the values you want. Press Return (Mac) or Enter (PC) to activate the selection.

Instead of typing start points and end points into the Event Edit display, you can use the blue arrows in the Rulers section of the Edit window to choose your start point and end point, as shown in Figure 4-17. Click and drag each arrow to where you want it. You can also use the Selector tool and click-drag across the area you want to select. Book 4, Chapter 2 explains these options in detail.
You’ll find Edit Mode buttons, Zoom controls, Edit tools, Location displays, and Event Edit displays — all the stuff we’ve talked about so far in this chapter — marching along the very top of the Edit window. Right beneath all these features, however, is a thin black toolbar that plays host to yet another variety of useful tools. (Refer to Figure 4-7 to see the black toolbar in all its glory.) The following list gives you the goods on what each tool can do for you:

✦ **Track View:** The Track View tool lets you choose different view formats for the Track section (the left-most column) of the Edit window. Clicking the downward-pointing arrow calls up a pop-up menu, where you can choose Comments view, I/O view, Inserts view, Sends view, All, or None.

✦ **Ruler View:** The Ruler View tool lets you choose different view formats for the Ruler section — the section running horizontally along the top of the Edit window. Clicking the downward-pointing arrow calls up a pop-up menu, where you can choose to see the Main Counter, Tempo, Meter, Markers, All, or None. The selection(s) you make here appear in the Timebase ruler section of the Edit window. (Check out the “Rulers rule!” section later in this chapter for details on the Timebase ruler.)

✦ **Tab to Transients:** The Tab to Transients button, when engaged, allows you to press the Tab key on your keyboard and move from transient to transient in the highlighted audio track. (A transient, by the way, is the loud initial attack that first attracts your attention to a sound.)

I love this feature for separating drum loops from a track. I simply engage this button, locate my cursor close to the start of my loop, hit the Tab key, and I’m right at the start of the section I want to cut. Without this feature I’d be messing around for quite a while to find the exact start point of the part I want to separate.

✦ **Command Keyboard Focus:** The Command Keyboard Focus button toggles the Keyboard Focus option on and off. What is the Keyboard Focus option, you ask? Well, here’s the short answer: This option allows you to use your keyboard to perform shortcuts — for example, you can select regions from the MIDI or audio lists (see the “Looking at lists” section later in this chapter), perform an edit, or enable or disable groups. For the long answer — as in, how do you actually use keyboard shortcuts? — these shortcuts are interspersed throughout the book for each command as I describe them.
**Link/Unlink:** By default the Timeline and Edit selections are linked so that if you choose a section to edit, the Timeline start and end times coincide with the start and end times of this selection, as shown on the left in Figure 4-18. Sometimes you want to be able to have a timeline setting remain unchanged as you select a different place to edit, as on the right in Figure 4-18. (In this case, click the Link/Unlink button once to turn linking off; click again to turn linking back on.)

**Grid Value:** This display shows the value for the Edit Window’s grid — the boundary lines for your session. The grid boundary value appears in the same format as the main time scale — bars/beat, min: seconds, or samples — unless you choose otherwise in the pull-down menu, where you also choose the boundary resolution for the grid itself. This is a great function when you want to move regions around in a tune and have them align to certain locations. For example, if I move drum grooves around I can have them snap right to the beginning of a bar by setting the grid value to 1 measure and moving the region close to the start of the measure.

**Nudge Value:** The Nudge Value display shows the setting for the distance that a region is moved with each press of the plus and minus keys on your keyboard. Clicking the downward-pointing arrow calls up a pop-up menu, shown in Figure 4-19, where you can choose this “nudge” value. Note that you can choose a number of different ways how your distances are to be measured — Bars:Beats, Min:Secs, Samples, or Regions/Markers.
Examining the Edit Window

Cursor: The Cursor display tracks where your cursor is in the timeline as well as the location of the sound wave in the selected track. (See Figure 4-20.)

Looking at lists

In the humdrum world, it’s hard to get excited about laundry lists and shopping lists. In the world of Pro Tools, however, lists are something to crow about, because they can help you keep track of your tracks, audio regions, MIDI regions, and groups.

The lists for your tracks, edit groups, audio files, and MIDI files are displayed on either side of the Edit window. To keep track of — and/or manipulate — any of these lists, you’re going to want to familiarize yourself with one more list of features:

Show/Hide Tracks list: The Show/Hide Tracks list lets you choose which tracks get displayed in your Edit and Mix windows. As Figure 4-21 shows,
you can choose to show all tracks, hide all tracks, or to show/hide only those tracks you’ve already selected. This menu is opened by click-hold-
ing over the Show/Hide title at the left side of the Edit window. (Refer to Figure 4-7.) If the Show/Hide section of the window isn’t visible, click the double arrows at the far lower left of the Edit window. The Show/Hide and Edit Groups (see next bullet) section appear.

✦ **Edit Groups:** In Pro Tools, you can group together selected tracks and perform an edit on them all at the same time. This is called working with an Edit Group. These groups are displayed in the Edit Groups list and clicking the name of the group toggles the enabling of a group on and off. You can also create, delete, or suspend groups by click-holding the Edit Groups title at the top of the groups list and then choosing an option from the pop-up menu that appears, as shown in Figure 4-22.

✦ **Audio Regions:** Audio Regions in Pro Tools are the representations of the audio files associated with your session. The Audio Regions list shows all the audio regions that are part of your session. You can do a
host of things to your audio regions such as renaming them, clearing them, exporting them, compacting them, and so on.

These functions are performed by opening the pop-up menu shown in Figure 4-23. To open this menu, click-hold the Audio title at the top of the Audio Regions list. If the Audio Regions list isn’t open in your session, click the double arrow at the bottom-right corner of the Edit window to open it.

✦ **MIDI Regions:** The MIDI Regions list shows all the MIDI regions in your session. By clicking open the pop-up menu shown in Figure 4-24, you can manage your MIDI regions by (for example) sorting them, renaming them, and importing them. This menu is accessed by click-holding the arrows next to the name of the track.
Rulers rule!

Lists hover discretely to the left or right of the Edit window. Rulers (as you might expect) lord it over the top of the Edit window and are masters of all they survey.

In Pro Tools-speak, rulers are actually referred to as Timebase Rulers; they show you where you are within the session (Figure 4-25). The Timebase Rulers section of the Edit window also lets you view the time, tempo, meter, and markers of a session. The following list gives details the four timelines:

Figure 4-25: The Timebase Rulers section of the Edit window shows where you are in the session.

Figure 4-26: The Ruler View Shows menu is located in the display drop-down menu at the top of the screen.

- **Time**: You have a choice between the now-familiar formats of Bars:Beats, Min:Secs, and Samples. By default, this timeline shows the same time format as the Main Counter, but it’s easy to change to one of the other formats. Just choose Display ► Ruler View Shows and then choose the format you want included in the Timebase Rulers section, as shown in Figure 4-26.
**Tempo:** The Tempo timeline shows you all the tempos and tempo changes in your section. But there's more! Using the Tempo timeline, you can quickly change the tempos in the session by clicking the little Note icon to the left of the Tempo title all the way to the left side of the figure. Doing so opens the Tempo Meter Change dialog box, where you can enter a new tempo for the session. Book 3, Chapter 3 goes into detail about creating Tempo changes (called tempo maps) in your session.

If you don’t plan on having any tempo changes and really don’t want to see the Tempo timeline, you can hide it by choosing Display ➪ Ruler View Shows from the main menu and then deselecting the Tempo option.

**Meter:** This timeline shows the meters (time signatures) contained in your session. To change the meter, click the little #/# icon to the left of the Meter title all the way to the left side of the figure. This opens the Tempo Meter Change dialog box.

If you prefer not to see this timeline, you can hide it by choosing Display ➪ Ruler View Shows from the main menu and then deselecting the Meter option.

**Markers:** The Markers timeline shows the position of session markers. (For more on session markers, see Book 3, Chapter 2.) Clicking the Marker icon to the left of the marker’s name opens a dialog box where you can enter your marker information, as shown in Figure 4-27. Markers are great for quickly locating sections of your tune. For example, pacing a marker at the start of the verses and choruses can make moving between them a breeze. You can even use markers in Pro Tools to recall visual settings — track height, zoom settings — or record and playback options — pre- and post-roll times — as well as the enabling of grouped tracks for speedy editing.

![Figure 4-27: The Markers dialog box lets you set and define marker locations.](image)
Managing the Mix Window

The Mix window is like a standard mixer, housing channel strips of each track type available in Pro Tools. Not only do these track types include audio, MIDI, auxiliary, and master tracks, as shown in Figure 4-28, but you can also choose various views of the channel strips, from a basic view to expanded views showing comments, inserts, and sends. Moreover, in addition to all your channel strips, the Mix window can list all the tracks in your session, along with any grouped tracks you may have created.

I know this sounds like a lot to keep track of (so to speak), but don’t worry. The upcoming sections fill you in on all you need to know to keep things straight.

Checking out channel strips

Each track in the Mix window has its own channel strip, and these channel strips perform the same kinds of tasks you’d see channel strips doing in a
hardware mixer, stuff like volume control, panning, effects sends and inserts, mute and solo switches, automation, input and output routing, and enabling recording. The Mix window can handle pretty much any kind of track you can imagine, including the track types covered in the next few sections.

**Audio track**

Your audio track is your basic meat-and-potatoes track, the main building block in your sonic universe. Getting the audio track to do exactly what you want takes a lot of work; Pro Tools is well aware of this fact, and therefore provides you with a full-featured tool palette so you can take care of business. More specifically, the audio track’s channel strip contains the following tools (as shown from top to bottom in Figure 4-29):

- **Input:** Clicking the Input button opens a pop-up menu where you can choose the sound source that feeds the track. It can either be a physical input from your hardware interface or it can be a bus (an internal signal path; see Book 1, Chapter 3 for more on buses). The hardware you use (Digi-002, M-Box, or whatever) determines the number of inputs you have to choose from.

- **Output:** This button controls the output of the track — where the sound goes when it leaves the track. Like the input selector button (see above) clicking it opens a menu that lets you choose from either the hardware outputs of your interface or any of 16 buses (internal signal paths) available in Pro Tools.

- **Automation Mode:** In Pro Tools, *automation* means having certain mix parameters, such as volume, panning, mute, send level, and insert level adjust dynamically throughout the session. Using this button you can choose between the different automation modes, including Off, Read, Touch, Latch, or Write. (Book 6, Chapter 6 details these automation modes.)

- **Panning Slider:** Use the slider to pan your track to the left or right in the stereo field, which is sort of the audio equivalent of a movie scene. (For more on panning, see Book 6, Chapter 1.)

- **Panning Display:** This display shows you your track’s panning position — its place left, right or center, in the stereo field.

- **Solo and Mute:** These buttons either solo or mute the track. (For more on soloing/muting, see Book 6, Chapter 1.)

- **Record Enable:** Pressing the Record Enable button enables the track for recording. When enabled, this button flashes red.

- **Voice On/Off:** This selector lets you choose between Off, where the track does not play, or Auto, where the track plays if there is data present.
✦ **Volume Fader:** This is the control for setting the volume of the audio contained in this track.

✦ **Velocity Meter:** This display, located to the right of the Volume Fader, shows you the volume (“velocity,” in Pro Tools-speak) of the track as the music plays. Any notes above digital 0 show in red at the top of the display.

✦ **Group:** The little red `G` is present if this track is grouped with others. You can find out which group it belongs to by clicking and holding over the icon.

✦ **Track Type:** This icon shows you what type of track it is. In Figure 4-28, the small waveform lets you know that this is an audio track.

✦ **Numerical Volume:** This display shows you the volume of the track in decibels.

✦ **Track name:** This tells you the name of the track. You can change the name at any time by clicking the name and typing in a new one.

---

**MIDI track**

The MIDI track, shown in Figure 4-30, shares many of the features of the audio track, but there are some important differences, as the following list makes clear:

✦ **Input:** The Input button lets you choose the MIDI input feeding this track. Clicking the button opens a pop-up menu where you can choose the MIDI port and channel(s) that you want to receive MIDI data from.
✦ **Output**: The Output button lets you choose the physical MIDI output that you want to assign the track to — any of the 16 MIDI channels (or choose All).

✦ **Program Change**: This button lets you change the sound that comes out of your MIDI hardware when a note is played. Clicking this button opens the MIDI Program Change dialog box. In it, you enter the program number or name of the sound to want the track to play. This lets you change sounds throughout the session,

✦ **Track type**: This MIDI track icon looks like a MIDI port.

**Auxiliary input track**

An auxiliary input track is a track that you can use for grouped audio — or for MIDI tracks, effects sends, submixes, alternative mixes, monitor mixes, and so on. Auxiliary tracks are similar to audio tracks and have the same functions, except you don’t have a record-enable button because these tracks don’t actually contain any audio; they are only for routing other tracks through them. The Track Type icon is a downward-facing blue arrow. Figure 4-31 shows a typical auxiliary track’s channel strip.

![Figure 4-30: The MIDI Track channel strip lets you control the MIDI track easily.](image)

**Master Fader track**

The Master Fader track lets you control where your other tracks are sent. This track’s channel strip is much simpler than the others; all it really does is sum (add) the other tracks together. The features include just the outputs, automation modes, fader and velocity display, and the Groups button.
The Track Type icon for a Master Fader track is a sideways M. Figure 4-32 shows a Master Fader Track's channel strip.

**Figure 4-31:**
The Auxiliary Track channel strip is used for effects sends, sub-mixes, and monitor mixes, among other things.

**Figure 4-32:**
The Master Track's channel strip controls the master tracks functions.

**Stereo and mono**
Each of the tracks can either be in monaural or stereo. Stereo tracks differ from mono tracks: They have two panning sliders and two velocity displays showing. Figure 4-33 shows a stereo track.
Stereo audio tracks take up two voices in your system. (Any audio track that’s active takes up a “voice” — Book 3, Chapter 1.) Since you can only have a total of 32 voices playing in any one session at one time, you need to choose your stereo tracks wisely.

**Expanding the view of the channel strips**

You can add three additional views to your channel strips by choosing Display ➤ Mix Window Shows from the main menu and then selecting Comments, Inserts, and/or Sends. Figure 4-34 shows you what you can expect to see, and the next few sections tell you the particulars for each view.

**Comments view**

Using this option, you can add comments to each track — just click the Comments box and type in your comments. This can be helpful for keeping track of things like microphones used, edits performed, or anything that can keep you organized while mixing.

**Inserts view**

The Inserts View section of the channel strip displays any inserted DSPs (Digital Signal Processors) that you have for each track — usually effects such as compression or delay. Click the arrows in the window to open a pop-up menu where you can choose from the plug-ins in your system. Figure 4-35 shows a typical list of these inserts. (Book 6, Chapters 4 and 5 have more on inserted effects.)
Book II
Chapter 4
Understanding the Pro Tools Windows

Managing the Mix Window

Figure 4-34: Your channel strips can be expanded to include views for comments, inserts, and sends.

Figure 4-35: The Insert pop-up menu lets you choose your inserted effect.
Sends view

The Sends View section of the channel strip lets you choose an effect bus to send your track’s signal to. Clicking the arrows opens a pop-up menu (shown in Figure 4-36) where you choose the bus or interface output to send your track’s signal. (If you use outboard effects, see Book 6, Chapter 5 for more details.)

Looking at lists: The Mix Window variant

Plenty of lists appear in the “Examining the Edit Window” section (earlier in this chapter), but Pro Tools listmaking capabilities crop up in the Mix window as well. Aside from containing all the channel strips for your project, the Mix window can also be set to list all the tracks in your session — as well list any groups you’ve created with those tracks. These lists show up on the left side of the Mix window, as shown in Figure 4-37.

Show/Hide Tracks list

Going from top to bottom, the first list to the left of the Mix window is the Show/Hide Tracks list. Each track of your session is listed in this list and with this List you can show or hide each track by simply selecting or deselecting it in the List window. When you hide a selected track, the channel strip disappears from the Mix window. This makes it easy to work with individual tracks or groups of tracks by keeping your Mix window uncluttered. To show a hidden track, click that track’s name in the Show/Hide Tracks list and watch it reappear.
Groups list

The Groups list lets you create and manage grouped tracks — tracks that you’ve assigned together so that you can edit them together. To create groups of tracks, hold the Shift key down and click the names of the tracks in each channel strip to highlight them. After they’re highlighted, click and hold the Edit Groups title. When a drop-down menu appears, choose Create Group; when a dialog box appears, enter a name for your new grouped track. After you’ve created a few groups, you can show or hide them in any combination that you want.

Figure 4-37:
The Show/Hide Tracks list and Groups list allows you to organize your tracks in the Mix window.
Chapter 5: Importing and Exporting Files

In This Chapter

- Importing and exporting audio files
- Importing and exporting MIDI files
- Importing and exporting session data

One of the most powerful aspects of Pro Tools is that it can import a variety of file types and formats into a session, and export them just as easily. You can record tracks in another session (or even another software program) and be able to edit, mix, and process them in Pro Tools.

You can (for example) import and export audio files, MIDI files, and session tracks in formats from AIFF and BWF to Standard MIDI files (SMF) — and even import raw session data, the tracks, plug-in settings, and other session details. This chapter covers all these options — and if you have some files that use bit depths and sample rates different from the session you’re working on, I show you how to import them, too.

Importing into a Session

If you want to fancy up your Pro Tools session, you can import stuff not only from other Pro Tools sessions but also from other recording programs such as Logic. So prepare to get fancy.

Importing audio files

Before Pro Tools can import an audio file into your session, it has to find the file on your hard drive. Then you can either add the file directly, copy it first and then plunk it down in your session, or convert it to a different format before you import it. Here’s a look at the types of files you can import, as well as the steps that make it all possible.
Figuring out file types
You can import audio files of the following types into a Pro Tools session:

✦ **SDII:** This stands for Sound Designer II, formerly the native format for Pro Tools sessions on Macs. This format isn’t used much anymore and you can’t exchange files of this type with PC computers unless you first convert them into a different format, such as BWF or AIFF.

✦ **BWF (WAV):** This file type is the standard for older, PC-based Pro Tools systems. Currently it’s the most commonly used file type (for that matter, I normally work with it); BWF (Broadcast Wave Files) files are compatible with both Macs and PCs.

✦ **AIFF:** This stands for Audio Interchange File Format, and it used to be native to Macs. You don’t have to convert AIFF files to any other format before importing them into a Pro Tools session, even if it’s on a PC.

✦ **MPEG-1 Layer 3:** This type — yep, it’s the famous MP3 — is a great format for putting music on the Internet (say, a demo track for your band), as you’ll find out if you check out Book 8, Chapter 2. If you choose this option, you have several parameters to choose from when encoding your music so that you can get the best combination of size and sound quality.

MP3 is an “option” for Pro Tools: You have to buy the full-feature version of this capability if you want to use it any longer than its 30-day free-trial period. Once your trial period is up you can buy the authorization code to keep using this option from Digidesign for $20. Go to [www.digidesign.com/products/products.cfm](http://www.digidesign.com/products/products.cfm), click Compatible Software and, once that page loads, scroll down until you get to the MP3 options (there’s one for PCs and one for Macs).

✦ **RealAudio G2:** This file format is for streaming audio files received over the Internet using the RealAudio player. You can use this file format on all PCs and on Macs running OS 9, but not on Macs using OS X. RealAudio G2 uses compression to reduce the size of the music file — but when you downsize the file, you also lose some sound quality, so it’s not recommended for your final mix.

✦ **QuickTime:** This is a Mac-only file type, and Pro Tools offers no built-in support for it (even though it shows up here). The QuickTime format is useful if you want to send the file via e-mail to someone. You play QuickTime files using the Apple QuickTime player — a nice bit of software supported by many multimedia applications — but you have to purchase and install that program separately.
Sound Resource: This is a Mac-only format and the only time to use it (in my opinion) is if you want to play the music in an application that doesn’t support either SDII or AIFF formats. If you end up with a file in this format you can convert it easily using the Import Audio to Track command.

Windows Media: This is a Windows-only format. Like with other unsupported file formats, you can convert these files into something usable by accessing the Import Audio dialog box (Choose File > Import Audio to Track).

Importing audio

The previous section outlined the different types of files Pro Tools can handle. Now it’s time to look at how you can import those audio files into Pro Tools. The two most common ways of doing this are

From the Audio Regions list: The Audio Regions list is located on the left side of the Edit window. (If it’s not visible, click on the double arrows at the bottom right of the Edit window.) To get a file added to this list, click the Audio Regions List title to display the Audio Regions menu and then choose Import Audio from the options listed. Doing so gets you the Import Audio dialog box, as shown in Figure 5-1 — more on that later.

If you want to avoid the menu altogether, just press Shift+Command+I on a Mac or Shift+Control+I on a PC. This gets you to the selfsame Import Audio dialog box.

From the File menu: Choose File > Import Audio to Track to access the Import Audio dialog box, which you can then use to place the audio directly into a track in your session.

Whichever of these methods you choose, you end up with the Import Audio dialog box, where you choose the file you want to import.

To keep the Import process rolling along, follow these steps after the Import Audio dialog box opens:

1. From the File Browser section of the Import Audio dialog box, click the file you want to import.

The properties of the selected file appear in the lower half of the dialog box.
The easiest way to find the files you want to import is from the browser section, located under the From drop-down menu. You can use the scroll bar at the bottom to find the hard drive you want by moving it all the way to the left. From there, progress to the right by choosing the folders you want as you go until you get to the actual file you want to import.

You can limit the types of files that show up in the file browser by choosing to display only certain file types (WAV, for example) by selecting this file type in the Show drop-down menu.

Depending on the properties of the file you select — and the settings in your session — you have three options: Add, Copy, and Convert.

- **Add:** If the audio files are the same file type and bit depth as your session, you can add the files directly into your session. When you do so, you’re telling Pro Tools to use the original file — not a copy — from its current place on your hard drive.
If you have to add files of different file types into your session, you can — AIFF or WAV on a PC, SDII, AIFF, or WAV on a Mac — but doing so slows down system performance.

- **Copy**: If your file is of the same type and bit depth as your session, you can make a copy of the file to put into your session. Doing this allows you to place the copy directly in the folder with the other files in your session. If you destructively alter the copy, you won’t be altering how the original file plays in any other session. The only drawback to choosing Copy when importing an audio file is that you’re adding more stuff that takes up space on your hard drive (not a big deal these days, given the low cost of huge hard drives).

- **Convert**: If the file you choose to import is of a different file type, bit depth, or sample rate as your session, you need to convert it first before importing it into your session.

When you choose to convert a file, you also choose the quality of the conversion process. You set the conversion quality of your converted files by using the Editing tab of the Preferences window, as shown in Figure 5-2. (Choose Setups → Preferences to get to the Preferences window.) The menu that controls conversion quality is located in the middle of the Editing tab of the Preferences window. Options range from “TweakHead” (highest quality/slowest conversion) to “Low” (lowest quality/fastest conversion).
2. Audition the selected file before importing it by pressing the Play and Stop buttons in the lower section of the dialog box.

The vertical slider adjusts the volume of your audition; the horizontal slider adjusts your location in the auditioned file.

3. Click Add, Copy, or Convert to place the file in the Import list.

You can select more than one file by Shift+clicking to highlight the files you want to include in the list. You can also click Add All or Convert All to include all the files in the current directory on the Import list.

4. Click Done after you’ve placed all the files in the Import list that you want to include.

If you chose Convert or Copy when placing the file in the Import list, you’re prompted to choose a location for the imported files.

If you import using the Import to Track option from the File menu, your files appear in a separate track within your session and are listed in the Audio Regions list. If you import using the Import Audio command from the Audio Regions menu, the files appear in the Audio Regions list — not as a separate track within your session.

**Importing MIDI files**

MIDI data contains all the performance information for your MIDI instruments, but it doesn’t contain any actual sound — you need a sound source for that. Pro Tools lets you bring that data into a session where you can work with and add the sounds you want. This data is in the form of a Standard MIDI File. Standard MIDI files consist of data stored in a common format that can be read by nearly all MIDI devices. When you import a Standard MIDI file into Pro Tools, you get two choices: You can import the file directly into a track or you can import it into your session’s MIDI Regions list. This section details the types of MIDI files supported by Pro Tools and how to import them.

**Figuring out file types**

Pro Tools allows you to import the following two types of Standard MIDI files:

- **Type 0**: Type 0 Standard MIDI files contain all MIDI data on one track. When you import this type of file into a session, Pro Tools sorts out data appropriate for each stereo channel and places the data in separate regions and tracks.

- **Type 1**: Type 1 MIDI files contain multiple tracks of MIDI data. When you import this type of file into Pro Tools, each track’s data goes to a separate MIDI track or region in Pro Tools.
Importing MIDI

You can import standard MIDI files into a Pro Tools session one of two ways:

✦ **From the File menu:** Choose File ➪ Import MIDI to Track command in the File menu to access the Import MIDI dialog box (shown in Figure 5-3), which you can then use to place the MIDI file directly into a track in your session.

✦ **From the MIDI Regions list:** The MIDI Regions list is located in the lower right of the Edit window. If this list is not visible, click the double arrow at the bottom-right corner of the window. Choose Import MIDI from the MIDI Regions list menu, which is opened by clicking the MIDI title at the top of the MIDI Regions list. Doing so gets you the Import MIDI dialog box, which you can use to put your imported file on the MIDI Regions List. From there, you can drag the file into an existing MIDI track.

Whichever of these methods you choose, you end up with the Import MIDI dialog box, where you choose the file you want to import.

Select the file using the browser at the top of the dialog box. Highlight the file.

1. **If you want the tempo of the imported MIDI file to override the tempo of your present session, check the Import Tempo From MIDI File box.**
Like with the Import Audio dialog box, the easiest way to find the files you want to import is from the browser section located under the From drop-down menu. To navigate this browser section, move the scroll bar at the bottom of the section all the way to the left to find the hard drive that contains your MIDI files. Click it to select it then click the folders you want from the boxes on the right until you get to the file you want to import.

Choosing this option removes existing tempo-and-meter information from your current session. If you want to keep the tempo and meter settings of your present session, be sure to keep the Use Existing Tempo From Session check box selected.

2. **Click Import (on a Mac) or Open (on a PC).**

Your file is imported into Pro Tools.

You may get a message asking if you want to keep or discard any existing MIDI tracks or regions in the session. If so, choose one of the options. (If you already have MIDI tracks that you want to use in the session, be sure to choose to keep them; if not go ahead and discard them.)

Your successfully imported MIDI file is placed in your session one of two ways:

- If you imported using the File⇒Import MIDI to Track command, your file has been placed in the appropriate tracks in your session. If this is the case, select the MIDI channel and instrument you want to specify for each MIDI track’s output so that you can hear the performances when you play your session, as described in Book 2, Chapter 4.

- If you imported using the MIDI Regions list menu, your MIDI data has been placed in the MIDI Regions list. Click and drag the files from the MIDI Regions list into an existing track to put them in your session.

### Importing tracks

The Pro Tools Import Bag of Tricks is not limited to just audio and MIDI files. In fact, you can import entire tracks from another session into your current session just by using the Import Tracks command. Choose File⇒Import Session Data to call up the Import Session Data dialog box and you’re well on your way to getting that great track from last month’s session embedded in your present project.

### Understanding the Import Session Data dialog box

The Import Session Data dialog box is where you select the various properties of the tracks you want to import. If you’re bringing in a track from a previous session, this is where you choose what aspects of your original track you want kept (say, keep the plug-in settings and lose the panning settings) when it gets imported into your present session.
As Figure 5-4 shows, the Import Session Data dialog box gives you lots of properties to mull over. ("Do I import? Don't I import? What parts of this stuff do I or don't I import? Ack . . .") These properties include

✦ **Source Properties:** This box shows the basics — session name, session type, session start time, bit depth, and sample rate — of the selected source file.

✦ **Audio Media Options:** This drop-down menu lets you select the way you copy and consolidate the source’s audio files. Its options include

• **Refer to Source Media (Where Possible):** Use this option if you want to avoid duplicating files — it refers to your original files whenever possible. The files are only copied if they don’t reside on supported media (such as CD-ROM), or if they have a different sample rate or bit depth from the session you import into. This saves some space on your hard drives.

• **Copy from Source Media:** Choosing this option copies all the audio files, automatically converting any files that have bit depths or sample rates that differ from those of the target session. This uses up space on your hard drive, but with today’s super-cheap drives it’s not as big a deal as it used to be when drives were expensive.
• **Consolidate from Source Media:** This option copies and consolidates the audio in regions used in the source session, eliminating any unused audio from the parent files. When you choose this option, you also get to choose the “handle” length (the extra time before and after the region start and end times). This keeps you from importing any unnecessary material if you’re sure that you won’t be using it in your session.

• **Force to Target Session Format:** This option copies — and converts — any files that don’t have the same bit depth and sample rate as the target session; it points to (but doesn’t copy) any files that do match these traits. Use this option if you don’t want any extra stuff taking up room on your hard drives.

✦ **Video Media Options:** The drop-down menu here gives you two options when importing video data into a session: You can either copy the stuff or you can refer to the source material. Which option you choose depends on how much hard drive space you have and whether you think you need more than one copy of the original file. If you have tons of space and think you’ll be editing the data, by all means copy it, but if you know you won’t be making any changes there’s no need to add to the clutter of your hard drive.

✦ **Timecode Mapping Options:** Every video file contains time code data (information that lets you know where you are in the video). You can choose any of three ways to place imported material in the session:

• **Maintain Absolute Timecode Values:** This option puts your imported tracks at the same time location as the source session. This is a good choice if the session you import into uses the same start time as your source session and you want the imported session tracks to remain at the beginning of the session.

• **Maintain Relative Timecode Values:** This option places the imported material at the same time from the start of the session as their source session. This means that if you have tracks in a session that start 30 seconds from the beginning of the session, they will remain 30 seconds from the start of the session they’re imported into regardless of what the actual start time of both session are.

• **Map Start Timecode To:** This option lets you choose a new start time for your imported files. When you select this option, you also select the start time for your imported file in the Time Value field. This option is useful when you have a different start time on the session data you want to import and you want to place the imported data at a specific point in the new session. This start point is entered into the Time Value field.
Track Offset Options: Selecting this option allows you to place the tracks relative to their original start times. For example, if you want to import session data into a track and have it start four measures (bars) after the session starts you can select this option and enter four bars in the Time Value field.

Sample Rate Conversion Options: If your source and target sessions have different sample rates (you select the sample rate of a session when you create it), you are prompted to select the way the sample rate conversion is carried out. This area of the Import Tracks dialog box lets you do that using the following options:

- Source Sample Rate: This option lets you choose the sample rate from which your source files begin the sample rate process.
- Destination Sample Rate: This setting is always the same as that of your current session.
- Conversion Quality: This drop-down menu lets you choose the sound quality you get from the sample-rate conversion process. You have a choice among Low (fastest), Good, Better, Best, and TweakHead (slowest).

Source Tracks: This section of the Import Tracks dialog box shows you all the source tracks in the session containing the tracks you want to import. Each track has a drop-down menu that allows you to either select it for import or not.

Import Tempo/Meter Map: This check box allows you to import tempo and meter maps (specified tempo and meter events throughout the session) from the source session. Select this option if your source session contains tempo and meter information that you want to use in the target session.

Importing tracks

After you’ve had a chance to get comfortable with the Import Tracks dialog box, you can get some practical experience by using the following steps to import some actual tracks into a session:

1. Choose File: New Session to create a new session or choose File: Open Session to open an existing one.
2. Choose File: Import Session Data from the main menu.
   A dialog box appears, prompting you to choose a file from which to import session data.
3. Choose the Pro Tools file (.pts suffix) containing the track you want to import, and then click Open.
   The Import Session Data Dialog box opens. (Refer to Figure 5-4.)
4. In the Import Session dialog box, go through the Source Tracks list and click the name of each track you want to import.

To select multiple noncontiguous tracks, press and hold Ctrl (on a PC) or Command (on a Mac) as you click the track names. To select multiple contiguous tracks, press and hold Shift as you click the names.

5. From the drop-down menus, choose your Audio Media and Video Media, Timecode Mapping, and Track Offset options.

See the previous section, “Understanding the Import Session Data dialog box,” for more on how to use these options.

6. If the sample rate of your new session is different from the sample rate of the session you’re importing from, you need to first convert it to the target session’s rate before you can import it. Do this by selecting the sample rate of the source session from the Source Sample Rate drop-down menu and choosing a conversion quality.

You find this drop-down menu in the Sample Rate Conversion Options section of the Import Session Data dialog box.

7. If you want to import meter and tempo maps from the source session, click to put a check in the Import Tempo/Meter Map check box.

Importing these maps ensures that the target session will have the same meter and tempo as the source session.

8. Click OK.

9. If you chose to copy audio or video media — or consolidate data from them — select a location to place the media files.

Exporting from a Session

Pro Tools lets you export audio, MIDI, and region data from one session to another. This is handy if you want to take parts of a song and add them to parts of another song, as in the case of an R&B remix of a pop tune. This section describes the process.

Exporting audio

Pro Tools gives you several ways to export audio — as regions, as stereo interleaved files, or as region definitions, depending on what you want to do with it. Here a rundown on these options (and what the heck these terms mean):

✦ Export Audio Regions as Files: This lets you take a region in your track and export it as its own audio file that you can then use in another session. This is great for making separate audio files of drum loops, for example, if you’re ready to place them in your mix.
Exporting and Exporting Files

Exporting from a Session

- **Export as Interleaved Stereo Files**: This lets you take the regions from a stereo track or two regions from two mono tracks and save them as a single interleaved stereo file. (Interleaved stereo files are the type that many other programs create when doing a stereo mix.)

- **Export Region Definitions**: This lets you export the information that defines the region. Doing this keeps you from having to make a copy of the audio (saves hard drive space) while still being able to use the region in a new session. (Pro Tools uses the original audio file so you don’t have two in your system.)

**Exporting regions**

Since regions are only portions of the audio in an audio file, Pro Tools lets you take this portion and make a separate file containing just this audio data. Exporting regions allows you to take a lovingly crafted musical element (a killer drum loop, for example) and use it in another session or application without having to re-create it from the parent audio file.

To export a region as a new audio file, follow these steps:

1. Select the region(s) one of two ways:
   - **From the Audio Regions list (located on the right side of the Edit window)**: Select the region(s) you want to export by clicking the region’s name. To select more than one region, hold the Shift key as you click each region’s name. (If the list isn’t visible, click the double arrows at the bottom left of the Edit window to call it up.)
   - **From the Track playlist in the Edit window**: Click anywhere on the region to select it. To select more than one region, hold the Shift key as you make your selections.

2. Choose Export Selected as Files from the Audio Regions pop-up menu — the menu you open by click-holding the Audio Regions name at the top of the Audio Regions list.
   
   The Export Selection dialog box opens, as shown in Figure 5-5.

3. Choose the export settings you want for your new file.
   
   You have the following settings to deal with:
   
   - **File type**: Choose the file type of the session you want to use this file in. If you’re not sure where you’re going to use the file, choose either BWF or AIFF.
   - **Format**: Your choices here are Multiple Mono or Stereo. Choose the format appropriate for your file. If your drum loop, for example, is in stereo and has panning information, you’ll want to select Stereo.
Exporting from a Session

- **Bit Depth**: You can choose from 8, 16, and 24 bits. I recommend selecting the same bit depth as your current session.

- **Sample Rate**: You choices include 44.1, 48, 88.2, 96, and 192kHz. Choose the sample rate of the session you want to put this file into. If you're not sure, select the same rate as your current session.

4. **Select a destination for the file in the Destination Directory field by clicking the Choose button and following the prompt.**

5. **Select from the Resolve Duplicate File Names By options. These options are:**

   - **Prompting for Each Duplicate**: This stops the exporting process and lets you know when Pro Tools finds a duplicate file name. You can then choose to either replace the original or create a new name.

   - **Auto Renaming**: You authorize Pro Tools to automatically create a new name for these files. This is the best option to choose if you don’t want to have to answer a prompt for each duplicate file name and you want to make sure that your original files aren’t replaced.

   - **Replacing with New Files**: This option replaces any existing files containing the same name with your newly exported ones. This is the option to take if you’re sure that you don’t ever want the original files bearing the same name.

![Figure 5-5: The Export Selected dialog box lets you choose the file settings for your new file.](image)
6. Click Export.

Your new file is created and saved to the destination you chose in the Destination Directory field of the Export Selected dialog box.

**Exporting stereo-interleaved files**

A stereo-interleaved file is a single audio file with all the stereo data contained in them. These types of stereo files are different than the ones used in Pro Tools, which consist of two separate audio files for stereo (one contains the left channel data and the other contains the right channel data).

Although Pro Tools doesn’t support stereo-interleaved file types, you can export regions from within your session as a single, stereo-interleaved file. This is an important feature because many other audio applications — such as mastering programs — use stereo-interleaved files instead of the separate ones that Pro Tools favors.

To export a region as a stereo-interleaved file, do the following:

1. **Select either a stereo region or two mono regions one of two ways:**
   - **From the Audio Regions list (located on the right side of the Edit window):** Click the name of the region to highlight it. To select two mono regions, hold the Shift key as you click each region’s name.
   - **From the track playlist in the Edit window:** Click anywhere on the region within the track to highlight it. For more than one mono region, hold the Shift key as you click each region.

2. **Choose Export Selected as Files from the Audio Regions list pop-up menu — the menu you opened by click-holding the Audio Regions name at the top of the Audio Regions list.**

   The Export Selected dialog box opens. (Refer to Figure 5-5.)

3. **Choose Interleaved from the Format drop-down menu in the Export Selected dialog box.**

4. **Choose the rest of your settings for this file.**

   Check out the previous section, “Exporting regions,” for tips on what settings to choose here.

5. **Click Export.**

   Your file is created and saved on your hard drive so you can use it in an application that supports stereo-interleaved files.
Exporting region definitions

Region definitions are the information that Pro Tools uses to define the location, start, and end times of a region within the parent audio file. If you’ve come up with some Pro Tools regions that you want to use in another session (or some other application that supports Pro Tools regions data), you can export region definitions from your session without having to copy the region as an audio file. In effect, all you save using this command are the pointers that make up the region definition: The definition points to the parent file and not the audio itself.

If you actually want to use a region definition in another session or application, make sure that the region’s parent audio file still exists on the hard drive. A definition that points to nothing is no help.

To export region definitions, follow these steps:

1. **Select the regions you want to export the region definitions for. This can be done one of two ways:**
   - From the Audio Regions list (located in the right side of the Edit window): Select the region(s) you want to export by clicking the region’s name. To select more than one region hold the Shift key as you click each region’s name. (If the list isn’t visible, click the double arrows at the bottom-left of the Edit window):
   - From the Track playlist in the Edit window: Click anywhere on the region to select it. To select more than one region, hold the Shift key as you make your selections.

2. **Choose Export Region Definitions from the Audio Regions list pop-up menu — the menu you opened by click-holding the Audio Regions name at the top of the Audio Regions list.**

3. **Click Export.**
   The pointing data for the selected regions are exported.

Exporting MIDI

Ah, the miracle of MIDI — say you’ve laid down a kickin’ “keyboard” part on guitar synth. How do you get it out of the current session? To export MIDI data to another device or application, you need to save your MIDI tracks and regions as a Standard MIDI file. You can save them as Type 0 files (a single multichannel track) or as Type 1 files (multiple tracks).

To export MIDI tracks, follow these steps:

1. **Mute any MIDI tracks you don’t want to include in the Export MIDI procedure by depressing the Mute button for these tracks.**
   Any muted tracks are excluded from the export function.
2. **Choose File ➪ Export MIDI from the main menu.**

The MIDI Export dialog box appears, as shown in Figure 5-6.

![Figure 5-6: The MIDI Export dialog box lets you choose the name and location for your exported MIDI file.](image)

3. **Enter the name and location for this newly exported file.**

4. **Select either 0 for type 0 (single track) or 1 for type 1 (multiple track) in the MIDI version field.**

5. **Press Save.**

   Your new MIDI file is created from all the unmuted MIDI tracks in your session in the location you designated. This file includes all notes, controller events, program changes, System Exclusive data (instructions exclusive to the device), and tempo, meter, and marker events. SMPTE time-code start time is also included so that your MIDI files will start at their proper time when opened.

### Managing Files

As soon as you start to record and edit your music, you start filling your hard drive with data. Properly managing your data helps you keep your system stable, lets you maximize your hard space, and protects you from the worst disaster of them all — lost data. This section details three important file-management tasks — compacting files, deleting files, and backing up data — you should routinely do to keep everything running smoothly.

### Compacting files

Editing means cutting a snippet from here and taking the best chunk from there and putting it altogether to make a — hopefully coherent — whole. It also means that, after you extract that great 15-second bit from that 75-second clip, you’re going to have a lot of stuff cluttering up the virtual cutting-room floor of your hard drive. What to do?
You can get rid of the clutter — the unused portions of the audio files in your session — by using the Audio Regions list’s Compact Selected command. This command deletes any audio from a file in your session where there are no regions referencing the data. It helps conserve disk space.

You’d generally use the Compact Selected command after you’ve done all the editing in your session, because it permanently deletes the unused audio data from the session. Don’t use this command until you’re sure that you don’t want to use any of your data leftovers.

Compacting your audio files consists of three basic steps:

1. Select any unused regions in the session.
2. Clear these unused regions. These two steps (ahem) clear the way to your final step:
3. Compact the files by removing the data for those cleared regions from the parent files.

To compact an audio file, do the following:

1. **Choose the Select Unused Regions option from the Audio Regions List pop-up menu** — the menu you opened by click-holding the Audio Regions name at the top of the Audio Regions list.
   
   Any regions not used in a track in the current session become highlighted in the Audio Regions list.

2. **Choose Clear Selected from the Audio Regions List pop-up menu to remove the unused regions.**
   
   The Clear Audio dialog box appears.

3. **Click Remove.**
   
   This removes the unused regions from your session.

4. **Select the region(s) you want to compact from the Audio Regions list by clicking the Region’s name.**
   
   To select more than one region, hold the Shift key as you click each region’s name.

5. **Choose Compact Selected from the Audio Regions List pop-up menu — the menu you opened by click-holding the Audio Regions name at the top of the Audio Regions list.**
   
   The Compact dialog box appears. This box contains a warning about the consequences of compacting a file (read the Warning icon earlier in this section) as a reminder that this is an irreversible process.
6. If you have crossfades in the selected region(s), enter the amount of padding (in milliseconds) that you want to put around each selected region.

_Padding_ adds space before and after your regions to account for any crossfades (Book 4, Chapter 4). Choose a pad length equal to (at least) to longest crossfade length for your selected regions.

7. Click the Compact button, located at the bottom of the Compact Audio dialog box.

Your file is compacted and the session is saved.

**Deleting unwanted files**

As with any creative process, what you end up with (in addition to your knockout musical creation) is leftover junk that just takes up space. You can delete unwanted files in your session from your hard drive by using the Clear Selected command located under the Audio Regions list pop-up menu (opened by click-holding the Audio Regions name at the top of the Audio Regions list). Less unused data on your hard drive means more space for the good stuff.

To delete an audio file, do the following:

1. **Select the audio files you want to delete from the Audio Regions list.**
   The audio files are listed in bold letters in the Audio Regions list.

2. **From the Audio Regions list pop-up menu (opened by click-holding the Audio Regions name at the top of the Audio Regions list), choose Clear Selected.**

   The Clear Audio dialog box appears. You have the option of Remove (which you use before compacting a file — see previous section) and Delete. This is the one you want for this procedure.

3. **Click the Delete button in the Clear Audio dialog box.**

   Your file is permanently deleted from your hard drive.

_**WARNING!**_

The Clear Selected command is irreversible. Once you click Delete, your data is gone forever. If you think you might want the data someday, choose Remove from the Clear Audio dialog box. Your file is removed from the session but not from your hard drive.

**Backing up data**

There’s a saying in the computer world: _If the data doesn’t exist in more than two places, it doesn’t exist._ I know I said this before (Book 2, Chapter 2, to be precise), but I think it bears repeating. As someone who lost an entire
project’s worth of data because I “forgot” to back up my files, I strongly encourage you to make a habit of backing up your sessions.

Back up your files to the same hard drive does you no good if your drive shuts down (a common occurrence). Always back-up to a different hard drive or to another medium, such as DVD-R (check out the manual for your DVD burner for steps on how to do this).

To back up your session files to another hard drive, do the following:

1. **Create a new folder on a different hard drive than your session and call it Back Ups.**
2. **Choose File ➪ Save Session Copy In from the main menu.**
   The Save Session Copy In dialog box appears.
3. **Use the File Browser section of the dialog box to select the folder you created in Step 1 as the destination for your backup files.**
4. **Enter a name for your backup in the Save As field of the Save Session Copy In dialog box.**
   Since this copy exists on a whole different hard drive, I can use the same name as that of my original session — and if it’s an exact duplicate, I do. This is important because if, for some reason, the original files are lost all you have to do is drag the backed-up files onto your audio drive and get to work. Using a different name means you have to rename or import all your files before you can use them.
5. **Under the Items to Copy box, select All Audio files as well as any other setting you want to save such as plug-in settings or movie/video files.**
6. **Click Save.**
   The files you selected are backed up to the destination you specified in Step 3.

---

**Tip**

You can also back up your files by clicking and dragging the folder containing your session and audio files from one hard drive to another on your computer’s desktop.
Book III

Recording Audio

The 5th Wave

By Rich Tennant

“I hope you're doing something online. An indie band like yours shouldn't just be playing street corners.”
Contents at a Glance

Chapter 1: Taking Care of Tracks
Chapter 2: Miking: Getting a Great Source Sound
Chapter 3: Preparing to Record
Chapter 4: Recording Audio
Chapter 1: Taking Care of Tracks

In This Chapter

- Working with tracks
- Understanding track views
- Grouping tracks

Before you can do any recording in Pro Tools, you need to create and configure some tracks — specific places to put the vocals, instrumental parts, pterodactyl screeches, whatever. This involves setting up new tracks, naming the tracks, and assigning inputs and outputs to your newly created and named tracks.

But that’s not all. When working with tracks in Pro Tools, you also need to know how to show and hide them, activate and deactivate them, solo them, mute them, and adjust your view of them, among other things. This chapter takes the mystery out of dealing with tracks and shows you how to work with them both efficiently and effectively.

Understanding Tracks in Pro Tools

Pro Tools has four types of tracks — Audio, Auxiliary Input, Master Fader, MIDI — and two track formats — mono and stereo. All possible permutations and combinations of these various types and formats are explained (with subtlety and style) in this section.

Track types

When you work with tracks in Pro Tools, you have to keep in mind that you’re sure to end up dealing with four distinct flavors of tracks. They are

- **Audio Tracks**: An audio track contains audio files and can be either mono or stereo.
- **Auxiliary Input Tracks**: These tracks are used as effects sends, for submixes, or for other routing purposes.
- **Master Fader Tracks**: This track type contains the summed output for all the tracks routed to it. Master Fader tracks can be either mono or stereo, although stereo is most common.
Setting Up Tracks

**MIDI Tracks:** MIDI tracks contain MIDI data — instructions to MIDI devices on how to create specific digital sounds. (For more on MIDI check out Book 1, Chapter 5 and for more on MIDI tracks, go to Book 5.) These tracks are only available in mono.

**Track formats**

You’ll find that Pro Tools offers a bit less variety when it comes to track formats. You get two — count ’em, two — choices:

- **Mono:** A mono (monaural) track consists of a single channel of audio or MIDI data. It uses — as its name implies — just one voice.
- **Stereo:** A stereo (stereophonic) track consists of two channels of audio and uses two voices. A MIDI track can’t be stereo.

**Setting Up Tracks**

Setting up your recording project is a little like setting up a railroad: It'll only take you somewhere if you’ve already put the tracks in place. Getting that done is what this section is about.

**Creating new tracks**

To create a new track, you can either choose File → New Track from the main menu or press Command+Shift+N on a Mac (or Ctrl+Shift+N on a PC). Either method opens the New Track dialog box (shown in Figure 1-1), where you get to choose the following:

- **Number of new tracks:** The default here is 1 but you can pretty much create as many new tracks as you like. Just keep in mind that you can only have 32 voices playing at one time in your session.
- **Track format:** Here you choose stereo or mono.
- **Track type:** Clicking the arrows opens a menu that lets you choose between an Audio, Auxiliary Input, Master Fader, or MIDI track.

Make your selections and click Create to create your new track. This track then appears in the Edit and Mix windows and in the Show/Hide list located on the right side of the Edit window. If the Show/Hide list isn’t visible, click the double arrow at the lower-left corner of the Edit window.
Duplicating tracks

You can duplicate tracks — creating a new track that mirrors all the input, output, effects send settings, and insert settings of your original track — in two easy steps:

1. Click the name of the track in the Mix or Edit windows. To select more than one track to duplicate, hold the Shift key as you click each track’s name.

   The name is highlighted.

2. Choose File › Duplicate from the main menu.

   The new track will appear in the Mix and Edit windows to the right of the track you’re duplicating and just below the duplicated track in the Show/Hide list.

Naming tracks

When you open a new track (select File › New Track), Pro Tools creates a default name for the track — something really helpful like Audio 1 — but you can change the name to anything you want. You do this by double-clicking the name of the track in either the Mix or Edit window. A dialog box similar to what you see in Figure 1-2 will open and you’ll be able to use the fields to both change the name of the track as well as add any comments you may want to include about the track. Once you enter your track name and comments, click OK and you’re set.
Assigning inputs and outputs

In order to record with your new track, you need to assign an input to it so Pro Tools knows where your source sound is coming from. In order to hear the track play, you need to choose an output so Pro Tools can send the sound out to your monitors or to your headphone jack.

That makes sense, right? Now, to actually assign an input to your track, do the following:

1. **Choose Display ➤ Edit Window Shows ➤ I/O View from the main menu to open the I/O section of the Edit window.**
   
The I/O section shows the inputs and outputs for each track.

2. **Within the I/O section of your track in the Edit window, click and hold the Input selector (see Figure 1-3) until the Input contextual menu pops up.**

3. **While still holding down your mouse button, move the mouse over the Input menu until it rests on the input listing you want.**

4. **Release the mouse button to select your choice from the Input contextual menu.**
   
   This menu closes and the input you’ve selected appears in the Input selector.

Choosing your outputs requires pretty much the same procedure, although now you start things off by clicking the Output selector instead.
Altering Your View of Tracks

Pro Tools gives you lots of options to change the way tracks look in the Mix and Edit windows. You can change a track’s color, size, location, and even whether you can see it or not. This section gets you up to speed on these options.

Showing and hiding tracks

Both the Edit and Mix windows have the option of including an audio tracks list in the window view (Figure 1-4). In this list, called the Show/Hide Tracks list, you can show or hide selected tracks or groups of tracks. This list is located on the left side of either window. If it’s not visible, click the double arrows at the bottom left side of either window to open it in that window.

You can show and hide tracks one of two ways:

✦ **Use the pop-up menu.** Click and hold the title bar of the Show/Hide Tracks list until a contextual menu opens up, as shown in Figure 1-5, and then just choose the option you want.

Keep in mind that the Show Only Selected Tracks option and the Hide Selected Tracks option require that you first highlight your desired tracks in the main part of the Edit or Mix windows. To select one track, just click the track’s name. To select more than one track, hold down the Shift key while clicking each track you want. When you then use the Show Only Selected option, for example, all tracks that are not highlighted will be hidden.

✦ **Click the track name in the Show/Hide Tracks list.** Clicking directly on the track name located in the Show/Hide Tracks list toggles between hiding and showing the track. You can even move the tracks around by click-dragging it to where you want it in relation to the others.
If the Show/Hide Tracks list is not showing, click the double arrow at the bottom-left corner of the window to open it (Figure 1-6).

**Figure 1-5:**
The Show/Hide pop-up menu lets you choose how you want to see your tracks.

**Figure 1-6:**
To show the Show/Hide Tracks list window, click the arrows in the lower-left part of the Edit or Mix window.

Click here to show the Show/Hide Tracks list.

You can also use the Show/Hide Tracks list pop-up menu to sort tracks by name, type, edit group, mix group, or voice, as shown in Figure 1-7. This menu is opened by click-holding the Show/Hide Tracks list title.
Assigning track color

To make all your tracks easier to keep track of when you’re working, you can assign color groups to the waveform display for each track in the Edit window. To do this, choose Setups ➪ Preferences from the main menu and then select the Display tab in the Preferences dialog box. This opens the window shown in Figure 1-8.

Figure 1-8: The Edit Window Color Coding section of the Preferences dialog box lets you choose how to color-code your tracks.
In the middle of this window is a box called Edit Window Color Coding. You can choose from several options:

- **None**: Makes the display for all the tracks the same color.
- **Tracks and MIDI channels**: Assigns colors to each waveform display based upon the audio track number and the MIDI channels assigned for each MIDI track.
- **Tracks and MIDI devices**: Bases colors for the waveform display on the audio track number and the MIDI device used.
- **Groups**: Colors the waveform display for your tracks according to a track’s group membership.

**Changing track size**

You can alter the viewed size of tracks in both the Edit or Mix windows. This can be a godsend, for example, when you have a ton of tracks in a session and you want to see them all on the screen (pick a small size) or if you have a track that you want to edit on (choose a giant size one). Here are your options:

- **Edit Window**: The Edit window allows you to choose from several different-size track views. Your options include: Mini, Small, Medium, Large, Jumbo, and Extreme. You access these options by clicking the track height selector or the ruler bar at the far left side of the waveform display of the track, as shown in Figure 1-9.

![Track Height selector](image)

**Figure 1-9: Changing track height.**

- **Mix Window**: In the Mix window, you can toggle between Regular and Narrow channel strip views by choosing Display→Narrow Mix Window or Display→Regular Mix Window from the main menu, as shown in Figure 1-10. Pressing Shift+Command M on your Mac’s keyboard (or Shift+Control on a PC) also toggles between the two views.
Moving tracks around

You can move tracks around and arrange them in your Mix or Edit window as you want them. This feature is handy if you have a group of tracks that you want to have next to each other, such as percussion and drums. I place any submixed tracks together to help me keep track (sorry, I couldn’t help myself) of them all without having to move all over the Edit or Mix windows. The following steps show you how to do this:

1. **Locate the name of the track you’d like to move in the Show/Hide list, as shown in Figure 1-11.**

2. **Using your mouse, click the track name and then drag the track up or down to where you want it.**

3. **Release the mouse.**

   The track stays put where you dragged it.

Moving the track around in one window will change its location in the other.
Deleting tracks
To delete a track, follow these steps:

1. Select the track by clicking its name in either the Edit or Mix window.
2. Choose File ➪ Delete Selected Tracks from the main menu.
3. Click OK.

Grouping Tracks
In Pro Tools, it’s a snap to create and manage groups of tracks. I strongly recommend taking advantage of Pro Tools grouping features, since they let you perform lots of different tasks — edits, for example — on more than one track at a time.

Keeping track of grouped track parameters
When tracks are grouped, certain parameters become linked. These include

✦ Automation modes
✦ Editing functions
✦ Mutes
✦ Send mutes
✦ Send levels
✦ Solos
✦ Track view
✦ Track height
✦ Volume levels

That’s a lot of parameters, but don’t let this long list fool you into thinking that grouping links up everything associated with your tracks. Some parameters are not linked when you use the grouping feature, including

✦ Creating plug-in instances
✦ Output assignments
✦ Panning
✦ Record enables
✦ Send panning
✦ Voice assignments
Having these parameters independent when tracks are grouped is nice because many times these parameters vary from track to track. For example, you don’t want the same plug-ins on all your drum tracks or the same panning setting on all backup vocal tracks (both of these are great candidates for grouping).

**Creating groups**

You can create groups by following these steps:

1. **In either the Edit window or the Mix window, shift-click the tracks you want in your group.**
   
   It doesn’t matter which window you use as your starting point here. Whatever groups are created in one window automatically get created in the other window.

2. **Choose File ➪ Group Selected Tracks from the main menu — or New Group from the Group pop-up menu — the menu you opened by click-holding the Group title in the Groups list section of the Edit or Mix window.**

   The New Group dialog box appears, as shown in Figure 1-12.

3. **Enter a name for your group in Name for Group field.**

4. **Use the Group Type drop-down menu to choose which window(s) will show your new group.**

   Your choices here are Edit (when you want the group listed just in the Edit window), Mix (when you want the group listed just in the Mix window), and Edit and Mix (when you want your group listed in both windows).

5. **Choose a group ID from the drop-down menu.**

   The Group ID is a single letter that defines your group. This lets you see which group a track is in at a glance. (The Group ID for a track is located beneath the track’s level meters in the mix window.)

6. **Click OK.**

   The New Group dialog box closes and your new group appears in the Edit, Mix, or Edit and Mix windows (depending on your choice in Step 4).

If a track in a group is hidden in the Show/Hide Tracks list, that track won’t be affected by edits done to that group. All mix operations — with the notable exception of Record Enable — do apply to hidden tracks, though.
Enabling groups

Before you can work with grouped tracks, you need to enable the group, which you do by clicking the group name in the Groups list. (You’ll find the Edit Groups list in the lower-left side of the Edit window; the Mix Groups list is in the lower-left side of the Mix window. If they aren’t visible, click on the double arrow at the bottom-left corner of the Mix or Edit window, respectively.) Highlighting in blue means the group is enabled. Click the group again to disable it. The blue highlight will disappear.

You can also enable and disable groups using a keystroke on your keyboard in the Mix window by simply pressing the key for the group ID. To do the same thing in the Edit window, you need to first make sure that the Commands Focus (A-Z) button to the right of the Edit Groups name is highlighted, as shown in Figure 1-13. (How will you know that it’s highlighted? That’s easy. In its highlighted state, a blue border surrounds the box.)

Editing groups

Once you’ve set up some groups, you don’t have to treat them as if they were set in stone. You can add — or subtract — members to the group, you can change the group name, or you can just delete the group altogether. These options are covered in this section.
Renaming a group
Follow these steps to rename a group:

1. **Double-click the area to the left of the group name in the Groups list.**
   
   The New Group dialog box reappears.
   
   The Edit Groups list is located in the lower-left side of the Edit window; the Mix Groups list is in the lower-left side of the Mix window. If they aren’t visible, click the double arrow at the bottom-left corner of the Mix or Edit window, respectively.

2. **Type in your new name in the Name for Group box.**

3. **Click OK.**
   
   Your group gets a spanking new name.

Adding a track to a group
You can add a track to an existing group by doing the following:

1. **Shift+click the track name of the track(s) you want to add to a group.**

2. **Choose File→Group Selected Tracks from the main menu or press Command+G.**
   
   The New Group dialog box appears.

3. **Select the Group ID of the existing group you want to serve as the selected track(s) new home.**

4. **Click OK.**
   
   The selected tracks are added to the groups whose Group ID you specify in Step 3.

Deleting groups
You can delete unwanted groups by doing the following:

1. **Click the name of the group in the Groups list.**
   
   Again, you find the Edit Groups list in the lower-left side of the Edit window, and the Mix Groups list in the lower-left side of the Mix window. If they aren’t visible, click the double arrow at the bottom-left corner of the Mix or Edit window, respectively.
2. Click the Groups pop-up menu (opened by click-holding the Group title in the Groups list section of the Edit or Mix window) and select Delete Group.

Your group is history.

**Linking edit and mix groups**

When you create a new group, you have the option of making that group an Edit group, a Mix group, or a combination Edit/Mix group. Regardless of which option you choose, by default functions done in either the Edit or Mix windows will affect groups in both. For example, if you have a drum group in your Mix window consisting of kick, snare, toms, and overheads and you want to edit a bad note out the snare drum in the Edit window, you end up editing not only the snare drum note but also the audio from the other members of the drum group you assigned in the Mix window.

This may be what you want most of the time, but there may be situations where you don’t want the default — where Edit or Mix functions affect entire groups. The way to get around this is to disable the Link Edit and Mix Groups option in the Preferences menu. Do so by following these steps:

1. **Choose Setups > Preferences from the main menu.**
   The Preferences dialog box appears.

2. **Choose the Operation tab in the Preferences dialog box.**
   You get a screen that looks like Figure 1-14.

3. **Deselect the Link Mix and Edit Group Enables option.**
   You can find the option near the top of the right column of choices.

---

*Figure 1-14: The Link Mix and Edit Group Enables options.*
Soloing and Muting

Soloing and muting tracks is a big part of the mix process. By being able to hear only those tracks you want to hear at a given time, you can find unwanted sounds lurking in your tracks by soloing the suspected track or you can turn off the lead vocal when you tweak the backup vocals. You can solo and mute each track in the Edit window by clicking the Solo or Mute button located underneath the track name, as on the left side of Figure 1-15. You can do the same thing in the Mix window by clicking the Solo and Mute buttons located above the volume fader, as on the right side of Figure 1-15. Check out Book 3, Chapter 4 for more on these windows and the location of the Solo and Mute buttons.

Soloing a track turns the mute function on for the rest of the tracks. You can solo and mute more than one track at a time. Choose the appropriate button for each track.

Managing Track Voices

Pro Tools has 32 available voices. This means that you can only have 32 different mono tracks playing or recording at one time. (With stereo, you can only have 16 tracks, because each stereo track uses two voices.) Since it isn’t that uncommon to have more than 32 tracks in a session, you need ways to manage the 32 available voices so you can hear all your tracks (or at least the important ones). This can be done one of two ways: by setting voice assignments for each track, and by setting voice priority. The next two sections give you the skinny on each method.
Assigning voices

In Pro Tools, the controls for each track let you choose between Off and Auto for voice assignments. Figure 1-16 shows the Voice Assignment menu in the Edit (left) and Mix (right) windows. With a track's voice assignment set to Off, the track won't play. If you have the track's voice set to Auto, Pro Tools automatically turns that track on and off according to how many voices are available for playback and where this particular track sits in the Voice Priority listing. (See the next section for more on voice priorities.)

For example, if you have a session containing 33 tracks, only 32 will play at any one time. Now, if you have one track (rhythm guitar) that only plays during the verse and another track (lead guitar) that only plays during the chorus, you can get these two tracks to trade off so only one at a time uses the available voice amongst the 32 — and everybody's happy because every note recorded will get heard.

Imagine, though, that both guitar parts have to play in the bridge section of the song. In this game of musical chairs, one part won't find one of the 32 available “slots” — and won't play. Which part ends up being silenced is determined by how high up the part sits in the list of tracks. You can choose how high by setting the voice priority of each track, something I cover in the next section.

Setting voice priority

Since Pro Tools only allows you to play 32 voices but lets you have more tracks than that in your session, you may need to do some finagling among the available voices if you want every track (or at least the most important ones) to be heard throughout the song. To pull off this trick, you have to set the voice priority of each track.
Voice priority is determined by the track's position in the tracks list in the Edit and Mix windows — the higher its place in the list, the higher its priority for voice assignment. You can increase the voice priority of a track the following ways:

✦ **Using the Show/Hide Tracks List:** Click and hold with the pointer over the track you want, and drag that track up the list.

✦ **Using the Edit Window:** Click and drag the name of the track up the list.

✦ **Using the Mix Window:** Click and drag the name of the track to the left on the list.

The higher up the list a track is, the higher its priority and the stronger its claim on the available voices when you assign voices.

**Freeing up a voice from a track**

Since you can’t make every track the highest priority, there is another way to free up (or at least control) how your available voices get used. If you can identify a voice that’s less crucial at a given moment, you can free that voice from a track by doing one of the following:

✦ Turn the voice assignment to Off. You can do so by using the Voice Assignment menu and choosing (logically enough) Off. (See the “Assigning voices” section, earlier in this chapter, for more on the Voice Assignment menu.)

✦ Deactivate the track by pressing Command+Ctrl on a Mac or Ctrl+Start/Windows on a PC and clicking the name of the track you want to deactivate. You can activate the track again by performing the same command over again, which toggles the track back on.

✦ Turn off any output or send assignments for that track.
Chapter 2: Miking: Getting a Great Source Sound

In This Chapter
- Exploring microphone techniques
- Miking drums
- Miking amplified instruments
- Miking acoustic instruments

You can do all the right things to get your Pro Tools software ready to record tracks — see Book 3, Chapter 1 for more on that topic — but it won’t mean diddly if you don’t know how to set up your mics properly.

As you’ll soon find out, the location of a microphone in relation to your instrument or a singer has a huge impact on the sound of your recording. In fact, just a movement of an inch or two or even a slight turn of the mic can bring out different characteristics in the sound. The art of placing mics is one that you will undoubtedly spend a lifetime discovering.

In this chapter, you discover the fundamentals of using microphones to get a good source sound. You explore tried-and-true miking methods along with some practical miking tips and tricks that you can use right away. You also examine the use of compression and mic placement to control and eliminate transients — the usual peaks in the instrument’s sound.

Tracing Typical Microphone Techniques

Regardless of the style of microphone you use — or the type of instrument you record — you can use one or more of the following mic-placement techniques to capture the sound you want:

- **Spot (or close) miking**: Put your microphone within inches of the sound source.
- **Distant miking**: Pull your mic back a few feet from the sound.
- **Ambient miking**: Place your mic way back in a room.
- **Stereo miking**: Set up two mics at various distances from one another.
- **Combining miking strategies**: Use a combination of the four traditional placement strategies listed here.
This section introduces you to the four traditional mic-placement strategies employed in recording. You discover the characteristics and purposes of each of these four methods and get a look at how each relates to a particular tonal or sound quality. I also discuss how you can combine these strategies.

**Spot**

Spot miking (also called close miking) involves placing your microphone within a couple of feet of the sound source. People with a home-recording setup use this technique most often because it adds little of the room (the reverb and delay) to the recorded sound. Figure 2-1 shows the close miking placement.

With spot miking, where you place the mic is much more crucial than it is with any other technique. Because the mic is so close to the sound source, small adjustments to the mic's placement make a noticeable difference, and the mic may not capture the complete sound of the instrument. Finding the spot that sounds the best may take some trial and error.
Distant

When you use *distant miking*, you place mics about 3 or 4 feet away from the sound source. (See Figure 2-2.) Distant miking enables you to capture some of the sound of the room along with the instrument. An example of a distant-miking technique is the overhead drum mic. With it, you can pick up the whole drum set to some extent. Coupled with a few select spot mics, you can record a natural sound.

Ambient

*Ambient miking* is simply placing the mic far enough away from the sound source so you capture more of the room sound (the reverb and delay) than the sound of the actual instrument. (See Figure 2-3.) You may place the mic a couple of feet away from the source but pointed in the opposite direction, or you may place it across the room. You can even put the mic in an adjacent room, although this is an unorthodox technique, I’ll admit. The distance that you choose varies from instrument to instrument.

Ambient mic placement works well in those places where the room adds to the sound of the instrument (home recordists sometimes use stairwells, bathrooms, or rooms with wood paneling to liven up the sound). The sound you record is ambient (hence the name) — that is, steeped in the sonic qualities of the surroundings. If you mix this in with a spot mic, you can end up with a natural reverb. If your room doesn’t add to the sound of the instrument, you’re better off not using any ambient mics. You can always add a room sound by using effects in the mixing process. (See Book 6, Chapter 5 for more on using effects.)
Stereo

Stereo miking involves using two mics to capture the stereo field of the instrument. There are a variety of stereo miking techniques and some pretty complicated ways of using two mics to record. The three most common approaches, however, are X-Y (coincident) pairs, the Blumlein technique, and spaced pairs. You can also find stereo mics that — on their own — do a good job of capturing the stereo field of an instrument.

Stereo miking has the advantage of capturing a natural stereo image. When you listen to performances that were recorded with well-placed stereo
miking, you can hear exactly where on the stage each instrument performed. Of course, there is an art to such wonderful stereo miking. You can’t just set up a couple of mics in a room and get a good stereo sound. Capturing a stereo image with two mics requires some careful planning.

**X-Y pairs**

X-Y (also called coincident) stereo miking consists of using two mics placed right next to each other so the diaphragms are at almost right angles (anywhere from 90 to 135 degrees) as close together as possible without touching one another. X-Y stereo miking is the most-common type of stereo mic setup and the one you’ll probably use if you end up doing any stereo miking. Figure 2-4 shows a basic X-Y setup. Notice how the mics in this figure are attached to a special mounting bracket. This bracket makes positioning the mics easy.

![Figure 2-4: The X-Y stereo mic approach uses two matched microphones placed close together.](image)

**Blumlein technique**

The Blumlein technique is named after Alan Dower Blumlein, who patented this approach in 1931. Blumlein stereo miking involves placing two figure-8 mics in much the same way as the X-Y pattern (at right angles to one another with the diaphragms as close together as possible). The two mics are mounted on separate stands, one above the other. The advantage with this technique is that the figure-8 mics pick up signals from both the front and back. This produces a very natural sound. You also don’t have to contend with any proximity effects (enhanced bass response that comes from being close to the sound source), because figure-8 mics don’t produce this effect. Figure 2-5 shows this technique. (For more on figure-8 mics, see Book 1, Chapter 5.)
Spaced pairs

Spaced-pair stereo miking involves placing two mics at a distance in front of the instrument(s) you want to record and at a distance from one another. This approach can work well if you record an ensemble that takes up a fairly large amount of room. Figure 2-6 shows a top view of a typical spaced stereo mic set-up.

One of the most important things to consider when you use spaced pairs for stereo miking is that they can develop phase problems if you don’t space the mics properly. For the most part, placing the mics three times further apart than they are from the sound source takes care of phase problems. This is called the 3:1 rule. (For more on phase problems, see the “Problems with stereo miking” sidebar in this chapter.)

Stereo microphones

If you want to record an instrument in stereo and don’t want the hassle of learning how to set up stereo pairs, you can use a stereo mic. Stereo mics basically have two diaphragms in them and use a special cord that allows you to record the output from each diaphragm on a separate track. Take a look at an inexpensive stereo condenser mic in Figure 2-7.
Problems with stereo miking

When you do stereo miking, watch out for phase cancellation and poor stereo imaging. **Phase cancellation** happens when the two microphones are placed in such a way that each one receives the sound at a slightly different time. When this occurs, you don’t hear the bass as well; the low frequencies drop off. Improper mic placement — or two mics that are out of phase with one another — can cause phase cancellation.

Most digital recorders have a phase switch that allows you to reverse the phase of the signal. (Pro Tools lets you do this after it’s recorded.) To test whether two mics are out of phase, just reverse the phase on one mic (don’t do both) and listen to see whether the low frequencies become more apparent. If they do, then you’ve corrected the problem and you’re good to go. If this doesn’t correct the problem, you can try changing cords on one of the mics (some mic cords are wired differently from others). If this doesn’t work either, then you need to adjust the relationship between the two mics. Just move one around a little and listen for any changes in the bass response. When the missing bass appears, you know you’ve solved the problem.

You have a problem with **poor stereo imaging** if you can’t tell clearly where the various instruments or vocals show up from left to right (or right to left, if that’s the way you think), or you can’t hear a clear center point in the sound. Poor stereo imaging is a little more difficult to correct than phase cancellation, but you can fix it.

The solution depends on the stereo miking technique you use. If you use the X-Y technique, you’ve probably placed your mics too close to the sound source. If you use the spaced-pairs technique, you’ve probably placed the mics too close to one another in relation to their distance from the instruments. In either case, adjusting the placement of your mics should clear up the problem.
Many times, you'll want to use more than one mic. The possible combinations are almost limitless: You can use several spot mics on one instrument, you can use a spot mic and an ambient mic, you can have a distant mic and a spot mic, or . . . Well, you get my point. I don’t go into detail in this section, but I do cover some great ideas (if I do say so myself) in “Setting Up Your Mics: Some Suggestions,” later in this chapter.
If you do end up doing multiple mic combinations, remember to listen for any phase problems. Do a couple of run-throughs to get level and balance, and try to correct phase troubles before you actually record the performance. Of course, since you’re using Pro Tools, you can deal with some phase problems later. This is done one of two ways:

✦ Use the Invert command located in the AudioSuites menu. (Choose AudioSuites ➤ Invert from the main menu.)
✦ Move your tracks around in your session to line up the waveforms. This is called time aligning and is covered in Book 4, Chapter 3.

Taming Transients

The single most difficult part of getting a good sound by using a microphone is dealing with sudden, extreme increases in the sound signal. These blips are called transients, and they happen when a drum is first struck, when a vocalist sings certain syllables (for example, those that begin with P), and when a guitar player picks certain notes. In fact, because you can’t always control the amount of force that you apply to an instrument, transients can happen any time — with any instrument — and without warning. (Highly trained musicians produce fewer transients because they have a greater mastery over their muscular movements.)

In digital recording, all it takes is one slight, unexpected note to cause clipping and distortion, ruining what may be the perfect musical performance. Believe me, nothing is so heart-wrenching as listening to the perfect take and hearing the unmistakable sound of digital distortion. Although you can’t eliminate transients completely (they are part of an instrument’s character), you can tame the extreme transients that often cause digital overs (a thick signal at too high a level, resulting in distortion). You can lash ’em down in three ways:

✦ Set your levels properly so the transients don’t overload the converters.
✦ Make sure you have proper mic placement.
✦ Run the signal through a compressor when recording. A compressor is a piece of hardware (not included in your Digidesign interface) that controls the dynamics of your signal to keep your levels from getting too high.

Setting your levels properly

It used to be the case, back in the days of 16-bit digital recording (in ancient times, oh, six years or so ago), that you wanted to record at as high a level as possible without going over the maximum of 0dB. The idea was to ensure
the highest-possible fidelity by using as many of the available 16 bits as possible. If you recorded at lower levels, you used fewer bits — which resulted in lower fidelity and higher noise levels.

Now, in the advanced age of digital (some six entire years later), your best bet is to record with 24-bit resolution. Those extra 8 bits gained since the olden days free you from having to record at the highest level possible. In fact, you can put your max levels down around –12dB and still end up with great-sounding tracks. Giving yourself that kind of room (called, logically enough, *headroom*) allows an instrument’s transients to be recorded without causing problems with your converters.

I highly recommend recording with peak levels no more than –12dB or –10dB, unless you run the incoming signal through a compressor before it hits your converters. Sure, your tracks will be quieter, but you can deal with that during mixing (Book 6, Chapter 1) and mastering (Book 7, Chapter 1).

**Placing mics properly**

A microphone that’s too close to a loud sound source (or pointed too directly at the point of attack) can easily pick up extreme transients. In most cases, all you have to do is to pull the mic away from the instrument a little or turn it ever so slightly so it avoids picking up too high a signal. (I cover mic setup thoroughly in the next section.)

The main thing to keep in mind when placing your microphones is to experiment. Don’t be afraid to spend time making small adjustments. After all, the track you save could be your own.

**Compressing carefully**

*Compressors* are processors that allow you to control the *dynamics* of a signal — extremes of loudness or softness — and boy, are they ever versatile. You can use them on the front end while *tracking* (recording) instruments to ward off any stray transients. You can use them to level off an erratic performance. And you can use them to raise the overall apparent level of a mixed song. In this section, you explore the first use of compression: the control of transients. (You can find out about the other ways to use compression in Book 6, Chapter 3, and in Book 7, Chapter 2.)

The compressor is an invaluable tool when you record digitally because it enables you to record at high levels without worrying as much about digital clipping. The only problem is that the careful use of compression is an art that normally takes a while to get the hang of. Don’t worry, though. In this chapter, you get some guidelines for using compression and in Book 6, Chapter 4 I offer quite a few conservative compression settings for a variety of instruments to get you started.
Pro Tools includes a compressor plug-in with the software program. You can use this built-in compression if you're tweaking a session you've already recorded — for that matter, you can use this feature when you're recording your tracks, but that won't do you any good. Remember that the Pro Tools compression system is digital; it can't work with analog signals. Your signal has to go through the A/D converter (and get changed from analog to digital) on its way to being recorded — and the A/D converter in your Digidesign interface, not the compression plug-in, is first in line after the preamp. All of which defeats the purpose of using a compressor to control transients. (Bummer.) In fact, the A/D converter is usually where you often get your first dose of distortion. (Ditto.) If you're serious about using compression on the front end to tame those transients, you may want to consider an external preamp that you can insert into the signal chain before the A/D converter (that is, before the signal gets to your Digidesign interface).

Compressors have a series of dials that allow you to adjust several parameters. They are

- **Threshold**: This setting dictates the level at which the compressor starts to act on the signal, listed in decibels (dB). For the most part, you want to set the threshold level so the compressor acts on only the highest peaks of the signal.

- **Ratio**: This setting determines the amount that the compressor affects the signal. The ratio — such as 2:1, for instance — means that for every decibel that the signal goes over the threshold setting, it is reduced by two. In other words, if a signal goes 1dB over the threshold setting, its output from the compressor will only be 1⁄2dB louder. The ratio is the one parameter that varies considerably from instrument to instrument because the level of the transient varies.

- **Attack**: This knob controls how soon the compressor starts, well, compressing. The attack is defined in milliseconds (ms); the lower the number, the faster the attack. For the most part, you're trying to control transients, and they happen at the beginning of a note. Therefore you want the attack set to act quickly.

- **Release**: This parameter controls how long the compressor continues to affect the note after it starts. Like the attack, the release is defined in milliseconds. Because transients don't last very long, your best bet is usually a short release time if you're using compression on the front end.

- **Gain**: This knob allows you to adjust the level of the signal going out of the compressor. The setting is listed in decibels. Because adding compression generally reduces the overall level of the sound, you use this control to raise the level back up to where it was going in.

- **Hard knee or soft knee**: Most compressors give you the option of choosing one or the other of these odd-sounding settings (or they do it for you, based on the setting you've chosen). Both refer to how the compressor behaves as the input signal passes the threshold: a *hard*
knee applies the compression at an even rate, regardless of how far over the threshold the level is. So if you choose a compression setting of 4:1, the compressor applies this ratio for any signal over the threshold limit. Hard-knee compression is used for instruments such as drums, where you need to clamp down on any transients quickly.

The soft knee, by contrast, applies the compression at a varying rate that depends on how far over the threshold setting the signal is. The compressor gradually increases the ratio of the compression as the signal crosses the threshold until the amount matches the level you set. Soft-knee compression is used on vocals and on instruments where the signal doesn’t have fast peaks.

Using compression is an art form. There is no one way to get the sound you want. Although I go into detail on compression and offer some great compressor settings for a variety of applications in Book 6, Chapter 4, there are a couple of things you can keep in mind as you think about using compression on your tracks:

- **You can always add compression to a recorded track, but you can never take it away.** If you’re not sure how much compression to apply to a particular situation, you’re much better off erring on the side of too little because you can always run the sound through another compressor later if you need to.

- **If you can hear a change in the sound of your signal, then you most likely have it set too high.** The reason to use a compressor on the front end is to eliminate extreme transients, which you can’t hear when you play anyway. If your compression setting changes the sound at all, then you would want to turn it down slightly (unless you’re going for that effect).

**Setting Up Your Mics: Some Suggestions**

When you start to record, you discover an almost infinite number of ways to set up your mics. I can’t go into all of them here (as if I really knew all of them anyway), but what I can do is share the miking approaches that I use and have found to work for me. Okay, they’re not just my approaches; they’re pretty common ways for miking a variety of instruments.

Telling you that a particular mic position will work for you is like telling you that you’ll like a particular ice cream flavor. I don’t know your tastes, goals, or specific recording conditions, so I can’t truly know what will work for you beforehand. Think of the miking techniques in this chapter as a starting point — and don’t be afraid to experiment until you find the sound you want. There’s no absolute right or wrong when it comes to miking. There’s only what works for you and what doesn’t. (Book 1, Chapter 5 talks more about microphone types and how they’re used.)
Vocals
Regardless of the type of studio you have or the style of music that you
record, you’ll probably record vocals at some point. And unfortunately, vocals
are one of the most challenging instruments to do well. First, you have to find
the right mic for the person who’s singing, and then you need to try different
approaches in order to get the best sound out of him or her. Fortunately,
you’re in luck. In this section, I lead you through the (sometimes complicated)
process of getting good lead and backup vocal sounds.

The room and the vocals
To get the best recording of vocals possible, you need a dead room — a
room that has no reverberation. (Book 1, Chapter 2 has some tips on how to
deaden your room.) Recording vocals in a dead room gives a sense of “pres-
ence” and allows you to add compression to the vocals without making them
sound distant. (This is because the compressor raises the level of the back-
ground noise, particularly the reverberation from a live room that bounces
the sound around a lot.)

The easiest way to deaden your room for vocal recording is to hang up cur-
tains, carpet, or blankets around the room (or to use the absorbent side of
the reflector/absorber panels that I discuss in Book 1, Chapter 2). Try to
cover the area in front — and to both sides — of the vocal with sound-
absorbent materials. (If you use the reflector/absorber panels that I describe
in Book 1, Chapter 2, then you’d better use the stands; the panels are only
4 feet tall.)

The mics and the vocals
You have a lot of options for miking vocals. The type of mic you use dictates
where you place it. Here’s the gist:

✦ Dynamic mic: Dynamic mics sound best when you place them close to
the singer’s mouth. The effect that you get is gritty. (Huh? Okay, by
gritty, I mean dirty. That’s no help either? Let me see . . .)

Dynamic mics produce a midrange-dominated sound (the high frequen-
cies aren’t reproduced well). You’ll find that when a singer sings with the
mic right in front of his or her mouth, the sound lacks even more high
frequencies due to the proximity effect (close range enhances the low-
frequency response). What you get is a deep, bass-heavy sound that’s
often described as gritty or dirty. This type of sound can be great for
matching the mood of some styles of rock and blues music.

To set up a dynamic mic for this purpose, just put it on a stand so the
singer can get his or her mouth right up against the windscreen. With
this type of singing style, I recommend a compressor setting that
“pumps and breathes.” (That is, you can hear the compressor working.
See my discussion of compression in Book 6, Chapter 4 for a recommended setting.)

- **Large-diaphragm condenser mic:** Large-diaphragm condenser mics are those most commonly used for vocals. These mics can clearly reproduce the entire audible frequency spectrum, emphasizing the low mids slightly at the same time. What you get is a nice warm, full-bodied sound (that sounds like I’m describing a wine). The **proximity effect** (how close the singer is to the mic) determines how nice and warm-bodied the sound is. The closer the singer is, the deeper and richer the tone can be.

When you set up a large-diaphragm condenser mic for vocals, place the mic in such a way that the nasty **sibilants** (the sound from singing s and t sounds) and pesky **plosives** (pops from singing p syllables) don’t mess up your recordings. To deal with plosives and sibilants, you can either use a pop filter (see Book 1, Chapter 2) or have the singer sing past (instead of right into) the mic. If you want the singer to sing past the mic, you can

- Place the mic above the singer and set it at an angle pointing away from him or her (Figure 2-8, left).
- Set up the mic below the singer and angle it away from him or her (Figure 2-8, right).
- Put the mic off to the side and face it toward the singer (Figure 2-8, center), but not squarely in the path of the vocal.

- **Small-diaphragm condenser mic:** Small-diaphragm condenser mics create a much brighter, airier sound than their large-diaphragm cousins. You don’t get the low-mid warmth of the large-diaphragm beast, so the small-diaphragm mic probably won’t be your first choice as a vocal mic — unless (for example) you’re recording a female vocalist with a soprano voice and you want to catch the more ethereal quality of her higher frequencies.
You set up the small-diaphragm mic in the same way you set up the large diaphragm mic.

✦ **Ribbon mic**: The ribbon mic is a good choice if you’re looking for an intimate, crooner-type sound (think Frank Sinatra). The ribbon mic is thought to add a silky sound to the singer’s voice — produced by a slight dropoff in the high frequencies (not as severe as you’d get from a dynamic mic). To my drum-abused ears, ribbon mics have a kind of softness that large-diaphragm condenser mics don’t have. The sound is more even, without the pronounced low-mid effect.

If you use a ribbon mic, you can set it up in the same way you set up a condenser mic. You just need to be more careful about singing directly into a ribbon mic because the ribbon breaks if you sing, speak, or breathe too hard into it.

**Backup vocals**

To record backup vocals, you can either track each part separately (using the same mic-placement techniques that I describe earlier) or you can have all the backup singers sing at once into one or two mics. If you go for the latter method, you can either use a stereo pair of mics, a figure-8 mic, or an omnidirectional mic.

If you use a stereo pair, I recommend setting them up in a coincident X-Y pattern. Have the vocalists stand next to each other, facing the mics at a distance of about 3 or 4 feet. Either large- or small-diaphragm mics work best for this setup. Check out Figure 2-9 for a neat top view of this arrangement.

---

**Figure 2-9:**

The X-Y stereo miking pattern can work well for backup vocals.
If you choose to use a figure-8 mic, then the singers can stand on opposite sides of the mic (Figure 2-10). The advantage of this setup is that the singers can look at each other while they sing, which helps keep the vocals tight.

![Figure 2-10](image)

An omnidirectional mic can also work well for backup vocals. In this case, the singers stand in a circle around the mic, as shown in Figure 2-11.

**Electric guitar**

Miking your electric guitar is a personal thing. Every guitar player, it seems to me (although I don’t play guitar, so what do I know?), spends an awful lot of time getting his or her “sound.” If you’re a real guitar player, then you undoubtedly take great pride in getting your sound exactly right on tape, er, disc. You likely spend countless hours tweaking your amp and adjusting the mic to get it just right. On the other hand, if you’re not a (harrumph) real guitar player, you may just want to record the part and get it over with. Either way, you can start looking for that perfect guitar sound by placing your mics in one (or more) of the ways that I outline later in this chapter.

**The room and the guitar**

Whether you play through a small jazz chorus amp or power-chord your way through a 6-foot-tall Marshall stack, the room that you play in has less impact on your sound than it does if you play drums or sing. For the most part, look for a room that is fairly dead — a room without natural reverberation. You can always add effects later.
Guitar miking involves mostly spot mics, so your only consideration when recording a guitar and using an amp is how your neighbors feel about the noise, er, your *most excellent guitar playing*.

If you have finicky neighbors, you can put your guitar amp inside an amp-isolator box (see Book I, Chapter 2) to cut down on the noise. You can find the plans to build one on my Web site, www.jeffstrong.com. (Or, hey, you *could* try plugging the guitar directly into your Digidesign interface. You might like the sound you get. More about that in a minute.)

**The mics and the guitar**

The type of mic you choose depends largely on the type of sound you’re looking for. For example, if you’re looking for a distorted rock guitar sound with effects, you can get by just fine with a dynamic mic. If you favor a clean sound, a small-diaphragm condenser mic might work better for you. If you’re going for a warm, full-bodied sound, try using a large-diaphragm condenser mic.

No matter which type of mic you use, you get the best sound from your amp speakers by putting the mic about 2 to 12 inches away from the cabinet, with the mic pointing directly at the cone of one of the amp speakers (specifically, the center of the speaker, which is that cone-shaped thing in the box). You can see this positioning in Figure 2-12.
You may want to experiment with how far the mic is from the amp and the angle at which you point it. Sometimes just a slight movement in or out, left or right, can make all the difference in the world. You can even try pointing the mic at different speakers if your amp has more than one, because each speaker has a slightly different sound.

For speaker cabinets that have more than one speaker, I know some engineers who actually disconnect all but one speaker to lower the overall volume without losing the intense, distorted sound. This can be especially beneficial if you have one of those amp stacks with a volume knob that goes to 11, and you just gotta crank the amp to get your “tone” (come on, rockers, you know who you are). This way you don’t overdrive the mic (which creates the wrong kind of distortion) and can still get that nasty sound you’re looking for.

If you can’t quite get the sound that you want from your amp with the one mic pointed at the speaker cone, try adding a second mic about 3 or 4 feet away — also pointed directly at the speaker cone — to get a more ambient sound. This arrangement may also give your sound more life, especially if you have a room with natural reverberation. If you add a second mic, however, remember to watch for phase differences between the mics and make adjustments accordingly. (I discuss phase cancellation earlier in this chapter.)
Are you sick of the same old sound coming out of your amp? Wanna really shake things up (and I mean this literally)? Well, put your guitar amp in a tiled bathroom and crank it up. You can put a mic in the bathroom with your amp (a couple of feet away) and maybe another one just outside the door (experiment with how much you close or open the door). The effect is, well . . . Try it and find out for yourself.

**Electric bass**

When you mic an electric bass, getting a good sound can be a real bear. Your two adversaries are muddiness (lack of definition) and thinness (a pronounced midrange tone). These seem almost polar-opposite characteristics, but they can both exist at the same time. I outline the best way to avoid these problems in the following sections.

Running your bass guitar directly into the board — via a direct box, your amp’s line-out jack, or a preamped input on your Digidesign interface — gives the guitar a punchier sound.

**The room and the bass**

The sound of an electric bass guitar can get muddy awfully fast. Your best bet is to choose a room that doesn’t have a lot of reflective surfaces (such as paneled walls and wooden floors) that bounce the sound around. A dead room is easier to work with. Don’t make your room too dead, however, or it just sucks the life out of your amp’s tone. If you can get your amp to sound good in your room, placing the mic properly is easy.

Don’t be afraid to be creative and to try recording your bass in different rooms. Look for a room with a warm sound to it. One thing, though — the bathroom amp trick doesn’t work too well for a bass guitar (but it can be fun to try anyway).

**The mics and the bass**

Because the bass guitar produces low frequencies, a dynamic mic or a large-diaphragm condenser mic works well. I personally avoid small-diaphragm condensers and ribbon mics for the electric bass, but try them if you want. Who knows — you may end up with an awesome bass track.

Mic placement for the electric bass is similar to the guitar; you place a single mic 2 to 12 inches away from one of the speakers. Sometimes, with bass, you can angle the mic and let the speaker’s sound kind of drift past the diaphragm. Potentially it’s a great sound. For a bass, skip the distant mic (which generally just adds muddiness to the sound).
Acoustic guitars and such
At the risk of offending banjo, dobro, or ukulele players, I’m lumping all guitarlike (strummed or picked) acoustic string instruments together. I know, they all sound and play differently, but the microphone-placement techniques are similar for all these instruments. Allow me to explain.

Because all these instruments have a resonating chamber and are played with the instrument facing forward, you can pretty much use the same mic placement for any of them. You use different types of mics for different instruments, and I get to that in a minute.

The room and the acoustic instruments
Because these are acoustic instruments, the room plays a role in the sound that you end up recording. Unless you have a great-sounding room, you want to minimize its impact on your instrument’s sound. You can do this in a couple of ways — by recording with spot mics or by placing absorber/reflectors in strategic places around your room — absorber-side-out (toward the walls) if the room is too live, reflector-side-out if the room is too dead.

For example, if your studio resides in a spare bedroom with carpeting and that awful popcorn stuff on the ceiling, then you can put a couple of the reflector panels around your guitar player and the mic. This adds some reverberation to your guitar. Any unwanted reflections from the ceiling or walls are shielded from the mics because the absorber sides of the panels are facing the rest of the room.

The mics and the acoustic instruments
I prefer to use condenser mics when recording acoustic instruments. The type of condenser mic you use depends on the overall tonal quality that you want to capture or emphasize. For example, if a guitar has a nice, woody sound that you want to bring out in the recording, then a large-diaphragm condenser mic is a good choice. On the other hand, if you’re trying to capture the brightness of a banjo, a small-diaphragm mic is a better choice.

You can position your microphone in a variety of ways, and each accents certain aspects of the instrument’s sound. Even a slight adjustment to the mic can have a significant impact on the sound. You may have to experiment quite a bit to figure out exactly where to put a mic.

To help with your experimentation, listen to the guitar carefully and move the mic around (closer in and farther out, to the left and right) until you find a spot that sounds particularly good. You need to get your ears close to the guitar to do this.
Here are some suggestions to get you started:

✦ Put the mic about 6 to 18 inches away from and 3 to 4 inches below the point where the neck meets the body of the guitar (or banjo, or whatever). Then make minor adjustments to the direction in which the mic points. Pointing it toward the sound hole(s) often gives you a richer, deeper tone. (This can translate to muddiness on some instruments.) Turning the mic more toward the neck brings out the instrument’s brighter qualities. (See the image on the left in Figure 2-13.)

✦ Place a mic about 3 feet away from the instrument and point it directly at the sound hole. At this distance, you capture the rich sound from the sound hole and the attack of the strings. See the center image in Figure 2-13.

✦ Put a mic about 6 inches out from the bridge of the guitar. Try pointing the mic in different directions (slight movements of an inch or less can make a huge difference) until you find the spot that sounds best to you. See the image on the right in Figure 2-13.

✦ Try setting up a mic at about the same distance and angle from the instrument as the player’s ears. Point the mic down toward the instrument so the mic is a couple of inches away from either side of the musician’s head. This is an unorthodox approach that I like because I’ve found that guitar players adjust their playing style and intonation to correspond to what they’re hearing when they play. With this technique, you’re trying to capture exactly what the musician hears.

---

**Figure 2-13:** Positioning the mic in these ways can produce a good acoustic instrument sound.

---

**Drum set**

If you’re like most musicians, getting great-sounding drums seems like one of the world’s great mysteries. (You know, along the lines of how the pyramids were built or how to cure cancer.) You can hear big, fat drums on great albums but when you try to record your drums, they always end up sounding more like cardboard boxes than drums. Fret not (hey, at least I didn’t say that in the guitar section), for I have solutions for you.
First things first: Tuning your drums

The single most important part of getting killer drum sounds is to make sure your drums are tuned properly and that they have good heads on them (okay, that’s two things). Seriously, if you spend some time getting the drums to sound good in your room, you’re already halfway to the drum sound of your dreams. There isn’t space to go into detail here (especially if you play a large kit), but if you want specific drum-tuning guidance, you can do a search on the Internet or (ahem) check out a copy of my book, Drums For Dummies (Wiley Publishing, Inc.).

You’re looking for a clear, open tone on your drums. By and large, resist the temptation to apply duct tape or other dampeners to the drumheads. Drums that are deadened and don’t ring clearly are definitely going to sound like cardboard boxes when you record them.

What type of drum set?

If you want to buy a drum set for your studio, here are some guidelines that have worked for me:

- **Smaller drums can sound bigger.** At one point I had two top-notch Gretsch drum sets in my studio. One was a rock kit that had a 24-inch kick, 13-, 14-, and 12-inch tom-toms; and a 6½-inch deep metal snare drum. The other was a small jazz kit, consisting of a 12-inch kick, 10- and 14-inch tom-toms, and a 5-inch-deep wood snare. Guess what? Even for the hardest rock music, the small kit sounded much bigger. You tune the small drums down a bit and they just sing!

- **Choose your heads wisely.** Not all heads are equal. Some sound great on stage while others are better suited for the studio. Because the heads that come with a kit are (most likely) not the ones that sound the best on a recording, invest some money in testing different drumheads on your kit. I prefer either Remo pinstripes (great for rock and R&B) or coated ambassadors (great for jazz) on the top and either clear or coated ambassadors (either works, I just choose what I like to look at) on the bottom of the drum.

- **Use cymbals with a fast decay.** Cymbals that sound great on stage are different from those that sound great in the studio. Stage cymbals often have long decays and slow attacks. This causes bleeding, especially through the tom-tom mics, and correcting the problem can be a headache. If you buy cymbals for your studio, choose those that have a very fast attack and a short decay.

- **More expensive isn’t always better.** For recording, my favorite drum sets are used kits from the late ’60s and early ’70s. My all-time favorite recording set is a late ’60s Gretsch jazz drum set with a 12-inch kick drum, a 10-inch mounted tom-tom, and a 14-inch floor tom. For a snare, I love old 5-inch-deep wooden snare drums (Gretsch, Ludwig, Slingerland, whatever). The last one of these sets I bought cost me $350, including all the mounting hardware and snare drum. It wasn’t pretty, but boy, did it sound great.
Once you get your drums tuned as well as you can, the next step is to take care of any rattles that might be coming from the stands or mounting hardware. Tighten up any loose hardware and move any stands that may be touching one another. You may need to make some small adjustments to the pitches of your drums if they are causing any hardware to rattle.

If you still have some ringing or unwanted overtones, then you can dampen the drums slightly. Cotton gauze taped lightly on the edge of the head (away from the drummer) is often enough. If you want a really dry sound on your snare drum, you can use the wallet trick: Have the drummer place his or her wallet on the head. (Use the drummer’s wallet — it’ll probably be lighter because of all the money that isn’t in it.)

When the tuning of your drums is perfect, you’re ready to start placing some microphones. You can choose from an unlimited number of miking configurations, only a few of which I can cover here. (It would take a whole book to cover them all.)

**The room and the drums**

The room influences the drums’ sound more than it influences that of the other instruments. If you’re looking for a big drum sound, you need a fairly live room (one with lots of reflection).

I know you’re thinking, “But all I have to work with is a bedroom for a studio and it’s carpeted.” No worries, you can work with that. Remember, if you have a home studio, then potentially you have your whole home to work with. Here are a couple of ideas to spark your imagination:

- Buy three or four 4-x-2-foot sheets of plywood and lean them up against the walls of your room. Also place one on the floor just in front of the kick drum. This adds some reflective surfaces to the room.
- Put the drums in your garage (or living room, or any other room with a reverberating sound) and run long mic cords to your mixer. If you have a laptop computer for your Pro Tools system, you can just throw it under your arm and move everything into your garage or, better yet, take all this stuff to a really great-sounding room and record.
- Set up your drums in a nice-sounding room and place an additional mic just outside the door to catch some additional ambient sound. You can then mix this in with the other drum tracks to add a different quality of reverberation to the drums.

**Kick (bass)-drum considerations**

The mic of choice for most recording engineers when recording a kick drum is a dynamic mic. In fact, you can find some large diaphragm-dynamic mics specifically designed to record kick drums.
No matter where you place the mic, you can reduce the amount of boominess that you get from the drum by placing a pillow or blanket inside the drum. Some people choose to let the pillow or blanket touch the inside head. I prefer to keep it a couple of inches away from the inside head, but sometimes it’s okay to let it touch the outside head.

That said, you can place your mic in several ways (all conveniently illustrated in Figure 2-14):

- **Near the inside head:** If you take off the outside head or cut a hole in it, you can stick the mic inside the drum. Place the mic 2 to 3 inches away from the inside head and a couple of inches off center. This is the standard way to mic a kick drum if you have the outside head off or if a hole is cut in it. This placement gives you a sharp attack from the beater hitting the head.

- **Halfway inside the drum:** You can modify the preceding miking technique by moving the mic back so it’s about halfway inside the drum. In this case, place the mic right in the middle, pointing at where the beater strikes the drum. This placement gives you less of the attack of the beater striking the head and more of the body of the drum’s sound.

- **Near the outside head:** If you have both heads on the drum, you can place the mic a few inches from the outside head. If you want a more open, boomy sound (and you have the drum’s pitch set fairly high), point the mic directly at the center of the head. If you want less boom, offset the mic a little and point it about two-thirds of the way toward the center.

If your drum sounds thin after trying these mic placement approaches, you can try these two things:
✦ **Tune the drum slightly up.** In your quest for a deep bass tone, you may have tuned the drum too low. (This is especially common if you have a large bass drum.) In this case, the drum’s fundamental tone may be too low to be heard clearly. Raising the pitch a bit usually solves the problem.

✦ **Create a tunnel with acoustic panels.** Putting the mic in the tunnel often helps if you have a room that’s too dead. Place two of the panels on their sides (reflective surfaces facing into the room) with one end of each panel near the outside of the drum. Angle the panels out so that where they are farthest from the drum set, the distance between them is just under 4 feet. Then lay the other two panels (reflective surface facing down) across the side panels to create a tunnel. You can also place a piece of plywood on the floor under these panels to further increase the resonance. Place the mic halfway into the tunnel, facing the center of the drum.

**Snare-drum considerations**

The snare drum is probably the most important drum in popular music. The bass guitar can cover the kick drum’s rhythm, and the rest of the drums aren’t part of the main groove. A good, punchy snare drum can make a track, whereas a weak, thin one can eliminate the drive that most popular music needs.

Because the snare drum is located so close to the other drums (especially the hi-hats), a cardioid pattern mic is a must. The most common mic for a snare drum is the trusty Shure SM57. The mic is generally placed between the hi-hats and the small tom-tom about 1 or 2 inches from the snare drum head (see Figure 2-15). Point the diaphragm directly at the head. You may need to make some minor adjustments to eliminate any bleed from the hi-hats. This position gives you a nice, punchy sound.

If you want a crisper tone, you can add a second mic under the drum. Place this mic about an inch or two from the head with the diaphragm pointing at the snares. Make minor adjustments to minimize any leakage from the hi-hats.

If you have the available tracks, record each snare mic to a separate track and blend the two later during mixdown. If you don’t have the available tracks, blend them together until you have the sound that you want. You can also try reversing the phase of the bottom mic. (Some preamps have a phase switch for each channel or you can reverse the phase by choosing the Invert option under the AudioSuites menu. Choose AudioSuite ➤ Invert from the main menu.) Some people prefer the sound of the bottom mic this way.
Tom-toms
The tom-toms sound best when you use a dynamic mic. For the mounted toms (the ones above the kick drum), you can use one or two mics. If you use one mic, place it between the two drums about 4 to 6 inches away from the heads. (Figure 2-16 shows this placement option.) If you use two mics, place one above each drum about 1 to 3 inches above the head.

If you want a boomy sound with less attack, you can place a mic inside the shell with the bottom head off the drum.

Floor toms are miked the same way as the mounted tom-toms:

✦ Place a single mic a couple of inches away from the head near the rim.
✦ If you have more than one floor tom, you can place one mic between them or mic them individually.

Hi-hats
The hi-hats are generally part of the main groove — as such, they’re important enough that you want to spend some time getting a good sound. You’ll probably have problems with a few other mics on the drum set picking up the hi-hats, particularly the snare drum mic and overhead mics. (Some people don’t even bother miking the hi-hats for this reason.)
I like to mic hi-hats because, to me, these cymbals often sound too trashy through the snare-drum mic. If you mic the hi-hats, make sure that the snare-drum mic is picking up as little of the hi-hats as possible by placing it properly.

You can use either a dynamic mic or, better yet, a small diaphragm condenser mic for the hi-hats. The dynamic mic gives you a trashier sound and the small diaphragm condenser mic produces a bright sound. You can work with either by adjusting the EQ. I usually add just a little bit (4dB or so) of a shelf EQ set at 10 kHz to add just a little sheen to the hi-hats. Book 6, Chapter 3 covers EQ in detail.

Place the mic about 3 to 4 inches above the hi-hats and point it down. The exact placement of the mic is less important than the placement of the other instrument mics because of the hi-hats’ tone. Just make sure your mic isn’t so close that you hit it instead of the cymbal.

**Cymbals**

You want to know one secret to the huge drum sound of Led Zeppelin’s drummer, John Bonham? Finesse. He understood (I’m guessing, because I never really talked to him about this) that the drums sound louder and bigger in a mix if the cymbals are quieter in comparison. So he played his
cymbals softly and hit the drums pretty hard. This allowed the engineer to boost the levels of the drums without having the cymbals drown everything else out. Absolutely brilliant.

Because the drums bleeding into the overhead mics is inevitable and the overhead mics are responsible for providing much of the drums’ presence in a mix, playing the cymbals softly allows you to get more of the drums in these mics. This helps the drums sound bigger.

Ask (no, demand) that your drummer play the cymbals quieter. Also use smaller cymbals with a fast attack and a short decay. Doing these things creates a better balance between the drums and cymbals and makes the drums stand out more in comparison.

Small-diaphragm condenser mics capture the cymbals’ high frequencies well. You can mic the cymbals by placing mics about 6 inches above each cymbal or by using overhead mics set 1 to 3 feet above the cymbals. (See the next section for more on mic placement.)

**The whole kit**

Most of the time, you want to have at least one (but preferably two) ambient mics on the drums — if for no other reason than to pick up the cymbals. These (assuming you use two mics) are called *overhead mics* and (as the name implies) you place them above the drum set (usually by means of a boom stand). The most-common types of mics to use for overheads are large- and small-diaphragm condenser mics because they pick up the high frequencies in the cymbals and give the drum set’s sound a nice sheen (brightness). You also might want to try a pair of ribbon mics to pick up a nice, sweet sound on the overheads (but remember, ribbon mics can be fragile).

To mic the drum set with overhead mics, you can use either the X-Y coincident technique or spaced stereo pairs. Place them 1 to 2 feet above the cymbals, just forward of the drummer’s head. Place X-Y mics in the center and set up spaced stereo pairs so they follow the 3:1 rule (the mics should be set up 3 to 6 feet apart if they are 1 to 2 feet above the cymbals). This counters any phase problems. Point the mic down toward the drums and you’re ready to record. Figure 2-17 shows both of these setups.

**Hand drums**

Hand drums can be anything from the familiar conga to unusual drums such as the North African tar, Middle Eastern doumbek, or Brazilian Pandeiro. Because you may encounter many types of hand drums, this section gives you some general guidelines when recording any hand drum.
Your selection in mics depends on the type of drum and its tonal characteristics. For example, conga drums occupy the middle of the frequency spectrum and produce a loud sound that a large diaphragm condenser mic can capture well. Or if you want a tighter, drier sound, you can use a dynamic mic. If you choose the dynamic mic, the mic colors the sound of your recording.

If you want to record any number of the smaller, higher-pitched hand drums, use either a large or small diaphragm condenser mic and skip the dynamic mic altogether.

Mic placement also varies considerably among the various hand drums. Listen to the sound of the drum and find a place where you like what you hear. For the most part, placing the mic anywhere from 1 to 3 feet from the drum creates the fullest sound. If you want a lot of attack, you can place the mic closer. You lose some of the drum’s depth, however, when you place the mic closer than a foot.

**Percussion**

Miscellaneous percussion instruments, such as shakers and triangles, are nice additions to many styles of music. These instruments sound best with a good condenser mic. I choose a large or small diaphragm mic, depending on the characteristics that I want to pick up. For instance, a shaker can sound great with a large diaphragm mic because this mic brings out the lower frequencies of the instrument slightly and softens the overall sound a bit.

**The room and the percussion**

Most of the time, the room doesn’t have a huge impact on percussion instruments because you mic them closely. If your room does get in the way, use the acoustic panels in much the same way that I suggest for vocals earlier in this chapter (partially surround the mic and musician with baffles).
The mics and the percussion
Both large and small diaphragm mics work well for percussion. The main thing to remember when recording percussion instruments is that they can have a high SPL (Sound Pressure Level, or just plain volume), so you may need to pad the mic.

As far as mic placement goes, I like to put a single mic anywhere from 6 to 18 inches away, depending on the size of the instrument. For example, because maracas are loud, I put the mic back a bit (18 inches), whereas with a triangle, I find that 6 to 8 inches sounds best.
Chapter 3: Preparing to Record

In This Chapter

- Understanding record modes
- Allocating disk space
- Setting levels
- Monitoring track inputs
- Creating click tracks

After you get your mics set up — see Chapter 2 of this book for more on that — and before you actually start to record, there are still a few things you can do to make the process easier and to optimize the performance of your system. This chapter covers all you need to do before you actually start to record. This includes understanding and using Record modes and dealing with disk allocation, for starters.

This chapter also shows you how to enable your tracks to record, how to set your levels to give you the best sound possible, and how to manage your monitoring setup so it's easy to perform at your best. To top it off, this chapter guides you through the process of setting up a click track and song tempo and meter map so when it comes time to edit your audio (not that your performances need editing), you'll be able to do it quicker and with less effort. (Not sure what click tracks, tempo maps, and meter maps are? Don't worry. By the time you finish this chapter, you'll be throwing these terms around like a seasoned sound engineer.)

Recognizing Record Modes

Pro Tools offers the following four Record modes: Non-Destructive, Destructive, Loop, and QuickPunch. You can choose the mode you want by selecting the mode from the Operations section of the main menu (Operations ➪ QuickPunch, for example), by Ctrl+clicking (Mac) the Record button in the Transport window, or by right-clicking (on a PC) that selfsame Record button. All this clicking cycles you through the four record modes.

Each of these modes has its place; knowing which one to use for a given situation can help you greatly in the efficiency department. These different modes are detailed in the following sections.
Recognizing Record Modes

You can see which mode you’re in by looking at the Record button in the Transport window. The modes are designated as shown in Figure 3-1.

### Non-Destructive Record mode

*Non-Destructive recording* is the default setting in Pro Tools. Whenever you record in this mode, a new audio file is created without erasing any previous files or regions. This new file automatically gets added to the Audio Regions list — located on the right side of the Edit window (if it’s not visible, click the double arrow at the bottom right of the Edit window) — where it resides with the previously recorded files.

### Destructive Record mode

Recording in *Destructive Record* mode erases any and all previously recorded audio regions found on that particular track — which basically mirrors the way traditional analog tape recorders work. This can be handy for keeping your hard drives from becoming full quickly, but it means that you don’t get a chance to use a previous take after you’ve recorded over it. Since Non-Destructive Record mode is the default mode, you need to select Destructive Record mode from either the Operations menu (choose Operations ➤ Destructive from the main menu) or Ctrl-click (on a Mac) the Record button in the Transport window or right-click (on a PC) until the “D” icon appears in the Record button, as shown in Figure 3-1.

### Loop Record mode

*Loop recording* consists of choosing a start and end point on a track and having this section play over and over again while you record and rerecord. Each time the loop runs, it creates a new audio region. That way you can
record a difficult section of a song as many times as you want and still have all the takes available for review later on. To enable Loop Record mode chose Operation: Loop Record or Ctrl-click (on a Mac) the Record button in the Transport window or right-click (on a PC) until the Loop Record icon appears in the record button (Figure 3-1).

To create a loop to record to, follow these steps:

1. **Enter the start point for your loop in the Start field of the Transport window.**

   The Transport window runs along the top of the Edit window. Its (many) features are discussed in detail in Book 2, Chapter 4.

2. **Enter the end point for your loop in the End field in the Transport window.**

3. **If you want a pre-roll, enter an amount of time for it to run, using the Pre-Roll field of the Transport window.**

   The pre-roll will only happen before the first time through the loop. After that, the loop runs the same way each time through: from start point to end point and then back to the start point.

To find out how to review a bunch of audio regions you’ve recorded using loops, check out the “Auditioning takes” section of the next chapter (Book 3, Chapter 4).

**QuickPunch Record mode**

The QuickPunch Record mode is great for manually adding a corrected musical phrase on the fly — punching in (starting to record) and punching out (stopping the recording process) onto record-enabled tracks while the song plays. Of course, you can punch in and out in the Destructive and Non-Destructive modes (by selecting start and end points), but QuickPunch is designed for use on the fly: You can punch in and out up to 100 times during each pass of the song. To select the QuickPunch Record mode, choose it from the Operations menu (choose Operations: QuickPunch from the main menu) or Ctrl-click (on a Mac) the Record button in the Transport window or right-click (on a PC) until the QuickPunch icon (a little “P”, refer to Figure 3-1) appears inside the Record button.

QuickPunch also ensures that you can constantly hear the audio as the punch in and punch out happens, seamlessly switching between monitoring the already-recorded track and monitoring the input source for the track being punched.
Dealing with Disk Allocation

Recording and playing back audio tracks is a hard drive-intensive process. To make this process as smooth as possible, you want to set up your hard drive for the best possible (optimized) disk allocation — the process of specifying where your tracks get stored.

Basically, “to optimize” here means either limiting the amount of hard-drive space used for recording audio or by recording to more than one hard drive. Both options are covered in this section.

Allocating hard-drive space

How fast you can write to or read from a hard drive depends on where the data is on the disk; if it’s all over the place, the hard drive has to hunt for it, which means the data takes longer to read. To minimize the jumping around that the hard drive has to do to find the data, you can tell Pro Tools to put your recorded audio on only a limited portion of the disk. This process of disk allocation speeds up access time. (You'll find that certain types of hard-drive formats, such as HFS+, and NTFS, are especially prone to slow-pokiness and can benefit from this “marking off” of available disk space.)

To allocate your hard-drive space, follow these steps:

1. Choose Setups › Preferences from the main menu.
   
   The Preferences dialog box duly appears.

2. Click the Operation tab at the top of the Preferences dialog box.
   
   The Preferences dialog box puts on its Operation face.

3. In the Open Ended Record Allocation box, choose Limit To:

4. Type in a time slightly longer than the longest song you usually record.

   This limits the maximum file size so that Pro Tools places it within certain boundaries on the hard drive, thus reducing the real estate that must be traveled for each file.
If you expect that you might end up with a really long song, check the Use All Available Space option instead — or choose a really high number (say, 60 minutes) for your limit. This way your recording won’t stop before you want it to.

**Using multiple audio drives**

One way to increase your ability to record and play back more tracks is to have more than one hard drive dedicated to audio. (Remember, this means having three hard drives in your computer: one for the system files and applications, and two for audio.)

To allocate a specific hard drive on which to record a track, choose Setups ➪ Disk Allocation from the main menu to open the Disk Allocation dialog box (as shown in Figure 3-2). In this dialog box, you can manually choose the hard drive that each audio track is recorded to by click-holding the track name (a pop-up menu opens) and selecting one of the drives from the list (all the drives in your computer will show up in this list). Or you can check the Use Round Robin Allocation for New Tracks option — in which case, Pro Tools distributes the tracks serially to more than one hard drive. All your files are placed in a folder created for the session by Pro Tools.

If you want to designate a different folder to record your tracks to, check the Disk Allocation dialog box and press Change. Select the folder from the dialog box that appears.

If you want to record audio to the system drive, remember that audio takes up a big honkin’ lot of space, and having to deal with it will compromise the performance of your system. Only choose this drive if you have no other options — you have only one hard drive in your system, for example, or all your other drives are full.
Enabling Recording

When you enable recording for a track, you’re ready to go. But before you push the ol’ Record Enable button, check out what I have to say about the ins and outs of enabling recording, using Latch mode, and running the Record Safe mode. Doing so may help you avoid some common pitfalls.

Record-enabling

Enabling a track for recording (the audio buzzword is record-enabling) is easy: Just click the Record Enable button for that track in either the Edit or Mix window (Figure 3-3). The track will stay in Record mode until you either click another track’s Record Enable button or you toggle out of Record mode (by clicking the track’s Record Enable button one more time).

It is possible to keep a track in Record mode when you move on and enable other tracks — just engage the Latch mode (see next section) or hold the Shift key down as you select your other track(s).

Aside from simply clicking the Record Enable button, you are free to use keyboard shortcuts to enable all tracks or selected tracks. These are done the following ways:

✦ **To record-enable all tracks**: Option+click (on a Mac) or Alt+click (on a PC) the Record Enable button of any track.

✦ **To record-enable selected tracks**: Shift+click each track to select multiple tracks and then Shift+option+click (on a Mac) or Shift+Alt+click (on a PC) the Record Enable button on one of the selected tracks. You can select grouped tracks to enable by highlighting the group in the Edit Groups list (located in the lower right of the Edit window) and then Shift+option+clicking (on a Mac) or Shift+Alt+clicking (on a PC) a Record Enable button on one of the tracks in the group.

This step is only a time-saver if you already have some tracks selected and you want to record enable them. If your tracks aren’t already selected it’s much faster to just Shift+click the Record Enable button on each track.

Once you have one or more tracks enabled for recording, you can hit Record then Play to start recording. (Book 3, Chapter 4, has more on the intricacies of recording.)
Using Latch Record Enable mode

With Pro Tools, you have the option of latching — or unlatching — your Record Enable buttons. And what, pray tell, is latching? Well, in Latch Record Enable mode you basically “lock” record enabling down so, when you enable recording on one track and then move to enable recording on another track, the first track stays in Record Enable mode. This allows you to consecutively enable more than one track.

With Latch Record Enable mode off, when you enable one track and then go to enable another track, the first track will turn off and no longer be record-enabled.

Now that that’s straight, here’s how you actually turn Latch Record Enable mode on and off:

1. **Choose Setups ➪ Preferences from the main menu.**
   The Preferences dialog box appears.

2. **In the Preferences dialog box, choose the Operation tab.**
   The Operation view of the Preferences dialog box appears.

3. **Check the Latch Record Enable Buttons box to turn on this feature.**
   This check box is located in the upper right of the window as shown in Figure 3-4.
Running Record Safe mode

Record Safe mode does for your tracks what Write Protect features do for your floppy disks or Zip disks — it makes it impossible for you to record-enable a track. This is a truly helpful feature that has saved me from accidentally recording over an already-great track. To put a track into Record Safe mode, Command+click (on a Mac) or Ctrl+click (on a PC) the track’s Record Enable button. (Remember: You can find the Record Enable button in either the Edit window or the Mix window — refer to Figure 3-3.) If you clicked correctly, the Record Enable button will gray out, as shown in Figure 3-5. To reverse this procedure, Command+click (Mac) or Ctrl+click (PC) the button again.

If you want, you can put more than one track at a time in Record Safe mode. Here’s how:

✦ **Placing selected tracks in Record Safe mode**: Command-Option-Shift-click (on a Mac) or Ctrl+Alt-Shift-click (on a PC) the Record Enable button for one of the selected tracks. This step assumes you have tracks already selected (Shift+click the track name in either Edit or Mix window...
to select them). If the tracks aren’t already selected, then it’s much quicker just Command+clicking (on a Mac) or Ctrl+clicking (on a PC) the track’s Record Enable button for each track.

✦ **Placing all tracks in Record Safe mode**: Command+Option+click (on a Mac) or Ctrl+Alt+click (on a PC) the Record Enable button on any track.

To toggle either selection off, just repeat whatever click combination you used to get the multiple tracks selected in the first place.

## Setting Levels

One of the most important parts of getting good recordings is to get your recording levels just right — too low and your instrument sounds thin or weak, too much level and you risk clipping (distorting) the signal.

In order to get a signal into Pro Tools, you need to a) record-enable a track and b) have the Input selector set to the hardware input your instrument or microphone is plugged into. (Book 2, Chapter 3 has more on inputs in general and Input selectors in particular.) Once this is done you can set the recording level in Pro Tools one of two ways:

✦ **Using the preamp trim knob in your Digidesign interface**. The 002 and 002R have four preamps while the M-Box and 001 have two preamps. You can plug your microphone or your electric guitar or bass directly into the input and adjust the trim knob until you get a good signal showing in the track’s level meter. (“Good” here means peaks that don’t rise above the yellow — see the “What’s a good level to record at?” sidebar, later in this chapter.)

Condenser mics need phantom power to function. You can turn on phantom power to the channels with preamps by engaging the switch on the back panel of the interface.

✦ **Using the line-in inputs in your interface and adjusting the output level of your instrument using the instrument’s volume control**. If you use the line-in inputs, your instrument needs to be at line level. This means that you can plug your synthesizer directly into these inputs but if you want to use a microphone or an electric guitar or bass, you need to boost the signal beforehand.

For microphones, this involves using an external preamp and plugging your mic into the preamp and the preamp into your Digidesign interface. For an electric guitar or bass, you need a direct box (or a preamp with a direct box connection). You place this device between your guitar’s output and the Digidesign input. Make adjustments to your signal level at this device, using the device’s gain control.
Setting a Record Range

The Volume fader for the track has no control over the Input level. It only controls the playback and monitoring level. So if you want to adjust the Input level, you need to make the adjustments on your interface or preamp. (Check your owner’s manual if you’re not sure how to do this.)

Adjust the level of your input until you get a reading of the highest notes somewhere in the middle of the yellow range in the track’s level meter.

What’s a good level to record at?

There’s a lot of debate among professional recording engineers as to what’s the best level to record at in a digital recorder (such as Pro Tools). Some say you should get as high a level as possible to take full advantage of the dynamic range that digital recording offers. Others say that it’s better to record a little lower so you don’t overload the summing bus of the software when it comes time to mix. According to this theory, doing so prevents unintentional clipping (distortion, in other words) from extreme transients (the initial attack of the instrument) when recording. So, which way should you go?

Well, since I record a lot of instruments with fast, extreme transients such as drums, I fall into the “record lower to be safe” category. Typically I go for a level around –12dB, with peaks no higher than –6dB. (If you follow my lead here, your level meter should read in the low- to middle-yellow range.) This gives me a good signal that has plenty of dynamic range but still leaves some headroom (room for more signal before clipping) to work with. It also minimizes any possibility of extreme transients ruining the take.

I’m going to recommend, then, that you keep your maximum levels squarely in the low to middle of the yellow range in the track’s level meter, regardless of the type of instrument you want to record. If you follow my advice, you’ll definitely thank me when you start to mix all your tracks together. (Check out Book 6 for more on mixing.)

Typically I go for a level around –12dB, with peaks no higher than –6dB. (If you follow my lead here, your level meter should read in the low- to middle-yellow range.) This gives me a good signal that has plenty of dynamic range but still leaves some headroom (room for more signal before clipping) to work with. It also minimizes any possibility of extreme transients ruining the take.

I’m going to recommend, then, that you keep your maximum levels squarely in the low to middle of the yellow range in the track’s level meter, regardless of the type of instrument you want to record. If you follow my advice, you’ll definitely thank me when you start to mix all your tracks together. (Check out Book 6 for more on mixing.)

Setting a Record Range

When you record in Pro Tools, you can either start and stop your session as you record or you can set a recording range so the Pro Tools starts and stops the recording process for you. This can be useful if you have your hands full with instruments and you don’t want to take the chance that you’ll miss your desired start or stop point by doing it by hand.

You can set the recording range using one of several methods:

✦ Type a start and end time into the Start and End boxes of the Transport window. (For a detailed look at the Transport window, check out Book 2, Chapter 4.)
Select a range in the ruler or in a track's playlist. If you want to use the ruler method, simply adjust the two blue arrows along the timeline until you have the Beginning arrow and the End arrow where you want them. If you want to use the track playlist method — where you set beginning and end times by dragging across the record range with the Selector tool — you must have the Link Edit and Timeline Selections turned on. This is done either by choosing Operations ➪ Link Edit and Timeline Selections from the main menu or by clicking the Link button in the Edit window. (The Link button, shown here in the margin, is on the long, black toolbar right above the timeline in the Edit window. Book 2, Chapter 4 tells you more about it.) To turn Link Edit and Timeline Selections off again, click the Link button again or choose Operations ➪ Auto Input Monitor from the main menu.

Of course, if you don’t want to preset the recording range — letting the clips fall where they may, as it were — don’t select either of these options and just let the playing start wherever it is and run to the end.

You can also set a pre-roll and post-roll time in the Transport window. You use pre-roll and post-roll settings to designate an amount of time for the song to play either before (pre-roll) or after (post-roll) the actual recording happens. This can help you get into the groove of the song before you need to start worrying about how well you’re playing.

**Monitoring Your Tracks**

To record effectively, you need to hear what you’re doing. This is the role of monitoring. Managing your input monitoring in Pro Tools involves setting up your monitor configuration and output and balancing between lowest latency (the delay between input and output of the sound) and system performance. These areas are detailed in this section.

**Setting up monitoring**

To set up your monitoring, you first need to choose the output of the tracks you want to monitor so they match the main outputs on your system. Do this by selecting the outputs in each track’s Output selector, located above the Pan control in the Mix window. (Book 2, Chapter 4 has more than you’d ever need to know about Output selectors and Mix windows.)

**Choosing a monitor mode**

Pro Tools has two monitor modes: Auto Input monitoring and Input Only monitoring. (More on what these terms actually mean in a minute.) You can select between these two options by choosing Operations ➪ Auto Input Monitor or Operations ➪ Input Only Monitor from the main menu. (See Figure 3-6.)
Monitoring Your Tracks

Auto Input monitoring
In Auto Input Monitoring mode, you hear your previously recorded audio (if there is any) on a record-enabled track right up until the point you start to record. Once recording has begun, you hear the input source as it's being recorded. After the recording is done, Pro Tools switches you back to hearing the previously recorded stuff. This is useful for doing punch recording, where you start and stop recording while the session plays.

Input Only monitoring
In Input Only Monitoring mode, you only hear the input source through your monitors, regardless of whether other stuff is recorded on that track. When this mode is enabled, the Record button in the Transport window is green. When this mode is not enabled the record button is red.

Linking and unlinking Record and Playback faders
You have the option of “linking” the fader on your tracks when in Record Enable or Playback mode (meaning that moving the fader in one mode moves it the same distance in the other mode) or “unlinking” them (so you can maintain separate fader levels in each mode). If you opt for the unlinking option, Pro Tools remembers where your fader was set in both Record Enable mode and Playback mode and returns the fader to its position when you switch between these modes.

Unlinking your Record and Playback faders allows you to set the level differently for playback and record. This can be useful for punch recording — where you start and stop recording while the session plays — since you can adjust both the recorded stuff and your input source independently and have the same relative levels between your previously recorded track and the input in the mix. Otherwise your input source may be too loud or too soft in comparison.
To link Record and Playback faders, follow these steps:

1. **Choose Setups ➤ Preferences from the main menu.**
   The Preferences dialog box makes an appearance.

2. **Click the Operation tab at the top of the Preferences dialog box.**
   The Preferences dialog box presents you with its Operation face.

3. **Check or uncheck the Link Record and Play Faders box located in the column on the right, as shown in Figure 3-7, depending which way you want to work.**

4. **Click Done.**

---

### Adjusting the monitoring latency

All digital systems have some delay between the input of the audio and its output. This is called latency. Latency used to be a big deal in computer-based systems, because to record more than a couple of tracks at once you had to set your system — usually by using a high HW (hardware) buffer size — so the latency was painfully noticeable. This made it hard for many musicians to record because they heard a distracting delay in their headphones as they recorded.

Nowadays, latency isn’t such a big deal because computers are often powerful enough to be able to handle a lower buffer size while recording. You can lower the buffer size in the Playback Engine dialog box, shown in Figure 3-8. (To access the Playback Engine dialog box, just choose Setups ➤ Playback Engine from the main menu.) Depending on your Digidesign interface, you have the choice between 64 (002 and 002R only), 128, 256, 512, and 1024 samples. The lower the number, the lower the latency.
For most recordings, you can get by with either 256- or 128-sample settings. When recording at 44.1 kHz, this only represents around a 3 and 6 ms delay, respectively. This is equivalent to standing either 3 or 6 feet away from your instrument/amp/speaker. When mixing lots of tracks with a bunch of plug-ins, you want to adjust this to a higher setting such as 512 or even 1024, depending on the speed of your processor.

**Using low-latency monitoring**

If you want the least amount of latency possible and you don’t mind not hearing reverb or other effects through your headphones, you can go for the low-latency monitoring option: Just choose **Operations** Æ **Low Latency Monitoring** from the main menu. (See Figure 3-9.)

Low-latency monitoring bypasses the internal mixer in Pro Tools and sends the input’s sound back out without processing it. This reduces latency but it also limits what you can do. Here are some of the “strings attached” that come with low-latency monitoring:
✦ Low-latency monitoring only applies to outputs 1 and 2 on your hardware. Any tracks set to another output can’t be monitored this way, so you must choose outputs 1 and 2 as your outputs for the track you want to monitor.

✦ None of the plug-ins that you have routed to tracks 1 and 2 will be heard in this mode.

✦ Tracks set to record from an internal bus (a submix for example) can’t be monitored this way. You can only use this mode for tracks that use a hardware input.

✦ Tracks that you’re recording to won’t show up in the levels at the Master Fader channel.

Creating a Click Track

A click track is basically a metronome that you can listen to while recording to ensure that you stay in time with the session. Recording to a click track can have many advantages, including being able to match the song’s sections to particular bars or beats within the session. It also makes finding edit points and performing certain edits much easier. I always spend a few minutes setting up a click track for my songs and I recommend that you give it try, too.

To create a click track, you need to attach and configure a MIDI device to produce the click. You also need to set a tempo and meter and create a track to record the click to. The steps for these procedures are covered in this section.

Setting the tempo

To set the tempo and meter of your session, or a section within your session, double-click the Meter button in the expanded Transport window (Check out Book 2, Chapter 4 for more on the expanded Transport window) or choose Windows > Show Tempo/Meter from the main menu. This will open the Tempo/Meter Change dialog box. Choose Tempo Change from the drop-down menu and you will have four parameters to adjust, as shown in Figure 3-10:

✦ Snap to Bar: Checking this box aligns any tempo event you create to the first beat in the nearest bar.

✦ Location: This is where you type the location where this tempo will begin. Choosing 1/1/000 (bars/beats/ticks) makes this the default tempo for the song.

✦ Tempo: This box lets you type in the tempo, in beats per minute (BPM).

✦ Resolution: This menu lets you choose the BPM (beats per minute) value for the tempo of the song or song’s section. The default is 1/4 note.
Choosing the meter

You set the meter for the session with the help of the Tempo/Meter Change dialog box. You call up the dialog box by double-clicking the Meter button in the expanded Transport window (or choose Windows ➪ Show Tempo/Meter from the main menu). When the dialog box appears, choose Meter Change from the drop-down menu, as shown in Figure 3-11. The Meter Change view of the Tempo/Meter Change dialog box gives you the following parameters to adjust:

✦ **Snap to Bar**: Check this box to align any meter events with the first beat in the nearest bar.

✦ **Location**: The number you enter in this box determines the beginning of the meter (time signature) event. For songs with only one time signature, you enter 1/1/000 (bars/beats/ticks).

✦ **Meter**: This box lets you type in the meter (4/4, for example) that you want to use.

✦ **Click**: This menu lets you choose the note value for the clicks played in each measure. Choosing 1/4 note gives you four clicks in a 4/4 measure.
Creating a Click Track

Configuring your device
To play a click track in Pro Tools, you need a device for creating the sound. This can be an external MIDI sound module (such as a drum machine or keyboard) or a virtual device such as the DigiRack Click software plug-in (only available in versions 6.0 and up).

To configure the click-track device, follow these steps:

1. **If you’re using an external MIDI device for your click, connect the device to a MIDI port connected to your computer.**
   
   The 002 and 002R come with MIDI ports. The 001 and M-Box do not — if you have one of these, you have to get a separate MIDI interface (Book 1, Chapter 4 can get you up to speed on this). If you use the Click plug-in, you don’t need to use your MIDI ports.

2. **Choose MIDI: Click Options from the main menu or double-click either the Click button or the Countoff button in the Transport window.**
   
   The Click/Countoff Options dialog box appears, as shown in Figure 3-12.

3. **In the Click/Countoff Options dialog box, click the Output drop-down menu to choose the device that will play your click.**
   
   If you’re using an external device, be sure to choose the port and MIDI channel that your device is connected to. If you’re using the Click plug-in, choose None.

4. **Choose when you want the click to be played by selecting from the options at the top of the window.**
   
   You can choose between During Play and Record, Only During Record, and Only During Countoff.

5. **Using the appropriate boxes, choose the MIDI note, velocity, and duration for the accented and unaccented notes of the click.**

6. **Select whether you want a countoff only during record or not and then enter the number of bars you want in the Bars field.**
   
   Selecting Only During Record means that there will be no countoff when you play back the track. If you don’t want any countoff at all, type in 0 bars in the Bars field.

Even with your device configured, you still won’t get any sound out of your click track until you enable it in your session. The next section shows you how to do this.
Enabling a click track

Even an electronic equivalent of a metronome has to be set in motion to do any good. When you’ve set up your click track to do its job, you have to enable it so it will run while you’re recording.

You can enable your click track in one of two ways:

✦ Choose MIDI➪Click from the main menu.
✦ Click the Click button in the MIDI section of the Transport window. When Click is engaged this button will be blue.

You can engage the countoff by clicking the Countoff button in the MIDI section of the Transport window. This button displays the number of bars that the countoff is set for, and shows itself as blue when it’s engaged.

Hearing your click

Of course, even when enabled, a click track does no good if you can’t hear it — and yes, you have to tell the computer to let you hear it. To hear the click played, you need to set up either your MIDI device or Click plug-in in its own session track. The procedure for each is explained in this section.

Connecting an external device

Follow these steps to connect your external MIDI device to sound the click:
1. Connect the audio output of your external MIDI device to an audio input of your Digidesign hardware.

2. Create a new mono audio track by selecting File ➪ New Track from the main menu or by pressing Shift+Command+N (on a Mac) or Shift+Control+N (on a PC). When the New Track dialog box opens, use the pop-up menus to choose a single mono Audio track and then click Create.

   Your track appears in the Edit and Mix window and in the Audio Regions list located at the right side of the Edit window.

   Why mono? Well, it’s annoying to hear the clicking in only one ear. Mono puts it in both ears, nice and clear.

3. Using the Input selector for your new track in either the Edit or Mix window, select the input that corresponds to the input your device is connected to.

4. Set the output to the main stereo outputs of your session, using the Output selector for your new track in either the Edit or Mix window.

5. Record-enable the track by clicking the Record Enable button in either the Edit or Mix window.

   Your click track plays according to your choice in the Click/Countoff dialog box.

Routing the Click plug-in

Routing the Click plug-in to play the click requires these steps:

1. Create a new auxiliary track by selecting File ➪ New Track from the main menu or by pressing Shift+Command+N (on a Mac) or Shift+Control+N (on a PC).

   The New Track dialog box opens.

2. Use the pop-up menus to choose a single mono Aux Input track and then click Create.

   Your track appears in the Edit and Mix windows.

3. Using the Input selector for your new track in the Edit or Mix window, select any one of your hardware inputs.

4. Set the output to the main stereo outputs of your session, using the Output drop-down menu for your new track.

5. Display your Inserts options by choosing Displays ➪ Mix Window Shows ➪ Inserts.

   The Inserts section for each channel strip appears in the Mix window.
6. Choose Click Plug-in from the Inserts drop-down menu for the track you just created, as shown in Figure 3-13.

The Click Plug-In dialog box opens.

7. Use the Click Plug-In dialog box to choose the volume for your accented and unaccented notes. Adjust the controls to taste and then close the window by clicking the button in the upper left.

Your click track plays according to your choice in the Click/Countoff dialog box.

I normally use a drum machine (or other decent drum sound from an external device) to create my click. The Click plug-in, handy as it is, doesn’t have the most pleasing sound.

**Setting up tempo and meter events**

If your song has any tempo or meter changes in it, you can set up a map of these changes (events). You may want to do this if you have complex songs with several different time signatures or tempos. This makes sure that your click track follows these changes so you can stay in time too. This section shows you how.

**Creating new tempo or meter events**

Tempo and meter events are changes to your tempo or meter throughout the song. You can make changes to the tempo or meter anywhere within the song and the placement of these events throughout the session constitutes
the tempo and meter maps. The easiest way to create new tempo or meter
events is to type in the location of the change of tempo or meter in the
Location field within the Tempo/Meter Options windows. You can also select
your locations by doing the following:

1. **Click the Tempo or Meter ruler bar in the Edit window where you
want your tempo or meter change to happen.**
   
   Book 2, Chapter 4 gives you all the details on both the Tempo and Meter
   ruler bars.

2. **Open the Tempo/Meter Change dialog box by clicking the appropriate
icon at the far-left side of the ruler bar.**
   
   In the Tempo ruler, the icon is a quarter note; for the Meter ruler,
   the icon is a fraction (⅓).

3. **In the Tempo/Meter Change dialog box, check the Snap to Bar box if
you want the tempo or meter event to start at the beginning of the
nearest bar.**

4. **Type in the tempo or meter you want to use for that section.**

5. **Click Apply.**
   
   A triangle icon (green for tempo and yellow for meter) appears at the
   location of this tempo or meter change.

You can use these steps to create more changes in tempo or meter (events)
anywhere within the session. As you create these events, Pro Tools creates a
map of them within your session with the little icons.

**Editing tempo and meter events**

When your tempo or meter events are in place, you can move them around,
delete them, copy them, or paste them. The following list tells you how:

- **Moving a tempo or meter event:** You can move the location of tempo or
  meter events easily by dragging the corresponding triangle along the
  ruler to where you want it. Alternatively, you can double-click the trian-
  gle to open the Tempo/Meter Change window, where you can use the
  Location field to set a specific location.

- **Deleting an event:** To delete an event, Option+click (on a Mac) or
  Alt+click (on a PC) over the triangle of the event you want to remove.

- **Copying an event:** To copy a tempo or meter event, follow these steps:

  1. **Set the Edit mode to Grid and the grid resolution to 1 bar.**
     
     Doing so ensures that you select the beginning of a bar. (Book 4,
     Chapter 1 details how to work with Edit modes and grid resolutions.)
2. **Press Command (on a Mac) or Ctrl (on a PC) and click and drag from the beginning to the end of the event you want to copy.**
   You can select more than one contiguous event by continuing to drag across the events you want to select.

3. **Choose Edit ➪ Copy from the main menu or press Command+C (on Mac) or Ctrl+C (on a PC) to copy the events.**

   ✦ **Pasting an event:** To paste an event that you’ve already copied, follow these steps:

   1. **Click the place in the ruler bar where you want to paste the event(s).**

   2. **Choose Edit ➪ Paste from the main menu or press Command+V (on a Mac) or Ctrl+V (on a PC).**
Chapter 4: Recording Audio

In This Chapter
- Recording a track
- Recording multiple tracks
- Playing back audio
- Recording additional tracks

Recording audio is what Pro Tools does best. (Well, that and editing it. See Book 4.) This chapter guides you through the process of recording single and multiple tracks from analog and digital sources, as well as playing all that stuff back again. In this chapter, you also discover the home recordist’s best way to create full-blown songs: overdubbing.

Overdubbing is adding tracks to those you’ve already recorded. This is a process that I guarantee you’ll use a lot, so I spend a fair amount of time getting you up to speed on the best (and easiest) ways to overdub in Pro Tools.

Recording Tracks

Recording audio tracks in Pro Tools requires that you first choose your Record mode, create a track, set levels, enable recording, and turn on a click track if you’re using one. These steps are all covered in detail in Book 3, Chapter 3 (the previous chapter), but you’ll also find a basic overview of these topics in this section.

Once you have all these steps taken care of, you’re ready to record some audio. This section leads you through the process of recording a single track or multiple tracks, undoing or canceling takes, recording additional takes, auditioning takes, and using playlists to organize and choose takes to listen to.

Recording a single track

Most home recordists tend to record a single track at a time. (After all, most human beings can only play one instrument at a time.) Recording to a single track — whether it’s a mono or stereo — requires the following basic steps (Steps 1-6 are explained in detail in Book 3, Chapter 3 — the previous chapter):
1. Open a session or create a new session.

2. Create a new audio track by pressing Command+N (on a Mac) or Ctrl+N (on a PC) or by choosing File → New Track from the main menu.

3. Assign an input and output to your new track by using the Input and Output drop-down menus found in the Controls section of the track.

4. Record-enable the track.

5. Set your recording level.

   Be sure that your monitor speakers are turned off or all the way down if you’re recording in the same room as your monitors, because the microphone may create feedback (an obnoxious hum or squeal) if it’s too close to your speakers. My advice: When recording, use headphones to monitor your playing.

6. Enable the click track and pre-roll (if you’re using those features).

7. Click the Return to Zero button in the Basic Controls section of the Transport window, as shown in Figure 4-1.

   This ensures that you start recording at the beginning of the session.

8. Click the Record button in the Basic Controls section of the Transport window, as shown in Figure 4-2. The Record button blinks red.

   Keep in mind that clicking Record doesn’t actually start the recording process; it only gets Pro Tools ready for recording.

   If you want to record using keyboard shortcuts for Step 8, you can use any of the following methods:

   - Press the F12 key.
   - Press Command+Spacebar (on a Mac) or Ctrl+Spacebar (on a PC).
✦ If you’ve set your system so your Numeric Keyboard mode is linked to Transport, just press the numeric keyboard’s 3 key. (Linking your numeric keyboard to Transport is easy; just choose Setups ➪ Preferences from the main menu to access the Preferences dialog box, select the Operation tab from the dialog box and then select Transport in the Numeric Keypad mode section.)

9. Click the Play button in the Basic Controls section of the Transport window (Figure 4-3).

Only after you click Play does Pro Tools actually start recording; the Record button glows a nice red while recording (not that you’ll be watching it as you play).

10. When you’re done recording, click the Stop button in the Basic Controls section of the Transport window or press the Spacebar on your keyboard.

This take appears in the Audio Regions list as a new region.

(The Audio Regions list is on the right side of the Edit window. If this list isn’t showing, click the double arrow at the bottom-right corner of the Edit window.)
Managing multiple tracks at once

There are times that you’ll want to record more than one track at a time — when you stereo-mic an instrument, when you record drums using several mics, or even when you want to record a few musicians at a time. Recording multiple tracks at one time follows much the same procedure as if you were recording a single track — the only difference is that you use one of the following methods to choose multiple tracks:

✦ Select the Latch Record Enable Buttons option in the Operation tab of the Preferences dialog box, and then click each track’s Record Enable button. (To call up the Preferences dialog box, choose Setups ➪ Preferences from the main menu.)

✦ Press and hold the Shift key as you click each track’s Record Enable button to record enable noncontiguous tracks.

✦ To select all the tracks in your session, Option+click (on a Mac) or Alt+click (on a PC) the Record Enable button on any track.

✦ To record-enable a selected track, Shift+option+click (Mac) or Shift+Alt+click (PC) the Record Enable button on the selected track.

Book 3, Chapter 3 has more on these options.

Recording multiple tracks at once takes a toll on your system. A normal and common symptom of this load is a delay between the time you click the Play button and when the recording actually starts. You can eliminate this delay by letting your system “warm up” first. This is done by following these steps:

1. Click the Record button.

2. Press and hold Alt (on a PC) or Option (on a Mac) key while you click the Play button.

   The Record and Play buttons flash.

3. Click the Play button when you’re ready to record.

   Pro Tools starts recording immediately, with no delay.

4. When you’re done recording, click the Stop button.

Using pre- and post-rolls

A pre-roll or post-roll is a designated amount of time that the session plays before or after the recording starts or stops. I’m a big fan of pre- and post-rolls (well, at least pre-rolls). For example, setting a pre-roll for two or three bars lets me get into the groove of a song before the recording actually starts. You can set pre- and post-rolls several ways, as the following sections make abundantly clear.
Using the Pre-Roll and Post-Roll fields in the Transport window

To set the pre- and post-roll values in the Transport window, do the following:

1. Choose Displays ➪ Transport Window Shows ➪ Expanded View from the main menu.

   The Pre-Roll and Post-Roll fields appear beneath the basic transport controls.

2. Click in the Pre-Roll Counter field in the Transport window and type in the length you want, as shown in Figure 4-4.

   This field will be displayed in the same format as the main counter. In the case of Figure 4-4, the format is bars and beats.

3. Press Enter.

4. Click in the Post-Roll Counter field and type in your desired value.

   This, too, will be displayed in the format selected for the main counter.

5. Press Enter.

6. Click the Pre-Roll and/or Post-Roll button in the Transport window to enable it. (The buttons are labeled “pre-roll” and “post-roll” and are to the left of the counter fields you used in Steps 2 and 4.)

   All enabled buttons are highlighted.

---

Using the Pre-Roll and Post-Roll flags in the ruler bar of the Edit window

The Pre- and Post-Roll flags are located along the Timebase ruler in the Edit window. The flags are colored gray when they are disabled and green when they are enabled. Follow these steps to set the pre-roll and post-roll amounts using the flags in the ruler bar:
1. Press Command+K (on a Mac) or Ctrl+K (on a PC) or choose Operations ‣ Pre/Post-Roll Playback from the main menu to enable Pre-Roll and Post-Roll flags on the ruler of the Edit window.

The flags turn green to alert you that the pre- and post-roll functions are enabled.

2. If you want the flag to snap to the grid, click the Grid button in the upper-right of the Edit window to select the Grid Edit mode. Otherwise use any other Edit mode.

3. Click and drag the Pre- and Post-Roll flags on the ruler to where you want them.

   If you want the same value for both the pre- and post-rolls, you can press Alt (on a PC) or Option (on a Mac) while you drag one of the flags. The other flag will follow along as you move one.

**Setting pre-rolls and post-rolls within a track’s playlist**

Playlists are the regions contained in a track and are located in the middle of the Edit window to the right of the track controls. Playlists most often display the waveform for the audio in the regions but can be set to display other things, such as automation views. In addition to all the other neat things you can do with a playlist, you can also enable and disable pre- and post-rolls. Just do the following:

1. Choose Operations ‣ Link Edit and Timeline Selection from the main menu.

2. Click the Selector tool and drag along your track where you want the recording to start and stop.

   This selects your record range.

3. Option+click (on a Mac) or Alt+click (on a PC) the track’s playlist where you want to put the pre-roll.

   This both turns on the pre-roll and sets its location, as shown in Figure 4-5.

4. Option+click (on a Mac) or Alt+click (on a PC) the track’s playlist where you want to put the post-roll.

   This both turns on the post-roll and sets its location.
To turn off the pre-roll from within a track's playlist, Option+click (on a Mac) or Alt+click (on a PC) near the Start point of the record range selected. To turn off the post-roll, Option+click (on a Mac) or Alt+click (on a PC) near the End point of the record range selected.

Figure 4-5: Setting the pre-or post-roll flag.

Playing Back Your Tracks

After you've recorded a track, most likely you'll want to listen to it to make sure that it sounds the way you want it. Pro Tools offers you many ways to play back a track. In this section, I guide you through a few of the many options for playing back audio regions.

Playing recorded tracks

After you've recorded a track and clicked the Stop button, you can hear the track by turning off the Record Enable button (click it to make the light disappear, as shown at left in Figure 4-6) and then clicking the Play button (shown at right in Figure 4-6). You can adjust the volume by moving the channel's fader up and down.

If you use the Auto Input Monitoring option from the Operations menu, there is no need to disable the Record Enable button. All you have to do is return to the beginning of the session (Press the Return to Zero button in the Transport window) and click the Play button in Basic Controls section of the Transport window. Pro Tools will automatically switch to play back the recorded track. When you click Record, and then click Start to record another take, Pro Tools will switch your monitoring back to the input.

Before you play back a track, make sure the fader is turned down most of the way; too-high volume can ruin your ears or speakers. You can slowly bring it up as the session plays to get the volume you want.
If you have Link Edit and Timeline Selection checked under the Operations menu, you can play back your recorded track from anywhere in the session by clicking where you want to start on the Timebase ruler — using the Selector tool in the Edit window — and then clicking Start. You can also use the Rewind and Fast Forward buttons to move through the session, but this tip makes getting around much faster and easier.

**Setting scrolling options**

Pro Tools lets you decide how you want the track material and Timebase ruler data to move (scroll) in Edit window as a session is playing or recording. You can choose between the following (all located in the Scroll Options submenu under the Operations menu, as shown in Figure 4-7):

- **No Auto-Scrolling:** With this option chosen, the Edit window remains where it is as the session plays. You can still move through the session by sliding the scroll bar at the bottom of the window as the session plays.
✦ **Scroll After Playback:** Scroll After Playback keeps the Edit window static as the session plays and immediately takes you to the current location of the song after the session has stopped.

✦ **Page Scroll During Playback:** Page scrolling during playback keeps the cursor visible at all times as the session plays. As the cursor moves from left to right, the window moves right.

This is the option I generally choose because I can easily keep track of where I am in the session at all times.

**Listening to playback loops**

If you want to hear a specific section of a session over and over — to find unidentifiable sounds, for example — you can create a playback loop. You set this up by choosing Operations—Loop Playback from the main menu, as shown in Figure 4-8, or you can press Shift+Command+L or Ctrl+click the Play button (on a Mac) or Shift+Ctrl+L or right-click the Play button (on a PC).

Next, set the Start and End point of the loop. There are several ways to designate the Start and End points. These include:

✦ **Use the Start and End fields in the Expanded section of the Transport window:** Click in the Start and End fields and type in the Start and End points of your loop.

✦ **Select a range in the track’s playlist or Timebase ruler (the timeline near the top of the Edit window):** Make sure that you have the Link Edit and Timeline Selection option checked in the Operations menu. Then, using the Selector tool, choose the range you want to loop, either in a track or along the Timebase ruler by dragging the Selector from the Start to End point.
Drag the playback markers in the Timebase ruler (timeline): Using the Selector tool, click and drag the playback markers (also called Start and End point markers). These are the blue arrows—or red if you have any tracks record-enabled—at the beginning and end points of your loop. You can move the markers either together or individually.

Use memory locators: Memory locators are user-assigned markers in the song. (This option is covered in detail in Book 4, Chapter 3.)

Click the Play button in the Basic Controls section of the Transport window to listen to the loop.

Using the Scrub feature
The Scrub feature in Pro Tools—located in the Edit window—works just like rocking the tape back and forth against the playback head of a reel-to-reel tape machine. (A what?) Um, okay. If you don’t recall that bit of twentieth-century technology, just trust me: Scrubbing was a way of listening to tiny snippets of a recorded track by moving the tape only a little. You can listen to a track by moving the cursor back and forth across the spot you want to hear. You can hear it both forward and backward (in case you want to check the secret backward message . . . just kidding). This is useful in finding a specific note in the track—the hit of a snare drum, for instance. One of the great things about the Pro Tools Scrub feature (as opposed to that of some other recording programs) is that you can scrub at any speed by simply moving the cursor at different speeds.

To scrub a track, follow these steps:

1. Click the Scrubber button from the top of the Edit window, as shown in Figure 4-9.

   The Scrubber button looks like a minispeaker emitting sound.

2. Click-and-drag over the waveform in a track to hear it played.
You can scrub two adjacent tracks at once by dragging the Scrubber at the boundary between the two tracks.

**Doing Additional Takes**

Chances are that your first attempt at recording a track wasn’t as good as you’d like. No problem. You can just do another take. This process is the same as recording your first one, but Pro Tools offers some options that can make it easy and fun to get the “perfect” performance. These include loop recording, punching in and out — sometimes (if you’re really on the fly) using the Pro Tools QuickPunch feature. Of course, you can always just record the whole thing over again if you want. All these options are covered in this section.

**Starting over from scratch**

Sometimes the best way to get it right is to start over. To record another take of the entire session, click the Return to Zero button in the Basic Control section of the Transport window to return to the beginning of the session. Then follow the steps in the “Recording a single track” section, earlier in this chapter.

If you record in Destructive mode, any additional takes that you record onto a track will erase the previous one. So, if you want to make sure that you have a take for later, first make sure you’re not using Destructive mode when you record over any existing takes on a track. Or you can create a new playlist for that track before you record your next take. (See the “Recording to Playlists” section, later in this chapter, for more on how to do that.)

**Punching in and out**

If you like some of your initial take and only want to record over part of it, you can set points to start and stop this “recording over” within the session. This is called punching in and out.

Punching into or out of a track involves (first) setting a Start point and End point. You can do that in one of several ways, as detailed in the next few sections.

Before you create your Start and End points for a punch you need to decide where these points are going to be. To make this decision you most likely need to play the track back so you can hear where you want to punch. If you’re not sure how to do this, the “Playing Back Your Tracks” section earlier in this chapter gives you the details on this process.
Using the Start/End fields in the Transport
To set the Start and End points in the Transport window, follow these steps:

1. Select the Expanded view option of the Transport window by choosing Displays ➪ Transport Window Shows ➪ Expanded from the main menu.

2. Click in the Start field in the Basic Controls section of the Transport window and type in the beginning of the punch section you want.
   This field appears in the same format as the main counter. In the case of Figure 4-10, it shows bars and beats.

3. Press Enter.

4. Click in the End field and type in the end of the range.
   This field, too, appears in the format selected for the main counter (as in Figure 4-10).

5. Press Enter.
   You’re now ready to perform a punch. Check out the “Performing the punch” section, later in this chapter, for steps on how to actually perform the punch.

Selecting a section of a track’s playlist
The playlist section of the Edit window contains all the regions for the track. You can make a selection within this playlist by following these steps:

1. Choose Operations ➪ Link Edit and Timeline Selection from the main menu.
   This ensures that when you make your selection in a track’s playlist, the Start and End point markers in the Timebase ruler follow along.

2. Using the Selector tool, click and drag over the section in your track you want to record over, as shown in Figure 4-11.
This highlights the selection and positions the Start point at the beginning of your selection and the End point at the end.

You’re now ready to perform a punch. Go to the “Performing the punch” section later in this chapter for steps on how to actually perform the punch.

Dragging the Start and End Point markers along the ruler bar

The Start and End Point markers are located along the Timebase ruler in the Edit window and appear as Up and Down arrows — down for punch in and up for punch out. The flags are colored blue when no tracks are record-enabled and red when one or more tracks are record-enabled. Setting Start and End Point markers in the Ruler bar consists of these steps:

1. Choose Operations ➤ Link Edit and Timeline Selection from the main menu.

   This makes sure that when you drag the markers along the ruler bar the corresponding section in the track’s playlist are selected as well.

2. If you want the markers to snap to the grid, click on the Grid button in the upper-left of the Edit window to select the Grid Edit mode; otherwise use any other Edit mode.

3. Using the Selector tool, click and drag the Start and End Point arrows to where you want them, as shown in Figure 4-12.

   You’re now ready to perform a punch. The “Performing the punch” section, later in this chapter, lays out steps on how to actually perform the punch.

   If you want to select the entire length of the session, double-click one of the arrows.
Performing the punch

Once you have set the Start and End points for your punch (whether in or out), you can record to that section by doing the following:

1. Set and enable a pre-roll by clicking in the Pre-Roll field in the expanded Transport window (choose Displays ➪ Transport Window Shows ➪ Expanded View to get there) and typing in the amount of pre-roll you want.

   When you’ve done so, you can hear the previously recorded track before the punch-in happens.

2. Set and enable a post-roll by clicking in the Post-Roll field in the expanded Transport window (choose Displays ➪ Transport Window Shows ➪ Expanded View to get there) and typing in the amount you want for your post-roll.

   Doing so lets you hear how your punch fits in with the previously recorded track.

3. Choose either Non-Destructive or Destructive Record mode.

   Non-Destructive Record mode is the default mode and is active if you have a Record button without any icon in it. The Destructive Record mode is selected from the Operations menu (choose Operations ➪ Destructive Record from the main menu). When you have this mode selected a small “D” is visible in the center of the Record button in the Transport window.

4. Click the Record Enable button for the track you want to record onto.

   The button will shine red.

   Only use the Destructive Record mode if you’re really sure you don’t want to keep the previous take in the selected section.

5. Click the Record button.

   The Record light flashes red.
6. **Click the Play button when you’re ready to record.**

   The session will start at the pre-roll time, the Record button will flash red, and you’ll hear the previously recorded track until the pre-roll is over. The monitoring will switch to the input source and the Record light stops flashing — but remains red.

When you hit the end of the recording range, the session either stops playing or — if you have the post-roll enabled — stops recording. At that point, the Record button starts flashing again — and the monitoring switches back to the recorded region until the end of the post-roll period. When the session reaches that point, it stops playing.

**Loop recording**

*Loop recording* lets you choose a section of the song to repeatedly record over. This makes it easy to try a bunch of takes without having to manually start and stop each time through the section. Loop recording can be done a bunch of ways. I described one in Book 4, Chapter 3, but here’s another:

1. **Choose Operations ➪ Link Edit and Timeline Selection from the main menu.**

   This insures that when you make a selection in either the Timebase ruler or within a track’s playlist, both are selected.

2. **Click on the Selector tool at the top of the Edit window to select it.**

3. **Using the Selector tool, click and drag across the section of the track that you want to record over.**

4. **Record-enable the track by clicking the Record Enable button in the Track Controls section of the Edit window.**

5. **Select the Loop record mode by either choosing Operations ➪ Loop Record, pressing Option+L (on a Mac) or Alt+L (on a PC), or by Ctrl+clicking (on a Mac) or right-clicking (on a PC) the Record button in the Basic Controls section of the Transport window until the Loop Record icon shows up.**

6. **Click the Record button in the Basic Controls section of the Transport window to prepare the session to record.**

7. **Click Play in the Basic Controls section of the Transport window to start recording.**

   If you designated a pre-roll, it will only happen before the first time through the loop. After that, the loop goes from Start point to End point, back to Start points, and so on.
Doing Additional Takes

Using QuickPunch
If you have a bunch of sections that you want to replace in a track (say, a bunch of guitar counter points to support the lead vocal) and you want to record the new parts in just one pass of the session, you can use QuickPunch mode.

Setting up for QuickPunch
Setting up for QuickPunch requires these steps:

1. Click the Return to Zero button in Basic Controls section of the Transport window to return to the beginning of the session.
2. Record enable the track(s) you want to fix by clicking the Record Enable button for each track in the Track Controls section of the Edit window.
3. Set the Record mode to QuickPunch by choosing Operations ➪ QuickPunch, Ctrl+clicking (on a Mac) or right-clicking (on a PC) the Record button, or pressing Shift+Command+P (on a Mac) or Shift+Ctrl+P (on a PC).

   The QuickPunch (P) icon appears in the Record button.
4. Click the Play button to start the session.

   The Record button flashes as the session plays and you hear the previously recorded track in the monitors.
5. Click the Record button when you want to punch in.

   The Record button stops flashing and recording starts immediately. Monitoring switches from what’s recorded to what’s coming in; you hear the input source.
6. Click the Record button again to stop recording.

   The button begins flashing again and monitoring switches back to the recorded track.

You can repeat this procedure up to 100 times per session (probably enough to fix that pesky track, huh?).

Overdubbing: Recording additional tracks

Overdubbing is the process of adding tracks to those you’ve already recorded. This is the mainstay of the home recordist’s recording repertoire; it allows you to play all (or as many as you want) of the instruments in your song. You can start with the drum tracks, add some bass guitar, then some rhythm guitar, and later the lead vocals, and so on.
The process of overdubbing is similar to recording your first track except you have to be able to hear the other tracks and synchronize to them as you play. The main things to be concerned about when you overdub are these:

- **Creating a monitoring mix:** Take some time to create a mix of the previously recorded tracks that you can hear as you record so you have a blend that inspires you to perform your best. Depending on your system, you may not be able to add any effects to your mix, but getting the right balance between instruments can really help your recording. (Check out Book 6 for more on mixing.)

- **Getting into the groove:** Make sure that you have the least amount of latency in your system when overdubbing; otherwise it can really mess up the groove. Book 3, Chapter 3 (the previous chapter) covers this in detail — and it’s especially important for instruments with a fast attack and decay such as drums and percussion (they sound awful when they’re slightly out of time).

The M-box, because it’s a USB interface, has a noticeable latency no matter what buffer setting you choose for your hardware. This latency can simply be too much for some critical instruments, so Digidesign has implemented a monitoring setup that lets you monitor the input of the M-Box while hearing *the output of your recorded tracks*, which reduces the latency. To set up your M-box monitoring to record without hearing latency, follow these steps:

1. **Click the Mute button located in the Track Controls section of the Edit window to mute the track you’re overdubbing onto.**
   
   This keeps you from hearing the track as it comes back out of the system.

2. **Click the Mono switch on the M-box.**
   
   This allows both the input and the recorded tracks to play through both speakers. If this switch isn’t depressed, you hear the input in one ear only.

3. **Adjust the Mix knob on the front of the M-Box to blend your input with the tracks playing in the session.**
   
   You need to do this when the session is playing and you’re playing your instrument at the same time so you can hear both the recorded tracks and your input. Try a test run-through to get a balance before you actually record.

After you’ve recorded your overdubbed track, you need to move it to a position that’s 164 samples earlier in the Edit window. These 164 samples are the exact amount of time that it takes for the sound to go through the Mbox and into Pro Tools. Follow these steps:
1. **Click on the Grabber tool (it looks like a small hand) at the top of the Edit window.**

   Using this tool lets you “grab” the region you want to move.

2. **Click and drag to highlight the overdubbed track.**

3. **Choose Edit ➪ Shift from the main menu or press Option+H (on a Mac) or Alt+H (on a PC).**

   The Shift dialog box appears, as shown in Figure 4-13.

4. **Check Earlier in the top box and type 164 into the Samples field at the bottom.**

   This moves your overdubbed material the exact amount of the latency introduced by the Mbox when you recorded.

5. **Click OK.**

---

**Figure 4-13:**
Use the Shift dialog box to adjust for the latency of the M-Box.

---

To make sure each overdubbed track lines up with the first track, you need to shift each overdubbed track over immediately after you record it (or at least before you record another overdub). This ensures that all the previously recorded tracks you’re hearing are lined up with the first track when you record a new one.

---

**Recording to playlists**

Whenever you have material recorded to a track, it exists within the Edit window as a playlist. This playlist contains all the regions (representations of the actual audio on your hard drive) that are currently in a track. One of the nice things about Pro Tools is that you can create a bunch of separate playlists for a track and swap them in and out of the track. Whichever of a track’s playlists is in the Timebase ruler section of the Edit window is the one that is heard when your session is playing back.
Playlists are handy for keeping all of your takes organized and it also lets you record additional takes on a track even when you’re using Destructive Record mode. You can create a new playlist by clicking the little arrows next to the track’s name in the Track Controls section of the Edit window. This opens a pop-up menu for a track, as shown in Figure 4-14.

To record to this playlist, follow the steps in the “Recording a single track” section earlier in this chapter.

Auditioning takes

After you record a bunch of takes of a track, you can audition them to see which one you prefer in one of three ways: from the Audio Regions list, from the Take List drop-down menu, and from the track’s playlist. You can also set preferences for viewing takes of a track and you can audition takes from multiple tracks at once. All these options are covered in this section.

Auditioning from the Audio Regions List

You can take regions from the Audio Regions list located at the right side of the Edit window (if this list isn’t visible click the double arrow at the bottom-right corner of the Edit window) and drag them directly into a track’s playlist (the regions that represent the audio for a track) located to the right of the Track Controls section of the Edit window.

1. **Click the Grabber button in the Edit window to select the Grabber tool.**
2. **Click the current take in the track’s playlist, as shown in Figure 4-15.**

The playlist in a track consists of all the regions that you can see in the session.
3. Press Ctrl (on a PC) or Command (on a Mac) and click another take in the Audio Regions list.

The Audio Regions list is located on the right side of the Edit window. If it’s not visible, click the double arrow at the bottom-right corner of the window to expand the Edit window.

4. Drag the track from the Audio Regions list onto the playlist, as shown in Figure 4-16.

The region is placed in a track and is ready to play.

---

**Auditioning from the Takes List pop-up menu**

You can audition your takes by opening a pop-up menu that has a list of all the takes for a punch or loop recording session. This option lets you freely switch the takes as the session plays. This section outlines the procedures.

1. Click the Selector button in the Edit window to choose the Selector tool.

2. Select a take within a track’s playlist (the regions located to the right of the track name) and Command+click it (on a Mac) or Ctrl+click it (on a PC) to open the Takes List pop-up menu, as shown in Figure 4-17.
You can also click the precise Start point of the punch or loop range in the track’s playlist or along the Timebase ruler without first selecting the track.

3. **Choose the take you want to hear from the Takes List pop-up menu.**

   This take will replace the previous one and be placed at its correct position in the session.

   You can follow the steps for both of these approaches if you want to audition more takes.

Using the Takes List pop-up menu, you can choose and change takes even as the session is playing.

The different takes are listed in the order they were recorded — but if you start moving them around, you can identify them by the time stamp created when you recorded the take.

**Choosing from a track’s playlist**

The track’s playlist contains the regions located in a track. The playlist is located to the right of the Track Controls for each track and represents the audio data for the track. To audition tracks from a track’s playlist, click in the little arrows next to the track’s name in the Track Controls section of the Edit window to open the playlist pop-up menu and then choose the playlist to play, as shown in Figure 4-18. The name of the track changes to the name in the chosen playlist.

**Choosing your take’s preferences**

You can use the “Matching Start Time” Takes List section of the Edit tab of the Preferences dialog box (shown in Figure 4-19) to choose which takes get listed in the Takes List pop-up menu. (To access the Preferences dialog box, choose Setups ➪ Preferences from the main menu.)
The Takes List options include the following:

✦ **Take Region Name(s) That Match Track Names**: Checking this box ensures that only takes from the same track are present.

✦ **Take Region Lengths That Match**: Checking this option only shows takes that are the same length as the one presently in the track.

✦ **“Separate Region” Operates on All Related Tracks**: If you check this box, all takes with the same User Time Stamp are edited when you use the Separate Region command for the track.

**Auditioning takes from multiple tracks at one time**

If you want to audition takes from multiple tracks at once — when recording drums to several tracks at a time, for example — follow these steps:

1. Check both the Take Region Name(s) That Match Track Names and the Take Regions Lengths That Match options in the “Matching Start Time” Takes List section of the Edit tab of the Preferences dialog box (see previous section).

2. Click the Selector button in the Edit window to choose the Selector tool.
3. Using the Selector tool, drag across all the tracks for the range you want to replace, as shown in Figure 4-20.

4. Command-click (on a Mac) or Ctrl-click (on a PC) one of the tracks within that selected region.

   The Takes List pop-up menu appears. Takes that match the preferences set in Step 1 show up in the list.

5. Choose a region (take) from the list.

---

Figure 4-20: To select multiple tracks on which to audition takes, drag across the tracks you want.

---

**Getting Rid of Unwanted Takes**

If you have a take (recorded performance) that you don’t like, you can get rid of it in one of several ways. You can cancel the take as you’re recording, undo the take after you’ve recorded it, or clear the audio region from the Audio Regions list. All of these options are detailed in this section.

**Canceling your performance**

Canceling a performance is handy when you’re in the middle of recording and you know you’re not going to keep the take (for example, the mail arrived and the dog went ballistic in the middle of your vocal). To cancel a performance, simply press Command+period (on a Mac) or Alt+period (on a PC). This stops the session and clears the audio region created for this take with one stroke.
You can’t use this command if you record in Destructive Record mode.

### Undoing your take

If you’ve already stopped recording and you know that you don’t want to keep your latest try, you can undo the take by choosing Edit ➪ Undo Record Audio from the main menu, as shown in Figure 4-21, or by pressing Command+Z (on a Mac) or Ctrl+Z (on a PC).

If you used QuickPunch mode, only the last punch will be undone. If you used Loop Record mode, on the other hand, all the looped passes will be undone. And if you used Destructive Record mode, your previous take will have already been erased when you recorded — so undoing the last take will leave you with nothing on that track.

![Figure 4-21: You can undo a take by choosing Edit ➪ Undo Record Audio from the main menu.](image)

### Clearing the file from the Audio Regions list

If you decide, after hearing a few of your takes, that you want to get rid of one or more of them, you can clear the take(s) from the Audio Regions list. The following steps show how:
1. Click the region you want to get rid of in the Audio Regions list to highlight it.

   To select more than one region to clear, press and hold the Shift key as you click each region.

2. Select Audio Regions ➤ Clear Selected from the main menu (see Figure 4-22) or press Shift+Command+B (on a Mac) or Shift+Ctrl+B (on a PC).

   Your selected takes are deleted.
Book IV

Editing Audio

The 5th Wave

By Rich Tennant

“I ran this Bob Dylan CD through our voice recognition system, and he really is just saying, ‘Mamaama-mamaabadaaabadhaabadha...’”
Contents at a Glance

Chapter 1: Audio Editing Basics
Chapter 2: Selecting Material to Edit
Chapter 3: Getting into Editing
Chapter 4: Adding to Your Editing Palette
Chapter 1: Audio Editing Basics

In This Chapter

- Getting to know hard-disk editing
- Working with audio regions
- Using Edit modes
- Editing playlists

Hard-disk recording — in general, and with Pro Tools specifically — makes the process of editing audio fast and easy. In days of old, if you wanted to remove a bad note or shoddy drum hit, you had to break out a razor blade and some sticky tape, prepare the offending segment of magnetic tape for surgery, hold your breath, and apply a steady hand. Any changes to the recorded tracks got you into a messy, inexact, time-consuming process that many engineers weren’t very good at. Even the steadiest hands couldn’t come close to the accuracy and variety now available (to even the clumsiest of the bunch) through the editing functions of the new digital gear.

This chapter gets you started on the process of editing audio in Pro Tools. First you get to know the basic ways that Pro Tools does editing — in particular, the role of audio regions (representations of your audio files in the Edit window). This chapter then guides you through finding and viewing regions so making edits is quick and easy. You also discover the joys of using playlists to work with these regions. And as if all that wasn’t enough, this chapter also explains the four different edit modes available in Pro Tools.

Understanding Pro Tools Editing

Editing in Pro Tools on your computer is similar to working with any hard-disk recorder — often it’s much easier. Two things about editing in Pro Tools make it fast, easy, and (from the viewpoint of your creative work) safe. First, unless you specify otherwise, it’s nondestructive; you can always undo your edit if you don’t like it. Second, you can perform most editing functions in Pro Tools while your session is playing back. Both these features are detailed in this section.
Nondestructive editing

Nondestructive editing means your original audio files are not changed when you edit an audio region. Most editing functions in Pro Tools — for example, clearing, cutting, pasting, separating, and trimming your audio regions — are nondestructive. (All these operations are explained in Book 4, Chapter 2.)

Not all Pro Tool editing procedures are nondestructive. A few are destructive; they will permanently alter your source audio file. Whenever I describe one of these procedures, I’ll warn you — with a Warning icon — that once you perform the function, your source file will be changed. To make things even safer (and so you don’t have to memorize all the instances in which edits are destructive), Pro Tools warns you automatically — a dialog box appears, asking whether you want to continue.

Editing during playback

Most editing functions can be carried out while the session is playing. This feature makes editing much faster and easier because you can instantly hear (and see) what your changes have done. Some of these edits include

✦ Capturing, separating, and trimming regions
✦ Nudging, placing, rearranging, or spotting regions
✦ Creating fades or crossfades in and between regions (version 6.0 and higher)
✦ Auditioning playlists
✦ Editing automation data
✦ Inserting RealTime plug-ins (version 6.0 and higher)
✦ Processing audio using Audio Suite plug-ins

You can find out more about these functions throughout this chapter and the next three chapters (Book 4, Chapter 2, Book 4, Chapter 3, and Book 4, Chapter 4).

You can’t, however, perform any routing changes (change send assignments) or alter inputs or outputs while playing your session.

Getting to Know Region Types

When you record a track, a new audio region is created in the track’s playlist — the track displays you see next to the Track Controls section in the Edit window. This region corresponds to an audio file of that performance, which resides on your hard drive. When you perform edits to your recorded performances you do so by making changes to these regions.
Both edited and unedited regions appear on the Audio Regions list, the
handy list you find to the right of the track playlist. (If the Audio Regions list
isn’t visible click the double arrow at the far bottom-right of the Edit window
to open it.) Several region types show up in the list, indicating the entire audio
file or a portion of it. You can choose Whole-File, User-Defined, Auto-Created,
Offline, and Stereo audio regions. The following list gives you details on each
region type:

✦ **Whole-File**: Whole-File audio regions represent entire audio files
recorded to your hard drive. Displayed in bold letters in the Audio
Regions list, they’re created when you do one of four things:
   - First record an audio track
   - Import an audio file from outside the session
   - Consolidate existing regions
   - Nondestructively process audio using an Audio Suite plug-in

✦ **User-Defined**: User-defined regions are created when you do one of
three things:
   - Rename an existing region
   - Capture, record, consolidate, or separate audio regions
   - Trim a Whole-File region

✦ **Auto-Created**: These regions are automatically created when you edit a
region or punch-record over one. The more takes you record of your
tracks — and the more edits you do — the more these regions add up.
To keep your Audio Regions list from becoming cluttered, you can hide
your Auto-Created regions easily — or you can convert them into full-
fledged User-Defined regions by renaming them.

✦ **Offline**: These regions can’t be linked to an audio file on your hard
drive, usually because Pro Tools can’t find the original file. In the Audio
Regions list, the names of these regions are displayed in dimmed italics;
in the track’s playlist, they show up in blue italics. You can generally edit
these regions as you would any other region — except you can’t process
them using Audio Suite plug-ins.

✦ **Stereo**: These audio regions are associated with a stereo file. If you click
the triangle to the left of the region name, you can see the two mono
channels (one for each side) listed. These individual channels can be
dragged onto separate tracks if you choose.
Viewing Regions

You can customize the way you view audio regions a number of ways in Pro Tools — select the track view, change the track height, assign name and time locations, zoom in and out. These options get a closer look in this section.

Selecting the track view

By default, audio tracks in the Edit window are set to Waveform. This view shows a visual representation of the sound produced by the audio file associated with a particular region. Pro Tools also gives you the option of ditching the Waveform view and going with something different. You switch between different views with the help of the Regions View menu shown in Figure 1-1, which you access by clicking and holding the Regions View display in the Track Controls section of the Edit window. Your options are as follows:

- **Block**: Block view shows a blank box for each audio region. This view makes screen redraws much quicker (useful during mixing when all the editing is done and you don’t need to see the waveform).

- **Waveform**: Waveform is the default view — a graphical representation of the audio file, much like what you’d see if you ran a sound through an oscilloscope. This is the best view to be in when you’re editing regions because you can easily find the start of a note. After a while, you’ll probably be able to almost hear the track by looking at the waveform.

Besides being able to see waveforms in their normal way — with both positive and negative values — you can choose the Draw Waveforms Rectified option, which displays the waveform as a combined positive value. This can be useful when you want to create volume automation to increase or reduce specific notes (such as, respectively, a weak or very loud drum hit). To get that rectified look, check the Draw Waveforms...
Rectified box on the Display tab of the Preferences dialog box. (You
know the drill: Choose Setups: Preferences from the main menu to get
to the Preferences dialog box.)

✦ **Volume:** This view shows the volume level of the track. The volume level
is displayed as a line superimposed over the waveform. In this view, the
region’s name is hidden.

✦ **Mute:** This view shows whether the track is muted. When a track is
muted, the line shows at the bottom of the view; when the track is
unmuted, the line shows at the top. If a track uses automatic muting, a
vertical line shows where the mute is turned on or off. This view also
shows the waveform in the background.

✦ **Pan:** Pan view shows the apparent position of the track’s output from
left to right (pan) in the stereo sound. When the track is panned in the
center, the line is centered in the view. Far-left panning shows up at the
top; far-right is on the bottom. Settings in between these two extremes
correspond to the pan value. In this view you can also see a waveform
display in the background.

You can toggle between Waveform and Volume views by highlighting the
track and pressing Ctrl-Minus/Dash on a Mac or Start/Windows-Minus/Dash
on a PC.

**Adjusting the track height**

Pro Tools lets you choose from various track heights, including Mini, Small,
Medium, Large, Jumbo, and Extreme. This lets you make tracks you’re not
editing small while the tracks you want to edit can be made big enough so
that you can really get in close to a waveform when you edit. You choose
your various track heights from the Track Height pop-up menu, which you
can access one of two ways:

✦ **From the Track Height Selector button in the Track Controls section of
the Edit window:** Click and hold with the mouse pointer over the button
(it looks like a “>”) to make the Track Height pop-up menu appear, as
shown in Figure 1-2. Choose the size you want.

✦ **From the far-right edge of the Track Controls section:** Choose the track
height you want by clicking-holding with the mouse pointer over the
little ruler at the far side of the Track Controls section (as in Figure 1-3)
and selecting an option from the Track Height pop-up menu that
appears.

For stereo tracks, you can choose an expanded view that allows you to view
each channel separately. If you edit the channels individually and they end
up being different lengths, these stereo tracks will become two mono tracks
instead.
Assigning region-name and time-location displays

Every audio region has a region name and time stamp attached to it. You can choose whether this information shows up on the region displays in your tracks.

Displaying region names

You can choose to show or hide the name of the regions in the track displays by checking or unchecking the Display Name in Regions option under the Display menu, as shown in Figure 1-4.

Choosing region time stamps

You can choose any of several Time Stamp views from the Display Time in Regions option, which is also under the Display menu (see Figure 1-5). Your options include these:
Figure 1-4:  
Checking the Display Name in Regions option under the Display menu shows the name in the tracks region display.

Figure 1-5:  
Choose Time Stamp views from the Display Time in Regions option under the Display menu.

✦ **None:** This option hides the time stamp.
✦ **Current Time:** This choice shows the Start and End times of each region.
✦ **Original Time Stamp:** This option shows the time when the region was created.
✦ **User Time Stamp:** This option displays a time stamp that you can define. By default, it shows the original time, but you can change it in the Time Stamp Selected option under the Audio Regions list pop-up menu — the menu you open by clicking the Audio Regions title bar at the top of the Audio Regions list. Clicking the Time Stamp Selected option opens a dialog box where you can enter the value you want, as shown in Figure 1-6.
Zooming in and out

You can zoom in and out of all tracks using the Zoom buttons at the top of the Edit window (see Figure 1-7) or you can zoom in and out of a single track by using the Zoom tool (see Figure 1-8). You can also zoom in on the ruler and toggle the zoom back and forth between unzoomed and zoomed. Being able to zoom way in to a region lets you make precise edits to the waveform.

Zooming in on all tracks using the Zoom buttons

The Zoom buttons section of the Edit window has buttons that allow you to zoom in and out both horizontally and vertically, as well as buttons for creating zoom presets for levels that you use frequently. The following list gives you the details on each feature:

- **Horizontal Zoom**: The outer two Zoom buttons control how wide a portion of the timeline — and of all audio and MIDI tracks and regions — you can see on-screen. Clicking the left button gives you a narrower view; clicking the right button gives you a wider view.

- **Vertical Zoom**: To zoom vertically in on audio tracks, click the top or bottom part of the button with the waveform icon (at the left of the window). Clicking the top of the button increases the height of the display in the track’s view; clicking the bottom decreases the height. Keep in mind that increasing the vertical zoom may make the waveform too big to fit in the track display. If this is the case, you can increase the
track’s height as described in the “Adjusting the track height” section, earlier in this chapter.

✦ Zoom Presets: At the bottom of the Zoom buttons section are five presets that work like the presets on your car radio. To assign a setting to a Preset button, just get the Zoom setting you want — kind of like tuning your car radio to the station you want — and then Command+Click (on a Mac) or Ctrl+Click (on a PC) the Preset button. Then repeat the steps for the other four Preset buttons.

You can select a preset in any of several ways:

• Click the numbered Preset button you want in the Zoom Buttons section of the Edit window.

• Press the number of the Preset button you want on your keyboard while pressing the Start/Windows key on a PC or the Ctrl key on a Mac.

• With Command Keyboard Focus (Commands Focus) enabled, press the number of the Preset number you want on the number pad of your keyboard. (You enable Command Keyboard Focus by clicking the Command Keyboard Focus button, shown here in the margin.)

Zooming in on a single track using the Zoom tool
The Zoom tool lets you select a specific spot in a track to zoom in and out of. The Zoom tool has two modes: Normal and Single Zoom.

✦ Normal Zoom Mode. You can zoom in and out both horizontally and vertically on the waveform when using this mode.

• Zoom horizontally: First click the Zoom Tool button, shown here in the margin, to select the Zoom tool. Then click and drag a section to select it, as shown in Figure 1-8. Pro Tools zooms to that section. To zoom in farther, click and drag again.
• **Zoom vertically and horizontally:** Press Command on a Mac or Ctrl on a PC and then click and drag the section, as shown in Figure 1-9. Pro Tools zooms in. Repeat to zoom in farther.

![Figure 1-9: Moving in vertically and horizontally.](image)

To zoom out again, press the Option key while you click the zoomed area. Each click moves you out a little bit.

✦ **Single Zoom Mode:** If you’re in Single Zoom mode when you finish zooming in on a spot, Pro Tools switches you back to the tool you were using previously. For example, if you want to scrub a section of a track and need to zoom in to get a more-accurate Start point, you can use the Single Zoom mode of the Zoom tool to zoom in. Once you’re zoomed in, you automatically return to the Scrub tool.

You can select Single Zoom mode one of two ways:

- Click and hold the Zoom Tool button (shown here in the margin) and select the Single Zoom option.

- Click the Zoom Tool button and press F5 on your keyboard to toggle back and forth between Zoom Tool modes.

No matter which method you choose to select Single Zoom mode, once you are in this mode, the Zoom Tool button changes its face to look like what you see here in the margin.

**Zooming in on the ruler**

If you have a spot in your session (the start of the chorus, for example) that you want to zoom into, you can use the ruler bar (where the location of your session is displayed) to select your zoom location. This is done by Command+Ctrl+clicking (on a Mac) or Ctrl+Alt+clicking (on a PC) over a section of the ruler to zoom in one level. You can also drag over a section of the ruler while holding the Command and Ctrl (on a Mac) or Ctrl and Alt (on a PC) keys.
Zooming with the Zoom Toggle command

The Zoom Toggle command takes a selection, increases the track’s height to Large, and fills the window. This command makes zooming quick by using just one keystroke. This is a great function to use when you edit parts and need to get in really close to make an accurate edit, and then move out further in order to find the next spot to edit. To use the Zoom Toggle command, follow these steps:

1. Choose the Selector tool by clicking it at the top of the Edit window.
2. Using the Selector tool, select a portion of one or more tracks.
3. Press Ctrl+E on a Mac or Start/Windows+E on a PC.
   The track height changes to the Large setting (see the “Adjusting the track height” section, earlier in the chapter) and the selection fills the space.
4. Repeat this command to return to the previous view.

If you want to change the default height for the Toggle Zoom to something other than Large, you can do so using the Zoom Toggle Track Height dropdown menu (it’s on the Display tab of the Preferences dialog box, as shown in Figure 1-10). Choose Setups > Preferences from the main menu to call up the Preferences dialog box; there you can select any of the possible Track Height options.

Understanding Edit Modes

Pro Tools offers four basic Edit modes; the mode you use depends on the task you want to perform. You get a chance to dig pretty deep into these Edit modes in the next chapter, but here’s a basic overview of each of them. Figure 1-11 shows all four Edit Mode buttons — Shuffle, Spot, Slip, and Grid — all nicely lined up on the toolbar — and coming right up is a list that gives you a taste of what each mode can do for you.
Shuffle: Shuffle mode allows you to move a region around in an audio track, automatically placing it at the end of the nearest region. This is a handy way to move regions around if you want to experiment with alternate arrangements of a song. For example, you can move the second bar of a four-bar phrase to the last bar by grabbing it and sliding it over to the end. The third bar will move to replace the second and the second bar will snap right to the end of the fourth. Presto — new arrangement.

Spot: In Spot mode, you can designate the exact timeline placement of a region you want to move. Click to engage Spot mode, and then click a region (which brings up the Spot dialog box, as shown in Figure 1-12). Enter the place you want to move the region to in the appropriate field and then click OK.

If you want to move the region back to its original place, you can click the arrow to the right of the Original Time Stamp field in the Spot dialog box.
✦ **Slip:** Slip mode lets you move regions anywhere you want within the playlist. You can have regions overlap or leave space between them, for instance. To move a region using Slip mode, click and hold over the region and drag it to where you want it.

✦ **Grid:** Moving a region using Grid mode snaps the region to the predefined time grid. Grid mode is useful if you want to quickly move a drum part over a beat, for example. Starting with version 6.0, Grid mode gives you two different options: Absolute and Relative. To choose one of these modes, click and hold the Grid button and choose the one you want.

Here’s what they offer you:

- **Absolute Grid Mode:** When using Absolute Grid mode, if you move a region that doesn’t begin where the grid resides — on the & of 1 when the grid is set to 1/4 notes, for example — the region will snap to the resolution of the grid.

  This isn’t a good mode to use if you have a region that starts on the & of 1 (1/8 note before the downbeat) with a 1/4 note grid and you want the region to fit in the measure the same way after moving it.

- **Relative Grid Mode:** In Relative Grid mode, you move regions by the unit of the grid (1/4 notes, for example). So, in the example of a region starting on the & of 1 with a grid resolution of 1/4 notes, the region will move over by the grid value (1/4 notes), leaving the start time of the region on the & of the beat.

  This Grid Mode is useful for moving a drum hit over and having it fit within the grid — even if its start point doesn’t originally match the grid itself.

### Setting the Grid resolution

Setting the resolution of the Grid is an outrageously handy tool for precision-tweaking the rhythms of your track. If you decide to go the Grid Mode route, you can set the resolution of the grid that you work in by following these steps:

1. **Click-hold on the Grid Value window, located under the Edit tools in the main Edit window, as shown in Figure 1-13.**

   The Grid Resolution menu appears, offering you choices for the resolution of your grid — 1/2 notes, 1/4 notes, 1/16 notes, whatever.
2. **Drag to the resolution you want.**

Within this menu you can also choose the time scale you want the grid in and whether you want the grid to follow the main time scale.

---

**Displaying the grid lines**

Again, if you want to work in Grid mode, it might help if you can actually see the grid lines in the Edit window: You can get them to display by using one of two methods:

- Check the Draw Grids in Edit Window check box in the Display tab of the Preferences dialog box, as shown in Figure 1-14. (Call up the Preferences dialog box by choosing Setups ➪ Preferences from the main menu.)
- With the Grid Edit mode enabled, click the Timeline Ruler button to toggle the grid on and off, as shown in Figure 1-15.
Working (Okay, Playing) with Playlists

The Edit playlists within your tracks consist of various arrangements of the regions within a track. Each track can have one or more regions that you can arrange in any order that you want using the Edit modes listed in the previous section. Edit playlists allow you to experiment with different arrangements of regions within a track — and you can still change them at will by switching to another playlist. This is handy if you want to try different arrangements of songs and easily compare them without having to create copies of entire sessions (as you would with some other programs).

Edit playlists are accessed by clicking the Playlist selector in the Track section of the Edit window, as shown in Figure 1-16. The menu called up by the Playlist selector, shown in all its glory in Figure 1-17, lets you choose from the various playlists, as well as letting you create, duplicate, or delete them.
Creating a new playlist

When you record or import audio into a track, you automatically create an empty playlist. With this new playlist you can import audio regions, drag those regions in, or copy and paste them from other tracks. You can create additional playlists by opening the Playlist drop-down menu — done by clicking the Playlist selector next to the track’s name in the Track Controls section of the Edit window — and choosing New. (Refer to Figure 1-17.)

Duplicating a playlist

Being able to duplicate a playlist makes creating different arrangements of a track or making edits to the regions in a playlist easy. Instead of creating a new blank playlist, you’re starting from one you’ve already created. To duplicate a playlist, click and hold with the mouse pointer over the playlist drop-down menu and choose Duplicate. You get the option of naming the new playlist or going with the default.

Deleting a playlist

Playlists take up no space on your hard drive so you don’t need to delete them to free up space, but if you want to delete a playlist from a session, follow these steps:

1. Make sure that the playlist you want to delete isn’t the active one in the track.
2. Open the track’s playlist menu by clicking the Playlist selector — the arrows located next to the track’s name in the Track Controls section of the Edit window.
3. Select Delete Unused.
   A menu opens, listing all playlists in the track (except the currently assigned playlist).
4. Select the playlist you want to delete from the list.
   If you want to delete more than one, press and hold the Shift key as you select the playlists.
5. Click OK.
   The selected playlist is deleted.
   You can’t undo this operation.

**Renaming playlists**
To rename the current playlist in a track, double-click the name of the track where the playlist resides, and then type in a new name.

**Choosing playlists**
You can choose the playlist that appears in a track by clicking the Playlist selector (the arrows located next to the track’s name in the Track Controls section of the Edit window) and dragging to the playlist you want. The name of the playlist then shows up as the track’s name.

**Using the Audio Regions List**
All the audio regions in your session are displayed in the Audio Regions list, located on the right side of your Edit or Mix window, as shown in Figure 1-18. From this list you can

✦ Drag a region into a track.
✦ Drag to rearrange regions in the list.
✦ Audition any region by Alt+clicking (on a PC) or Option+clicking (on a Mac) a region in the list.

Once you start recording, importing, and editing regions in your session, you can start accumulating regions in this list very quickly. Fortunately, Pro Tools helps you keep track of them by displaying region types differently. The “distinguishing marks” are as follows:
Selecting regions

You can select single or multiple regions from the Audio Regions list several ways.

- To select a single region, you have one option: Click a single region. It becomes highlighted. Then click to put a check in the box next to Region List Selection Follows Track Selection in the Edit tab of the Preferences dialog box (that’s the dialog box you get by choosing Setups > Preferences from the main menu). Voilà — the track containing this region becomes highlighted to show it’s selected.

- To select a range of contiguous regions, you have two choices:
  - With the cursor on the left of the Audio Regions list (a marquee will appear) click-drag across the regions you want to select.
  - Shift+click to the left of the first and last region names for a group of regions. All the regions in between these two will be selected.

- To select multiple regions that aren’t next to one another, you have two methods to choose from:
  - With the cursor located to the left of the region (a marquee will appear), Command+click each region. (Got it, Mac fans?)
  - For all you PC people, Shift+click over the name of each region.

Using the Audio Regions list pop-up menu

Audio regions can also be managed from the pop-up menu located at the top of the Audio Regions list, as shown in Figure 1-19. (The Audio Regions list is located at the right side of the Edit window. If it isn’t visible, click the double arrow at the bottom-right corner of the Edit window to open it.) Open this menu by clicking and holding the Audio Regions title at the top of the Audio regions list. Many of the functions in this menu are covered in this section.
After you start editing in earnest, the regions in the Audio Regions list start adding up. The only way to be able to keep track of them is by being able to sort them. Pro Tools offers you several ways to sort, including by name, by time stamp (when it was recorded), by length, and a host of others. To sort regions from the Audio Regions pop-up menu, choose Sorting from the menu and choose one of the many options pictured in Figure 1-20.

Finding regions
You can find regions in the list by selecting Find from the Audio Regions pop-up menu. When you do this, a dialog box appears, as shown in Figure 1-21, where you can enter part of a word or a whole word for the region you want to find.
Managing Undos

Displaying region information
Besides displaying just the region’s name — the default for the Audio Regions list — you can have Pro Tools display some additional information about the region in the playlist section of the track:

✦ **The complete path of the region’s location.** Choose the Show Full Path option under the Audio Regions list pop-up menu. Open this menu by click-holding the Audio Regions title at the top of the Audio Regions list located on the right side of the Edit window. (If this list isn’t visible, click the double arrow at the bottom-right corner of the Edit window.)

✦ **The name of the file where the audio region is located.** Choose Show File Name under the Audio Regions list pop-up menu.

✦ **The name of the hard disk where the file is located.** To see this information, choose Show Disk Names under the Audio Regions list pop-up menu.

Managing Undos
Here’s the realm where digital editing saves you vast quantities of time, hassle, and frustration: Pro Tools lets you undo operations that you perform in your sessions. This gives you vast flexibility and offers at least some safety net when you start messing around with your songs.

Setting levels of Undo
Prior to version 6.1, Pro Tools offered up to 16 levels of Undo. 6.1 and up offers up to 32 levels of Undo. You don’t have to use them all, though. In fact, if you have minimal memory in your computer, performing operations such as edits in Pro Tools will quickly fill it up and really slow things down, or if
your memory is really low, it prevents you from performing an edit at all. This is because all your previous edits are stored in RAM, right up to the number you specified under your preferences.

Luckily, Pro Tools offers you the ability to choose the maximum levels of Undo that your session will have. You can set these levels on your session by doing the following:

1. Choose Setups ➪ Preferences from the main menu.
   The Preferences dialog box duly appears.
2. Click the Edit tab.
   The Preferences dialog box shows its Edit face.
3. Type in the number of Undos you want in your session in the Levels of Undo field at the bottom of the window, as shown in Figure 1-22.
4. Click Done.

Performing Undos
Performing Undos in Pro Tools is just like any other program: Choose Edit ➪ Undo from the main menu. The Undo option also includes the name of the operation that you’re undoing, as shown in Figure 1-23. This is helpful when you want to perform multiple Undos, because you have to move back progressively through each operation that you performed. Keeping track of 32 operations can be tricky.

You can redo an Undo — only the last one — by choosing Edit ➪ Redo from the main menu.
Knowing when you can no longer Undo

Some operations result in clearing your Undo lineup. Whenever you perform the following operations, your previous operations can no longer be undone:

✦ Importing track or session data.
✦ Selecting Select Unused Regions or Select Unused Regions Except Whole Files from the Audio Regions list pop-up menu.
✦ Deleting a track or clearing a region from the Audio Regions list pop-up menu.

Pro Tools won’t warn you before you perform these operations. But hey, sometimes we human beings actually do know what we’re doing.
Chapter 2: Selecting Material to Edit

In This Chapter

- Selecting parts of regions
- Changing and extending selections
- Playing selections

Before you can do any editing of audio regions, you have to make a selection. Pro Tools offers many ways to select material. You can select from a single track, grouped tracks, or the entire track list. You can select from a track’s playlist or from the Timeline ruler. And you can make adjustments to the length and position of the selected material. All these options are covered in this chapter.

Selecting Track Material

When you select material to edit, the selection becomes highlighted and, if you have the Edit and Timeline Selection Linked option chosen, you’ll see little arrows in the Timeline ruler designating the Start and End points of the selection. (Figure 2-1 shows a selection, whereas you can see the handy Edit and Timeline Selection Linked button right here in the margin.) The arrows will be blue if there are no tracks enabled for recording and red if there are.

Tip

If you haven’t chosen the Edit and Timeline Selection Linked option, Edit markers instead of arrows will mark your selection, as shown in Figure 2-2.
Selecting part of a region

You can select material one of three ways:

✦ Drag within a track’s playlist, as shown in Figure 2-3. Do this by clicking and dragging your Start and End points within the track’s playlist.
Selecting Material to Edit

✦ Drag along the Timeline ruler, as shown in Figure 2-4. Do this by clicking and dragging your Start and End points along the Timeline ruler or by moving the Start and End point arrows to where you want them. Doing this selects all the unhidden tracks in the session.

![Figure 2-4: You can make selections in all tracks by dragging along the Timeline ruler.](image)

✦ Enter values in the Start and End fields of your Expanded section in the Transport window, as shown in Figure 2-5. Do this by highlighting a track and typing in your start point in the Start field and pressing Return (Mac) or Enter (PC). Type in your end point in the End field and press Return (Mac) or Enter (PC) or type in the length of the selection in the Length field and press Return (Mac) or Enter (PC).

![Figure 2-5: Enter Start and End values to select a section of a region.](image)

When you make a selection within a track that is part of a group, all tracks in the group — except those that are specifically hidden — are selected.
To create a selection that extends farther than the width of your computer screen, click the Start point, scroll to the End point, and then Shift+click the point. You can toggle back and forth from the Start and End points by pressing the left or right arrow keys respectively.

**Selecting across multiple tracks**

You can select more than one track to edit in Pro Tools in several ways:

- Drag across the tracks you want using the Selector tool (click the Selector Tool button at the top of the Edit window to, well, select it). This only works if the tracks you want to include are adjacent to one another.
- Group the tracks you want to select and click-drag on one of the tracks within that group. Any hidden tracks in the group will not be selected. (For more on groups and grouping, see Book 3, Chapter 4.)
- Drag along the Timeline ruler to select all the tracks.
- To select all the tracks along with any conductor tracks (those dealing with Meter and Tempo changes), press Alt (on a PC) or Option (on a Mac) while dragging along the Timeline ruler.

**Selecting an entire region**

You can select an entire region one of two ways:

- Click in that region with the Grabber tool. Click the Grabber Tool button located at the top of the Edit window to enable it.
- Double-click the region with the Selector tool. Click the Selector Tool button located at the top of the Edit window to enable it.

**Selecting two regions and any space between them**

To select two or more regions and include any space that separates them, follow these steps:

1. Select the Grabber tool by clicking the Grabber Tool button at the top of the Edit window.
2. Click in the first region with the Grabber tool.
3. Shift+click the next region. To add more regions, Shift+click each one you want until you have them all chosen.

All regions selected become highlighted, along with any spaces that exist between them.
**Selecting an entire track**

You can select all the regions in a track one of two ways:

✦ Triple-click one of the regions in the track.

✦ Click in the track with the Selector tool and choose Edit → Select All from the main menu or press Command+A on a Mac or Ctrl+A on a PC.

You call up the Selector tool by clicking the Selector button located at the top of the Edit window.

**Selecting all regions in all tracks**

You can select all regions located in the tracks of your session (except the hidden ones) in any of four ways:

✦ Select All in the Edit Groups list pop-up menu. This menu is accessed by click-holding the Edit Groups title in the Edit Group List section of the Edit window. If the Edit Group List isn’t visible, click the double arrow at the bottom-left corner of the Edit window.

✦ Triple-click any region within a track in the playlist section of the Edit window.

✦ Press Return and Command+A (on a Mac) or Ctrl+A (on a PC) on your keyboard.

✦ Double-click anywhere along the Timeline ruler (the session’s timeline).

If you want to include the conductor events in your selection (tempo or meter changes) of all regions in the tracks, make sure that you have the Edit and Timeline Selection Linked option chosen and press Ctrl (on a PC) or Option (on a Mac) while you double-click the Timeline ruler.

**Selecting on the fly**

You can make selections while your session is playing by using the arrow keys. Follow these steps:

1. **Engage the Link Edit and Timeline Selection Linked button or choose Operations → Link Edit and Timeline Selection Linked from the main menu. Alternately, you can engage the Edit and Timeline link button at the upper right of the Edit window.**

2. **Click the track somewhere before the place you want to start your selection.**

This is where the session will start playing back. If you want a select a point near the beginning of the session, you can skip this step and just start playing from the beginning.
3. Either click Play in the Transport window or press the spacebar on your keyboard to start the session playing.

4. Press the Down arrow key on your keyboard when your playback reaches the point where you want the selection to begin.

5. Press the Up arrow when your playback reaches the point where you want the selection to end.

6. Click Stop in the Transport window or press the spacebar on your keyboard to stop the session.

To scroll back to the selection Start point, press the Left arrow key; to scroll to the selection End point, press the Right arrow key.

If you have either the Scroll After Playback or Page Scroll During Playback options checked under Scroll Options in the Operations menu, these options toggle off when you select on the fly. To reactivate one of them after you’ve made your selection, you need to scroll down the Operations menu and check that option again (version 6.0 and later).

**Selecting using the Selection Indicator fields**

You can use the Selection Indicator fields to enter either the Start and End points or the length of a selection. This section describes how to do this.

**Making a selection using the indicators**

1. Using the Selector tool, click in the track you want to select.  
   
   **Remember:** You choose the Selector tool by clicking the Selector Tool button at the top of the Edit window.

2. Click in the Start field and type in the start point that you want and then press Return (on a Mac) or Enter (on PC).

3. Click in the End field and type in the location of the end of the selection and then press Return (on a Mac) or Enter (on a PC).

You can also enter the length of the selection after entering the Start point. The End point will automatically be entered in the End field.

**Changing a selection using the indicators**

To change the values in any of the indicator fields without typing in a value:

- Press the slash (/) key on your keyboard to move from one selection indicator to the next.
✦ Press the period (.) key or the left and right arrow keys to move from one time field in an indicator to the next.
✦ Press the up arrow key to increase the value in the field or the down arrow key to decrease it.

**Making a selection using the Tab to Transients function**

Transients are the initial attack in an instrument and in Pro Tools you can move from one transient in a region to another by engaging the Tab to Transients button and pressing the Tab key. To use this function to choose Start and End points for a selection:

1. **Enable the Tab to Transients button.**
   The button here in the margin shows you what to look for.
2. **Make sure that you have the Edit and Timeline Selection Linked option enabled by checking the Link Edit and Timeline Selection Linked checkbox in the Operation menu or by engaging the Edit and Timeline link button.**
3. **Using the Selector tool, click in the audio track somewhere before the Start point of the area you want to select.**
4. **Press the Tab key on your keyboard repeatedly to move from transient to transient until you get to the Start point. If you go too far, you can back up by pressing the Ctrl (on a PC) or Option (on a Mac) key when you hit Tab.**
5. **Press the Shift key as you tab through the transients to the End point. Again if you go too far, you can back up the End point by pressing Shift+Ctrl+Tab (on a PC) or Shift+Option+Tab (on a Mac).**

**Making Changes to Your Selection**

Try as you might, after you’ve made a selection on one of your tracks, you may find that your selection just doesn’t cut it. You may end up with too much or too little material at the beginning or end of the selection. You may decide that you want to move the entire selection over in time to encompass different material. You may decide that you want to include other tracks in the selection. You also may want to change the track onto which you’ve made your selection. Luckily, you don’t have to start over selecting material to do this. You can make these adjustments to a selection quickly and easily in Pro Tools. This section describes these ways to change what you’ve selected.
Changing a selection’s length

If, after you’ve made a selection, you want to change its Start or End point (say, skip the first two bars of your selection), you can do so by doing one of the following:

✦ Using the Selector tool, Shift+click at the point you want outside the current selection.
✦ Again using your Selector tool, Shift+drag either the Start or End point to where you want it.
✦ Drag the Playback marker (or Edit marker if the Edit and Timeline selections are unlinked) for the Start or End point in the Timeline ruler (the section in the Edit window with the time markers located above the track playlists).
✦ Type in the new Start or End point value in the Start or End field of the Expanded section of the Transport window and press Enter (on a PC) or Return (on a Mac).

Nudging selections

Sometimes you want to move a selection very slightly forward or back in the Timeline to make sure you cover the exact material you want to edit. Pro Tools lets you use the Nudge function to move either your entire selection or just its Start or End point so you can fine-tune your selections.

Nudging the entire selection

You can move a selection by the increments set up in your Nudge Value menu, so that you can move across the material without actually moving that material itself. (The latter move is done after you finish making a selection and is covered in Book 4, Chapter 3). Follow these steps:

1. Make your selection, using one of the procedures listed earlier in this section.
2. Click-hold on the Nudge Value drop-down menu, located next to Nudge below the Counter section of the Edit window.
   The Nudge Value menu pops up.
3. Select the desired value for your nudge in the pop-up menu, as shown in Figure 2-6.
   For more on using the Nudge feature, go to the next chapter (Book 4, Chapter 3).
4. Press the Shift key along with either the + key or – key.
   Doing so “nudges” your selection to the right or left by the designated nudge value.
Making Changes to Your Selection

If you have the Commands Keyboard focus function enabled by depressing the Command Focus button you can skip pressing the Shift key as you use the + or - keys.

Nudging the Start point

Follow these steps to move the Start point of a selection by the nudge value:

1. Make your selection, using one of the procedures listed earlier in this section.

2. Click-hold on the Nudge Value drop-down menu, located next to Nudge below the Counter section of the Edit window.

   The Nudge Value menu pops up. (Refer to Figure 2-6.)

3. Select the desired value for your nudge in the drop-down menu.

   For more on using the Nudge feature, check out Book 4, Chapter 3.

4. Press Alt+Shift (on a PC) or Option+Shift (on a Mac) and press the + or – key on your keyboard to “nudge” the Start point to the right or left by the designated nudge value.

Nudging the End point

To nudge the End point of a selection, follow these steps:

1. Make your selection, using one of the procedures listed earlier in this section.

2. Click-hold on the Nudge Value drop-down menu, located next to Nudge below the Counter section of the Edit window.

   The Nudge Value menu pops up. (Refer to Figure 2-6.)
3. Select the desired value for your nudge in the drop-down menu.
   For more on using the Nudge feature, go to Book 4, Chapter 3.

4. Press Ctrl+Shift (PC) or Command+Shift (Mac) and press the + or − key on your keyboard to move the End point the designated nudge value to the right or left.

**Extending selection lengths**

Sometimes the best way to get all the material in your selection is to redefine its boundaries. Pro Tools offers you three ways to extend your selection: to the Start or End point of the selected region, to include an adjacent region, or to markers (memory locations). These options are covered in this section.

**Extending to the Start or End point of a selected region**

Follow these steps to extend your selection to the Start or End point of the region:

1. Select a portion of the region using the Selector tool, or simply click anywhere in that region.
   
   **Remember:** Choose the Selector tool by clicking the Selector button at the top of the Edit window.

2. Press Shift+Tab to extend the selection to the end of the region or Shift+Ctrl+Tab (on a PC) or Shift+Command+Tab (on a Mac) to extend your selection to the start of the region.

**Extending a selection to an adjacent region**

Use the following steps to extend a selection to include an adjacent region:

1. Using the Grabber tool, click the first region to select it.

2. Press Shift+Ctrl+Tab (on a Mac) or Shift+Start/Windows+Tab (on a PC) to include the following region or press Shift+Ctrl+Option+Tab (on a Mac) or Shift+Start/Windows+Ctrl+Tab (on a PC) to include the previous region.

**Extending a selection to a memory location (marker)**

Memory locations (markers) are flags you can place within the session to make navigating your session faster. I usually make a habit of putting a marker at the beginning of each verse and chorus to help me find them quickly. To extend a selection to a marker or memory location, follow these steps:
1. Click the Start or End point in a track or make a selection in one of the ways listed earlier in this chapter.

2. Shift-click a marker in the Markers ruler (located above the track playlist section of the Edit window) or a memory location in the Memory Locations window.

The Memory Locations window is opened by clicking on any of the markers in your session or by clicking on the Marker icon at the left of the Markers ruler.

**Moving and extending selections between tracks**

You can take a selection on a track and extend it to include other tracks — or you can even move the selection to another track. For example, this is handy if you selected the snare drum and then decided you want to include the rest of the drum tracks in your edit. Another example would be if you selected one rhythm guitar track but decided you want to edit another rhythm guitar track instead. This section covers these options.

**Moving a selection to another track**

If, after you’ve made a selection, you decide that you’d rather edit a different track instead — while still using the same Start and End points as the selection you’ve already made — you can move the selection from one track to another. This process is done by following these steps:

1. Click the Commands Focus button, seen here in the margin, to enable the Commands Focus function.

2. Make a selection, using one of the procedures listed earlier in this chapter.

3. Press P to move the selection to the previous (above) track or press ; (semicolon) to move the selection to the following (below) track.

**Extending a selection to an adjacent track**

If you’d like to include adjacent tracks in your selection — as in the case of adding drums track to a selection you made on the snare drum track — you can do this by following these steps:

1. Click the Commands Focus button to enable the Commands Focus function.

2. Make a selection in a track in one of the ways listed earlier in this chapter.
3. Press Shift+P to include the previous (above) track or Press Shift+; (semicolon) to include the following (below) track.

Figure 2-7 shows what happens when you extend a selection to include an adjacent track.

If you’ve gotten overzealous in extending your selection to adjacent tracks you can remove the bottom track from this group by pressing Ctrl+Option+; (semicolon) on a Mac or Start/Windows+Alt+; (semicolon) on a PC.

Managing Memory Locations

Memory locations let you quickly move from one position in a session to another with the click of a button. You can have up to 200 memory markers in each session.

Dealing with the dialog box

Whenever you create a memory location a dialog box opens, as shown in Figure 2-8, where you choose the parameters of the marker. This box contains two sections: Time Properties and General Properties.

Setting time properties

The Time Properties section of the New Memory Location dialog box lets you choose from three options — Marker, Selection, and None — and whether you want the reference in bar/beat (the location in your session related to measures) or absolute time (the location in your session related to the clock in minutes and seconds from the start of the session).
The following list fills you in on what each of the three options here means:

✦ **Marker**: This option marks a specific location and is designated by a yellow icon in the Markers ruler — the ruler located at the top of the playlist section of the Edit window. If you set the reference for the location marker to Bar/Beat, the icon is a chevron (Figure 2-9, left) and if you set the reference to Absolute, it appears as a triangle (Figure 2-9, right).

✦ **Selection**: Using this option marks a selected range within a track or multiple tracks.

✦ **None**: This type of memory location is called a General Properties memory location and it actually doesn’t contain any time-based information; rather, it memorizes just the selections from the General Properties section of the menu. (See the next section for more on General Properties.) This is good option if you just want to remember a zoom or pre- and post-roll setting for part of the session.
Choosing general properties

In the General Properties section of the Memory Location dialog box (refer to Figure 2-8) you can set preferences for the information that you store with the memory location. These include

✦ **Name:** You can enter a name in this field to help you remember what the memory location is for.

✦ **Zoom Settings:** This lets you store the horizontal and vertical zoom settings for the tracks.

✦ **Pre- and Post-roll Times:** This option stores the pre- and post-roll times and is handy when using the Selection memory location for setting record ranges.

✦ **Track/Show Hide:** This setting allows you to store track layouts in your session (as far as them being shown or hidden, anyway).

✦ **Track Heights:** This option lets you store the height of tracks in your session.

✦ **Group Enables:** This setting stores both Edit and Mix groups for easy recall of them when mixing or editing.

Creating memory locations

You create memory locations differently depending on the type — Marker, Selection, None — that you want. This section details those ways.

Memory markers

Creating a Marker memory location requires these steps:

1. **Get all your Settings ducks in a row for your session, so that the session is set up the way you want it to be.**

   Settings here can include zoom settings, track heights, or any of the setting options listed in the previous section, “Dealing with the dialog box.”

2. **Link your Edit and Timeline selections by clicking the Link Edit and Timeline Selection button, pressing Shift+/, or choosing Operations ➪ Link Edit and Timeline Selection from the main menu.**

   The Edit and Timeline Link button is shown here in the margin.

3. **Open the Markers Ruler — if it’s not already displayed — by choosing Display ➪ Ruler View Shows ➪ Markers from the main menu.**

   The Markers ruler appears just above the playlist section of the Edit window.
4. Press Ctrl (on a Mac) or Start/Windows (on PC) and position your cursor where you want the memory location in the Markers ruler. When the cursor changes to a Grabber tool with a +, go ahead and click with your mouse.

or

Choose the Selector tool by clicking the Selector button at the top of the Edit window.

5. Click within any track where you want the memory location to go.

6. Click the Marker button located at the far left of the Memory Location ruler next to the Marker title.

The New Memory Location Dialog box opens. (Refer to Figure 2-8.)

7. Choose the Marker option and then use the drop-down menu to choose whether you want the marker reference in bars/beats or absolute time depending on whether you prefer to work referencing measures or the time from the start of the session.

8. Enter a name for the marker and check the boxes in the General Properties section that you want to include in the marker.

9. Click OK.

A Marker icon appears at the location you specified in Step 4.

**Selection memory locations**

If you have a section of the session that you think you want to go back to later on — such as with a drum edit — you can store that selection by creating a Selection memory location. To create a Selection memory location, follow these steps:

1. Configure your session with the settings you want to save.

2. Select a section of a track or tracks that you want to memorize.

   For more on how to select stuff, see the “Selecting Track Material” section, earlier in the chapter.

3. Press Enter in the number pad section of your keyboard.

   The New Memory Location dialog box opens.

4. Choose the Selection option and then use the drop-down menu to choose whether you want to use the bars/beats or absolute time reference option.

5. Enter a name for the location and check any of the options in the General Properties section of the window.
6. Click OK.

The memory location appears in the Memory Locations window (opened by choosing Windows $$\rightarrow$$ Show Memory Locations from the main menu). This window shows all the memory locations for your session.

To recall this memory location, simply click on it in the Memory Locations window.

**General Properties memory location**

If you just want to store a zoom or pre-roll setting (or any other of the General Properties parameters) for your session you can do so by creating a General Properties memory location. To create this type of memory location, follow these steps:

1. **Configure your session to the settings that you want to save.**
2. **Press Enter on the number pad section of your keyboard.**
   The New Memory Location dialog box opens.
3. **Select None.**
4. **Enter a name and check the parameters you want to save from the list in the General Properties section.**
5. **Click OK.**

The location is stored and appears in the Memory Locations window. This window shows all the memory locations for your session and is opened by choosing Windows $$\rightarrow$$ Show Memory Locations from the main menu.

To recall this memory location, simply click on it in the Memory Locations window.

**Creating Marker memory locations on the fly**

You can create memory locations while the session plays. You can create any type of memory location — Marker, Selection, or General Properties (none) — on the fly, but the most common are Marker memory locations. This “on-the-fly” business can be handy for marking the sections of your song or locations where you want to go back to make edits. Follow these steps to create Marker memory locations on the fly:

1. **Enable the Auto-Name Memory Locations When Playing option under the Edit tab in the Preferences dialog box.**
Managing Memory Locations

**Note:** To get to the Preferences dialog box, choose Setups ➪ Preferences from the main menu.

2. **Choose Windows ➪ Show Memory Locations from the main menu, as shown in Figure 2-10.**

   The Memory Locations window appears. (See Figure 2-11.)

   **Note:** You can also call up this window by pressing Command+5 (on a Mac) or Ctrl+5 (on a PC).

3. **In the Memory Locations window, click the Name button and then choose the Default to Marker and the Auto-Name Memory Location options from the pop-up menu that appears.**

   If you don’t choose this option, the new memory locations created on the fly are of the same type as the last one made.

4. **Set your session’s time scale to bars:beats if you want the memory locations to reference bars/beats.**

   Use the arrow to the right of the Main Counter display located at the top of the Edit window to make this selection.

5. **Play your session by clicking Play in the Transport window or by pressing the spacebar on your keyboard.**

6. **Press Enter on the number pad of your keyboard when you want to place a marker.**
Getting to know the Memory Locations window

Once you create a memory location, it appears in the Memory Locations window, shown in Figure 2-11. (You access this window by choosing Windows $\Rightarrow$ Show Memory Locations from the main menu.) You can recall, view, and edit your stored memory locations by using the window’s pop-up menu, shown in Figure 2-12. (You call up the window’s pop-up menu by clicking the Name button in the Memory Locations window.)

Your choices on the pop-up menu for the Memory Locations window are as follows:

- **Show Markers Only**: Selecting this option limits the view in the window to just the Marker memory locations in your session.

- **Show View Filter Icons**: By selecting this option, a series of icons appears in the window, which let you hide or show memory locations by their properties. The icons in this selection are (from left to right in Figure 2-13):
  - Marker
  - Selection Memory Location
  - Zoom Settings
Managing Memory Locations

- Pre-Post-Roll
- Show/Hide Track
- Track Heights
- Group Enables

Descriptions of these properties can be found in the “Dealing with the dialog box” section, earlier in this chapter.

✦ Show Main/Sub Counter: Selecting this option opens two columns in the window that list the main and sub time scales for Selection memory locations as well as the locations for Marker memory locations, as shown in Figure 2-14. General Properties memory locations have nothing listed in these columns.

✦ Sort by Time: By selecting this option, you sort your Marker memory locations by their Timeline positions in the session, followed by the Selection and General Properties locations in the order they were created. When this option isn’t selected, memory locations are listed according to their assigned numbers (the order they were created).

✦ Add Memory Location: Choose this option if you want to add a new location.

✦ Remove Memory Location: Choosing this option deletes the selected memory location from the list.

✦ Delete All: This option removes all the memory locations in the session.

✦ Default To Marker: Choosing this option makes any memory locations that you create on the fly (see previous section) Marker memory locations.

✦ Auto-Name Memory Location: Choosing this option automatically names memory locations created on the fly and keeps the New Memory Location dialog box from opening when you create on the fly. These names are consecutively numbered but you can change the name later on if you want. To change the name later, simply click on the marker in the Markers ruler in the Edit window and, when the New Memory Location dialog box opens, enter a new name in the Name field.
Recalling memory locations

You can recall memory locations from the Memory Locations window. (Choose Windows ➪ Show Memory Locations from the main menu to call the window up, or press Command+5 on a Mac or Ctrl+5 on a PC.) Marker memory locations can also be recalled by clicking the Marker icon in the Markers ruler located directly above the track playlist section of the Edit window.

Recalling from the Memory Locations window

Follow these steps to recall a memory location from the Memory Locations window:

1. Open the Memory Locations window by choosing Windows ➪ Show Memory Locations from the main menu or by pressing Command+5 (on a Mac) or Ctrl+5 (on a PC).

   Refer to Figure 2-11 for a peek at what this window looks like when open.

2. If your Link Edit and Timeline Selections option is not enabled and you want to recall a Selection memory location, click the Edit and Timeline Link button to enable the option.

3. Click the memory location you want in the Memory Locations window to recall it.

   or:

   Press the memory location number followed by a period (.) if you have the Numeric Keypad mode set to Classic mode. If your numeric keypad is set to Transport mode, press period (.) followed by the memory location number followed by another period (.)

To select your Numeric Keypad Mode options, first choose Setups ➪ Preferences from the main menu. After the Preferences dialog box appears, click to select the Operations tab and then check the appropriate mode boxes.
Recalling markers from the Markers ruler

You can recall a Marker memory location in the Markers ruler by following these steps:

1. **Display the Markers ruler in the session by choosing Display ➪ Ruler ➪ Marker from the main menu.**
   
   This ruler appears directly above the track playlist section of the Edit window.

2. **Click the marker.**
   
   The General Properties settings stored in the marker are instantly recalled.

Editing memory locations

You can perform quite a few editing functions on your various memory locations including renaming them, deleting them, editing their properties, copying them, and pasting them. These functions are detailed in this section.

Renaming a memory location

To rename a memory location, follow these steps:

1. **Double-click the memory location in the Memory Locations window or Markers ruler.**
   
   The New Memory Location dialog box makes an appearance. (Refer to Figure 2-8.)

2. **Enter the new name in the Name field.**

3. **Click OK.**

Changing a memory location’s properties

You can change the properties of a stored memory location a number of different ways, depending on the change you want to make. This section details changing general properties, location types, and selection ranges.

First off, you can redefine General Properties settings by using these steps:

1. **Set up your new General Properties settings (zoom, track height, and so on).**

2. **Open the Memory Location window by pressing Command+5 (Mac) or Ctrl+5 (PC) or by choosing Windows ➪ Show Memory Location from the main menu.**
3. Right-click (on a PC) or Ctrl+click (on a Mac) the memory location in the Memory Location window. You can also right-click (PC) or Ctrl+click (Mac) on the Marker icon in the Markers ruler if you want to redefine a Marker memory location.

The New Memory Location dialog box opens.

4. Enter the General Properties you want to include in this marker and enter a new name if you want to change it.

Remember: This only stores the settings you have in your session; it doesn’t create them. You need to make sure that your screen is the way you want it before saving the settings.

5. Click OK.

You can change your memory location type — Marker, Selection, None — by doing the following:

1. Open the Memory Location window by pressing Command+5 (Mac) or Ctrl+5 (PC) or by choosing Windows ➪ Show Memory Location from the main menu.

2. Double-click the name of the memory location (in the Memory Location window) or the Marker memory location (in the Markers ruler).

The New Memory Location dialog box opens.

3. Select Marker, Selection, or None and enter a new name if you want to.

4. Click OK.

You can change the selection range of a Selection location by following these steps:

1. Open the Memory Locations Window by choosing Windows ➪ Show Memory Locations from the main menu or by pressing Command+5 (on a Mac) or Ctrl+5 (on a PC).

2. Select a range of material within your session.

   For more on how to select stuff, see the “Selecting Track Material” section, earlier in the chapter.

3. Right-click (on a PC) or Ctrl+click (on Mac) on the name of the Selection memory location you want to change in the Memory Locations window.

   The New Memory Location dialog box opens.

4. If you want to, enter a new name for the Selection memory location in the Name field of the Memory Location dialog box.

5. Click OK.

   Your new selection is saved with the Selection memory location.
Managing Memory Locations

You can move a Marker memory location one of these ways:

✦ Drag a marker by grabbing the icon in the Markers ruler and dragging it to its new location.

The Markers ruler is located just above the track playlist section of the Edit window. If it’s not visible, select Display ➤ Ruler View Shows ➤ Markers from the main menu.

✦ Align a marker by clicking with the Selector tool on the new location along the Timebase ruler or within a track’s playlist and then right-clicking (on a PC) or Ctrl+clicking (on a Mac) the name of the marker location in the Memory Locations window.

✦ Align the marker to the start of a region by selecting the region with the Grabber tool, and then right-clicking (on a PC) or Ctrl+clicking (on a Mac) the name of the marker location in the Memory Locations window.

Copying and pasting memory locations

You can copy single or multiple markers in a session by following these steps:

1. Choose the Selector tool by clicking the Selector Tool button at the top of the Edit window.

2. Drag along the Markers ruler to select the portion of the session that contains the markers you want to copy. To select all the markers in the session, double-click anywhere in the Markers ruler.

If the beginning of your selection includes a marker, press Ctrl (on a PC) or Command (on a Mac) for the Selector tool to appear because it will automatically disappear when your cursor is located directly over an existing marker.

3. Choose Edit ➤ Copy from the main menu or press Command+C (on a Mac) or Ctrl+C (on a PC) to copy the selection into the clipboard.

If you want to paste the selection somewhere else in the session, follow these steps:

1. Place your cursor along the Markers ruler where you want to paste the markers.

2. Press Command+V (on a Mac) or Ctrl+V (on PC) or choose Edit ➤ Paste from the main menu.
Playing Selected Material

After you make a selection, you’re free to give it a listen. This section covers a variety of ways of doing this.

Playing your selection

To play your selection, simply click the Play button in the Transport window or press the Spacebar on your keyboard. All the tracks in the session will play during the selected range. If you only want to hear the track(s) in which you made your selection, you’ve got one of two choices:

✦ Hide or mute the tracks you don’t want to hear.
✦ Solo the track(s) you do want to hear.

Using pre- and post-rolls

You can set Pro Tools to play a designated length of time before and after your selection by using pre- and post-rolls. This section shows you how to set your pre-rolls and post-rolls, as well as how to audition them.

Setting and enabling pre- and post-rolls

To set pre- and post-rolls

1. Choose Display ➪ Transport Window Shows ➪ Expanded from the main menu.
   The Pre- and Post-Roll fields appear in the window.

2. Click in the Pre- or Post-Roll field in the Transport window, type in a number, and then press Return (on a Mac) or Enter (on a PC).

3. Press Command+K (on a Mac) or Ctrl+K (on a PC) or choose Operations ➪ Pre/Post-roll Playback from the main menu to enable the Pre- and Post-Roll feature.

Auditioning pre- and post-rolls

If you just want to hear the pre- or post-roll, you can audition them by doing the following:

✦ To audition the pre-roll: Press Alt+left arrow (on a PC) or Option+left arrow (on a Mac). The pre-roll plays to the start of the selection or to the position of the cursor in the selected region.

✦ To audition the post-roll: Press Ctrl+right arrow (on a PC) or Command+right arrow (on a Mac). The post-roll plays from its beginning or from the current cursor location.
Auditioning Start and End points

When you audition Start and End points, you get to listen to just the beginning or end of a selection without having to listen to the whole thing. This kind of auditioning is done in the following ways:

Auditioning the Start point

You can audition the Start point of a selection either with or without listening to the pre-roll along with it. Both options are covered in this section.

- To audition just the Start point of a selection: Press Ctrl+left arrow (on a PC) or Command+left arrow (on a Mac). The selection plays for the length of time designated in the Post-Roll field of the Transport window.

- To audition the Start point of a selection along with the pre-roll: Press Ctrl+Alt+left arrow (on a PC) or Command+Option+left arrow (on a Mac). The pre-roll plays along with the length of the selection, as designated in the Post-Roll field of the Transport window as long as you have the Pre/Post-roll Playback function enabled. (Choose Operations ➤ Pre/Post-roll Playback from the main menu.)

Auditioning the End point

Pro Tools lets you audition the end point of your selection, either with or without hearing the post-roll too. Here’s how to use these options:

- To audition just the end point of a selection: Press Alt+right arrow (on a PC) or Option+right arrow (on a Mac). The selection will start at the point equal to the pre-roll amount from the end of the selection.

- To audition the End point of a selection along with the post-roll: Press Ctrl+Alt+right arrow (on a PC) or Command+Option+right arrow (on a Mac). The Selection will start at the point equal to the pre-roll amount from the end of the selection and continue until the end of the post-roll.

Looping your selection’s playback

If you have a section of the song that you want to listen to repeatedly (say, if you’re trying to find a chair squeak to edit), you can loop a selection by engaging the Loop command. This enables you to create looped sections and to make sure that your Start and End points play seamlessly. Follow these steps to loop a selection:

1. Engage the Link Edit and Timeline Selection option by either choosing Operations ➤ Link Edit and Timeline Selection from the main menu or by clicking the Edit and Timeline Link button.
2. Make a selection using one of the techniques listed in the “Selecting Track Material” section, earlier in this chapter.

3. Choose Operations ➪ Loop Playback from the main menu, or Ctrl+click (on a Mac) or Right-click (on a PC) the Play button in the Transport window.

4. Click Play in the Transport window or press the Spacebar on your keyboard.

   If you have the pre-roll engaged, playback will begin with it; otherwise it starts at the beginning of your selection. When the selection loops the pre-and post-rolls won't play after the starting pre-roll (if you have the function engaged).

5. Click Stop in the Transport window or the Spacebar on your keyboard to stop playback.
In This Chapter

- Working with regions
- Using Edit commands
- Editing regions
- Working with looped material

Pro Tools offers you many options for editing the audio files in your sessions, include cutting file segments, copying them, pasting them, clearing them, basting them, and marinating them. (Okay, maybe not the last two, but you get the point.). You can also edit by trimming segments, moving them, aligning them, locking them, and so on.

In this chapter, you discover the many Edit commands of Pro Tools and you begin to edit regions — our term for audio file segments — using the various Edit functions that Pro Tools is famous for. I also fill you in on creating loops you can use to build your song (if that’s the way you want to work).

Editing Regions

Regions are the defined areas of the track in which you do your editing. Each audio file is represented in your session by a region (or series of regions). A region can be the entire file or it can be bits and pieces of a file. When you edit in Pro Tools, you’re not actually making any changes to the audio file. (There are some exceptions to this that I explain later in this chapter.). Instead, you make changes to the way Pro Tools plays those files by editing the regions that represent the file.

For example, if you decide that a track really does sound better without that accordion solo and you cut that section of the region containing that part, the section isn’t really erased from your hard drive — it’s simply not played back when you listen to your session. This allows you to make a stunning variety of edits without having to worry about ruining your original audio file.

Being able to create, capture, separate, trim, and heal regions is essential to being able to edit in Pro Tools. These procedures are explained in this section.
Creating regions
Whenever you record or import an audio file in Pro Tools, you create a region of that entire file. You can edit that region, but once you cut it, separate it, paste it, or do any other edit to it, you’ll be creating new regions from the original file. There are several ways to create new regions with which to work, including capturing selections, separating selections, and trimming to a selection. These are all covered in this section.

When you create a new region, it appears in the track’s playlist — the area next to the Track Controls section of the Edit window that contains the visual representations of the audio files (regions) — as well as in the Audio Regions list, located on the right side of the Edit and Mix windows.

Using the Capture Region command
The Capture Region command lets you create a new region within an existing one. The new region is still part of the original region, but it has its own name. If you want to create a region that can be moved around separately from the original, use the Separate Regions command detailed in the next section. To use the Capture Region command, follow these steps:

1. Choose the Selector tool from the top of the Edit window.
2. Click and drag the track’s region in the playlist section of the Edit window where you want to create a new region.
3. Choose Edit → Capture Region from the main menu or press Command+R (on a Mac) or Ctrl+R (on a PC).

   The Name Region dialog box appears.
4. Enter the name of this region in the Name Region dialog box and click OK.

   The new region is created and the region’s name appears in the Audio Regions list menu in the Track’s playlist.

Employing the Separate Regions command
If you want to create a region that can be moved around separately from the original, use the Separate Regions command. Here’s how it’s done:

1. Choose the Selector tool from the top of the Edit window.
2. Click-drag on the track’s region in the track’s playlist where you want to create a new region.

   If you want to select more than one track, drag across the desired tracks.
3. **Choose Edit ➪ Separate Region from the main menu or press Command+E (on a Mac) or Ctrl+E (on a PC).**

The Name Region dialog box appears.

4. **Enter the name of this region in the Name Region dialog box and click OK.**

The new region is created; its name appears in the Audio Regions list menu. You can now move, copy, cut, or otherwise edit this region.

If you don’t want to have to type in a name for this new region, you can use the Pro Tools Auto-Name feature, which automatically gives your new regions such exciting names as Audio 2_02. To activate this feature, choose Setups ➪ Preferences from the main menu, click the Edit tab in the Preferences dialog box when it appears, and then check the Auto-Name Separated Regions check box on the tab.

If you have a bunch of takes that you’ve recorded in succession (when you loop-record, for example) and you want to separate all of them at the same place, check the Separate Region Operates on All Related Takes option on the Edit tab of the Preferences dialog box. (Choose Setups ➪ Preferences from the main menu to get to the Preference dialog box.) If you choose to do this, make sure that both the Take Region Names That Match Track Names and Take Regions Lengths That Match options are also checked in the Edit tab of Preferences dialog box.

### Using the Separation Grabber tool

If you want to separate and move a region in one step, you can use the Separation Grabber tool, located in the Edit Tools section of the Edit window. This tool toggles between the Grabber tool by click-holding the button and choosing the Separation option from the pop-up menu that appears, as shown in Figure 3-1.

To use the Separation Grabber tool, follow these steps:
1. Using the Selector tool, drag over the part of the region you want to separate in the playlist section of the Edit window.

This selection can be across multiple tracks or regions within a single track.

2. Click-hold on the Grabber tool and choose the Separation option from the pop-up menu that appears.

3. Click the selection you made in Step 1 and drag the selection to where you want it.

Pro Tools automatically creates three new regions: the separated section and the parts before and after this section. These three sections all show up in the Audio Regions list menu.

If you want to leave the original region as it is and grab a section from it to put somewhere else, press Option (on a Mac) or Alt (on a PC) when you drag the selection with the Separation Grabber tool. The original region remains intact and your selection is simply copied and moved.

**Trying the Trim to Selection command**

The Trim to Selection command allows you to choose a section of a region and remove the unselected parts of that region. Follow these steps to trim unwanted parts from a selection:

1. Choose the area you want to keep by selecting it in the track’s playlist with the Selector tool.

2. Press Command+T (on a Mac) or Ctrl+T (on PC) or choose Edit ➤ Trim ➤ To Selection from the main menu, as shown in Figure 3-2.

The unselected parts of the region disappear.

**Healing regions**

You can use the Heal Separations command to combine regions that you separated into one region again. There are some restrictions to this process, though:

✦ You can’t heal regions that come from different audio files.
✦ Your regions must be in the same places they were when you separated them.
To heal two regions, follow these steps:

1. **Using the Selector tool**, select a portion of both regions along with the spot to be healed, as shown in Figure 3-3.

2. **Choose Edit ➪ Heal Separation from the main menu** or press Command+H (on a Mac) or Ctrl+H (on a PC).

   Your two regions become one again.

---

**Figure 3-3:**
Selecting the area you want to heal.
If the selection doesn’t heal (because one region has been moved, for instance) you can do one of the following:

✦ Choose Slip Edit mode (select this from the Edit mode options at the top-left portion of the Edit window) and delete one of the two regions. Next, using the Trimmer tool, expand the existing region to its original size. (See the “Trimming regions” section, later in this chapter, for more on the Trimmer tool.) This procedure expands the region to include hidden material. In this, case the hidden material is the stuff from the deleted region.

✦ Delete both regions and drag the original region into the track from the Audio Regions list (Book IV, Chapter 1 has more on this procedure).

**Placing regions in tracks**

All the regions for your session are located in the Audio Regions list; you can use this list to drag a region (or regions) into any track.

**Placing a region in a track**

Follow these steps to place a region in a track:

1. **Select the region you want to place in a track by highlighting it in the Audio Regions list.**

   The Audio Regions list is located on the right side of the Edit and Mix windows.

2. **Click the region’s name and drag it into the track where you want it.**

Depending on the Edit mode that you have selected — you select an Edit mode from the options located at the upper-left corner of the Edit window — your region is placed in one of several possible ways:

✦ **In Shuffle mode:** Placing a region while in Shuffle mode slides existing regions over to make room for the one you’re placing. This places regions end to end (they automatically touch on another).

✦ **In Spot mode:** Placing a region while in Spot mode opens a dialog box where you can enter the position of the region you’re placing. This mode allows you to place a region at a precise point.

✦ **In Slip mode:** Placing a region while in Slip mode lets you drag the region anywhere you want within the track’s playlist, allowing you to overlap another region or be separated from it.

✦ **In Grid mode:** Placing a region in Grid mode places the region to the nearest grid boundary. Pro Tools lets you temporarily disable the grid by pressing Ctrl (on a PC) or Command (on a Mac) while you drag your selected region into a track.
You can adjust the grid value for your session by opening the Grid Value drop-down menu, shown in Figure 3-4. (This menu is opened by click-holding on the arrow to the right of the Grid title in the center of the Edit menu, right below the Edit tools.)

Figure 3-4: The Grid Value pop-up menu lets you choose the grid value of your session.

Placing a region at the Edit Insert point
You can designate an Edit Insert point by clicking your cursor within a track in the playlist section of the Edit window; you can then place your region right at this point. You can either have the region’s Start or End point snap to the Edit Insert point.

To designate an Edit Insert point, start by locating your cursor at the place in the track where you want the region placed, as shown in Figure 3-5. Then, depending on where you want your region to end up, do one of the following:

✦ **To place the start of a region at the Edit Insert point:** Press Start/Windows (on a PC) or Ctrl (on a Mac) key while you drag the region from the Audio Regions list to the track.

If the region is already in the track and you want to move it, Start/Windows+click (on a PC) or Ctrl+click (on a Mac) while dragging with the Grabber tool.

✦ **To place the end of a region at the Edit Insert point:** Press Ctrl+Start/Windows (on a PC) or Command+Ctrl (on a Mac) while you drag the region from the Audio Regions list to the track.

If the region already resides in the track, Ctrl+Start/Windows+click (on a PC) or Command+Ctrl+click (on a Mac) while dragging with the Grabber tool.
Using region Synch points

A Synch point is a specific location in your session where you can have regions align to. This lets you place a specific point in the region (called the synch point) precisely where you want without regard to the placements of Start or End points of that region. You can assign a region Synch point in Pro Tools anywhere within the session. This feature is helpful when you want to place a sound at a precise point in the session, as when you’re spotting (positioning) sound effects for video. Using a Synch point, you first mark the location sound effect that you want to place (breaking glass for instance) in the region with this sound and then place that region where you want the glass to start breaking in your session. This makes it easy to spot that sound even when the sound doesn’t begin at the Start point of a region.

Creating a Synch point

To define a region’s Synch point, follow these steps:

1. Using the Selector tool, click within a track where you want your Synch point to be.

2. Choose Edit ▶ Identify Synch Point from the main menu, as shown in Figure 3-6, or press Command+, (comma) (on a Mac) or Ctrl+, (comma) (on a PC).

   A small arrow appears at the bottom of the region, as shown in Figure 3-7, to show you where you’ve placed the Synch point.

   You can remove the Synch point by choosing Edit ▶ Remove Synch Point from the main menu.

   Since each region can only have one Synch point at a time, if you want to change the location of this Synch point, simply select a new place in the region and choose Edit ▶ Identify Synch Point again from the main menu. The old Synch point is removed and a new one appears at the new location.
Placing a region’s Synch point at an Edit Insert point

Once you have a Synch point defined, you can use it to place or align a region within your track’s playlist. To place the Synch point of the region to the Edit Insert point in the track’s playlist, do the following:

1. Using the Selector tool, click a point in the target region to define your Edit Insert point.

2. Press Shift+Ctrl (on a Mac) or Shift+Start/Windows (PC) while dragging the region you want to insert — the one containing the Synch point you added, following the procedure outlined in the previous Steps list — from the Audio Regions list into the track.
The region’s Synch point snaps to the selected position in the track’s playlist.

or

If the region with the Synch point already resides within the track, switch to the Grabber tool, and then press Shift+Ctrl (on a Mac) or Shift+Start/Windows (on a PC) while clicking on the region.

The region’s Synch point snaps to the selected position in the track’s playlist.

**Aligning regions**

Pro Tools lets you align the Start, End, or Synch point of regions to the Start point of another region. This can be helpful for arranging regions in songs to get synchronized playback.

**Aligning a Start point of a region to the Start point of a region on another track**

To do this, follow these steps:

1. Using the Grabber tool, click the region in the playlist of the track you want to align to.

2. If the region you want to move already exists in the playlist of the track from Step 1, press Start/Windows (on PC) or Ctrl (on a Mac) and then click on the region you want to move. The region automatically moves into position.

   or

   If the region you want to move resides in the Audio Regions list, press Start/Windows (on a PC) or Ctrl (on a Mac) and then click and drag the region onto the track’s playlist.

   Both Start points are aligned.

**Aligning the End point of a region to the Start point of a region on a different track**

To do this, follow these steps:

1. Using the Grabber tool, click the region you want to align to in the track’s playlist.

2. If the region you want to move is located in the playlist of the track from Step 1, press Ctrl+Start/Windows (on a PC) or Command+Ctrl (on a Mac) and then click the region.
The region automatically moves into position.

or

If this region isn’t already in the track’s playlist, press Ctrl+Start/Windows (on a PC) or Command+Ctrl (on a Mac) and click and drag the region you want to move from the Audio Regions list onto the playlist.

The End point of the region you moved is aligned to the Start point of the first region you chose.

Aligning a region’s Synch point to the Start point of another track’s region

You can align your Synch point on one track to the Start point of a region on another track by following these steps:

1. Using the Grabber tool, click the region you want to align to in the track’s playlist.

2. If the region you want to move is located in the playlist of the track from Step 1, press Shift+Ctrl (on a Mac) or Shift+Start/Windows (on a PC) while clicking with the Grabber on the region.

   The region automatically moves into position.

   or

   If the region doesn’t already exist within the track’s playlist, you can place and align a region from the Audio Regions list by pressing Shift+Ctrl (on a Mac) or Shift+Start/Windows (on a PC) while clicking and dragging the region from the Audio Regions list.

   The Synch point of the second region aligns to the Start point of the first, as shown in Figure 3-8.
Trimming regions
You can trim regions using the Trimmer tool, by choosing Edit ➪ Trim from the main menu, or by nudging the Start or End point of a region. The Trimmer tool, shown here in the margin, consists of two options: the Standard Trimmer and the Time Trimmer. All of these trimming options are detailed in this section.

Using the Standard Trimmer tool
The Standard Trimmer tool lets you shorten or lengthen (to the maximum length of the parent audio file, anyway) a region without altering the original file. Whenever you trim a region, a new region is created in the Audio Regions list.

To trim a region using the Standard Trimmer tool, first call up the tool by clicking the Trimmer Tool button and then do one of the following:

✦ Place the cursor near the Start or End point of a region and drag the region’s Start or End point to shorten or lengthen, as shown in Figure 3-9.
or
✦ Place your cursor where you want to trim the region and click with your mouse, as shown in Figure 3-10. The region is trimmed to the Start point or the End point, depending on where you’ve placed the cursor. If the cursor is located closer to the Start point, you trim the Start point; if the cursor is closer to the End point, you trim the End point. You can reverse the default here by pressing Option (on a Mac) or Alt (on a PC) as you trim.

You can tell which way the trim is going to happen by the direction of the cursor. Figure 3-11 shows the cursor as it is set to trim the Start point (left) and the End point (right).

Figure 3-9:
To trim or expand a region, drag with the Trimmer tool.
The Trimmer tools (both the Standard Trimmer and the Time Trimmer) behave differently depending on the Edit mode you’re using. Here’s a quick rundown of the differences:

✦ **Shuffle mode:** In this mode, any adjacent regions slide over as you expand or trim the region.

✦ **Spot mode:** In this mode, the Spot dialog box appears, prompting you to type in the exact placement of the region’s Start or End point.

✦ **Grid mode:** In this mode, any trimming or expanding that you do automatically snaps to the nearest grid boundary.

✦ **Slip mode:** In this mode, your region moves to wherever you place it. Any other regions in the playlist remain where they are.

If you want to return the region to its original size, you can either

✦ Drag the original region from the Audio Regions list to the track’s playlist.

✦ Drag the Start or End point of the region with the Trimmer tool to its original length.
Tackling the Time Trimmer tool

The Time Trimmer tool, shown here in the margin, expands or compresses a region using the Time Compression/Expansion (TC/E) plug-in, in the process of creating a new audio file. Using the Time Trimmer is different from using the Standard Trimmer: Instead of cutting off part of the file when you trim, the Time Trimmer tool shortens how long the region takes to play.

When you use the Time Trimmer tool to expand or compress a region, it alters the speed at which the region plays — which alters the way the material in the region sounds. Compressing speeds up the region; expanding slows it down.

To use the Time Trimmer tool, call it up by click-holding over the Trimmer tool button and dragging down to select the Time Trimmer option and then do one of the following:

✦ Place the cursor near the Start or End point of a region and drag the region’s Start or End point to shorten or lengthen the region. (Refer to Figure 3-9.)

or

✦ Place your cursor where you want to expand or contract the region and click with your mouse. (Refer to Figure 3-10.) The Start or End point of the region moves out or in depending on which way the Time Trimmer Tool cursor is facing. (See Figure 3-12.)

The Edit mode you use determines how the Time Trimmer tool behaves and how the regions surrounding the trim react. Check out the previous section for a rundown of the different ways the Edit modes work with the trim tools.

To return the region to its original length, follow these steps:

✦ Drag the original region from the Audio Regions list to the track’s playlist.

✦ Select Edit ➤ Undo from the main menu if this was the last operation you performed.

Taking advantage of the Trim command

You can trim regions using the Trim command located in the Edit menu. (Refer to Figure 3-2.) The menu gives you three options:

✦ **Trim to Selection:** This command removes all of the region except the part you’ve selected, as shown in Figure 3-12. To do this trim, select the part of the region that you want to keep and then choose this command.
✦ **Trim Start to Insertion:** This command trims the region from the Start point to the Edit Insert point designated by your cursor, as shown in Figure 3-13. To perform this trim, start by placing your cursor where you want to trim to and then choose this command.

✦ **Trim End to Insertion:** This command removes that part of the region from the Edit Insert point to the End point of the region, as shown in Figure 3-14. Doing this trim is as simple as placing your cursor at the desired place in the region and choosing the command from the Edit menu.

**Using the Nudge function to trim a region**

You can trim or expand the Start or End points of a region using the plus (+) and minus (-) keys on the number pad section of your keyboard. (To see how to set the Nudge value, go to the next section, “Moving regions.”)
To trim the Start point using the Nudge function:

1. **Select a region, using the Grabber tool.**

2. **Press Alt (on a PC) or Option (on a Mac) along with the plus (+) key to trim or the minus (-) key to expand the Start point.**

   Each time you press the key, you move the boundary of the region by the Nudge value.

To trim the End point using the Nudge function:

1. **Select a region, using the Grabber tool.**

2. **Press Ctrl (on PC) or Command (on Mac) along with the plus (+) key to expand or the minus (-) key to trim the End point.**

   Each time you press the key, you move the boundary of the region by the Nudge value.

**Moving regions**

You can move (that is, slide) regions in a session either within a track or across tracks. You can nudge them, shift them, and — depending on the Edit mode you’re using — you can move them to precisely where you want them. This section details the many ways you can move regions.

Before you do any moving, however, keep two things in mind:

- You can make a copy of a region you want to slide by pressing Option (on a Mac) or Alt (on a PC) as you slide it. This keeps the original in its place.

- When you move a region from one track to another, you can keep its Start point from changing by pressing Ctrl (on a Mac) or Start/Windows (on a PC) as you slide it. This is good because it lets you move regions from track to track without losing (ahem) track of its position in the session.

**Nudging**

If you only want to move a region over a little bit, you can simply nudge it. With the Nudge function, you can set the Nudge value to be as fine or coarse as you like.

To set the Nudge value, click-hold over the arrow to the right of the Nudge title located just beneath the Counters in the Edit window to open the Nudge Value pop-up menu and then select the scale and value you want, as shown in
Figure 3-15. You can choose Bars:Beats, Min:Sec, or Samples for your Nudge scale. The values you choose depend on this scale. You can also choose to follow the main time scale for the session by checking that option at the bottom of the dialog box.

To actually nudge a region or multiple regions, do the following:

1. Select the region or regions that you want to move using the Grabber tool. (Select the Grabber by clicking on its icon in the upper part of the Edit window.)
   
   To select more than one region, press the Shift key as you grab each region.

2. Press the plus (+) key or minus (-) key in the numerical section of your keyboard to move it right or left respectively.
   
   Each press of the key moves the region over by the Nudge value.

If you want to move the region over faster and still use the Nudge function, you can have Pro Tools move the region by the next higher Nudge value than the one you have chosen. For example, if you have the Nudge value set for 1/4 notes, you can nudge by 1/2 notes. Here’s the drill:

1. Select the region(s) you want to nudge with the Grabber (select the Grabber by clicking on its icon in the upper part of the Edit window).

2. Press Start/Windows (on a PC) or Ctrl (on a Mac) as well as the slash key (/) to move the material forward (right) or the M key to nudge it back (left).

   You can skip the Start/Windows or Ctrl keys if you have the Commands Focus (a-z) button enabled.
You can nudge the contents within a region without moving its Start or End points. This lets you keep the region you have and its Start and End points while changing which material from the region’s parent audio file is contained within the region’s boundaries.

1. Select the region you want to nudge with the Grabber tool.

2. Press Start/Windows (on a PC) or Ctrl (on a Mac) and the plus (+) key to move the region’s content to the right and minus (-) key to move the contents to the left.

The region stays put and the audio from the original file moves within it, as shown in Figure 3-16.

![Figure 3-16: Nudging a region moves the audio file within the region.](image)

This process only works if there is audio information located outside the current region’s boundaries.

**Shifting regions**

Pro Tools has a Shift command that lets you move regions by a specified amount. This is real handy when compensating for latency, such as with the Mbox or with some plug-ins.

To shift regions using the Shift command, follow these steps:

1. Select a region, using either the Grabber or the Selector tool.

   You can select regions from more than one track. (Check out Book 4, Chapter 2 for details on how to do this.)

2. Choose Edit → Shift from the main menu.

   The Shift dialog box appears, as shown in Figure 3-17.

3. Enter the Shift value in the Shift dialog box and whether you want to shift the region earlier or later.

   This value can be in whatever time format you want: bars and beats, minutes and seconds, or samples.
4. **Press OK.**

   The region shifts by the amount you specified in Step 3.

   The Edit mode you’re in has no effect on the way the Shift command works. Your region moves over by the specified amount regardless of whether any other regions are present on that spot.

---

**Moving with Edit modes**

When you move or slide regions around in sessions, each Edit mode treats the regions differently. This section lays out the ways these modes work. (You select your Edit mode by clicking on the corresponding mode name in the upper-left side of the Edit window.)

- **Shuffle mode:** You can shuffle regions by selecting the Shuffle Edit mode. This mode lets you shuffle the regions in a track around, but they always snap to one another — Start point to End point.

- **Slip mode:** In Slip Edit mode you can move regions around at will. You can have space between them and have them overlap.

   If you place a region in a track using Slip mode and then switch to Shuffle mode, that region stays where it is as you shuffle other regions in the track. These other regions may end up overlapping the slipped region or you may end up with empty space between them.

- **Spot mode:** In Spot mode, whenever you select a region or part of a region, the Spot dialog box opens, prompting you to enter your destination location.

- **Grid mode:** In Grid mode, your regions snap to the nearest grid boundary as you move them around. Grid mode offers you two options: Absolute and Relative.

   Whenever you move a region in Absolute mode, the Start point moves to the nearest grid boundary. When you move a region in Relative mode, it moves by grid increments (the square units of the grid). This allows you to move a region around while keeping its Start point at the same position relative to a grid boundary.
For example, if you have a region that starts on the last sixteenth note of a beat and your grid value is set for quarter notes, here’s what the move looks like: Each time you move the region by one grid increment, the region moves by the value of one quarter note — but it stays at the last sixteenth note of the beat. This is handy for moving drum rhythms around.

You can change the grid resolution by opening the Grid pop-up menu — refer to Figure 3-4 — and choosing the grid scale and value. You open this menu by click-holding over the arrow to the right of the Grid title situated under the Edit tools at the upper end of the Edit window.

You can show the grid in the Edit menu by pressing the Timebase ruler icon located at the top of the Timebase ruler section of the Edit window. This grid is labeled with whatever time format you have chosen for your Main counter. You can also choose the Draw Grid in Edit Window option in the Display tab of the Preferences dialog box to show the grid. (Choose Setups ➪ Preferences from the main menu to call up the Preferences dialog box.)

**Locking regions**

You can lock regions in place after you’ve put them where you want them. This keeps you from accidentally moving or deleting them as you work with other regions in the session. To lock a region, do the following:

1. **Select one or more regions with the Grabber tool.**
   
   To select multiple regions on different tracks, press and hold the Shift key as you click each region.

2. **Choose Edit ➪ Lock/Unlock Region from the main menu.**
   
   A small closed-lock icon appears at the lower-left corner of the region, as shown in Figure 3-18.

To unlock a region, select the region and choose Edit ➪ Lock/Unlock from the main menu.
In effect, any region after the locked region is also locked when you’re in Shuffle mode since they won’t move. Also, in this mode, you can’t place a region in front of the locked one if it’s longer than the space available for it.

Quantizing regions

Quantizing regions in Pro Tools involves snapping a region’s Start or Synch point (if you have one defined) to the nearest grid boundary. It’s a way to align regions — handy for working with drum and percussion parts because you can arrange them and then quantize them to make them fit the groove of the song. To quantize a region, follow these steps:

1. **Set the grid value that you want in the Grid Value pop-up menu.**
   You open this menu by click-holding the arrow to the right of the Grid title located just beneath the Edit tool sections at the top of the Edit window.

2. **Select the region you want to quantize using the Grabber tool.**
   Selecting part of a region quantizes the entire region because this command moves the Start point (and the rest of the region with it).

3. **Choose Edit ➪ Quantize Region from the main menu, as shown in Figure 3-19, or press Command+Zero (on a Mac) or Ctrl+Zero (on a PC).**
   The region’s Start or Synch point moves to the nearest grid boundary.

---

**Figure 3-19:**
The Quantize Region command moves the Start or Synch point of a region to the nearest grid boundary.
**Muting/Unmuting regions**

You can mute regions or parts of regions. This gives you more flexibility than muting an entire track. To mute a region, do the following:

1. **Select a region or portion of one.**
   
   To select the entire region use the Grabber tool and click anywhere on that region within the track’s playlist. To select a portion of a region, use the Selector tool and drag across the region in the track's playlist.

2. **Press Command+M (on a Mac) or Ctrl+M (on a PC) or choose Edit➪Mute/Unmute Region from the main menu.**
   
   When muted, the region appears dimmed in the playlist, as shown in Figure 3-20.

   **Figure 3-20:**
   Muted regions are dimmed in the playlist.

To unmute a region, follow these steps:

1. **Select the muted region or portion of the region using the Grabber tool.**
   
   You select the Grabber tool by clicking the Grabber tool button at the top of the Edit window.

2. **Choose Edit➪Mute/Unmute from the main menu or press Command+M (on a Mac) or Ctrl+M (on a PC).**
   
   What was muted is now unmuted.

**Splitting stereo tracks**

When you work with stereo tracks, you usually work with both sides of the stereo file at once. If you want to edit one or another of the stereo channels independently, the first step toward doing so is splitting the stereo track into two mono tracks.
You split a stereo track into two mono tracks by following these steps:

1. **Click the track in the Edit or Mix window with the Grabber tool to select the track you want to split, as shown in the upper part of Figure 3-21.**

   If you want to split more than one track, Shift+click the rest of the tracks.

2. **Choose File→Split Selected Tracks into Mono from the main menu.**

   The tracks are split and renamed automatically, as shown at the bottom in Figure 3-21.

---

**Examining Edit Commands**

If you've worked with any word-processing program, you're probably familiar with Edit commands such as cut, copy, clear, duplicate, and paste. Pro Tools, being the super-editor of audio it is, offers a couple more: repeat and merge-paste. All of these Edit commands are detailed in this section.

The view that you choose for a track affects the kinds of edits you can make using the commands in this section. If you have the Waveform view open, for example, any edit you do affects all the parameters for that track — including automation data. Conversely, if you have one of the Automation Parameters views open, that parameter is the only one affected by the edit.

Each Edit mode treats the material in the track differently when you use the Edit commands in this section. For instance, when you use Shuffle mode, regions slide over to make room for a pasted region (or to close the gap left from a cut region). Likewise, in Slip mode, existing regions stay put, no matter whether a space is left after cutting or if regions overlap from pasting.
Using the Cut command
As in most programs that employ a Cut command, any selection that you cut is removed from the track and placed in the Clipboard where you can paste it somewhere else if you choose. Here’s how to cut a region or selection:

1. Click-hold on the Track View selector (located in the Track Controls section of the Edit window) and drag down the list to choose the track view you want.
   This determines what data is cut from the track. (See the Remember icon at the beginning of this section.)

2. Select the region or part of the region you want to cut.
   To select the entire region use the Grabber tool and click anywhere on that region within the track’s playlist. To select a portion of a region, use the Selector tool and drag across the region in the track’s playlist.

3. Press Command+X (on a Mac) or Ctrl+X (on a PC) or choose Edit ▸ Cut from the main menu.
   The selection is placed in the Clipboard.

If you selected only part of a region to cut, Pro Tools creates new regions, basing them on the new region arrangement for the track. For example, if you choose a part of a region within the entire region, you end up with three new regions listed in the Audio Regions list: the portion to the left of the selection, the cut selection that no longer resides in the track’s playlist and now sits in the clipboard instead, and the material to the right of the cut selection.

Employing Copy
The Copy command in Pro Tools functions just as it does in any computer software Copy function: The selected material is copied to the Clipboard. To copy a selection, follow these steps:

1. Click-hold on the Track View selector (located in the Track Controls section of the Edit window) and drag down the list to choose the track view you want to edit.
   This determines the data that is cut from the track. (See the Remember icon at the beginning of this section.)

2. Select the region or part of the region you want to copy.
   To select the entire region, use the Grabber tool and click anywhere on that region within the track’s playlist. To select a portion of a region, use the Selector tool and drag across the region in the track’s playlist.
3. Choose Edit ➪ Copy from the main menu or press Command+C (on a Mac) or Ctrl+C (on a PC).

The selection is placed in the Clipboard, and, if you’re not dealing with the entire region, a new region corresponding to your selection is created in the Audio Regions list.

**Clearing selections**

In Pro Tools, the Clear command removes the selected material from a track without putting it in the Clipboard and without adding a region to the Audio Regions list corresponding to the selection you cleared. To clear a selection, do the following:

1. Choose the Waveform Track view if you want to clear all the data from the selection (or choose the Automation Parameters view if you only want to clear from that parameter). To select a track view, click-hold on the track view selector (located in the Track Controls section of the Edit window) and drag down the list.

   This determines the data that is cut from the track. (See the Remember icon at the beginning of this section.)

2. Select the region or part of the region you want to copy.

   To select the entire region, use the Grabber tool and click anywhere on that region within the track’s playlist. To select a portion of a region use the Selector tool and drag across the region in the track’s playlist.

3. Choose Edit ➪ Clear from the main menu or press Command+B (on a Mac) or Ctrl+B (on a PC).

   The selection is cleared from your session.

   If you only cleared part of the region, Pro Tools creates new regions from the remaining material in the region.

**Performing a paste**

When you paste a selection, the pasted material comes from the Clipboard — the result of either a Copy or Cut command. To paste a selection, do the following:

1. Using the Selector tool, place your cursor where you want to paste the material in the appropriate track.
If you want the selection to be right at the Start or End point of a region, you can move the cursor to the right or left to put it there:

- Pressing the Tab key to move the cursor to the right.
- Press Ctrl+Tab (on a PC) or Option+Tab (on a Mac) to move the cursor to the left.

2. **Press Command+V (on a Mac) or Ctrl+V (on a PC) or choose Edit ➤ Paste from the main menu.**

The material in the Clipboard is placed at the selection point.

If you paste a selection at an Edit Insert point (putting the cursor at a single point) in Shuffle mode, the material to the right of the cursor slides over to the end of the pasted section. If you paste into a selected section of the track, the pasted material replaces the selected material.

**Using the Duplicate command**

Using the Duplicate command in Pro Tools is essentially the same as copying and then pasting the Start point of the selection right after the End point of the copied section. Duplicate makes quick work of creating loops. To duplicate a selection:

1. **Select the region or part of the region you want to duplicate.**

   To select the entire region, use the Grabber tool and click anywhere on that region within the track’s playlist. To select a portion of a region, use the Selector tool and drag across the region in the track’s playlist.

2. **Choose Edit ➤ Duplicate from the main menu or press Command+D (on a Mac) or Ctrl+D (on a PC).**

   The selection is copied and pasted at the End point.

If you want to construct loops, make sure that you’ve set the main time scale of your session to Bars:Beats. Also, use the Selector tool to drag your selection or (if you’d rather type in a specific value) type in the number of bars or beats in the Start and End points in the Event Edit area. This ensures that your selection is duplicated and placed in the proper time location. Using the Grabber tool may result in the material moving by a few samples in one direction or another.
Performing a repeat

If you want to duplicate a selection more than once (when creating looped sections, for instance) you can use the Repeat command. The Repeat command works the same way as the Duplicate command except that when you choose Edit > Repeat from the main menu (or press Option+R on a Mac or Alt+R on a PC) the Repeat dialog box opens, as shown in Figure 3-22, where you can enter the number of times you want to repeat the Paste part of the procedure.

Each repeated selection is placed immediately after the previous one.
Chapter 4: Adding to Your Editing Palette

In This Chapter
- Getting to know the Smart tool
- Fixing waveforms
- Silencing regions
- Using processing plug-ins
- Performing fades and crossfades

Aside from the basic editing methods — the ones I describe in the first three chapters of this minibook — Pro Tools offers some extra goodies that can make the editing process easier. And what might I mean by goodies? In this particular case, I’m talking about the aptly named Smart tool, the Pencil tool, processing plug-ins, fades, and crossfades. This chapter lays out these tools and helps turn you into a Pro Tools editing pro (or at least an informed amateur).

Signing On to the Smart Tool

The Smart Tool in Pro Tools is, well, smart. This tool consists of three tools you’ve already had a chance to explore in Book 4, Chapter 3 — the Trimmer, Selector, and Grabber. But it’s more than just these three tools. The Smart tool actually changes the way it works depending on what you try to do with it. For example, if you place the cursor close to the Start or End point of a region, the Trimmer tool will be activated, whereas if you place the cursor somewhere else within the region, the Selector or Grabber tool will appear, depending on where you put the cursor.

To use the Smart tool, click the button located under the Selector tool in the Edit window, as shown in Figure 4-1.
Using the Smart tool in Waveform view

When you’re using the Smart tool with a track set to Waveform view, each Edit tool in the Smart tool set (Trimmer, Selector, Grabber) becomes active according to where you place the cursor in the region. (See Book 2, Chapter 4 for more on setting your view to Waveform view.) While you’re in Waveform view, you can also perform fades and crossfades. This section details each of these editing tools and/or techniques.

Trimmer tool

To activate the Trimmer tool when you’re in the Smart tool mode, position your cursor near the Start or End point of the region you want to work with. The Trimmer cursor appears, as shown in Figure 4-2. You can trim or extend a region by clicking and dragging the Start or End point to the left or right.

Selector tool

You enable the Selector tool when you’re in the Smart tool mode by positioning your cursor in the upper half of the region, as shown in Figure 4-3. When you see the Selector cursor, you can drag across the region to make a selection.
Adding to Your Editing Palette

Signing On to the Smart Tool

Grabber tool
When you place the cursor in the lower half of a region — but not near the Start or End point — you enable the Grabber tool, as shown in Figure 4-4. To grab the region, click it when the Grabber cursor appears. You can then drag the region to another place.

Fading in or out
Fade-ins and fade-outs are editing techniques where you make the volume of the region increase from silence (fade in) or decrease to silence (fade out). This is useful when you want to eliminate abrupt changes in sound, such as clicks, when a region start or ends. You can use the Smart tool to perform a fade-in or -out by placing the cursor in the upper corner of the region near the Start point (for a fade-in) or End point (for a fade-out) and waiting until the Fade icon appears, as shown in Figure 4-5. Then you can select the Fade length by dragging your cursor to the right (to fade in) or left (to fade out). (For more on fade-ins and fade-outs, see the “Performing Fades and Crossfades” section, later in this chapter.)
Creating crossfades

A crossfade is when the volume of the first of two adjacent regions decreases to silence while the second of these two regions increases from silence. This smooths the transition going from one region to another. You can create a crossfade between two adjacent regions by placing the cursor at the bottom corner where the two regions adjoin and waiting until the Crossfade icon appears, as shown in Figure 4-6. Once the icon appears, you can drag to the left or right to set the Crossfade length. (The “Performing Fades and Crossfades” section, later in this chapter, has more on crossfades.)

Using the Smart tool in Automation view

To add to the versatility of the Smart tools (outlined in the previous section), each tool in the set — Trimmer, Selector, and Grabber — performs differently when you have a track set to one of the Automation views (Volume, Panning, Mute, and Send Levels). (Book 2, Chapter 4 has more on track views; Book 6, Chapter 6 has more on automating a mix.)
Automating the Trimmer tool
To select a region in one of the Automation views using the Smart version of the Trimmer tool, position your cursor in the top 25 percent of the region. The Trimmer icon appears, as shown in Figure 4-7. You can move your cursor up and down to change the automation value or to create breakpoints (places where changes occur in the automation curves). If you want finer control of the Trimmer tool and your work, press Ctrl (PC) or Command (Mac) after you begin trimming.

Automating the Selector tool
To use the Selector tool in Smart mode when you have one of the Automation views set for a track, position your cursor in the lower 75 percent of the region, as shown in Figure 4-8. You can then make your selection.

Automating the Grabber tool
To use the Smart version of the Grabber tool in a track set to one of the Automation views, press Ctrl (on a PC) or Command (on a Mac) with your cursor placed in the region, as shown in Figure 4-9.
You can use the Grabber tool in several different ways when you have a track set to an Automation view. Here are two especially handy ways:

✦ **Editing existing breakpoints**: Just position the cursor near one of these points and the Grabber magically appears. You can increase the resolution of your movements to fine control by pressing Ctrl (on a PC) or Command (on a Mac) after you start moving the breakpoint.

✦ **Constraining the Grabber vertically**: To keep the Grabber from moving right or left, press Shift — or, if you’ve set the tool to fine control, press Ctrl+Shift (PC) or Command+Shift (Mac).

---

**Perusing the Pencil Tool**

In spite of all your effort to keep from creating any of the digital distortions known as *overs* — also referred to as *clipping* — you may have one pop through. No worries; you can use the Pencil tool to *redraw the waveform* and get rid that nasty critter (is that cool, or what?). You can also use this tool to remove other unwanted pops or clicks that show up in your precious tracks.

The Pencil tool, shown here in the margin, is only active when you zoom way in.

---

**Figure 4-10:**
You can use the Pencil tool if you zoom way in.
Using the Pencil tool to redraw a waveform is a destructive act; it changes your original audio file permanently. Before you redraw, it’s a good idea to make a copy of the original region (using the Duplicate function under the AudioSuite menu) so you don’t lose the good stuff in the original file. The next section tells you precisely how to do that.

**Creating a copy of the original file**

I strongly recommend making a copy of a region before you edit it with the Pencil tool (see the Warning icon in the previous section). Here’s how it’s done:

1. Select the region you want to work on.
2. Choose AudioSuite > Duplicate from the main menu.

   The Duplicate dialog box appears, as shown in Figure 4-11.

3. Enable the Use in Playlist option on the right; make sure that Playlist is chosen in the top-center field.
4. Click Process at the lower right.

   You now have a copy of the original region that’s put in the track in place of the original. (The original still resides in the Audio Regions list.)

**Using the Pencil tool to redraw a waveform**

To redraw a waveform (*after* you’ve made a copy of it — see the previous section for why), follow these steps:

1. Find the area in the region that you want to edit.
2. Using the Zoomer tool, click repeatedly on the spot you want to edit until you get into the sample level.

   The waveform will look like a single wavy line. (Refer to Figure 4-10.)
3. **Select the Pencil tool.**

4. **Locate the exact spot to edit.**

   Your target, typically a moment of distorted sound, is usually easy to see because it looks like a sharp peak in the waveform (Figure 4-12, left). If it isn’t apparent, you may need to adjust the horizontal until you can see it clearly. (For more on adjusting the horizontal zoom, see Book 2, Chapter 4.)

   If you have trouble seeing the problem, use the Scrub tool to listen to the audio.

5. **Draw over the waveform to round over the spot that was chopped off when the note got “clipped”** (Figure 4-12, right).

   Take it easy on making changes to the waveform. All you want to do is smooth out the peak, not change the sound too much.

---

**Figure 4-12:**
The Pencil tool fixes a chopped-off peak (left) of a waveform (right).

---

**Silencing Selections**

Pro Tools offers a couple of ways to manage silence in selections: You can strip silence from regions to reduce the size of your audio files and you can insert silence into regions where you don’t want any sound. Both these options are covered in this section.

**Stripping silence**

The Strip Silence command allows you to take a selection that meets a minimum sound level and silence it. This divides the region that the silence was stripped from into smaller regions. This lets you isolate sound effects or
musical passages so you can quantize them or locate them at specific Synch points within your session (check out Book 4, Chapter 3 for more on synch points). Stripping silence from regions also allows you to compact your audio file farther than you could if you didn’t strip the low-volume parts to silence. (See the “Compacting a file” section, later in this chapter.) This technique saves hard-disk space by making your audio files smaller.

**Understanding the Strip Silence window**

Whenever you use the Strip Silence command (see next section), a dialog window opens (see Figure 4-13) where you can set the parameters under which the silence will be stripped from a region. These parameters include

- **Strip Threshold**: This setting determines the signal level below which the audio is silenced.
- **Minimum Strip Duration**: This parameter makes sure that if you have a really small section that falls below the threshold, you don’t end up with a ton of sections where silence was stripped and didn’t need to be.
- **Region Start Pad**: This parameter adds a specified amount of time to the beginning of each region created when you use the Strip Silence command.
- **Region End Pad**: This parameter is essentially the same as the previous one except it adds time after the end of a region stripped from silence.
- **Rename**: This button opens The Rename Selected Regions dialog box (see Figure 4-14) where you choose how new regions are named after silence has been stripped.
Using the Strip Silence command

To strip silence from audio regions, follow these steps:

1. **Select a region or part of a region.**
   
   Book 4, Chapter 2 has more on making selections.

2. **Choose Windows ➪ Show Strip Silence from the main menu.**
   
   The Strip Silence dialog box opens. (Refer to Figure 4-13.)

3. **Click the Rename button to set your region name preferences.**

4. **Adjust the parameter sliders until rectangles appear in the region and any material you want to remove resides outside the rectangles, as shown in Figure 4-15.**
   
   This may take some time. If you want to increase the resolution of the sliders, press Command (on a Mac) or Ctrl (on a PC) as you move them.
5. When you have the rectangles where you want them, click the Strip button in the Strip Silence dialog box.

Any part of the region not in the rectangles is removed; each rectangled section then becomes a new region, using the naming scheme that you choose in the Rename window.

**Inserting silence**

If you’re like most people, you keep the session rolling — even when you don’t play anything during certain passages — in order to keep the feel happening throughout the tune. In this case, it’s not uncommon to have passages where pretty much nothing is recorded (well, except for maybe a cough or a chair squeak). Rather than cutting those sections out of your track you can insert silence into those sections instead. Using the Insert Silence command you can put silence anywhere you want within a track quickly and easily. Keep in mind, though, that inserting silence into tracks works differently for each Edit mode. This can often prove confusing, so to help you keep things straight, I not only show you how to insert silence, but also let you know what conditions apply when you use the different Edit modes.

**Inserting an amount of silence**

You insert silence into a track with the following steps:

1. Select the part of a region that you want to silence using the Selector tool and click-drag across the section of the region you want to select.
2. Choose Edit \( \rightarrow \) Insert Silence from the main menu or press Shift+Command+E (on a Mac) or Shift+Ctrl+E (on a PC).

The selected section is silenced.

**Understanding the results**

When you’re using the Insert Silence command, each Edit mode treats certain conditions differently. The difference depends on the mode in use at the time:

- **Shuffle mode:** If the track(s) you selected is set to Waveform view, all audio and automation data is cleared and all subsequent regions are shuffled the amount of the silence.

- **Slip mode:** If the track(s) you selected is set to Waveform view, all audio and automation data is cleared. On the other hand, if your track is set to one of the Automation views, only the data from that view is removed.

- **Grid mode:** All audio and automation data is cleared. This is essentially the same as using the clear command (Book 4, Chapter 3). All the regions stay where they are in the session when the silence is inserted.
Performing Fades and Crossfades

Fade-ins and fade-outs are techniques where you make the volume of the region increase from silence (fade in) or decrease to silence (fade out). This is useful when you want to eliminate abrupt changes in sound, such as clicks, when a region start or ends. A crossfade is the combination of a fade-out and a fade-in that happens at the junction of two adjacent regions to make the transition between these two regions smooth. You can create fade-ins, fade-outs, and crossfades — faster and easier than ever before — in Pro Tools. You can use fades to bring regions in and out of a mix or to make a seamless transition from one adjoining region to another. One of the key aspects of creating fades is creating a curve (the way the fade happens) that fits the material you want to fade and it shouldn’t surprise you that Pro Tools gives you many options for shaping your curves.

Dealing with the Fades dialog box

Whatever kind of fade you create — fade-in, fade-out, or crossfade — the fade is made according to the settings in the Fades dialog box. You access the Fades dialog box by choosing Edit ➪ Fades ➪ Create Fades from the main menu. After you get the dialog box up on your computer screen (as in Figure 4-16), you can adjust the following parameters to meet your needs:

✦ **Audition:** Clicking this button plays the crossfade so you can hear what your settings will sound like.

✦ **View First Track:** Pro Tools lets you select more than one track to crossfade at one time. (The crossfade, however, takes place on each track and not across tracks.) The View First Track button allows you to view and audition the first of the tracks selected.

✦ **View Second Track:** In a selection that includes more than one track, this button shows you the second track. If you have more than two tracks selected, you can’t view beyond the second.

✦ **View Both Tracks:** Clicking this button lets you view and audition both tracks selected for crossfading.

✦ **Fade Curves Only:** Enabling this button shows the fade curves but not the waveforms for the audio you want to crossfade.

✦ **Fade Curves and Separate Waveforms:** This button lets you see both the fade curves and the waveforms for each track. The fade out waveform shows up above the fade in waveform.

✦ **Fade Curves and Superimposed Waveforms:** This button superimposes the two waveforms one on top of the other and shows the fade curves.
Performing Fades and Crossfades

✦ **Fade Curves and Summed Waveform**: This button shows the fade curves and a single waveform depicting the sum of both original waveforms.

✦ **Zoom In**: The Zoom In button increases the visual height of the waveforms. You can return to the default setting by using Command+click (on a Mac) or Ctrl+click (on a PC).

✦ **Zoom Out**: Clicking the Zoom Out button decreases the visual height of the waveform. Using Command+click (on a Mac) or Ctrl+click (on a PC) returns the view to the default setting.
Out Shape Setting: This box lets you select the shape of the fade out curve. You have three options:

- **Standard:** This setting uses a basic fade-out shape that you can adjust by clicking the curve and dragging the curve the way you want it.

- **S-Curve:** This setting creates an “S” shaped curve that you can adjust by clicking the curve and dragging to the shape you want. (Well, as long as it’s an S-shape.)

- **Presets:** Clicking here presents you with a pop-up menu containing seven preset curves for you to choose from, as shown in Figure 4-17. You can change a preset by clicking one of the End points and dragging it.

Link settings: You have the following three choices on how you want the fade-out and fade-in curves of your crossfades to relate to one another:

- **Equal power:** This option keeps the relative volume of the Fade Out and Fade In regions the same. This selection is best for material that differs greatly in sound character, such as the fading out of one instrument and the fading in of another.

- **Equal Gain:** This setting keeps the Fade In and Fade Out selections from summing together and overloading the track, resulting in clipping (distortion). This setting is best for selections that have the same relative volume and phase, such as one drum loop to another.

- **None:** This setting leaves the two fades independent of one another. This gives you more flexibility to create unique fades. If you want to edit the Fade In curve only, press Alt (on a PC) or Option (on a Mac) while you drag the curve. To adjust the Fade Out only, press Ctrl (on a PC) or Command (on a Mac) while you drag the curve.
Performing Fades and Crossfades

✦ **Use Dither:** Clicking this option applies *dither* — a way to improve the sound of very quiet material. (Book 7, Chapter 2 has more on dither.) You don’t need this box checked if you crossfade fairly loud material, but it’s a good idea if the audio is quiet.

✦ **In Shape Setting:** This box lets you select the shape of the Fade In curve. As was the case with Out Shape setting, there are two options:
  - **Standard:** This setting uses a basic fade in shape that you can adjust by clicking the curve and dragging the curve the way you want it.
  - **S-Curve:** This setting creates an S-shaped Fade In curve that you can adjust by clicking the curve and dragging it to the shape you want (as long as it’s an S-shape).

✦ **Presets:** As you might have guessed, there are seven preset curves that you can choose from — mirror images of the curves found in the Out Shape Presets menu. You can change them by clicking one of the End points and dragging it.

Creating crossfades

There are three types of crossfades: centered, pre, and post. These different flavors — and the actual process of creating a crossfade — are covered in this section.

Creating a centered crossfade

The *centered crossfade* is the most common type of crossfade and is great for times when the material in the two regions fits well together — such as with two different takes of a lead vocal part that end up being your final vocal track. Center crossfades are fades where the crossfade happens evenly between the two regions, incorporating audio on both sides of two regions’ splice points (the point where they meet). In order for this type of crossfade to work, you need audio data after the End point of the first region and before the Start point of the second region.

To create a center crossfade, follow these steps:

1. **Using the Selector tool,** drag from the point where you want the crossfade to start (in the first region) to where you want the crossfade to end (in the second region), as shown in Figure 4-18.

2. **Choose Edit → Fades → Create Fades** from the main menu or press Command+F (on a Mac) or Ctrl+F (on a PC).

   The Fades dialog box opens. (Refer to Figure 4-16.)
3. Enter your crossfade preferences in the Fades dialog box as listed in the previous section, “Dealing with the Fades dialog box.”

Make adjustments to the view, the Fade In and Fade Out curves, and the Link option — auditioning the crossfade periodically as you go — until you have the crossfade you want.

4. When you're happy with the sound of the crossfade, click OK.

Your crossfade will be calculated. You can change the duration of the fade by trimming it (see the “Trimming a crossfade” section later in this chapter).

Creating a pre-crossfade

This type of crossfade happens before the Start point of the second region, as shown in Figure 4-19. This is a good type of crossfade to use when you have an initial attack (a cymbal crash, for example) that happens right at the Start point of the second region. In this example, if the second region isn't at full volume when the crash happens you lose the impact of the cymbal. The pre-crossfade ensures that you get the full impact of the cymbal. For this crossfade to work, audio data has to be in place before the Start point of the second region.
Performing Fades and Crossfades

Follow these steps to create a pre-crossfade:

1. Using the Selector tool, click in the region at the point where you want the pre-crossfade to begin.
2. Shift-drag or press Shift+Tab to select to the end of the region.
3. Choose Edit ➤ Fades ➤ Create Fades from the main menu or press Command+F (on a Mac) or Ctrl+F (on a PC).
   The Fades dialog box makes its appearance. (Refer to Figure 4-16.)
4. Choose your Fade settings and audition them, adjusting the settings as you go until you have the fade that you want.
5. Click OK.
   The fade is created.

Creating a post-crossfade

The post-crossfade happens after the end of the first region, as shown in Figure 4-20. This type of crossfade is useful for times when you have a sound that continues all the way up to the end of the first region (to keep the drum theme going, a hi-hat note, for instance) and you want to make sure that the last hi-hat doesn’t drop off in volume as it’s being hit. This type of crossfade only works if the first region contains audio data after its End point.

Follow these steps to create a post-crossfade:

1. Using the Selector tool, click in the region at the point where you want the fade to end.
2. Shift-drag or press Shift+Option+Tab (on a Mac) or Shift+Alt+Tab (on a PC) to select back to the region’s Start point.
3. Choose Edit ➤ Fades ➤ Create Fades from the main menu or press Command+F (on a Mac) or Ctrl+F (on a PC) to open the Fades dialog box. (Refer to Figure 4-16.)
4. Choose your fade settings and audition them, adjusting the settings as you go until you have the fade you want.

5. Click OK.
   
The fade is created.

**Removing a crossfade**

To remove a crossfade, select the crossfade with the Grabber tool and press Delete (on a Mac) or Backspace (on a PC). You can also choose Edit ➪ Fades ➪ Delete Fades from the main menu.

**Trimming a crossfade**

Here’s how to change the boundaries of a crossfade:

1. Select the crossfade by double-clicking with the Selector tool or grabbing with the Grabber tool.

2. Using the Trimmer tool, click and drag either side of the crossfade.

**Fading in and out**

A fade-in is where you make the volume of the region increase from silence in order to smooth the transition into the region. A fade-out is a decrease in volume that is useful when you want to smooth the transition out of a region. These types of fades are often used when you have accent parts that come and go in the song — keyboard or guitar licks that counterpoint the lead vocal, for instance — and you want them to seamlessly flow in and out of the song. Without a fade into or out of the region you may hear abrupt changes in the sound due to the background noise in those parts.

You can fade a single region in or out by using the Fades dialog box. Creating these fades saves you the trouble of performing automation curves to fade in or out. (Of course, you can still do that, but it does use more of your computer’s processing power. I explain the process in Book 6, Chapter 6.)

**Fading in to the beginning of a region**

To fade in to a single region, follow these steps:

1. Using the Selector tool, select the beginning of the region you want to fade into.

   To make this process work, you have to begin your selection point before (or at) the Start point — not after it.

2. Choose Edit ➪ Fades ➪ Create Fades from the main menu or press Ctrl+F (on a PC) or Command+F (on a Mac).

   The Fades dialog box appears. (Refer to Figure 4-16.)
3. Choose your parameters in the dialog box and audition the fade, making adjustments to the settings until you get the fade to sound the way you want.

4. Click OK.

The fade is created and the Fade curve appears in the selected region.

You can also fade in without opening the Fades dialog box. When you do this, Pro Tools uses the setting you currently have entered in the Fades menu.

To fade in without using the dialog box, follow these steps:

1. Click an insertion point somewhere within the region, as shown in Figure 4-21.

2. Press Ctrl+D (on a Mac) or Start/Windows+D (on a PC) or select Edit ➤ Fades ➤ Fade To Start from the main menu.

The Fade is created and the curve appears in the selected region.

---

**Figure 4-21:**
To create a fade-in without opening the dialog box, click your Fade point and press the keyboard shortcut.

---

**Fading out at the end of a region**
To fade out from a single region, follow these steps:

1. **Using the Selector tool, select the beginning of the region you want to fade.**

   Keep in mind that your selection point needs to stop after or at the End point — not before it — in order for this process to work.

2. **Choose Edit ➤ Fades ➤ Create Fades from the main menu or press Ctrl+F (on a PC) or Command+F (on a Mac).**

   The Fades dialog box appears. (Refer to Figure 4-16.)
3. Choose your parameters in the dialog box and audition the fade, making adjustments to the settings until you get the fade to sound the way you want.

4. Click OK.

The fade is created and the Fade curve appears in the selected region.

You can also fade out without opening the Fades dialog box. When you do this, Pro Tools uses the setting you currently have entered in the Fades menu.

To fade out without using the dialog box, follow these steps:

1. Click an insertion point prior to the end of the region, as shown in Figure 4-22.

2. Press Ctrl+G (on a Mac) or Start/Windows+G (on a Windows PC) or select Edit ➤ Fades ➤ Fade To End from the main menu.

The fade is created and the curve appears in the selected region.

---

**Creating batch fades**

You can create more than one fade at a time using the Batch Fades command and selecting multiple regions at a time.

Here’s the way to create batch fades:

1. Using the Selector tool, choose the first region you want to fade.

2. Click-drag across the regions you want to include in the batch.
Make sure that the entire last region that you want to fade is selected, as shown in Figure 4-23.

3. Press Ctrl+F (on a PC) or Command+F (on Mac) or choose Edit ➪ Fades ➪ Create Fades from the main menu.

The Batch Fades dialog box appears, as shown in Figure 4-24.

4. In the Batch Fades dialog box, choose your In and Out Shapes, Link option, Fade Placement, the crossfade length (in milliseconds) and whether you want to create a new fade, create new fade ins and outs, or adjust existing fades.

5. Click OK.

The fades are calculated.

You can trim or extend each of the fades later if you choose.

**Figure 4-23:**
Select across multiple regions to perform batch fades.

**Figure 4-24:**
The Batch Fades dialog box lets you create fades on more than one region at a time.
Cleaning Up Your Session

After you’ve done all your editing, you probably have a ton of regions in your Audio Regions list. Things can get cluttered up pretty quick, so before I start mixing the song, I like to clean up my session by consolidating regions, getting rid of any unused regions, and compacting the regions that I do want to use. Doing these things both makes it easier to deal with the regions in the session and frees up hard disk space. It can also make playing the tracks easier on your hard disk, depending on how many tracks you have in your session.

Consolidating selections

You can consolidate regions that make up a section of a song by using the Consolidate Selections command. In effect, you take a bunch of regions — for instance, the various assembled takes of your guitar part that create the parts for a song’s verse — and make them into one region. This makes moving or copying this section easier and makes for a less-cluttered track playlist.

To consolidate selections, follow these steps:

1. Select the regions you want to consolidate using either the Selector tool or the Grabber tool or, if you want to select all the regions in the track, triple-click anywhere in the track’s playlist.

2. Choose Edit > Consolidate Selection from the main menu or press Option+Shift+3 (on a Mac) Alt+Shift+3 (on a PC).

   The selected regions are replaced by a new region, which contains all the audio from the selection, including any muted regions.

Automation data is not consolidated. If you have regions that you want to consolidate and you want to keep any automation data at all, your best bet is to do a bounce procedure for that selection. (I cover bounce procedures in Book 6, Chapter 7.)

Removing unused regions

You can easily get rid of any regions that are not being used in your session. Here’s how:

1. Open the Audio Regions pop-up menu by click-holding on the Audio Regions title at the top of the Audio Regions list located on the right side of the Edit window.
2. **Under Select ➤ Unused Regions in the Audio Regions List pop-up menu or press Shift+Command+U (on a Mac) or Shift+Ctrl+U (on a PC).**

   All regions in the list that aren’t included in any tracks in the session are highlighted.

3. **Choose Clear Selected from the Audio Regions list pop-up menu.**

   The Clear Audio dialog box appears, as shown in Figure 4-25, asking if you either want to remove the regions from the session or delete the audio files from your hard drive. Choose the option you prefer.

![Figure 4-25: The Clear Audio dialog box lets you get rid of any regions you aren’t using in your session.](image)

Removing the regions from your present session will ensure that you have the region to use in another session, but it won’t reduce the amount of stuff on your hard drive. If you want to free up space and know that you won’t use the region in another session, delete it to save disk space.

**Compacting a file**

You can *compact* an audio file (make it smaller) by using the Compact Selected command from the Audio Regions pop-up menu. Compacting an audio file in Pro Tools deletes any audio data that is not being used. This reduces the amount of space taken up in your hard drive, which makes backing up your data a quicker process.

Compacting an audio file is like taking all the pieces of tape that were cut from reels of recorded tape and — gasp — throwing them away. (Well, okay, that’s what it would have been like in the days before digital audio.) My point is that, once you compact a file, you’re committed to the results. This is one of the few editing tasks that you can do that you can’t undo afterward.
You only want to compact an audio file after you’ve done all your editing and you’re sure you don’t want any of the unused data. (You’re sure. Right?)

To compact a region, follow these steps:

1. Choose the region(s) you want to compact from the Audio Regions list.
2. Open the Audio Regions pop-up menu by click-holding over the Audio Regions title at the top of the Audio Regions list and then choosing Compact.

   The Compact dialog box appears, as shown in Figure 4-26.

3. In the Padding field, enter the amount of padding you want on your regions.

   Padding is the amount of data on either side of the region’s Start and End points that may contain fade information. If you have fades in the region, set your padding amount to the length of the fade to insure that your fades still work.

4. Click Compact.

   Pro Tools deletes all the data outside the region and its padding.

![Figure 4-26: The Compact Regions dialog box removes extra data from your regions, increasing available hard-disk space.](image)
Book V

Managing MIDI

The 5th Wave  By Rich Tennant

“You know kids – You can’t buy them just any audio recording software.”
Contents at a Glance

Chapter 1: Preparing to Record MIDI
Chapter 2: Recording MIDI
Chapter 3: Editing MIDI Data
Chapter 4: Performing MIDI Operations
Chapter 1: Preparing to Record MIDI

In This Chapter

- Configuring MIDI devices
- Creating MIDI tracks
- Setting inputs and outputs
- Creating a click track

MIDI functions in Pro Tools are new to the program, so at this point in time MIDI is still pretty basic. For the home recordist without heavy-duty MIDI needs (you know who you are), using MIDI in Pro Tools is simpler than in many other MIDI-intensive programs such as Logic or Sonar. Even though MIDI isn’t exactly the Pro Tools strong suit, it still offers plenty of functions that can help make your music shine.

In this chapter, I walk you through the process of setting up your system and session to record MIDI in Pro Tools. Along the way, you discover how to set up your devices, create MIDI tracks, and enable them for recording. You also get a chance to create a click track to play along with that makes editing MIDI faster and easier.

Setting Up Your MIDI Devices

The process of setting up your MIDI device varies according to whether you use a Mac or a PC. Either way, though, setting up a MIDI device only takes a couple of minutes. This section walks you through the process.

Enabling MIDI devices in Mac OS X

Before you can record MIDI in Mac OS X, you need to do three separate things: a) set up your MIDI devices in OS X; b) enable the MIDI channels, which lets you choose the MIDI channels that each device receives and sends data on; and c) enable the input devices in Pro Tools so that you can actually use those devices in Pro Tools.
To configure your MIDI devices in OS X, follow these steps:

1. **Using your MIDI cables, connect the devices you want to use with Pro Tools to either the DigiDesign hardware or to a separate MIDI interface.**

2. **Click the Audio MIDI Setup icon (see margin) in the Dock.**

   The Audio MIDI Setup window opens.

3. **Click the MIDI Devices tab of the Audio MIDI Setup window.**

   A message appears that tells you your system is being scanned. Once the scan is complete, your MIDI interface should appear in the tab’s window, along with any devices connected to it, as shown in Figure 1-1.

4. **If one or more of your devices don’t appear, double-check your cables for proper connection, and then click the Rescan MIDI icon.**

5. **If your device still doesn’t appear, click Add Device. In the dialog box that appears, enter the name, manufacturer, and model number of the device, and then click OK.**

6. **After your devices appear in the MIDI Devices tab of the Audio MIDI Setup window, close the window by choosing Audio MIDI Setup: Quit Audio MIDI Setup from the main menu (or press Command+Q). You can also close this window by clicking on the red X in the upper-left corner of the window.**

To enable MIDI channels in your devices
1. Click the Audio MIDI Setup icon (see margin) in the Dock.
   The Audio MIDI Setup window opens. (Refer to Figure 1-1.)

2. Click the MIDI Devices tab of the Audio MIDI Setup window.
   All MIDI devices connected to your MIDI interface should appear in the tab’s window.

3. In the MIDI Devices tab of the Audio MIDI Setup window, double-click the device for which you want to activate MIDI channels.
   The Device window appears.

4. Click the More Properties tab to expand the window.
   The window expands to include Basic and Expert tabs containing settings you can make to your device.

5. Click the Basic Tab.

6. In the Transmits and Receives section of the Basics tab, click the channel number(s) that you want to be able to transmit and receive data through.
   Blue highlighted channels are active.

7. Click OK to close the Device window.

8. Close the Audio MIDI Setup window by clicking the red X in the upper-left of the window or by pressing Command+Q.

You can receive MIDI data from other software programs through the Pro Tools inputs. This is useful if you want to use a separate MIDI sequencer (such as Logic) to record and edit your MIDI performances before you bring it into Pro Tools. If you want to do more intensive MIDI editing than Pro Tools offers, this option can be real handy. (For more on using inputs, see Book 5, Chapter 2.)

If you use any control surfaces such as the Mackie Control or if you want to synch your system to another using MMC (MIDI machine control), you must enable the devices for these tasks in the MIDI Input Enable dialog box, along with your other MIDI devices.

To enable input devices in Pro Tools, follow these steps:

1. Choose MIDI-Input Devices from the main menu.
   The MIDI Input Enable dialog box opens, displaying all the MIDI ports in your system, as shown in Figure 1-2.

2. Check the boxes for the devices you want to use.

3. Click OK.
Enabling MIDI devices in Windows XP

Enabling MIDI devices is as easy as adding a printer to your system.

To configure MIDI devices in Windows XP:

1. **Install the drivers for your MIDI device as described in the device’s manual.**
   
   If you use the MIDI ports in your Digidesign interface, this step was already done when you installed the software, as I describe in Book 2, Chapter 1.

2. **Using your MIDI cables, connect the devices you want to use with Pro Tools to either the Digidesign hardware or to a separate MIDI interface.**

3. **Turn on the power for the device.**
   
   At this point, your device should show up in your MIDI tracks’ Input and Output selector pop-up menus. If not, restart your computer. If this still doesn’t work, you may need to go into the Device Driver menu and manually move the driver for your device into the Device Driver folder.

To enable input devices in Pro Tools, the steps are just like those you’d use for a Mac:

1. **Choose MIDI > Input Devices from the main menu.**
   
   The MIDI Input Enable dialog box opens, showing the MIDI ports in your system.

2. **Check the boxes for the devices you want to use.**

3. **Click OK.**
Running MIDI Thru

MIDI Thru allows you to hear what your MIDI instrument is playing while the track it’s assigned to is record-enabled. Pro Tools also lets you set up a default MIDI Thru instrument, so that you don’t have to choose a device each time you enable a MIDI track. Pro Tools uses the designated MIDI Thru instrument automatically.

To enable MIDI Thru, all you have to do is choose MIDI -> MIDI Thru from the main menu.

When you enable MIDI Thru, you also need to disable Local Control in each of your devices to keep them from receiving double messages and creating stuck notes. This is done within each of your MIDI devices. Consult your device’s manual for details on how to do this.

If, for some reason, you end up with some stuck notes, choose MIDI -> All Notes Off from the main menu or press Ctrl+Shift+period (.) on a PC or Command+Shift+period (.) on a Mac.

To set the default MIDI Thru instrument:

1. **Choose Setups -> Preferences from the main menu.**
   The Preferences dialog box opens.
2. **Click the MIDI Tab.**
   The MIDI Preferences dialog box opens, as shown in Figure 1-3.
3. Choose the MIDI device — as well as the channel you want to use to play the MIDI data — from the Default Thru Instrument drop-down menu.

4. Click Done.

Managing the MIDI Input filter

The MIDI Input filter allows you to ignore certain MIDI data while recording. For example, you can have Pro Tools ignore aftertouch or pitch bend messages when you record a drum part using your keyboard. This can be handy if you want to avoid recording system exclusive data — messages that are exclusive to the device and not related to performance information — when recording a MIDI performance.

To set the MIDI Input Filter parameters:

1. Choose MIDI Input Filter from the main menu.

   The MIDI Input Filter dialog box opens, as shown in Figure 1-4.

2. Select the Record options (All, Only, All Except) by checking your selection.

   Choosing All means that Pro Tools will record all the MIDI messages received, whereas choosing Only means that only the parameters that you select in Step 3 are recorded, and choosing AllExcept sets your system to record all the MIDI data it receives except for the boxes you check in Step 3.

![Figure 1-4: The MIDI Input Filter dialog box lets you choose MIDI parameters to record along with your performance data.](image-url)
3. Depending on the mode you chose (see previous step) check the boxes in the Channel Info and Controllers sections that correspond to what you want to include or exclude from the recording process.

4. Depending on the choice you made in Step 2 and whether you want to include any system-exclusive data in your recording, either check or uncheck the System Exclusive box.

If you chose All in Step 2 checking or unchecking this box doesn’t matter — system-exclusive data is recorded either way. If you chose Only in Step 2, checking this box means system exclusive data is recorded and if you chose All Except in Step 2, checking this box means that system-exclusive data is not recorded.

5. Click OK.

Quantizing your inputs

You can have Pro Tools automatically quantize your performance — adjust the position of each note’s timing so that it fits within a specified time frame. This can be useful if you want the timing of your performance to fit a selected grid exactly.

Be careful with quantizing. Stop short of doing too much — it’s real easy to suck the life out of a performance.

To quantize your input

1. Choose MIDI➪Input Quantize from the main menu.

The Input Quantize dialog box opens, as shown in Figure 1-5.
2. Check the Enable Input Quantize box to quantize and enter the rest of the options/parameters in the window.

Here’s a rundown on what each of these parameters mean:

**What to quantize:** The section lets you choose the part of the note to quantize.

- **Attack.** The field sets the quantization to the start of the selected notes.
- **Release.** Clicking this field quantizes the ends of the notes.
- **Preserve Note Duration.** Clicking this field produces different results depending on whether you choose Attack or Release.

With Attack selected, Preserve Note Duration keeps the end of the note intact and with Release selected the start of the note is left intact. If both Attack and Release are selected the Preserve Note Duration option is dimmed.

**Quantize grid:** This section is where you choose the resolution of the quantize grid, from whole notes to 32nd notes.

- **Note Selector.** This section lets you choose the note value of your quantize grid. Click the note to select it.
- **Tuplet.** Checking this box lets you select odd note groupings such as triplets. When you check this option, you need to fill in the tuplet value. For example to create a regular eighth-note triplet choose “3 in time 1” and for a quarter note triplet choose “3 in time 2.”
- **Offset Grid By.** This option lets you move the quantize grid forward or backward in time by the selected number of ticks. This is helpful for creating grooves that lie slightly ahead or behind the beat.
- **Swing.** This field lets you create a swing (dotted quarter-eighth note triplet) feel. You specify a percentage (from 0 to 300) with 100% being a triplet feel.

**Options:** You can include other options with your quantize operation.

These include:

- **Include Within.** Selecting this option only quantizes the notes that fall within the boundaries created with this setting. Your setting ranges are from 0 to 100% with the smaller number affecting the narrower range of notes.

- **Exclude Within.** Exclude Within lets you choose to exclude any notes within the boundaries set in this field. Like with Include Within, you can set your boundaries between 0 and 100%.
**Strength.** This is, in my opinion, the most useful function in the Pro Tool's quantize operation. Using this option lets you move your quantized notes by a percentage rather than just snapping them right to the grid. Your setting range runs from 0 to 100%, with the higher numbers keeping more strictly to the grid than lower values.

**Randomize.** This option adds a level of randomness to the quantizing of your selection. This can further help with keeping your rhythm from being too rigid. You can select values between 0 and 100%. Lower values place the randomized notes closer to the grid.

3. Press Enter (on a PC) or Return (on a Mac) to close the window.

**Offsetting MIDI tracks**

Pro Tools lets you offset your MIDI tracks to be a specified amount of time in your session. This can be especially handy if you record your MIDI track while listening to your sound device through the Digidesign interface; you may notice some delay (also called latency) in the sound. This delay is the result of the time it takes the sound to travel through the interface, into the computer, and then back out the interface to your speakers. Depending on the Buffer setting you have in your session, this latency may be large enough to bother you. (Book 2, Chapter 3 has more on Buffer settings.)

The way around this problem is to offset your MIDI tracks by moving them to a point earlier in your session by the amount of the delay. This makes Pro Tools play the MIDI track(s) earlier so you can hear them on time.

To offset all of your MIDI tracks, follow these steps:

1. **Choose Setups ➤ Preferences from the main menu.**
   
The Preferences dialog box opens.

2. **Click the MIDI Tab.**
   
The MIDI Preferences dialog box opens. (Refer to Figure 1-3.)

3. **Enter a negative number equal to your H/W buffer setting in the Global MIDI Offset field.**
   
   This offset amount uses samples (the individual snapshots of the audio in your session) as the unit of measure.

4. **Click Done.**
   
   Your specified offset will compensate for the latency.
To offset a single track, follow these steps:

1. **Choose Windows ➤ Show MIDI Track Offsets from the main menu.**
   
   The MIDI Track Offsets window opens.

2. **On the row for the track you want to offset, double-click the Sample Offset column.**
   
   The field is highlighted.

3. **Enter the offset value in the Sample Offset column.**
   
   A negative number moves the track to an earlier point in the session; a positive number moves it later. Enter a value equal to the H/W buffer setting (as described in Book 2, Chapter 3).

4. **Press Return (on a Mac) or Enter (on a PC) to save the value and close the window.**

---

**Getting Ready to Record**

Setting up MIDI tracks involves first creating the tracks for your session and then setting the inputs, outputs, and MIDI channels for the tracks you created. This section spells out how to do all these tasks.

**Creating MIDI tracks**

Of course, before you can manipulate a MIDI track, you’ve got to have one. To create a new MIDI track, follow these steps:

1. **Choose File ➤ New Track from the main menu.**
   
   The New Track dialog box appears, as shown in Figure 1-6.

2. **Enter the number of tracks you want to create.**

3. **Select MIDI Track from the drop-down menu.**

4. **Click Create.**
   
   Your new track(s) appear in both the Edit and the Mix windows.

---

**Figure 1-6:**

The New Track dialog box lets you create new MIDI tracks.
When you create a new track a default name is used — something not entirely useful (like MIDI 1). You can rename this track by following these steps:

1. **Double-click the track name in the Edit window.**
   The Name Track dialog box appears.
2. **Type in the new name and add any comments about the track in the appropriate places.**
3. **Click OK to close the window.**
   Your track gets a — hopefully more helpful — new name.

**Setting inputs, outputs, and MIDI channels**

For MIDI tracks, like with audio tracks, you need to select the input and output sources for your MIDI data in order to be able to record and play back your tracks. Where MIDI tracks differ from audio tracks is that you also need to set the MIDI channel(s) through which the MIDI data for each track travels. You can set the inputs and outputs for your MIDI tracks in either the Edit or Mix window. If you want to set these in the Edit window, make sure that you’ve set up the window so that it displays the Input and Output sections (Choosing Display ➪ Edit Window Show ➪ I/O View gets that done for you).

To set the input on a MIDI track, follow these steps:

1. **Click the MIDI Input Selector pop-up menu.**
   You find the selector in the Track Controls section of the Edit window and above the track’s fader in the Mix window.
2. **Drag through the menu to the MIDI device and channel you want.**
3. **Release your mouse.**

To set the output for your MIDI track, follow these steps:

1. **Click the MIDI Output Selector pop-up menu.**
   You find the selector in the Track Controls section of the Edit window and above the track’s fader in the Mix window.
2. **Drag through the menu to the MIDI device and channel you want.**
3. **Release your mouse button.**

You can assign multiple destinations for your MIDI tracks by pressing Ctrl (on a Mac) or Start/Windows (on PC) when you select your input and output assignments.
Any devices and MIDI channels that are already assigned to another track are listed in bold letters. This makes it easy to keep from accidentally assigning two tracks to the same device and channels (although you can if you want to).

**Creating a click track**

*Click tracks* (a metronome to play to) are useful for making sure that your performance data lines up with the bars and beats of your session. Having your MIDI line up allows you to do a variety of editing tasks much faster and more accurately.

To create a click track, you need to set a tempo and meter and enable the click in the Transport window. I cover the steps for these procedures in this section.

**Setting the tempo**

To set the tempo and meter of your session, or a section within your session, do the following:

1. **Double-click the Meter button in the expanded Transport window — check out Book 2, Chapter 4 for more on expanding the Transport window — or choose Windows\*Show Tempo/Meter from the main menu.**

   The Tempo/Meter Change dialog box appears.

2. **Choose Tempo Change from the drop-down menu.**

   The Tempo Change view of the Tempo/Meter Change dialog box, shown in Figure 1-7, has the following four parameters to adjust:

   - **Snap to Bar**: Checking this box aligns any tempo event you create to the first beat in the nearest bar. (See the “Setting up tempo and meter events” section in Book 3, Chapter 3.)

![Figure 1-7: The Tempo Change dialog box.](image)
**Location:** This is where you type the location at which this tempo begins. Choosing 1/1/000 makes this the default tempo for the song.

**Tempo:** This box lets you type in the tempo, in beats per minute (BPM).

**Resolution:** This menu lets you choose the note value that gets one beat for the tempo of the song or song’s section. The default is 1/4 note.

---

**Choosing the meter**

You can set the meter for the session by doing the following:

1. **Double-click the Meter button in the expanded Transport window — check out Book 2, Chapter 4 for more on expanding the Transport window — or choose Windows ➪ Show Tempo/Meter from the main menu.**

   The Tempo/Meter Change dialog box appears.

2. **Choose Meter Change from the drop-down menu.**

   The Meter Change view of the Tempo/Meter Change dialog box, shown in Figure 1-8, has the following four parameters to adjust:

   - **Snap to Bar:** Check this box to have any meter events align to the first beat in the nearest bar. (See the “Setting up tempo and meter events” section in Book 3, Chapter 3.)

   - **Location:** The number you enter in this box determines the beginning of the meter (time signature) event. For songs with only one time signature, you enter 1/1/000.

   - **Meter:** This box lets you type in the meter that you want to use.

   - **Click:** This menu lets you choose the note value for the clicks that are played in each measure. Choosing 1/4 note means you’ll hear four clicks in a 4/4 measure.

---

*Figure 1-8:*

The Meter Change dialog box is where you designate the meter in your session.
**Configuring your device**

Of course, to play a click track in Pro Tools, you need a device to create the sound (details, details). This can be an external MIDI sound module (such as a drum machine or keyboard) or the DigiRack Click plug-in.

Follow these steps to configure the click-track device:

1. **Choose MIDI→Click Options from the main menu or double-click the Click or Countoff button in the Transport window.**

   The Click/Countoff Options dialog box appears, as shown in Figure 1-9.

2. **In the Click/Countoff Options dialog box, use the Output drop-down menu to choose the device to play your click.**

   If your using an external device, choose the port and MIDI channel that your device is connected to. If you’re using the Click plug-in choose None.

3. **Choose when you want the click to be played by selecting from the options at the top of the window.**

   You can choose between During Play and Record, Only During Record, and Only During Countoff.

4. **Select the MIDI note, velocity, and duration for the accented and unaccented notes of the click in the appropriate boxes.**

5. **Select whether you want a countoff or not and the number of bars you want.**

   Selecting Only During Record means that there’s no countoff when you play back the track. If you select one of the other options and decide that you still don’t want any countoff, type in 0 bars in the Bars box.
The next order of business is to enable your click track, which you can do in one of two ways:

✦ Choose MIDI  Click from the main menu.
✦ Click the Click button in the MIDI section of the Transport window. When Click is engaged, this button is blue.

You can engage the countoff by clicking the Countoff button in the MIDI section of the Transport window. This button displays the number of bars that the countoff is set for. This button is blue when it’s engaged.

If you want to use the Click plug-in — rather than an external device — to play the click, do the following:

1. Create a new auxiliary track by choosing File  New Track from the main menu or pressing Shift+Command+N (on a Mac) or Shift+Ctrl+N (on a PC).
2. In the track you created in Step 1, select one of your hardware inputs from the Input Selector pop-up menu.
3. Use the Output selector to set the output of the track to the main outputs (the outputs you use for your monitors - usually 1 & 2).
4. Make sure that the Inserts option is chosen under the Mix Window Shows menu. (Choose Displays  Mix Window Shows to check.)
5. Choose Click from the Inserts pop-up menu (click-hold over the arrow and drag to the plug-in) for the track you just created, as shown in Figure 1-10.

Your chosen click plays according to your choice in the Click/Countoff dialog-box menu.
I usually use a drum machine or other decent drum sound from an external device to create my click track. The Click plug-in, as handy as it is, doesn’t have the most-pleasing sound.
Chapter 2: Recording MIDI

In This Chapter

- Recording MIDI performances
- Playing back tracks
- Understanding overdubbing
- Recording system-exclusive data

Recording MIDI in Pro Tools is much like recording audio. The advantage with MIDI is that you only record the performance data and not the sound itself. This allows you flexibility in choosing the sound that you ultimately want for your song.

In this chapter, you discover the process of recording MIDI in Pro Tools. You walk through enabling your tracks and recording your MIDI data. You also get a chance to overdub using use punch and loop recording.

Recording MIDI Performances

If you read Book 3, Chapter 4, you pretty much know the basics about recording MIDI performances, because the process is very similar to recording audio tracks. The only significant difference is that you can set your system to wait until it receives MIDI data before starting to record. (This keeps you from having to hit the Record button in the Transport window.) This section details how to record single or multiple MIDI tracks.

Enabling recording for MIDI tracks

You can record-enable your MIDI tracks the same way you enable recording for audio tracks. Let me count the ways:

- **To record-enable a single track:** Click the Record Enable button, which you can find in either the track’s channel strip (in the Mix window) or the track menu (in the Edit window). The Record Enable button blinks red to let you know it’s engaged.

- **To record-enable all tracks:** Option+click (on a Mac) or Alt+click (on a PC) the Record Enable button on any track.
To record-enable selected tracks: Shift+click to select the tracks you want in the playlist and then Shift+Option+click (on a Mac) or Shift+Alt+click (on a PC) the Record Enable button of one of the selected tracks.

Setting the Wait for Note option

One of the nice things about recording MIDI in Pro Tools is that you can set your session to start recording only after it starts receiving MIDI data. This feature is called Wait for Note, and it allows you to make sure that your first note is timed exactly where Record Start Time is set.

To enable the Wait for Note feature, do the following:

1. Set your Transport window to display MIDI controls by choosing Display ➪ Transport Window Shows ➪ MIDI Controls from the main menu.

   The Transport window expands to include MIDI controls.

2. Click the Wait for Note button to highlight it, as shown in Figure 2-1.

Recording MIDI tracks in Pro Tools requires that you get a few tasks out of the way first — choose the Record mode, create a track, set levels, enable recording, and turn on a click track if you’re using one. Those steps are all covered in detail in Book 3, Chapter 3; when you’ve got ’em done, you’re ready to record some MIDI.

This section gives you a basic overview of what you can do at that point — record a single track or multiple tracks, undo or cancel takes, record additional takes, audition takes, and use playlists to organize the whole mess, or choose some takes to listen to.
Monitoring MIDI inputs

Even after you get your MIDI devices all hooked up and record-enabled, you still won’t hear what you’re playing unless you make some connection to the analog outputs of your MIDI device and route them to an audio track in Pro Tools.

To monitor your MIDI device through Pro Tools, do the following:

1. Connect the analog output of your MIDI device to one of the analog inputs in your Digidesign hardware.
2. Choose File ➪ New Track from the main menu.
   The New Track dialog box appears.
3. Use the drop-down menus of the dialog box to enter the number of tracks you want (1), the type (Audio), and whether you want your track in mono or stereo.
4. Using the new track’s Input selector, select the analog input that your device is connected to in your Digidesign interface.
5. Using the new track’s Output selector, select the main outputs for your session.
6. Record-enable this track by clicking the Record Enable button in either the track’s channel strip (Mix window) or the track menu (Edit window).

Now you should hear the sound coming out of your MIDI device as you play your MIDI performance.

Recording MIDI tracks

After you’ve record-enabled your MIDI track(s) (see the “Enabling recording for MIDI tracks” section, earlier in this chapter), you can begin recording. Follow these steps to record one or more MIDI tracks:

1. Click the Record Enable button located in either the track channel strip (Mix window) or track menu (Edit window) to record-enable the track(s).
2. Using the channel strips located in the Mix window, set the level of the instruments in your session using the fader for each audio track associated with your MIDI devices.

This is so you hear your music the way you want.
3. Enable the click track and the pre-roll if you're using them.

4. Click the Return to Zero button in the Transport section of the Transport window.
   Doing so ensures that you start recording at the beginning of the session.

5. Click the Record button in the Transport section of the Transport window.
   This step gets you ready to record; it doesn’t start the actual recording process.

6. Click the Play button in the Transport section of the Transport window.
   Pro Tools starts recording.

7. When you’re done recording, click the Stop button in the Transport section of the Transport window or press the Spacebar on your keyboard.
   The finished take appears in the MIDI Regions list as a new region.

Playing Back Your Tracks

After you’ve recorded a track, most likely you’ll want to listen to it to make sure that it’s sounds the way you want it to sound. Pro Tools offers you many ways to play a track back. In this section I guide you through a few of the many options for playing back audio regions.

Playing recorded tracks

After you record a track and click the Stop button, you can immediately hear the track by toggling off the Record Enable button on your MIDI tracks — click it to make the red light disappear — and then clicking the Play button. Leave the audio tracks associated with the MIDI devices in record-enable mode so that you hear the playback of the MIDI device from the recorded MIDI data instead of the recorded audio that was recorded to that track when you recorded your performance. You can adjust the volume by moving the fader in the channel strip for the audio track associated with your MIDI device up and down.

Setting scrolling options

Pro Tools lets you decide how you want the Edit window to scroll when a session is playing or recording. Just choose Operations ➤ Scroll Options from the main menu and you’ll see the choices displayed in Figure 2-2. The following list gives you the scoop on each option:
No Auto-Scrolling: With you choose this option, the Edit window remains where it is as the session plays. You can still move through the session by manually sliding the scroll bar at the bottom of the window as the session plays.

Scroll After Playback: This option takes you to where the cursor is located once the session has been stopped.

Page Scroll During Playback: Page scrolling during playback keeps the cursor visible at all times as the session plays. The cursor moves from left to right and the Edit window follows gamely along, just like Little Bo Peep’s sheep.

This is the option I generally choose because I can easily keep track of where I am in the session at all times.

Changing sounds

One of the great features of recording MIDI data is that you can change the sound that the recorded performance plays. This lets you decide what sound you use in your song after you’ve played the part.

You can change the playback sound of a recorded MIDI track one of two ways:

Change the MIDI Device or Channel: Click the Output selector for the MIDI track and scroll to a different MIDI channel or MIDI device.

Change the MIDI Patch: Click the Patch pop-up menu located in the Track Controls section of the Edit window, as shown in Figure 2-3. After the Patch window opens, as shown in Figure 2-4, choose a patch from the list and then click Done to close the window.
Getting Rid of Unwanted Takes

If you have a take (recorded performance) that you don’t particularly like, you can get rid of it several different ways. You can cancel the take as you’re recording, you can undo the take after you’ve recorded, or you can clear the audio region from the Audio Regions list. All of these options are detailed in this section.

**Canceling your performance**

Canceling a performance is handy when you’re in the middle of recording and you know that you’re not going to keep the take. To cancel a performance, simply press Command+period (on a Mac) or Ctrl+period (on a PC). This will stop the session and clear the audio region created for this take with two keystrokes.

**Undoing your take**

If you’ve already stopped recording and you know you don’t want to keep your latest try, you can undo the take by choosing Edit→Undo MIDI Recording.
from the main menu (as shown in Figure 2-5), or by pressing Command+Z (on a Mac) or Ctrl+Z (on a PC).

If you punched in more than once before you stopped the recording, only the last punch is undone. The rest of the punches remain.

When you use Loop record mode, all the takes from the loop sequence are undone.

Clearing the file from the MIDI Regions list

If you decide, after hearing a few of your takes, that you want to get rid of one or more of them, you can clear the offending takes from the MIDI Regions list. Here’s how to get that done:

1. **Highlight the region you want to get rid of in the MIDI Regions list by clicking it.**

   The MIDI Regions list is located in the lower-right corner of the Edit window, right below the Audio Regions list. If this section of the Edit window isn’t visible, click the double arrow at the bottom-right corner of the Edit window to expand it.
2. Click-hold the MIDI Regions list title ("MIDI") at the top of the list to access the MIDI Regions pop-up menu and then choose Clear Selected (as shown in Figure 2-6), or press Shift+Command+B (on a Mac) or Shift+Ctrl+B (on a PC).

To select more than one region to clear, press and hold the Shift key as you click each region.

---

**Overdubbing MIDI Performances**

Once you have some MIDI performances recorded, you can add to or change them easily. The time-honored name for this kind of recording is **overdubbing** — but MIDI takes it to a whole new level. In Pro Tools, you can overdub MIDI in several ways: You can punch in or out, loop, and either **merge** (that is, add) new data or replace existing performance information. This section gets you up to speed on these procedures.

**Using MIDI Merge/Replace**

When you overdub to a MIDI track, Pro Tools offers you the option to either replace existing material or add new data to it. Which option you use depends on the position of the MIDI Merge button located in the Transport window, as shown in Figure 2-7.

- When the button is engaged (MIDI Merge mode), new material is merged with any existing MIDI data on the record-enabled track(s).
- When the button is disengaged (MIDI Replace mode), new MIDI data replaces any existing information on record-enabled track(s).

---

**Figure 2-6:**
Choosing Clear Selected from the MIDI Regions pop-up menu gets rid of a selected MIDI region.
To engage MIDI Merge, do the following:

1. Open the MIDI controls section of the Transport window by choosing Display ➪ Transport Window Shows ➪ MIDI Controls from the main menu.
   The Transport window expands to include the MIDI controls section.

2. Click the MIDI Merge button.
   The button becomes highlighted.

**Punching in and out**

If you like some of your initial take and only want to record over part of it you can set points at which to start and stop recording within the session. This is called **punching in and out**. Punching in or out of a track involves first setting a Start and End point. This can be done several ways; the next sections give you the details.

**Using the Start/End fields in the Transport section of the Transport window**

This method is pretty straightforward. To set your Start and End points using the Transport section, just do the following:

1. Choose Displays ➪ Transport Window ➪ Expanded View from the main menu to get a nice, big view of the window.

2. Click in the Start field in the Transport section of the Transport window, type in the beginning of the punch section you want, and then press Enter.
This field will be displayed in the same format as the main counter. In the case of Figure 2-8, the format is Bars and Beats.

3. **Click in the End field, type in the end of the range, and then press Enter.**

   This field is displayed as well in the format selected for the main counter (as in Figure 2-8).

---

**Selecting a section of a track’s playlist**

For those of you out there who are especially handy with a mouse, this method may have some appeal:

1. **Make sure that the Link Edit and Timeline Selection option is chosen under the Operations menu.**

2. **Using the Selector tool, click-drag a recorded range in your track, as shown in Figure 2-9.**

   The section becomes highlighted and the session Start and End points are set to match the beginning and ending of this selection.

---

**Figure 2-8:**
Typing in the Start and End points in the appropriate field sets your punch range.

**Figure 2-9:**
Selecting a recorded range from a track’s playlist is as simple as clicking and dragging it.
**Dragging the Start and End point markers along the ruler bar**

The Start and End markers are displayed along the Timeline in the Edit window as up and down arrows — down for punch in and up for punch out. The arrows are blue when no tracks are record-enabled and red when one or more tracks are record-enabled. Setting Start and End points in the Timeline consists of these steps:

1. **Make sure that the Link Edit and Timeline Selections is chosen under the Operations menu.**

2. **Select the Grid edit mode (click on the Grid mode selector in the upper left of the Edit window) if you want the markers to snap to the grid, otherwise use any other Edit mode.**

3. **Click-drag the Start and End Point arrows to where you want them, as shown in Figure 2-10.**

![Figure 2-10: You can set a punch range by dragging the Start and End Point arrows.](image)

**Performing the punch**

After you have designated the Start and End points of your punch-in-and-out range, you can record to that section by doing the following:

1. **Set and enable a pre-roll.**

   Doing so enables you to hear the previously recorded track before the punch-in happens. Here’s the quick drill. (See Book 3, Chapter 4 for details.)

   a. Click the Pre-Roll field in the expanded version of the Transport window and type in a pre-roll time. (Choose Display ➪ Transport Window Shows ➪ Expanded if you need to expand the window.)

   b. Click the Pre-Roll button in the expanded version of the Transport window to enable the pre-roll function.
2. **Set and enable a post-roll.**

   Doing so lets you hear how your punch fits in with your previously recorded track. Here’s the quick drill. (See Book 3, Chapter 4 for details.)

   a. Click the Post-Roll field in the expanded version of the Transport window and type in a pre-roll time. (Choose Display ➪ Transport Window Shows ➪ Expanded if you need to expand the window.)

   b. Click the Post-Roll button in the expanded version of the Transport window to enable the post-roll function.

3. **Choose the nondestructive record mode by making sure that destructive, loop, and quick-punch modes are disabled in the Operations menu.**

4. **Choose either MIDI Merge or MIDI Replace mode.**

   See the “Using MIDI Merge/Replace” section, earlier in the chapter, for more on MIDI Merge/Replace.

5. **Click the Record Enable button in either the track’s channel strip (Mix window) or the track menu (Edit window).**

   The track is record-enabled.

6. **Click the Record button in the Transport section of the Transport window.**

   The Record button flashes red.

7. **Click the Play button in the Transport section of the Transport window when you’re ready to record.**

   The session starts at the pre-roll time, the Record button flashes red, and you hear the previously recorded track until the pre-roll is over. The monitoring then switches to the Input source and the Record button stops flashing (but remains red). Once you hit the end of the record range, the session either stops playing or (if you’ve enabled a post-roll) the recording stops. If the recording stops to accommodate a post-roll, the Record button starts flashing again. The monitoring then switches back to the recorded region until the end of the post-roll period. When the post-roll is done, the session stops playing.

**Punching MIDI on-the-fly**

With MIDI you can punch in and out of a track while the session plays. This is called *punching on-the-fly* and is especially effective if you have a Digi 002, 002 Rack, or 001 — and a footswitch connected to the footswitch input on your interface.
To punch on-the-fly

1. Choose the nondestructive record mode by making sure that destructive, loop, and quick-punch modes are disabled in the Operations menu.

2. Select either MIDI Merge or MIDI Replace mode.

   See the “Using MIDI Merge/Replace” section, earlier in the chapter, for more on MIDI Merge/Replace.

3. Disable the Wait for Note and Countoff options in the Transport window.

4. Click the Record Enable button in either the track’s channel strip (Mix window) or the track menu (Edit window).

   The track is record-enabled.

5. Click the Play button in the Transport section of the Transport window.

   The session plays.

6. When you reach the point where you want to start recording in the session, click the Record button or press the footswitch.

   The punch begins. Play what you want to go in there.

7. When you reach the point that you want to stop recording, click the Record button or press the footswitch again.

   Recording stops but the session continues playing — with any luck, seamlessly.

Loop recording

Loop recording lets you choose a section of the song to repeatedly record over. This makes it easy to try a bunch of takes without having to manually start and stop every time you go through the section. Loop recording can be done a bunch of ways. I described two of ‘em in the Audio Recording chapters (Book 3, Chapters 3 and 4), but I prefer using MIDI Merge mode to loop-record MIDI (makes sense, doesn’t it?)

To loop-record using MIDI Merge mode, do the following:

1. Choose the nondestructive record mode by making sure that destructive, loop, and quick-punch modes are disabled in the Operations menu.

2. Enable MIDI Merge mode.

   The button becomes highlighted.
3. Disable the Wait for Note and Countoff options in the Transport section of the Transport window.

4. Enable the Link Edit and Timeline Selection option in the Operations menu.

5. Choose the Selector tool in the Edit window.

6. Click-drag across the section of the track that you want to record over.

7. Click in the Pre-Roll field in the expanded Transport window and type in a pre-roll time. Click the Pre-Roll button in the Transport window to enable the pre-roll function. (Choose Display ➤ Transport Window Shows ➤ Expanded if you need to expand the window.)

   If you don’t want to hear a section of the session before the loop begins skip this step.

8. Click the Record Enable button located in either the track channel strip (Mix window) or track menu (Edit window) to record enable the track.

9. Select Loop Record mode. You’ve got a three ways to make this selection:
   - Check the Loop Record option under the Operations menu.
   - Press Option+L (on a Mac) or Alt+L (on a PC).
   - Ctrl+click (on a Mac) or right-click (on a PC) the Record button in the Transport window until the Loop Record icon shows up.

10. Click Play in the Transport section of the Transport window to start recording.

    While the recording is under way, the new MIDI data appears in the track as a new region (and in the MIDI Regions list) — but doesn’t replace the previously recorded material.

11. Click Stop when you’re finished recording.

    If you designated a pre-roll, it only happens before the first time through the loop. After that, the loop goes from Start point to End point, back to the Start point, and so on, as many times as needed.

    If you loop-record using the Loop Record mode without engaging MIDI Merge, then each time you go through the loop, you create a new region in the MIDI Regions list. This is in contrast to loop-recording audio tracks, where all the takes are stored in one audio file.
Recording System-Exclusive Data

In Pro Tools, you can record system-exclusive data — data that is unique to your MIDI device — to a MIDI track. That means you can record changes made to your patches (prepared sounds selected from a sound bank), to your configuration, and any real-time changes in the system. For example, you can record patch changes so your MIDI device changes its sound as the session plays (from, say, a Chainsaw patch to a Bagpipe patch). You can also store the parameter settings for a device and have Pro Tools automatically restore those settings to your device before your session plays.

To record system-exclusive data to a MIDI track in Pro Tools, do the following:

1. Connect the MIDI Out of your device to one of the MIDI In ports configured in Pro Tools.
2. Choose File ➪ New Track from the main menu.
   The New Track dialog box appears.
3. Use the drop-down menus of the dialog box to enter the number of tracks you want (1), the type (MIDI), and whether you want your track in mono or stereo.
4. Use the new track’s Input selector, set the input of the track to the MIDI In port that’s connected to your device.
5. Choose the non-destructive record mode by making sure that destructive, loop, and quick-punch modes are disabled in the Operations menu.
6. Choose MIDI ➪ Input Filter from the main menu.
   The MIDI Input Filter dialog box appears.
7. Enable system-exclusive recording by checking the System Exclusive check box in the MIDI Input Filter dialog box.
8. Enable the Wait for Note function in the Transport.
9. Click the Return to Zero button in the Transport window to return to the beginning of the session.
10. Click the Record Enable button in either the track’s channel strip (Mix window) or the track menu (Edit window).
   The track is record-enabled.
11. Click the Record button in the Transport section of the Transport window.
   The Record, Play, and Wait for Note buttons flash.

12. Initiate the MIDI dump on your MIDI Device. (Check your MIDI device’s manual to figure how this is done; it’s different for every device.)
   The transfer begins.

13. Click Stop when the transfer is finished.

To send system-exclusive data back to your device, do the following:

1. Make sure that the MIDI Out port of your MIDI interface is connected to the MIDI In port of your device.

2. Using the Output selector of the MIDI track that has the system-exclusive data, set the output to the MIDI port that’s connected to your device.

3. Set your device to receive system-exclusive data. (You may need to check your owner’s manual for details on how to do this.)

4. Click the Return to Zero button in the Transport section of the Transport window to return the session to the beginning.

5. Click Play in the Transport window.
   The session plays and the system-exclusive data is received.

6. Click Stop when the transfer is complete.
Chapter 3: Editing MIDI Data

In This Chapter

- Understanding MIDI track view
- Selecting MIDI data
- Editing in the Edit window
- Understanding the MIDI Event window

Although MIDI editing in Pro Tools isn’t as elaborate as what you find in programs like Logic or Sonar, it’s plenty powerful enough to tweak your MIDI data quite a bit. If your overall MIDI needs are moderate, the relatively simple Pro Tools MIDI features can do what you need with minimum fuss.

In this chapter, you explore the MIDI-editing functions available to you in Pro Tools. You examine the many uses of the Pencil tool, discover ways to edit MIDI notes, controller data, and system-exclusive messages.

Working with MIDI Tracks

Working with MIDI tracks is almost the same as working with audio tracks. (The latter are covered in great detail in Book 4, Chapters 1 and 2.) This section explains track views, selecting MIDI data, understanding regions, and setting default program changes.

Taking a look at track views

You can adjust the track view for MIDI tracks by clicking the Track View selector in the Track Controls section of the Edit window, as shown in Figure 3-1. The track views for MIDI tracks include the following options:

- Blocks: In Blocks view, regions are displayed as blocks, each showing only the region name. This view takes up the least amount of processing power to show and redraw — that makes it the best option after all your editing is done and you’re ready to start mixing.

- Regions: Regions view shows the regions in the track, also displaying notes in the track in the piano-roll fashion you see in Figure 3-2. The notes can’t be edited but the regions can be. This view is useful when you want to move or edit the regions in your track.
When you edit in the Regions view on a MIDI track, you edit continuous controller events (volume, pitch bend, aftertouch) along with the region because such events are connected to the region and not to the track’s playlist.

✦ **Notes:** The Notes view displays the location, pitch, and duration of the notes in the track in piano-roll format (as in Figure 3-3). You can edit or insert MIDI notes in this view.

MIDI notes are shown as small rectangles — the horizontal range represents the location and duration of the note; the vertical placement shows the note’s pitch.

Along the left side of the track’s playlist is a representation of a keyboard with up and down arrows, which allow you to scroll through the octaves of the notes. This is necessary because not all the possible MIDI notes can be displayed in the track’s playlist at one time. A single line at the top or bottom of the track display designates any notes that can’t be displayed (because they’re above or below the octave being displayed).

You can also scroll through the octaves in the playlist by using the Grabber tool and dragging the piano-roll display up and down.

✦ **Velocity:** This view displays — and allows you to edit — velocity (note volume) settings for each note in the track. (You can still see the piano-roll data in the background.)
✦ **Volume**: The Volume view shows automation volume curves with breakpoints — markers that show shifts in the automation level — displayed as dots along the line. Note data, in piano-roll format, is shown in the background. In this view, you can edit the volume data but not the underlying notes.

✦ **Pan**: This view displays — and lets you adjust — panning automation data (far left at the top and far right at the bottom) with the piano-roll display in the background.

✦ **Mute**: This view shows mute automation settings for the track — and allows you to mute or unmute the track. Note data, in piano-roll format, is shown in the background.

✦ **Pitch Bend**: The Pitch Bend view shows any pitch bend data in the track as a line graph with editable breakpoints. The piano-roll data is shown in the background but can’t be edited.

✦ **After Touch**: This view shows aftertouch data — the velocity of the note after the initial touch of the keyboard — as a line graph with editable breakpoints. The piano-roll data is shown in the background to help you know where you are in the session.

✦ **Program Change**: This view displays program-change information for the track with the piano-roll data in the background (uneditable, of course). Use this view to add or edit program-change events.

✦ **Sysex**: This view shows system-exclusive data — messages exclusive to the MIDI device — for the track.

✦ **Controller**: This view shows continuous controller data, such as modulation wheel, breath controller, foot control, and sustain with the piano-roll data in the background. Use this view to add or edit continuous controller data for your track.

You can toggle between the two most-used MIDI track views: Regions and Notes. Do this by pressing Start/Windows (on a PC) or Ctrl (on a Mac) while you press the minus key on the alpha section (the main section) of the keyboard or simply press the minus key (alpha section) after having engaged the Command Keyboard Focus button. (See Book 2, Chapter 4, for more on the Command Keyboard Focus feature.)
Selecting track material
You can select track material the same way you select material from audio tracks — well, okay, with a few variations. This section tells you about those variations; Book 4, Chapter 2 covers the selection stuff about audio tracks that’s perfectly applicable to MIDI tracks. (You may want to skim through Book 4, Chapter 2 to refresh your memory about selection basics.)

MIDI notes are selected from the Notes view; regions are selected from the Regions view.

Selecting notes with the Pencil tool
You select notes with the Pencil tool by clicking the notes. (No big deal, right?) To select more than one note, press the Shift key as you click each of the notes. Selected notes become highlighted.

Using the Selector tool
When you use the Selector tool to select notes, certain conditions apply. They’re pretty straightforward:

✦ Before a note can be included in a selection, its Start point must be in the selection range. In Figure 3-4, for example, the note whose Start point begins before the selection range is not selected. (You can tell it’s not selected because it’s not highlighted.)
✦ Notes with their End points outside the selection range are still selected.
✦ When you select notes using the Selector tool, you also select (automatically) all the underlying automation and controller data pertaining to the notes.

Figure 3-4:
The Selector tool selects notes only if the start time is included in the selection range.
Grabbing with the Grabber tool

When you select a series of notes with the Grabber tool, all notes partially or fully contained in the Grabber selection are selected, as shown in Figure 3-5. Notes selected with the Grabber tool don’t include automation or controller data.

Selecting notes from the mini keyboard

You can select all the notes in a track that have the same pitch by clicking the represented MIDI note in the minikeyboard located along the left side of the track’s playlist display, as shown in Figure 3-6.

Recognizing regions

The procedures for working with MIDI regions are the same as those for audio regions. Book 4, Chapter 1 describes how to select and view regions in a track’s playlist, as well as how to work with regions in the Audio Regions list. The procedures for working with the MIDI Regions list are the same as those for working with the Audio Regions list, so if you check out Book 4, Chapter 1, you’re all set.
**Setting MIDI patches on tracks**

You can change the default program (sound patch) in use with your MIDI tracks so your MIDI device automatically resets to the program you want for your track. Here's how to make it happen:

1. **Click the Program button in the Track Controls section of the Edit window, as shown in Figure 3-7.**

   The Patch Select dialog box opens.

2. **Click the patch number or name that you want from the list in the main section of the dialog box. It becomes highlighted.**

   Depending on your MIDI device, you may need to specify a bank along with the patch number. The bank number is entered in one of the Controller fields at the top of the dialog box. Check the specification for your device to see what to enter in this field.

3. **Click Done.**

   The Patch Select dialog box closes and the patch number/name is displayed on the Program button of the Track Controls section.

**Dealing with Note Chasing**

*Note chasing* makes sure that when you start your session in the middle of a long MIDI note, the note is played. This is useful when you want to start and stop the session from anywhere and still be able to hear the notes that are recorded.
The Note Chasing feature is turned on by default, but you may want to turn it off on any tracks that you have playing loops (doing so ensures that the loop doesn’t get out of synch when you start and stop the session in the middle of its sequence).

To turn on and off Note Chasing, do the following:

1. **Click the track’s Playlist selector, located in the Track Controls section of the Edit window.** (The selector is the arrow to the right of the name of the track.)
   
The Track Playlist pop-up menu opens with an option for engaging note chasing in the track.

2. **Choose Note Chasing from the Track Playlist menu.**
   
   You uncheck to turn the Note Chasing feature off and check to turn it on.

**Editing MIDI in the Edit Window**

As with audio, you do most of your MIDI editing from the Edit window. The process, again, is very similar to editing audio (described in Book 4, Chapters 1, 2, and 3). This section offers some tips and tricks tailored to inserting, deleting, and editing MIDI data — but for the most part you’re going to hear about the amazing Pencil tool, Smart tool, and Grabber tool.

If your MIDI region exists in only one location (that is, it’s not shared with other tracks or sessions), then any changes you make to the data in that region change it permanently. If you want to ensure that you don’t lose important data while editing (or want to be able to return to the original), make a copy of the playlist and work from there. (I explain playlists in detail in Book 4, Chapter 1.)

**Perusing the Pencil tools**

Pro Tools offers five Pencil tools — Free Hand, Line, Triangle, Square, and Random — that let you create and edit MIDI data easily with your mouse. You select these tools by clicking and holding the Pencil Tool icon and then choosing from the pop-up menu that appears, as shown in Figure 3-8. Each of these tools can be used to add notes and draw velocity and controller data, but each one works a little differently, as the following list makes clear:

- **Free Hand**
   
   When you insert notes, here’s what happens:
   
   You can place them anywhere you want and drag your mouse to specify the duration you want the note to be.
If you simply click with the Free Hand Pencil tool to insert a note, the note duration is equal to the grid value for your session. (Grid values are boundaries you can set for your session and are set in the Grid Value drop-down menu, located just below the Pencil Tool button in the Edit window.)

Note velocity is determined by the setting you have in the MIDI tab of the Preferences dialog box. (Choose Setups ➤ Preferences to access the Preferences dialog box.)

When you draw velocity or continuous controller data, here’s what happens:

- You can draw any shape you want with your mouse.
- The resolution of the lines is determined by the settings you’ve chosen for controller data in the MIDI tab of the Preferences dialog box. (Choose Setups ➤ Preferences to access the Preferences dialog box.)

✦ **Line**

When you insert notes, here’s what you get:

You can place as many notes as you want as a single pitch.

The note duration is equal to the current grid value in your session.

The note velocity is determined by the setting you have in the MIDI tab of the Preferences dialog box.

When you draw velocity or continuous controller data, these conditions apply:

- The line is straight from the initial mouse click through the drag and release.
- The resolution of the lines is determined by the settings you have chosen for controller data in the MIDI tab of the Preferences dialog box.

---

**Figure 3-8:** Pencil tools in five shapes for creating and editing MIDI data.
✦ Triangle

When you insert notes, three conditions apply:

You can place as many notes as you want as a single pitch.

The note duration is equal to the current grid value in your session.

The note velocity oscillates between the setting you have for Note On Velocity in the MIDI tab of the Preferences dialog box and 127 (maximum level).

When you draw velocity or continuous controller data, here’s what you see:

The line is a triangular pattern, which changes direction according to the current grid value in your session.

The resolution of the lines is determined by the settings for controller data you have chosen in the MIDI tab of the Preferences dialog box.

✦ Square

When you insert notes, here’s the skinny:

You can place as many notes as you want as a single pitch.

The note duration is equal to the current grid value in your session.

The note velocity alternates between the setting you have for Note On Velocity in the MIDI tab of the Preferences dialog box and 127 (the maximum level).

When you draw velocity or continuous controller data, it works this way:

The line is a square pattern, which repeats according to the current grid value in your session.

The resolution of the lines is determined by the settings you have chosen for controller data in the MIDI tab of the Preferences dialog box.

✦ Random

When you insert notes, here’s what you get:

You can place as many notes as you want as a single pitch.

The note duration is equal to the current grid value in your session.

The note velocity changes randomly between the setting you have for Note On Velocity in the MIDI tab of the Preferences dialog box and 127 (maximum level).

When you draw velocity or continuous controller data, the line is a random pattern, which changes value according to the current grid value in your session.
**Custom note duration**

When you insert a note using one of Pencil tools and you want a different value than the grid setting in your session you can choose the Custom Note Duration option located at the bottom of the Pencil Tool pop-up menu. Enabling this option adds the Notes button you see here in the margin beneath the Pencil Tool icon on the Edit Window toolbar.

The Custom Note Duration option lets you specify a note duration other than your current grid setting.

To choose a custom note duration when you’re inserting a MIDI note, do the following:

1. **Click-hold on the Pencil button in the Edit window toolbar.**
   
   The Pencil Tool pop-up menu appears.

2. **Select the Custom Note Duration option from the Pencil Tool pop-up menu.**

   The Notes button appears beneath the Pencil button in the Edit Window toolbar.

3. **Select the Pencil tool you want to use from the pop-up menu.**

4. **Using the Notes button beneath the Pencil Tool button, choose a note duration.**

5. **Using the Pencil tool you selected in Step 3, insert the note in your track.**

**Adding MIDI events**

You can add MIDI notes or controller data (collectively called MIDI events) to a MIDI track by using the Pencil tool (see the previous section for more about the Pencil tools).

**Inserting notes**

To use the Pencil tool to insert a note, do the following:

1. **Using the Track View pop-up menu in the Track Controls section of the Edit Window, set the track view to Notes.**

2. **Click-and-hold the Pencil button and then select the Pencil tool you want to use from the Pencil Tool pop-up menu that appears.**

3. **Locate the place you want to add your MIDI note in the track’s playlist area.**

4. **Using the Pencil tool you selected in Step 2, click in the playlist to insert a note with a duration equal to the grid value.**
When you use the Free Hand tool, you can make the note to whatever duration you want. Do so by clicking the Start point of the note in the track’s playlist, dragging to the End point you want, and then releasing the mouse button.

If you want to hear the MIDI note as you insert it, first make sure that you have the Play MIDI Notes When Editing preference chosen in the MIDI tab of the Preferences dialog box. (Choose Setups ➤ Preferences to access the dialog box.)

If you have the Grid mode enabled as your editing mode, the inserted note is snapped to the nearest grid boundary. To disable this function, press Ctrl (on a PC) or Command (on a Mac) as you insert the note. (Book 4, Chapter 1 has more on editing modes.)

**Drawing velocity or continuous controller data**

To draw velocity or continuous controller data in a track’s playlist, do the following:

1. Using the Track View pop-up menu in the Track Controls section of the Edit Window, set the track to Velocity or Controller view.

2. Click and hold the Pencil button and then select the Pencil tool you want to use from the menu that appears.

3. Locate the place where you want to enter your MIDI data in the track’s playlist.

4. Using the Pencil tool you selected in Step 2, click and drag in the track’s playlist to sketch in the velocity or the controller level you want to draw.

5. Release the mouse button when you reach the end point of your edit.

**Inserting program changes**

To insert MIDI program changes, do the following:

1. Using the Track View pop-up menu, set the track to Program Change view.

2. Click and hold the Pencil button and then select the Pencil tool you want to use from the menu that appears.

3. Click in the track’s playlist at the location you want the change to occur.

   The Patch Select dialog box opens.

4. Click the patch number or name in the main section of the dialog box to select it.
5. Click Done.

The program change is inserted, as shown in Figure 3-9.

Figure 3-9: A program-change event appears in the track's playlist when Program Change view is selected.

Deleting MIDI data
You can delete MIDI notes and other data several ways. This section details the process.

Deleting a MIDI note
To delete a MIDI note, do the following:

1. Using the Track View pop-up menu, set the track view to Notes.

2. Using either the Grabber tool or the Selector tool, select the note in the playlist you want to delete.

3. Press Delete on your keyboard or choose Edit: Clear from the main menu.

Instead of Steps 2 and 3 just given, start out with the Pencil tool. Then press Alt (on a PC) or Option (on a Mac) to change the pencil into an eraser, and click the note to delete it.

If you use the Selector to select the note, all automation and controller data is deleted along with the note.

Deleting a program change
To delete a program change, do the following:
1. **Using the Track View pop-up menu, set the track view to Program Change.**

2. **Select the program change you want to delete:**

   Using the Grabber tool, either click the event or drag across it to select it. (If you drag, you can include other MIDI events in your selection to delete them as well.)

   Using the Pencil tool, press Alt (on a PC) or Option (on a Mac) while you click the event. (You won’t need to perform Step 3 using this procedure, because the event is automatically deleted.)

3. **Press Delete on your keyboard or choose Edit → Clear from the main menu.**

   The event is deleted.

**Changing MIDI events**

In the Edit window, you can edit MIDI notes in a variety of ways including changing pitch, duration, velocity, and time location.

When you edit or move notes, you can make a copy of the note to move by pressing Option (Mac) or Ctrl (PC) as you drag the note.

**Changing a note’s pitch**

To change a note’s pitch, do the following:

1. **Using the Track View pop-up menu, set your track to Notes view.**

2. **Select the Pencil or Grabber tool.**

3. **Press Shift to keep the note’s start point from changing as you move it.**

4. **Click the note and drag it up (higher pitch) or down (lower pitch) in the playlist.**

5. **Release the mouse button when the note is where you want it.**

**Changing a note’s duration**

To change a note’s duration — its Start or End points — do the following:

1. **Using the Track View pop-up menu, set your track to Notes view.**

2. **Select the Pencil tool.**

3. **Using the Pencil tool, click on the note you want to change.**

   Press Shift as you click to select more than one note.
4. **Click the Start or End point of the note and drag it left or right.**

   If your edit mode is set to Grid, the note is moved along the grid boundary. If you’re using the Spot edit mode, the Spot dialog box appears; there you can type in a location for the note and then click Done.

5. **Release the mouse button when the note is where you want it.**

---

**Changing a note’s velocity**

In the MIDI world, velocity means volume. To change a note’s velocity, do the following:

1. **Using the Track View pop-up menu, set your track to Velocity view.**

2. **Select the Grabber tool.**

3. **Click the diamond-shaped icon at the top of the velocity stalk — the vertical line with a diamond at the top representing the velocity level — in the track’s playlist and drag it up or down.**

4. **Release the mouse button when the velocity is where you want it.**

   You can also use one of the Pencil tools to draw various velocity shapes. This is done by selecting the desired Pencil tool and drawing a line in the track’s playlist where you want the velocities to be. (See “Perusing the Pencil tools” section, earlier in this chapter, for more on drawing velocity settings.)

   You can scale the velocities of several notes by using the Selector to select the notes and the Trimmer to drag them up or down as a unit. This lets you keep the relationship between the velocities the same as you change the overall levels.

---

**Changing time locations**

Time locations define where the Start points of your notes are placed within your session. To change a note’s time location, do the following:

1. **Using the Track View pop-up menu, set your track to Notes view.**

2. **Select the Pencil or Grabber tool.**

3. **Press Shift to keep the note’s pitch from changing as you move it.**

4. **Click the note and drag it left or right.**

   If your edit mode is set to Grid, the note is moved along the grid boundary. If you’re using Spot edit mode, the Spot dialog box appears; there you can type in a location for the note and then click Done.

5. **Release the mouse button when the note is where you want it.**
**Moving notes freely**

To move a note freely in the track, do the following:

1. Using the Track View pop-up menu, set your track to Notes view.
2. Select the Pencil or Grabber tool.
3. Click the note and drag it left or right, up or down.
4. Release the mouse button when the note is where you want it.

**Editing note attributes**

To edit a note by changing note attributes as displayed in the MIDI Event List, do the following:

1. Using the Track View pop-up menu, set your track to Notes view.
2. Click the note using the Pencil or Grabber tool.

The note’s attributes show up in the MIDI Event List window with a blue highlight (as shown in Figure 3-10).

3. Click in the Attribute field you want to change in the box.

Your options include:

- **Start:** This field indicates the Start point of the selected note. This is displayed in the main time scale setting for the session.
- **End:** This field controls the End point of the note, which is displayed in the main time scale format. If this field isn’t visible, click the Options button at the top of the MIDI Event List dialog box and choose Show Note End Time from the menu that appears.
Editing MIDI in the Edit Window

- **Length/Info**: This field displays the duration of the note (shown in the session’s main time scale). Changing the Start or End times also changes this value. Changing this field alters the End point but leaves the Start point untouched. MIDI events without length data, such as program changes or controller events, show data associated with that data, such as the program number or controller event type. If this field isn’t visible, click the Options button at the top of the MIDI Event List dialog box and choose Show Note Length from the menu that appears.

- **Pitch**: This field displays the pitch of the note.

- **Attack Velocity**: This field shows the velocity of the start of the note as a MIDI value between 0 and 127.

- **Release Velocity**: This field displays the release velocity of the note as a MIDI value between 0 and 127.

4. Enter in the new value in the field corresponding to the attribute you want to change.

5. Click Return (on a Mac) or Enter (on a PC).

   The note changes to match the new attributes.

   **TIP**

   If you want to change more than one field, press the Slash key to move between fields.

**Editing program data**

Since MIDI contains no sound in itself, you can create program change events to change the sound patches of your MIDI sound modules throughout the session. This can keep your computer processing resources optimized and keep you from using more tracks than absolutely necessary for your session, which is a good thing since Pro Tools allows you to have no more than 32 active tracks playing in a session.

**Changing program patches**

Program patches are the sounds available in your MIDI device. To change program patches:

1. Using the Track View pop-up menu, set the track to Program Change view.

2. Using the Grabber tool, double-click the program change event you want to change.

   The Patch Select dialog box appears.
3. In the Patch Select dialog box, select the new patch name/number. (If the patch resides on a different bank as the current patch, select the new bank as well.)

4. Click Done.

The Patch Select dialog box closes and the new program is sounded when you play your session.

**Moving program change markers**

Program change markers are helpful little tools because they tell Pro Tools when to change the sound of your MIDI device as your session plays. To move a program change marker:

1. Using the Track View pop-up menu, set the track to Program Change view.

2. Select the Grabber or Pencil tool.

3. Click-drag the Program Change Marker left or right.

If you have Grid mode enabled, the program change event moves to the closest grid boundary. If you have Spot mode selected, the Spot dialog box opens; there you can enter a new location for the marker and then click Done.

**Changing continuous controller data**

When you deal with continuous controller data, you are dealing with Volume, Pan, Pitch Bend, After Touch, and MIDI controllers. All this data is represented as a line graph punctuated by a series of breakpoints. You have a choice when you want to make changes: you can edit the line itself using the Pencil tool or you can edit the breakpoints using the Grabber, Pencil, or Smart tool.

**Editing lines with the Pencil tool**

To edit the line graph with a Pencil tool, do the following:

1. Using the Track View pop-up menu, select the track view that corresponds to the parameter you want to edit (Volume, Pan, Pitch Bend, After Touch, MIDI Controller).

2. Click and hold the Pencil button, and then select the Pencil tool you want to use from the menu that appears.

3. Click in the playlist where you want to start drawing and drag your mouse to draw the new values.
The line is drawn and breakpoints are inserted according to the resolution you’ve set for the Pencil Tool Resolution When Drawing Controller Data option in the MIDI tab of the Preferences dialog box. (Choose Setups > Preferences from the main menu to access the Preferences dialog box.)

4. Release the mouse button when you reach the end of your edit.

**Editing breakpoints**

If you’re not adept at drawing lines, you might want to work with breakpoints instead. Here’s how:

1. Using the Track View pop-up menu, select the track view that corresponds to the parameter you want to edit (Volume, Pan, Pitch Bend, After Touch, MIDI Controller).

2. Select the Grabber tool.

3. Click and drag the breakpoint.

4. Release the mouse button.

**Scaling breakpoints**

When you scale breakpoints, you move a group of breakpoints while retaining the relationship between them. You can use the Trimmer tool to scale breakpoints, as in the following Steps list:

1. Using the Track View pop-up menu, select the track view that corresponds to the parameter you want to edit (Volume, Pan, Pitch Bend, After Touch, MIDI Controller).

2. Select the Selector tool.

3. Click-drag across the breakpoints you want to scale with the mouse.
   
   The selection becomes highlighted.

4. Select the Trimmer tool.

5. Click and drag the breakpoints up or down.
   
   The breakpoints move as a unit but they don’t all move the same amount. They move differently to keep the relationship between the breakpoints intact.

6. Release your mouse button.

There are other ways to edit continuous controller data in Pro Tools. Check out Book 6, Chapter 6 to find out more.
Using the Smart tool

The Smart tool puts a new spin on three older tools — the Trimmer tool, Selector tool, and Grabber tool. Basically, the Smart tool changes the way it works depending on what you try to do. This section details how this tool behaves when you work with MIDI data.

To use the Smart tool, press the button located under the Selector tool in the Edit window, as shown in Figure 3-11.

Check out Book 4, Chapter 4 for more details about the Smart tool.

Using the Smart tool in Notes view

When you use the Smart tool with your Track view set to Notes, the tool behaves the following way:

✦ Placing the cursor so that it doesn’t touch any notes or pressing Command (on a Mac) or Ctrl (on a PC) enables the Selector face of the Smart tool. You can then click and drag to make a selection.

✦ Positioning the cursor near the middle of a note enables the Grabber face of the Smart tool.

✦ Placing the cursor over the Start or End point of a note enables the Trimmer face of the Smart tool.

✦ To turn the Smart tool into an eraser, make sure the cursor isn’t touching any notes (the Selector appears) and then press Start/Windows+Alt (on a PC) or Ctrl+Option (on a Mac).

Using the Smart tool in an Automation or in Controller views

When you use the Smart tool in an Automation view (Volume, Mute, or Pan) or in Controller view, the tool acts the following ways:
Trimmer: To enable the Trimmer tool, position your cursor in the top 25% of the region. The Trimmer icon appears. You can move your cursor up and down to change the value or to create breakpoints. If you want finer control of the Trimmer tool while you work, press Ctrl (on a PC) or Command (on a Mac) after you begin trimming.

Selector: To enable the Selector tool, position your cursor in the lower 75 percent of the region. You can then drag your selection.

Grabber: To enable the Grabber tool, press Ctrl (on a PC) or Command (on a Mac). You can do several things using the Grabber tool with a track set to an automation view:

- **Edit Existing Breakpoints**: Position the cursor near one of these points and the Grabber appears. You can increase the resolution of your movements to fine-control by pressing Ctrl (on a PC) or Command (on a Mac) after you start moving the breakpoint.

- **Constrain the Grabber Vertically**: To keep the Grabber from moving right or left, press Shift or — if you’ve set the tool to fine control — press Ctrl+Shift (on a PC) or Command+Shift (on a Mac).

### Exploring MIDI Events

The MIDI Event List consists of all the MIDI data in your track. This list displays the location, pitch, velocity, and duration of every note as well as all other parameters for the track. The MIDI Event List window lets you edit all your track’s MIDI data in one place — it’s one extremely helpful tool in the Pro Tools toolbox. This section explains the ways to best use this window to edit your track.

### Exploring the MIDI Event List window

The MIDI Event List window, shown in Figure 3-12, displays MIDI data for a selected track. You can open the window in several different ways:

- Choose Windows ➤ Show MIDI Event List from the main menu.
- Press Start/Windows (on a PC) or Ctrl (on a Mac) while you double-click the MIDI track name in the Edit or Mix window.
- Press Alt+equal (=) on a PC or Option+Equal (=) on a Mac. Pressing this combination again toggles you back to the Edit window.

If you have a selection made within a MIDI track and you open the MIDI Event List window, the selected note or range of notes is highlighted.

The cursor location is marked with an arrow in the MIDI Event List.
Examining MIDI Event menus

The MIDI Event List contains three menus at the top of the window. These are the Track Selector menu, the Options menu, and the Insert menu. The following list gives you the details on the various menu options:

✦ **Track Selector**: This menu shows the track that’s currently listed in the window and lets you choose a different track to display.

✦ **Options menu**: This menu consists of the following options, shown in Figure 3-13:
  
  - **Show Sub Counter**: This option displays the event times in the sub-counter value. (Book 2, Chapter 4 has more on how to use counters.)
  
  - **Go to**: Choosing this option opens a dialog box where you enter the location in the session you want to go to.

Figure 3-12:
You can choose Windows ➪ Show MIDI Event List to open the MIDI Event List window.
• **Scroll To Edit Selection:** This automatically moves the MIDI Event List to the Edit Start or Insertion point for the session.

• **Page Scroll During Playback:** This option scrolls the MIDI Event List as your session plays.

• **Scroll During Edit Selection:** This option automatically scrolls the MIDI Event List as you move your edit point in the Edit window.

• **Show Note Length:** Checking this option displays the length of the MIDI notes in the MIDI Event List.

• **Show Note End Time:** This option lets you display the end time of the MIDI notes in the Event List instead of the note length (sorry, you can’t have both).

• **Insert At Edit Location:** This option lets you designate that any inserted event is placed at the Edit Start or Insertion point.

• **Insert At Playback Location:** This option lets you insert notes on-the-fly as the session plays back.

• **Insert At Playback Location With Grid:** This option snaps any inserted notes placed on-the-fly (see the previous bullet) to the nearest grid boundary.

• **View Filter:** This option opens the MIDI Event List View Filter dialog box, as shown in Figure 3-14. You use this dialog box to specify which fields appear in the MIDI Event List dialog box. This, in turn, effects which events are edited using Cut, Copy, and Paste — any fields that are not displayed in the MIDI Event List aren’t affected by Cut, Copy, and Paste commands. (For more about this window, see Book 5, Chapter 4.)

✦ **Insert menu:** The Insert menu consists of the types of events you can insert into the track using the MIDI Event List. This menu is covered in greater detail in the “Inserting MIDI events” section, later in this chapter.

---

**Figure 3-14:** The View Filter dialog box lets you choose what fields are displayed in the MIDI Event List.
Although it isn’t actually a menu option, the number of Events in your current track is displayed to the right of the three menus listed in this section.

**Eyeing the rest of the MIDI Event List**

Below the MIDI Event menus (see previous section) lies the whole range of possible MIDI events for the track. (Refer to Figure 3-12.) These events are listed in order from the beginning of the session to the end and are listed in three columns. (The “Inserting MIDI events” section, later in this chapter, explores these columns further.)

- **Start:** This column displays the location of the event’s Start point in either the main or sub counter time format, depending on whether you have the Show Sub Counter option checked in the Options menu. (See the “Examining MIDI Event menus” section, earlier in this chapter.)

  If more than one event is located at the same place in the session (as with chords, for example) the location for all but the first event is dimmed. This makes it easier to see these multiple events.

  To the left of the Start point is an arrow indicating the location of the cursor in the session.

- **Event:** This column shows the event type — indicated by the icon at the left of the column — as well as its associated values. In the case of notes, you see the note letter and octave as well as its attack and release velocities.

- **Length/info:** This column shows the length or End point of the MIDI notes, depending on whether you have the Show Note Length or Show Note End Time option selected under the Options menu. (See previous section.)

**Getting around the MIDI Event List**

There are several ways to move quickly around the MIDI Event List. They include these:

- Double-clicking the event in the list highlights your selection.
- Pressing Tab or the Down arrow moves you to the next event.
- Pressing Ctrl+Tab (on a PC) or Option+Tab (on a Mac) or pressing the Up arrow moves you to the previous event.
- Using the left or right arrows moves you laterally in the event list.
- Pressing Shift while you double-click or pressing Tab/arrow adds events to your selection.
- Choosing Go To from the Options pop-up menu takes you to a specific location in the event list.
- Selecting the Scroll to Edit Selection option under the Options menu lets you go automatically to the beginning of the edit selection.
Editing in the MIDI Event List

Editing in the MIDI Event list isn’t for everyone. Many people prefer the visual format offered by the Edit window, but editing in the MIDI Event List window can be faster and more accurate. This section describes the process of inserting, deleting, and editing MIDI data in the MIDI Events List.

Inserting MIDI events

Using the Insert menu, shown in Figure 3-15, you can insert the following MIDI events into your track:

✦ **Note**: Selecting Note lets you enter the start time, pitch, attack velocity, release velocity, and either the end time or duration of the notes.

✦ **Pitch Bend**: When you enter pitch bend information in the Event entry window, you include start time and the bend amount. Positive values raise the pitch while negative numbers lower it.

✦ **Volume**: The Volume Event entry window lets you enter the start time, controller number (it’s set to 7 for volume) and the volume level (0-17). The controller name appears in the far right column.

✦ **Pan**: The Pan Event entry window contains fields for start time, controller number (in this case it’s set to 10), and pan value (negative numbers pan left of center while positive numbers pan right of center). The controller name (pan) appears in the far right column.

✦ **Mono Aftertouch**: The Mono Aftertouch Event entry window offers fields for the start time and the aftertouch level (0 and 127). Aftertouch is the velocity of the note after the initial attack.

✦ **Poly Aftertouch**: The Poly (polyphonic) Aftertouch Event entry window offers fields for the start time, note name, and the aftertouch level (0 and 127).

✦ **Program Change**: The Program Change Event entry window has fields for the start time, program number, controller 0 value, and controller 32 value. The program name appears when you choose the program number.

✦ **Controller**: This option lets you designate which of the many controller events you want to enter. The event’s entry window for this option includes the start time, controller number, and the controller value. The controller number you choose determines the controller parameter you change and this parameter name shows up in the farthest column to the right.

✦ **Another (note)**: This option enters the data from the previous inserted event into fields.
To insert a MIDI note using the MIDI Event List, do the following:

1. **In the MIDI Event List window, choose Note from the Insert menu.**

   The Note Event entry window opens at the top of the MIDI event list, as shown in Figure 3-16.

2. **Enter the note in one of the following ways:**
   - Type its values in the appropriate fields.
   - Play the note or operation on your MIDI keyboard.
   - Scroll up or down in the fields.

3. **Insert the note by performing one of these commands:**
   - Press Enter (on a PC) or Return (on a Mac) on your keyboard to close the Event entry window when the event is accepted.
   - Press Enter in the alphanumeric section (not the number pad section) of your keyboard to insert the event and keep the window open.
To insert a controller event, do the following:

1. **In the MIDI Event List window, choose the controller event you want to insert from the Insert menu or choose “Controller” to specify the controller type later.**

   The Controller event’s entry window opens at the top of the MIDI event list (as shown in Figure 3-17). Unless you selected the Controller option, the name for the event appears in the far-right column.

2. **Enter the value in each of the fields in one of the following ways:**
   - Type the value into the fields.
   - Press the up or down arrows to scroll the value.
   - Drag up or down in the field by pressing Ctrl (on a PC) or Command (on a Mac) as you drag.
   - Play the controller event on your keyboard.

3. **Insert the note by performing one of these commands:**
   - Press Enter (on a PC) or Return (on a Mac) on your keyboard to close the Event entry window when the event is accepted.
   - Press Enter in the alphanumeric section (not the number pad section) of your keyboard to insert the event and keep the window open.

To insert a program change, do the following:
1. In the MIDI Event List window, Choose Program Change in the Insert menu.

The Program Change Event entry window opens at the top of the MIDI event list, as shown in Figure 3-18.

2. Enter the start time for the event.

3. Enter the program number or click the info column to open the Program Change window.

4. Insert the note by performing one of these commands:
   - Press Enter (on a PC) or Return (on a Mac) on your keyboard to close the Event entry window when the event is accepted.
   - Press Enter in the alphanumeric section (not the number pad section) of your keyboard to insert the event and keep the window open.

Deleting events

You can delete MIDI events one of two ways:

- Press Alt (on a PC) or Option (on a Mac) while you click the event using one of the Edit tools located at the top of the Edit window.
- Select the event or events (hold the Shift key as you select more than one event) in the MIDI Event list using one of the Edit tools located at the top of the Edit window and press Delete (on a Mac) or Backspace (on a PC) or choose EditClear from the main menu.
Changing data
You can edit any MIDI event in the event list several ways, including using the familiar Cut, Copy, and Paste commands. These are covered in this section.

To select events to edit, do one of the following:
- Click the event to highlight it.
- Command+click (on a Mac) or Ctrl+click (on a PC) to select several non-contiguous events.
- Shift+click the beginning and end events of a group of contiguous events.
- Click-drag across multiple events.
- You can remove an event from a selection by pressing Ctrl (on a PC) or Command (on a Mac) while clicking it.

To cut or copy events, do the following:

1. Select your event (see previous section).
2. Select Edit ➪ cut or Edit ➪ copy from the main menu to place the event in the Clipboard.

To paste events do one of the following:
- Click within the track’s playlist where you want the event to go and press Command+V (on a Mac) or Ctrl+V (on a PC) or choose Edit ➪ Paste from the main menu.
- Choose Go To from the Options menu in the MIDI Event List window, type in the location, and click OK.

To manually edit an event, do the following:

1. Double-click in the field you want to edit of the event in the list.
   or
   Press Ctrl+Enter (on a PC) or Command+Enter (on a Mac) when you have an event selected.
2. Enter the new value in the field you want to edit.
3. Insert the note by performing one of these commands:
   - Press Enter (on a PC) or Return (on a Mac) on your keyboard to close the Event entry window when the event is accepted.
   - Press Enter in the alphanumeric section (not the number pad section) of your keyboard to insert the event and keep the window open.
Chapter 4: Performing MIDI Operations

In This Chapter

- Quantizing MIDI notes
- Flattening and restoring MIDI performances
- Changing note velocity and duration
- Transposing, selecting, and splitting MIDI notes

Pro Tools offers you a handful of MIDI operations (located under the MIDI section of the main menu) where you can transform a mediocre track into a stunning performance (well, almost, depending on how well you use these operations). These operations allow you to make changes to the MIDI performance data on a track.

In this chapter, you get a chance to dig into some of the most-powerful MIDI editing operations in Pro Tools. This lets you do some really cool things like change the key of a song, alter the characteristics of a performance, or correct timing problems. This chapter also leads you through the MIDI Operations menu and shows you how to perform each of the operations in the menu.

Getting Used to the MIDI Operations Menu

Logically enough, the MIDI Operations window is where you do all your MIDI operations. This window, shown in Figure 4-1, is accessed by choosing any one of the MIDI operations listed under the MIDI section of the main menu, or by choosing Windows→Show MIDI Operations from the main menu.

After this window is open, you can select the operation you want to perform from the pop-up menu at the top of the window.

To close the window, press Return (on a Mac) or Enter in the alphanumeric section of the keyboard (on a PC) when you apply the operation.

When you use the MIDI Operations window, you can use the following commands as a fast way to navigate and adjust parameters:

- Press Tab to move forward through the fields in the window and Shift+Tab to move backward through the fields.
Performing MIDI Operations

- Use the Up and Down arrows to adjust values up and down in your selected field.
- Press Ctrl (on a PC) or Command (on a Mac) as you drag to adjust the value up or down in your selected field’s dialog box.
- Press Command (on a Mac) or Ctrl (on a PC) to increase the resolution of the sliders as you use them to adjust the values in your selected field.
- Play a note on your MIDI controller to select a note in fields with pitch and velocity settings.

Figure 4-1: The MIDI Operations window lets you perform many MIDI operations on selected MIDI data.

Performing MIDI Operations

MIDI operations are all done from the MIDI Operations window (see previous section). The operations you can perform are listed in the pop-up menu at the top of the window. In version 6 of Pro Tools, you have the following operations available to you (as shown in Figure 4-2):

- **Quantize**: Lets you adjust the timing of your selected notes.
- **Groove Quantize**: Similar to the Quantize operation, except you use a groove template to create a grid to quantize to.
- **Restore Performance**: This option lets you return to previously saved performance settings.
- **Flatten Performance**: This option lets you tweak performance data and lock it in before you do any more tweaking.
- **Change Velocity**: Lets you adjust the volume of the attack or the release of selected MIDI notes.
Performing MIDI Operations

Figure 4-2: The MIDI Operations window includes a pop-up menu that lets you select from several MIDI Operations.

✦ **Change Duration:** Lets you alter the length of recorded MIDI notes.

✦ **Transpose:** Lets you change the pitch of selected notes.

✦ **Select Notes:** Lets you choose specific MIDI notes or a range of notes in a selection.

✦ **Split Notes:** Lets you select a note or range of notes — but also lets you copy or cut the selected notes.

✦ **Input Quantize:** Lets you set a Quantize value that your recorded performance is adjusted to automatically as you record it.

Stay tuned: This section looks at each of these MIDI operations in greater detail. If you want to perform any one of them, here’s how:

1. **Select the note(s) you want to change.**
   
   Book 4, Chapter 2 describes how to make these selections.

2. **Select the MIDI operation you want to perform from the MIDI section of the main menu (or choose Windows\MIDI Operations from the main menu and choose the operation you want from the window’s pop-up menu).**

3. **Make the settings you want in the fields available.**
   
   Check out the section for each operation to see what to adjust.

4. **Apply the operation by clicking Apply or using the keyboard:**
   
   - If you want to keep the MIDI Operations window open, press Enter in the number pad section of the keyboard or click Apply.
   
   - If you want to close the MIDI Operations window, press Return (on a Mac) or Enter in the alphanumeric section of the keyboard (on a PC) to apply the operation and close the MIDI Operations window.
Quantize

The Quantize MIDI operation lets you adjust the timing of your selected notes. This is great when you want to conform the rhythmic placement of your MIDI notes to a grid or you have a problem with a really bad drummer and you want to fix his timing mistakes.

The Quantize version of the MIDI Operations window, shown in Figure 4-3, contains the following fields:

- **What to Quantize:** This section lets you choose which part of the note to quantize.
  - **Attacks:** This field sets the quantization to the start of the selected notes.
  - **Releases:** Clicking this field quantizes the ends of the notes.
  - **Preserve Note Duration:** Clicking this field produces different results depending on whether you choose Attack or Release.

  With Attack selected, Preserve Note Duration keeps the end of the note intact and with Release selected the start of the note is left intact. If both Attack and Release are selected, the Preserve Note Duration option is dimmed.

- **Quantize Grid:** This section is where you choose the resolution of the quantize grid, from whole notes to 32nd notes. If you choose 16th notes, for example, your notes will move to the nearest 16th note when you quantize.
**Note Selector:** This section lets you choose the note value of your quantize grid. Click the note to select it.

**Tuplet Checking:** This box lets you select odd note groupings such as triplets. When you check this option, you need to fill in the tuplet value. For example, to create a regular eighth-note triplet, choose 3 in time 1; for a quarter-note triplet, choose 3 in time 2.

**Offset Grid By:** This option lets you move the Quantize grid forward or backward in time by the selected number of ticks. This is helpful for creating a groove that lies slightly ahead of — or behind — the beat.

**Swing:** This field lets you create a swing feel (dotted-quarter-eighth-note triplet). You specify a percentage (from 0 to 300); selecting 100% provides a triplet feel.

✦ **Options:** Choose these to fine-tune your Quantize operation by specifying which notes to quantize and by how much:

- **Include Within:** Here you specify a range of notes to include. Selecting this option quantizes only selected notes that fall within the boundaries you set here (from 0 to 100%); the smaller the number, the narrower the range of notes affected.

- **Exclude Within:** Here you specify a range of notes to exclude from quantization. Any selected notes that fall within the boundaries you set here (between 0 and 100%) won’t be quantized.

- **Strength:** This is, in my opinion, the most-useful function in the Pro Tool Quantize operation. You can use it to move your quantized notes by a percentage (from 0 to 100%) rather than just snapping them right to the grid. Higher numbers keep more strictly to the grid than do the lower values.

- **Randomize:** This option adds a level of randomness to the quantizing of your selection — no, not to mess up the rhythm, but to keep it from being too rigid. You can select values between 0 and 100%. Lower values place the randomized notes closer to the grid.

Using these four options well helps keep a natural feel in your performance.

**Groove Quantize**

The Groove Quantize function is similar to the Quantize operation except that you use a groove template to create the grid to quantize to. This lets you take the groove from an already-recorded performance and apply it to the MIDI sequence of your track. This operation is performed from the Groove Quantize version of the MIDI Operations window, shown Figure 4-4.
One limitation of Pro Tools LE is that you can’t create your own groove templates. Instead, you either have to use the ones that come with Pro Tools (which aren’t bad), buy one from Digidesign, or hunt one up from a third-party maker. Of course, there’s an off chance that you may find some downloadable ones on the Internet. To find out, I recommend checking out the Digidesign User Conference Web site at duc.digidesign.com/ (do a search for Digigroove template).

The fields in the Groove Quantize version of the MIDI Operations window include the following:

✦ **Groove Template selector:** This pop-up menu lets you choose a groove template to apply to your selection. (These templates are located in the Groove folder within the Pro Tools folder on your system’s hard drive.)

   After you choose your template, its content, meter, and tempo information show up in the Comments section in the middle of the window.

✦ **Options:** Here’s where you can tinker with your groove:

   **Pre-Process Using “Quantize”:** When you have the timing field enabled (see next section), checking this box applies the setting in the Quantize version of the MIDI Operations window to the template before you apply your selection using the Groove Quantize settings.

   **Timing:** This option lets you adjust the timing of the quantization applied. A setting of 0% makes no change to the selection; a setting of 100% places the notes right at the groove template’s grid settings. A setting of 200% moves the selected notes twice the distance from the template’s grid locations.
**Duration:** This setting changes the duration of the notes to fit the groove template. A setting of 0% makes no change, a setting of 100% matches the notes to the groove template, and a setting beyond that increases or decreases the duration of the original notes according to their ratio to the notes in the groove template.

**Velocity:** This field changes the velocity — the volume — of the quantized notes. As with the other fields (Timing and Duration), the lower the number, the less the velocity changes.

✦ **Slider Settings:** You can recall and save the slider settings of the options with a template.
  - **Recall with Template:** Checking this box resets all the option settings to those that are saved with the template.
  - **Save:** Click this button to save your current option settings. If you choose Save, you can add any comments about the template and they will show up in the Comments section of the Groove Quantize window.

**Restore Performance**

Restore Performance returns you to your previously saved performance settings. This operation is like having an Undo for all the other operations listed in this chapter. Your performance returns to one of two earlier states:

✦ The settings saved using the Flatten Performance command (see next section) if you used it
✦ Its original settings (if you haven’t saved any other settings)

Using the Restore Performance version of the MIDI Operations window, you can select from several areas to restore. (See Figure 4-5.)

✦ **Timing (Quantization):** This option restores the note’s start time. If the Duration box is unchecked, the duration of the notes changes back to what it was originally.
✦ **Duration.** This option restores the length of the note. If you don’t have the Timing box checked, the Start times of your notes don’t change but the end times may.
✦ **Velocity:** This option restores the volume of the note.
✦ **Pitch.** Well, you know what this restores.

If you used the Input Quantize operation when you recorded, you can remove it by using this operation. Choose the Timing (Quantization) option and your original performance is resurrected in all its pristine beauty.
Flatten Performance

Flatten Performance is the operation you use when you want to save the performance data of a selection — timing, duration, velocity, and pitch — as the “original” setting that the Restore Performance operation (see previous section) returns you to. The Flatten Performance version of the MIDI Operations window is shown in Figure 4-6.

This operation lets you tweak performance data and lock it in before you do more tweaking. If you don’t like the extra tweaking, you can just go back to these settings. It’s a little added insurance when you’re messing creatively with MIDI data.

The Flatten Performance operation lets you save the following data:

- **Timing (Quantization):** The note’s Start time. If the Duration box is unchecked, the duration of the note changes back to what it was originally.
- **Duration:** The length of the note.
- **Velocity:** The volume of the note.
- **Pitch:** Well, you know what that is.
**Change Velocity**

The Change Velocity version of the MIDI Operations window, shown in Figure 4-7, lets you adjust the volume (velocity in MIDI-speak) of the attack or release of selected MIDI notes.

This operation is a lifesaver for times when you have a drummer playing an electronic kit and *just one note* is weak — or when you need to tame overly aggressive cymbals.

The Change Velocity window contains the following fields:

- **Change Velocity Of:** Here you choose between the initial attack of the note (attack) or the release value.

- **Set All To:** Checking this box sets all the velocities of the selected notes to the value in the box. You can either type the value in or move the slider up or down.

- **Add:** Here you add a specified value to your existing one. You can either enter the value in the box or use the slider.

- **Subtract:** Here you subtract a specified value to your existing one. You can either enter the value in the box or use the slider.

- **Scale By:** Here you set a scale for how much the velocities of your selected notes are to change — a percentage between 1 and 400. (Again, you can use the slider or type in a number.)
**Performing MIDI Operations**

- **Change Smoothly**: This lets you change the velocity of selected notes gradually over time. This is useful for creating crescendos and decrescendos. Type in the beginning and end values in the fields.

- **Change Smoothly By Percentage**: This option is similar to Change Smoothly (see previous bullet), except you specify a percentage of change instead of typing in specific numbers. This field is also where you can use a curve graph to specify how much the notes’ velocity must increase or decrease; you choose a percentage value between –99 and +99. The curve graph then shows how your setting is implemented.

- **Limit To**: Select this option if you want to set a minimum and maximum range for your Change Velocity settings. You type those values into the fields.

- **Randomize**: Here you create a random velocity change, specifying it as a percentage value between 0 and 100%. For example, if you choose a Set All To value of 60 and a Randomize setting of 40%, you end up with Change Velocity values from 48 to 72.

Be careful if you’re changing groups of notes. Using Add or Subtract for that purpose can change the relationships between various notes. If you like the way the original notes sound together, try using the Scale option instead. This keeps the relationships between notes intact.

**Change Duration**

The Change Duration operation lets you alter the length of recorded MIDI notes. The Change Duration version of the MIDI Operations window, seen in Figure 4-8, contains the following fields:

- **Set All To**: Check this box to set the duration of selected notes to the value in the box.

- **Add**: Here you add a specified value to your existing one.

- **Subtract**: Here you subtract a specified value to your existing one.

- **Scale By**: Here you set a scale for how much the velocities of your selected notes are to change — a percentage between 1 and 400.

- **Move Releases to the Closest Attack**: This setting moves the end times of the notes to the closest attack by either lengthening or shortening the notes.

- **Extend Releases to the Next Attack**: This setting extends the selected notes to the next attack. You can limit this extension by entering a value in the Add No More Than fields either as a percentage or by quarter notes and ticks (portions of quarter notes).

- **Change Smoothly**: Here you change the length of notes gradually over time, entering quarter notes and ticks in the From and To boxes to specify beginning and end times for the change in duration.
Performing MIDI Operations

✦ Change Smoothly by Percentage: This field lets you apply the duration change smoothly (see previous bullet) by a percentage rather than by entering quarter notes and ticks. You can also adjust the curve of the change, using values from –99 to +99.

✦ Limit Range: This setting lets you specify a minimum and maximum change duration for the settings you’ve chosen.

✦ Randomize: This field lets you create a random change in duration, based on the setting you chose in the fields described here.

The Change Duration operation is useful for changing the feel of the music by making your selection either more staccato or legato.

**Transpose**

The Transpose operation lets you change the pitch of selected notes. Checking out the Transpose version of the MIDI Operations window, shown in Figure 4-9, you see that the Transpose operation offers you two ways of doing this:

✦ Transpose By: This setting lets you transpose by semitones (1/2 step). You can either type in the value or use the slider to adjust the setting.

✦ Transpose: Here you type in the note and octave that you want to transpose from (in the From box) and to (in the To box). You can also use the slider to adjust the settings if you prefer.

Transposing using this MIDI operation makes it easy to change the pitch — in effect, the musical key — of the entire song or region. This is especially helpful if you decide that the song needs to be in a different key for your singer to sing well.
Performing MIDI Operations

Select Notes

The Select Notes operation allows you to choose specific MIDI notes or a range of notes in a selection. Your options, shown in the Select Notes version of the Operations window you see in Figure 4-10, include these:

- **All Notes**: This option selects all the notes in your selection.
- **Notes Between**: This option lets you specify the range of notes to select. You can either use pitch references (C1, B1, and so on) or MIDI note numbers (0-127) for your selection.
- **Top**: This option chooses the highest note or notes (depending on the number you enter) in each chord.
- **Bottom**: This option selects the lowest note or notes (depending on the number you enter) in each chord.

To actually select notes, do the following:

1. **Make a selection on a track or tracks that contain the notes you want to select.**
   
   Book 4, Chapter 2 has all you need to know about making selections.

2. **Choose MIDI>Select Notes from the main menu.**
   
   The Select Notes version of the Operations window appears.
3. **Enter your note or note range in the window.**
   Again, your choices here are All Notes, Notes Between, Top, and Bottom.

4. **Click Apply.**

This operation is handy for selecting the snare drum from a drum sequence before you change its note (pitch) or quantize it.

### Split Notes

The Split Notes version of the MIDI Operations window, shown in Figure 4-11, is similar to the Select Notes version (see previous section). It allows you to select a note or range of notes, but in addition you can also either copy or cut the selected notes. These two options each treat the material differently:

- **Copy:** This command places a copy of the selected notes in the Clipboard so you can place them somewhere else.
- **Cut:** This removes the selected notes from the original track and places them in the Clipboard so that you can paste them into another location.

The Split Notes operation is handy for taking the tom-toms from a drum sequence and moving them to their own track where you can edit, pan, and effect them separately from the rest of the drums. Another useful thing you can do with Split Notes (keeping the drum-track theme going) is to make a copy of all the kick-drum notes and put them in another track where you can process them and add them to the original kick during mixdown. (Hey, why not get your kicks while you can? Sorry about that.)

To actually split notes from a MIDI track, do the following:

1. **Make a selection on a track or tracks that contain the notes you want to select.**

   Book 4, Chapter 2 has all you need to know about making selections.
Performing MIDI Operations

2. **Choose MIDI &gt;&gt; Split Notes from the main menu.**
   
   The Split Notes version of the Operations window appears.

3. **Enter your note or note range in the window.**
   
   Again, your choices here are All Notes, Notes Between, Top, and Bottom.

4. **Choose whether you want to copy or cut the select notes from the track.**

5. **Click Apply.**

   To place the split notes into another track, do the following:

   1. **Position your cursor in the destination track at the same point as the Start point of your Split Note operation.**

   2. **Press Command+V (on a Mac) or Ctrl+V (on a PC) to place the copies or cut notes from your Clipboard into the track.**

**Input Quantize**

The Input Quantize operation lets you set a Quantize value that your recorded performance is adjusted to automatically as you record it. The fields you can adjust in the Input Quantize version of the Operations window (see Figure 4-12) are the same as with the Quantize operation.

Unless your timing is really bad (or the person you record can’t walk and chew gum at the same time), I suggest that you disable this function and quantize — if needed — **after** your performance is saved. Otherwise it’s incredibly easy to overdo the quantizing and end up with a performance with absolutely no human feel to it.

![Figure 4-12:](image)

The Input Quantize function lets you automatically adjust note timing as it’s recorded.
Book VI

Mixing in Pro Tools

The 5th Wave

By Rich Tennant

The Scarlet Letter

17th Century

21st Century

Adultery

Analog
Contents at a Glance

Chapter 1: Mixing Basics
Chapter 2: Setting Up Your Mix
Chapter 3: Using Equalization
Chapter 4: Digging into Dynamics Processors
Chapter 5: Singling Out Signal Processors
Chapter 6: Automating Your Mix
Chapter 7: Making Your Mix
Chapter 1: Mixing Basics

In This Chapter

✓ Getting to know the mix process
✓ Managing levels
✓ Using control surfaces and external mixers
✓ Understanding the stereo field
✓ Using reference CDs

Think about all the time it took for you to record all the tracks for your song. You spent countless hours setting up mics; getting good, “hot” (high, but not distorting) levels on your instruments; and making sure each performance was as good as you could get it. You’d think, then, that most of your work would be done.

Well, on the one hand, it is — you no longer have to set up and play each instrument. On the other hand, you still have to make all the parts that you recorded fit together. This process can take as long as it took you to record all the tracks in the first place. In fact, for many people, it takes even longer to mix the song than to record all its parts.

In this chapter, I introduce you to the process of mixing your music. You get a chance to see the basics of mixing using the Pro Tools Mix window and you discover how to set up external mixing aids such as MIDI control surfaces, digital mixers, and analog mixers. To top it all off, you discover how to reference your music to other people’s recordings and how to train your ears so that your mix “translates” to different types of playback systems.

Mixing music is a very subjective thing. You can relate one instrument to another in an almost infinite variety of ways. You may find that several mixes work equally well for your song. Allow yourself to experiment and don’t be afraid to record several different mixes if you want.

Understanding Mixing

The goal of mixing is to make sure each instrument can be heard in the mix — the recorded whole that results from blending all your recorded
parts together — without covering up something else or sounding out of place. You can pull this off in several ways:

✦ Choosing the recorded parts that add to the emotional impact of the music and build intensity throughout the song. By necessity, this also means choosing not to use parts that are unnecessary, or which clash with parts that have a greater impact.

✦ Setting the level (volume) of each instrument relative to the others so nothing is buried so far back in the mix that you can’t hear it — and no instrument is so loud that it overpowers the other instruments.

✦ Adjusting the equalization (also called EQ or frequency response) of each instrument so each leaves room for the other instruments in the mix. This means getting rid of any frequencies of an instrument that clash with those of another, or emphasizing certain frequencies that define the sound of an instrument so it can be heard clearly in the mix.

✦ Taking advantage of stereo panning (movement from left to right) to put each instrument in its proper place in the stereo field — toward the left or right — where it can either sound as natural as possible or produce a desired effect. Also, stereo panning allows you to make room for each instrument in the mix, especially those with similar frequency ranges.

✦ Adding effects (such as reverb or delay), to the instruments in the mix to either place them “in front” or “in back” relative to other instruments or to create a desired sound.

The mixing process is where you can get really creative in crafting your song. The stress of capturing great performances is over — all that’s left for you to do is to massage all the parts of your song into a cohesive whole. Don’t be afraid to try new things. Experiment with different EQ, panning, and effect settings. Take your time and have fun. The great thing about mixing is that you can make as many versions as you want — and you can always go back and try again.

**Managing Levels as You Work**

When you mix all the tracks in your session together, the mix bus (which, for its part, is controlled by the master fader) is where they end up. There the signals are summed (added together) and result in a level (volume) that is higher than that of the original tracks. One danger in mixing in-the-box (within Pro Tools) is that this level can get pretty high and you may not recognize it unless you listen very carefully.

As you work, watch the level meter in the master fader and make adjustments to the individual tracks to bring the individual levels down, rather than dropping the fader on the master.
Many people like to get the most volume out of their song when mixing, so they crank the master fader up to where the levels peak right at 0dB or maybe –.1dB. This used to be considered okay to do, but more and more professional engineers are backing off on the mix bus by as much as 6dB. This is what I recommend as well. Keep your peak levels that go to the master fader down to about –3dB to –6dB and make this up when you master (or have someone else master) your music. Sure, the volume will be lower than it is on the commercial CDs you own — but you can adjust that during the mastering process. (Book 7, Chapter 1 has more on mastering.)

The advantage to keeping peak levels down is that you get better levels going to the mix bus and reduce the chance that some clipping (also called overs in digital recording — distortion that results when the summed signals end up too hot and overload the mix bus) will happen.

**Getting Started Mixing Your Song**

Before I start to mix a song, I do a few things to prepare myself for the process. My goal before I mix is to get in the headspace of mixing. This often means taking a step back from the song and approaching it as a listener rather than as the musician who recorded each of the tracks. Start the mixing process by following these steps:

1. **Determine the overall quality you want from the song.**
   
   At this point I don’t mean “quality” in terms of “is it good or bad?” Rather, I define “quality” here as a musical style or a feeling. Do you want it to kick? Soothe? Scream? You probably don’t need to think about this too hard if you had a definite sound in mind when you started recording. In fact, most composers hear a song in their heads before they even start recording.

2. **Listen to a song or two from a CD that has a sound or feel similar to the song you’re trying to mix.**

   Listen to the examples on your studio monitors if you can; try to get a sense of the tonal and textural quality of these songs. Listen to them at fairly low volume; be careful not to tire your ears. All you’re trying to do at this point is get your ears familiar with the sound you’re trying to produce in your music.

3. **Set up a rough mix using no EQ or effects and listen through it once.**

   For this listening session, don’t think like a producer; rather, try to put yourself in the mindset of the average listener. Listen to the various parts that you’ve recorded — does anything stick out as particularly good or bad? You’re not listening for production quality. You’re trying to determine which instruments, musical phrases, licks, melodies, or harmonies grab you as a listener.
4. **Get a piece of paper and a pen to jot down ideas as you work.**

As you listen through the song, take notes on where certain instruments should be in the mix. For example, you may want the licks you played on lead guitar throughout the song to be muted during the first verse. Or maybe you decide that the third rhythm guitar part you recorded would be best put way to the right side of the mix while the other two rhythm guitar parts might be closer to the center. Write these ideas down so you can try them later. Chances are you’ll have a lot of ideas as you listen through the first few times.

**Mixing In Pro Tools**

Pro Tools comes with a powerful software mixer — everything you may want to do can be done with mouse and keyboard. Even so, many people — myself included — prefer to mix using real faders, knobs, and buttons. This can be done several ways: using the Digi 002 control surface, a MIDI controller, a digital mixer, or an analog mixer. These alternative types of mixers are covered in more detail in Book 1, Chapter 2; for now, I just want to cover the basic setups of these various options.

**Using the 002 control surface**

If you have the Digi 002 with the control surface, your system is automatically integrated within Pro Tools software. With your system hooked up via the FireWire interface, all of your faders, knobs, and buttons should work seamlessly with the software mixer. When you push a fader on the control surface, the corresponding track fader in the computer moves as well.

Check out the manual for the 002 to get familiar with the operation of its control options. Or you can just fiddle around a bit — the controller is very intuitively set up.

**Using a MIDI controller**

Quite a few MIDI control surfaces currently on the market work well with Pro Tools. (The Mackie Control is one that immediately comes to mind.) If you want to go the MIDI route, check out the compatibility page on the Digidesign Web site (www.digidesign.com/compato/) to see whether the unit you’re interested in is supported.

Hooking up a MIDI control surface is the same as setting up any MIDI instrument, so go to Book 5, Chapter 1 for details on configuring your system.
Once you’re hooked up and running, the control surface is basically the same as using a Digi 002. All your faders, knobs, and buttons on your control surface will adjust one of the parameters in the Pro Tools software. The manual for your MIDI control surface will spell out the function of each of the buttons. In the case of the Mackie Control, you can get a template that fits over the surface of the controller and shows you the appropriate functions in Pro Tools listed for easy reference.

**Using a digital mixer**

If you want to use a digital mixer with your Pro Tools system, you need to make sure that you have the proper number of digital inputs and outputs in your Digidesign interface in order to connect to your mixer. With the 002 Rack, for example, you have ten outputs (eight ADAT and two S/PDIF) that you can use to send your tracks from your computer to your mixer. (Just make sure that your mixer can accept ADAT and S/PDIF signals at the same time, otherwise you’re down to eight.) This means you can send no more than ten tracks of material to your mixer to mix. In this example, if you have a session with more than ten tracks, your digital mixer becomes somewhat useless — unless you want to mix in stages (ten tracks at a time) or mix in the box (within Pro Tools) and from your mixer.

I don’t recommend this half-in-the-box approach because you’ll have a delay between the internal track and the tracks sent to your mixer. Any such delay will really mess with the feel of your music.

To connect your digital mixer to your Pro Tools system, simply run the appropriate cables (ADAT, for instance) from the output of your Digidesign interface to the input of your digital mixer. When you move a fader (or a button or a knob) in your mixer, the corresponding fader (or button or knob) track in the Pro Tools software you see on-screen won’t be affected.

**Using an analog mixer**

As was the case with the digital mixer, your ability to mix in an analog mixer is limited by the number of outputs that your interface has. In this case, it all depends on the number of analog outputs you have. For example, the 002 R provides eight analog outputs, so this is the maximum number of tracks you can mix with an analog mixer at any one time.

Mixing a session with more than eight tracks can be done, but it’s not worth the hassle in my opinion, unless you have a really expensive analog mixer. Inexpensive analog mixers (those under $10,000, for instance) won’t sound any better than mixing within Pro Tools.
Using the Stereo Field

If, for some reason, you want to mix your session through an analog mixer, all you need to do is connect each of the analog outputs from your Digidesign hardware to one of the inputs of your mixer. In the case of the 002 Rack, you need eight TS cables running from outputs 1 through 8 to the corresponding inputs of your mixer. (Book 1, Chapter 2 has more on the various cables you meet in the recording world.)

Using the Stereo Field

When you’re at a live concert and you close your eyes, you can hear where each instrument is coming from on stage. You can hear that certain instruments are on the left side of the stage, others are on the right, and still others seem to come from the center. You can also generally discern whether an instrument is at the front or the back of the stage. Put all these sound-based impressions together, and you’ve got a 3D image made of sound — a stereo field.

What makes up the stereo field is the specific placement of sound sources from left to right and front to back. When you mix a song, you can set your instruments wherever you want them on the imaginary “stage” created by your listener’s speakers. You can do this with panning, which sets your instruments from left to right, and you can use effects (such as reverb and delay), to provide the illusion of distance, placing your instruments toward the front or back in your mix. (Book 6, Chapter 4 has more on effects.) When you mix your song, try to visualize where on stage each of your instruments might be placed.

Some people choose to set the panning and depth of their instruments to sound as natural as possible, while others use these settings to create otherworldly sounds. There is no right or wrong when panning and adding effects to simulate depth, just what works for your goals. Don’t be afraid to get creative and try unusual things.

Left or right

You adjust each instrument’s position from left to right in a mix with the Panning control, located in the Pro Tools Mix window. (See Figure 1-1.) Panning for most songs is pretty straightforward, and I outline some settings in the following sections. Some mixing engineers like to keep their instruments toward the center of the mix; other engineers prefer spreading things way out with instruments on either end of the spectrum. There’s no absolute right or wrong way to pan instruments. In fact, no one says you have to leave any of your instruments in the same place throughout the entire song. Just make sure that your panning choices contribute to the overall impact of the music. (Check out Book 6, Chapter 5 for how to automate your panning in Pro Tools.)
Lead vocals

Lead vocals are usually panned directly in the center.

Backup vocals

Because backup vocals are often recorded in stereo, they are panned hard left and hard right. If you recorded only one track of backup vocals, you can make a duplicate of the track and pan one to each side, just as you can with stereo tracks.

In addition to tracks panned to each side, some mixing engineers also have a third backup vocal track panned in the center to add more depth. Your choice to do this depends on how you recorded your backup vocals, and on how many tracks you have available for them.
**Guitar parts**
Lead guitar is often panned to the center (or just slightly off-center if the sound in the center of the stereo field is too cluttered). Rhythm guitar, on the other hand, is generally placed somewhere just off-center. Which side doesn’t matter, but it’s usually the opposite side from any other background instruments, such as an additional rhythm guitar, synthesizers, organs, or pianos.

**Bass**
Normally the bass guitar is panned in the center, but it’s not uncommon for mixing engineers to create a second track for the bass — panning one to the far left and the other to the far right. This gives the bass a sense of spaciousness and allows more room for both the bass guitar and the kick drum in the mix.

**Drums**
As a general rule, I (and most other people) pan the drums so they appear in the stereo field much as they would on stage (but this doesn’t mean you have to). The snare drum and kick drum are typically panned right up the center, with the tom-toms panned from slightly right to slightly left. Hi-hat cymbals often go just to the right of center, the ride cymbal just left of center, and crash cymbals sit from left to right, much like the tom-toms.

**Percussion**
Percussion instruments tend to be panned just off to the left or right of center. If I have a shaker or triangle part that plays throughout the song, for instance, I’ll pan it to the right an equal distance from center as the hi-hat is to the left. This way you hear the hi-hat and percussion parts playing off one another in the mix.

**Piano/synthesizers/organs**
These instruments are usually placed just off-center. If your song has rhythm guitar parts, then the piano or organ usually goes to the other side. Synthesizers can be panned all over the place. In fact, it’s not uncommon for the synths to be actively panned throughout the song (that is, they move from place to place).

**Front or back**
As you probably discovered when you were placing your mics to record an instrument, the quality of sound changes when you place a mic closer to — or farther away from — the instrument. The closer you place the mic, the
less room ambience you pick up, which makes the instrument sound closer to you or “in your face.” By contrast, the farther from the instrument you place your mic, the more room sound you hear; the instrument sounds farther away.

If you’ve ever stood in a large room and talked to someone, you have seen (well, heard, actually) how this relationship works. When your friend stands close to you, you can hear him clearly. You hear very little of the reflections of his voice from around the room. As he moves farther away from you, the room’s reflections play an increasing role in the way that you hear him. By the time your friend is at the other side of the room, you hear not only his voice, but also the room in which you are talking with him. In fact, if the room is large enough, your friend probably sounds as if he were a mile away from you, and all the reflections from his voice bouncing around the room may make it difficult to understand what he says.

You can easily simulate this effect by using your reverb or delay effects processors. In fact, this is often the purpose of reverb and delay in the mixing process. With them, you can effectively “place” your instruments almost anywhere that you want them, from front to back, in your mix.

The less reverb or delay you use with your instrument, the closer it appears on the recording; the more effect you add to an instrument, the farther away it seems.

The type of reverb or delay setting that you use has an impact on how close or far away a sound appears as well. For example, a longer reverb decay or delay sounds farther away than a shorter one.

In Book 6, Chapter 4, I go into detail about the various effects processors to help you understand how best to use them. I also present settings you can use to create natural-sounding reverb and delay on your tracks, as well as some unusual settings that you can use for special effects.

**Adjusting Levels: Enhancing the Emotion of the Song**

After you have a rough mix and have gotten your EQ (Book 6, Chapter 3) and panning settings where you want them, your next step is to determine which parts of which tracks are used when — and sometimes whether a part or track is used at all. If you’re like most musician/producers, you try to get all the wonderful instrumental and vocal parts you recorded as loud as possible in the mix so each brilliant note can be heard clearly all the time. After all, you didn’t go through all the time and effort to record all those great tracks just to hide them in the mix or (worse yet) mute them, right?
Well, I feel your pain. But when you get to the mixing point of a song, it’s time to take off your musician’s hat and put on the one that says producer. And a producer’s job is to sort through all the parts of a song, choose those that add to its impact, and dump those that are superfluous or just add clutter. Your goal is to assemble the tracks that tell the story you want to tell and that carry the greatest emotional impact for the listener.

This can be the toughest part of mixing your own songs, because you aren’t likely to be totally objective when it comes to determining what to use and what not to use. Try not to get stressed out. You aren’t erasing any of your tracks, so you can always do another mix later on if you just have to hear the part that you muted before.

One of the great joys when listening to music (for me, anyway) is hearing a song that carries me away and pulls me into the emotional journey that the songwriter had in mind. If the song is done well, I’m sucked right into the song, and by the end, all I want to do is rewind it and listen to it again.

What is it about certain songs that can draw you in and get you to feel the emotion of the performers? Well, aside from a good melody and some great performances, it’s the way the arrangement builds throughout the song to create tension, release that tension, and build it up again. A good song builds intensity so that the listener feels pulled into the emotions of the song.

Generally, a song starts out quiet, becomes a little louder during the first chorus, and then drops down in level for the second verse (not as quiet as the first, though). The second chorus is often louder and fuller than the first chorus, and is often followed by a bridge section that is even fuller yet (or at least differs in arrangement from the second chorus). The loud bridge section may be followed by a third verse where the volume drops a little. Then a superheated chorus generally follows the last verse and keeps building intensity until the song ends.

When you’re crafting the mix for your song, you have two tools at your disposal to build and release intensity: dynamics and instrumental content (the arrangement).

**Dynamics**

*Dynamics* are simply how loud or soft something is — and whether the loudness is emotionally effective. Listen to a classic blues tune (or even some classical music), and you’ll hear sections where the song is almost deafeningly silent and other sections where you think the band is actually going to
step out of the speakers and into your room. This is an effective and power-
ful use of dynamics. The problem is that this seems to be a lost art, at least
in popular music.

It used to be that a song could have very quiet parts and really loud ones.
Unfortunately, a lot of CDs nowadays have only one level — loud. This often
isn’t the fault of the musicians or even the band’s producer. Radio stations
and record-company bean counters have fueled this trend; they’re betting
that if a band’s music is as loud as (or louder than) other CDs on the market,
it’ll attract more attention and sell more copies. (You can read more about
this trend in Book 7, Chapter 1.) But consider: Whether you can hear the
music is one thing; whether it’s worth listening to is another.

Try recording a song with a lot of dynamic changes. I know this bucks the
trend, but who knows? You may end up with a song that carries a ton of emo-
tional impact. Also, as you mix your song, incorporate dynamic variation by
dropping the levels of background instruments during the verses and bring-
ing them up during the chorus and bridge sections of the song. You can
always eliminate your dynamic variation (if you absolutely have to) by
squashing your mix with compression during the mastering process.

The biggest mistake that most people make when they mix their own music
is to try to get their song as loud as commercial CDs. This is the mastering
engineer’s job, however, not yours, so don’t worry about it. Get your song to
sound good with a balance between high and low frequencies and loud and
soft sections. Let the mastering engineer make your music as loud as it can
be. He or she definitely has gear that is better designed to raise the volume
of a recording without making it sound squashed or harsh.

**The arrangement**

Building intensity with the arrangement involves varying the amount of
sound in each section. A verse with just lead vocal, drums, bass, and an
instrument playing the basic chords of the song is going to have less inten-
sity (not to mention volume) than a chorus with a wash of guitars, backup
vocals, drums, percussion, organ, and so on. Most songs that build intensity
effectively start with fewer instruments than they end with.

When you mix your song, think about how you can use the instruments to
add to the emotional content of your lyrics. For example, if you have a guitar
lick that you played at every break in the vocal line, think about using it less
to leave space for lower levels at certain points in your song. If you do this,
each lick will provide more impact for the listener and bring more to the
song’s emotion.
Tuning Your Ears

To create a mix that sounds good, the most critical tools you need are your ears, because your ability to hear the music clearly and accurately is essential. To maximize this ability, you need a decent set of studio monitors and a good idea how other people’s music sounds on your speakers. You also need to make sure that you don’t mix when your ears are tired. This section explores these areas.

Listening critically

One of the best ways to learn how to mix music is to listen to music that you like — and listen, in particular, for the way it’s mixed. Put on a CD of something similar to your music (or music that has sound you like) and ask yourself the following questions:

✦ What is the overall tonal quality or texture of the song? Notice how the frequencies of all the instruments cover the hearing spectrum. Does the song sound smooth or harsh, full or thin? Try to determine what you like about the overall production.

✦ How does the song’s arrangement contribute to its overall feel? Listen for licks or phrases that add to the arrangement. Notice if the song seems to get fuller as it goes on.

✦ Where are the instruments in the stereo field? Notice where each instrument is, from left to right and front to back, in the mix. Listen to see whether they stay in one place throughout the song or move around.

✦ What effects are being used on each instrument? Listen for reverb and delay — in particular, how they affect decay lengths — as well as for the overall effect level compared to the dry (unaffected) signal.

✦ What tonal quality does each instrument have? Try to determine the frequencies from each instrument that seem dominant. Pay particular attention to the way the drums sound, especially the snare drum.

Even if you’re not mixing one of your songs, it’s a good idea to just sit down once in a while and listen to music on your monitors to get used to listening to music critically. Also, the more well-made music you hear on your monitors, the easier it is to know when your music sounds good on those same speakers.

A good mix should sound good on a variety of systems, not just through the speakers in your studio. Before you decide a mix is done, copy it onto a CD and play it in your car, your friend’s stereo, and a boom box. In fact, try to listen to your music on as many different kinds of systems as you can. As
you listen, notice if the bass disappears or becomes too loud or if the treble becomes thin or harsh. Basically you’re trying to determine where you need to make adjustments in your mix so that it sounds good everywhere.

Unless you spent a lot of time and money getting your mixing room to sound world-class, you’ll have to compensate when you mix to get your music to sound good on other people’s systems. If your room or speakers enhance the bass in your song, the same tracks will sound thin on other people’s systems. On the other hand, if your system lacks bass, your mixes will be boomy when you listen to them somewhere else.

**Choosing reference CDs**

A reference CD can be any music that you like or that helps you to hear your music more clearly. For the most part, choose reference CDs that have a good balance between high and low frequencies and that sound good to your ear. That said, some CDs are mixed really well, which can help you get to know your monitors and train your ears to hear the subtleties of a mix. I name a few in the following list. *(Disclaimer: I try to cover a variety of music styles in this list, but can’t cover them all without a list that’s pages long.)*

✦ Steely Dan, *Two Against Nature*
✦ Peter Gabriel, *So*
✦ Sarah McLachlan, *Surfacing*
✦ No Doubt, *Return of Saturn*
✦ Los Lobos, *Kiko*
✦ Marilyn Manson, *Mechanical Animals*
✦ Depeche Mode, *Ultra*
✦ Bonnie Raitt, *Fundamental*
✦ Macy Gray, *On How Life Is*
✦ Pearl Jam, *Yield*
✦ Metallica, *S&M*
✦ Dr. Dre, *2001*

All commercial CDs have been mastered. This is going to affect their sound a little — most importantly, they’ll be louder than your music in its pre-mastered form. If you toggle back and forth between your mix and a reference CD, adjust the relative levels so that each one sounds equally loud coming through your speakers. The louder song always sounds “better.” And whatever you do, don’t try to match the volume of your mix to a reference CD.
Dealing with ear fatigue

If you’ve ever had a chance to mix a song, you may have found that you do a better mix early on in the process, and the longer you work on the song, the worse the mix gets. In most cases, this is because your ears get tired — and when they do, hearing accurately becomes harder. To tame ear fatigue, try the following:

✦ **Don’t mix at the end of the day, especially after doing any other recording.** Save your mixing for first thing in the morning when your ears have had a chance to rest.

✦ **Keep the volume low.** I know you’ll be tempted to crank the volume on your song as you work on it, but doing so only tires your ears prematurely and can cause damage, especially if you have monitors that can get really loud.

✦ **Take a break once in a while.** Just 10 or 15 minutes of silence can allow you to work for another hour or so. Also, don’t be afraid to walk away from a mix for a day or more.

✦ **Try not to mix under a deadline.** This suggestion fits with the preceding one. If you’re under a deadline, you can’t give yourself the time you may need to rest and reassess your mix before it goes to print.

Making several versions

One great thing about digital recording is that it costs you nothing to make several versions of a mix. All you need is a little (well, actually a lot of) hard-disk space. Because you can make as many variations on your song’s mix as your hard drive allows, you can really experiment by trying new effects settings or trying active panning in your song and see whether you like it. You may end up with something exciting. At the very least, you end up learning more about your gear. That’s always a good thing.

*Print (that is, make a clear recording of) a mix early on. Most of the time, your best mixes happen early in the mixing process. Print (or save) the first good mix you make — before you try making more “creative” ones. If you get burned out or run out of time, you still have a decent mix to fall back on.*
Chapter 2: Setting Up Your Mix

In This Chapter

- Understanding equalization
- Inserting EQ in a track
- Getting to know the EQ windows in Pro Tools
- Equalizing your tracks

Before you can actually mix anything in Pro Tools, you have to get a few preliminaries out of the way first. More specifically, you need to open the Mix window, you need to have a good grasp of how the signal flows through the system, you need to know how to create auxiliary inputs and master faders, and you need to get up to speed on inserts and sends. This chapter gives you the details on all of these things.

Revisiting the Mix Window

When you mix in Pro Tools, you spend most of your time working in the Mix Window, as shown in Figure 2-1. The Mix window contains the channels strips for each track, routing information, and your master faders. Each part of the Mix window is covered in detail in Book 2, Chapter 4.

To open the Mix window, choose Windows ➪ Show Mix from the main menu or press Command+equal sign (=) on a Mac or Ctrl+equal sign (=) on a PC. You can then set up the display parameters of the window by choosing Display ➪ Mix Window Shows from the main menu and choosing the options you want included in the view, as shown in Figure 2-2.
Figure 2-1: The Mix window is where you do your mixing in Pro Tools.

Figure 2-2: Selecting parameters to view in the Mix window.
Getting to Know Signal Flow

Knowing how the tracks you record are routed through Pro Tools can help you make the best choices and keep your sound top-notch as you mix your song. Figure 2-3 shows how the signal (represented by the regions in your audio tracks) flows through the track channels in the Pro Tools mixer (shown in the Mix window).

The audio enters the mixer at the top of the diagram and flows downward. From top to bottom, the channel strip contains the following sections:

✦ **Source:** This is the audio recorded to your hard drive or, if you have the track record-enabled, the input coming from the input you have selected in the Input section of the channel strip. The signal starts here and enters the Track’s channel strip.

✦ **Insert:** This lets you insert effects into your track. Inserts in Audio and Auxiliary Input tracks occur before the fader (pre-fader) for the track. Inserts on master fader tracks occur after the fader (post-fader).

✦ **Send Pre-fader:** This lets you send your signal out to an Auxiliary Input track where you can then insert an effect.

✦ **Mute:** This button lets you mute (turn off) the output of the track.

✦ **Fader:** This lets you control the level (volume) of your signal leaving the track and going to the output(s) you have chosen in the Output section of the channel strip.

✦ **Send Post-fader:** When you have the “Pre” button disengaged, your Send signal is sent from your track after it passes through the track fader. Adjusting the volume of the track also adjusts the level going through your send.

✦ **Pan:** This lets you adjust how much of your signal goes to the left or right channel of your stereo output. This option is only available if your Output setting is set for stereo.

✦ **Output:** This is where your signal goes as it leaves the track’s channel strip. This can be the master bus, or an effect or submix bus (controlled by an Auxiliary Input track).

To create a new track (whether audio, MIDI, auxiliary input, or master fader) choose File→New Track from the main menu to call up the New Track dialog box, where you can choose the type of track you want to create. (Book 3, Chapter 1 covers this process in detail.)
When you start mixing in Pro Tools, it helps to have few routing setups under control. You need a master fader so you can control the volume leaving Pro Tools, and you need to know how to use the insert and send portions of the channel strip so that you can insert effects into your tracks. This section outlines these procedures.
If you’re using version 6 or higher, you can make a track inactive by Ctrl+Start/Windows+clicking (on a PC) or Command+Ctrl+clicking (on a Mac) the Track Type indicator in the lower right of the track’s channel strip (as in Figure 2-4). This frees up processing power, and is something I recommend for any tracks in your session that you don’t want to play.

**Figure 2-4:**
To make a track inactive Ctrl+Start+click (PC) or Command+Ctrl+click (Mac) the Track Type indicator.

---

**Using a master fader**

The *master fader* is used to control the level coming out of all the tracks routed to it. Here’s a short list of a few of the things you can do with a master fader:

- **Control the main level of your mix:** This is the standard use of this fader. All your tracks are routed to the master fader and you use it to control the overall level going to your monitors.

- **Control submix levels:** To do this, route the tracks you want to submix to one of your buses and assign the input of the master fader to this bus.
The output of this master fader goes to your master bus. You can set the individual levels of the submixed track at each track’s fader and the combined level at this submix’s master fader.

✦ **Control effect-send levels:** You can route your sends — signals going through the Send section of your track — to a bus and designate that bus as the input of a master fader. You can then insert your effect into this master fader’s input, and set the resulting output to go to your mix bus’s master fader.

✦ **Add effects to your entire mix:** You can add effects such as compression or reverb to the entire mix by placing it in the insert of the master fader.

To create a master fader, follow these steps:

1. **Choose File:** New Track from the main menu.

   The New Track dialog box appears.

2. **Use the drop-down menus to enter the number of tracks you want, the type (in this case choose Master Fader) and whether you want your tracks(s) in stereo.**

3. **Click Create.**

   The master fader appears in your session.

4. **Click the master fader’s Output selector — the second of the three buttons in the middle of the channel strip — and set it to the output that you want it to control.**

   Set this to the main outputs that all your tracks are routed to if you want to make this the master fader for your main mix bus.

### Adding auxiliary inputs

*Auxiliary inputs* are pretty much like audio tracks, except they receive a signal from within Pro Tools, rather than from some external source (such as a microphone). Auxiliary inputs let you route internally and are great for some vital mixing tasks such as

✦ **Sending several tracks to a single effect processor:** This can reduce the stress on your system and can help you to make your tracks sound more cohesive — by blending their reverb sounds together, for example.

✦ **Controlling a submix with a single fader:** Submixing is the process of mixing tracks together before they are mixed by the master bus. Book 6, Chapter 7 details how to perform a submix in Pro Tools.

✦ **Inputting audio signals from your MIDI devices:** This lets you monitor the output from your MIDI devices as your MIDI tracks trigger them.
To create an auxiliary input track, follow these steps:

1. **Choose File ➪ New Track from the main menu.**
   The New Track dialog box appears.

2. **Use the drop-down menus to enter the number of tracks you want, the type (in this case choose Auxiliary Input), and whether you want your tracks(s) in stereo.**

3. **Click Create.**
   The auxiliary input appears in your session.

4. **Click the track’s Input selector — t of the three buttons in the I/O section of the channel strip — and choose the source for this track.**
   This can be an internal bus or hardware input.

5. **Click the Output selector — second of the three buttons in the middle of the channel strip — and set it to the output you want to send the signal.**

### Inserting inserts

Inserts are effects that you can place into a track’s signal to alter its sound. For example, inserting a compressor lets you control the dynamic range of your track and inserting a delay can add an echo effect to your instrument. You can have up to five inserts in each track in Pro Tools. You can use either hardware or software (plug-in) effects in these inserts.

The signal passes through the effects in the order — from top to bottom — in which they appear in the Insert section of your track’s channel strip. For example, in Figure 2-5, the signal goes through the compressor before it goes through the reverb. To change the order of your insert, simply click and drag it up or down the list.

---

**Figure 2-5:** Inserted effects can be rearranged by click-dragging the insert name up or down the list.
To insert an effect into a track’s channel strip, follow these steps:

1. **Enable the Insert view in the Mix window by choosing Display ➪ Mix Window Shows ➪ Inserts from the main menu.**

   The Insert section of the Mix window appears at the top of your track’s channel strip.

2. **Click an entry in the Insert section to open the pop-up menu.**

3. **Select a plug-in to insert (or the hardware output/input you want if you’re using an external effect).**

   If you choose a plug-in, the plug-in window opens. (See the “Playing with Plug-ins” section, later in this chapter, for more information.)

**Turning off the effect**

There are three ways to turn off the effect in an insert:

- **Remove the insert:** To remove the insert from the track, choose No Insert from the Insert pop-up menu. (Click-hold over the arrows located to the left of the Insert name to access the menu.) This removes the insert from the track and moves any inserts below it up the line.

- **Bypass the effect:** Do this by engaging the Bypass button in the plug-in window. To open this window, click the Insert name in the Insert section of the track’s channel strip. This keeps the effect in-line but turns it off. The effect still draws processing power even though you don’t hear it.

- **Make the insert inactive:** Do this by pressing Ctrl+Start/Windows (on a PC) or Command+Ctrl (on a Mac) as you click the plug-in’s name in the Insert section of the channel strip. Doing so removes the effect from the signal chain but not from the Insert section. This frees up processing resources and allows you to turn on the insert at any time. (You simply repeat the keystrokes-and-click you used to turn it off.)

**Setting up sends**

You can send the signal from your track to another bus for processing. Pro Tools lets you have up to five such sends per audio or auxiliary track. Sends are useful for two major purposes:

- Applying effects to more than one track, which you can do internally (using a plug-in) or externally (using a hardware device).

- Creating submixes that combine several tracks into one or two tracks.
You can choose to send the signal pre- or post-fader, which means the signal going to the send is either sent before or after it travels through the track’s fader. The Pre- or Post-Fader options, along with the Send Level, Panning, and Mute options, are accessed through the Send window, shown in Figure 2-6. You access this window by clicking the Send name in the Send section of the track’s channel strip. If the Send section isn’t visible in the track’s channels strip, enable the Send view in the Mix window by selecting Display ▸ Mix Window Shows ▸ Sends from the main menu.

To assign a send, follow these steps:

1. **Enable the Send view in the Mix window by selecting Display ▸ Mix Window Shows ▸ Sends from the main menu.**
   
The track channel strips expand to include the Sends section, located between the Inserts and I/O sections of the channel strip.

2. **Click one of the entries in the Send section to open the entry’s pop-up menu.**

3. **Select the bus or hardware output/input to which you want to send the signal.**
   
The Send window opens.
4. **In the Send window, select Pre- or Post-Fader.**
   Selecting Pre-Fader sends the signal from your track before the fader control for that track and selecting Post-Fader sends the signal after it passes through the channel's fader.

5. **While still in the Send window, adjust your level, panning, and mute settings.**

To assign an effect to this sent signal, follow these steps:

1. **Choose File ➪ New Track from the main menu.**
   The New Track dialog box appears.

2. **Use the drop-down menus to enter the number of tracks you want, the type (in this case choose Auxiliary Input), and whether you want your tracks(s) in stereo.**

3. **Click Create.**
   The auxiliary input appears in your session.

4. **Assign the input for this auxiliary track to the bus that you chose for your send destination in the previous list.**

5. **Follow the steps for inserting an effect into a track (see “Inserting inserts,” earlier in this chapter).**

**Viewing sends**
You can view your sends, send controls, and send assignments by opening the following windows in your session:

- **Send A-E views:** You can see the controls for a send in the track's channels strip by choosing Display ➪ Send View Shows ➪ A-E from the main menu, where A-E represents a listing of the sends you have available to work with.

- **Send View Level Meters:** If you want to add to the basic Send view (see previous bullet) to include level meters for the Send signal, select Show Meters in Sends View in the Display tab of the Preferences dialog box. (Choose Setups ➪ Preferences from the main menu to access this dialog box.)

- **Send Assignments:** You can show Send assignments for your tracks by choosing Display ➪ Sends View Shows ➪ Assignments from the main menu. This lets you see the names of the sends assigned to a track.

- **Send Output Window:** You can open a window that contains all the Send settings in a large format by clicking the name of the Send in the Send section of the track's channels strip. This Send Output window is explained further in the section “Accessing Output Windows,” later in this chapter.
✦ **Send Names:** As one more way to stay organized, you can name the destination buses for your sends. Do so by choosing Setups ➤ I/O Setup from the main menu and then choosing the Bus tab of the I/O Setup dialog box. After you get the Bus tab up, double-click the name of one of the buses (to highlight it) and then type in its new name, as shown in Figure 2-7.

![I/O Setup](image)

**Figure 2-7:** You can create names for your buses to keep your effect sends straight.

**Turning off the effect**

There are three ways to turn off the effect in a send:

✦ **Remove the Send:** To remove the send from the track, choose No Send from the Send pop-up menu. (Click-hold over one the arrows in the Send section of a track’s channel strip to open the pop-up menu.) This removes the send from the track and moves any other sends below it up the line.

✦ **Bypass the effect:** Do this by engaging the Bypass button in the plug-in window. This keeps the effect in-line but turns it off. The effect still draws processing power even though you don’t hear it. To open the plug-in window, click the name of the plug-in in the track that this plug-in is inserted into. The Bypass button is located at the top of the window.
✦ **Make the send inactive:** Do this by pressing Ctrl+Start/Windows (on a Windows PC) or Command+Ctrl (on a Mac) while you click the send bus’s name in the Sends list. Doing so removes the effect from the signal chain but not from the Sends list. Making a send inactive frees up processing resources, but you can still turn on the send at any time. (Simply repeat the keystrokes-and-click you used to turn it off.)

**Using sends for groups**

Controlling the send level and mute for sends across an entire group can be an enormous help, because it allows you to use one set of controls for all the tracks in a group. To control sends for a group, do the following:

1. **Choose Setups ➪ Preferences from the main menu.**
   
   The Preferences dialog box appears.

2. **Choose the Automation tab of the Preferences dialog box.**

3. **Check the Enable Send Level Follows Groups option and/or the Send Mute Follows Groups option.**
   
   This sets it up so that the following happens:
   
   - If you select Enable Send Level Follows Groups, any send level change you make on one track in the group affects all the tracks in a group.
   
   - If you select Send Mute Follows Groups, any send mutes that you create on one track in the group affect all the tracks in a group.

   For more on group sends, see Book 6, Chapter 6.

4. **Click Done.**

**Accessing Output Windows**

Outputs windows are floating sections of either the channel strip or the send settings. These windows allow you to adjust Output controls without having to search for them in the Mix window. This section details the Send and the Track Output windows.

**Tackling Track Output windows**

Track Output windows contain Fader, Pan, Automation, Output Selector, Solo, and Mute controls, as shown in Figure 2-8.

To open a Track Output window, just click the Output Window button in the track’s channel strip in the Mix window, as shown in Figure 2-9.
Figure 2-8: The Output window for a track lets you adjust Output parameters from outside the Mix window.

Figure 2-9: Open a Track Output window by clicking the Output window button in the Mix window.
The track output window includes the following controls:

- **Close**: Clicking this button closes the window.
- **Path Meter View Box**: When you click this button (the last button to the right at the top of the window), another window opens, showing the meters for the output path you selected in the Path Selector box. (See the appropriate bullet item later in this list.)
- **Tracks Selector**: This box lets you choose the track that shows in this window. You can choose from any track (audio, auxiliary input, or master fader) in your session.
- **Output Selector**: From this box, you can choose from among the outputs (whether track or send) in your system.
- **Path Selector**: This button lets you choose the output path for the current track.
- **Automation Safe**: Clicking this button puts the track in Automation Safe mode where no new automation data can be written. (Book 6, Chapter 6 has more on automation data.)
- **Target**: Engaging this button keeps this track's window open if you click another Track or Send Output window. With the Target button disengaged (the button will be red), whenever you open a send in the Output Selector box (see bullet earlier in this section) or another track's Output Window button, the current track will be replaced by the new Track or Send Output window.
- **Inverse Pan**: For stereo tracks, this button ensures that when you move one of the pan controls (left or right) the other moves to exactly the opposite side. Make sure the Panner Link button (see next bullet) is depressed so this function can work.
- **Panner Link button**: This button links the two pan controls on a stereo track. With this button engaged, moving one panning slider also moves the other to the same location, whereas when the button is not engaged, you can move each panning control independently.
- **Pan controls**: These adjust the pan setting for the track.
- **Track fader**: This adjusts the volume of the track.
- **Track meter**: This display shows the level of the track as the session plays.
- **Mute**: Depressing this button mutes the track.
- **Solo**: Clicking this button solos the track.
- **Automation mode**: This pop-up menu lets you choose the automation mode for your track.
Setting up the Send Output window

The Send Output window, shown in Figure 2-10, shows the same basic information as the Track Output window (refer to Figure 2-8), with two exceptions:

✦ **Send Selector**: Instead of viewing and selecting the output for the track (Output selector), you can choose any of the five sends for the track.

✦ **Pre/post button**: This button controls whether the send is located before (pre-) or after (post-) the track’s fader control. This is the button marked “Pre” located just below the name of the track that feeds this send. Engaging this button sends the signal before the fader (pre-fader) and leaving the button untouched sends the signal after the fader (post-fader).

To open a Send Output window, just click the Send name in the track’s Send list in the Mix window.
Playing with Plug-ins

Whenever you want to process your tracks in Pro Tools — add EQ, effects, or dynamics processors — you use a plug-in. Plug-ins are audio-processing tools that change the sound of your original file. Some plug-ins permanently alter the original file and work offline (that is, processing happens without playing the session). This is the case with pitch-shifting, for example. Other plug-ins — reverb, for example — affect the audio file without permanently changing it, processing the audio in real time as the session plays.

These two types of audio processing — offline and real-time — are some of the more-powerful mixing tools available to you in Pro Tools. With them you can EQ your tracks and add compression, reverb, delay — and a myriad of other enhancements — to your music. Your only limitations are the plug-ins you have at your disposal and the processing power of your computer. This section introduces you to the two types of plug-ins — AudioSuite and RTAS (Real Time Audio Suite) — and then shows you how to route your system so you can use them effectively.

Real Time Audio Suite (RTAS)

RTAS plug-ins process your audio as your session plays, allowing you to make adjustments on the fly and be able to hear these changes immediately. This is handy for adding compression, delay, and reverb, for example. The drawback to this is that anytime you process as your session plays, you’re using up more of your computer-processing power — sometimes a lot more, as in the case of reverb. This section lays out the basics of using RTAS plug-ins (see Book 6, Chapters 3 through 5 for more detailed information).

Routing your RTAS plug-ins

RTAS plug-ins are like the effects processors that you plug into your mixer. The sound from your tracks are sent to these effects and routed back through the mixer so you can hear the affected sound.

There are two ways to place these effects in your mixer within Pro Tools: by using inserts or by using sends and returns. (Check out the previous section, “Rounding out Your Routing,” for more on inserts and sends.)

✦ Inserts: Inserting a plug-in basically involves putting the effect inline with the audio as it travels through the channel strip in your mixer. This means all the sound from the audio file passes through the effect on its way out of the mixer (and to your ears).

When you insert a plug-in, you can choose from three formats:

✦ Mono in/mono out: One channel goes in and one comes out of the effect.
- **Mono in/stereo out**: One channel goes in and two come out.
- **Stereo in/stereo out**: Two channels go in and two channels come out.

✦ **Sends**. Using a send for your effects lets you route a portion of your track’s signal that you can then control with the Send level. These sends are routed to an auxiliary track, into which the effect is inserted. Thus you can route more than one track to a single effect.

**Understanding the RTAS Plug-In window**

When you select a plug-in (or click its name in the Inserts section of a track’s channel strip), a window opens, displaying all the controls for the plug-in (as shown in Figure 2-11). Most plug-ins usually have controls similar to what you see in the following list:

✦ **Track Selector**: This control lets you choose to view the plug-ins for any of the tracks in your session (except MIDI). Selecting a track without a plug-in shows no insert.

✦ **Insert Selector**: Allows you to choose from the five inserts for the track you have selected.

✦ **Plug-In Selector**: This menu lets you select any RTAS plug-in that’s located in your Plug-Ins folder — the one located within the Pro Tools folder on your hard drive.

✦ **Bypass Button**: This button (surprise, surprise) bypasses the effect, allowing you to quickly and easily compare the affected and unaffected sounds. A bypassed effect shows as blue in the Mix and Edit windows. If you bypass some, but not all, of a multimono effect, the effect shows as purple in the Mix and Edit windows. This makes it easy for you to see whether one of your effects is bypassed without having to open all your Plug-In windows.
✦ **Settings menu:** Click-holding on the arrows at the left side of the plug-in window accesses the Settings pop-up menu, shown in Figure 2-12, which lets you save, copy, paste, import, delete, and lock your plug-ins’ settings, as well as set plug-in preferences (such as where to store these settings).

![Figure 2-12: The Plug-Ins Settings menu lets you save your settings, among other things.]

✦ **Librarian menu:** This drop-down menu lets you choose from plug-in settings that you may already have stored. This menu is activated by click-holding on the setting name (labeled Factory Default in figure 2-11) next to the arrows for the Settings pop-up menu.

✦ **Compare button:** This button lets you toggle back and forth between your current and your previous setting.

✦ **Automation Enable button:** Clicking this button opens the Plug-In Automation dialog box, which allows you to set automation for your selected plug-in parameters. (Book 6, Chapter 6 has more on automation.)

✦ **Automation Safe button:** Engaging this button keeps any written automation data from being overwritten.

✦ **Target button:** Depressing this button keeps the current Plug-In window open when you open another plug-in. With this button off, clicking the plug-in name in a track’s insert replaces the open window with a new window.

✦ **Phase Invert button:** This button (not available on all plug-ins) allows you to reverse the phase of the audio passing through the plug-in. This means flipping the waveform top to bottom.

**Working with RTAS plug-ins**

Chances are that you’ll spend quite a bit of time using plug-ins. Unless you have a control surface, you’ll probably end up spending more time than necessary just mouse-jockeying the controls. In this section, I offer some shortcuts to make working with plug-ins quicker and easier.
✦ To make fine adjustments with your mouse, press Ctrl (on a PC) or Command (on a Mac) while you drag the plug-in control.

✦ You can return a control to its default setting by pressing Alt (on a PC) or Option (on a Mac) while you click that control.

✦ You can move through the controls in a plug-in by pressing the Tab key on your keyboard. To go backward, press Shift+Tab.

✦ For plug-in parameters that offer kilohertz values, press the K key after the number of kilohertz you want to enter (for example, to enter 10 kHz, type 10k).

✦ To increase the value of a parameter without using your mouse, press the Up-arrow key on your keyboard; to decrease a value, press the Down-arrow key.

✦ To enter a value using your keyboard, type in the value in the parameter box and then press Enter (on a PC) or Return (on a Mac).

AudioSuite

Pro Tools comes with a variety of offline plug-ins — that is, effects that you can use to process your tracks so that you end up either altering the original audio file or creating a new one. These types of plug-ins are listed under AudioSuite in the main menu. Figure 2-13 shows the plug-ins that come with Pro Tools LE.
Understanding the Plug-In window

When you select a plug-in from the AudioSuite menu, a window opens, containing all the controls for the plug-in, as shown in Figure 2-14. You’re going to find the same kinds of controls for nearly all the plug-ins. They include the following:

- **Plug-in Selector**: This menu lets you select from any AudioSuite plug-in listed in the AudioSuite menu.

- **Selection Reference**: This menu lets you choose which regions are processed. By default, when you select a region in the track, in the playlist, or in the Audio Regions list, all occurrences of the selected region are processed. You can limit the processing to either the track/playlist or the Audio Regions list by selecting from the pop-up menu. Your choices are
  - **Playlist**: If you choose Playlist, only regions that are currently selected in tracks or playlists in the Edit window are processed.
  - **Region List**: If you choose this option, only regions currently selected in the Audio Regions list are processed.
✦ **Use in Playlist button:** This button lets you choose whether your chosen processing happens to all instances of your selected regions throughout the session, or whether processing happens only to those you have selected. The settings are as follows:

- **Off:** When this button is disabled, your processed audio is added to the Audio Regions list but not put into the session.

- **On:** When this button is enabled, the processed audio is placed in the playlist according to the Selection reference you have chosen. (See the previous bullet item.) If you have Region List selected, all copies of the region are replaced within the session. If you selected Playlist, only the regions that you selected in the tracks are replaced.

✦ **File Mode Selector:** This menu allows you to choose how your audio is processed. You have three options:

- **Overwrite Files:** This option destructively overwrites your original file. Not all plug-ins have this option.

- **Create Individual Files:** This option creates a new audio file for each region processed. These regions appear in the Audio Regions list.

- **Create Continuous File:** Choosing this option processes the selected region as a single audio file. This option isn’t available when you have Region List chosen as you Selection reference. (See the earlier bullet item in this list).

✦ **Process Mode Selector:** This menu appears if you have a selection that includes more than one region. With it, you can select whether processing is done region by region or whether it affects the entire selection.

✦ **Settings menu:** This drop-down menu lets you save, copy, paste, import, delete, and lock your plug-ins settings as well as set plug-in preferences (such as where to store these settings). 2-12 shows this menu.

✦ **Librarian menu:** This pop-up menu lets you choose from plug-in settings that you may already have stored.

✦ **Compare button:** This button lets you compare the unprocessed sound to the processed sound.

✦ **Preview button:** Pressing this button lets you preview the audio before you commit to processing it.

✦ **Bypass button:** This button bypasses the effect, allowing you to quickly and easily compare the affected and unaffected sounds. (This button only applies to the Preview feature and doesn’t change the processing of the file.)

✦ **Process:** Clicking this button processes the region(s) you have selected according to the rest of the settings in this window.
Using AudioSuite Plug-ins

You can use the AudioSuite plug-ins to process any part — or all — of an audio region. If you choose part of a region, that region is split so the selected part becomes its own region.

To use an AudioSuite plug-in, follow these steps:

1. **Using the Selector tool, select the region or regions (click-drag across them) in the Edit window you want to process.**
   
   Book 4, Chapter 2 details this process.

2. **Select the plug-in from the AudioSuite menu.**
   
   The Plug-In window appears.

3. **Click Preview to hear your selected material.**

4. **Adjust the plug-in controls until you get the sound and processing settings you want.**
   
   The previous section spells out what these settings are for.

5. **Click the Process button.**
   
   Pro Tools processes your audio.

Be aware that the processing can take some time and always demands some computer resources.

Processing with External Effects

You can connect external effects devices (such as a reverb or compressor), to Pro Tools and easily route your sends or inserts to them. The advantage of using an external device (with its own dedicated source of processing power) is that you can reduce demand for your system’s resources. The disadvantage is that going out and back into Pro Tools takes at least some time; you get a delay (also known as latency) in the returned signal, especially if you’re using the analog connection in your Digidesign interface. This latency isn’t much of a problem with reverbs, since often a pre-delay on the effect is desirable anyway, but it can be a real issue if you use an analog compressor. (Book 6 Chapter 5 talks about pre-delay on reverb.)
The best way to eliminate the latency inherent in routing to an external analog device is to record your effect to a new track and then shift the new region in that track over so it synchronizes with the source track for that instrument (Book 4, Chapter 3 explains the process of shifting regions.)

Using an external effects device requires three simple steps: creating a hardware insert, connecting the device to your interface, and assigning the insert in your track. How to go about that? Glad you asked . . .

**Creating a hardware insert**
Before you can route your track’s insert to an external device, you need to create a hardware insert — an insert in a track that routes your signal to one of the hardware inputs and outputs of your Digidesign interface. Follow these steps:

1. **Choose Setups ➤ I/O Setup from the main menu.**
   The I/O Setup dialog box appears.
2. **Choose the Insert tab on the I/O Setup dialog box.**
3. **Choose one of the insert paths listed (or choose Default if none are listed); double-click that path to create a new name for it.**
   The insert becomes highlighted.
4. **Type in a new name for the insert.**
5. **Select the proper format for the insert path (mono or stereo).**

**Connecting your external device**
You can connect either an analog or digital device as your hardware insert. This section describes connecting both devices.

**Connecting an analog device**
Nothing much to it, really. Just do the following:

1. **Select the output and input (or pairs for stereo) that correspond to the inserts you created in the previous section.**
2. **Connect the output of your Digidesign interface to the input of your external device.**
3. **Connect the output of your external device to the selected input in your Digidesign interface.**
Connecting a digital device

Whoa, here comes the high-tech stuff, right? Nah. It’s a bit more involved, but it’s still not brain surgery:

1. **Connect your external device to your Digidesign interface using the digital connections on the back of your device.**
   
   Depending on your device, you either use an optical connection or a coaxial S/PDIF connection (Book 1, Chapter 2 has more about these types of connections). Connect the output of your Digidesign interface to the input of your external device and the Output of your external device to the input of your Digidesign interface.

2. **Choose Setups > Hardware Setup from the main menu.**
   
   The Hardware Setup dialog box opens.

3. **Click your Digidesign interface in the Peripheral section of the window to select your Digidesign interface.**
   
   If you only have one Digidesign interface connected to your computer, it is automatically highlighted.

4. **Perform one of the following in the Digital Input section of the Hardware Setup dialog box:**
   
   - To connect through the optical ports, choose S/PDIF from the Optical Format drop-down menu.
   - To connect through the coaxial (RCA) S/PDIF jack.

5. **Choose your clock source — the digital clock that controls your system — from the Clock Source pop-up menu.**
   
   - If you want the effect device to be your clock source select External.
   - If you want Pro Tools to be the clock source (or if you don’t know what a clock source is) select Internal.

   Check out the Pro Tools Reference manual for more on clock sources.

6. **Set your external device to the appropriate clock source — Internal if you selected External in Pro Tools, and External if you selected Internal in Pro Tools.**
   
   Your owner’s manual should describe this process.

7. **Click OK.**
Routing your track
To route your track's insert to the hardware insert connected to your effects device, select the hardware insert from the Insert Pop-up menu, accessed by click-holding over one of the arrows in the Insert section of your track's channel strip.

You're now ready to dig in and use your external effect processor on your Pro Tools tracks.

The only disadvantage with using external effects in Pro Tools is that you can't save the effect settings with your Pro Tools session like you can with an RTAS plug-in. In order to get around this deficit, I usually type the effect patch (setting number) I use for a track in the Comments section of the track. To enter this information, double-click on the track's name in either the Edit or Mix window to call up the Name Track dialog box. Then enter your effect patch and any other reminders you need in the Comments section and click OK to save your comments and close the window.
Chapter 3: Using Equalization

In This Chapter
- Understanding equalization
- Inserting EQ in a track
- Getting to know the EQ options in Pro Tools
- Equalizing your tracks

Equalization (EQ) is the process of changing the frequency response of the data in the session’s track to make the track sound the way you want. The main goal when EQing during the mix process is to get the instruments in your song to smoothly blend together.

In this chapter, you discover the types of equalizers used in Pro Tools and you walk through the process of applying EQ to your tracks. This chapter also offers some basic EQ settings for a variety of instruments to get you started EQing your songs.

Exploring Equalization

The most useful tool you have for mixing is equalization (EQ). You use equalizers to adjust the various frequencies of your instruments so that there’s enough room for each of them in your stereo tracks. Pro Tools offers three types of equalizers — parametric, low-shelf/high-shelf, and low-pass/high-pass. I outline these types of EQ in the following sections.

Parametric

The parametric equalizer (called a Peak EQ in Pro Tools and designated by the icon shown here in the margin) allows you to choose the frequency that you want to change as well as the range of frequencies around that frequency. With a parametric EQ, you dial in the frequency that you want to change and then set the range itself (referred to as the Q) that you want to affect.

The Q is a number that signifies the range of frequencies that the EQ affects — usually between ½ and 2 octaves. Pro Tools offers settings from .33 to 12, with the lower numbers allowing larger ranges of frequencies to be EQed.
You choose your Q setting based on what you hear in the mix. Just as you can experiment with different frequencies to adjust in the mix, you can also try different Q settings to find the best-possible frequency range to use.

The beauty of a parametric EQ is that you can take a small band (range) of frequencies and boost (increase) or cut (decrease) them. This capability enables you to get the various instruments in a mix to fit in with one another. (This technique is called carving out frequencies.) When you’re mixing, the parametric EQ is the most useful equalizer because you can adjust the frequency response of each instrument so that the other instruments can be heard clearly in the mix. The only downside to parametric EQs is that they need processing power to run. If you have a lot of Eqing to do, you may end up stressing your system pretty hard. (Yet another reason to have a powerful computer.)

**Low-shelf/high-shelf**

A shelf equalizer affects a range of frequencies above (high-shelf) or below (low-shelf) the target frequency. Shelf EQs are generally used to roll off the top or bottom end of the frequency spectrum. For example, you can set a low-shelf EQ to roll off the frequencies below 250 hertz (Hz), which reduces the amount of rumble (low-frequency noise) in a recording. You generally use the shelf EQ to adjust the lowest and highest frequencies and the parametric EQ to adjust any in-between frequencies when you mix.

In Pro Tools, the low- and high-shelf EQs are designated with the icons seen here in the margin.

**Low-pass/high-pass**

Believe it or not, sometimes your track just sounds better if you eliminate a few carefully chosen frequencies. You just need to know which ones to target. That’s where a couple of Pro Tools capabilities can help with the needed audio acrobatics: low-pass (duking the high frequencies you don’t want) and high-pass (jumping over the low frequencies you don’t want).

This type of EQ is actually called a filter — it filters out frequencies either higher (low-pass) or lower (high-pass) than the target frequency. The high-pass filter is useful for getting rid of unwanted low frequencies, and the low-pass filter is used for eliminating unwanted high frequencies. In Pro Tools, the low- and high-pass filters are designated with the icons seen here in the margin.

**Dialing in EQ**

Before you start EQing your tracks, you need to know how to insert the EQ plug-in in a track and how to actually make those adjustments with one of the EQ plug-ins in Pro Tools. This section details these procedures.
Inserting an EQ plug-in in a track

To EQ a track, you first need to insert the Pro Tools AudioSuite plug-in in the track. To do so, follow these steps:

1. **Choose Display➪Mix Window Shows: Inserts from the main menu to make sure that the Inserts section is showing in the Mix window.**

2. **Click the top arrow on the left side of the Inserts section of the track’s channels strip.**

   The Inserts pop-up menu appears, as shown in Figure 3-1.

3. **Select either the Multi-Channel Plug-In or Multi-Mono Plug-In option to fit the type of track you have.**

   If your track is stereo, use Multi-Channel; if it’s mono, use Multi-Mono.

4. **Select either the 1-Band EQ II or 4-Band EQ II option.**

   Your chosen EQ plug-in window opens. (The 1-Band EQ II option lets you set one EQ parameter, whereas the 4-Band EQ II option lets you work with four parameters. For more on which option would work best for you, check out the following section.)

5. **Adjust the parameters that you want to EQ.**

   You can find the particulars for each kind of EQ — parametric, low-shelf/high-shelf, and low-pass/high-pass — later in the chapter.

---

**If you want to EQ a bunch of tracks at the same time and use the same settings (submixes, for example), you can do this the following way:**

1. **Select one of the buses from the Output selector in each track that you want to submix.**

2. **Choose File➪New Track from the main menu.**

   The New Track dialog box appears.

3. **Use the drop-down menus to enter the number of tracks that you want (1 the type (Auxiliary Input) and whether you want your track in stereo.**
4. Use your new track’s Input selector to select the bus that you used for the output of the submix tracks as the input for this auxiliary track.

5. Insert one of the EQ plug-ins from the Insert pop-up menu in this auxiliary track.

The EQ plug-in window opens.

6. Adjust the EQ settings to get the sound that you want.

You can find the particulars for each kind of EQ — parametric, low-shelf/high-shelf, and low-pass/high-pass — later in the chapter.

**Perusing Pro Tools EQ options**

Using an EQ in Pro Tools consists of selecting one of the plug-ins, inserting it in the track that you want to affect, and setting your parameters. Pro Tools comes with two basic EQs: 1-band EQ and 4-band EQ. (They’re part of the RTAS set of tools.)

You can also use any RTAS-type EQ plug-in, but these have to be purchased separately. If you do an Internet search with the keyword RTAS plug-ins, you’re sure to find tons to choose from. (For you enquiring minds out there, RTAS stands for Real Time Audio Suite — the plug-in format that Pro Tools uses.)

**1-band EQ**

The 1-band EQ plug-in for Pro Tools, shown in Figure 3-2, lets you apply one EQ filter to a track. This EQ is useful if you just want to adjust one parameter. You can choose any of the three types of EQs — parametric, low-shelf/high-shelf, and low-pass/high-pass — by clicking the appropriate button to engage your chosen EQ.

**4-band EQ**

The four-band EQ in Pro Tools, shown in Figure 3-3, lets you adjust up to four EQ filters to a track. This type of EQ is useful when you have to do some major EQing to a track. You can choose from a low-shelf, high-shelf, and two parametric (Peak) EQs.

In the 4-Band EQ plug-in window, the high shelf is located at the top of the window and the low shelf at the bottom. The two parametric EQs are located between the two shelf EQs.
Using Equalization

Dialing in EQ 539

Figure 3-2: The 1-band EQ plug-in in Pro Tools lets you make one EQ setting.

Figure 3-3: The 4-band EQ in Pro Tools lets you apply four EQ filters to a track.
Using parametric EQ
To use the parametric EQ, click the Peak EQ button in whatever EQ plug-in window — 1-band or 4-band, for example — you have open. You have three settings to adjust:

✦ **Gain:** This is the amount of boost (increase) or cut (decrease) that you apply to the signal. You can either type in the amount in the box next to the Peak EQ button or use the slider to the right.

✦ **Freq:** This is the frequency that the EQ centers around. You select the range of frequencies above and below this point by using the Q setting (see next bullet). You can either type in the frequency on the box or you can use the slider to make your adjustment.

✦ **Q:** This is the range of frequencies that your EQ will affect. The higher the number, the narrower the range that gets EQed. You adjust this setting either by moving the slider or by clicking in the box and typing a value between .33 and 12.

Using low-shelf/high-shelf EQ
To use low-shelf/high-shelf EQ, click the Low Shelf and High Shelf buttons in the EQ plug-in window. When you use low-shelf/high-shelf EQ, you have two parameters to adjust:

✦ **Gain:** This is the amount of boost or cut that you apply to the signal. You can either type in the amount in the box next to the shelf button or use the slider to the right.

✦ **Freq:** This is the frequency that the shelf starts at. You can either type in the frequency in the box or use the slider to make your adjustment.

Using low-pass/high-pass EQ
Here’s where you tell Pro Tools which frequencies to avoid in the course of adjusting the EQ. The low- and high-pass buttons appear in the margin.

To use the low- or high-pass filter, click the appropriate button in the EQ window. The only option to set is Freq, which is the frequency that the filter engages. Any frequency below (high-pass) or above (low-pass) the setting is removed from the track. You can either type the frequency in the box or use the slider to make your adjustment.

Equalizing Your Tracks
Only so many frequencies are available for all the instruments in a mix. If more than one instrument occupies a particular frequency range, they can get in each other’s way and muddy the mix. Your goals when EQing during
the mixing process are to reduce the frequencies that add clutter and/or to enhance the frequencies that define an instrument’s sound. To do this, make a little space for each instrument within the same general frequency range, which you can accomplish by EQing the individual tracks as you mix. The first part of this chapter shows you how to get up to the point of doing some EQing. The rest of the chapter gets your hands dirty with some real EQing experience.

Here’s a good trick to use when initially trying to decide which frequencies to boost or cut: First, solo the track(s) that you’re working on and set your parametric EQ to a narrow Q setting (a high number). Next, turn the boost all the way up (move the Gain slider all the way to the right) and sweep the frequency setting as you listen (to sweep, just move the Freq slider to the left and right). Noticing the areas where the annoying or pleasing sounds are located can help you better understand the frequencies that your instrument produces. When you find a frequency to adjust, experiment with the Q setting to find the range that produces the best sound, and then adjust the amount of boost or cut until it has the effect that you want.

After you determine the frequencies that you want to work with, do your EQing to the individual track while the instrument is in the mix (not soloed). You want to make the instrument fit as well as possible with the rest of the instruments, and to do this you need to know how your instrument sounds in relation to all the music going on around it.

Your goal when making adjustments in EQ is to make all the tracks blend together as well as possible. In some instances, you may have to make some radical EQ moves. Don’t be afraid to do whatever it takes to make your mix sound good — even if it means having cuts or boosts as great as 12dB.

**General guidelines**

Although some instruments do call for specific EQ guidelines, you need to think about some general considerations when EQing, regardless of the instrument involved. When it comes to the audible frequency spectrum (which is about 20 Hz to 20 kHz), certain frequencies have special characteristics:

✦ Frequencies below 100 Hz can either warm up an instrument or can add boominess to it.

✦ Frequencies between 100 and 200 Hz can be muddy for some instruments and can add fullness to others.

✦ Frequencies around 400 Hz can sound boxy.

✦ Frequencies around 800 Hz can add depth or body.

✦ 1-kHz to 2-kHz frequencies can add *attack* (initial signal) or *punch* (pronounced attack) to some instruments and can create a nasally sound in others.
2 kHz to 5 kHz can increase the presence of instruments.

5-kHz to 8-kHz frequencies can sound harsh on some instruments.

Frequencies from 8 kHz to 17 kHz add airiness or brightness to an instrument.

You’re generally better off cutting a frequency than boosting one. This belief goes back to the days of analog EQs, which often added noise when boosting a signal. This can still be a factor with some digital EQs, but the issue is much less. Out of habit, I still try to cut frequencies before I boost them, and I recommend that you do the same (not out of habit, of course, but because if a noise difference exists between cutting and boosting, you may as well avoid it).

The exact frequencies that you end up cutting or boosting depend on three factors: the sound you’re after, the tonal characteristic of the instrument, and the relationship between all the instruments in the song. In the following sections, I list a variety of frequencies to cut or boost for each instrument. If you don’t want to follow all the suggestions, choose only the ones that fit with your goals.

The Parametric EQ is the type of EQ you use most when trying to get your tracks to fit together. This EQ gives you the greatest control over the range of frequencies you can adjust. The other EQ types (high-shelf, low-shelf, high-pass, low-pass) can often be used successfully for the top or bottom frequencies listed in the sections that follow.

To adjust frequencies using Pro Tool’s EQ plug-ins, use the Frequency slider to choose the frequency you want to EQ and the Gain slider to control the amount of EQ that you boost (move the slider to the right) or cut (move the slider to the left) from your track.

**Vocals**

For the majority of popular music, the vocals are the most important instrument in the song. You need to hear them clearly, and they should contain the character of the singer’s voice and style. One of the most common mistakes in mixing vocals is to make them too loud. The next most common mistake is to make them too quiet. (The second mistake most often occurs when a shy or self-conscious vocalist is doing the mixing.) You want the lead vocals to shine through, but you don’t want them to overpower the other instruments. The best way to do this is to EQ the vocal tracks so they can sit nicely in the mix and still be heard clearly. The following guidelines can help you do this.

**Lead**

The lead vocal can go a lot of ways, depending on the singer and the style of music. For the most part, I tend to cut a little around 200 Hz and add a couple dBs at 3 kHz and again at 10 kHz. In general, follow these guidelines:
Equalizing Your Tracks

✦ To add fullness, add a few dBs at 150 Hz.
✦ To get rid of muddiness, cut a few dBs at 200 to 250 Hz.
✦ To add clarity, boost a little at 3 kHz.
✦ For more presence, add at 5 kHz.
✦ To add air or to brighten, boost at 10 kHz.
✦ To get rid of sibilance, cut a little between 7.5 to 10 kHz.

Backup
To keep backup vocals from competing with lead vocals, cut the backup vocals a little in the low end (below 250 Hz) and at the 2.5-to-3.5-kHz range. To add clarity, boost a little around 10 kHz without letting it get in the way of the lead vocal.

Guitar
For the most part, you want to avoid getting a muddy guitar sound and make sure that the guitar attack comes through in the mix.

Electric
Electric guitars often need a little cutting below 100 Hz to get rid of muddiness. A boost between 120 and 250 Hz adds warmth. A boost in the 2.5-to-4-kHz range brings out the attack of the guitar, and a boost at 5 kHz can add some bite.

Acoustic
Acoustic guitars often do well with a little cut below 80 Hz and again around 800 Hz to 1 kHz. If you want a warmer tone and more body, try boosting a little around 150 to 250 Hz. Also, try adding a few dBs around 3 to 5 kHz if you want more attack or punch. A few dBs added at 7 kHz can add a little more brightness to the instrument.

Bass
This instrument can get muddy pretty fast. The mud generally happens in the 200 to 300 Hz range, so I either leave that alone or cut just a little if the bass lacks definition. I rarely add any frequencies below 100 Hz. If the instrument sounds flat or thin, I boost some between 100 and 200 Hz. Adding a little between 500 Hz and 1 kHz can increase the punch, and a boost between 2.5 and 5 kHz accentuates the attack, adding a little brightness to the bass.

One of the most important things to keep in mind with the bass guitar is to make sure that it and the kick drum can both be heard. You need to adjust the frequencies of these two instruments to make room for both. If you add a frequency to the kick drum, try cutting the same frequency from the bass.
**Drums**

The guidelines for EQing the drums depend on whether you use live acoustic drums or a drum machine. (The drum machine probably requires less EQ because the sounds were already EQed when they were created.) The type and placement of your mic or mics also affect how you EQ the drums. (You can find out more about mic placement in Book 3, Chapter 2.)

**Kick**

You want the kick drum to blend with the bass guitar. To do this, reduce the frequencies that the bass guitar takes up. For example, if I boost a few dB between 100 and 200 Hz for the bass guitar, I generally cut them in the kick drum (and maybe go as high as 250 Hz). To bring out the bottom end of the kick drum, I sometimes add a couple of dBs between 80 and 100 Hz. The kick drum can get boxy sounding (you know, like a cardboard box), so I often cut a little between 400 and 600 Hz to get rid of the boxiness. To bring out the click from the beater hitting the head, try adding a little between 2.5 and 5 kHz. This increases the attack of the drum and gives it more presence.

**Snare**

The snare drum drives the music, making it the most important drum in popular music. As such, it needs to really cut through the rest of the instruments. Although the adjustments that you make depend on the pitch and size of the drum and whether you used one mic or two during recording, you can usually boost a little at 100 to 150 Hz for added warmth. You can also try boosting at 250 Hz to add some depth. If the drum sounds too boxy, try cutting at 800 Hz to 1 kHz. A little boost at around 3 to 5 kHz increases the attack, and an increase in the 8 to 10 kHz range can add crispness to the drum.

If you used two mics during recording, you might consider dropping a few dBs on the top mic in both the 800 Hz to 1 kHz range and the 8 to 10 kHz range. Allow the bottom mic to create the crispness. I generally use a shelf EQ to roll off the bottom end of the bottom mic below, say, 250 to 300 Hz. Depending on the music (R&B and pop, for instance), I may use a shelf EQ to add a little sizzle to the bottom mic by boosting frequencies above 10 kHz.

For many recording engineers and producers, the snare-drum sound is almost a signature. If you listen to different artists’ songs from the same producer, you’ll likely hear similarities in the songs’ snare-drum sound. Don’t be afraid to take your time getting the snare drum to sound just right. After all, if you become a famous producer, you’ll want people to recognize your distinct snare-drum sound. And you want it to sound good anyway.
Tom-toms

Tom-toms come in a large range of sizes and pitches. For mounted toms, you can boost a little around 200 to 250 Hz to add depth to the drum. A boost in the 3 to 5 kHz range can add more of the sticks’ attack, and for some additional presence, try adding a little in the 5 to 8 kHz range. If the drums sound too boxy, try cutting a little in the 600-Hz-to-1-kHz range.

For floor toms, you can try boosting the frequency range 40 to 125 Hz if you want to add some richness and fullness. You may also find that cutting in the 400-to-800-Hz range can get rid of any boxy sound that the drum may have. To add more attack, boost the 2.5-to-5-kHz range.

Hi-hats

Most of the time, the hi-hats are pretty well represented in the rest of the mics in the drum set, but depending on which mics are picking up the hi-hats, you can use the hi-hat mic to bring out their sheen or brightness. To do this, try boosting the frequencies above 10 kHz with a shelf EQ. You may also find that cutting frequencies below 200 Hz eliminates any rumble created by other drums that the hi-hat mic picked up.

Cymbals

With the cymbals, I usually cut anything below 150 to 200 Hz with a shelf EQ to get rid of any rumbling that these mics pick-up. I also drop a few dBs at 1 to 2 kHz if the cymbals sound kind of trashy or clanky. Adding a shelf EQ above 10 kHz can add a nice sheen to the mix.

Overhead mics

If you used overhead mics to pick up both the drums and the cymbals, be careful about cutting too much low end — doing so just sucks the life right out of your drums. Also, if the drums coming through the overhead mics sound boxy or muddy, work with the 100-to-200-Hz frequencies for the muddiness and 400-Hz-to-1-kHz frequencies for the boxiness.

Percussion

High-pitched percussion instruments (shakers, for example) sound good when the higher frequencies are boosted a little bit, over 10 kHz for instance. This adds some brightness and softness to their sound. You can also roll off many of the lower frequencies, below 500 Hz, to eliminate any boxiness that might be present from miking too closely. (See Book 3, Chapter 2 for more on mic placement.)
Lower-pitched percussion instruments, such as maracas, can also have the lower frequencies cut a little — use 250 Hz and lower. Try boosting frequencies between 2.5 and 5 kHz to add more of the instruments’ attack. To brighten them up, add a little bit in the 8-kHz-to-10-kHz range.

**Piano**

For pianos, you often want to make sure that the instrument has both a nice attack and a warm-bodied tone. You can add attack in the 2.5-to-5-kHz range, and warmth can be added in the 80-to-150-Hz range. If your piano sounds boomy or muddy, try cutting a little between 200 and 400 Hz.
Chapter 4: Digging into Dynamics Processors

In This Chapter

- Understanding and using effects in Pro Tools
- Getting to know compressors and limiters
- Introducing gates and expanders
- Examining side-chain processing

Dynamics processors allow you to control the dynamic range of a signal. The dynamic range is the difference between the softest and loudest signals that a sound source produces. The dynamic range is listed in decibels (dB). The larger the dynamic range, the more variation exists between the softest and loudest notes.

The four types of dynamics processors are compressors, limiters, gates, and expanders. This chapter gives you the lowdown on each type and how they can help you do a number of important things to your music. You can add punch or smooth out an instrument’s sound, even out an erratic performance, or eliminate noise from a track.

Connecting Dynamics Processors

Dynamics processors are Insert effects. This means you insert them into a track so they become part of it, affecting the track’s entire signal. To apply a dynamics processor in Pro Tools follow these steps:

1. Choose Display ‹ Mix Window Shows ‹ Inserts from the main menu to make sure that the Inserts section is showing in the Mix window.
2. Click the top arrow on the left side of the Inserts section of the track’s channel strip.
   The Inserts pop-up menu opens, as shown in Figure 4-1.
3. Select either the Multi-Channel Plug-In or Multi-Mono Plug-In option depending on whether your track is a stereo (in which case, use multichannel) or a mono (use multimono) track.
4. Select the Compressor, Limiter, Expander-Gate, or Gate option.
Introducing Compressors

The chosen plug-in window opens. (Figures 4-2, 4-3, 4-4, and 4-5 show the Compressor, Limiter, Expander-Gate, and Gate respectively).

Introducing Compressors

The compressor's job is to compress (go figure) the dynamic range of the sound being affected. The compressor not only limits how loud a note can be but also reduces the difference between the loudest and softest note, compressing the dynamic range.

Compressors are used for three main purposes (although other purposes certainly exist as well):

✦ To keep transients — the initial attack of an instrument — from creating digital distortion during tracking. This is common with drums that have a very fast attack (initial signal) that can easily overload the recorder (or converters or preamps).

✦ To even out any performance that shows signs of a high degree of unwanted dynamic variation. You do this during either the mixing or tracking stage. Some recorded passages are too loud and others are too quiet.

✦ To raise the overall apparent level of the music during mastering. For example, listen to a CD recorded ten years ago and one from the last year or so. The newer CD sounds louder.

I cover Purpose 1 in Book 3, Chapter 2, and I explore Purpose 3 in Book 7, Chapter 2. So that leaves Purpose 2 to explore with sample settings later in this section.

Getting to know compressor parameters

Pro Tools comes with its own compressor plug-in, as detailed in the previous section. After you get this guy open, you're going to want to adjust the following parameters (listed top to bottom in Figure 4-2):
Gain: The Gain slider allows you to adjust the level (volume) of the signal going out of the compressor. This is listed in decibels (dB). Because adding compression generally reduces the overall level of the sound, you use this control to raise the level back up to where it was when it went in.

Threshold: The Threshold setting dictates the dB level at which the compressor starts to act on the signal. This setting is often listed as dB below peak (0dB). In other words, a setting of –6dB means that the compressor starts to act when the signal is 6 decibels below its calibrated 0dB mark. (In digital systems, 0dB is the highest level a signal can go before clipping.)

Ratio: The Ratio setting shows the how much the compressor affects the signal. The ratio — 2:1, for instance — means that for every decibel that the signal goes over the threshold setting, it is reduced by two. In other words, if a signal goes 1dB over the threshold setting, its output from the compressor will be only 1⁄2dB louder. With ratios above 10:1, your compressor starts to act like a limiter (see the later section “Looking into Limiters”).

Attack: The Attack slider controls how soon the compressor kicks in. The attack is defined in milliseconds (ms), and the lower the number, the faster the attack.

Release: The Release slider controls how long the compressor continues affecting the signal after it drops back below the Threshold setting. Like the attack, the release is defined in milliseconds. The lower the number, the faster the release time.

Knee: The Knee slider controls how the compressor behaves as the input signal passes the threshold. The lower the setting, the more gradual the compressor acts as the signal passes the threshold.
Getting started using compression

The compressor is one of the most useful — and one of the most abused — pieces of gear in the recording studio. The most difficult part of using compression is that every instrument reacts differently to the same settings. In this section, I offer you some guidelines and ideas for using the compressor effectively.

The following steps show you one good way to get familiar with the compressor:

1. Start with a high Ratio setting (between 8:1 and 10:1) and move the Threshold slider all the way to the right.

2. Slowly move the Threshold slider back to the left, watch the meters, and listen carefully.
   As you reduce the threshold, notice where the meters are when you start hearing a change in the sound of the track. Also notice what happens to the sound when you have the threshold really low and the meters are peaked. (The sound is very different from where you started.)

3. Slowly move the Threshold slider back to the right and notice how the sound changes back again.

After you get used to how the sound changes as you adjust the Threshold setting, try using different Attack and Release settings and do this procedure again. The more you experiment and critically listen to the changes made by the different compressor settings, the better you’ll understand how to get the sound that you want. The following guidelines can also help you achieve your desired sound:

✦ Try to avoid using any compression on your two-track mix while you mix your music. Compression is a job for the mastering phase of your project. If you compress your stereo tracks during mixdown, you limit what can be done to your music in the mastering stage. This is true even if you master it yourself and think you know what you want during mixdown.

✦ If you hear noise when you use your compressor, you’ve set it too high. What’s happening is you’re compressing the loud portions enough to make the level of the softest sections of the music (including any noise) much louder in comparison. To get rid of the noise, decrease the Ratio or the Threshold settings.

✦ To increase the punch of a track, make sure that the Attack setting isn’t too quick. Otherwise, you lose the initial transient and the punch of a track.

✦ To smooth out a track, use a short Attack setting and a quick Release time. This evens out the difference in level between the initial transient and the body of the instrument, and results in a smoother sound.
Less is more when using compression. Resist the temptation to move those sliders too much to the right — it just squashes your music. On the other hand, if that’s an effect that you’re going for, don’t be afraid to experiment.

**Using compression**

When you first start experimenting with some compressor settings, you most likely won’t know where to start. To make this process easier for you, this section includes some sample settings for a variety of instruments. Start with these and use the guidelines listed in the previous section to fine-tune your settings.

**Vocals**

Most recording engineers think that compression is a must for vocals. It evens out the often-erratic levels that a singer can produce and tames the transient jumps in level that can cause digital distortion. You can use compression on vocals to even out the performance and to create an effect.

If you use a compressor to even out a vocal performance, you don’t want to hear the compressor working. Instead, you want to catch only the occasional extremely loud transient that would cause clipping. A good compression setting has three elements: a fast attack to catch the stray transient, a quick release so that the compression doesn’t color the sound of the singer, and a low ratio so that when the compressor does go on it smooths out the vocals without squashing them. A typical setting might look like this:

- **Threshold:** –8dB
- **Ratio:** Between 1.5:1 and 2:1
- **Attack:** <1 ms
- **Release:** About 40 ms
- **Gain:** Adjust so that the output level matches the input level. You don’t need to add much gain.

If you want to use a compressor that pumps and breathes — that is, one that you can really hear working — or if you want to bring the vocals way up front in the mix, try using the following setting. This puts the vocals “in your face” as recording engineers say:

- **Threshold:** –2dB
- **Ratio:** Between 4:1 and 6:1
- **Attack:** <1 ms
- **Release:** About 40 ms
**Gain**: Adjust so that the output level matches the input level. You need to add a fair amount of gain at this setting.

As you can see, the two parameters that you adjust most are Threshold and Ratio. Experiment with these settings and check their effects by toggling between the affected and unaffected sound. (Use the Bypass button in the plug-in window.) Watch the levels going to disk and make sure that they don’t peak over –6dB or –4dB. This ensures a *hot* signal — one that is loud — and also leaves you some headroom (a few decibels below clipping) for when you mixdown. (More on this in Book 6, Chapter 7.)

**Electric guitar**

Generally (these days, at least), the signal from an electric guitar gets run through a compressor and other external effects before it’s even recorded. You don’t need additional compression when you track the guitar unless you use a clean (undistorted) setting on your guitar. If you do want to use a little compression to bring the guitar forward and give it some punch, try these settings:

- **Threshold**: –1dB
- **Ratio**: Between 2:1 and 3:1
- **Attack**: 25ms to 30ms
- **Release**: About 200ms
- **Gain**: Adjust so that the output level matches the input level. You don’t need to add much gain.

The slow attack is what allows the guitar to have a bit of punch to it. If you want less punchiness, shorten the attack slightly. Be careful though — if you shorten it too much, you end up with a mushy sound. (Ahem . . . we’re not talking romance here. I mean the guitar has no definition.)

**Electric bass**

Another way to get a handle on the potential muddiness of the amplified bass guitar is to use a little compression. Compression can also help control any uneven levels that result from overzealous or inexperienced bass players. Try these settings for a start:

- **Threshold**: –4dB
- **Ratio**: Between 2.5:1 and 3:1
- **Attack**: Between 40 ms and 50 ms
- **Release**: About 180 ms
- **Gain**: Adjust so that the output level matches the input level. You don’t need to add much gain.
**Acoustic instruments**

You don’t generally need a lot of compression on acoustic instruments, especially if you want a natural sound. You can use the compressor to even out the resonance of the instrument, which keeps the main character of the instrument from getting lost in a mix and avoids a muddy sound. Here’s a good setting for strummed or picked acoustic instruments:

- **Threshold:** –6dB
- **Ratio:** Between 3:1 and 4:1
- **Attack:** About 150 ms
- **Release:** About 400 ms
- **Gain:** Adjust so that the output level matches the input level. You don’t need to add much gain.

The release is set very high because of the amount of sustain that these acoustic instruments can have. If you play an instrument with less sustain, such as a banjo, you may find that a shorter attack and release work just fine. In this case, you can try the following settings:

- **Threshold:** –6dB
- **Ratio:** Between 2.5:1 and 3:1
- **Attack:** Between 40 ms and 50 ms
- **Release:** About 180 ms
- **Gain:** Adjust so that the output level matches the input level. You don’t need to add much gain, if any.

**Kick drum**

The kick drum responds quite well to a compressor when tracking. For the most part, you can get by with settings that tame the boom a little and allow the initial attack to get through. A sample setting looks like this:

- **Threshold:** –6dB
- **Ratio:** Between 4:1 and 6:1
- **Attack:** Between 40 ms and 50 ms
- **Release:** Between 200 ms and 300 ms
- **Gain:** Adjust so that the output level matches the input level. You don’t need to add much gain.
**Snare drum**

Adding compression to the snare drum is crucial if you want a tight, punchy sound. You can go a lot of ways with the snare. The following settings are common and versatile:

- **Threshold**: –4dB
- **Ratio**: Between 4:1 and 6:1
- **Attack**: Between 5 ms and 10 ms
- **Release**: Between 125 ms and 175 ms
- **Gain**: Adjust so that the output level matches the input level. You don’t need to add much gain.

**Percussion**

Because these instruments have high sound levels and are prone to extreme transients, I like to use a little compression just to control the levels going to disk. Here’s a good starting point:

- **Threshold**: –10dB
- **Ratio**: Between 3:1 and 6:1
- **Attack**: Between 10 ms and 20 ms
- **Release**: About 50 ms
- **Gain**: Adjust so that the output level matches the input level. You need to add a bit of gain.

**Looking into Limiters**

The limiter works much like the compressor except that it limits the highest level of a sound source. Any signal above the threshold is chopped off rather than compressed. Limiters are great for raising the overall level of an instrument and keeping transients from eating up all the headroom (maximum level) of a track.

**Understanding limiter settings**

Pro Tools comes with the limiter plug-in shown in Figure 4-3. You insert this plug-in into a track by following the procedures listed in the “Connecting Dynamics Processors” section at the beginning of this chapter. The limiter contains the following parameters:
✦ **Gain**: The Gain slider allows you to adjust the level (volume) of the signal going out of the limiter. This is listed in decibels.

✦ **Threshold**: The Threshold setting dictates the level at which the limiter starts to act on the signal. This is listed in dB (decibels). This setting is often listed as dB below peak (0dB). In other words, a setting of –6dB means that the limiter kicks in when the signal is 6 decibels below its calibrated 0dB mark. (In digital systems, 0dB is the highest level a signal can go before clipping.)

✦ **Attack**: The Attack slider controls how soon the limiter kicks in. The attack is defined in milliseconds (ms), and the lower the number, the faster the attack.

✦ **Release**: The Release slider controls how long the limiter continues limiting the signal after it has dropped back below the threshold setting. Like the attack, the release is defined in milliseconds. The lower the number, the faster the release time.

### Setting limits with the limiter

The limiter is essentially a compressor on steroids, so many of the settings that you can use for a compressor work for limiters. The only difference is that you don’t have the Ratio and Knee settings. Keep in mind these two tips when using limiters on your tracks:

✦ When using limiters to raise the volume of a track or mix, limit only 2 or 3dB at a time. This way, the limiter doesn’t alter the sound of your signal; it just reduces the highest peaks and raises the volume.

✦ To add grunge to a track, lower the Threshold setting so that you limit the signal 6 to 12dB. Tweak the Attack and Release parameters to get the sound you’re after. This creates distortion that may work for a particular track such as the snare drum.
Introducing Gates

A gate is basically the opposite of the limiter: Rather than limiting how loud a note can get, the gate limits how soft a note can get. The gate filters out any sound below the threshold and allows any note above it to be passed through unaffected.

Gates are useful for filtering out any unwanted noise that may be present in the recording environment. A classic situation for using gates is when you record drums. You can set the gate to filter any sound (other drums, for instance) except for the sounds resulting from the hits to the particular drum that you have miked.

Getting to know gate parameters

You can see the gate plug-in that ships with Pro Tools in Figure 4-4. The various settings that you get to play with are similar to the ones for compressors and limiters, as the following list makes clear:

- **Threshold**: The Threshold slider sets the level (in dB) at which the gate opens (stops filtering the signal). The gate allows all signals above the Threshold setting to pass through unaffected, whereas any signals below the Threshold setting are reduced by the amount set by the Range control.

- **Attack**: Like with the compressor and limiter, the Attack slider sets the rate at which the gate opens (in milliseconds). Fast attacks work well for instruments with, well, fast attacks, such as drums, whereas slow attacks are better suited for instruments with slow attacks, like vocals.

- **Hold**: The Hold setting controls the amount of time that the gate stays open after the signal drops below the threshold. When the hold time is
reached, the gate closes abruptly. This parameter is listed in milliseconds (ms). The Hold parameter allows you to get the gated drum sound that was so popular in the 1980s. (Phil Collins, anyone?)

✦ **Decay:** The Decay setting dictates the rate at which the gate closes after the signal hits the threshold (listed in milliseconds). Unlike the Hold feature, the Decay setting doesn’t close abruptly; rather it slowly (according to the Decay setting) closes, which produces a more natural sound.

✦ **Range:** The Range setting is similar to the Ratio setting on the compressor except that you choose the dB amount by which the gate attenuates (reduces) the signal. For example, a setting of 40dB drops any signal below the Threshold setting by 40 decibels.

### Getting started using gates

Noise gates can be extremely useful for getting rid of unwanted noise. The most common use for a gate is to eliminate bleeding from drum mics. For example, you may get bleed from your snare drum into your tom-toms mics. When using noise gates, keep the following in mind:

✦ When the threshold is reached, the gate allows the signal through. If your background noise is high enough, when the gate opens, you still hear not only the intended sound but the background noise as well.

✦ When gating drums, be sure to set the attack very fast. Otherwise, the initial transient is lost, and you end up with mushy-sounding drums.

✦ When setting the release time of the gate, adjust it until it sounds natural and doesn’t clip off the end of your instrument’s sound.

✦ Set the range just high enough to mask any unwanted noise. If you set it too high, the sound becomes unnatural because the natural resonance of the instrument may be filtered out.

### Examining the Expander

The expander is to the gate what the compressor is to the limiter — instead of reducing the volume of notes below the set threshold by a specified amount, the *expander* reduces them by a ratio. In other words, with the gate, you set a certain dB amount by which a signal is reduced, and with the expander, you reduce the signal by setting a ratio. The ratio changes the signal gradually, making the affected signals sound more natural.

You use an expander when you want to subtly reduce noise from a track rather than just filtering it out completely. A classic example is when you deal with breath from a singer. If you use a gate, you get an unnatural-sounding
track because the breaths are filtered out completely. With the expander, you can set it to reduce the breath just enough so that it’s less noticeable, but you can leave a little of the sound in to make the singer sound normal. (I mean, everyone has to breathe, right?)

Playing with expander parameters

The expander plug-in in Pro Tools, shown in Figure 4-5, uses similar settings to the compressors, limiter, and gates. They are as follows:

- **Threshold**: The Threshold setting in an expander works the same way as with the gate — anything below the threshold is affected, and any signal above the threshold passes through unaffected.

- **Ratio**: The ratio dictates how much the signal is attenuated by the expander. When using a ratio of 2:1, for instance, the expander reduces any signal below the threshold by 2 times. In this case, a signal that is 10dB below the threshold is reduced to 20dB below it; likewise, a signal that’s 2dB below the threshold is reduced to 4dB below it.

- **Attack**: As with the compressor and limiter, the Attack slider sets the rate at which the expander opens (in milliseconds). Fast attacks work well for instruments with, well, fast attacks, such as drums, whereas slow attacks are better suited for instruments with slow attacks, like vocals.

- **Hold**: The Hold setting controls the amount of time that the gate stays open after the signal drops below the threshold. The hold time is listed in milliseconds (ms).
✦ Decay: The Decay setting dictates the rate at which the expander closes after the signal hits the threshold (listed in milliseconds). Unlike the Hold feature, the Decay setting doesn’t close abruptly; rather it slowly (according to the Decay setting) closes, which produces a more natural sound.

✦ Range: The Range setting is similar to the Ratio setting on the compressor except that you choose the dB amount by which you want the expander to be attenuate (reduce) the signal. For example, a setting of 40dB drops any signal below the threshold setting by 40 decibels.

**Getting started using an expander**

Because the expander works much like a gate, you can use the same basic starting points. Choose between a gate or an expander based on the type of overall attenuation that you want of the signal. For example, the expander is a good choice if you have an instrument that contains sounds that are too loud but you don’t want to get rid of them completely — you just want to reduce them a little.

Adjusting for a vocalist’s breath is the perfect situation for using an expander rather than a gate. In this case, you can set the expander’s threshold just below the singer’s softest note and start with a low ratio (1.5:1 or 2:1, for instance). See if the breathiness improves, and if it doesn’t, slowly move the Ratio slider until you get the effect that you want. Be careful not to overdo it, though. If the breath is too quiet compared to the vocal, the vocal sounds unnatural.

If you use a high ratio in your expander (6:1 or above), the effect that you get is similar in sound to the gate, but you end up having less control over the sound because you don’t have the Hold or Release settings to adjust. So if you find yourself using a high ratio on a signal, a gate may be a better choice for that situation.

**Keying into External Keys**

Engaging the External Key option in the dynamics processors in Pro Tools lets you set up a side-chain. Using a side-chain means that the signal from another track (through one of the buses) or from one of your interface inputs triggers your dynamics processor into action. The signal that you choose to do the triggering is called the key input.

Side-chains are great for de-essing a vocal track (getting rid of “s” sounds), making tracks fit together better in a sense mix, or letting a kick drum be heard when it plays at the same time as the bass guitar. Not sure how to do this? Don’t worry, I provide some examples later in this section.
Setting up a side-chain

Setting up a side-chain in one of Pro Tool’s dynamics processors involves the following steps:

1. Click to open the Key Input drop-down menu located next to the little Key icon at the top of the plug-in window.
2. From the pop-up menu, choose the interface input or bus that has the signal that you want to use to trigger the dynamics processor.
   This routes the signal from that input or bus to the processor.
3. Click the External Key button to engage the side-chain.
   The External Key button is located near the bottom-left of the various plug-in windows. (Refer to Figure 4-5.)
4. Click the Key Listen button — located to the right of the External Key button — to hear the signal coming through your selected key input.
5. Play your session and adjust the processor’s parameters until you get the sound that you want.

Using a side-chain

The uses for side-chains are numerous, and only your creativity limits how you end up using your side-chain. The most common use for side-chains is creating more room for your instruments in the mix. This is done by EQing the Key Input signal and letting that EQed signal trigger a compressor or limiter.

To make room for a vocal in a dense mix, follow these steps:

1. Route all your instruments in the mix (except the vocal) to Bus 15 and 16.
2. Insert the compressor plug-in in this bus and set the Key Input to Bus 14.
3. Make a copy of your vocal tracks and assign their outputs to Bus 14.
4. Shift the copied vocal tracks ahead (to the right) a few milliseconds.
5. Adjust the settings on the compressor so that the volume of the instruments drops slightly whenever the vocals come in.

For a starting point, use the smooth vocal compressor setting that I mention in the “Vocals” section earlier in this chapter.
You can also use a special trick to make the bass guitar drop slightly in the mix whenever the kick drum is played. Follow these steps:

1. **Insert the compressor plug-in into the bass guitar track and set the Key Input to Bus 16.**

2. **Make a copy of the kick drum track and set the output for the copied track to Bus 16.**

   The kick signal will trigger the compressor that’s assigned to the bass guitar track.

3. **Use fast Attack and Release settings on the compressor.**

   You want the compressor to activate only when the initial strike of the kick drum happens. The bass guitar drops in volume when the kick drum plays. This means that the kick drum creates the attack and the bass guitar produces the sustain.

This trick works really well for music that has a kick drum and bass guitar that play similar patterns.
Chapter 5: Singling out Signal Processors

In This Chapter

- Understanding and using effects in Pro Tools
- Getting to know reverb
- Introducing delays
- Examining offline effects processing

Unless you record your songs using a live band in a perfect acoustic environment, your music will sound a little flat without the addition of some type of effects. Effects allow you to make your music sound like you recorded it in just about any environment possible. You can make your drums sound as if they were recorded in a cathedral or your vocals sound as if you were singing underwater. Effects also have the ability to make you sound better than the real you. For example, you can add harmony parts to your lead or backup vocals, or you can make your guitar sound like you played it through any number of great amplifiers.

In this chapter, you discover many of the most-common effects processors used in recording studios. (*Signal processors* are the neat software plug-ins behind all the effects you can achieve in your Pro Tools studio.) You discern the difference between insert (that is, line) effects and send/return effects. You also get a chance to explore ways of using these processors, with recommendations for using reverb, delay, and chorus. To top it off, you get a glimpse into offline effects processing such as pitch-shifting.

The best way to learn how to use effects on your music is to experiment. The more you play around with the different settings, the more familiar you become with how each effect operates. Then you can get creative and come up with the best ways to use effects for your music.

The *Bypass* button in the Pro Tools effects-processor plug-in window is your friend. With a click of the Bypass button, you can quickly turn off any effect in use with your signal. Use this button to check your effect settings against your original signal. Sometimes you’ll like the original sound better.
Routing Your Effects

Effects processors can be used as either send/return or insert effects. In both cases, you can work with the dry (unaffected) signal and the wet (affected) signals separately. If you use the effect in a send/return routing, you can adjust the wet and dry signals with two track faders: Aux Send (opened by clicking the effect’s name in the Send list) and Auxiliary. If you use the effect in a line configuration, the plug-in window displays a Mix parameter where you can adjust the wet/dry balance.

You choose whether to insert an effect in a track or to use the Send function based upon what you intend to do. For example, if you insert the effect into a track (as described in the next section), that effect only alters the signal that exists on the track it’s inserted into. On the other hand, using an effect send for your effect allows you to route more than one track through that effect. (You can adjust the individual levels going to the send at each track so you still have control over how much effect is applied to each track going to the send.) In addition, inserting an effect always puts the effect before the fader in the track (pre-fader); if you use a send, you can choose whether the effect does its magic before (pre-fader) or after (post-fader) signal enters the fader that controls the track’s output. If you use a send to apply the effect to more than one track at a time, you also reduce the amount of processing power the effect has to use. (Inserting the same effect into each track you want to alter ends up using more processing power.)

Inserting effects

If you only want to use an effect on one specific track, you can insert it into the track using the Insert function. To insert an effect in Pro Tools, follow these steps:

1. Make sure that the Inserts section is showing in the Mix window by choosing Display ➪ Mix Window Shows ➪ Inserts from the main menu.
2. Click the top arrow on the left side of the Inserts section of the track’s channel strip.
   The Insert pop-up menu appears, as shown in Figure 5-1.
3. If your track is a stereo track, select either the multi-channel or multi-mono option.
   If your track is mono, you don’t have a choice here. You’re stuck using a mono plug.
   The plug-in window opens. Here you can set your parameters. (My professional advice on what settings to actually tweak comes later in this chapter, when I cover the individual effects.)
Sending signals to effects

There are times when you want to route a bunch of tracks to a single effect (in the case of reverb, for instance). In this case, you follow these steps:

1. **Select one of the buses from the Send selector in each track that you want to route to the effect.**

   The Send Output window appears, as shown in Figure 5-2. The window contains a handy channel strip for controlling the signal being sent to the selected bus.
2. Choose File ➪ New Track from the main menu.

The New Track dialog box appears.

3. Use the drop-down menus to enter the number of tracks you want (1) the type (Auxiliary Input) and whether you want your track in mono or stereo.

4. Using the Input selector pop-up menu, select the bus you used for the send of the tracks in Step 1 as the input for this auxiliary track.

5. Select one of the effects plug-ins from the Inserts pop-up menu and insert it into this auxiliary track.

The Effect plug-in window opens.

The previous section, “Inserting effects,” gives you the gory details on inserting effects.

6. Adjust the effect settings to get the sound you want.

Book 6, Chapter 2 further details plug-ins and how to route signals through your system to them.

**Rolling out the Reverb**

Reverb is undoubtedly the most commonly used effects processor. Reverb is a natural characteristic of any enclosed room and is the result of sound waves bouncing off the walls, floor, and ceiling. A small room produces reflections that start quickly and end soon; in larger rooms, halls, or cathedrals, the sound has farther to travel, so you get slower start times and a longer-lasting reverberation.

This room effect enables you to place your track closer to the imaginary “front” or “back” of the mix. You do this by varying how much of the affected signal you include with the unaffected one. For example, mixing a lot of reverb with the dry (unaffected) signal gives the impression of being farther away, so your instrument sounds like it’s farther back in the mix.

**Seeing reverb settings**

You can adjust several parameters when you use reverb, which gives you a lot of flexibility. Figure 5-3, which shows the Reverb plug-in that comes with Pro Tools, including a peek at the parameters you can play with.
The following list explains how the parameters — most, but not all, visible in Figure 5-3 — affect the sound of the reverb:

- **Algorithm:** This setting lets you choose the type of room that the reverb sounds like. You have the option of a hall, church, plate (a type of reverb that uses a metal plate to create its sound), two different rooms, ambient (natural room sound), and nonlinear (less natural) sound. Each choice also sets the other parameters for the reverb, but you can adjust those as you like to give your reverb a distinct sound.

- **Size:** This option refers to the “room” choices you have in the Algorithm setting. You have three settings to choose from: Small, Medium, and Large. Clicking one of these options adjusts the rest of parameters in the window, except for the Algorithm setting.

- **Diffusion:** Diffusion affects the density of the reflections in the “room” you have chosen. A higher diffusion setting results in a thicker sound. Think of the diffusion parameter as a way to simulate how reflective the room is. More-reflective rooms produce a much higher diffusion. To simulate a less-reflective room, use lower-diffusion settings.

- **Decay:** The decay is the length of time that the reverb lasts. Larger or more-reflective rooms produce a longer decay.

- **Predelay:** A sound reaches your ears before the sound’s reverb does, and the predelay is the amount of time from the sound’s beginning and the start of the reverb, which is described in milliseconds (ms). Because reverb is made up of reflections of sound within a room, the sound takes time to bounce around the room and reach your ears. By then, you’ve already heard the sound because it came directly to you. Predelay helps to define the initial sound signal by separating it from the reverb. This parameter is essential in making your reverb sound natural.
A small room has a shorter predelay than a large room.

✦ **HF Cut:** This setting allows you to control the rate at which the high frequencies decay. Most of the time the high frequencies decay faster, so being able to control this effect can result in a more natural sounding reverb.

✦ **Low Pass:** This filter controls the level of the high frequencies within the reverb. Setting this frequency gives the impression of a “darker” (lower-frequency setting) or “brighter” (higher-frequency setting) room.

## Getting started using reverb

Reverb is like garlic: The more you use, the less you can taste it. Just as the new chef puts garlic in everything (and lots of it) many budding engineers make the same mistake with reverb. Go easy. **Remember:** Less is more.

Here are some other things to keep in mind:

✦ Mixes often sound better when you use reverb on only a few instruments instead of them all. For example, it’s not uncommon for just the snare drum of the drumset to have reverb on it. The rest of the drums and cymbals remain dry (unaffected).

✦ Try using reverb to “glue” instruments together. Routing all of your drum tracks to the same reverb, for instance, can make them sound like they were all recorded in the same room. When doing this, make sure that you adjust the Send level for each instrument so that the effect sounds natural. Also, use less reverb for all the instruments than you would for just one. This keeps the sound from becoming muddy from using too much reverb.

✦ Think about how you want each instrument to sit in the mix when you choose reverb. Make sure the type and amount of reverb fits the song and the rest of the instruments.

✦ Try putting the dry (unaffected) sound on one side of the stereo field and the reverb on the other. For example, if you have a rhythm guitar part that you set at 30 degrees off to the right of the stereo field, set the reverb 30 degrees off to the left. This can be a nice effect.

✦ To keep the vocals up front in the mix, use a short reverb setting. A vocal plate is a great choice because the decay is fast. This adds a fair amount of the reverb to the vocal without making it sit way back in the mix.

✦ Experiment with room types, sizes, and decay times. Sometimes a long decay on a small room reverb sounds better than a short decay on a large room or hall reverb.
Along with reverb, delay is a natural part of sound bouncing around a room. When you speak (or sing or play) into a room, you often hear not only reverb, but also a distinct echo. This echo may be short or long depending on the size of the room. The original sound may bounce back to you as a single echo or as multiple, progressively quieter delays.

## Digging into delay settings

There are several types of delay effects, including a slap-back echo, tape delay, and multiple delays, and each of them is designed to add dimension to your instrument. To create these various effects, you adjust several parameters, as the following list and Figure 5-4 make clear. The Delay plug-ins that come with Pro Tools are pretty much the same. (Okay, the default setting for each is different, but that’s a pretty minor thing.) The parameters that you can adjust include the following:

- **Gain**: This lets you set the signal level going into the delay.
- **Mix**: This parameter controls the output level of the effect. The higher you set this parameter, the louder the delayed signal is relative to the original signal.
- **LPF**: The Low Pass filter (LPF) lets you filter out some of the high frequencies from the delay.
- **Delay**: This parameter controls the amount of time between the initial signal and the repeated sound. The time is listed in milliseconds (ms) and can be as short as a few milliseconds or as long as several seconds.
- **Depth**: This parameter lets you add modulation to the delay so that you can create a chorus effect. (See the “Creating Chorus Effects” section, later in this chapter, for more on chorus and flange effects.) The higher the level on this setting, the greater the modulation.
Rate: This setting lets you set the amount of time that the modulation takes to cycle.

Feedback: The Feedback parameter controls how many times the echo repeats. A low setting makes the echo happen just once while higher settings produce more echoes.

Some of the Delay plug-ins in Pro Tools also offer the ability to set the delay to the tempo of your song. The following list covers these settings:

- **Tempo Match:** This option allows you to set the delay to beat in time with the music. The Tempo Match feature is referenced to the tempo map that you set for the song. You can set this parameter to any note division, from sixteenth notes to whole notes, if you want the delays to keep time with your song. (Quarter- and eighth-note delays are the most commonly used note divisions.)

- **Meter:** This lets you set the meter of the song and the subdivision that you want the delay to follow. When you change this parameter, the Delay parameter moves too.

- **Groove:** Use this parameter to adjust the rate of the delay in relation to the tempo and subdivision you chose. By changing this setting, you alter the delay (by percentages) away from the strict tempo and subdivision settings. This can be useful if you're adjusting the exact delay that you want. When you adjust this parameter, the Delay setting changes as well.

## Getting started using delay

Delay is used a lot in contemporary music, and many times you don’t hear it unless you listen carefully. Other times it is prominent in the mix (for example, the snare drum in some reggae music). Here are ways you can use delay in your music:

- One of the most effective ways to use delay is as a slap-back echo on vocals. A *slap-back echo* consists of one to three repeats spaced very closely together, which fattens up the sound of the vocals. You generally want to set your time parameter between 90 and 120 milliseconds. Set the level so you barely hear the first echo when your vocal is in the mix and adjust it from there until you like the sound. In pop music, a slap-back echo and a vocal plate reverb are commonly used on lead vocals. (It was really common in the 1950s, and shows up a lot — less subtly — in rockabilly.) The Slap Delay plug-in in Pro Tools is a good place to start, although the default setting has a longer delay time than I recommend.

- Use the Tempo Match feature to have your delay echo in time with the music. This can add some depth to the mix without creating a muddy or cluttered sound. Be careful — if you use this too much, it can make your music sound annoyingly repetitive.
Creating Chorus Effects

*Chorus* takes the original sound and creates a copy that is very slightly out of tune with the original and varies over time. This variance is called *modulation*, and the result is an effect that can add interest and variety to an instrument. Chorus is used quite extensively to add fullness to an instrument, particularly guitars and vocals. Pro Tools doesn’t come with a Chorus plug-in per se, but all of the Delay plug-ins can produce chorusing effects by adjusting the Depth and Rate parameters. (Check out the “Detailing Delay” section, earlier in this chapter, for more on delays.)

If reverb is like garlic, then chorus is cayenne pepper. You may get away with a little too much garlic in your food without too much trouble, but if you add too much cayenne, you run the risk of making your food inedible. Such is the case with the chorus effect. Used sparingly, it can add a lot to your music; overdone, it can wreak havoc on a good song.

✦ To fill out a vocal track, try setting the rate at 2 Hz, the depth at about 20 to 30, and the delay at 10 to 20 ms. Keep the Feedback level low.

✦ Use a chorus on backup vocals to make them much fuller and allow you to use fewer tracks.

✦ Pan the chorus to one side of the mix and the dry (unaffected) signal to the other. This can be especially interesting on guitars and synthesizer patches.
Chapter 6: Automating Your Mix

In This Chapter

- Understanding automation
- Writing automation
- Editing automation
- Playing automated tracks

It’s unlikely to have a session that doesn’t have a single change in level, pan, EQ, or plug-in parameters somewhere in the song. Unless you have an external mixer or control surface, you’re stuck making these changes with your mouse. The problem with all this mouse-intensive work is that there is no way you can move more than one fader, panning knob, or plug-in setting at a time. To be honest, the only way you can really mix within Pro Tools is by using some kind of automation feature . . . which Pro Tools just happens to have in spades. In fact, Pro Tools has a quite powerful automation engine that allows you to control a variety of mix parameters.

Don’t like the way the guitar in the second verse sits in the mix? No problem. Just fix your automation data and mix it again. You can even save multiple versions of these settings so you can create as many mixes as you want. (Be careful here. When asked, most mix engineers say that they only finally finish a mix when they run out of time or money to keep trying things.)

This chapter gets you going on mixing the new-fangled way: automatically. Well, not exactly automatically — you still need to program these mixing settings, but I’ll show you how to do it. In this chapter, I lead you through the process of automating the various aspects of your song — volume levels, mute and panning placement, EQ, and plug-in settings are all covered. In addition, you discover how to change your automation settings and how to play the automation data back so you’re ready to do your final mix.

Understanding Automation

You can automate a variety of parameters in Pro Tools. Each of these parameters has a playlist that contains its automation data. You can write this data one parameter (or more) at a time — and you can display and edit the data even while playing the session. This section describes the parameters you can automate in audio and MIDI tracks.
**Accessing Automation Modes**

**Audio tracks**

You can automate the following parameters in your audio tracks:

- **Volume**: This parameter controls the overall volume of the track.
- **Pan**: This lets you set the left/right balance of the track in the stereo field.
- **Mute**: This allows you to turn the track on and off.
- **Send**: This includes volume, mute, and panning settings for the send — the routing section that lets you send part of your track’s signal to an effect.
- **Plug-in parameters**: You adjust these parameters within the Plug-In window.

Automation data for each of these parameters resides in a playlist that’s separate from the regions that contain your edits for that track. This allows you to move the regions in and out of the track’s playlist without changing the automation data for that track.

**MIDI tracks**

You can automate the following parameters when you’re working with MIDI tracks:

- **Volume**: This parameter sets the overall volume of the MIDI data.
- **Pan**: You can place your tracks anywhere from left to right in the stereo field.
- **Mute**: This allows you to turn the track on and off.
- **Controller data**: This includes a number of MIDI settings, including options such as the modulation wheel, breath controller, and sustain.

Pro Tools stores the automation data for MIDI tracks — with the exception of Mute settings — within the MIDI region for that track. So when you move a region within a track’s playlist, the automation data (except for any mute settings) moves along with the region.

**Accessing Automation Modes**

Pro Tools offers five automation modes: Auto Off, Auto Write, Auto Touch, Auto Latch, and Auto Trim. You access these modes by clicking the Automation Mode selector in the channel strip of each track in the Mix window or in the Track Controls section of the Edit window, as shown in Figure 6-1. Each of these modes affects how automation data for a track are written or played back. These are covered in this section.
Now for the particulars. Here’s what each mode actually does:

- **Auto Off:** This mode turns off all automation data for the selected track.

- **Auto Read:** This mode plays back the automation data for the selected track.

- **Auto Write:** This mode writes automation data for the selected parameter(s) while the session plays — overwriting any pre-existing automation data in the process. When you stop playback after writing automation in this mode, Pro Tools automatically switches the automation mode to Auto Touch (see next bullet) so you don’t accidentally erase this data next time you play back the session.

- **Auto Touch:** Auto Touch mode writes automation data only when you click a parameter with your mouse; it stops writing when you release the mouse button. (See the upcoming Remember icon for control-surface behavior in this mode.) At this point, your automated parameter returns to any previously automated position, according to the time you’ve set for AutoMatch in the Automation tab of the Preferences menu. (See the “Setting Automation Preferences” section, later in this chapter, for more on the Preferences dialog box.) Using Auto Touch, you can fix parts of your previously recorded automation data without erasing the stuff you want to keep.

Auto Touch will engage differently depending on the control surface you use. If you have touch-sensitive faders (like those on the Digi 002), new automation data is written as soon as you touch a fader. If your control surface doesn’t sport touch-sensitive faders, Auto Touch mode won’t engage until you move a fader past the position it occupied in the previously written automation data (which is called the pass-through point). Once you hit that point, automation data is written until you stop moving the fader.
Setting Automation Preferences

✦ **Auto Latch:** This mode works much like Auto Touch (see previous bullet) — once you touch or move a parameter, new automation data is written. The difference is that Latch mode continues to write new automation data until you stop playback.

Setting Automation Preferences

Pro Tools writes and plays back automation data differently depending on the preferences you have selected. You set these preferences by opening the Preferences dialog box — choose Setups → Preferences from the main menu to get there — and then choosing the Automation tab (shown in Figure 6-2).

![Pro Tools LE Preferences](image)

Figure 6-2: The Automation tab in the Preferences dialog box lets you determine how automation behaves in Pro Tools.

These preferences are where you specify how automation behaves in Pro Tools:

✦ **Faders Move During Playback:** With this box checked, your on-screen faders move to match the volume changes you’ve automated. Useful for double-checking your work with the faders, but turning off this option can save processing power and speed up screen redraws.
✦ **Smooth and Thin Data After Pass:** Checking this box lets Pro Tools automatically smooth and thin automation data after you’ve recorded your moves. (See the “Thinning Automation” section, later in this chapter, for more on thinning.) This can make your automation curves more manageable and free up memory for your automation data. (See the last bullet item in this section.)

✦ **Mutes Follow Groups:** Having this box checked means that any mutes you apply to a track in a Mix group get applied to all tracks in that group. If you want to mute your grouped tracks individually you can simply leave this box unchecked, or you can right-click (on a PC) or Ctrl+click (on a Mac) when you mute your track.

✦ **Solos Follow Groups:** Checking this box makes all the tracks in a Mix group solo whenever you hit the Solo button on one. To solo only one track within a group, leave this box unchecked — or you can right-click (on a PC) or Ctrl+click (on a Mac) the Solo button in your track’s channel strip.

✦ **Send Mutes Follow Groups:** With this box checked, all tracks in a Mix group respond whenever you mute the send of one of the track in that group. To mute a send individually, uncheck this box or right-click (on a PC) or Ctrl+click (on a Mac) on the Send Mute button in the channel strip of the track you want to mute individually.

✦ **Send Levels Follow Groups:** When this box is checked, altering the Send level of one track within a Mix group changes all the Send levels for the members of that group. To adjust the Send level of a single track in a group, uncheck this box or Start/Windows+drag (on a Windows PC) or Ctrl+drag (on a Mac) the Send level of that track.

✦ **Degree of Thinning:** This box lets you determine the amount of thinning that’s applied to automation data when you put a check in the Smooth and Thin Data After Pass check box — or whenever you use the Thin Automation command. (See the “Thinning Automation” section, later in this chapter, for more about this command.)

✦ **Touch Timeout:** When you’re using Auto Touch automation mode, this setting controls how long your automation data continues to be written after you stop moving a non-touch-sensitive control. (See the “Accessing Automation Modes” section, earlier in this chapter, for more on Auto Touch.)

✦ **AutoMatch Time:** This setting controls the amount of time it takes for Pro Tools to return to previously written automation data when you stop recording new data in Auto Touch mode.

✦ **Amount of Memory To Reserve for Automation Recording:** This setting does what it says: You can reserve between 200 to 3000 KB of memory. If your session needs a ton of automation data, choose a higher number; for most mixes, I’ve found 500 to 1000 KB to be sufficient.
Enabling Automation

You can enable or suspend automation parameters on all tracks by using the Automation Enable window (Choose Windows: Show Automation Enable to get the window on-screen.) or on individual or grouped tracks using the automation drop-down menu (located in the Track Controls section of the Edit window). Here you can play with all the parameters for audio tracks that I list in “Understanding Automation” (earlier in this chapter) — except for plug-ins, which are controlled in their respective windows.

Suspending or enabling automation across all tracks
To enable or suspend the writing of automation data across all the tracks in your session

1. **Choose Windows: Show Automation Enable from the main menu.**
   The Automation Enable window appears, as shown in Figure 6-3. The default setting for this window is that all parameters are enabled — all parameters highlighted. In the case of Figure 6-3, only the volume parameter is enabled, meaning that when you set your track to one of the automation writing modes (Auto Write, Auto Latch, or Auto Touch) the only automation that is written is volume data.

2. **To suspend automation across all tracks, perform one of the following:**
   - To suspend a single control, click the name of an enabled parameter in the Automation Enable window to deselect it. It's no longer highlighted.
   - To suspend all the available parameters, press the Auto Suspend button.

3. **To enable automation across all tracks, perform one of the following:**
   - To enable a single control, click the name of the parameter in the Automation Enable window. It becomes highlighted.
   - To enable all the available parameters, press the Auto Suspend button to deselect it.
Suspending automation for an individual track

You can suspend or enable reading or writing of automation without using the Automation Enable window. In order to do this, though, you need to make sure that you haven’t suspended automation using the Automation Enable window (see previous section). You can suspend or enable automation for a single track or a group of tracks in a session by doing the following:

1. **Click-hold the Automation selector in the Track Controls section of the Edit window and drag to the Automation parameter (volume, mute, pan, send level, or send mute) you want to suspend or enable.**

2. **Perform one of the following steps:**
   - To suspend automation writing or reading for the control selected in the automation playlist, Ctrl+click (on a PC) or Command+click (on a Mac) that control — Mute, Volume, Pan, whatever — in the Track View Selector in the Track control section of the Edit window.
   - To suspend automation writing and reading of a single control across all tracks, Ctrl+Alt+click (on a PC) or Command+Option+click (on a Mac) the control in one Track View Selector in the Track control section of the Edit window.
   - To suspend automation writing and reading of all controls in a single track, Ctrl+Shift+click (on a PC) or Command+Shift+click (on a Mac) any control in the Track View Selector in the Track control section of the Edit window.

To enable these parameters, repeat the steps above to toggle between Suspend and Enable.
Writing Automation

Writing automation is easy — simply enable the parameter that you want to write automation data for, choose your automation mode, and adjust the parameter as the session plays. This section details this process.

As automation is written, it appears in your track as breakpoints with lines (ramps) between these points. The breakpoints are placed in the track’s automation playlist — the playlist section of the track when you have the Tracks view set to one of the Automation views using the Track View pop-up menu. The number of breakpoints that appear is determined by the complexity of the changes to the automation levels and by the setting you have in the Degree of Thinning section of the Automation tab of the Preferences dialog box. (Check out the “Setting Automation Preferences” section earlier in this chapter.)

When the Smooth and Thin Data After Pass box is checked, a setting of None creates lots of breakpoints — you may not even notice any lines between them — while a setting of Most creates many fewer breakpoints — with longer, more pronounced lines between them. Pro Tools places lines between these breakpoints to connect them. These lines follow the level from one breakpoint to another, either going up, down, or staying the same. The combination of breakpoints and connecting lines represent the automation curves for your track.

To keep from accidentally erasing or overwriting automation data, suspend the writing of automation for the parameter by using one of the methods of suspending automation listed in the previous section.

Writing automation on a track

To write automation on a track, follow these steps:

1. **Choose Windows ➤ Show Automation Enable from the main menu.**
   The Automation Enable window appears. (Refer to Figure 6-3.)

2. **In the Automation Enable window, click the buttons of the parameters you want to enable.**

3. **Select Auto Write in each track you want to write to (choose Auto Touch or Auto Latch for subsequent times) by clicking the Automation selector.**
   The Automation selector lives in the Edit menu (Book 2, Chapter 4).

4. **Click Play in the Transport Window or press the Spacebar on your keyboard to start your session.**

5. **Move the control for the parameters you want to automate.**
   For example, move the track’s fader (located in the Channel strip of the Mix window) up and down to record changes in the volume level of your track.
6. **Click Stop in the Transport window or press the Spacebar on your keyboard to stop the session.**

Your automation shows up as a line with breakpoints (little dots) in the track’s playlist, as long as you have the automation view visible. If it isn’t visible, click on the Track View selector in the Track Controls section of the Edit window to open the Track view pop-up menu and select the automation parameter — volume, pan, mute, send level, send mute — you want to view.

If this was your first pass writing automation and you had Auto Write mode chosen, Pro Tools automatically switches the Automation mode to Touch when you’re done.

To write over the first pass, you can start anywhere within the session by clicking within the track or along the timeline where you want the automation data to start.

To overwrite switched controls, such as mute, solo, and plug-in bypasses, you can simply press and hold the button down as the session plays. Pro Tools writes new automation data as long as the switch is depressed based upon the current state of the control (on or off).

**Writing plug-in automation**

To write automation data for plug-in parameters:

1. **In the Mix window, click the name of the plug-in in the Insert section of the track’s channel strip.**

   The particular Plug-In window appears.

2. **Click the Auto Enable button in the upper-right of the Plug-In window.**

   The Plug-In Automation dialog box appears, as shown in Figure 6-4.

![Figure 6-4: The Plug-In Automation dialog box lets you choose the parameters to automate.](Image)
3. Select the parameters you want to automate by clicking them in the column on the left and then clicking Add.
   The selected parameters are added to the column on the right

4. Click OK.
   The dialog box closes.

5. Click Play in the Transport Window (or press the Spacebar on your keyboard) to start your session.

6. Carefully move the control for the parameters you want to automate.

7. Click Stop in the Transport window (or press the Spacebar on your keyboard) to stop the session.
   Your automation shows up as a line with breakpoints (little dots) in the track’s playlist, as long as you have the automation view visible. If it’s not visible, click on the Track View selector in the Track Controls section of the Edit window to open the Track view pop-up menu and select the automation parameter — volume, pan, mute, send level, send mute — you want to view.

   Once you’re done writing the automation for the plug-in, you can make sure that you don’t accidentally record over it by clicking the Safe button in the upper-right part of the Plug-In window.

**Writing send automation**

To write automation data for send level, mute, and pan settings, follow these steps:

1. Choose Windows>Show Automation Enable from the main menu.
   The Automation Enable window appears. (Refer to Figure 6-3.)

2. In the Automation Enable window, click the buttons of the Send parameters you want to enable.

3. Choose Windows>Mix Windows Shows>Sends View from the main menu.
   Doing so displays the Send controls for the track(s) you want to automate.

4. Select the Auto Write (choose Auto Touch or Auto Latch for subsequent times) in each track you want to write to by clicking the Automation selector.
   You can find the Automation selector in the Edit window (Book 2, Chapter 4).

5. Click Play in the Transport Window (or press the Spacebar on your keyboard) to start your session.
6. Carefully move the control for the parameters you want to automate.

7. Click Stop in the Transport window (or press the Spacebar on your keyboard) to stop the session.

Your automation shows up as a line with breakpoints (little dots) in the track’s playlist, as long as you have the automation view visible. If it’s not visible, click on the Track View selector in the Track Controls section of the Edit window to open the Track view pop-up menu and select the automation parameter — volume, pan, mute, send level, send mute — you want to view.

**Viewing Automation**

You can view automation data for a particular parameter by selecting the parameter name in the Track View selector in the Edit window, as shown in Figure 6-5.

**Drawing Automation**

Aside from being able to record automation data by moving the parameter as your session plays — as I covered in the chapter up to this point — you can manually draw automation using the Pencil tool. This can be handy for you visual people (you now who you are) who prefer to see what they’re doing — just be sure you know what it’s going to sound like. It is music after all. Seriously, using the Pencil tool to draw automation can make creating fades or correcting previously drawn automation data quick and easy.
You can draw your automation using the Pencil tool in the Edit window. The Pencil tool lets you draw five different shapes, as shown in Figure 6-6: you access the various pencil shapes by click-holding the Pencil Tool.

- **Freehand:** With this tool, you can freely draw automation curves — the changes to the settings for your automation data. If you’re automating an audio track, the shape of the curve you draw determines the number of breakpoints (discrete levels) Pro Tools creates; MIDI tracks follow the preferences you set in the MIDI tab of the Preferences dialog box.

Here’s how you specify that MIDI setting: Choose Setups > Preferences from the main menu, click the MIDI tab, and then enter a value in the Pencil Tools Resolution When Drawing Controller Data box.

- **Line:** This tool draws a straight line. For audio tracks you get two breakpoints — one at the beginning and one at the end. MIDI tracks create breakpoints based upon the resolution setting in the MIDI tab of the Preferences dialog box.

- **Triangle:** This tool creates a sawtooth pattern that follows the current grid value. As was the case with the Line tool, audio tracks contain two breakpoints — one at the beginning and one at the end of each line — while MIDI tracks are stepped according to the resolution you set in the MIDI tab of Preferences dialog box.

- **Square:** This tool draws a square pattern that repeats according to the current grid setting.

- **Random:** This tool creates random levels that change according to the grid value.

So here’s where automation gets visual and, well, kind of magical. To use the Pencil tool to draw automation, follow these steps:
1. **In the Edit window, click the Track view selector in the Track Controls section of the Edit window to access the Track View pop-up menu and then select the automation parameter you want.**

   The waveform fades in the track’s playlist and the automation line appears.

2. **Click and hold the Pencil Tool icon until the pop-up menu appears; then drag your mouse through the menu to choose the tool you want.**

3. **Click and drag within the automation line on the track’s playlist, at the place where you want the data drawn.**

   The new automation data replaces any existing data.

---

**Thinning Automation**

When you write, automation breakpoints are created at a maximum density. Depending on the shape of the curve, you may not need all these breakpoints to get an accurate playback of your moves. Since every breakpoint requires at least some computer memory, removing unnecessary breakpoints can be helpful. This is called *thinning* and can be done either automatically or with the help of the Thin Command.

**Automatically thinning data**

Pro Tools can automatically thin your automation data for you — immediately after you write it. You can make it all happen from the Automation tab of the Preferences dialog box. Open this menu by choosing Setups ➪ Preferences from the main menu and then selecting the Automations tab.

From the Automations tab, you enable automatic thinning by checking the Smooth and Thin Data After Pass box and choosing how much thinning you want by specifying an amount in the Degree of Thinning box. (Refer to Figure 6-2.) The default setting in Pro Tools is *Some* — is that sufficiently vague, or what?

You can always thin your automation data further — at any time — by using the Thin Command. To be safe, I always keep this setting at either Little or Some.

**Using the Thin command**

If the need for thinning doesn’t become apparent until well into your creative process, you can use the Thin command to thin a selection at any time. To do so, follow these steps:
1. Display the automation data you want to thin using the Track View selector located in the Track Control's section of the Edit window.

2. Using the Selector tool, select the section in the playlist you want to thin.

3. Choose Edit ➪ Thin Automation from the main menu.

To thin all data for your selected parameter in a track, press Command+A (on a Mac) or Ctrl+A (on a PC) to select all the data and then choose Edit ➪ Thin Automation from the main menu.

You select the degree of thinning in the Degree of Thinning box in the Automation tab of the Preferences dialog box. (Choose Setups ➪ Preferences to access the dialog box.)

To check your thinning — basically to make sure that it still sounds good — play the thinned section. If you don’t like what you hear, you can choose Edit ➪ Undo from the main menu to undo the thinning.

Editing Automation Data

There are a lot of ways to edit automation data after it’s been written. You can use one of the Edit tools (Grabber, Pencil, Trimmer), you can cut/copy/paste, and (of you want to get drastic) you can delete your automation. These options are covered in this section.

Using editing commands

You can use standard Edit commands such as Cut, Copy, Delete, and Paste to edit your automation data. To edit using these commands, you first have to select the data. Here’s how:

1. Using the Track View selector in either the Edit or Mix window, display the automation parameter you want to edit.

2. Using the Selector tool, highlight the section in the playlist you want to edit.

   If you’re looking at the track in Waveform or Block view (for audio tracks) — or in Block, Region, or Notes view (for MIDI tracks), your edits will affect all automation data for the selected section. To edit an individual parameter, display it in the Track View.

   Grouped audio tracks are all edited (except when you’re editing panning data) when you select data from one track in a group. To edit only the data on the selected track, press Start/Windows (on a Windows PC) or Command (on a Mac) when you perform your edit.
Grouped MIDI tracks are edited individually (except for panning data) unless you press Start/Windows (on a PC) or Command (on a Mac) as you perform your edit.

Panning data works in two opposite ways for groups of audio tracks and MIDI tracks. If you want to edit the panning data for a group of audio tracks, you have to press Start/Windows (on a PC) or Command (on a Mac) as you edit — which affects the entire group. Using this keystroke command (pressing Start/Windows on a PC or Command on a Mac) on a group of MIDI tracks, however, edits panning data one track at a time.

Cut and Delete

You get rid of unwanted stuff when you cut and delete automation data, but the Cut and Delete commands treat the unwanted stuff a bit differently:

✦ Cut: When you cut a selection of automation data, Pro Tools automatically adds two new breakpoints to your remaining data and places the cut material in the Clipboard. The two new breakpoints are placed at the beginning and end of the cut section. Any slope in automation curves that exist before and after the cut section remain, as shown in Figure 6-7.

In Pro Tools, you cut by choosing Edit ➪ Cut from the main menu or by pressing Command+X (on a Mac) or Ctrl+X (on a PC)

✦ Delete: When you delete selected automation data, the remaining automation data connects at the nearest breakpoints. Any curves between the breakpoints and the beginning or end of the deleted selection are removed, as shown in Figure 6-8.

In Pro Tools, you delete by choosing Edit ➪ Delete from the main menu or by pressing Backspace (on a PC) or Delete (on a Mac).
Copy
Choose Edit➪Copy from the main menu to place copied data in the Clipboard so you can paste it somewhere else.

Paste
When you use Edit➪Paste from the main menu to paste selected automation data in a new location, breakpoints are created at the beginning and end points of the selection. These breakpoints make sure that the automation levels and slope (change in level) that exist before the beginning and end points of the pasted material remain the same, as shown in Figure 6-9.

Editing with (surprise) edit tools
You can use the editing tools located in the Edit window to change automation data within a track. The three tools you can use are the Grabber tool, the Trimmer tool, and the Pencil tool. These are detailed in this section.

Grabber
The Grabber tools lets you move, add, and delete breakpoints. To perform these operations, do the following:
• **Adding breakpoints:** To add a breakpoint with the Grabber tool, click in the automation line where you want the new breakpoint.

• **Deleting breakpoints:** To delete a breakpoint from an automation line, put the Grabber tool on it and press Alt (on a PC) or Option (on a Mac) as you click.

• **Moving breakpoints:** To move a breakpoint, click and drag it to where you want it.

**Pencil**

You can add or delete breakpoints with the Pencil tool by doing the following:

• **Adding breakpoints:** To add a breakpoint with the Pencil tool, click in the automation line at the place where you want the new breakpoint.

• **Deleting breakpoints:** To delete a breakpoint, put the Pencil tool on it and press Alt (on a PC) or Option (on a Mac) as you click.

**Trimmer**

The Trimmer tool lets you move selected breakpoints up or down by clicking and dragging them, as shown in Figure 6-10.

![Figure 6-10: Before (left) and after (right) adjusting automation levels using the Trimmer tool.](image)

**Tip**

To move breakpoints left or right, select them using the Selector tool and, using the number pad on your keyboard, press the minus key (−) to move left or the plus key (+) to move right.
Chapter 7: Making Your Mix

In This Chapter

- Submixing your tracks
- Mixing within Pro Tools
- Mixing to an external recorder

The final step in mixing your music involves taking all your EQed, panned, processed, and automated tracks and recording them into a stereo pair of tracks. This is often called bouncing your mix. In the old analog days, bouncing meant sending all your tracks to either two separate tracks on the same tape deck or to a different tape deck. Nowadays, with Pro Tools, you can create bounces several ways — all of which are covered in this chapter.

In this chapter, I lead you through the process of making your mix either within Pro Tools (a method called in-the-box) or by sending your tracks out to either a digital or analog two-track machine (usually a DAT or — yes, even today — reel-to-reel tape deck).

Unless you have a seriously great analog deck and you want to add some of that sought-after “warmth-of-analog” tape sound to your final mix, your best bet is to go with the in-the-box approach — using the Pro Tools Bounce to Disk feature and keeping your music in your computer.

Submixing by Recording to Tracks

Submixing is the process of mixing some of your tracks down to one or two additional tracks within your session. When you record to tracks, the submixed material automatically shows up in your session. You can then turn off the voices of the tracks you submixed and control the resulting track(s) from one (or two) fader(s). This is handy if . . .

✦ You have more than 32 tracks (or 24 if you have an older version of Pro Tools) in your song that you want to mix. For example, you can reduce your track count by submixing your drums or backup vocals to two tracks and using only those two for the final mix.

✦ You have MIDI tracks and want to record the audio output from your MIDI devices to audio tracks before doing your final mix. Your MIDI tracks are just instrument-control data; they contain no recorded sound. At some point in the process of mixing, you need to record the actual audio output from your sound source to your audio tracks.
You want to record your final mix in real time and still be able to move the faders and other controls while your session plays. Some recordists get antsy when Bounce-to-Disk mode (see “Mixing in the Box,” later in this chapter) creates the bounce offline; it prevents them from adjusting any controls as the mix is created. (Hey, call it a control issue.)

To create a submix by recording to tracks, follow these steps:

1. Set your effects, panning, and EQ settings for the tracks you want to submix.
2. Using the Output selector, assign the outputs for all tracks you want to submix (including any auxiliary tracks that your Send effects are routed to) to one of the stereo bus paths (buses 1 and 2 for instance).
3. Choose File ➤ New Track from the main menu.
   The New Track dialog box appears.
4. Use the drop-down menus in the New Track dialog box to enter the number of tracks you want (1), the type (Audio), and whether you want your track in mono or stereo.
5. If you created a stereo track to submix to, set the panning of the right track to hard right and that of the left track to hard left.
6. Set the Input selector for the new track you created in Step 4 to the same bus path that you chose for the tracks you want to submix (buses 1 and 2, in this case).
7. Using the new track’s Output selector, select the main output for your session as the output path for the track.
8. Make sure that your Edit and Timeline selections are linked by choosing Operations ➤ Link Edit and Timeline Selections from the main menu.
   Linking Edit and Timeline selections means the Timeline selection range follows the selection you make in a track’s playlist.
9. Using the Selector tool, select the section of the session that you want to submix.
   If you want to record the entire session, be sure to put your cursor at the beginning of the session before you record it. If you want to record only part of the session, select the part you want. (Book 4, Chapter 2 details this process.)
10. Click the Record Enable button on the new track.
11. Click Record in the Transport window.
12. Click Play in the Transport window.
   The submix process begins.
13. Press Stop in the Transport window when you’re finished. (If you selected part of the session to record, the session stops playing automatically when it reaches the end of your selection.)

Be sure to let the session play until the last bit of reverb or other effect is finished playing.

Mixing in-the-Box

Mixing in-the-box refers to using the Bounce to Disk feature in Pro Tools to create your final mix. The Bounce to Disk feature processes your audio tracks in real time (you can hear the session as it plays) but offline (you can’t manipulate any controls when the bounce is happening).

Pro Tools creates a new file with the settings you choose in the Bounce dialog box. What you get is a file you can import back into your session so you can play back your Bounced mix and evaluate how it sounds. The advantage of using the Bounce to Disk feature over recording to tracks (described earlier in “Submixing by Recording to Tracks”) is that you don’t need to have any extra voices available to receive the bounced files.

Examining bounce options

You access the Bounce dialog box, shown in Figure 7-1, by choosing File ➪ Bounce To Disk from the main menu. The dialog box lets you set the following options:

✦ **Source:** You can use the Bounce Source drop-down menu to select any output or bus path as your source for the bounce. (Figure 7-2 gives you a peek at some of the choices.)

✦ **File Type:** This drop-down menu sets the file type for the bounced file. You have many choices — Book 2, Chapter 5 details them all — but for your final mix, these common, Pro-Tools-supported file types are the ones to choose from:

  - **BWF (WAV):** This file type is the standard for older, PC-based Pro Tools systems — and it’s currently the most commonly used file type. (One reason: BWF files are compatible with both Macs and PCs.) This is the type I generally choose.

  - **AIFF:** This stands for Audio Interchange File Format and used to be native to Macs. AIFF files can be imported without converting into any Pro Tools session — including those on a PC — but since BWF is becoming the standard I skip this type. If you use a Mac and you plan to do your mastering on your Mac using Pro Tools, this file type is a fine choice.
✦ **Format:** This drop-down menu determines whether your bounced file is in Mono, Multiple Mono, or Stereo Interleaved. These formats do have some differences that are good to know:

**Mono (Summed):** Choosing this option creates a single audio file that contains all the material without any panning information.

Because any stereo information is summed, it’s easy to get too high of a combined signal. This results in clipping (distortion). If you want to record using this format, make sure that you reduce your levels so that the left and right channels peak at no more than –3db, although –6dB is better. (Book 6, Chapter 1 has more on setting levels.)

**Multiple Mono:** This format puts the left and right channels of your stereo mix in separate files, labeling the files with (respectively) the .L and .R filename extensions.

Multiple mono is the file format supported by Pro Tools — which makes it the one to use if you intend to master your music yourself within Pro Tools. If you plan to use a professional mastering engineer, call him or her to see what file format works with the mastering equipment. (It will either be multiple mono or stereo interleaved.)

**Stereo Interleaved:** This format contains all stereo information in a single stereo file. Panning information is retained. Any tracks set to even-numbered outputs end up on the right side of the stereo file; tracks set to odd-numbered outputs go to the left side of the stereo field.

✦ **Resolution:** This setting lets you choose one of three bit rates for your bounced files: 8, 16, or 24. (Book 1, Chapter 1 has more on resolution.) For your final mix, choose 24 bit (maximum resolution). You can reduce it as needed later on, when you master your music yourself or when you have a professional do it for you.

✦ **Sample Rate:** You can save your file with any of several sample rates, but I recommend saving it with the same rate as the files in your session. Check out Book 1, Chapter 2 for all the details about sample rates.

If you intend to have your music mastered by a professional, make sure to ask her what she prefers. Some mastering engineers want the files at the highest sample rate possible while others would rather have you not change the rate.

✦ **Conversion Quality:** If you choose a sample rate different from the files in your session — which I don’t recommend — you’re prompted to choose a level of quality for the conversion. Choose the highest quality possible for your mix material, but keep in mind that the higher the quality you choose, the longer it takes to do the conversion process.
Performing the bounce

To use the Bounce to Disk feature, first make sure that all your tracks are the way you want them. Check all routing, automation, effects, and EQ settings to make sure they’re right. Then do the following:

1. **Choose File ➤ Bounce to Disk from the main menu.**
   The Bounce dialog box appears. (Refer to Figure 7-1.)

2. **Set your Bounce options to the settings you want.**

3. **Click Bounce.**
   The Save Bounce As dialog box opens.

4. **In the Save As dialog box, choose a destination point for this file, enter the name of this mix, and then click Save.**
   The session plays while the bounce happens.
Using an External Master Deck

You can mix to an external device instead of mixing within Pro Tools. This section explains how to mix to both analog and digital recorders.

You can mix to an external digital device such as a DAT (Digital Audio Tape) deck — or (for you “classic technology” fans) to an analog device such as a reel-to-reel tape recorder — by following these steps:

1. **Connect your device to your Digidesign interface.**
   
   For digital recorders, run a cable from the digital outputs of the interface to the digital inputs of your device. You’ll need to use either an optical or coaxial connection, depending on the interface.
   
   For analog recorders, run a cable from two of the analog outputs of the interface to the inputs of your device.

2. **If you want to be able to monitor this device as it records, connect the device’s outputs to your monitors (speakers) or plug your headphones into the headphone jack (if your device has one).**

3. **Using the Output selectors, set the output of your tracks, auxiliary inputs, and master fader to the physical outputs of your interface.**
   
   These must correspond to the output you connected your device to.

4. **Enable recording in your external device.**

5. **Click Play in the Transport window of your Pro Tools session.**

6. **Adjust your input levels on your external device.**

7. **Rewind the session.**

8. **Start recording on the external device and immediately press the Spacebar on your computer keyboard or click Play in the Transport window.**
   
   The session plays and you record it into your external device.

9. **Click Stop in the Transport window or press the Spacebar on your keyboard when the music is done.**
   
   You now have a mix recorded into your external device. (Look out, world, here it comes . . .)
Book VII

Mastering with Pro Tools

The 5th Wave

By Rich Tennant

“ Aren’t you taking this world music thing a bit too far?”
Contents at a Glance

Chapter 1: Mastering Basics
Chapter 2: Mastering Your Music
Chapter 1: Mastering Basics

In This Chapter

- Understanding mastering
- Knowing when to master your music yourself
- Knowing when to send your music to a mastering house

You’ve spent a lot of time getting all your tracks recorded using the best mics you can afford. (Mics you’ve carefully set up following the guidelines in Book 3, Chapter 2, I hope!) You adjusted your levels just right, EQed, panned, and added effects to each instrument with great care so they fit perfectly in the mix. Now you have awesome-sounding music. So all that’s left is to burn a CD, create cool cover artwork, make some copies, and you’re ready to go platinum, right?

Well, you could do that, but you’d be missing one of the most important steps in getting your music to sound its very best. This is the mastering process. Mastering can turn your already-good music into a truly great CD. The only problem is that most people have no idea what mastering is. It’s been presented as some mysterious voodoo that only people who belong to some secret society and have access to a magical pile of gear can do.

This isn’t the case. Mastering is, in fact, a pretty simple process, involving some plug-ins in Pro Tools that you’ve already had a chance to use. Mastering does require specialized skills, but you don’t need to go through any strange initiation rites to learn them. All it takes is an idea of what to do, decent ears (you’ve got a couple of those, right?), and a dose of patience while you work your way through the process.

In this chapter, you get a chance to understand the “magic” that is mastering. You discover what’s involved in mastering your music. You explore ways to make sure your music is ready to master and discern when it might be best to find a professional to do the job for you.

Demystifying Mastering

The mastering process of recording involves preparing your music for duplication. Several steps are involved in taking your songs from individual, mixed tunes to part of a whole album. First, you need to optimize the dynamics and tonal balance of each song, and then process the songs so
they are matched in volume to each other. These steps usually involve putting the songs through some EQing, compressing, limiting, and sometimes expanding.

You also need to sequence your music — put your songs in the best order possible, with an appropriate amount of time between songs. Your last step is to put your mastered music into a format — and a medium — that enables you to duplicate and distribute (hey, even sell!) it. This format and medium is usually a CD. (I describe this process in detail in Book 8, Chapter 1.)

**Processing**

No matter how well you recorded and mixed your music, you still need to do some processing during the mastering stage. This usually consists of adjusting levels with compression, limiting, EQing, and (if needed) additional processing. Luckily, all this can be done right in Pro Tools, using the plug-ins that came with the software. The plug-ins you’ll use when mastering are covered in detail in Book 6, Chapters 3 and 4.

The purpose of the processing stage is to do the following:

- Balance the overall tonal characteristics of each song.
- Optimize the dynamics of each song so all the songs are at their best overall volume.

You can achieve these goals by using the following tools:

- **Compression**: Some music sounds best when it’s smooth, and other music is much better when it has a punchy quality to it. Judicious use of a Pro Tools Compressor plug-in can produce either of these effects. A good mastering engineer knows when and how to make music punchy or smooth. (Sorry, you can’t have both at the same time.)

- **Limiters**: If any instruments are too high in comparison to the rest of the mix, then a Pro Tools Limiter plug-in can tame them so you get the best overall difference between the songs’ peak levels and average levels. This difference varies depending on the style of music, but it should never be less than 6dB and is usually between 12dB and 18dB. (For more on limiter plug-ins, see Book 6, Chapter 4.)

- **EQ**: Because you recorded and mixed each of your songs individually over a period of time (often a long period of time), chances are that each song sounds a little different. Some may be brighter than others, some may be heavier on bass, but one thing’s for sure — each will have a different tonal quality.
Sequencing
Sequencing involves putting your songs in the order that you want and setting the blank space between each song so that the CD flows well from one song to another. Because a CD is supposed to represent a cohesive body of work, this is one of the most important aspects of mastering.

Leveling
A crucial aspect of mastering a CD is getting the levels of all the songs to be the same. After all, you don’t want your listener to adjust the volume of his stereo from one song to another. Having consistent levels from song to song helps with the cohesiveness and flow of a CD. This is done with simple gain adjustments, compressors, and/or limiters — and by making those processes consistent, Pro Tools gives us mere mortals a crack at doing it right.

Getting Ready to Master
You can save yourself a ton of time and energy when mastering your music if you keep a few things in mind during the mixing stage. When you’re wearing your Mixing Master hat, the following reminders can make the mastering process go a bit more smoothly:

✦ Check your levels. Listen to your mix quietly and you can tell whether one instrument sticks out too much in the mix. Also, burn a CD of your mixed song to test on other systems (your car, a boom box, your friend’s stereo system). Listen carefully. If the bass drum is even slightly too loud, it eats up headroom that the rest of the instruments need — so you can’t get the overall volume of the song very high.

✦ Check your EQ. Even though the mastering engineer (you or a pro) EQs the entire song, the time you spent getting each instrument EQed in the mix is still a good investment. If you didn’t get your EQ just right during the mixing process and (for example) a muddy bass guitar sound has to be EQed during mastering, you lose some of the low end on all the instruments. This makes your mix sound thin. If your bass is EQed properly in the first place, you don’t have to make that adjustment to the entire mix.

✦ Test your mix in mono (turn off the stereo panning on your master bus). This helps you hear whether any instrument’s volume or tonal characteristics are seriously out of balance with others. I never consider a mix finished until I monitor it in mono.

✦ Apply compression on your mix before you record the two-track mix just to see what your music sounds like compressed. Don’t record the compression, though. Leave that for the mastering stage. By testing your
mix with some compression, you may hear whether certain instruments are too loud in the mix — if so, they become more apparent when compressed.

✦ **Listen for phase holes.** Phase holes occur when you record an instrument (piano, backup vocals) in stereo and the left and right tracks are out of phase. To listen for phase holes, pay attention to how the instrument sounds in the stereo field. You have a phase hole if you hear sound coming only from the far right and far left and nothing seems to be coming from the center of the stereo field. If you have this problem, all you have to do is reverse the phase on one of the two channels for that instrument.

**Paying a Pro or Doing It Yourself**

Whether to master your music yourself or to hire a professional may be one of your toughest music-making decisions. If you master your music yourself, you can have complete control from start to finish and save yourself some bucks. On the other hand, if you hand your mixed music over to a skilled professional, you can have the added benefit of another person’s ears and advice, and you can end up with a finished product that far exceeds your expectations.

So how do you choose?

Well, your first consideration is probably based upon economics — do you have the money to spend on professional help (for your music, that is)? Mastering can cost anywhere from a couple hundred to thousands of dollars. A midline mastering engineer often charges around $500 to master your CD (about ten songs). This may seem like a lot of money, but if you find the right engineer for your music, it can make the difference between a decent CD and a truly world-class one.

Another consideration for hiring out your mastering is how well you know your equipment and how capable it is of performing the mastering procedure. To do mastering, you need at least one good (well, preferably great) multiband compressor, a limiter, and a great multiband parametric EQ. The plug-ins that come with Pro Tools can get you most of the way to a great-sounding master. If you really get into mastering in Pro Tools, you can add some third-party plug-ins (such as the Waves or PSP Audioware brands) that offer better sound and more flexibility. You also need to have a CD burner of some sort and the software to create a Red Book CD master. (More about CD burners and Red Book standards in Book 8, Chapter 1.)
Before you decide, take a look at other benefits of hiring a skilled professional to do your mastering:

✦ A meticulously tuned room and top-notch monitors so you can hear what your music actually sounds like.
✦ Equipment specifically designed to handle the process of mastering. The EQs, compressors, and other gear that the mastering house uses can tweak your music so it can sound its best.
✦ A fresh set of professional ears that may be able to hear things in your mix that need fixing. You may be so close to the project that you have a hard time hearing your mix objectively.

**Hiring a Professional Mastering Engineer**

If you do decide to use a professional mastering engineer, the following tips can help you choose one for your project:

✦ **Ask around for referrals.** If you know local bands or musicians whose music you like and whose CDs sound great, ask them who mastered their music. Call local studios and find out whom they recommend for mastering in your area. Also check out resources on the Internet. Two great Internet forums are: www.musicplayer.com/cgi-bin/ultimate bb.cgi recpit.prosoundweb.com/. In a forum, do a search for the term mastering or post a new topic and ask your question. Try to get referrals from people who work with your type of music.

✦ **Listen to other recordings that the mastering house has done in a style of music similar to yours.** If you’re entrusting your artistic vision to someone else, make sure that this person is the right person for the job. If you like what the prospective mastering engineer has done on other people’s music, you’ll probably like what he or she does with yours.

✦ **Clarify what the fee for your project will be before you actually start working together.** Most mastering engineers charge by the hour and can give you a pretty good estimate of how many hours they’ll need to do the job. You’ll also be expected to pay for materials (reference CDs, for example).

✦ **If you don’t like the way the engineer mastered your music, you’ll probably be charged at the hourly rate to redo it.** Some engineers may redo your project for free, but don’t count on it. Be sure to discuss this possibility before you start the project to avoid unwanted surprises.
Many mastering engineers will do a demo for you, tooling up one or two songs so you can hear what kind of job they can do for your music before you hire them. Ask whether the mastering engineer you’re interested in offers this service. This simple step can save both you and the engineer a lot of time and energy if he or she isn’t right for the job. It can also help you determine whether your mixed music is ready for mastering — if you need to go back and make adjustments, now’s the time to find out.

After you choose the mastering engineer that you think will work well for you and your music, you can make the process much easier and less stressful (for both you and the engineer) if you follow a few guidelines:

✦ **Discuss your expectations and desires.** This is the best way to ensure that your mastered music turns out the way you want. People who are unhappy with the job that the mastering engineer does usually aren’t clear about what they want or don’t understand what is possible in the mastering process.

✦ **Take a few CDs whose sound you like with you to the mastering session.** Talk with the engineer about how you can get your music to sound similar. A skilled engineer can let you know right away whether the sound you want is possible.

✦ **Try to be present at the mastering session.** Many people send their music to a mastering engineer and expect him or her to do the job without their presence in the studio. Try to go to the studio, but if you can’t, be sure that the engineer clearly understands your desires and expectations.

If you’re in the studio during the mastering process and things aren’t going the way you want, talk with the engineer and try to get things on track again. If you’re finding that you’re unable to communicate with the engineer, stop the session, have him burn a *ref* (reference copy), pay for the time you’ve used, and listen to the ref at home. If you don’t like what you hear at home, then you may be best off going somewhere else with your music.

A right balance does exist between what you can achieve on your own with your Pro Tools skills and the benefits that professional mastering can bring to your finished product. The balance is well worth finding.
Chapter 2: Mastering Your Music

In This Chapter

✓ Setting up a mastering session
✓ Converting your song files
✓ Processing your production
✓ Sequencing your songs

You've done everything else yourself, so why not master your music, too? Well, I hear ya. Even though I'm a firm believer in the magic that a professional mastering engineer can bring to a production — check out Book 7, Chapter 1 for my take on that — I'm also a do-it-yourself kinda guy. If you're like me, then you at least need to give mastering a shot. After all, there's nothing to lose — only a little time — and everything to gain (or at least learn from).

This chapter walks you through the process of mastering your music in Pro Tools. I offer some general guidelines that you can keep in mind as you work and get you up to speed on mastering your music yourself. I also show you how to set up your mastering session in Pro Tools.

The Pro Tools mastering steps given here use the Bounce to Disk function. You do not necessarily have to go this route. If you want, you can also send your mastered tracks out to a digital device by following the steps in this chapter — and then use the steps that describe mixing to an external digital device (found in Book 6, Chapter 7).

Considering General Guidelines

In other chapters, I present some specific techniques and settings to get you started. Unfortunately, I can’t do that when it comes to mastering — there are just too many variables. That also means too many ways to mess up your music when you’re trying to master it. What I can do (and actually do) in the upcoming sections is walk you through the process of mastering and show you the tools to use for each step. When you’re reading these sections, keep the following in mind:

✦ Less is more when mastering. Do as little as possible to your music. All you really should need to do when you’re mastering is optimize the dynamics and tonal balance of each song, get the levels between the
Setting up a Mastering Session

The first step in mastering your music in Pro Tools is to set up a mastering session. This involves creating a new Pro Tools session and importing the mixed tracks from each song you want on your CD. This section of the chapter details that process.

Start by creating a new session for mastering:

1. **Choose File ➤ New Session from the main menu.**
   
The New Session dialog box appears.

2. **Type in the name of the file in the Save As field.**
   
   I usually call it mastering and include the name of the CD project that I’m working on.

3. **In the Where field, choose the folder you want to place the new session in.**
   
   I usually create a new folder called mastered mixes so it’s easy to find the files later when I burn them to CD.
4. Choose the session parameters that match the mixed files for your songs.

We’re talking audio file type, sample rate, I/O settings, and bit depth here. Book 2, Chapter 3 has more on the basics of setting up a new session.

5. Click Save.

Your new session opens.

Okay, at this point you have a general “same place” to put the songs. Next, create tracks to import the mixed song files into:

1. Choose File ➪ New Track from the main menu.

The New Track dialog box appears.

2. In the Create field, enter a number corresponding to the number of songs you want on your CD. Then choose Stereo and Audio Track from the drop-down menus.

3. Click Create.

Your session now has the necessary tracks for importing your audio.

With tracks created, you can now import your mixed tracks into this session:

1. Click-hold the Audio title bar from the top of the Audio Regions list and choose Import Audio from the pop-up menu that appears.

If the Audio Regions list isn’t visible, click the double arrow at the bottom-right corner of the Edit window or press Shift+Command+I (on a Mac) or Shift+Control+I (on a PC).

The Import Audio dialog box opens.

2. Using the Look In field, navigate through your folder structure to find and select the song file you want to import.

3. Click Done.

The file appears as a region in the Audio Regions list.

4. Repeat Steps 1-3 for each song you want to master in this session.

Finally, place your audio regions into the tracks in the session:

1. Click-drag the region from the Audio Regions list into the playlist of the track you want the song in.

2. Repeat Step 1 for each of your songs, so that you end up with only one song in each of the available tracks.
You now have a session that contains all the songs for your project. Having them all in one session allows you to switch from one song to the next as you master your tunes and makes it easy to check loudness levels and EQ balancing as you work. (See the “Perfecting Tonal Balance” and “Balancing Levels” sections, later in this chapter.)

**Optimizing Dynamics**

Okay, this is where the magic in mastering happens. This is where you can make your music shine or where you can royally mess it up. (How’s that for adding a little pressure?) Before you get tense (okay, breathe), remember that you can always go back and try again. Oh, did I mention that you should make backup copies of your individual tracks and your final mix? Well, if you haven’t already done the backing-up business, now would be a good time to do that. I’ll wait.

You done? Okay, now to the job at hand — getting your music to be as loud as possible. (I’m just kidding; see the sidebar “Turn it up!” to see why.) Seriously, optimizing the dynamics of your songs doesn’t mean getting it loud enough to level a city block, but rather getting it to have life and emotion. And, yes, this _also_ means getting it to be loud _enough_ to sound good.

The style of your music and the arrangements that you use determine how you optimize the dynamics of your music. For example, classical music has a much broader dynamic range than rock music, and the infamous “wall of sound” type of arrangement has a narrower dynamic range than a song with sparse verses and thicker choruses.

When you’re optimizing the dynamics of your music, be sensitive to the song and try not to get sucked into the idea that you need to get the most volume out of your music. I know I’m beating this volume thing into the ground, but you’d be surprised how seductive the lure of Big Volume can be. (“C’mon, let’s get just a few more dBs out of the song . . .” trust me, you’ll soon find out.)

You have two main types of tools to use when you work on the dynamics during mastering in Pro Tools — compressor plug-ins and a limiter plug-ins — and each has its purpose. For the most part, if you’re trying to add punch or smoothness to your music, a compressor plug-in does the job nicely. On the other hand, if you’re trying to squeeze a _little_ more volume out of a song and you don’t want to change the song’s sound quality, a limiter plug-in is your best choice.

Here are suggestions that might help you to use compression and limiting most effectively during mastering:
✦ Use a mild compression ratio (between 1.1:1 and 2:1) to keep from over-compressing your music.

✦ Apply only 1 or 2dB of compression or limiting at one time. If you need more than that, chain more than one compressor together by inserting more than one compressor plug-in in your track and use these small amounts on each. If you compress or limit more than 1 or 2dB at a time, you end up with artifacts (audible changes to your music caused by the compressor or limiter).

✦ Work with your attack and release times. An attack that’s too short takes the punch out of your music by cutting off the initial transients. Likewise, a release time that’s too long doesn’t recover quickly enough, and the dynamics of the vocal disappear. In contrast, if the release time is too short, you hear distortion.

✦ Set the threshold so your compressor’s meters dance (bounce) to the rhythm of the music. The meter you want to watch in your Pro Tools compressor plug-in is the one labeled “reduction,” located below the input and output meters. Only the loudest notes (snare drum or lead vocal accents, for example) should trigger the meters — and then only by one or two dB.

✦ A multiband compressor allows you to bring out individual instruments in the mix. For example, if the bass drum seems to be getting lost, you can apply mild compression to the lower frequencies (around 80 to 100 Hz). This brings the instrument forward in the mix slightly.

Pro Tools LE doesn’t come with a multiband compressor plug-in. If you want to use one on your music, you need to get a third-party RTAS plug-in. Check out the Digidesign User’s Conference (DUC) at duc.digidesign.com/ for some options.

✦ When you’re not sure if what you’re doing sounds better, don’t use the processor. Any dynamics processing is going to affect the quality of your song’s sound to some extent. If adding this processing doesn’t improve the overall sound, you’re better off not using it.

You can find out more about compression and limiting in Book 6, Chapter 4.

When you’re testing your compressor plug-in or limiter plug-in settings (you do this by comparing the processed and unprocessed versions), be sure to have the volume of both versions exactly the same. Any difference in volume defeats the purpose of side-by-side comparison because people almost always prefer the louder version whether or not it sounds better.
Perfecting Tonal Balance

The tonal balance of a song is how the various frequencies of the music relate to one another. You’re not concerned with how each individual instrument sounds in the mix (that’s the job for the mixing stage); instead, what you’re looking for is an overall balance of frequencies within the hearing spectrum.

For the most part, a tonal balance consists of an even distribution of frequencies from 20 to 10 kHz with a slight drop-off (1 or 2 dB) from 10 to 20 kHz or higher. That’s great, you say, but what does that sound like? Well, listen to any number of great CDs, and you’ll hear it.

When you master your music, you want to constantly compare what your song sounds like to other CDs whose sound you like. In Book 6, Chapter 1, I list a variety of excellent reference CDs for mixing. These CDs work just as well for mastering, so check them out.

When you work on adjusting the overall tonal balance of your songs, listen carefully for any frequencies that seem too loud or too soft. You can find these by listening to particular instruments in the mix or by using the parametric EQ plug-in and sweeping the frequency spectrum. To do this, set your

Turn it up!

Everyone wants his or her music to be as loud as possible. Louder sounds better. In fact, test after test has shown that when people listen to two versions of a song, they nearly always prefer the louder one (whether it actually sounds better or not).

Musicians, producers, and engineers seem to be in the middle of a competition to see who can make the loudest CD. If you compare a CD made about ten years ago with one made this year, you’ll notice that the newer one is much louder. Give them both a good listen, though. Does the louder one really sound better?

You can test this by setting them both to play at the same volume and switching back and forth. (You need to turn the volume up a bit on the older CD to match the volume of the newer one.) One way to do this is to record both songs into Pro Tools and set the levels of each so that they’re the same. At the same volume, which song sounds better to you? I’m willing to bet that, nine out of ten times, you’ll prefer the older song. This is because older recordings have more dynamic range than newer ones. The variety is pleasing to listen to, whereas the song with only a small dynamic range quickly becomes tiring.

Do yourself and your listeners a favor and resist the temptation to compress the dynamic variability out of your music. It will be much easier to listen to and have a lot more life and excitement. You can always turn the volume up on your stereo if it’s not loud enough, but you can’t add dynamic range after you’ve squashed it out.
Q fairly wide (0.6, for instance) and move the Gain slider all the way the right. Start with the lowest frequency and slowly raise the frequency as the song plays by moving the Freq slider from left to right. Adjust any annoying frequencies by cutting them by a couple of dBs to see if your overall mix improves.

As far as general EQ guidelines go, try these suggestions:

✦ If your mix sounds muddy, add high frequencies (above 10 kHz) or cut low ones (200 to 400 Hz). Likewise, if your mix is too bright (common with digital recording), try reducing the frequencies above 10 kHz by using a shelf EQ or a Baxandall curve.

(To use a Baxandall curve, use a parametric EQ and set the threshold at 20 kHz with a Q setting around 1. This gradually cuts frequencies above around 10 kHz. You can adjust the Q to reach as far down as you want. Your EQ graph shows you what’s happening.)

✦ Use the same EQ adjustments for both the right and left channels because this keeps the stereo balance intact and doesn’t alter the relative phase between the channels. For example, if you add some bass frequencies (100 Hz, for example) to the one channel and not the other, you may hear a wavering or pulsating sound around this frequency go back and forth between the speakers.

✦ If you used a multiband compressor on any specific frequencies, you may need to adjust the EQ for those frequencies; compression tends to mess with frequency response.

Pro Tools LE doesn’t come with a multiband compressor plug-in. If you want to use one on your music, you need to get a third-party RTAS plug-in for Pro Tools. Check out the Digidesign Users’ Conference (DUC) at duc.digidesign.com/ for some options.

✦ If you need to adjust the EQ of certain instruments in the mix (the snare drum is buried, for example), be careful and notice the overall effect of your adjustments on the rest of the mix. If your adjustments aren’t fixing the problem, go back to the mixing process and make your adjustments there. You’ll be glad you took the time to do that.

Any adjustments you make to the EQ during mastering impact more than just those frequencies. Such adjustments alter the entire frequency spectrum — and the relationship between all the instruments. So listen carefully as you make adjustments and back off on the additional EQ if you don’t like what you hear.

For more specific information on EQ and inserting EQ in your tracks, go to Book 6, Chapter 3.
Some people check the tonal balance of their songs against that of their favorite CDs. You do this by recording a song into your mastering program and taking a look at its frequency response by using a spectral analyzer. (Pro Tools doesn’t come with a spectral analyzer, but you can buy one as a third-party plug-in — look for an RTAS version to ensure that it works with Pro Tools.) Then do an analysis of your song and compare it to the spectral analysis of a CD you like. This technique seems to work for many people (not me — I like using my ears instead — but alas, I’m old-fashioned).

Balancing Levels

For a truly professional-sounding CD, you want all your songs to be at nearly the same relative level so your listeners (I hope you have more than one) don’t have to adjust the volume on their stereos from song to song.

Balancing the levels of your songs to one another is pretty easy. In fact, in most cases, you have very little to do after you EQ and optimize the dynamics of each song. You balance the levels from one song to the next in Pro Tools by putting each track’s fader up to 0dB — this puts them at the level you mixed them to — and then soloing Track 1 and comparing the level to Track 2 by soloing back and forth.

If you use a mouse to mix, this can be kinda tricky because you can’t press more than one button at a time. The best way I’ve found to deal with this situation is to follow these steps:

1. In the Track Controls section of Track 1, click the Solo button to solo the track.
   
   You hear only Track 1 in your monitors.

2. In the Track Controls section of Track 1, click the Mute button so both the Solo and Mute buttons for Track 1 are engaged.
   
   Track 1 is silent.

3. In the Track Controls section of Track 2, quickly click the Solo button.
   
   You now hear Track 2.

4. To switch back to hearing Track 1, click Track 2’s Solo button (disengage it) and — as quickly as possible — click Track 1’s Mute button (disengaging the Mute button and engaging the Solo button).
   
   You hear Track 1 again.

You get a short bit of silence when following this procedure but you’ll still be able to hear the relative volumes of the two.
Do this procedure for each of the tracks (Track 1 to Track 2, Track 2 to Track 3, and so on) until you’ve checked all the tracks in your mastering session.

If you miss one of the buttons while you’re doing this quick-switch procedure, you may end up with both tracks playing at the same time. This will be very loud because the tracks are summed together in the mix bus. To avoid damaging your speakers — or ears — keep your monitoring (speaker) volume down pretty low.

If you notice any differences, just raise (or better yet, lower) the levels until they are all roughly the same. Don’t get too finicky. Some variation from song to song is okay. In fact, minor differences can help to make your CD more interesting to listen to. When you’re balancing levels, just make sure that any differences aren’t enough to make the listener run to his or her stereo to adjust the volume knob. If one or two songs seem much lower in volume than the rest, you may want to go back to the volume-optimizing stage and raise those songs up a bit to make them more consistent with the rest of the songs on the CD. That way you don’t lower the volume of the entire CD because one or two songs are too quiet.

*Mastering Your Mix*

Once you have all your songs dynamically optimized, EQed and level-balanced (see previous sections) you’re ready to record your final master. This process is essentially the same as making your final mix, so check out Book 6, Chapter 7 for the steps to do this. There is one more thing you need to do when mastering however — this involves getting your songs to the CD format.

Most likely, your session’s songs are recorded at 24 bits, using any number of possible sample rates (44.1, 48, 88.2, or 96 kHz) — and your final master should be 16-bit at 44.1 kHz. Making this change can reduce the sound quality of your music if it’s not done right. This section details how to change the sample rate and bit depth as you create a final master version of your music.

*Making the most of your bits*

Getting your music from 24-bit to 16-bit means either dithering or truncating your files. This section explains how these processes differ, and gives you pointers on which one to use so your music sounds as good as possible.

*Dithering*

*Dithering* is the process of adding random noise to your music when 8 bits get cut from your pristine 24-bit files. This random noise helps keep the quiet sections of your song (fades-outs, for instance) from sounding grainy
when those 8 bits are removed. There are several types of dithering — and each produces a slightly different result in a piece of music.

Pro Tools comes with two dithering plug-ins — Dither and POWr Dither — and each plug-in has different noise-shaping options (noise-shaping uses filters to move the random noise to inaudible frequencies). I’m confident that you’ll find at least one of them works well for your music. Figure 2-1 shows these plug-ins.

To dither your songs, simply insert one of the two dithering plug-ins into one of the inserts in your master fader, and then follow the steps (detailed in Book 6, Chapter 7) for mixing your music. The dithering happens automatically as your song is mixed (or, in this case, mastered).

**Truncation**

*Truncation* involves simply cutting off the last 8 bits of information. This option works well for material that doesn’t have quiet sections (for example, hard rock with punchy endings that don’t fade out).

To master your music using truncation, follow the steps in Book 6, Chapter 7 for mixing your song and choose 16-bit as your Bounce to Disk resolution — or use one of the digital outputs to send your signal out of Pro Tools. Either technique cuts off the last 8 bits without otherwise processing the signal (which makes this process different from dithering).

To dither or not to dither (and which dithering option to use)? That is the question. No universal answer exists. The only way to know which sounds better on your music is to try each of them. For the most part, songs with quiet passages and fade-outs often sound better if you dither ’em.
Mastering to 16 bits

When you master — regardless of whether you’re using the dithering approach — make sure you select the 16-bit option under the Resolution pop-up menu (located in the Bounce dialog box, as shown in Figure 2-2). If you have a dithering plug-in inserted into your master fader, your music is dithered while it’s being bounced; if you don’t use a dithering plug-in, your music is truncated.

![Figure 2-2: Select 16 in the Resolution pop-up menu to bounce to 16 bits.](image)

Settling on a sample rate

If you recorded at any sample rate other than 44.1kHz, you need to do a sample-rate conversion (SRC) process. SRC can change the sound of your song (and not for the better). Your best bet when bouncing from one sample rate to another is to set the conversion quality as high as possible. The following steps show how:

1. **Choose Setups ➤ Preferences from the main menu.**

   The Preferences dialog box appears.

2. **Click on the Edit tab of the Preferences dialog box.**

3. **Click the Conversion Quality pop-up menu in the center of the Edit tab, as shown in Figure 2-3, and choose TweakHead if you want the highest quality possible.**

   It takes a while to process (go get a cup of coffee or read your favorite gear magazine while you wait) but I think it’s worth it.
You have several options for sample-rate conversion quality. Don’t take my anal-retentive word for which works best for your music. Do some experimenting on your own. One of the lower-quality conversion settings may work just fine (and you won’t have to wait so long while your song is being processed).

When you actually bounce your song to disk, you need to choose 44.1kHz from the Sample Rate pop-up menu located in the center of the Bounce dialog box, as shown in Figure 2-4.
Sequencing Your Songs

Sequencing your songs consists of choosing the order of the songs on the CD as well as the amount of silence between songs. Chances are, when you wrote and recorded your songs, you had an idea about the order in which you wanted them to appear on your final CD. If you don’t know how you want to arrange your songs, here are some things to consider:

✦ Consider each song’s tempo in the sequencing equation. Some CDs work well if songs with a similar tempo are grouped together, while others work best when contrasting songs follow one another.

✦ Think about a song’s lyrics and how they relate to the lyrics from the other songs on your CD. If you want to tell your listener a story, consider how the order of the songs can best tell that story.

✦ Think about the chords that you used in each song and how they relate to another song you might want to place before or after it in the sequence. The ending chord of one song might conflict with the beginning chord of another — or lead right in.

For most of us, sequencing has more to do with the actual process of placing each song in its proper place on the CD than with trying to decide where that proper place may actually be. I cover that process in detail in this section.

Most of the sequencing process involves deciding how much time to place between the songs on your CD. No set amount of time has to be placed between songs. Choose what seems right for the two songs you’re working with. Sometimes you may want just a second or two; other times four or five seconds is more appropriate. For example, if you have a mellow ballad followed by an upbeat song, you may want to leave a little more time between these two songs so the listener is prepared for the faster song (try leaving a space that lasts about four to six beats at the slower song’s tempo, for instance). On the other hand, if you want two tunes to flow together, you can leave less time in between. Use your ears and think about how you want your listener to respond when the music moves from one song to another.

You don’t sequence your songs in Pro Tools; instead, this is done within the CD-burning program you use. Once you’ve bounced your mastered tracks in Pro Tools to 16-bit files with a 44.1 kHz sampling rate, you can then import them into your CD-burning software and arrange them the way you want them. This includes both arranging the order of the songs and setting the amount of silence between songs. Check out your CD-burning program for specifics on how it handles these operations.
“Mary Jo, come here quick! Look at this special effect I learned with the new Pro Tools.”
Contents at a Glance

Chapter 1: Putting Your Music on CD
Chapter 2: Getting Your Music on the Internet
Chapter 1: Putting Your Music on CD

In This Chapter

- Understanding CD burning
- Finding the right CD-Rs
- Burning your first CD
- Preparing your CDs for duplication
- Finding a CD duplicator

One of the coolest things about audio recording nowadays is that you can create music in your home and put it on the same medium that the biggest record companies use. When I started as a recording engineer, the best you could do was put your music on cassette for other people to listen to. Pressing vinyl was expensive. But now anyone with a computer, a CD burner, and a few inexpensive CD-Rs can put his or her music on the same format as all the best albums in the record store. You gotta love it!

In this chapter, you explore how to make CDs of your music. You discover the best CD-Rs to buy, and you get a chance to burn a CD. You also find out how to submit your mastered CD to a company that can mass-produce your music and make it ready to sell. All that’s left are some ideas for promoting your packaged product, which you can find in this chapter as well.

Getting into CD Burning

Since you’re recording in your computer with Pro Tools, chances are you have a computer with a CD-R or CR-RW drive. If so, then you also have software that you can use to burn your CDs. Most CD-burning software works fine for putting your mastered music onto CDs. If you don’t already have a burner and want to add one to your existing computer, check the system requirements for the burner that interests you to make sure that your system is capable of using it. For audio CDs, you can use just about any CD burner on the market (as long as it’s compatible with your system, of course).
Regardless of the CD burner you get, make sure that it can create a Red Book CD. I know that this sounds mysterious, but all the Red Book term means is that the CD is an audio CD, not a CD-ROM. Red Book is a standard for the data used to create an audio CD; a Red Book–capable burner follows that standard. This ensures that your CD can play on all audio CD players. Your CD burner clearly states whether it can burn audio, or Red Book, CDs.

**Purchasing CD-Rs**

A staggering variety of CD-Rs is available. You have green, blue, gold, even black CDs, and you have data and music CDs. So which ones are best? Well, that depends.

Unless you have a consumer CD recorder from a few years ago, you can record your CD onto any data CD-R. You can find these discs just about anywhere, and they can cost as little as five to ten cents apiece if you buy in quantity. If you have an older consumer CD recorder, you have to use music CD-Rs. These CD-Rs have a code in them that allows older consumer recorders to actually record. These CD-Rs cost a lot more, not because they capture music any better, but because a royalty — which is about a dollar and goes to the recording industry — is figured into the price of the CD (don’t get me started).

So, if you have a recent CD-R recorder connected to your computer, or if you have a professional-grade CD burner (such as the Alesis Masterlink), you can get by just fine using run-of-the-mill data CD-Rs.

As far as which of the countless CD-R brands to use, well, they’re all pretty much the same — as long as you go with a major manufacturer. Personally, I always go with Taiyo Yuden if I can find them. (Do a search on the Internet for some places that sell these.) Keep in mind, though, that some CD-Rs work better on some recorders, and the only way to find out is to try them and see. When you find a brand that works, try to stick with it.

Look for CD-Rs with a tough top surface. It’s the scratches in the top of the disc that cause it not to play over time, not the scratches on the bottom.

**Recording Your Music to CD-R**

Burning a CD is easy. All you generally have to do is open your CD-burning software and follow the prompts. A few things, however, can be helpful to know in order to get the best sound and to create a CD that you can duplicate.
Dealing with diversity: Using different CD recorders

If you’re using a CD burner in your computer, burning a CD is as simple as opening your software and following the program’s directions for making a CD. If you use a standalone CD recorder (burner), you have to connect it to your Digidesign interface (using a digital connection) and record to your CD recorder. These options are presented in this section.

If you have a newer CD burner (say, a 2000 or later model), it can probably burn at pretty fast rates (8x, 16x, or more). Well, that’s cool, but you’re actually better off burning your master CD at a slower speed. In fact, tests have shown that 2x burning produces the fewest errors. Even though this test was performed a few years ago, I still burn at 2x just to be safe. If you’re intent on burning at a higher rate, always double-check the CD by playing it in a regular CD player (a boom box or the one in your car, for instance).

Computer-based systems

If you have a CD burner program (such as Toast, Jam, or CD Creator), burning your CD is easy. One advantage of using one of these programs to burn a CD is that you have quite a bit of flexibility to organize your songs and place space between them.

In general, all you have to do is click the Add Track button on the main screen and select the track you want to add. You’re also prompted to choose any silence that you want to place before the track, as well as PQ-subcode information. (A PQ subcode is “housekeeping” information added to the CD data; it includes instructions for start and stop times for each track.)

When you have all your tracks assembled, you can go ahead and burn your CD. Pretty simple, huh?

Standalone CD burners

A variety of standalone CD burners are available — and they all work differently. Some record the CD the same way a cassette player records tapes — you connect the digital input of the CD recorder to the digital output of your Digidesign interface and press Record on the CD recorder while clicking Play in Pro Tools. The CD is then recorded in real time. Other standalone CD burners, such as the Alesis Masterlink (the CD-burning standard for many pro studios), work more like computer software programs than cassette recorders.

With the Masterlink, you first record the music from Pro Tools to the Masterlink’s hard drive (using the same procedures just listed). From there, you can edit, sequence, and even dynamically process each song before you burn all the songs to a CD-R. When you’re happy with the order of the songs and the spacing between them, you can then burn your CD.
If you want to do any dynamic processing to your music in the Masterlink, be sure to send your files to the machine undithered and at 24-bit. You can dither in the Masterlink after you make your changes. This improves the sound of your final CD. If all you’re doing is sequencing your songs, then you can send the files dithered if you want. (For more on dithering, see Book 7, Chapter 2.)

**Burning for mass production**

If you intend to send your CD-R to a duplication or replication company to have it mass-produced, you have a few ducks to get in a row first. Here are a few things to keep in mind:

✦ **Check for physical defects to the CD-R before you try to burn to it.** Scratches, fingerprints, smudges, and other imperfections on the mirror side (bottom) of the CD-R can cause errors in the data when burning the CD-R. Be sure to use a clean and unblemished CD-R for burning your master. After all, CD-Rs are cheap.

✦ **Always write your master CD by using Disc at Once mode.** This allows the CD to be read as a Red Book audio CD. Your other option when recording a CD is Track at Once — which burns one song (track) at a time. Unfortunately, Track at Once produces more errors than Disc at Once, which burns the entire CD at one time. Because of the errors present on CDs burned using Track at Once, a mass producer’s equipment can’t read — and therefore summarily rejects — CDs that people produce using this method. (In fact, many older CD players for homes and cars can’t read these CDs either.) So be sure that you use Disc at Once whenever you make a CD of your mastered music.

✦ **If you can, use an error-detection software program to check for errors in your recorded CD.** If you don’t have access to an error-detection program, check the back of the CD for any blemishes (just like you did before recording onto it).

✦ **Listen carefully to your entire CD after it’s been recorded.** Compare it with your original file and make sure that the CD is perfect. Also, spend time reevaluating the order of the songs. Make sure that they flow well together.

✦ **Use a felt-tip marker approved for writing on CD-Rs when you label your finished CD master.** If the marker isn’t specifically labeled as approved, the ink may leak through the top surface of the disc over time, disrupting the data. Also, don’t use a ballpoint pen or an adhesive label (paper or plastic) to identify your master. A ballpoint pen can damage the surface of the CD. Adhesive labels can slow the rotation speed of the CD (causing errors in the duplication or replication process), and they’ve been known to come off inside a duplication machine, clogging up the works.
✦ Label the CD master with the name of your album and all your contact info. Again, remember to use a CD-R-approved felt-tip marker, and write only on the top surface of the disc (but you knew that). Your contact information should include your name (or your band’s name), your phone number, and the date the master was made.

✦ Make three CD-Rs of your mastered music. Keep one safe in your studio and send two to the duplication or replication company. Call it good insurance: If one of the two CDs that you send off for mass production has an error, you don’t waste any time sending the company a replacement.

✦ Prepare a PQ subcode log. PQ subcodes are additional information written on the CD that provides time-code information, such as track numbers and the start and stop times of the tracks. If your CD burner software doesn’t support PQ subcodes, make a list of the start and stop time of each track (referenced from the start of the CD) on a separate piece of paper — as well as the track number and length of each track — and send that info along with your CD masters. If your software program can generate a PQ subcode log, print it — and remember to send it with your CD master.

If you’re burning a CD for a major record label, first of all, congratulations! Secondly, make sure you supply ISRC codes with your CD. ISRC stands for International Standard Recording Code, and it contains information about the CD, such as the owner of the song, the country of origin, year of release, and serial number. You enter ISRC codes into a dialog box on most CD-burning programs, and the information is placed within the PQ subcodes.

Before you put your music out into the world, get it copyrighted. Getting a copyright on your music is easy and relatively inexpensive so there’s no reason not to do it. All you have to do is fill out an SR (sound recording) form and send it into the U.S. Copyright Office at the Library of Congress. You can find the form at www.loc.gov/copyright/forms, or you can call the Copyright Office at 202-707-9100 to have it mailed to you. Choose (or ask for) the Form SR with Instructions. The current cost for filing the form is $30, but double-check this fee before you send it in, because it’s been known to go up (hey, it’s the government). You can fill out one form for each CD so the cost per song isn’t very high.

The form is pretty easy to fill out, but if you run into difficulty, you can call an information specialist to help you out. The number is 202-707-3000. Be prepared to wait on hold for a little while (hey, it’s the government).

Send your completed form, the fee, and a copy of your CD to the address listed on the form. You’ll receive a certificate in the mail, but you can consider your music copyrighted as soon as you mail it in (as long as you sent it
to the correct address). If you’re especially protective of your music (paranoid? or is that paranoid enough?), you can wait until your check clears your bank. At this point, you can be almost certain that your form is being processed. If you can’t sleep at night unless your music is copyrighted, you’re best off waiting until your certificate arrives in the mail before you start selling or distributing your CD. (This is a good reason to file for your copyright early.)

**Making Multiple Copies**

When you have a CD that you want to copy, you can either make the copies yourself or hire someone to copy them for you. If you do them yourself, you have to burn CDs one at a time just like the first one. This can cost little but takes a lot of time (as you undoubtedly found out when you burned your first CD).

**Doing it yourself**

Well, you’ve done everything else yourself, so why not add the copying process to the list? If you have more time than money and only need a few CDs, making them yourself might be a good option.

To make saleable CDs yourself, you’re going to need not only the CD burner, but also a graphics design software program and a printer to print CD labels and cover material (CD sleeve and tray card). Even with this equipment, your package won’t look as professional as the package that a CD duplication or replication company can create, but what you create is probably good enough for you to sell a few copies to friends, acquaintances, and maybe open-mic-night audiences.

**A work of art**

Your cover artwork is an important part of your CD. Take the time to create a visually appealing CD cover and tray card. This is especially true if you intend to sell your CD through record stores or other retailers. Your package needs to look professional because it’s going to be competing with the big boys (and girls) who have huge art budgets for their CDs.

If you can’t create a professional package yourself (no shame there — not everybody can), hire someone to do it. Most CD replicators I discuss in this chapter provide design services. Sometimes these services are even included in the CD package price. I recommend that you take advantage of these services — sometimes you get best results by letting the pros do what they do.
Having someone else do it

Depending on how many copies you want, you can either have them duplicated or replicated. Either process can provide you with a professional-quality product that you can sell alongside major releases. Your choice between duplication and replication depends on how many copies you plan to have made.

Duplication

Duplication involves making copies of your master CD-R the same way you made the CD-R in the first place. The only difference is that duplication companies use CD burners that enable them to make more than one copy at a time. Duplication is great if you want to make a small number of copies — anywhere from 50 to 300. CD-duplication companies often provide one-color printing on the CD and either a vinyl sleeve or jewel cases to hold the CD. Some companies can prepare retail-ready packages, which look like other commercial CDs and include the actual discs (with printing on them), jewel cases with color-printed inserts, bar codes (see the “UPC bar codes” sidebar in this chapter), and shrink-wrap. You can expect to pay around $3 to $5 for each CD, depending on the quantity you order.

An advantage to having your CDs duplicated is that your CDs usually can be done quickly. Many duplication companies can provide you with a finished product in as little as a few days (although an average of seven days seems more common). The disadvantage is that you usually pay considerably more for each CD than you would if you did it yourself or went the replication route.

To have your CDs duplicated, you need to provide a CD-R master — that is, a CD-R recorded as a Red Book–compliant audio CD. If you want the duplication company to create retail-ready packages, you also have to provide artwork laid out to the company’s specifications (get ’em beforehand).

If you’re interested in going the duplication route, here are a few resources to get you started. You can also do a search on the Internet for more places by using the search term CD duplication.

✦ Master Mind CD Duplication, 26 Route 13, Brookline, NH 03030; phone 877-213-4512; Web site www.mastermindcdduplication.com.

✦ CDWorks, 1266 Soldiers Field Road, Boston, MA 02135-1003; phone 800-CDWORKS; Web site www.cdworks.com.

✦ The CD Marksman, 2105 S. McClintock Drive, Tempe, AZ 85282; phone 877-890-5470; Web site www.cdmarksman.com.
Most of the companies that I list in the following section also provide duplication services for smaller quantities.

**Replication**

*Replication* is the process used for making commercial CDs — lots and lots of them. Instead of making copies directly from your master CD-R, this process involves burning a *glass master* — the master disc from which all your CD copies will be made — from your master disc. The glass master is then used to transfer the data onto CD media. Replication is designed for larger runs — 500 or more copies. Quantities of fewer than 300 aren’t cost-effective because the glass master often costs between $100 and $200 to make — and the film needed for the printing of the CD and sleeve and tray card can cost several hundred more.

CD replication usually comes with printing on the CD in one to four colors, and a tray card and sleeve often printed in four colors. Most CD-replication companies have retail-ready CD package deals that cover everything from layout of your artwork (some do, some don’t, so be sure to ask first), printed CDs, jewel boxes, bar codes (see the “UPC bar codes” sidebar in this chapter), and shrink wrap. You can expect to pay between $1,000 and $1,500 for 500 to 1,000 retail-ready copies from most manufacturers.

If you’re interested in going the replication route, you need to provide the replication company with a master audio CD, artwork set to its specifications, and a completed order form. Oh, and you’ll probably have to pay half the money for the job up front before they start work on your project (bummer).

---

**UPC bar codes**

If you make a CD that you intend to sell through major retailers, such as record stores or Internet retailers, you need a UPC bar code. A UPC bar code is a string of numbers that identify your product. Every CD has its own unique bar code. You can go about getting a bar code in one of two ways: You can register and pay $750 with the Universal Code Council (UCC) or you can pay anywhere from nothing to $50 to get one from a CD replicator or distributor. Unless you intend to release more than 35 CDs, your best bet is to buy a bar code from a replicator or distributor, who can provide bar codes for a small (or no) fee with your CD order. Here are additional places where you can get a UPC bar code:

- **Discmakers**: www.discmakers.com/music
- **Oasis CD Duplication**: www.oasiscd.com
- **CD Baby**: www.cdbaby.com
- **Ampcast**: www.ampcast.com

---
After people at the manufacturing company receive your order form, the CD, and the artwork, they make a reference CD (which shows you what the finished product will sound like) and proofs of your finished printed material. Be sure to look over the art proofs carefully — and listen to every second of the reference CD. Any mistakes you don’t catch are your problem, so take your time and compare the reference CD very closely with the master recording (you did make a copy of your master CD before you sent it out, right?). The master and the reference should be exactly the same.

Having your CD replicated is a stressful thing. You’re spending a ton of money and getting quite a few copies; you’ll need to be proud enough of them to go out in the world and sell them. So choosing a CD-replication company to work with is an important task. Quite a few companies are out there, so you should choose the place that makes you feel the most comfortable and makes a high-quality product. Following is a list of the larger CD-replication companies. For more possibilities, do a search on your favorite search engine for the term CD replication or CD duplication.


✦ **Disc Masters**, 2460 W. Main St., Suite D300, Saint Charles, IL 60175; phone 888-430-disc; Web site [www.discmasters.com](http://www.discmasters.com).

✦ **Oasis CD Duplication**, 12625 Lee Hwy. (PO Box 214), Sperryville, VA 22740; phone 888-296-2747; Web site [www.oasiscd.com](http://www.oasiscd.com).


✦ **DiscMakers**, phone 800-468-9353; Web site [www.discmakers.com/music](http://www.discmakers.com/music). This company has five locations in the United States.

Many CD-replication companies can provide you with great resources, information, and even opportunities for promoting your work. Take advantage of these opportunities if you can, but don’t choose a company based on its promotional promises. Choose a company because of its customer service, price, and the quality of its product.

Be sure to ask for referrals (or at least a list of satisfied clients) before you go with a duplication or replication company. As always, your best bet when you’re entrusting someone with your precious music to is to ask friends for recommendations. Also, take timing estimates with a grain of salt — I’ve had a couple of occasions when a company promised to finish my CDs by a certain date and the discs didn’t show up. So, leave plenty of time between when you print your CDs and when you need them.
Promoting Your Music

Congratulations, you have a CD to sell. The hard — oops, I’m sorry, actually the easy — part is behind you. I’m sure you don’t want to be stuck with boxes of expensive coasters, so now you have to work on getting people interested in buying your music. You’ve just gone from being a musician-composer-engineer-producer to being all those plus a record company-owner-business-person (exactly how hyphenated can a person get, anyway?).

Your friends and some acquaintances will probably buy a few copies, but after you’ve sold a CD to all of them, you need to get your music to the broader world. This can be tricky. After all, you’re now competing with the big boys and, face it, you don’t have nearly the resources that they do. Traditional channels of distribution and marketing are pretty much out of the question for you (and for most of us). So, to succeed in selling your music, you need to try some alternative approaches.

I’m no marketing guru, but I have managed to create a nice niche for myself and my music. So trust me; you can do the same. All it takes is a little imagination and a lot of hard work. In the following list, I present a few ideas that have worked for me and other enterprising, independent artists.

♦ Take yourself seriously. No, don’t go buy a limo. At least not yet. What I mean here is take the job of promoting and selling your music seriously — treat it as a business. Getting people to notice and buy your music is a lot of work, but it doesn’t have to be a drag. (If it is, you’re better off getting someone else to do it for you.)

♦ Get organized. Get your new business off on the right foot by developing a habit of keeping track of your sales and developing a contact list. One of the best investments that you can make is to get a contact-management database (Act! is a good one) to keep track of promotion contacts (newspapers, radio stations, clubs), CD sales, and fans. Also, do yourself a big favor and keep meticulous records of your income and expenses; you’ll be grateful you did that when tax time comes.

♦ Create a mailing list. This is one of the most cost-effective and powerful ways that you can start to develop a following. Make a sign-up sheet for your mailing list available at every public appearance. (Ask people to include not only their postal mail address, but their e-mail address as well.) Then enter those names into your database system. You can then either send out snail-mailings or e-mail notices whenever you play or do anything worth mentioning.
✦ **Get out and be seen.** This one is pretty straightforward. Get out in the world and let people know about your music. This can mean not only playing gigs but also talking about your music. I have a good friend who releases an album each year. He prints a thousand copies, which he sells at his gigs, and every year he sells out. (Hey, that’s an extra ten grand a year after expenses, not bad.) He also uses them as his calling card in order to get more gigs.

✦ **Look beyond the record store.** It’s nearly impossible to compete with the major labels in the record store. Unless you live in a small town or know of a record shop that has a section devoted to local bands, ready and willing to sell your CDs, you need to think of other places to put your music. For example, another friend of mine has placed his CD at quite a few of the local businesses in his neighborhood around the holidays. Everything — from the local pack-and-ship to the video store, has a counter-top display with his CD. He creates a small poster that fits on the counter, describing him and his music. He sells quite a few CDs and gets a handful more gigs each year this way.

✦ **Capitalize on your style.** Some nonrecord-store venues just happen to fit what your music is saying. For example, another one of my friends composes folksy, new-age music, and he managed to get his CDs into a handful of new-age, gift-type shops. He often puts them in the stores on consignment and checks each store once a week to refill the counter-top display and collect any money that the store took in (minus the store’s cut, of course). Going into the stores every week helps him to develop a connection with the store owners, many of whom have arranged for him to do performances in their stores, which increases his exposure and sales.

✦ **Try something different.** Years ago I teamed up with a local author and played at her book signings. (This is before I wrote any books myself.) She read a passage from her book, and then I played for a few minutes. I always ended up selling a few dozen CDs at these events.

✦ **Don’t be stingy.** Give away your CD (within reason, of course). I usually count on giving away anywhere from 10 to 15 percent of the CDs I print. These can be for reviews, as a way to get gigs, or for any purpose that may spread the word about the music. Giving out your CD as a promotional tool is an inexpensive way to let people know what you’re doing.

If you’re interested in the possibilities for using the Internet to promote and sell your music, I discuss these in Book 8, Chapter 2.

I’m sure there are dozens more ways to promote and sell your music. Think outside the box and use your imagination. **Remember**: Don’t be shy. Do whatever you can to get your music out into the world.
Chapter 2: Getting Your Music on the Internet

In This Chapter

- Understanding MP3
- Exploring streaming audio
- Formatting your music for the Internet
- Finding an MP3 host site
- Using the Internet to promote your music

To make it as a musician, you have to get the word out that you and your music exist. Traditionally, you played gigs, sold your CDs at these gigs, and tried to get your music in local stores and on local radio. If you were lucky, you’d sell a few CDs at each gig, move a handful of others through local outlets, and maybe get some radio play on a college station. Forget getting any national exposure unless you had developed a following and had a busy touring schedule.

That’s the way it used to play, but now the Internet has made it possible for any musician to get national — even international — exposure without going on the road (as much). All you have to do is get your music on the Internet and promote it well. You can then make money from your music while you sleep (or at least make your music available while you sleep).

“How do I do this?” you may ask. Well, that’s the purpose of this chapter. Here you explore the ways you can use the Internet to promote and sell your music. You discover how to put up music files so that your potential customers can either download your music or listen to it online. You find out about some of the best ways to have your music hosted online, and you take a look at promotional ideas to get you started.

Understanding MP3

I’m sure you’ve heard about MP3s. In fact I’m willing to bet that you’ve already downloaded a few MP3s off the Internet and experienced first-hand the immediacy that MP3s offer. You go to a Web site and choose a song to download. After just a short while, you have a copy on your hard drive that you can listen to anytime you want. You can even put that song on a CD or portable player and take it with you.
Understanding MP3

With all this convenience and immediacy comes a downside. That MP3 song doesn’t sound as good as one mastered to a CD. For most people, this is a small price to pay for the ability to download a song for free (well, okay, often for a buck a shot these days). After all, most people play their music on less-than-stellar stereos (Walkmans and boom boxes come to mind). But if you’re one of the lucky few with a stellar (or more-than-stellar) stereo system, you’re going to hear the difference, which may prompt the following question: Why doesn’t a song in MP3 format sound as good as one mastered to a CD? The answer: data compression.

MP3 is a process that compresses your music so it takes up less hard-disk space. Data compression is necessary or MP3s couldn’t work over the Internet. Consider the numbers: A regular CD music file can take up 30 to 40MB (about 10MB per minute). That same song can take up only 3 to 4MB in MP3 format. This is important because promoting music on the Internet is totally dependent on speed. A 30 or 40MB file is way too big to download or to stream on the Web. For example, dial-up users using a 28-Kbps modem would have to wait over four hours to download a 40MB file! I don’t know about you, but I don’t know anyone who is willing to wait that long to hear a piece of music. And if you haven’t heard it before and aren’t yet sure you like it . . . ? You get the idea.

Although compression causes your MP3 to lose fidelity as well as megabytes, I think this loss of quality is an actual advantage. After all, it’s normal that your MP3 won’t sound as good as your mastered CD in its multimeg brilliance. It doesn’t have to; you’re giving listeners just a taste of your music.

What do you mean “near-CD quality”?

You may have heard the term near-CD quality used in reference to MP3 sound. This is a marketing term, meaning: “It doesn’t sound as good as a CD, but we’ll make it sound like it’s pretty darn close and maybe the buyer won’t notice.” If you sense a note of cynicism in my writing, you’re right. Don’t delude yourself into believing that the song you start with is going to sound quite the same after MP3 conversion.

The difference between a song on a CD and a song that’s near CD quality is like the difference between playing a CD in your car and then hearing the same song on the radio. You lose some high end and the bass is thinner. You may even lose the stereo image, depending on the conversion mode you choose, and you’ll probably lose some dynamic range. Overall, the song will have a little less life to it.

This is not a huge difference for most people but is noticeable nonetheless. The good news is that most people don’t seem to care (or are at least willing to accept it) — and that the song is now slim enough to zip through the phone wire to potential customers.
By giving people this taste, along with the opportunity to purchase a CD, you help them to decide whether they want to buy the high-quality version.

**Engine**

When you convert a song on your mastered CD to an MP3, the *engine* is the encoding algorithm (technical term: number cruncher) that is used to convert your file. Not all engines make your song sound the same. Some engines give your song a much better online sound than others, and you may get a better-quality sound from an engine if you adjust the bit rate and/or the recording mode. Some MP3 encoders allow you to choose the engine you want to use (as shown in Figure 2-1); others don’t.

The standard (and arguably best) encoding engine is the Franhofer algorithm, although LAME is gaining in popularity (maybe in spite of its name). The encoding engine you choose depends on the results you get. Try a few to decide what works best for your music and your situation.

![Figure 2-1: MP3 encoders use a variety of engines to convert your music.](image)

**Bit rate**

The *bit rate* essentially determines the quality of your encoded music. When you encode your music, you have to choose what bit rate you want your file to be in, as shown in Figure 2-2. Bit rates range anywhere from 20 kbps (kilobauds per second) to 320 kbps. The higher the bit rate, the better the sound quality. The downside is that higher bit rates create larger files. When you convert your music to MP3, you’re constantly balancing quality with file size.
The bit rate that you ultimately choose depends on how you plan to use your MP3 file. For example, if you want to put your music on an MP3 host site (an Internet site that makes people’s MP3 music available for download), you most likely need to choose the 128-kbps rate because this is what many host sites require for Download or Hi-Fi mode. On the other hand, if you want to stream audio on the Web (a process that plays the track as it’s downloading), you’re better off choosing a much-lower rate (between 20 and 24 kbps). Otherwise your song will pause abruptly while it’s playing — at least for the mass of people who are still using dial-up modems.

Variable bit rate (VBR) is an option that many encoders offer. VBR allows the encoder to change the bit rate as it compresses the file. The advantage to this approach is that the sections with fewer instruments — in effect, less data — can be compressed further than sections full of more critical information. The result is often a better-sounding MP3 that takes up less space. The only drawback — and it’s a big one — is that few MP3 players can read a file created with VBR. So, you’re probably best off not using this approach for your Web-based files.

If you’re making MP3s to listen to through your own player and it supports VBR playback, then using VBR keeps your files smaller. If you do choose VBR, you’re prompted to choose an average bit rate or a minimum and maximum bit rate. Try them both and choose the one that sounds best to you.

Mode

Modes essentially refer to whether your file is in stereo or mono, only your choices include more than just plain stereo and mono. You can choose mono, stereo, joint stereo, or (sometimes) forced stereo (also known as dual mono).
as shown in Figure 2-3. Again, you choose the mode according to what your music needs to sound its best, and you balance quality against file size.

Here’s a look at the various modes and how they relate to quality and file size:

- **Mono**: Mono takes up little room because all the stereo data from your CD is contained on one track. The sound quality can be good, depending on the bit rate you choose, but you lose all stereo-imaging data. Choose the mono mode if the loss of the stereo image won’t adversely affect your song, or if the overall sound quality is more important to you than the stereo information.

- **Stereo**: The stereo mode consists of two mono tracks. With the stereo mode, you retain all your stereo information. The drawback is that your two tracks are at half the bit rate of a mono version using the same bit-rate setting — so they don’t sound as good. For example, if you encode at 128 kbps, each of your stereo tracks is actually only 64 kbps. If you want each track to be at 128 kbps, you have to encode at 256 kbps. The resulting file is twice as large as the mono file at 128 kbps, has no better sound quality, and takes longer to download.

  Even so, it’s your call. Stereo mode is a good choice if you have a song with complex stereo panning effects that you just can’t live without and you don’t mind a sound quality that’s slightly lower.

- **Joint Stereo**: This mode is a cross between mono and stereo: It creates one track of audio information and one track of information that tells the player to send certain sounds through one speaker or the other (a set of instructions called steering data). You get most of the stereo information with only a slightly larger file size than you’d get with the mono mode.
For most songs, the difference in stereo image between regular stereo and joint stereo is indistinguishable — and you end up with a higher-quality recording because the higher bit rate is used. You may find that this option works better for you than the regular stereo mode. Experiment and see whether you can hear a difference.

✦ **Force Stereo:** Also known as dual mono, this mode is essentially the same as the mono mode — one track of audio data is recorded and the stereo panning information is lost. The only difference between mono and force stereo is that force stereo makes sure that the mono data is played through both speakers of the player. Choose Force Stereo mode if you don’t mind your music being in mono but want to ensure that the player plays it through both speakers.

### Creating MP3 Files

To create MP3 files, all you need (well, besides the computer) is MP3 encoding software and a CD or audio file of your music. To create an MP3 of your music, just choose the song to convert and let the encoder do the rest. There are some variables that can make your MP3s sound their best — such as which encoder to use and what parameters to choose. I cover these variables in this section.

### Choosing encoding software

You have a lot of MP3 encoding software choices. Some software encodes from various file formats as well as from CD, whereas others don’t encode directly from a CD. Not being able to encode directly from CD isn’t necessarily a bad thing, however, because the process of lifting music off a CD (also known as CD ripping) can cause audible artifacts (noise, clicks, and pops, and so on). If you encode from a WAV or AIFF file, you can first make sure that the sound going into the encoding process is as good as possible.

A couple of popular MP3 programs that both encode and rip are

✦ **Musicmatch Jukebox** ([www.musicmatch.com](http://www.musicmatch.com)): You can download the basic version for free, which allows you to play, rip, burn, and convert MP3s and audio CDs.

✦ **N2MP3** ([www.proteron.com](http://www.proteron.com)): This is a Mac-only program, but Proteron has a Windows version called EasyMP3. You can download trial versions of these programs for free. The trial versions allow you to encode only 20 MP3s at full length (a maximum of one minute after that), and they put a voice clip at the beginning that says, “Encoded by N2MP3” that
you can’t get rid of (of course, if you buy the program these limitations disappear).

There are a lot of other MP3 encoders out there, so if you’re looking for a little more variety, you can check out these sites:

✦ www.cnet.shareware.com: This site contains shareware of all sorts, from games to word-processing software to MP3 encoders. From the main page just type MP3 into the keyword search function and choose the computer platform that you use (Mac or PC). You’re sure to find a bunch of matches for your search.

✦ www.mp3software.com.ar: This site claims to have the most complete list of MP3-related software products available for download. You can find freeware and shareware versions in this site.

✦ www.mp3-mac.com/Pages/Encoders.html: This site contains tons of software programs (some free, some not) for Macintosh computer users. You may find one or more programs that meet your needs.

**Encoding your music**

You can use any number of different software programs to encode your music, but since you already have Pro Tools — and you can get an MP3 option for it — you may as well use that to encode your music. The Pro Tools MP3 encoding option comes with your Pro Tools software as a demo (you get 30 days to try it out), but you’ll need to pay $20 if you want to keep using it after the demo period is over. Purchasing the MP3 encoding option involves the following steps:

1. **Log onto the Internet and go to** store.digidesign.com/.
   
   The Avid/DigiStore page will take a moment to load.

2. **From the options listed on the left side of the page, select MP3 Option under the Software heading.**

   The MP3 page will load.

   After the MP3 page loads, you’ll find four MP3 types. The two versions entitled MP3 Export are for Pro Tools version 5.0.1 and the two versions called MP3 Option are for Pro Tools versions 5.1 and higher.

3. **Click the Buy Now button for the option that matches your computer system and your software version.**

   The shopping cart page appears.
4. Click Checkout and follow the prompts to buy the software.

After you finish paying for your software, you’ll receive an authorization code that you can enter when you get the “This Trial has Expired” alert when you try to encode an MP3 using the Bounce To Disk function (see next section).

When this alert appears, click Authorize and enter the code when prompted.

The actual encoding process is pretty simple. To encode using the MP3 option, follow these steps:

1. Select File ➪ Bounce To Disk.
   The Bounce dialog box makes an appearance.
2. From the File Type drop-down menu, choose the MPEG-1 layer 3 option.
3. Using the other drop-down menus, enter the format, bounce source, sample rate, and whether you want to convert during or after the bounce.
4. Click Bounce.
   The MP3 window appears, as shown in Figure 2-4.
5. Choose your encoding speed.
6. Click the Constant Bit Rate (CBR) box and choose the quality of the MP3 from the pop-up menu.
   For streaming audio, choose between 20 and 32 kbps; for higher-quality downloads, choose between 96 and 128 kbps.
7. Enter the ID3 Tag Info in the dialog box.
   This includes the name of the song, the artist’s name, the album title, any comments you want to add, and the genre of your music.
8. Click OK.
   The Save Bounce As dialog box opens.
9. Enter the Name for your MP3 file in the Save As field.
10. Select the location for your new MP3 file using the Where drop-down menu.
11. Click Save.
   Your file is bounced (this will take a few minutes) and the MP3 shows up in the location you specified in Step 10. You can take that file and use it in your marketing efforts.
Chapter 2

Getting Your Music on the Internet

Hosting Your Music

When you have your music in MP3 format, it’s time to get it out into the world. This involves either putting it on your own Web site or someone else’s. This section explores the pros and cons of — as well as the process involved in — both of these options. Chances are you’ll end up choosing a combination approach if you’re serious about selling your music online.

Choosing a host site

An Internet host site is a Web site that allows you to add your music to its list of available music downloads. Putting your MP3s on a host site can give you exposure that you wouldn’t otherwise be able to get. Not only can you direct people to the site to listen to your music, you can also benefit from the traffic that the site itself, other musicians, and the site’s fans generate. For some of the larger sites, that traffic can add up to a lot of potential listeners. Although MP3 host sites are constantly changing, a few have managed to hang around for a while.

Internet music host sites are always coming and going. To find out what sites are currently available and what they offer check out compo10.com/Music Hosts.htm. This site has a comprehensive list that’s updated regularly.

Be sure to read and understand the contracts (often called agreements) that each of these sites requires you agree to. Make sure that you don’t sign away your rights to your music. If you’re not sure you like a particular agreement, don’t sign up for the service. You can find plenty of other places to put your music on the Internet.
Ampcast
www.ampcast.com/artists/signup.php

Ampcast has been around since 1998 and is, as its Web site duly states, “dedicated to introducing and exposing new musicians and bands as well as providing a forum for the promotion of more established musical artists.” To join Ampcast, you pay a $95 per year fee. For this, you can put your music and pictures on its site and get up to 50 cents for each MP3 that is sold of your music.

Ampcast also has a “one-off” CD program where it creates a CD of your music for you and makes the CD available on its site. You can have them create the CD from your uploaded music or you can send them a Red Book–compatible CD (Book 8, Chapter 1) from which to burn the CD. The amount you get from each CD sale depends on the price you set, but it can range from $1 to $3 or more. The good thing is that you don’t have to have a CD to sell one on this site — Ampcast creates it for you.

Iuma
www.iuma.com/ArtistsOnly/

Iuma is the oldest MP3 host site, having been around since 1993. Iuma’s blurb on its Web site states that it is “the one place to post your music where actual musicians are watching out for you — not weasels watching the numbers. You have your own URL with your band name first. And a custom Web page where you can post all your band info and MP3s, sell CDs, create message boards, fan lists, and of course, get e-mail from your fans — all Free.”

You don’t get paid for downloads on Iuma, but the fact that it doesn’t cost you anything to join easily offsets that disadvantage. (Most bands don’t earn their fees back from downloads anyway.) Iuma doesn’t actually sell CDs on its site, but it enables you to put links from its site to the site(s) where you sell your CDs.

Vitaminic.com
www.vitaminic.com

Vitaminic is a European company that operates ten different sites. The address listed here takes you to the English language site, where you can join for free and get exposure through all the sites. Vitaminic claims to have 10 million hits per month from 2 million unique users. Vitaminic doesn’t pay you for downloads, but it does offer to sell your music from its site. Vitaminic creates CDs on demand and pays you half the proceeds from your sales.
Setting up your own site

Even if you put your music on an MP3 site, you should consider creating your own Web site as well. With your own site, you can provide a lot more information for visitors to read. You can also offer more products that might make you more money than your CDs — T-shirts, for instance.

Having your own Web site is not without problems. For example, you have to design and maintain the site, which can take a lot of time. You also have to pay for things like hosting (granted, you can find places to host your site for free — but remember that those are often thick with advertising for other stuff). If you intend to sell products on your site, you need to provide online ordering, which often involves setting up a merchant account with a credit card company. In all, having a Web site can be time-consuming and expensive, so be prepared to do a fair amount of work if you really plan to make money from your Web site.

If maintaining a full e-commerce Web site sounds like too much for you, you can still make money from the Internet using your Web site to promote your band, especially if you get creative. In fact, with just a few simple steps, you can have a Web site without the expense or the hassle (well, at least less hassle), and still provide your visitors with a great Web experience. Here are a few suggestions:

✦ Create links from your site to your MP3 host site. This keeps you from having to put MP3s or streaming audio on your Web site and your visitors can still hear your music.

✦ Get your CD on Amazon.com or CD Baby and link your visitors to those sites to buy your CD. You don’t get as much money in your pocket, but these other sites take care of all the ordering hassle for you. (You find out how to sell your music through CD Baby and Amazon.com in the “Selling Your CDs” section later in this chapter.)

Designing your site

Your first step in getting a Web site up and going is to design it. When you design your Web site keep the following things in mind:

✦ **Make your site easy to navigate.** Make sure that your visitors know where they are in your site at all times. It’s often a good idea to have a menu bar on each page so they can at least get back to the home page without having to search for it.

✦ **Make sure your site loads quickly.** Most people still use dial-up modems (often as slow as 28 Kbps) — and sites with a ton of big graphics or streaming videos take forever to download. Most people don’t have the patience to wait. Think lean and mean. Your visitors will appreciate it more than a fancy, slow-to-load page.
✦ **Make ordering your CD (or other stuff) easy.** Put a Buy My CD icon on every page.

✦ **Double-check all your links.** Nothing is worse to a Web surfer than a bunch of links that lead nowhere. If you have links on your site, double-check each one to be sure it works. And if you have links to other people’s sites, check the links occasionally to make sure that the page you’re linking to still exists.

✦ **Test your site.** Before you sign off on your site design, check it from a slow modem. You instantly get a sense of whether your site is dial-up-friendly. If it’s slow to load or confusing, keep working on it until it works. You may also want to check your site using different Internet browsers and screen resolutions to make sure your site still looks good.

✦ **Make your site your home page in your browser.** I had a site down for weeks because I didn’t have it set as my default site in my browser. I never got a chance to get there until I got a call from a friend who told me it was down.

For more tips and tricks on creating a great Web site, check out the *Creating Web Pages All-in-One Desk Reference For Dummies*, also published by Wiley.

**Putting up your site**

After you design your site, you need to find an ISP (*Internet Service Provider*) to host it. Most ISPs allow you to put up a personal Web page for free, but if you want to do any business from it, you generally need to pay to have your site hosted. The exception is Geocities (geocities.yahoo.com/home), which lets you put up a site for free. Geocities also has an inexpensive domain hosting option ($8.95 per month) where you can have your name as your URL (www.jeffstrong.com, for instance).

This leads me to the whole *domain-name* thing. That is, a Web address that has you or your band’s name as your address. If you want your own domain name, you need to register it and pay a fee. It used to be that all domain names were purchased through Internic (now Network Solutions), but now you can get a domain name in a lot of places.

To find a place to buy and register your domain name, search for *domain registration* on your favorite search engine. You’ll end up with a ton of matches to get you started.

After you choose an ISP and register a domain name — if you choose to go that route — then it’s just a matter of putting your site up and making sure it works. Your ISP may either give you detailed instructions on how to do this or do it for you.
Getting noticed

If you set up your own Web site, submit it to as many search engines as you can. Otherwise people may not be able to find you. You can do this vital step in one of three ways:

✦ Submit your Web site information to each search engine site by hand. This means going to each site (Yahoo!, for example) and filling out the submission form you find there.

✦ Hire a submission service to do this for you. These services enter your Web-site information on hundreds (sometimes thousands) of search sites for you. These businesses charge a fee that ranges from about $40 to $150, depending on the services and what other benefits they offer — which can include one-time submission or repeated submission (sometimes as often as every 48 hours).

✦ Buy software to automatically submit your Web site information for you. The software can cost more than the submission service does, but you can submit your information more than once and be sure that your submission goes through. Some software even tracks your ranking on the various search engines.

The major search engines used to include any site for free. All you had to do was complete a submission form describing your Web site and you were set. This has changed dramatically over the last year or two. Now the larger search engines (such as Yahoo) charge a fee if you’re a commercial site — that is, if you intend to sell anything. These fees can be quite high ($299 on Yahoo!, for instance).

If your site isn’t a commercial site, you can still list for free — but completing the submission form may not get you into a search engine’s system. You may have to submit more than once. Also keep in mind that it can take a month or more for your site to show up after you’ve placed your submission.

Providing Your Music Online

If you have a Web site, you probably want your visitors to be able to hear your music. You can make your music available for listening online in two ways — by download or by streaming audio:

✦ **Music downloads** are files that your visitors can download to their hard drives and listen to anytime that they want.

✦ **Streaming audio** is a file that your visitor connects to that plays without being copied to your visitor’s hard drive.

Each of these options has its advantages, which I outline in the following sections.
Offering downloads

Online promotion of your music almost requires you to make downloads available to your potential fans. You can talk about your music all you want, but what people want is to hear it. The purpose of the download is to get your listener to buy your CD or to come see your show.

Put only a few of your best songs on your site (or on any site, for that matter). If you make your entire CD available, visitors have no incentive to buy it.

Streaming audio

Streaming audio is basically an MP3 file that plays without being downloaded. The advantage is that it greatly reduces the amount of time your listener has to wait to hear your music. The downside is that the quality of the audio is lower.

You always want to make the process of navigating your site and listening to your music as fast as possible. This provides a much better experience than having to wait. The less time a person has to wait, the more likely he or she is to return. The more repeat visitors that you get, the better chance you have for selling CDs.

You can create streaming audio in two ways: You can use a RealAudio file (a file format developed by Real Networks) or an MP3 file. The process is the same, except your file names are going to be different. (Note that you need an encoder that can create a RealAudio file if you want to go that route.)

The following steps walk you through the process of getting your MP3 file to stream on your site:

1. Create an MP3 file, using a bit rate between 20 kbps and 32 kbps.
   This is a good range for streaming audio over dial-up modems.

2. Save the MP3 file so that you can identify it.
   The easiest way to do this is to save your file as songname24.mp3 (the 24 stands for 24 kbps).

3. Create a pointer file and name it songname24.m3u.
   A pointer file is a file that directs your visitor’s audio player to the song so that it plays without waiting for the entire song to download. This file contains directions to your MP3 file. For example, your file would contain the following text:

   http://www.YourWebSiteAddress/songname24.mp3
Keep in mind that any visitor who doesn’t have an audio player can’t listen to your music. It’s a good idea to put a link on your site to another site where your listener can download an audio player.

4. **Create a hyperlink in your Web page to the `songname24.m3u` file.**

   For example, you can put it in some text saying something like this:
   `check out our new song, songname` and link the text to the file.
   Or you can place the hyperlink in a picture or graphic (or both).

5. **Upload your MP3 file, your pointer file, and the new page with your hyperlink to your Web site.**

6. **Go to your Web site and see whether it works.**

Make sure that your site-hosting service has its MIME types configured for MP3. Otherwise, your audio files won’t work. (Don’t worry. The people who work for your hosting service will know what you’re talking about when you mention MIME types. That’s their job.)

If all this sounds like too much work, you can just create a link to the streaming files on your MP3 host site. That way people can still hear your music, even if it isn’t available on your site.

### Selling Your CDs

Whether or not you have your own site, you can always sell your CDs on the Internet through other outlets. One advantage to selling your music through other online stores is that you can capitalize on the traffic that those stores generate. A number of online retailers are out there, but the following list sums up some of the major players:

- **CD Baby** ([www.cdbaby.com](http://www.cdbaby.com)): CD Baby is an online record store that specializes in independent artists. It puts your CD on its site for a very small set-up fee ($35). For this, you get a Web page (which the people at CD Baby design) with pictures, bios, MP3s, and streaming audio. The site sells your CD for whatever price you set, takes $4 from the sale, and gives you the rest. You even receive an e-mail whenever someone buys one of your CDs. Sign-up is easy; just direct your browser to [www.cdbaby.com](http://www.cdbaby.com) and click the Sell Your CD icon. The instructions are clear, and a lot of helpful articles on the site can help you to, well, sell your CD.

- **Garageband.com** ([www.garageband.com/musicians](http://www.garageband.com/musicians)): Garageband.com works in partnership with CD Baby. You just set up a membership with CD Baby and list your music on Garageband.com. This gives you more exposure without any extra expense. Garageband.com also has some great information to help you sell more of your music and get gigs.
Amazon.com (www.amazon.com): Yes, you can get your music on Amazon.com, which boasts that it’s the world’s largest online retailer. Amazon.com has an Advantage program that allows you to put your CD on its site and compete with major-label artists. All you need is a professional CD package (retail-ready) with a UPC code on it. To join, point your browser to www.amazon.com and click the Join Advantage link at the bottom of the page. Follow the directions, and you’ll have your music on the most prominent online retailer in no time.

Because the Internet is constantly changing and growing, you may find other sites that allow you to sell your music online. Use your favorite search engine to search for the term, sell your CD. This gives a ton of other places to consider selling your CD online.

Promoting Your Music

The whole point of making CDs and putting MP3s of your music on the Internet is to promote and sell your music. To do this, you need exposure. Like any promotion technique, there are no rules except to use your imagination. Experience will be your guide, but here are some ideas to get you started:

✦ Start an e-mail newsletter. An e-mail newsletter is an inexpensive way to keep your music on people’s minds. Try to be somewhat consistent in sending it out, but don’t just send out the same message on a regular basis. Give your subscribers something. Provide new information in your e-mail, such as a press release about where you’re playing next or a link to a new song that you’ve just uploaded. Note: Don’t send your newsletter to anyone who hasn’t asked to receive it. This is called spamming, and it’s not nice. To build up a subscriber list, encourage people to fill in your mailing list sign-up forms at your gigs and on your Web site. Always provide a way for them to unsubscribe from your list — and make it easy to do so.

✦ Put your Web site address on everything. People can’t come to you if they don’t know that you exist. So print your Web site address on all your promotional materials, including the CD itself. Also, include your Web site address on all e-mails and Internet correspondence that you do (as a signature on Internet forums if you belong to any, for example).

✦ Network. Check out as many independent-musician sites as you can. You not only learn a lot about marketing your music, but also have an opportunity to spread the word about your music. Check out Garageband.com (www.garageband.com), Getsigned.com (www.getsigned.com), and indiecentre.com (www.indiecentre.com), for starters.
✦ **Stay up to date.** Keep track of where you put your music and check back often to make sure everything is working properly. Web sites change and go out of business often. Unless you check the site occasionally, you may not know if your music suddenly disappears from there. Also, routinely search for new places to put your music.

✦ **Get linked.** Try to get folks to link from their sites to your own. Likewise, share the wealth and link to other sites that you like. Cross-promotion can be a good thing and allow you to pool your fan base with another band. This doesn’t take away from your sales (after all, you listen to more than one band’s CDs, right?). Visitors to your site will appreciate the link and will probably check back to see whether you’ve added any new ones.
A/D converters, digital recorders, 17–18
Absolute Grid mode, Edit mode, 329
absorber/reflectors for sound, 45, 46
acoustic guitars
  equalization, 543
  microphones, 97, 256–257
  room, 256
acoustic instruments, compression, 553
acoustics
  about, 44
  acoustical foam, 42
active monitors, 27
ADAT lightpipe, hardware interface, 128
ADAT optical, 38
Add option, audio files import to session, 200–201
adding track to group, 231
adjusting
  levels, 503–505
  mixing, 503–505
  monitoring latency, 279–280
  track height, 321–322
AES/EBU, digital connectors, 36–37
After Touch view, 453
AIFF files, 29, 198
Alesis Digital Audio Tape, 38
Alesis Masterlink, 623
algorithm, reverb, 567
aligning regions, 374–375
Amazon, 643, 648
ambient microphones, 237, 239–240
AMD processors, 116
amp-isolator box, 43
Ampcast, 628, 642
analog connectors
  about, 32
  designer cords, 33
  quarter-inch plug, 32–33
  unbalanced lines, 33
analog mixers, 52, 499–500
analog-to-digital (A/D) converters. See
  A/D converters
AOL software, 112
applications, microphone, 96–98
arrangement, mixing, 505
The Art of Digital Audio (Watkinson), 17
artifacts, 638
artwork on CDs, 626
Assign switches, 61
assigning
  inputs and outputs, tracks, 222
  region-name and time-location displays, 322–324
  voices, 234
attack compressors, 247
audio drive, Mac, 111–112
audio editing
  about, 317
  Edit modes, 327–331
  nondestructive editing, 318
  during playback, 318
  region types, 318–319
  viewing regions, 320–327
Audio Engineering Society/European Broadcast Union, 36
audio files
  about, 159–161
  sessions, 153
audio files import
  Add option, 200–201
Audio Regions list, 199
Convert option, 201–202
Copy option, 201
File menu, 199
  file types, 198–199
Audio Interchange File Format files, 198
Audio Media Options, Import Session Data dialog box, 205
audio recording
  about, 289
  recording tracks, 289–295
audio regions, 317
Audio Regions list
about, 333–334
audio files import to session, 199
displaying region information, 336
Edit window, 183–184
finding regions, 335–336
pop-up menu, 334–336
selecting regions, 334
sorting regions, 335
audio tracks
about, 219
automation, 574
AudioSuite
about, 527
controls, 528–529
using, 530
auditioning
pre and post-rolls, 362
Start and End points, 363
takes, 307–311
Auto-Created region types, 319
Auto Input Monitoring option, 295
Auto Latch, 56
auto-scrolling, playback audio tracks, 296–297
automation
about, 573
audio tracks, 574
Copy command, 588
Cut command, 587
Delete command, 587
drawing, 583–585
Edit tools, 588–589
editing, 586–589
editing commands, 586–588
enabling, 578–579
Grabber tools, 588–589
MIDI tracks, 574
modes, 574–576
Paste command, 588
Pencil tools, 589
plug-in, 581–582
preferences, 576–577
send, 582–583
Thin command, 585–586
thinning, 585–586
Trimmer tool, 589
viewing, 583
writing, 580–583
Automation Mode
channel strips audio track, Mix window, 188
selector, track controls, Edit window, 173
Automation view, Smart tool, 396–398
Aux Assign, 64
Aux Return jacks, 67
Aux Return knobs, 64
Aux Send knobs, 64
auxiliary bus, 61
auxiliary input track, Mix window, 190
Auxiliary Input Tracks, 219
auxiliary inputs, routing, 514–515
auxiliary send knobs, 58–60
axial room modes, 44
back stereo, mixing, 502–503
backplates, 86
backup system drive, 124–125
backup vocals
about, 251–252
equalization, 542–543
mixing, 501
balance, tonal mastering, 610–612
balanced cord, 33–34
balancing levels, mastering, 612–613
bars and beats, counter display, 178
basic controls, Transport window, 164–166
bass
about, 10
equalization, 543
mixing, 502
bass traps, 49–50
batch fades, 412–413
bidirectional microphones, 92
bit depth, digital recorders, 17
bit rate, MP3, 635–636
black toolbar, Edit window, 180–182
Block view, 320
Blumlein, Alan Dower, 241
Blumlein technique microphones, 241–242
Bounce dialog box, 593–595
bouncing mix, 891
Broadcast Wave Files, 198
buffer size
about, 111
hard drives, 19
burning CDs, 621–622
bus, Pro Tools, 152
buttons
Bypass, 563
Click button, MIDI controls, Transport window, 169
Command Keyboard Focus button, Edit window, 180
Conductor button, MIDI controls, Transport window, 170
Countoff button, MIDI controls, Transport window, 170
Disable the Record Enable, 296
Fast Forward button, Transport window, 165–166
Go to End button, Transport window, 166
Grid Value, 181
Group, 189
Input, 188, 189
Link/Unlink, 181
Meter button, MIDI controls, Transport window, 170
MIDI Merge, 170
Note, 171
Nudge Value, 181–182
Numerical Volume, 189
Output, 188, 190
Program Change, 190
Record Enable, 188
Solo and Mute, 188
Tab to Transients, 180
Tempo, 171
Track name, 189
Track Type, 189
Track type, 190
Velocity Meter, 189
Voice On/Off, 188
Volume Fader, 189
Wait for Note, 169
buying CD-Rs, 622
BWF files, 198
Bypass button, 563

C

cache buffers, 19
canceling performances, recording MIDI, 440
Capture Region command, 366
cardioid microphones, 91–93
carpet, 42
CD Baby, 628, 643, 647
CD Marksman, 627
CD-R master, 627
CD-Rs
about, 29, 622
buying, 622
computer-based systems, 623
defects, 624
error-detection software, 624
mass production, 624–626
multiple copies, 626–629
recording music on, 622–626
standalone CD burners, 623–624
CD-RWs, 29
CDWorks, 627
CDs
about, 29
artwork on, 626
burning, 621–622
duplication, 627
replication, 628–629
ripping, 638
selling, Web sites, 647–648
UPC bar codes, 628
centered crossfade, 407–408
Change Duration, MIDI Operations window, 488–489
Change Velocity, MIDI Operations window, 487–488
changing
data, MIDI events, 478
events, MIDI data edit, 463–466
sounds, recording MIDI, 439–440
channel codes, 73
channel-strip devices, 100
channel strips
about, 55
audio track, Mix window, 187–192
Automation Mode, 188
Comments View, 192
expansion, Mix window, 192–194
Group button, 189
Input button, 188
Inserts View, 192–193
Numerical Volume button, 189
Output button, 188
Panning Display, 188
Panning Slider, 188
Record Enable button, 188
Sends View, 194
Solo and Mute button, 188
Track name button, 189
Track Type button, 189
Velocity Meter button, 189
Voice On/Off button, 188
Volume Fader button, 189
channel voice message, 73
channels, MIDI, 72–73
characters, 13
chipset, 112
chorus, 25
chorus effects, effects processors, 571
Clear command, 389
clearing file from MIDI Regions list, 441–442
Click button, MIDI controls, Transport window, 169
Click/Countoff Options dialog box, 170
click track, record preparation
about, 281
connecting external device, 284–285
device configuration, 283–284
enable click track, 284
hearing click, 284–286
meter, 282
routing click plug-in, 285–286
tempo, 281–282
tempo and meter events, 286–288
click tracks, 430–434
clock source, Pro Tools, 147–148
close miking, 237, 238
closets, 43
coaxial connectors, 129
coincident microphones, 241
color, track views, 225–226
combined microphones, 237
Command Keyboard Focus button, Edit window, 180
commands
audio regions list, 333–336
automation, 568–588, 586–588
Capture Region, 366
Clear, 389
Command Keyboard Focus button, 180
Copy, 388–389, 588
Cut, 388, 587
Delete, 587
Duplicate, 390
Edit, 387
Edit playlists, 331–333
Edit window, 180
editing, 586–588
editing regions, 378–379
Paste, 389–390, 588
Repeat, 391
Separate Regions, 366–367
Strip Silence, 403
Thin, 585–586
Trim, 378–379
Trim to Selection, 368
undos, 336–338
Zoom Toggle, 327
Comments View, channel strips expansion, Mix window, 192
compact files
   about, 213–215
   sessions, 415–416
compression
   about, 551
   acoustic instruments, 553
   electric bass, 552
   electric guitar, 552
   kick drum, 553
   percussion, 554
   snare drum, 554
   vocals, 551–552
compressors
   about, 246–247
   attack, 247
   dynamic processors, 23–24
   gain, 247
   hard knee or soft knee, 247–248
   microphones, 100
   parameters, 548–549
   ratio, 247
   release, 247
   threshold, 247
computer-based systems, CD-Rs recording
   music on, 623
computer configuration
   about, 109
   backup system drive, 124–125
   data backup, 123–124
   Mac, 109–115
computer connections
   Digi-001, 133–134
   Mbox, 130
computer control surface mixers, 53–55
computers
   CPU, 18
   files, 29
   hard drives, 19
   memory, 18–19
   MIDI, 84
   PCI cards, 20
   software, 20–21
   sound cards, 19–20
   sound in and out, 19–20
condenser microphones, 86
Conductor button, MIDI controls,
   Transport window, 170
configure device, MIDI recording, 432–434
connecting digital devices, external effects, 532
connecting external devices, click track,
   record preparation, 284–285
connections, Digi 002 Rack, 136–138
connectors
   about, 31
   analog, 32–33
   digital, 36–38
   stereo/TRS, 33–36
Console/Channel View section, Digi 002, 140
 consoles, 69
Consolidate from Source Media, Import
   Session Data dialog box, 206
consolidating selections, sessions, 414
construction types, microphones, 86
continuous controller data, MIDI data edit, 467–468
control-change messages, MIDI messages, 74
c control room bus, 61
Control Room level knob, 64
control surface
   about, 127
   computer, 53–55
   Digi 002, 139
Controller view, 453
controllers, MIDI, 82–83
Conversion Quality, Import Session Data dialog box, 207
Convert option, audio files import to
   session, 201–202
converting analog signal into digital data, 17–18
Copy command
   about, 388–389
   automation, 588
Copy from Source Media, Import Session
   Data dialog box, 205
copy in sessions, 156
Copy option, audio files import to session, 201
copying and pasting, memory locations, 361
copyright music, 625
Copyright Office, U.S., 625–626
cords, microphones, 101
Counter displays, Edit window, 178–179
Counters section, Transport window, 167
Countoff button, MIDI controls, Transport window, 170
CPUs
computers, 18
PC configuration, 116
usage limit, Pro Tools, 150
Creating Web Pages All-in-One Desk Reference For Dummies, 644
crossfades
about, 407
centered crossfade, 407–408
post-crossfade, 409–410
pre-crossfade, 408–409
removing, 410
Smart tool, 396
trimming, 410
Cursor display, Edit window, 182
custom note duration, MIDI data edit, 460
customize Transport window, 164
Cut command
about, 388
automation, 587
cymbals
equalization, 545
microphones, 97, 263–264
data backup
computer configuration, 123–124
files manage, 215–216
dead rooms
about, 249
sound control, 45
Decay, reverb, 567
delay
about, 25
effects processors, 569–570
settings, 569–570
Delete command, 587
deleting
data, MIDI, 462–463
events, MIDI, 477
files, 215
groups, tracks, 231–232
playlists, 332–333
Depeche Mode, 507
desiccant packets, 105
designer cords, 33
Destination Sample Rate, Import Session
Data dialog box, 207
Destructive Record mode, 166, 268
device configuration, click track, record preparation, 283–284
dialing in equalization, 536–538
dialog boxes
Audio Media Options, Import Session
Data dialog box, 205
Bounce dialog box, 593–595
Click/Countoff Options dialog box, 170
Consolidate from Source Media, Import Session Data dialog box, 206
Conversion Quality, Import Session Data dialog box, 207
Copy from Source Media, Import Session
Data dialog box, 205
Destination Sample Rate, Import Session
Data dialog box, 207
Disk Allocation dialog box, 271
Export Selected dialog box, 210
Fades dialog box, 404–407
D/A converters, 17–18
DAE playback buffer, Pro Tools, 150
daisychains, 70
DAT player, 130, 596
Force to Target Session Format, Import Session Data dialog box, 206
Import Audio dialog box, 200
Import Session Data dialog box, 204–207
Import Tempo/Meter Map, Import Session Data dialog box, 207
Maintain Absolute Timecode Values, Import Session Data dialog box, 206
Maintain Relative Timecode Values, Import Session Data dialog box, 206
Map Start Timecode To, Import Session Data dialog box, 206
memory locations, 350–352
MIDI Export dialog box, 213
New Memory Location dialog box, 351
Refer to Source Media, Import Session Data dialog box, 205
Sample Rate Conversion Options, Import Session Data dialog box, 207
Source Properties, Import Session Data dialog box, 205
Source Sample Rate, Import Session Data dialog box, 207
Source Tracks, Import Session Data dialog box, 207
Timecode Mapping Options, Import Session Data dialog box, 206
Track Offset Options, Import Session Data dialog box, 207
Video Media Options, Import Session Data dialog box, 206
diffusers, sound control, 46
Diffusion, reverb, 567
Digi 001
about, 132
computer connections, 133–134
gear connections, 134–135
Digi 002
about, 138
Console/Channel View section, 140
control surface, 139
control surface mixing, 498
fader section, 140
Global Fader controls, 141
Status Indicators and Display Controls, 142–143
Transport and Navigation section, 141–142
Digi 002 Rack
about, 135–136
connections, 136–138
Digidesign, 52
Digidesign Audio Engine. See DAE playback buffer
Digidesign User's Conference (DUC), 609
digital connectors
about, 36
ADAT optical, 38
AES/EBU, 36–37
MIDI, 36
S/PDIF connectors, 37–38
TDIF, 38
Digital Domain, 629
digital input, Pro Tools, 148
digital mixers, 52–53
digital recorders
about, 16
analog-to-digital (A/D) converters, 17–18
bit depth, 17
digital-to-analog (D/A) converters, 17–18
sampling rate, 16–17
digital signal processors (DSPs), 192
digital-to-analog (D/A) converters, 17–18
direct boxes, 10, 12, 56
Direct Out jacks, 66–67
Disable the Record Enable button, 296
Disc Masters, 629
Discmakers, 628, 629
disk allocation
about, 270
hard drive space, 270–271
multiple audio drives, 271
Disk Allocation dialog box, 271
displaying region information, Audio Regions list, 336
distant microphones, 237, 239
dithering
  about, 407
  mastering, 613–614
do-it-yourself mastering, 602–603
domains, Web site, 644
downloads music, offering, 646
Dr. Dre, 507
drawing automation, 583–585
drum machines
  about, 10
  MIDI, 79
drum sets
  microphone placement, 260–261
  microphones, 97, 257–265
  room, 259
  tuning, 258–259
drums
  equalization, 544–545
  mixing, 502
dry signals, 64
dual mono, 636–637
Duplicate command, 390
duplicating
  CDs, 627
  playlists, 332
  tracks, 221
dust, workstation setup, 40
dynamic microphones
  about, 86, 88–89
  vocals, 249–250
dynamic processors
  about, 23
  compressors, 23–24
  expanders, 24
  gates, 24
  limiters, 23–24
dynamic range, 23, 547
dynamics
  about, 246
  mixing, 504–505
dynamics processors
  about, 547
  compressor parameters, 548–549
  connecting, 547–548
expanders, 557–559
External Key option, 559–561
gates, 556–557
limiters, 554–555
using compression, 550–554

e-mail newsletter, music promotion, 648
ear fatigue, mixing, 507–508
Edit commands
  about, 387
  audio regions list, 333–336
  automation, 586–588
  Clear command, 389
  Copy command, 388–389
  Cut command, 388
  Duplicate command, 390
  Edit playlists, 331–333
  Paste command, 389–390
  Repeat command, 391
  undos, 336–338
Edit Groups list, Edit window, 183
Edit modes, audio
  about, 327
  Absolute Grid mode, 329
  Grid lines, 330–331
  Grid mode, 329
  Grid resolution, 329–330
  Relative Grid mode, 329
  Shuffle mode, 328
  Split mode, 329
  Spot mode, 328
Edit modes, Edit window
  about, 175
  Grid mode, 176
  Shuffle mode, 175
  Slip mode, 175
  Spot mode, 175
Edit tools
  about, 176–177
  automation, 588–589
  Grabber tool, 177
Pencil tool, 178
Scrubber tool, 177–178
Selector tool, 177
Separation Grabber tool, 177
Standard Trimmer tool, 177
Time Grabber tool, 177
Zoomer tool, 177
Edit window
about, 171
Audio Regions list, 183–184
black toolbar, 180–182
Command Keyboard Focus button, 180
Counter displays, 178–179
Cursor display, 182
Edit Groups list, 183
edit modes, 175–176
Edit tools, 176–178
Event Edit display, 179
Grid Value button, 181
Link/Unlink button, 181
lists, 182–184
Markers timeline, 186
Meter timeline, 186
MIDI data, 457–470
MIDI Regions list, 184
Nudge Value button, 181–182
Post-Roll fields, 293–294
Pre-Roll fields, 293–294
Ruler View tool, 180
rulers, 185–186
Show/Hide Tracks list, 182–183
Tab to Transients button, 180
Tempo timeline, 186
Timebase Rulers section, 185
track controls, 171–174
Track View tool, 180
track views, 226
Zoom controls, 176
editing
automation, 586–589
memory locations, 359–361
MIDI events, 474–478
tempo and meter events, 287–288
tracks grouping, 230–232
Editing Preferences window, 201
editing regions
about, 365
aligning regions, 374–375
Capture Region command, 366
creating, 366–368
healing regions, 368–370
locking regions, 384–385
moving regions, 380–384
editing regions
moving with Edit modes, 383–384
muting/unmuting regions, 386
Nudge function, 379–380
nudging, 380–382
placing regions in tracks, 370–372
quantizing regions, 385
region Synch points, 372–374
Separate Regions command, 366–367
Separation Grabber tool, 367–368
shifting regions, 382–383
splitting stereo tracks, 386–387
Standard Trimmer tool, 376–377
Time Trimmer tool, 378
Trim command, 378–379
Trim to Selection command, 368
trimming regions, 376–380
effects processors
about, 24, 563
chorus, 25
chorus effects, 571
delay, 25, 569–570
flanger, 25–26
inserting effects, 564–565
pitch correction, 26
reverb, 25, 566–568
routing, 564–566
sending signals to effects, 565–566
electric bass
compression, 552
microphones, 255
room, 255
electric bass amp microphones, 97
electric guitar amp microphones, 97
electric guitars
  compression, 552
  equalization, 543
  microphones, 252–255
  room, 252–253
enabling
  automation, 578–579
  click track, record preparation, 284
  devices in Mac OSX, MIDI recording, 419–422
  devices in Windows XP, 422
  Latch Record Enable mode, 273–274
  record-enabling, 272–273
  Record Safe mode, 274–275
  recording, record preparation, 272–275
  recording for MIDI tracks, 435–436
  tracks grouping, 230
encoding
  music, 639–641
  software, MP3 file creation, 638–639
End counter, Expanded section, Transport window, 169
engine, MP3, 635
entire region, selecting material to edit, 342
EQ. See equalizers (EQ)
Equal gain, 406
equalization
  about, 21, 58, 496, 535
  acoustic guitar, 543
  backup vocals, 542–543
  bass, 543
  cymbals, 545
  dialing in, 536–538
  drums, 544–545
  electric guitar, 543
  4-band EQ, 538–539
  graphic equalizers, 21–22
  guitar, 543
  hi-hats, 545
  kick drums, 544
  lead vocals, 542–543
  low-pass/high-pass, 536, 540
  low-shelf/high-shelf, 536, 540
1-band EQ, 538–539
  options, 538–540
  overhead microphones, 545
  parametric equalizers, 22–23, 535–536, 540
  percussion, 545–546
  piano, 546
  shelf equalizers, 22
  snare drums, 544
  tom-toms, 545
  tracks, 540–545
  vocals, 542–543
error-detection software, CD-Rs, 624
Event Edit display, Edit window, 179
Event List window, MIDI events, 470–478
events, MIDI data edit, 460–462
Expanded section, Transport window
  about, 167–169
  End counter, 169
  Length counter, 169
  Post-roll counter, 168
  Pre-roll counter, 168
  Secondary Counter, 167–168
  Start counter, 168
  Transport Master counter, 168
expanders
  dynamics processors, 24, 557–559
  parameters, 558–559
  using, 559
expansion, channel strips, 192–194
expense, music CD promotion, 631
Export as Interleaved Stereo Files, 209
export audio
  about, 208
  Export as Interleaved Stereo Files, 209
  Export Audio Regions as Files, 208
  Export Region Definitions, 209
  export regions, 209–211
  Export Audio Regions as Files, 208
  Export Region Definitions, 209
  Export Selected dialog box, 210
exporting
  MIDI, 212–213
  region definitions, 212
regions, Resolve Duplicate File Names By, 210
from session, 208
stereo-interleaved files, 211
external effects
connecting digital devices, 532
mix setup, 530–533
routing tracks, 533
External Key option
about, 559
side-chains, 560–561
external master deck, mixing, 596
external preamp, 14

Broadcast Wave Files, 198
BWF files, 198
clearing file from MIDI Regions list,
441–442
compact, 213–215
computers, 29
Convert option, audio files import to
session, 201–202
Copy option, audio files import to
session, 201
data backup, 215–216
deleting, 215"encoding software, MP3 file creation,
638–639
Export as Interleaved Stereo Files, 209
Export Audio Regions as Files, 208
File menu, 203
finding, 160–161
import audio files, 197–202
import MIDI files, 202–204
import to session, 202
locations, sessions, 153
managing, 213–220
MIDI files, 29
MIDI files import to session, 202
MIDI Regions list, 203–204
MP3, 29, 633–638, 646
MPEG-1 Layer 3, 198
pointer, 646
QuickTime, 198
RealAudio, 646
RealAudio G2 files, 198
Resolve Duplicate File Names By, 210
SDII, 198
sessions, 153, 415–416
Sound Designer II, 198
Sound Resource, 199
stereo-interleaved, 211
Type 0, 202
Type 1, 202
files
types, 202
WAV, 29, 198

Fade icon, Smart tool, 395–396
Fader Flip switch, 141
fader section, Digi-002, 140
Fader signal flow, 511–512
faders, 61
fades, batch, 412–413
Fades dialog box, 404–407
fading in and out, 410–412
Fast Forward button, Transport window,
165–166
figure-8 microphones, 252
file locations, sessions, 153
File menu
audio files import to session, 199
MIDI files import to session, 203
file types
audio files import to session, 198–199
MIDI files import to session, 202
files
about, 29, 159–161, 213
Add option, audio files import to session,
200–201
AIFF files, 29, 198
audio, 159–161
audio files import to session, 198–201
Audio Interchange File Format files, 198
Audio Regions list, 199
files (continued)
  Whole-File region types, audio editing, 319
  Windows Media, 199
files import
  Add option, 200–201
  Audio Regions list, 199
  Convert option, 201–202
  Copy option, 201
  File menu, 199
  file types, 198–199
files management
  about, 213
  compact files, 213–215
  data backup, 215–216
  delete files, 215
finding regions, Audio Regions list, 335–336
FireWire ports, 20
flanger, 25–26
Flatten Performance, MIDI Operations window, 486
force stereo mode, 638
Force to Target Session Format, Import Session Data dialog box, 206
formats, tracks, 220
Franhofer algorithm, 635
Free Hand Pencil tool, 178
Free Hand tool, 457–458
freeing voice from track, 235
front stereo, mixing, 502–503
Fundamental, 507

G

G4 Mac, 110
G5 Mac, 110
Gabriel, Peter, 507
gain, compressors, 247
Garageband.com, 647
gates
  dynamic processors, 24
  dynamics processors, 556–557
gear connections
  Digi-001, 134–135
  Mbox, 131–132
General MIDI (GM)
  Level-1 compatibility, 75
  Level-2 compatibility, 76
General Properties, memory locations, 354–355
Geocities, 644
glass master CD, 628
Global Fader controls,
  Digi-002, 141
Go to End button, Transport window, 166
Grabber tool
  automation, 588–589
  Edit tool, 177
  Smart tool, 395, 397–398
  graphic equalizers, 21–22
  graphics card, PC configuration, 117
Gray, Macy, 507
Grid lines, Edit modes, audio, 330–331
Grid mode
  Edit modes, audio, 329
  edit modes, Edit window, 176
  Grid resolution, Edit modes, audio, 329–330
  Grid Value button, Edit window, 181
Groove House Records, 629
Groove Quantize, MIDI Operations window, 483–485
Group button, channel strips audio track,
  Mix window, 189
groups
  adding track, 231
  create, 229–230
  deleting tracks, 231–232
  Edit Groups list, Edit window, 183
  editing tracks, 230–232
  enabling tracks, 230
  Groups list, Mix window, 195
  linking, 232
  renaming, 231
  track parameters, 228–229
Groups list, Mix window, 195
guitars
  about, 10
  direct to amp, 56
  equalization, 543
  mixing parts, 502
H/W buffer size, 149–150
hand drums microphones, 264–265
hard drives
  buffer size, 19
  Mac configuration, 111–112
  PC configuration, 117
  seek time, 19
  space, 270–271
  spindle speed, 19
hard knee compressors, 247–248
hardware interfaces
  about, 127–128
  ADAT lightpipe, 128
  Digi-001, 132–135
  Digi-002 Rack, 135–143
  line-level inputs, 128
  Mbox, 128–132
  phantom power, 128
  preamps, 127
  S/PDIF, 128
hardware settings, Pro Tools, 147–149
headphones, 26–27
headroom, 246
healing regions, editing regions, 368–370
hearing click, click track, record
  preparation, 284–286
heat and dust, workstation setup, 40
HF Cut, reverb, 567
hi-hats
  equalization, 545
  microphones, 262–263
home studio components
  about, 9–10
  computers, 18–21
  input devices, 10–12
  mastering media, 28–29
  mixers, 14–16
  preamps, 12–14
  recorders, 16–21
  signal processors, 21–28
Horizontal Zoom
  about, 324
  Zoom controls, Edit window, 176
host-based system, 145
hosting music, 641–645
hybrid preamps
  about, 13–14
  microphones, 99–100
Import Audio dialog box, 200
Import Session Data dialog box
  about, 204–205
  Audio Media Options, 205
  Consolidate from Source Media, 206
  Conversion Quality, 207
  Copy from Source Media, 205
  Destination Sample Rate, 207
  Force to Target Session Format, 206
  Import Tempo/Meter Map, 207
  Maintain Absolute Timecode Values, 206
  Maintain Relative Timecode Values, 206
  Map Start Timecode To, 206
  Refer to Source Media, 205
  Sample Rate Conversion Options, 207
  Source Properties, 205
  Source Sample Rate, 207
  Source Tracks, 207
  Timecode Mapping Options, 206
  Track Offset Options, 207
  Video Media Options, 206
Import Tempo/Meter Map, Import Session
  Data dialog box, 207
import to session
  about, 197
  Add option, audio files, 200–201
  Audio Regions list, 199
  Convert option, audio files, 201–202
  Copy option, audio files, 201
  import audio files, 197–202
  import MIDI files, 202–204
import tracks
    about, 204–208
    Import Session Data dialog box, 204–207
In port, 70
input, Pro Tools, 150–151
Input button
    channel strips audio track, Mix window, 188
    MIDI track, Mix window, 189
input channels, 55
input devices
    about, 9
    direct boxes, 12
    instruments, 10
    microphone, 10–11
    monitors, 26–28
    recorders, 16–28
    signal processors, 21–28
    sound modules, 11–12
    input jacks, 55–56
Input Quantize, MIDI Operations window, 492
Insert menu, MIDI events, 472
inserting
    effects, 564–565
    jacks mixers, 56–57
    MIDI events, 474–477
    Pro Tools, 152
    signal flow, 511–512
    silence, Strip Silence command, 403
    inserts, routing, 515–516
Inserts View, channel strips expansion, Mix window, 192–193
installation
    Mac configuration, 114–115
    PC configuration, 118–123
instruments
    about, 10
    MIDI, 84
    Intel Celeron, 116
    Intel processors, 116
    interface, MIDI, 83–84
International Standard Recording Code (ISRC), 625
Internet host site, 641–642
Internet Service Provider (ISP), 644
isolation booths, 43
ISP (Internet Service Provider), 644
ISRC (International Standard Recording Code), 625
Iuma, 642

J
joint stereo mode, 637

K

Keyboard Focus option, Edit window, 180
Keyboard Modifier switches, 143
keyboard shortcuts,
    Digi-002, 143
keyboard workstations, 79
kick drums
    compression, 553
    equalization, 544
    Kiko, 507

L
LAME, 635
large-diaphragm microphones
    about, 87
    vocals, 250
Latch Record Enable mode, enabling
    recording, record preparation, 273–274
latency
    about, 530
    adjusting monitoring latency, 279–280
    low-latency monitoring, 280–281
LE version, Pro Tools, 145–146
lead vocals
    equalization, 542–543
    mixing, 501
    left stereo mixing, 500–503
Length counter, Expanded section, Transport window, 169
leveling, mastering, 601
limiters
dynamics processors, 23–24, 554–555
limits, 555
settings, 554–555
line-level inputs, hardware interface, 128
Line Pencil tool, 178
Line tool, MIDI data edit, 458
Link settings, 406
Link/Unlink button, Edit window, 181
linking
edit and mix groups, 232
Record and Playback faders, 278–279
sites, music promotion, 649
Web sites, 644
listening
mixing, 506–507
playback loops, 297–298
lists
Edit window, 182–184
mailing lists, music CD promotion, 630
Mix window, 194–195
loading Web sites, 643
locking regions, 384–385
Loop Record mode, 166, 268–269
loop recording
overdubbing MIDI performances, 447–448
playback audio tracks, 303
looping your selection’s playback, 363–364
Los Lobos, 507
low-latency monitoring, 280–281
Low Pass, reverb, 567
low-pass/high-pass equalization, 536
low-shelf/high-shelf equalization, 536
models, 110
operating system, 110
versus PCs for Pro Tools, 146
RAM needs, 111
session template, 158
software, 112
system drive, 111
system requirements, 109112
system settings, 113–114
mailing lists, music CD promotion, 630
Maintain Absolute Timecode Values,
Import Session Data dialog box, 206
Maintain Relative Timecode Values, Import
Session Data dialog box, 206
managing
files, 213–220
MIDI Input filter, 424–425
modes, MIDI, 74–75
Manson, Marilyn, 507
Map Start Timecode To, Import Session
Data dialog box, 206
Marker option, memory, 351
Markers timeline, Edit window, 186
mass production, CD-Rs recording music
on, 624–626
master bus, 61
Master Disc, 629
master fader
about, 62
routing, 513–514
Master Fader switch, 141
Master Fader tracks
about, 219
Mix window, 190–191
Master Level meters, 65
Master Mind CD Duplication, 627
Master Out jack, 66
mastering
about, 599–600, 605
balancing levels, 612–613
dithering, 613–614
do-it-yourself, 602–603
getting ready, 601–602
Mac G5 computer, 20
Macs
about, 109
audio drive, 111–112
hard drives, 111–112
installation, 114–115
mastering (continued)
leveling, 601
optimizing dynamics, 608–610
processing, 600
professional, 603–604
sample rate, 615–616
sequencing, 601, 617
session setup, 606–608
sixteen bits, 615
tonal balance, 610–612
truncation, 614
volume, 610
mastering media
about, 28
AIFF files, 29
CDs, 29
computer files, 29
MIDI files, 29
MP3 files, 29
WAV files, 29
Mbox
about, 129–130
calendar, 130
calendar connections, 131–132
McLachlan, Sarah, 507
Mechanical Animals, 507
memory, computers, 18–19
memory locations
about, 350
copying and pasting, 361
dialog box, 350–352
ing, 359–361
General Properties, 354–355
memory markers, 352–353
properties, 359–361
recall, 358–359
renaming, 359
selection memory locations, 353–354
Time Properties, 350–351
window, 356–358
memory markers, 352–353
menus, MIDI events, 471–472
Metallica, 507
meter, click track, record preparation, 282
Meter button, MIDI controls, Transport window, 170
meter choice, MIDI recording, 431
meter events, 286–287
Meter timeline, Edit window, 186
microphones
about, 10–11, 85, 237
accessories, 101–102
acoustic guitars, 97, 256–257
ambient, 237, 239–240
applications, 96–98
Blumlein technique, 241–242
buying, 94–103
care, 103–105
coincident, 241
combinations, 244–245
combined, 237
compressors, 100
construction types, 86
cords, 101
cymbals, 97, 263–264
daily care, 104
distant, 237, 239
drum set, 97, 257–265
electric bass, 255
electric bass amp, 97
electric guitar, 252–255
electric guitar amp, 97
figure-8 mic, 252
hand drums, 264–265
hi-hats, 262–263
hybrid preamps, 99–100
percussion, 97–98, 265–266
polarity patterns, 89–94
pop filters, 101–103
preamps, 98–100
preamps, compressor and equalizer combos, 100
quantity, 95
microphones
setup, 248–249
snare drums, 261
solid-state preamps, 98–99
spaced pairs, 242
spot, 237, 238
stands, 101
stereo, 237, 240–241, 242–244
stimulator, 95
storage, 104–105
techniques, 237
tom-toms, 262
tube preamps, 99
vocals, 97, 249–251
X-Y pairs, 241
MIDI
about, 11, 69
built-in sequencer, 79
controller, 77, 82–83
digital connectors, 36
drum machine, 79
export, 212–213
general, 75–76
getting started, 76–77
instruments, 84
interface, 83–84
keyboard feel, 78–79
managing modes, 74–75
multitimbrality, 78
Omni Off/Mono mode, 75
Omni Off/Poly mode, 75
Omni On/Mono mode, 74
Omni On/Poly mode, 74
polyphony, 78
ports, 70–72
protocol, 70
samplers, 80
sequencer, 77, 83
soft-synths, 81
sound generators, 77
sound module, 79
sound quality, 79
synthesizer, 77–79
workstations, 79
MIDI channels, 72–73
MIDI controller
mixers, 14–15
mixing, 498–499
MIDI controls, Transport window
about, 169
Click button, 169
Conductor button, 170
Countoff button, 170
Meter button, 170
MIDI Merge button, 170
Note button, 171
Tempo button, 171
Wait for Note button, 169
MIDI data
Edit window, 457–470
note chasing, 456–457
MIDI data edit
changing events, 463–466
continuous controller data, 467–468
custom note duration, 460
deleting data, 462–463edit program data, 466–467
events, 460–462
Free Hand tool, 457–458
Line tool, 458
Pencil tools, 457–459
Random tool, 459
Smart tool, 469–470
Square tool, 459
Triangle tool, 459
MIDI events
about, 470
changing data, 478
deleting events, 477
editing, 474–478
Event List window, 470–478
Insert menu, 472
inserting events, 474–477
menus, 471–472
Options menu, 471
MIDI Export dialog box, 213
MIDI files
about, 29, 159–161
File menu, 203
file types, 202
finding, 160–161
MIDI files (continued)
import to session, 202
MIDI Regions list, 203–204
MIDI jacks, 11
MIDI Merge button, MIDI controls,
Transport window, 170
MIDI Merge/Replace, overdubbing MIDI
performances, 442
MIDI messages
about, 73
control-change messages, 74
performance data, 73–74
system-common messages, 74
system-exclusive messages, 74
MIDI Operations window
about, 479–480
Change Duration, 488–489
Change Velocity, 487–488
Flatten Performance, 486
Groove Quantize, 483–485
Input Quantize, 492
operations, 480–481
Quantize, 482–483
Restore Performance, 485–486
Select Notes, 490–491
Split Notes, 491–492
Transpose, 489–490
MIDI ports, 11
MIDI recording
configure device, 432–434
create MIDI tracks, 428–429
creating click track, 430–434
enable devices in Mac OSX, 419–422
enable devices in Windows XP, 422
managing MIDI Input filter, 424–425
meter choice, 431
offsetting MIDI tracks, 427–428
quantizing inputs, 425–427
ready, 428–434
running MIDI Thru, 423–424
setting inputs, outputs, and MIDI
channels, 429–430
setup devices, 419–428
MIDI Regions list
Edit window, 184
MIDI files import to session, 203–204
MIDI tracks
about, 220, 451
automation, 574
create, 428–429
Input button, 189
Mix window, 189–190
Output button, 190
Program Change button, 190
regions, 455
selecting track material, 454–455
Track type button, 190
track views, 451–453
mini keyboard, 455
minisololation, 43
minutes and seconds, counter display, 178
mix, bouncing, 891
mix bus, 496
mix setup
about, 509, 524
external effects, 530–533
Mix window, 509–510
Output windows, 520–523
plug-ins, 524–530
routing, 512–520
signal flow, 511–512
Mix window
Automation Mode, 188
auxiliary input track, 190
channel strips, 187–194
channel strips audio track, Track Name
button, 189
channel strips expansion, 192–194
Comments View, channel strips
expansion, 192
Groups list, 195
Input button, 188
Inserts View, channel strips expansion,
192–193
lists, 194–195
Master Fader track, 190–191
MIDI track, 189–190
mix setup, 509–510
Numerical Volume button, channel strips audio track, 189
Output button, 188
Panning Display, channel strips audio track, 188
Panning Slider, channel strips audio track, 188
Program Change button, MIDI track, 190
Record Enable button, 188
Sends View, channel strips expansion, 194
Show/Hide Tracks list, 194–195
Solo and Mute button, channel strips audio track, 188
stereo and mono track, 191–192
Track Type button, channel strips audio track, 189
Track View, 226–227
Velocity Meter button, channel strips audio track, 189
Voice On/Off button, channel strips audio track, 188
Volume Fader button, channel strips audio track, 189
mixers
about, 14, 51, 55
analog, 52
Assign switches, 61
auxiliary send knobs, 58–60
channel strips, 55
computer control surface, 53–55
digital, 52–53
equalization, 58
faders, 61
inputs jacks, 55–56
insert jacks, 56–57
MIDI controller, 14–15
Mute switch, 60–61
Pan knob, 60
Pre/Post switch, 60
routing/busing, 61–65
Solo switch, 61
Trim knobs, 57–58
mixing
about, 495–496
adjusting levels, 503–505
analog mixer, 499–500
arrangement, 505
back stereo, 502–503
backup vocals, 501
bass, 502
Digi 002 control surface, 498
digital mixer, 499
drums, 502
dynamics, 504–505
ear fatigue, 507–508
external master deck, 596
front stereo, 502–503
guitar parts, 502
lead vocals, 501
left stereo, 500–503
levels, 496–497
listening, 506–507
MIDI controller, 498–499
organs, 502
percussion, 502
piano, 502
reference CDs, 507
right stereo, 500–503
songs, 497–498
sound control, 45–50
stereo field, 500–503
synthesizers, 502
versions, 508
mixing in-the-box
about, 593
Bounce dialog box, 593–595
modes
Absolute Grid mode, Edit mode, 329
audio editing, 327–331
Auto Input Monitoring mode, 278
automation, 574–576
Automation Mode, 173, 188
modes (continued)
Automation Mode selector, 173
axial room modes, 44
Depreche Mode, 507
Destructive Record mode, 166, 268
Edit modes, 327–331
Edit modes, Edit window, 175–176
editing regions, moving with Edit modes, 383–384
enabling, 273–275
force stereo mode, 638
Grid lines, Edit modes, 330–331
Grid mode, 176, 329
Grid resolution, Edit modes, 329–330
Input Only Monitoring mode, 278
joint stereo mode, 637
Latch Record Enable mode, enabling recording, record preparation, 273–274
Loop Record mode, 166, 268–269
managing, 74–75
Mix window, 188
monitor mode, 277–278
mono mode, 637
moving with Edit modes, 383–384
Non-Destructive Record mode, 268
Nondestructive Record mode, 166
Normal Zoom mode, 325
oblique room modes, 44
Omni Off/Mono mode, MIDI, 75
Omni Off/Poly mode, MIDI, 75
Omni On/Mono mode, MIDI, 74
Omni On/Poly mode, MIDI, 74
Quick-punch Record mode, 166
QuickPunch Record mode, 269–270
record modes, 267–268
record preparation, 267–270
Record Safe mode, 274–275
Relative Grid mode, 329
Relative Grid mode, Edit modes, audio, 329
Shuffle mode, 175, 328
Single Zoom mode, 326
Slip mode, Edit window, 175
sound control room modes, 44
Split mode, 329
Spot mode, 175, 328
stereo mode, 637
tangential room modes, 44
Windows XP Classic mode, 118–119
zooming in and out, audio editing, 325
modulations, 571
monitoring
adjusting monitoring latency, 279–280
linking and unlinking Record and Playback faders, 278–279
low-latency monitoring, 280–281
MIDI inputs, 437
monitor mode, 277–278
setting up monitoring, 277
tracks, record preparation, 277–281
monitors
about, 26
headphones, 26–27
speakers, 27–28
workstation setup, 41
Monitors jack, 66
mono mode, 637
mono tracks, 220
mono/TS analog connector, 32–33
motherboards, 116–117
moving
around tracks, 227
with Edit modes, 383–384
regions, 380–384
MP3 files
about, 29, 633–635, 646
bit rate, 635–636
creation, 638
encoding software, 638–639
engine, 635
mode, 636–638
near-CD quality, 634
MP3 host site, 636
MPEG-1 Layer 3 files, 198
multiple audio drives, 271
multiple copies, CD-Rs, 626–629
multiple-pattern microphones, 93
multiple tracks
  recording audio tracks, 292
  selecting material to edit, 342
music
  downloads, 645
  encoding music, 639–641
  hosting, 641–645
  providing online, 645–647
music CD promotion
  expense, 631
  job promotion, 630
  mailing list, 630
  organization, 630
  publicity, 631
  style, 631
music on Internet
  about, 633
  MP3, 633–638
music promotion
  about, 648
  e-mail newsletter, 648
  linking site, 649
  networks, 648
  up-to-date, 649
  Web address, 648
Musical Instrument Digital Interface (MIDI).
  See MIDI
Musicmatch Jukebox, 638
Mute, signal flow, 511–512
Mute button, track controls, Edit window, 173
Mute/Solo switches, 62–63
Mute switch, 60–61
Mute view, 321, 453
muting tracks, 233
muting/unmuting regions, editing regions, 386

N

naming
  sessions, 153
  tracks, 221

navigation Web site, 643
near-CD quality, MP3, 634
near-field monitors, 27, 41
networks, music promotion, 648
New Memory Location dialog box, 351
new sessions, 152
N2MP3, 638–639
No Doubt, 507
Non-Destructive Record mode, 268
nondestructive editing, 318
Nondestructive Record mode, 166
Normal Zoom mode, 325
Note button, MIDI controls, Transport window, 171
  note chasing, MIDI data, 456–457
  Notes view, 452
  Nudge function, editing regions, 379–380
  Nudge Value button, Edit window, 181–182
  nudging
    editing regions, 380–382
    selecting material to edit, 346–348
Numerical Volume button, channel strips
  audio track, Mix window, 189

O

Oasis CD Duplication, 628, 629
oblique room modes, 44
offline plug-ins, 527
Offline region types, audio editing, 319
offsetting MIDI tracks, 427–428
Omni Off/Mono mode, MIDI, 75
Omni Off/Poly mode, MIDI, 75
Omni On/Mono mode, MIDI, 74
Omni On/Poly mode, MIDI, 74
omnidirectional microphones, 90–91
On How Life Is, 507
Online button, Transport window, 165
open sessions, 154
operating system
  Mac configuration, 110
  PC configuration, 117–118
optimizing dynamics, mastering, 608–610
optional windows, track controls, Edit window, 173–174
Options menu, MIDI events, 471
ordering from Web sites, 644
organization, music CD promotion, 630
organs, mixing, 502
Out port, 70
Out Shape Setting, 406
output, Pro Tools, 151–152
Output, signal flow, 511–512
Output button
channel strips audio track, Mix window, 188
MIDI track, Mix window, 190
output jacks
about, 65
Aux Return jacks, 67
Direct Out jacks, 66–67
Master Out jack, 66
Monitors jack, 66
Phones jack, 66
Output windows
mix setup, 520–523
Send Output window, 523
Track Output window, 520–522
overdubbing, playback audio tracks, 304–306
overdubbing MIDI performances
about, 442
loop recording, 447–448
punch, 443–447
using MIDI Merge/Replace, 442
overhead microphones
about, 264
equalization, 545
overhead panels for sound control, 47

Panning Display, channel strips audio track, Mix window, 188
Panning Slider, channel strips audio track, Mix window, 188
parameters, expanders, 558–559
parametric equalizers, 22–23, 535–536, 540
part of region, selecting material to edit, 340–342
pass-through point, 575
passive monitors, 27
Paste command
about, 389–390
automation, 588
Patch bay, 39, 67–68
PC configuration
about, 115
Control Panel settings, 119–120
CPUs, 116
disabling AutoPlay, 121
disabling virus protection, 121–122
enabling DMA, 120–121
graphics card, 117
hard drives, 117
hardware connection, 122
installation, 118–123
motherboard, 116–117
operating system, 117–118
RAM, 117
session template, 158
system requirements, 115–116
Window’s settings, 118
Windows XP Classic mode, 118–119
Peak EQ, 535
Pearl Jam, 507
Pencil tool
about, 398–399
automation, 589
copy of original file, 399
Edit tools, Edit window, 178
MIDI data edit, 457–459
redraw waveform, 399–400
percussion
compression, 554
equalization, 545–546

Page Scroll During Playback, 297
Pan, signal flow, 511–512
Pan knob, 60
Pan view, 321, 453
panning, 496
microphones, 97–98, 265–266
mixing, 502
room, 265
performances
data, MIDI messages, 73–74
information, 70
recording MIDI, 435–438
peripherals, Pro Tools, 147
phantom power, hardware interfaces, 128
phantom power features, 56, 86–87
phase cancellation, 243
Phones jack, 66
Phones knob, 64
phono plugs, 34–36
piano
equalization, 546
mixing, 502
Pitch Bend view, 453
pitch correction, 26
placing regions in tracks, 370–372
Play button
about, 291
Transport window, 165
play recorded tracks, recording MIDI, 438
playback audio tracks
about, 295
additional takes, 299–311
auditioning takes, 307–311
auto-scrolling, 296–297
editing during, 318
listening playback loops, 297–298
loop recording, 303
overdubbing, 304–306
Page Scroll During Playback, 297
punch in and out, 299–303
QuickPunch, 304
recorded tracks, 295–296
recording to playlists, 306–307
Scroll After Playback, 297
Scrub tool, 298–299
setting scrolling options, 296–297
start over, 299
Playback Engine window, Pro Tools, 149–150
playback tracks, recording MIDI, 438–440
playing
post-rolls, 362
pre-rolls, 362
selected materials, 363–364
selections, 362
Playlist selector
about, 331
track controls, Edit window, 173
playlists
choosing, 333
creating new, 332
deleting, 332–333
duplicating, 332
Edit, audio, 331–333
recording audio tracks, 294–295
renaming, 333
pleasing distortion, 13
plug-ins
automation, 581–582
offline, 527
real time audio suite (RTAS), 525–527
plug-ins, mix setup
AudioSuite, 527–530
real time audio suite (RTAS), 524–527
Pohlmann, Ken C., 17
pointer file, 646
polarity patterns, microphones, 89–94
poor stereo imaging, 243
pop filters, microphones, 101–103
pop-up menu, Audio Regions list, 334–336
ports, MIDI, 70–72
post-crossfade, 409–410
Post-roll counter, Expanded section,
Transport window, 168
Post-roll fields
Edit window, 293–294
playing, 362
recording audio tracks, 292–295
Transport window, 292–293
PowerBook, 110
PQ subcode, 623
pre-crossfade, 408–409
Pre/Post switch, 60
Pre-roll counter, Expanded section, Transport window, 168
Pre-roll fields
  Edit window, 293–294
  playing, 362
  recording audio tracks, 292–295
  Transport window, 292–293
preamps
  about, 12–13
  combos, 100
  external, 14
  hardware interfaces, 127
  hybrid, 13–14
  microphones, 98–100
  solid-state, 13
  tube, 13
Predelay, reverb, 567
preferences, automation, 576–577
Presets, 406
Principles of Digital Audio (Pohlmann), 17
Pro Tools
  bus, 152
  clock source, 147–148
  CPU usage limit, 150
  DAE playback buffer, 150
  digital input, 148
  H/W buffer size, 149–150
  hardware settings, 147–149
  input, 150–151
  insert, 152
  installation on PC, 118–123
  LE version, 145–146
  Mac installation, 114–115
  Macs versus PCs, 146
  output, 151–152
  peripherals, 147
  Playback Engine window, 149–150
Pro Tools
  Sample Rate, 148–149
  sessions, 152–159
  setup, 147–152
  software versions, 145–146
  TDM version, 145–146
  processing, mastering, 600
  processor-based system, 146
  processors, AMD, 116
  professional mastering, 603–604
  Program Change button, MIDI track, Mix window, 190
  Program Change view, 453
  program data, edit, 466–467
  properties, memory locations, 359–361
  providing online music, 645–647
  proximity effects, 241
  publicity, music CD promotion, 631
  punch
    overdubbing MIDI performances, 443–447
    playback audio tracks, 299–303

Q
Quantize, MIDI Operations window, 482–483
quantizing
  inputs, MIDI recording, 425–427
  regions, editing, 385
  quarter-inch analog connectors, 32–33, 56
  Quick-punch Record mode, 166
  QuickPunch playback audio tracks, 304
  QuickPunch Record mode, 269–270
  QuickTime files, 198

R
rack-mountable sound modules, 12
Raitt, Bonnie, 507
RAM
  Mac configuration, 111
  PC configuration, 117
Random Pencil tool, 178
  ratio, compressors, 247
  RCA connectors, 34–36
  ready MIDI recording, 428–434
real time audio suite (RTAS)
  plug-in window, 525–526
  plug-ins, 526–527
  routing, 524–525
RealAudio files, 646
RealAudio G2 files, 198
recall, memory locations, 358–359
Record button
about, 291
Transport window, 166
Record Enable button
channel strips audio track, Mix window, 188
track controls, Edit window, 173
Record Enable switch, 141
record-enabling, 272–273
record modes
about, 267–268
Destructive Record mode, 268
Loop Record mode, 268–269
Non-Destructive Record mode, 268
QuickPunch Record mode, 269–270
record preparation
about, 267
creating click track, 281–288
disk allocation, 270–271
enabling recording, 272–275
monitoring tracks, 277–281
record modes, 267–270
setting levels, 275–277
Record Safe mode, 274–275
recorded tracks, playback audio tracks, 295–296
recorders
about, 16
digital, 16–18
recording
music on CD-Rs, 622–626
to playlists, 306–307
system-exclusive data, 449–450
to tracks, submixing, 591–593
recording audio tracks
about, 289
multiple tracks, 292
playback, 295–299
playlists, 294–295
post-roll fields, 292–295
pre-roll fields, 292–295
single tracks, 289–291
recording MIDI
about, 435
canceling performances, 440
changing sounds, 439–440
clearing file from MIDI Regions list, 441–442
enabling recording for MIDI tracks, 435–436
monitoring MIDI inputs, 437
performances, 435–438
play recorded tracks, 438
playback tracks, 438–440
recording MIDI, 437–438
recording MIDI tracks, 437–438
setting scrolling options, 438–439
undo takes, 440–441
unwanted takes, 440–442
Wait for Note option, 436
Red Book, 642
Refer to Source Media, Import Session Data
dialog box, 205
reference CDs, 507, 629
reflections, sound control, 44
region definitions, export, 212
region Synch points, editing regions, 372–374
region types, audio editing
about, 318
Auto-Created, 319
Offline, 319
Stereo, 319
User-Defined, 319
Whole-File, 319
regions
about, 159
export audio, 209–211
Relative Grid mode, Edit modes, audio, 329
release, compressors, 247
removing
crossfades, 410
unused regions, sessions, 414–415
renaming
   memory locations, 359
   playlists, 333
   tracks grouping, 231
Repeat command, 391
replication, CDs, 628–629
Resolve Duplicate File Names By, export regions, 210
Restore Performance, MIDI Operations window, 485–486
retail-ready packages, 627
Return of Saturn, 507
Return to Zero button
   about, 290
   Transport window, 165
reverb
   about, 25
   Algorithm, 567
   Decay, 567
   Diffusion, 567
effects processors, 566–568
   HF Cut, 567
   Low Pass, 567
Predelay, 567
settings, 566–568
Size, 567
revert to save sessions, 157
Rewind button, Transport window, 165
ribbon microphones
   about, 86, 89
   vocals, 251
right stereo mixing, 500–503
Roland, 76
rooms
   acoustic guitars, 256
drum set, 259
electric bass, 255
electric guitar, 252–253
percussion, 265
sound, 41–50
sound control, 44
rotational speed, 19, 111
routing
   about, 55
   auxiliary inputs, 514–515
   click plug-in, 285–286
effects processors, 564–566
   inserts, 515–516
master fader, 513–514
Mix setup, 512–520
real time audio suite (RTAS), 524–525
   sends, 516–520
tracks, external effects, 533
routing/busing
   Aux Assign, 64
   Aux Return knobs, 64
   Aux Send knobs, 64
   Control Room level knob, 64
   Master fader, 62
   Master Level meters, 65
mixers, 61–65
Mute/Solo switches, 62–63
Phones knob, 64
submix fader, 62
RTAS. See real time audio suite (RTAS)
Ruler View tool, Edit window, 180
rulers
   Edit window, 179, 185–186
   zooming in and out, audio editing, 326
rumble, 22
running MIDI Thru, MIDI recording, 423–424
S
S-Curve, 406
S/PDIF
   connectors, 37–38
   hardware interfaces, 128
sample rate
   digital recorders, 16–17
   mastering, 615–616
   Pro Tools, 148–149
   sessions, 153
Sample Rate Conversion Options, Import Session Data dialog box, 207
samples, counter display, 178
save as sessions, 155
save sessions, 154–155
Scroll After Playback, playback audio tracks, 297
Scrub tool, playback audio tracks, 298–299
Scrubber tool, Edit tools, Edit window, 177–178
SDII files, 198
Secondary Counter, Expanded section, Transport window, 167–168
seek time
about, 111
hard drives, 19
Select Notes, MIDI Operations window, 490–491
selecting material to edit
about, 339
changes to selection, 345–350
entire region, 342
multiple tracks, 342
nudging selections, 346–348
part of region, 340–342
Selection Indicator fields, 344–345
selection length, 348–349
selections between tracks, 349–350
track material, 339–345
two regions, 342
selection
changes material to edit, 345–350
length, selecting material to edit, 348–349
memory locations, 353–354
playing, 362
playlists, 333
between tracks, 349–350
Selection Indicator fields, 344–345
Selector tool, Edit tools, Edit window, 177
Selector tool, Smart tool, 394–395, 397
selling CDs, 647–648
send
automation, 582–583
routings, 516–520
Send Output window, 523
Send Post-fader, signal flow, 511–512
Send Pre-fader, signal flow, 511–512
sending signals to effects, effects processors, 565–566
Sends View, channel strips expansion, Mix window, 194
Separate Regions command, editing regions, 366–367
Separation Grabber tool
Edit tools, Edit window, 177
ingedit regions, 367–368
sequence music, 600
sequencer, MIDI, 83
sequencing
about, 69
mastering, 601, 617
songs, 617
sessions
about, 152
audio file type, 153
cleanup, 414–416
compacting files, 415–416
consolidating selections, 414
copy in, 156
file location, 153
name, 153
new, 152
open, 154
remove unused regions, 414–415
revert to save, 157
sample rate, 153
save, 154–155
save as, 155
template, 157–159
setting
inputs, outputs, and MIDI channels, 429–430
voice priority, 234–235
setting levels, record preparation
about, 275–276, 275–277
Digidesign interface, 275
preamp trim knob, 275
record range, 276–277
setting scrolling options
playback audio tracks, 296–297
recording MIDI, 438–439
settings
  delay, 569–570
  reverb, 566–568
setup
  devices, MIDI recording, 419–428
  Pro Tools, 147–152
  Web sites, 643–645
shelf equalizers, 22
shifting regions, editing regions, 382–383
Show/Hide Tracks list
  Edit window, 182–183
  Mix window, 194–195
showing and hiding tracks, 223–225
Shuffle mode
  Edit modes, audio, 328
  edit modes, Edit window, 175
side-chains, External Key option, 560–561
signal flow
  about, 511
  Fader, 511–512
  Insert, 511–512
  Mute, 511–512
  Output, 511–512
  Pan, 511–512
  Send Post-fader, 511–512
  Send Pre-fader, 511–512
  Source, 511–512
signal processors
  about, 21, 563
  dynamic processors, 23–24
  equalizers (EQ), 21–23
  silica gel, 105
single tracks, recording audio tracks, 289–291
Single Zoom mode, 326
sixteen bits, mastering, 615
size
  reverb, 567
  track views, 226–227
slap-back echo, 570
Slip mode, edit modes, Edit window, 175
S&M, 507
small-diaphragm microphones
  about, 87
  vocals, 250–251
Smart tool
  about, 393
  Automation view, 396–398
  copy of original file, 399
  crossfade, 396
  Fade icon, 395–396
  Grabber tool, 395, 397–398
  MIDI data edit, 469–470
  Pencil tool, 398–400
  Selector tool, 394–395, 397
  Trimmer tool, 394, 397
  Waveform view, 394–396
snare drums
  about, 261
  compression, 554
  equalization, 544
  microphones, 261
So, 507
soft knee compressors, 247–248
soft-synths, MIDI, 81
software
  computers, 20–21
  LE version, 145–146
  Mac configuration, 112
  TDM version, 145–146
  versions, Pro Tools, 145–146
solid-state microphones, 87
solid-state preamps
  about, 13
  microphones, 98–99
Solo and Mute button, channel strips
  audio track, Mix window, 188
Solo button, track controls, Edit window, 173
Solo switch, 61
soloing tracks, 233
songs
  mixing, 497–498
  sequencing, 617
Index 679

Sony/Philips Digital Interface Format, 37
sorting regions, Audio Regions list, 335
sound control
  about, 44
  acoustics, 44
  bass traps, 49–50
  dead rooms, 45
diffusers, 46
during mixing, 45–50
  overhead panels, 47
  reflections, 44
  room modes, 44
  standing waves, 48
during tracking, 44–45
Sound Designer II files, 198
sound isolation, 42–43
sound modules
  about, 11–12
  MIDI, 79
Sound Pressure Level (SPL), 88
Sound Resource files, 199
Source Properties, Import Session Data
dialog box, 205
Source Sample Rate, Import Session Data
dialog box, 207
Source signal flow, 511–512
Source Tracks, Import Session Data
dialog box, 207
spaced pairs, microphones, 242
speakers, 27–28
spindle speed
  about, 111
  hard drives, 19
Split mode, Edit modes, audio, 329
Split Notes, MIDI Operations window,
  491–492
splitting stereo tracks, editing regions,
  386–387
spot miking, 237, 238
Spot mode
  Edit modes, audio, 328
  edit modes, Edit window, 175
Square Pencil tool, 178
Square tool, MIDI data edit, 459
standalone CD burners, 623–624
Standard Trimmer tool
  Edit tools, Edit window, 177
  editing regions, 376–377
standing waves, sound control, 48
stands, microphones, 101
Start and End points, auditioning, 363
Start counter, Expanded section, Transport
  window, 168
starved-plate tubes, 13
Status Indicators and Display Controls,
  Digi-002, 142–143
Steely Dan, 507
steering data, 637–638
stereo
  microphones, 242–244
  region types, audio editing, 319
 stereo and mono track, Mix window,
    191–192
stereo field
  about, 188
  mixing, 500–503
stereo-interleaved files, 211
stereo microphones, 237, 240–241
stereo mode, 637
stereo tracks, 220
stereo/TRS connectors
  about, 33–34
  RCA connectors, 34–36
  XLR connectors, 34
stimulator microphones, 95
Stop button, Transport window, 165
storage microphones, 104–105
streaming audio, 645, 646–647
Strip Silence command
  about, 400
  insert silence, 403
style, music CD promotion, 631
submix bus, 61
submix fader, 62
submixing recording to tracks, 591–593
Surfacing, 507
synthesizers
  about, 10
  mixing, 502
Sysex view, 453
system-common messages, MIDI
  messages, 74
system drive, Mac, 111
system-exclusive data recording, 449–450
system-exclusive messages, MIDI, 74
system requirements, Mac, 109–112
system settings, Mac, 113–114

t
Tab to Transients button, Edit window, 180
tangential room modes, 44
TDIF, 38
TDM version, Pro Tools, 145–146
Teac Digital Interface Format, 38
template sessions, 157–159
tempo, click track, record preparation, 281–282
tempo and meter events
  creating new, 286–287
  editing, 287–288
Tempo button, MIDI controls, Transport window, 171
tempo map, 170
Tempo timeline, Edit window, 186
testing Web sites, 644
Thin command, automation, 585–586
thinning automation, 585–586
threshold
  about, 24
  compressors, 247
Thru port, 70
Time Grabber tool, Edit tools, Edit window, 177
Time Trimmer tool, editing regions, 378
Timebase Rulers section, Edit window, 180
Timecode Mapping Options, Import Session Data dialog box, 206
tom-toms
  equalization, 545
  microphones, 262
tonal balance, mastering, 610–612
tools
  Edit, 176–177, 588–589
  Free Hand, 457–458
  Free Hand Pencil, 178
  Grabber, 177, 588–589
  Line Pencil, 178
  Pencil, 178, 589
  Ruler View, 180
  Scrubber, 177–178
  Selector, 177
  Separation Grabber, 177, 367–368
  Smart, 394–398
  Square, 459
  Square Pencil, 178
  Standard Trimmer, 177, 376–377
  Time Grabber, 177
  Time Trimmer, 378
  Track View, 180
  Triangle, 459
  Triangle Pencil, 178
  Trimmer, 589
  Zoomer, 177
track channels, 55
track controls, Edit window
  about, 171
  Automation Mode selector, 173
  Mute button, 173
  optional windows, 173–174
  Playlist selector, 173
  Record Enable button, 173
  Solo button, 173
  Track Height selector, 173
  Track Name button, 173
  Track View selector, 173
  Voice selector, 173
Track Height selector, track controls, Edit window, 173
track material, selecting material to edit, 339–345
Track Name button
channel strips audio track, Mix window, 189
track controls, Edit window, 173
Track Offset Options, Import Session Data
dialog box, 207
Track Output window, 520–522
Track Type button
channel strips audio track, Mix window, 189
MIDI track, Mix window, 190
Track View
about, 320
Block view, 320
color, 225–226
Edit window, 226
MIDI tracks, 451–453
Mix window, 226–227
Mute view, 321
Pan view, 321
selector, 173
showing and hiding tracks, 223–225
size, 226–227
Volume view, 321
Waveform view, 320–321
Track View tool, 180
track voices
about, 233
assigning voices, 234
freeing voice from track, 235
set voice priority, 234–235
tracking sound control, 44–45
tracks
about, 219
assigning inputs and outputs, 222
Audio Tracks, 219
Auxiliary Input Tracks, 219
creating new, 220–221
deleting, 228
duplicating, 221
equalization, 540–545
formats, 220
import tracks, 204–208
Master Fader Tracks, 219
MIDI Tracks, 220
mono, 220
moving around, 227
muting, 233
naming, 221
number of new, 220
setup, 220–222
soloing, 233
stereo, 220
types, 219–220, 220
views, 223–228
tracks grouping. See also groups
about, 228
adding track to group, 231
creating groups, 229–230
deleting groups, 231–232
editing, 230–232
enabling, 230
grouped track parameters, 228–229
linking edit and mix groups, 232
renaming, 231
transients
about, 237, 245
compressors, 246–248
levels, 245–246
mic placement, 246
Transport and Navigation section, Digi-002,
141–142
Transport Master counter, Expanded
section, Transport window, 168
Transport window
about, 163
basic controls, 164–166
Counters section, 167
customize, 164
Expanded section, 167–169
Fast Forward button, 165–166
Go to End button, 166
MIDI controls, 169–171
Online button, 165
Play button, 165
Post-Roll fields, 292–293
Transport window (continued)
Pre-Roll fields, 292–293
Record button, 166
Return to Zero button, 165
Rewind button, 165
Stop button, 165
Transpose, MIDI Operations window, 489–490
Triangle Pencil tool, 178
Triangle tool, MIDI data edit, 459
Trim command, editing regions, 378–379
Trim knobs, 57–58
Trim to Selection command, editing regions, 368
Trimmer tool
automation, 589
Smart tool, 394, 397
trimming
crossfades, 410
regions, 376–380
truncation, mastering, 614
tube microphones, 87
tube preamps
about, 13
microphones, 99
tuning drum set, 258–259
Two Against Nature, 507
two regions, selecting material to edit, 342
2001, 507
Type 0 files, 202
Type 1 files, 202
takes, 440–441
unlinking Record and Playback faders, 278–279
unwanted takes, 440–442
UPC bar codes, 628
U.S Copyright Office, 625–626
USB ports, 20
User-Defined region types, audio editing, 319

U

variable bit rate (VBR), 636
Velocity Meter button, channel strips audio track, Mix window, 189
Velocity view, 452
versions
LE version, Pro Tools, 145–146
mixing, 508
TDM version, 145–146
Vertical Zoom
about, 324
Zoom controls, Edit window, 176
Video Media Options, Import Session Data dialog box, 206
viewing automation, 583
viewing regions, audio editing
about, 320
adjusting track height, 321–322
assigning region-name and time-location displays, 322–324
selecting track view, 320–321
zooming in and out, 324–327
views, tracks, 223–228
Vitaminic, 642
vocals
backup, 251–252
compression, 551–552
dynamic microphones, 249–250
equalization, 542–543
large-diaphragm microphones, 250
lead, 501
microphones, 97, 249–250
mixing, 501
ribbon microphones, 251
room, 249
small-diaphragm microphones, 250–251
voice coil, 88–89
Voice On/Off button, channel strips audio track, Mix window, 188
Volume Fader button, channel strips audio track, Mix window, 189
volume mastering, 610
Volume view, 321, 453

UPC bar codes, 628
U.S Copyright Office, 625–626
wet signal, 64
Whole-File region types, audio editing, 319
window memory locations, 356–358
windows
Edit, 171–184, 293–294
Mix, 187–194, 509–510
Transport, 163–171, 292–293
Windows Media files, 199
Windows XP, 117–118
workstation setup
about, 38–39
heat and dust, 40
monitors, 41
workstations, MIDI, 79
writing automation, 580–583

X

X-Y pairs, microphones, 241
XLR connectors, 34

Y

Y cords, 33–34
Yamaha, 76
Yield, 507

Z

Zoom controls, Edit window
  Horizontal Zoom, 176
  Vertical Zoom, 176
  Zoom Presets, 176
Zoom Presets
  about, 325
  Zoom controls, Edit window, 176
  Zoom Toggle command, 327
Zoomer tool, Edit tools, Edit window, 177
<table>
<thead>
<tr>
<th>zooming in and out, audio editing about, 324</th>
<th>Single Zoom mode, 326</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal Zoom, 324</td>
<td>Vertical Zoom, 324–325</td>
</tr>
<tr>
<td>Normal Zoom mode, 325</td>
<td>Zoom Presets, 325</td>
</tr>
<tr>
<td>rulers, 326</td>
<td>Zoom Toggle command, 327</td>
</tr>
</tbody>
</table>
### PERSONAL FINANCE

- **Personal Finance For Dummies**
  - ISBN: 0-7645-5231-7

- **Investing For Dummies**

- **Home Buying For Dummies**

Also available:

- Estate Planning For Dummies
  - ISBN: 0-7645-5501-4

- 401(k)s For Dummies

- Frugal Living For Dummies
  - ISBN: 0-7645-5403-4

- Microsoft Money “X” For

- Mutual Funds For Dummies
  - ISBN: 0-7645-5329-1

- Personal Bankruptcy For
  - ISBN: 0-7645-5498-0

- Quicken “X” For
  - ISBN: 0-7645-1666-3

- Stock Investing For Dummies

- Taxes For Dummies 2003
  - ISBN: 0-7645-5475-1

### BUSINESS & CAREERS

- **Accounting For Dummies**

- **Grant Writing For Dummies**
  - ISBN: 0-7645-5307-0

- **Resumes For Dummies**

Also available:

- Business Plans Kit For
  - ISBN: 0-7645-5365-8

- Consulting For Dummies
  - ISBN: 0-7645-5034-9

- Cool Careers For Dummies
  - ISBN: 0-7645-5345-3

- Human Resources Kit For
  - ISBN: 0-7645-5131-0

- Managing For Dummies

- QuickBooks All-in-One Desk

- Selling For Dummies
  - ISBN: 0-7645-5363-1

- Small Business Kit For
  - ISBN: 0-7645-5093-4

- Starting an eBay Business For
  - ISBN: 0-7645-1547-0

### HEALTH, SPORTS & FITNESS

- **Fitness For Dummies**
  - ISBN: 0-7645-5167-1

- **Golf For Dummies**

- **Diabetes For Dummies**

Also available:

- Controlling Cholesterol For

- Dieting For Dummies
  - ISBN: 0-7645-5126-4

- High Blood Pressure For
  - ISBN: 0-7645-5424-7

- Martial Arts For Dummies

- Menopause For Dummies
  - ISBN: 0-7645-5458-1

- Nutrition For Dummies
  - ISBN: 0-7645-5180-9

- Power Yoga For Dummies

- Thyroid For Dummies

- Weight Training For Dummies

- Yoga For Dummies

Available wherever books are sold. Go to www.dummies.com or call 1-877-762-2974 to order direct.
Also available:

<table>
<thead>
<tr>
<th>HOME, GARDEN &amp; HOBBIES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Feng Shui For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5295-3</td>
</tr>
<tr>
<td><strong>Gardening For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5130-2</td>
</tr>
<tr>
<td><strong>Guitar For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5106-X</td>
</tr>
<tr>
<td><strong>Auto Repair For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5089-6)</td>
</tr>
<tr>
<td><strong>Chess For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5003-9)</td>
</tr>
<tr>
<td><strong>Home Maintenance For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5215-5)</td>
</tr>
<tr>
<td><strong>Organizing For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5300-3)</td>
</tr>
<tr>
<td><strong>Piano For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5105-1)</td>
</tr>
<tr>
<td><strong>Poker For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5232-5)</td>
</tr>
<tr>
<td><strong>Quilting For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5118-3)</td>
</tr>
<tr>
<td><strong>Rock Guitar For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5356-9)</td>
</tr>
<tr>
<td><strong>Roses For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5202-3)</td>
</tr>
<tr>
<td><strong>Sewing For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5137-X)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FOOD &amp; WINE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cooking For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5250-3</td>
</tr>
<tr>
<td><strong>Cookies For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5390-9</td>
</tr>
<tr>
<td><strong>Wine For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5114-0</td>
</tr>
<tr>
<td><strong>Bartending For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5051-9)</td>
</tr>
<tr>
<td><strong>Chinese Cooking For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5247-3)</td>
</tr>
<tr>
<td><strong>Christmas Cooking For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5407-7)</td>
</tr>
<tr>
<td><strong>Diabetes Cookbook For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5230-9)</td>
</tr>
<tr>
<td><strong>Grilling For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5076-4)</td>
</tr>
<tr>
<td><strong>Low-Fat Cooking For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5035-7)</td>
</tr>
<tr>
<td><strong>Slow Cookers For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5240-6)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TRAVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Italy For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5453-0</td>
</tr>
<tr>
<td><strong>Hawaii For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5438-7</td>
</tr>
<tr>
<td><strong>Las Vegas For Dummies</strong></td>
</tr>
<tr>
<td>0-7645-5448-4</td>
</tr>
<tr>
<td><strong>America’s National Parks For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-6204-5)</td>
</tr>
<tr>
<td><strong>Caribbean For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5445-X)</td>
</tr>
<tr>
<td><strong>Cruise Vacations For Dummies 2003</strong></td>
</tr>
<tr>
<td>(0-7645-5499-X)</td>
</tr>
<tr>
<td><strong>Europe For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5456-5)</td>
</tr>
<tr>
<td><strong>Ireland For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-6199-5)</td>
</tr>
<tr>
<td><strong>France For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-6292-4)</td>
</tr>
<tr>
<td><strong>London For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5416-6)</td>
</tr>
<tr>
<td><strong>Mexico’s Beach Resorts For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-6262-2)</td>
</tr>
<tr>
<td><strong>Paris For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5494-8)</td>
</tr>
<tr>
<td><strong>RV Vacations For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5443-3)</td>
</tr>
<tr>
<td><strong>Walt Disney World &amp; Orlando For Dummies</strong></td>
</tr>
<tr>
<td>(0-7645-5444-1)</td>
</tr>
</tbody>
</table>

Available wherever books are sold. Go to www.dummies.com or call 1-877-762-2974 to order direct.
# SELF-HELP, SPIRITUALITY & RELIGION

<table>
<thead>
<tr>
<th>Also available:</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Bible For Dummies (0-7645-5296-1)</td>
</tr>
<tr>
<td>Buddhism For Dummies (0-7645-5359-3)</td>
</tr>
<tr>
<td>Christian Prayer For Dummies (0-7645-5500-6)</td>
</tr>
<tr>
<td>Dating For Dummies (0-7645-5072-1)</td>
</tr>
<tr>
<td>Judaism For Dummies (0-7645-5299-6)</td>
</tr>
<tr>
<td>Potty Training For Dummies (0-7645-5417-4)</td>
</tr>
<tr>
<td>Pregnancy For Dummies (0-7645-5074-8)</td>
</tr>
<tr>
<td>Rekindling Romance For Dummies (0-7645-5303-8)</td>
</tr>
<tr>
<td>Spirituality For Dummies (0-7645-5298-8)</td>
</tr>
<tr>
<td>Weddings For Dummies (0-7645-5055-1)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PETS</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Also available:</td>
</tr>
<tr>
<td>Labrador Retrievers For Dummies (0-7645-5281-3)</td>
</tr>
<tr>
<td>Aquariums For Dummies (0-7645-5156-6)</td>
</tr>
<tr>
<td>Birds For Dummies (0-7645-5139-6)</td>
</tr>
<tr>
<td>Dogs For Dummies (0-7645-5274-0)</td>
</tr>
<tr>
<td>Ferrets For Dummies (0-7645-5259-7)</td>
</tr>
<tr>
<td>German Shepherds For Dummies (0-7645-5280-5)</td>
</tr>
<tr>
<td>Golden Retrievers For Dummies (0-7645-5267-8)</td>
</tr>
<tr>
<td>Horses For Dummies (0-7645-5138-8)</td>
</tr>
<tr>
<td>Jack Russell Terriers For Dummies (0-7645-5268-6)</td>
</tr>
<tr>
<td>Puppies Raising &amp; Training Diary For Dummies (0-7645-0876-8)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>EDUCATION &amp; TEST PREPARATION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Also available:</td>
</tr>
<tr>
<td>Chemistry For Dummies (0-7645-5430-1)</td>
</tr>
<tr>
<td>English Grammar For Dummies (0-7645-5322-4)</td>
</tr>
<tr>
<td>French For Dummies (0-7645-5193-0)</td>
</tr>
<tr>
<td>The GMAT For Dummies (0-7645-5251-1)</td>
</tr>
<tr>
<td>Inglés Para Dummies (0-7645-5427-1)</td>
</tr>
<tr>
<td>Italian For Dummies (0-7645-5196-5)</td>
</tr>
<tr>
<td>Research Papers For Dummies (0-7645-5426-3)</td>
</tr>
<tr>
<td>The SAT I For Dummies (0-7645-5472-7)</td>
</tr>
<tr>
<td>U.S. History For Dummies (0-7645-5249-X)</td>
</tr>
<tr>
<td>World History For Dummies (0-7645-5242-2)</td>
</tr>
</tbody>
</table>

Available wherever books are sold. Go to www.dummies.com or call 1-877-762-2974 to order direct.